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Partial Differential Equation Toolbox Product Description
Solve partial differential equations using finite element analysis

Partial Differential Equation Toolbox provides functions for solving structural mechanics,
heat transfer, and general partial differential equations (PDEs) using finite element
analysis.

You can perform linear static analysis to compute deformation, stress, and strain. For
modeling structural dynamics and vibration, the toolbox provides a direct time integration
solver. You can analyze a component’s structural characteristics by performing modal
analysis to find natural frequencies and mode shapes. You can model conduction-
dominant heat transfer problems to calculate temperature distributions, heat fluxes, and
heat flow rates through surfaces. You can also solve standard problems such as diffusion,
electrostatics, and magnetostatics, as well as custom PDEs.

Partial Differential Equation Toolbox lets you import 2D and 3D geometries from STL or
mesh data. You can automatically generate meshes with triangular and tetrahedral
elements. You can solve PDEs by using the finite element method, and postprocess results
to explore and analyze them.

Key Features
• Structural analysis, including linear static, dynamic, and modal analysis
• Heat transfer analysis for conduction-dominant problems
• General linear and nonlinear PDEs for stationary, time-dependent, and eigenvalue

problems
• 2D and 3D geometry import from STL files and mesh data
• Automatic meshing using triangular and tetrahedral elements with linear or quadratic

basis functions
• User-defined functions for specifying PDE coefficients, boundary conditions, and initial

conditions
• Plotting and animating results, as well as derived and interpolated values
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Equations You Can Solve Using Legacy Functions

Note THIS PAGE DESCRIBES THE LEGACY WORKFLOW. New features might not be
compatible with the legacy workflow. For the corresponding step in the recommended
workflow, see “Equations You Can Solve Using PDE Toolbox” on page 1-6.

This toolbox applies to the following PDE type:

−∇ ⋅ c∇u + au = f

expressed in Ω, which we shall refer to as the elliptic equation, regardless of whether its
coefficients and boundary conditions make the PDE problem elliptic in the mathematical
sense. Analogously, we shall use the terms parabolic equation and hyperbolic equation for
equations with spatial operators like the previous one, and first and second order time
derivatives, respectively. Ω is a bounded domain in the plane or is a bounded 3-D region.
c, a, f, and the unknown u are scalar, complex valued functions defined on Ω. c can be a
matrix function on Ω (see “c Coefficient for Systems” on page 2-122). The software can
also handle the parabolic PDE

d∂u∂t − ∇ ⋅ c∇u + au = f

the hyperbolic PDE

d∂
2u
∂t2 − ∇ ⋅ c∇u + au = f

and the eigenvalue problem

−∇ ⋅ c∇u + au = λdu

where d is a complex valued function on Ω, and λ is an unknown eigenvalue. For the
parabolic and hyperbolic PDE the coefficients c, a, f, and d can depend on time, on the
solution u, and on its gradient ∇u. A nonlinear solver (pdenonlin) is available for the
nonlinear elliptic PDE

−∇ ⋅ c(u)∇u + a(u)u = f (u)
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where c, a, and f are functions of the unknown solution u and of its gradient ∇u. The
parabolic and hyperbolic equation solvers also solve nonlinear and time-dependent
problems.

Note Before solving a nonlinear elliptic PDE, from the Solve menu in the PDE Modeler
app, select Parameters. Then, select the Use nonlinear solver check box and click OK.

For eigenvalue problems, the coefficients cannot depend on the solution u or its gradient.

A system of PDEs with N components is N coupled PDEs with coupled boundary
conditions. Scalar PDEs are those with N = 1, meaning just one PDE. Systems of PDEs
generally means N > 1. The documentation sometimes refers to systems as
multidimensional PDEs or as PDEs with a vector solution u. In all cases, PDE systems
have a single geometry and mesh. It is only N, the number of equations, that can vary.

All solvers can handle the system case of N coupled equations. You can solve N = 1 or 2
equations using the PDE Modeler app, and any number of equations using command-line
functions. For example, N = 2 elliptic equations:

−∇ · c11∇u1 − ∇ · c12∇u2 + a11u1 + a12u2 = f1
−∇ · c21∇u1 − ∇ · c22∇u2 + a21u1 + a22u2 = f2

For the elliptic problem, an adaptive mesh refinement algorithm is implemented. It can
also be used in conjunction with the nonlinear solver. In addition, a fast solver for
Poisson's equation on a rectangular grid is available.

The following boundary conditions are defined for scalar u:

• Dirichlet: hu = r on the boundary ∂Ω.
• Generalized Neumann: n · c∇u + qu = g on ∂Ω.

n  is the outward unit normal. g, q, h, and r are complex-valued functions defined on ∂Ω.
(The eigenvalue problem is a homogeneous problem, i.e., g = 0, r = 0.) In the nonlinear
case, the coefficients g, q, h, and r can depend on u, and for the hyperbolic and parabolic
PDE, the coefficients can depend on time. For the two-dimensional system case, Dirichlet
boundary condition is

h11u1 + h12u2 = r1
h21u1 + h22u2 = r2
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the generalized Neumann boundary condition is

n · c11∇u1 + n · c12∇u2 + q11u1 + q12u2 = g1

n · c21∇u1 + n · c22∇u2 + q21u1 + q22u2 = g2

and the mixed boundary condition is

h11u1 + h12u2 = r1

n · c11∇u1 + n · c12∇u2 + q11u1 + q12u2 = g1 + h11μ

n · c21∇u1 + n · c22∇u2 + q21u1 + q22u2 = g2 + h12μ

where µ is computed such that the Dirichlet boundary condition is satisfied. Dirichlet
boundary conditions are also called essential boundary conditions, and Neumann
boundary conditions are also called natural boundary conditions.

For advanced, nonstandard applications you can transfer the description of domains,
boundary conditions etc. to your MATLAB® workspace. From there you use Partial
Differential Equation Toolbox functions for managing data on unstructured meshes. You
have full access to the mesh generators, FEM discretizations of the PDE and boundary
conditions, interpolation functions, etc. You can design your own solvers or use FEM to
solve subproblems of more complex algorithms. See also “Solve PDEs Programmatically”
on page 3-278.
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Equations You Can Solve Using PDE Toolbox
Partial Differential Equation Toolbox solves scalar equations of the form

m∂
2u
∂t2 + d∂u∂t − ∇ · c∇u + au = f

and eigenvalue equations of the form

−∇ · c∇u + au = λdu
or

−∇ · c∇u + au = λ2mu

For scalar PDEs, there are two choices of boundary conditions for each edge or face:

• Dirichlet — On the edge or face, the solution u satisfies the equation

hu = r,

where h and r can be functions of space (x, y, and, in 3-D case, z), the solution u, and
time. Often, you take h = 1, and set r to the appropriate value.

• Generalized Neumann boundary conditions — On the edge or face the solution u
satisfies the equation

n · c∇u + qu = g

n  is the outward unit normal. q and g are functions defined on ∂Ω, and can be
functions of x, y, and, in 3-D case, z, the solution u, and, for time-dependent equations,
time.

The toolbox also solves systems of equations of the form

m∂2u
∂t2 + d∂u∂t − ∇ · c⊗ ∇u + au = f

and eigenvalue systems of the form

−∇ · c⊗ ∇u + au = λdu
or

−∇ · c⊗ ∇u + au = λ2mu
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A system of PDEs with N components is N coupled PDEs with coupled boundary
conditions. Scalar PDEs are those with N = 1, meaning just one PDE. Systems of PDEs
generally means N > 1. The documentation sometimes refers to systems as
multidimensional PDEs or as PDEs with a vector solution u. In all cases, PDE systems
have a single geometry and mesh. It is only N, the number of equations, that can vary.

The coefficients m, d, c, a, and f can be functions of location (x, y, and, in 3-D, z), and,
except for eigenvalue problems, they also can be functions of the solution u or its
gradient. For eigenvalue problems, the coefficients cannot depend on the solution u or its
gradient.

For scalar equations, all the coefficients except c are scalar. The coefficient c represents a
2-by-2 matrix in 2-D geometry, or a 3-by-3 matrix in 3-D geometry. For systems of N
equations, the coefficients m, d, and a are N-by-N matrices, f is an N-by-1 vector, and c is
a 2N-by-2N tensor (2-D geometry) or a 3N-by-3N tensor (3-D geometry). For the meaning
of c⊗ u, see “c Coefficient for specifyCoefficients” on page 2-100.

When both m and d are 0, the PDE is stationary. When either m or d are nonzero, the
problem is time-dependent. When any coefficient depends on the solution u or its
gradient, the problem is called nonlinear.

For systems of PDEs, there are generalized versions of the Dirichlet and Neumann
boundary conditions:

• hu = r represents a matrix h multiplying the solution vector u, and equaling the
vector r.

• n · c⊗ ∇u + qu = g. For 2-D systems, the notation n · c⊗ ∇u  means the N-by-1
matrix with (i,1)-component

∑
j = 1

N
cos(α)ci, j, 1, 1

∂
∂x + cos(α)ci, j, 1, 2

∂
∂y + sin(α)ci, j, 2, 1

∂
∂x + sin(α)ci, j, 2, 2

∂
∂y u j

where the outward normal vector of the boundary n = cos(α), sin(α) .

For 3-D systems, the notation n · c⊗ ∇u  means the N-by-1 vector with (i,1)-
component
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∑
j = 1

N
sin φ cos θ ci, j, 1, 1

∂
∂x + sin φ cos θ ci, j, 1, 2

∂
∂y + sin φ cos θ ci, j, 1, 3

∂
∂z u j

+ ∑
j = 1

N
sin φ sin θ ci, j, 2, 1

∂
∂x + sin φ sin θ ci, j, 2, 2

∂
∂y + sin φ sin θ ci, j, 2, 3

∂
∂z u j

+ ∑
j = 1

N
cos θ ci, j, 3, 1

∂
∂x + cos θ ci, j, 3, 2

∂
∂y + cos θ ci, j, 3, 3

∂
∂z u j

where the outward normal vector of the boundary
n = sin(φ)cos(θ), sin(φ)sin(θ), cos(φ) .

For each edge or face segment, there are a total of N boundary conditions.

See Also

Related Examples
• “Solve Problems Using PDEModel Objects” on page 2-6
• “f Coefficient for specifyCoefficients” on page 2-97
• “c Coefficient for specifyCoefficients” on page 2-100
• “m, d, or a Coefficient for specifyCoefficients” on page 2-142
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Common Toolbox Applications
PDEs used for:

• Steady and unsteady heat transfer in solids
• Flows in porous media and diffusion problems
• Electrostatics of dielectric and conductive media
• Potential flow
• Steady state of wave equations
• Transient and harmonic wave propagation in acoustics and electromagnetics
• Transverse motions of membranes

Eigenvalue problems are used for:

• Determining natural vibration states in membranes and structural mechanics
problems

In addition to solving generic scalar PDEs and generic systems of PDEs with vector
valued u, Partial Differential Equation Toolbox provides tools for solving PDEs that occur
in these common applications in engineering and science:

• “Electrostatics and Magnetostatics”
• “Structural Mechanics”
• “AC Power Electromagnetics”
• “DC Conduction”
• “Heat Transfer”

The PDE Modeler app lets you specify PDE coefficients and boundary conditions in terms
of physical entities. For example, you can specify Young's modulus in structural
mechanics problems.

The application mode can be selected directly from the pop-up menu in the upper right
part of the PDE Modeler app or by selecting an application from the Application
submenu in the Options menu. Changing the application resets all PDE coefficients and
boundary conditions to the default values for that specific application mode.

When using an application mode, the generic PDE coefficients are replaced by
application-specific parameters such as Young's modulus for problems in structural
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mechanics. The application-specific parameters are entered by selecting Parameters
from the PDE menu or by clicking the PDE button. You can also access the PDE
parameters by double-clicking a subdomain, if you are in the PDE mode. That way it is
possible to define PDE parameters for problems with regions of different material
properties. The Boundary condition dialog box is also altered so that the Description
column reflects the physical meaning of the different boundary condition coefficients.
Finally, the Plot Selection dialog box allows you to visualize the relevant physical
variables for the selected application.

Note In the User entry options in the Plot Selection dialog box, the solution and its
derivatives are always referred to as u, ux, and uy (v, vx, and vy for the system cases)
even if the application mode is nongeneric and the solution of the application-specific
PDE normally is named, e.g., V or T.

The PDE Modeler app lets you solve problems with vector valued u of dimension two.
However, you can use functions to solve problems for any dimension of u.
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Solve 2-D PDEs Using the PDE Modeler App
To solve 2-D PDE problems using the PDE Modeler app follow these steps:

1 Start the PDE Modeler app by using the Apps tab or typing pdeModeler in the
MATLAB Command Window. For details, see “Open the PDE Modeler App” on page 4-
2.

2 Choose the application mode by selecting Application from the Options menu.
3 Create a 2-D geometry by drawing, rotating, and combining the basic shapes: circles,

ellipses, rectangles, and polygons. To draw and rotate shapes, use the Draw menu or
the corresponding toolbar buttons. To combine shapes, use the Set formula field.
See “2-D Geometry Creation in PDE Modeler App” on page 4-3.

4 Specify boundary conditions for each boundary segment. To do this, first switch to
the Boundary Mode by using the Boundary menu. Click the boundary to select it,
then specify the boundary condition for that boundary. You can have different types of
boundary conditions on different boundary segments. The default boundary condition
is the Dirichlet condition hu = r with h = 1 and r = 0. You can remove unnecessary
subdomain borders by selecting Remove Subdomain Border or Remove All
Subdomain Borders from the Boundary menu. For details, see “Specify Boundary
Conditions in the PDE Modeler App” on page 4-21.

5 Specify PDE coefficients by selecting PDE Mode from the PDE menu. Then select a
region or multiple regions for which you are specifying the coefficients. Select PDE
Specification from the PDE menu or click the PDE button on the toolbar. Type the
coefficients in the resulting dialog box. For details, see “Coefficients for Scalar PDEs
in PDE Modeler App” on page 2-77 and “Coefficients for Systems of PDEs in the
PDE Modeler App” on page 2-91.

You can specify the coefficients at any time before solving the PDE because the
coefficients are independent of the geometry and the boundaries. If the PDE
coefficients are material-dependent, specify them by double-clicking each particular
region.

6 Generate a triangular mesh by selecting Initialize Mesh from the Mesh menu.
Using the same menu, you can also refine mesh, display node and triangle labels, and
control mesh parameters, letting you generate a mesh that is fine enough to
adequately resolve the important features in the geometry, but is coarse enough to
run in a reasonable amount of time and memory. See “Specify Mesh Parameters in
the PDE Modeler App” on page 4-24.
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7 Solve the PDE by clicking the = button or by selecting Solve PDE from the Solve
menu. To use a solver with non-default parameters, select Parameters from the
Solve menu to. The resulting dialog box lets you:

• Invoke and control the nonlinear and adaptive solvers for elliptic problems.
• Specify the initial values, and the times for which to generate the output for

parabolic and hyperbolic problems.
• Specify the interval in which to search for eigenvalues for eigenvalue problems.

See “Adjust Solve Parameters in the PDE Modeler App” on page 4-26.
8 When you solve the PDE, the app automatically plots the solution using the default

settings. To customize the plot or plot other physical properties calculated using the
solution, select Parameters from the Plot menu. See “Plot the Solution in the PDE
Modeler App” on page 4-33.

Tips
After solving the problem, you can:

• Export the solution or the mesh or both to the MATLAB workspace for further analysis.
• Visualize other properties of the solution.
• Change the PDE and recompute the solution.
• Change the mesh and recompute the solution. If you select Initialize Mesh, the mesh

is initialized; if you select Refine Mesh, the current mesh is refined. From the Mesh
menu, you can also jiggle the mesh and undo previous mesh changes. You also can use
the adaptive mesh refiner and solver, adaptmesh. This option tries to find a mesh that
fits the solution.

• Change the boundary conditions. To return to the mode where you can select
boundaries, use the ∂Ω button or the Boundary Mode option from the Boundary
menu.

• Change the geometry. You can switch to the draw mode again by selecting Draw
Mode from the Draw menu or by clicking one of the Draw Mode icons to add another
shape.

The following are the shortcuts that you can use to skip one or more steps. In general, the
PDE Modeler app adds the necessary steps automatically.

• If you do not create a geometry, the PDE Modeler app uses an L-shaped geometry with
the default boundary conditions.
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• If you initialize the mesh while in the draw mode, the PDE Modeler app first
decomposes the geometry using the current set formula and assigns the default
boundary condition to the outer boundaries. After that, it generate the mesh.

• If you refine the mesh before initializing it, the PDE Modeler app first initializes the
mesh.

• If you solve the PDE without generating a mesh, the PDE Modeler app initializes a
mesh before solving the PDE.

• If you select a plot type and choose to plot the solution, the PDE Modeler app checks if
the solution to the current PDE is available. If not, the PDE Modeler app first solves
the current PDE. The app displays the solution using the selected plot options.

• If do not specify the coefficients and use the default Generic Scalar application mode,
the PDE Modeler app solves the default PDE, which is Poisson's equation:

–Δu = 10.

This corresponds to the generic elliptic PDE with c = 1, a = 0, and f = 10. The default
PDE settings depend on the application mode.

See Also

Related Examples
• “Poisson’s Equation with Complex 2-D Geometry” on page 1-14
• “Poisson's Equation on Unit Disk” on page 3-169
• “Current Density Between Two Metallic Conductors” on page 3-146
• “Minimal Surface Problem” on page 3-184
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Poisson’s Equation with Complex 2-D Geometry
This example shows how to solve the Poisson's equation, –Δu = f on a 2-D geometry
created as a combination of two rectangles and two circles.

To solve this problem in the PDE Modeler app, follow these steps:

1 Open the PDE Modeler app by using the pdeModeler command.
2 Display grid lines. To do this, select Options > Grid Spacing and clear the Auto

checkbox for the x-axis linear spacing. Enter X-axis linear spacing as
-1.5:0.25:1.5. Then select Options > Grid.

3 Align new shapes to the grid lines by selecting Options > Snap.
4 Draw two circles: one with the radius 0.4 and the center at (-0.5,0) and another with

the radius 0.2 and the center at (0.5,0.2). To draw a circle, first click the 
button. Then right-click the origin and drag to draw a circle. Right-clicking constrains
the shape you draw so that it is a circle rather than an ellipse.

5 Draw two rectangles: one with corners (-1,0.2), (1,0.2), (1,-0.2), and (-1,-0.2) and
another with corners (0.5,1), (1,1), (1,-0.6), and (0.5,-0.6). To draw a rectangle, first

click the  button. Then click any corner and drag to draw the rectangle.
6 Model the geometry by entering (R1+C1+R2)-C2 in the Set formula field.
7 Save the model to a file by selecting FileSave As.
8 Remove the subdomain borders. To do this, switch to the boundary mode by selecting

Boundary > Boundary Mode. Then select Boundary > Remove All Subdomain
Borders.

9 Specify the boundary conditions for all circle arcs. Using Shift+click, select these
borders. Then select Boundary > Specify Boundary Conditions and specify the
Neumann boundary condition with g = -5 and q = 0. This boundary condition means
that the solution has a slope of –5 in the normal direction for these boundary
segments.

10 For all other boundaries, keep the default Dirichlet boundary condition: h = 1, r =
0.

11 Specify the coefficients by selecting PDE > PDE Specification or clicking the PDE
button on the toolbar. Specify c = 1, a = 0, and f = 10.
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12 Initialize the mesh by selecting Mesh > Initialize Mesh. Refine the mesh by
selecting Mesh > Refine Mesh.

13 Solve the PDE by selecting Solve > Solve PDE or clicking the = button on the
toolbar. The toolbox assembles the PDE problem, solves it, and plots the solution.
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14 Plot the solution as a 3-D plot:

a Select Plot > Parameters.
b In the resulting dialog box, select Height (3-D plot).
c Click Plot.
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Finite Element Method Basics
The core Partial Differential Equation Toolbox algorithm uses the Finite Element Method
(FEM) for problems defined on bounded domains in 2-D or 3-D space. In most cases,
elementary functions cannot express the solutions of even simple PDEs on complicated
geometries. The finite element method describes a complicated geometry as a collection
of subdomains by generating a mesh on the geometry. For example, you can approximate
the computational domain Ω with a union of triangles (2-D geometry) or tetrahedra (3-D
geometry). The subdomains form a mesh, and each vertex is called a node. The next step
is to approximate the original PDE problem on each subdomain by using simpler
equations.

For example, consider the basic elliptic equation.

−∇ ⋅ c∇u + au = f  on domain Ω

Suppose that this equation is a subject to the Dirichlet boundary condition u = r on ∂ΩD
and Neumann boundary conditions on ∂ΩN. Here, ∂Ω = ∂ΩD∪ ∂ΩN is the boundary of Ω.

The first step in FEM is to convert the original differential (strong) form of the PDE into
an integral (weak) form by multiplying with test function v and integrating over the
domain Ω.

∫
Ω

−∇ · c∇u + au− f v dΩ = 0 ∀v

The test functions are chosen from a collection of functions (functional space) that vanish
on the Dirichlet portion of the boundary, v = 0 on ∂ΩD. Above equation can be thought of
as weighted averaging of the residue using all possible weighting functions v. The
collection of functions that are admissible solutions, u, of the weak form of PDE are
chosen so that they satisfy the Dirichlet BC, u = r on ∂ΩD.

Integrating by parts (Green’s formula) the second-order term results in:

∫
Ω

c∇u ∇v + auv dΩ− ∫
∂ΩN

n · c∇u v d∂ΩN + ∫
∂ΩD

n · c∇u v d∂ΩD = ∫
Ω

f v dΩ ∀v

Use the Neumann boundary condition to substitute for second term on the left side of the
equation. Also, note that v = 0 on ∂ΩD nullifies the third term. The resulting equation is:
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∫
Ω

c∇u ∇v + auv dΩ + ∫
∂ΩN

quv d∂ΩN = ∫
∂ΩN

gv d∂ΩN + ∫
Ω

f v dΩ ∀v

Note that all manipulations up to this stage are performed on continuum Ω, the global
domain of the problem. Therefore, the collection of admissible functions and trial
functions span infinite-dimensional functional spaces. Next step is to discretize the weak
form by subdividing Ω into smaller subdomains or elements Ωe, where Ω = ∪ Ωe. This
step is equivalent to projection of the weak form of PDEs onto a finite-dimensional
subspace. Using the notations uh and vh to represent the finite-dimensional equivalent of
admissible and trial functions defined on Ωe, you can write the discretized weak form of
the PDE as:

∫
Ωe

c∇uh∇vh + auhvh dΩe + ∫
∂ΩN

e
quhv hd∂ΩN

e = ∫
∂ΩN

e
gv hd∂ΩN

e + ∫
Ωe

f vhdΩe ∀vh

Next, let ϕi, with i = 1, 2, ... , Np, be the piecewise polynomial basis functions for the

subspace containing the collections uh and vh, then any particular uh  can be expressed as
a linear combination of basis functions:

uh = ∑
1

Np
Uiϕi

Here Ui are yet undetermined scalar coefficients. Substituting uh  into to the discretized
weak form of PDE and using each vh = φi as test functions and performing integration
over element yields a system of Np equations in terms of Np unknowns Ui.

Note that finite element method approximates a solution by minimizing the associated
error function. The minimizing process automatically finds the linear combination of basis
functions which is closest to the solution u.

FEM yields a system KU = F where the matrix K and the right side F contain integrals in
terms of the test functions ϕi, ϕj, and the coefficients c, a, f, q, and g defining the problem.
The solution vector U contains the expansion coefficients of uh, which are also the values
of uh at each node xk (k = 1,2 for a 2-D problem or k = 1,2,3 for a 3-D problem) since
uh(xk) = Ui.

FEM techniques are also used to solve more general problems, such as:
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• Time-dependent problems. The solution u(x,t) of the equation

d∂u∂t − ∇ ⋅ c∇u + au = f

can be approximated by

uh(x, t) = ∑
i = 1

N
Ui(t)ϕi(x)

The result is a system of ordinary differential equations (ODEs)

MdU
dt + KU = F

Two time derivatives result in a second-order ODE

Md2U
dt2 + KU = F

• Eigenvalue problems. Solve

−∇ ⋅ c∇u + au = λdu

for the unknowns u and λ, where λ is a complex number. Using the FEM discretization,
you solve the algebraic eigenvalue problem KU = λMU to find uh as an approximation
to u. To solve eigenvalue problems, use solvepdeeig.

• Nonlinear problems. If the coefficients c, a, f, q, or g are functions of u or ∇u, the PDE
is called nonlinear and FEM yields a nonlinear system K(U)U = F(U).

To summarize, the FEM approach:

1 Represents the original domain of the problem as a collection of elements.
2 For each element, substitutes the original PDE problem by a set of simple equations

that locally approximate the original equations. Applies boundary conditions for
boundaries of each element. For stationary linear problems where the coefficients do
not depend on the solution or its gradient, the result is a linear system of equations.
For stationary problems where the coefficients depend on the solution or its gradient,
the result is a system of nonlinear equations. For time-dependent problems, the result
is a set of ODEs.

3 Assembles the resulting equations and boundary conditions into a global system of
equations that models the entire problem.
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4 Solves the resulting system of algebraic equations or ODEs using linear solvers or
numerical integration, respectively. The toolbox internally calls appropriate MATLAB
solvers for this task.

References
[1] Cook, Robert D., David S. Malkus, and Michael E. Plesha. Concepts and Applications of

Finite Element Analysis. 3rd edition. New York, NY: John Wiley & Sons, 1989.

[2] Gilbert Strang and George Fix. An Analysis of the Finite Element Method. 2nd edition.
Wellesley, MA: Wellesley-Cambridge Press, 2008.

See Also
assembleFEMatrices | solvepde | solvepdeeig
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Setting Up Your PDE
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• “Solve PDEs with Initial Conditions” on page 2-161
• “No Boundary Conditions Between Subdomains” on page 2-164
• “Identify Boundary Labels” on page 2-166
• “Boundary Matrix for 2-D Geometry” on page 2-168
• “Specify Boundary Conditions” on page 2-174
• “Solve PDEs with Constant Boundary Conditions” on page 2-181
• “Solve PDEs with Nonconstant Boundary Conditions” on page 2-186
• “View, Edit, and Delete Boundary Conditions” on page 2-192
• “Boundary Conditions by Writing Functions” on page 2-197
• “Generate Mesh” on page 2-209
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• “Mesh Data” on page 2-233
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Solve Problems Using Legacy PDEModel Objects

Note THIS PAGE DESCRIBES THE LEGACY WORKFLOW. New features might not be
compatible with the legacy workflow. For the corresponding step in the recommended
workflow, see “Solve Problems Using PDEModel Objects” on page 2-6.

1 Put your problem in the correct form for Partial Differential Equation Toolbox solvers.
For details, see “Equations You Can Solve Using Legacy Functions” on page 1-3. If
you need to convert your problem to divergence form, see “Put Equations in
Divergence Form” on page 2-71.

2 Create a PDEModel model container. For scalar PDEs, use createpde with no
arguments.

model = createpde;

If N is the number of equations in your system, use createpde with input argument
N.

model = createpde(N);
3 Import the geometry into model. For details, see “STL File Import” on page 2-46 or

“Three Ways to Create 2-D Geometry” on page 2-8. For example:

importGeometry(model,'geometry.stl'); % importGeometry for 3-D
geometryFromEdges(model,g); % geometryFromEdges for 2-D

4 View the geometry so that you know the labels of the faces. To see labels of a 3-D
model, you might need to rotate the model, or make it transparent, or zoom in on it.
See “STL File Import” on page 2-46. For a 2-D example, see “Identify Boundary
Labels” on page 2-166. For example:

pdegplot(model,'FaceLabels','on') % 'FaceLabels' for 3-D
pdegplot(model,'EdgeLabels','on') % 'EdgeLabels' for 2-D

5 Create the boundary conditions. For details, see “Specify Boundary Conditions” on
page 2-174. For example:

% 'Face' for 3-D
applyBoundaryCondition(model,'Face',[2,3,5],'u',[0,0]);

% 'Edge' for 2-D
applyBoundaryCondition(model,'Edge',[1,4],'g',1,'q',eye(2));
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For more information on boundary conditions, see “Boundary Conditions”.
6 Create the PDE coefficients. For example:

f = [1;2];
a = 0;
c = [1;3;5];

• You can specify coefficients as numeric, character functions on page 2-74, or
functions in 2-D functional form on page 2-80 or 3-D functional form on page 2-
83. For a 2-D example, see “Solve PDE with Coefficients in Functional Form” on
page 2-85.

• For systems of PDEs, each coefficient f, c, a, and d has a specific format. See “f
Coefficient for Systems” on page 2-94, “c Coefficient for Systems” on page 2-122,
and “a or d Coefficient for Systems” on page 2-147.

For all information on coefficients, see “PDE Coefficients”.
7 For hyperbolic or parabolic equations, create an initial condition. For nonlinear

elliptic problems, create an initial guess. See “Solve PDEs with Initial Conditions” on
page 2-161.

8 Create the mesh. To obtain a nondefault mesh, use generateMesh name-value pairs.
For example:

generateMesh(model);
9 Call the appropriate solver. For example:

u = assempde(model,c,a,f);

• For elliptic problems whose coefficients do not depend on the solution u, use
assempde.

• For elliptic problems whose coefficients depend on the solution u, use
pdenonlin.

• For parabolic problems, use parabolic.
• For hyperbolic problems, use hyperbolic.
• For eigenvalue problems, use pdeeig.

For definitions of the problems that these solvers address, see “Equations You Can
Solve Using Legacy Functions” on page 1-3.

10 Examine the solution. See “Plot 3-D Solutions and Their Gradients” on page 3-295 or
pdeplot.
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See Also
applyBoundaryCondition | createpde | generateMesh | geometryFromEdges |
importGeometry | pdegplot | pdeplot | pdeplot3D
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Solve Problems Using PDEModel Objects
1 Put your problem in the correct form for Partial Differential Equation Toolbox solvers.

For details, see “Equations You Can Solve Using PDE Toolbox” on page 1-6. If you
need to convert your problem to divergence form, see “Put Equations in Divergence
Form” on page 2-71.

2 Create a PDEModel model container. For scalar PDEs, use createpde with no
arguments.

model = createpde();

If N is the number of equations in your system, use createpde with input argument
N.

model = createpde(N);
3 Import or create the geometry. For details, see “STL File Import” on page 2-46 or

“Three Ways to Create 2-D Geometry” on page 2-8.

importGeometry(model,'geometry.stl'); % importGeometry for 3-D
geometryFromEdges(model,g); % geometryFromEdges for 2-D

4 View the geometry so that you know the labels of the boundaries.

pdegplot(model,'FaceLabels','on') % 'FaceLabels' for 3-D
pdegplot(model,'EdgeLabels','on') % 'EdgeLabels' for 2-D

To see labels of a 3-D model, you might need to rotate the model, or make it
transparent, or zoom in on it. See “STL File Import” on page 2-46.

5 Create the boundary conditions. For details, see “Specify Boundary Conditions” on
page 2-174.

% 'face' for 3-D
applyBoundaryCondition(model,'dirichlet','face',[2,3,5],'u',[0,0]);
% 'edge' for 2-D
applyBoundaryCondition(model,'neumann','edge',[1,4],'g',1,'q',eye(2));

For more information on boundary conditions, see “Boundary Conditions”.
6 Create the PDE coefficients.

f = [1;2];
a = 0;
c = [1;3;5];
specifyCoefficients(model,'m',0,'d',0,'c',c,'a',a,'f',f);
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• You can specify coefficients as numeric or as functions.
• Each coefficient m, d, c, a, and f, has a specific format. See “f Coefficient for
specifyCoefficients” on page 2-97, “c Coefficient for specifyCoefficients” on page
2-100, and “m, d, or a Coefficient for specifyCoefficients” on page 2-142.

For all information on coefficients, see “PDE Coefficients”.
7 For time-dependent equations, or optionally for nonlinear stationary equations,

create an initial condition. See “Set Initial Conditions” on page 2-154.
8 Create the mesh.

generateMesh(model);
9 Call the appropriate solver. For all problems except for eigenvalue problems, call

solvepde.

result = solvepde(model); % for stationary problems
result = solvepde(model,tlist); % for time-dependent problems

For eigenvalue problems, use solvepdeeig:

result = solvepdeeig(model);
10 Examine the solution. See “Plot 2-D Solutions and Their Gradients” on page 3-284

and “Plot 3-D Solutions and Their Gradients” on page 3-295.

See Also
applyBoundaryCondition | createpde | generateMesh | geometryFromEdges |
importGeometry | pdegplot | pdeplot | pdeplot3D

Related Examples
• “Plot 3-D Solutions and Their Gradients” on page 3-295
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Three Ways to Create 2-D Geometry
There are three ways to create 2-D geometry. Two are based on CSG (Constructive Solid
Geometry) models, which combine basic shapes.

• Use the PDE Modeler app to draw basic shapes (rectangles, circles, ellipses, and
polygons) and combine them with set intersection and unions to obtain the final
geometry. You can then export the geometry to your MATLAB workspace, or continue
to work in the app. For details, see “2-D Geometry Creation in PDE Modeler App” on
page 4-3.

• Use the decsg function to create geometry at the command line as follows:

• Specify matrices that represent the basic shapes (rectangles, circles, ellipses, and
polygons).

• Give each shape a label.
• Specify a “set formula” that describes the intersections, unions, and set differences

of the basic shapes.

decsg allows you to describe any geometry that you can make from the basic shapes
(rectangles, circles, ellipses, and polygons). For details, see “2-D Geometry Creation at
Command Line” on page 2-10.

• Specify a function that describes the geometry. The function must be in the form
described in “Parametrized Function for 2-D Geometry Creation” on page 2-17.

How to Decide on a Geometry Creation Method
This table lists the advantages and disadvantages of each method for creating geometry.
In general, choose the lowest-numbered method:

1 Use the PDE Modeler app if you can (simple geometry).
2 Use the decsg function for geometries that are somewhat complex but can be

described in terms of the basic shapes.
3 Use a geometry description function if you cannot use the other methods.

Method Advantages Disadvantages
PDE Modeler app Simple click-and-drag

interface
Can be tedious to specify
exact shapes
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Method Advantages Disadvantages
See the geometry as you
create it

Can fail for complex figures

Instant feedback on
subdomains, connectedness

No control of edge or
subdomain labels

 Only basic shapes as
building blocks: rectangles,
circles, ellipses, and
polygons

decsg Control all basic geometry
elements

Cannot see the geometry as
you create it

 No control of edge or
subdomain labels

 Only basic shapes as
building blocks: rectangles,
circles, ellipses, and
polygons

Geometry function Specify any shape Cannot see the geometry as
you create it

Specify edge and subdomain
labels

Need to write a function
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2-D Geometry Creation at Command Line

Three Elements of Geometry
For basic information on 2-D geometry construction, see “Three Ways to Create 2-D
Geometry” on page 2-8

To describe your geometry through Constructive Solid Geometry (CSG) modeling, use
three data structures.

1 A matrix whose columns describe the basic shapes. When you export geometry from
the PDE Modeler app, this matrix has the default name gd (geometry description).
See “Create Basic Shapes” on page 2-10.

2 A matrix whose columns contain names for the basic shapes. Pad the columns with
zeros or 32 (blanks) so that every column has the same length. See “Create Names
for the Basic Shapes” on page 2-12.

3 A set of characters describing the unions, intersections, and set differences of the
basic shapes that make the geometry. See “Set Formula” on page 2-13.

Create Basic Shapes
To create basic shapes at the command line, create a matrix whose columns each
describe a basic shape. If necessary, add extra zeros to some columns so that all columns
have the same length. Write each column using the following encoding.

Circle

Row Value
1 1 (indicates a circle)
2 x-coordinate of circle center
3 y-coordinate of circle center
4 Radius (strictly positive)
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Polygon

Row Value
1 2 (indicates a polygon)
2 Number of line segments n
3 through 3+n-1 x-coordinate of edge starting points
3+n through 2*n+2 y-coordinate of edge starting points

Note Your polygon cannot contain any self-intersections. To check whether your polygon
satisfies this restriction, use the csgchk function.

Rectangle

Row Value
1 3 (indicates a rectangle)
2 4 (number of line segments)
3 through 6 x-coordinate of edge starting points
7 through 10 y-coordinate of edge starting points

The encoding of a rectangle is the same as that of a polygon, except that the first row is 3
instead of 2.

Ellipse

Row Value
1 4 (indicates an ellipse)
2 x-coordinate of ellipse center
3 y-coordinate of ellipse center
4 First semiaxis length (strictly positive)
5 Second semiaxis length (strictly positive)
6 Angle in radians from x axis to first semiaxis

For example, specify a matrix that has a rectangle with a circular end cap and another
circular excision. First, create a rectangle and two adjoining circles.
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rect1 = [3
    4
    -1
    1
    1
    -1
    0
    0
    -0.5
    -0.5];
C1 = [1
    1
    -0.25
    0.25];
C2 = [1
    -1
    -0.25
    0.25];

Append extra zeros to the circles so they have the same number of rows as the rectangle.

C1 = [C1;zeros(length(rect1) - length(C1),1)];
C2 = [C2;zeros(length(rect1) - length(C2),1)];

Combine the shapes into one matrix.

gd = [rect1,C1,C2];

Create Names for the Basic Shapes
In order to create a formula describing the unions and intersections of basic shapes, you
need a name for each basic shape. Give the names as a matrix whose columns contain the
names of the corresponding columns in the basic shape matrix. Pad the columns with 0 or
32 if necessary so that each has the same length.

One easy way to create the names is by specifying a character array whose rows contain
the names, and then taking the transpose. Use the char function to create the array.
char pads the rows as needed so all have the same length. Continuing the example, give
names for the three shapes.

ns = char('rect1','C1','C2');
ns = ns';
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Set Formula
Obtain the final geometry by writing a set of characters that describes the unions and
intersections of basic shapes. Use + for union, * for intersection, - for set difference, and
parentheses for grouping. + and * have the same grouping precedence. - has higher
grouping precedence.

Continuing the example, specify the union of the rectangle and C1, and subtract C2.

sf = '(rect1+C1)-C2';

Create Geometry and Remove Face Boundaries
After you have created the basic shapes, given them names, and specified a set formula,
create the geometry using decsg. Often, you also remove some or all of the resulting face
boundaries. Completing the example, combine the basic shapes using the set formula.

[dl,bt] = decsg(gd,sf,ns);

View the geometry with and without boundary removal.

pdegplot(dl,'EdgeLabels','on','FaceLabels','on')
xlim([-1.5,1.5])
axis equal
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Remove the face boundaries.

[dl2,bt2] = csgdel(dl,bt); % removes face boundaries
figure
pdegplot(dl2,'EdgeLabels','on','FaceLabels','on')
xlim([-1.5,1.5])
axis equal
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Decomposed Geometry Data Structure
A decomposed geometry matrix has the following encoding. Each column of the matrix
corresponds to one boundary segment. Any 0 entry means no encoding is necessary for
this row. So, for example, if only line segments appear in the matrix, then the matrix has 7
rows. But if there is also a circular segment, then the matrix has 10 rows. The extra three
rows of the line columns are filled with 0.

Row Circle Line Ellipse
1 1 2 4
2 Starting x coordinate Starting x coordinate Starting x coordinate
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Row Circle Line Ellipse
3 Ending x coordinate Ending x coordinate Ending x coordinate
4 Starting y coordinate Starting y coordinate Starting y coordinate
5 Ending y coordinate Ending y coordinate Ending y coordinate
6 Region label to left of

segment, with direction
induced by start and
end points (0 is exterior
label)

Region label to left of
segment, with direction
induced by start and
end points (0 is exterior
label)

Region label to left of
segment, with direction
induced by start and
end points (0 is exterior
label)

7 Region label to right of
segment, with direction
induced by start and
end points (0 is exterior
label)

Region label to right of
segment, with direction
induced by start and
end points (0 is exterior
label)

Region label to right of
segment, with direction
induced by start and
end points (0 is exterior
label)

8 x coordinate of circle
center

0 x coordinate of ellipse
center

9 y coordinate of circle
center

0 y coordinate of ellipse
center

10 Radius 0 Length of first semiaxis
11 0 0 Length of second

semiaxis
12 0 0 Angle in radians

between x axis and first
semiaxis
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Parametrized Function for 2-D Geometry Creation

Required Syntax
For basic information on creating a 2-D geometry, see “Three Ways to Create 2-D
Geometry” on page 2-8.

A geometry function describes the curves that bound the geometry regions. A curve is a
parametrized function (x(t),y(t)). The variable t ranges over a fixed interval. For best
results, t must be proportional to the arc length plus a constant.

You must specify at least two curves for each geometric region. For example, the
'circleg' geometry function, which is available in Partial Differential Equation Toolbox,
uses four curves to describe a circle. Curves can intersect only at the beginning or end of
parameter intervals.

Toolbox functions query your geometry function by passing in 0, 1, or 2 arguments.
Conditionalize your geometry function based on the number of input arguments to return
the data described in this table.

Number of Input Arguments Returned Data
0 (ne = pdegeom) ne is the number of edges in the geometry.
1 (d = pdegeom(bs)) bs is a vector of edge segments. Your function returns

d as a matrix with one column for each edge segment
specified in bs. The rows of d are:

1 Start parameter value
2 End parameter value
3 Left region label, where “left” is with respect to

the direction from the start to the end parameter
value

4 Right region label

A region label is the same as a subdomain number.
The region label of the exterior of the geometry is 0.
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Number of Input Arguments Returned Data
2 ([x,y] = pdegeom(bs,s)) s is an array of arc lengths, and bs is a scalar or an

array of the same size as s that gives the edge
numbers. If bs is a scalar, then it applies to every
element in s. Your function returns x and y, which are
the x and y coordinates of the edge segments
specified in bs at the parameter value s. The x and y
arrays have the same size as s.

Relation Between Parametrization and Region Labels
The following figure shows how the direction of parameter increase relates to label
numbering. The arrows in the figure show the directions of increasing parameter values.
The black dots indicate curve beginning and end points. The red numbers indicate region
labels. The red 0 in the center of the figure indicates that the center square is a hole.

• The arrows by curves 1 and 2 show region 1 to the left and region 0 to the right.
• The arrows by curves 3 and 4 show region 0 to the left and region 1 to the right.
• The arrows by curves 5 and 6 show region 0 to the left and region 1 to the right.
• The arrows by curves 7 and 8 show region 1 to the left and region 0 to the right.
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Geometry Function for a Circle
This example shows how to write a geometry function for creating a circular region.
Parametrize a circle with radius 1 centered at the origin (0,0), as follows:

x = cos t ,
y = sin t ,
0 ≤ t ≤ 2π .

A geometry function must have at least two segments. To satisfy this requirement, break
up the circle into four segments.
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• 0 ≤ t ≤ π/2
• π/2 ≤ t ≤ π
• π ≤ t ≤ 3π/2
• 3π/2 ≤ t ≤ 2π

Now that you have a parametrization, write the geometry function. Save this function file
as circlefunction.m on your MATLAB® path. This geometry is simple to create
because the parametrization does not change depending on the segment number.

function [x,y] = circlefunction(bs,s)
% Create a unit circle centered at (0,0) using four segments.
switch nargin
    case 0
        x = 4; % four edge segments
        return
    case 1
        A = [0,pi/2,pi,3*pi/2; % start parameter values
             pi/2,pi,3*pi/2,2*pi; % end parameter values
             1,1,1,1; % region label to left
             0,0,0,0]; % region label to right
        x = A(:,bs); % return requested columns
        return
    case 2
        x = cos(s);
        y = sin(s);
end

Plot the geometry displaying the edge numbers and the face label.

pdegplot(@circlefunction,'EdgeLabels','on','FaceLabels','on')
axis equal
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Arc Length Calculations for a Geometry Function
This example shows how to create a cardioid geometry using four distinct techniques. The
techniques are ways to parametrize your geometry using arc length calculations. The
cardioid satisfies the equation .

ezpolar('2*(1+cos(Phi))')
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The following are the four ways to parametrize the cardioid as a function of the arc
length:

• Use the pdearcl function with a polygonal approximation to the geometry. This
approach is general, accurate enough, and computationally fast.

• Use the integral and fzero functions to compute the arc length. This approach is more
computationally costly, but can be accurate without requiring you to choose an
arbitrary polygon.

• Use an analytic calculation of the arc length. This approach is the best when it applies,
but there are many cases where it does not apply.
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• Use a parametrization that is not proportional to the arc length plus a constant. This
approach is the simplest, but can yield a distorted mesh that does not give the most
accurate solution to your PDE problem.

Polygonal Approximation

The finite element method uses a triangular mesh to approximate the solution to a PDE
numerically. You can avoid loss in accuracy by taking a sufficiently fine polygonal
approximation to the geometry. The pdearcl function maps between parametrization and
arc length in a form well suited to a geometry function. Write the following geometry
function for the cardioid.

function [x,y] = cardioid1(bs,s)
% CARDIOID1 Geometry file defining the geometry of a cardioid.

if nargin == 0
  x = 4; % four segments in boundary
  return
end

if nargin == 1
  dl = [0    pi/2   pi       3*pi/2
        pi/2   pi     3*pi/2   2*pi
        1      1      1        1
        0      0      0        0];
  x = dl(:,bs);
  return
end

x = zeros(size(s));
y = zeros(size(s));
if numel(bs) == 1 % bs might need scalar expansion
  bs = bs*ones(size(s)); % expand bs
end

nth = 400; % fine polygon, 100 segments per quadrant
th = linspace(0,2*pi,nth); % parametrization
r = 2*(1 + cos(th));
xt = r.*cos(th); % Points for interpolation of arc lengths
yt = r.*sin(th);
% Compute parameters corresponding to the arc length values in s
th = pdearcl(th,[xt;yt],s,0,2*pi); % th contains the parameters
% Now compute x and y for the parameters th
r = 2*(1 + cos(th));
x(:) = r.*cos(th);
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y(:) = r.*sin(th);
end

Plot the geometry function.

pdegplot('cardioid1','EdgeLabels','on')
axis equal

With 400 line segments, the geometry looks smooth.

The built-in cardg function gives a slightly different version of this technique.
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Integral for Arc Length

You can write an integral for the arc length of a curve. If the parametrization is in terms
of  and , then the arc length  is

For a given value , you can find  as the root of the equation . The fzero
function solves this type of nonlinear equation.

Write the following geometry function for the cardioid example.

function [x,y] = cardioid2(bs,s)
% CARDIOID2 Geometry file defining the geometry of a cardioid.

if nargin == 0
  x = 4; % four segments in boundary
  return
end

if nargin == 1
  dl = [0    pi/2   pi       3*pi/2
        pi/2   pi     3*pi/2   2*pi
        1      1      1        1
        0      0      0        0];
  x = dl(:,bs);
  return
end

x = zeros(size(s));
y = zeros(size(s));
if numel(bs) == 1 % bs might need scalar expansion
  bs = bs*ones(size(s)); % expand bs
end

cbs = find(bs < 3); % upper half of cardioid
fun = @(ss)integral(@(t)sqrt(4*(1 + cos(t)).^2 + 4*sin(t).^2),0,ss);
sscale  = fun(pi);
for ii = cbs(:)' % ensure a row vector
    myfun = @(rr)fun(rr)-s(ii)*sscale/pi;
    theta = fzero(myfun,[0,pi]);
    r = 2*(1 + cos(theta));
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    x(ii) = r*cos(theta);
    y(ii) = r*sin(theta);
end
cbs = find(bs >= 3); % lower half of cardioid
s(cbs) = 2*pi - s(cbs);
for ii = cbs(:)'
    theta = fzero(@(rr)fun(rr)-s(ii)*sscale/pi,[0,pi]);
    r = 2*(1 + cos(theta));
    x(ii) = r*cos(theta);
    y(ii) = -r*sin(theta);
end
end

Plot the geometry function displaying the edge labels.

pdegplot('cardioid2','EdgeLabels','on')
axis equal
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The geometry looks identical to the polygonal approximation. This integral version takes
much longer to calculate than the polygonal version.

Analytic Arc Length

You also can find an analytic expression for the arc length as a function of the
parametrization. Then you can give the parametrization in terms of arc length. For
example, find an analytic expression for the arc length by using Symbolic Math Toolbox™.

syms t real
r = 2*(1+cos(t));
x = r*cos(t);
y = r*sin(t);
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arcl = simplify(sqrt(diff(x)^2+diff(y)^2));
s = int(arcl,t,0,t,'IgnoreAnalyticConstraints',true)

 
s =
 
8*sin(t/2)
 

In terms of the arc length s, the parameter t is t = 2*asin(s/8), where s ranges from
0 to 8, corresponding to t ranging from 0 to . For s between 8 and 16, by symmetry of
the cardioid, t = pi + 2*asin((16-s)/8). Furthermore, you can express x and y in
terms of s by these analytic calculations.

syms s real
th = 2*asin(s/8);
r = 2*(1 + cos(th));
r = expand(r)

 
r =
 
4 - s^2/16
 

x = r*cos(th);
x = simplify(expand(x))

 
x =
 
s^4/512 - (3*s^2)/16 + 4
 

y = r*sin(th);
y = simplify(expand(y))

 
y =
 
(s*(64 - s^2)^(3/2))/512
 

Now that you have analytic expressions for x and y in terms of the arc length s, write the
geometry function.
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function [x,y] = cardioid3(bs,s)
% CARDIOID3 Geometry file defining the geometry of a cardioid.

if nargin == 0
  x = 4; % four segments in boundary
  return
end

if nargin == 1
dl = [0   4   8  12
      4   8  12  16
      1   1   1   1
      0   0   0   0];
  x = dl(:,bs);
  return
end

x = zeros(size(s));
y = zeros(size(s));
if numel(bs) == 1 % bs might need scalar expansion
  bs = bs*ones(size(s)); % expand bs
end

cbs = find(bs < 3); % upper half of cardioid
x(cbs) = s(cbs).^4/512 - 3*s(cbs).^2/16 + 4;
y(cbs) = s(cbs).*(64 - s(cbs).^2).^(3/2)/512;
cbs = find(bs >= 3); % lower half
s(cbs) = 16 - s(cbs); % take the reflection
x(cbs) = s(cbs).^4/512 - 3*s(cbs).^2/16 + 4;
y(cbs) = -s(cbs).*(64 - s(cbs).^2).^(3/2)/512; % negate y
end

Plot the geometry function displaying the edge labels.

pdegplot('cardioid3','EdgeLabels','on')
axis equal
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This analytic geometry looks slightly smoother than the previous versions. However, the
difference is inconsequential in terms of calculations.

Geometry Not Proportional to Arc Length

You also can write a geometry function where the parameter is not proportional to the arc
length. This approach can yield a distorted mesh.

function [x,y] = cardioid4(bs,s)
% CARDIOID4 Geometry file defining the geometry of a cardioid.

if nargin == 0
  x = 4; % four segments in boundary
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  return
end

if nargin == 1
  dl = [0    pi/2   pi       3*pi/2
        pi/2   pi     3*pi/2   2*pi
        1      1      1        1
        0      0      0        0];
  x = dl(:,bs);
  return
end

r = 2*(1 + cos(s)); % s is not proportional to arc length
x = r.*cos(s);
y = r.*sin(s);
end

Plot the geometry function displaying the edge labels.

pdegplot('cardioid4','EdgeLabels','on')
axis equal
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The labels are not evenly spaced on the edges because the parameter is not proportional
to the arc length.

Examine the default mesh for each of the four methods of creating a geometry.

subplot(2,2,1)
model = createpde;
geometryFromEdges(model,@cardioid1);
generateMesh(model);
pdeplot(model)
title('Polygons')
axis equal

subplot(2,2,2)
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model = createpde;
geometryFromEdges(model,@cardioid2);
generateMesh(model);
pdeplot(model)
title('Integral')
axis equal

subplot(2,2,3)
model = createpde;
geometryFromEdges(model,@cardioid3);
generateMesh(model);
pdeplot(model)
title('Analytic')
axis equal

subplot(2,2,4)
model = createpde;
geometryFromEdges(model,@cardioid4);
generateMesh(model);
pdeplot(model)
title('Distorted')
axis equal
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The distorted mesh looks a bit less regular than the other meshes. It has some very
narrow triangles near the cusp of the cardioid. Nevertheless, all of the meshes appear to
be usable.

Geometry Function Example with Subdomains and a Hole
This example shows how to create a geometry file for a region with subdomains and a
hole. It uses the "Analytic Arc Length" section of the "Arc Length Calculations for a
Geometry Function" example and a variant of the circle function from "Geometry
Function for a Circle". The geometry consists of an outer cardioid that is divided into an
upper half called subdomain 1 and a lower half called subdomain 2. Also, the lower half
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has a circular hole centered at (1,-1) and of radius 1/2. The following is the code of the
geometry function.

function [x,y] = cardg3(bs,s) 
% CARDG3 Geometry File defining the geometry of a cardioid with two
% subregions and a hole.
if nargin == 0  
  x = 9; % 9 segments
  return 
end
if nargin == 1
   % Outer cardioid
    dl = [0   4   8  12
          4   8  12  16
          1   1   2   2 % Region 1 to the left in the upper half, 2 in the lower
          0   0   0   0];
    % Dividing line between top and bottom
    dl2 = [0
        4
        1 % Region 1 to the left
        2]; % Region 2 to the right
    % Inner circular hole
    dl3 = [0      pi/2   pi       3*pi/2
           pi/2   pi     3*pi/2   2*pi
           0      0      0        0 % To the left is empty
           2      2      2        2]; % To the right is region 2
    % Combine the three edge matrices
    dl = [dl,dl2,dl3];
    x = dl(:,bs);   
    return 
end 
x = zeros(size(s)); 
y = zeros(size(s)); 
if numel(bs) == 1 % Does bs need scalar expansion?
    bs = bs*ones(size(s)); % Expand bs
end
cbs = find(bs < 3); % Upper half of cardioid
x(cbs) = s(cbs).^4/512 - 3*s(cbs).^2/16 + 4;
y(cbs) = s(cbs).*(64 - s(cbs).^2).^(3/2)/512;
cbs = find(bs >= 3 & bs <= 4); % Lower half of cardioid
s(cbs) = 16 - s(cbs);
x(cbs) = s(cbs).^4/512 - 3*s(cbs).^2/16 + 4;
y(cbs) = -s(cbs).*(64 - s(cbs).^2).^(3/2)/512;
cbs = find(bs == 5); % Index of straight line
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x(cbs) = s(cbs);
y(cbs) = zeros(size(cbs));
cbs = find(bs > 5); % Inner circle radius 0.25 center (1,-1)
x(cbs) = 1 + 0.25*cos(s(cbs));
y(cbs) = -1 + 0.25*sin(s(cbs));
end

Plot the geometry, including edge labels and subdomain labels.

pdegplot(@cardg3,'EdgeLabels','on','FaceLabels','on')
axis equal
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Nested Function for Geometry with Additional Parameters
This example shows how to include additional parameters into a function for creating a 2-
D geometry.

When a 2-D geometry function requires additional parameters, you cannot use a standard
anonymous function approach because geometry functions return a varying number of
arguments. Instead, you can use global variables or nested functions. In most cases, the
recommended approach is to use nested functions.

The example solves a Poisson's equation with zero Dirichlet boundary conditions on all
boundaries. The geometry is a cardioid with an elliptic hole that has a center at (1,-1) and
variable semiaxes. To set up and solve the PDE model with this geometry, use a nested
function. Here, the parent function accepts the lengths of the semiaxes, rr and ss, as
input parameters. The reason to nest cardioidWithEllipseGeom within
cardioidWithEllipseModel is that nested functions share the workspace of their
parent functions. Therefore, the cardioidWithEllipseGeom function can access the
values of rr and ss that you pass to cardioidWithEllipseModel.

function cardioidWithEllipseModel(rr,ss)

if (rr > 0) & (ss > 0)
  model = createpde();
  geometryFromEdges(model,@cardioidWithEllipseGeom);
  pdegplot(model,'EdgeLabels','on','FaceLabels','on')
  axis equal

  applyBoundaryCondition(model,'dirichlet','Edge',1:8,'u',0);
  specifyCoefficients(model,'m',0,'d',0,'c',1,'a',0,'f',1);

  generateMesh(model);
  u = solvepde(model);
  figure
  pdeplot(model,'XYData',u.NodalSolution)
  axis equal

else
    display('Semiaxes values must be positive numbers.')
end

function [x,y] = cardioidWithEllipseGeom(bs,s)

if nargin == 0
 x = 8; % eight segments in boundary
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 return
end

if nargin == 1
    % Cardioid
    dlc = [ 0   4   8  12
            4   8  12  16
            1   1   1   1
            0   0   0   0];
    % Ellipse
    dle = [0      pi/2   pi       3*pi/2
           pi/2   pi     3*pi/2   2*pi
           0      0      0        0
           1      1      1        1];
    % Combine the edge matrices
    dl = [dlc,dle];
    x = dl(:,bs);
    return
end

x = zeros(size(s));
y = zeros(size(s));
if numel(bs) == 1 % Does bs need scalar expansion?
    bs = bs*ones(size(s)); % Expand bs
end

cbs = find(bs < 3); % Upper half of cardioid
x(cbs) = s(cbs).^4/512 - 3*s(cbs).^2/16 + 4;
y(cbs) = s(cbs).*(64 - s(cbs).^2).^(3/2)/512;
cbs = find(bs >= 3 & bs <= 4); % Lower half of cardioid
s(cbs) = 16 - s(cbs);
x(cbs) = s(cbs).^4/512 - 3*s(cbs).^2/16 + 4;
y(cbs) = -s(cbs).*(64 - s(cbs).^2).^(3/2)/512;
cbs = find(bs > 4); % Inner ellipse center (1,-1) axes rr and ss
x(cbs) = 1 + rr*cos(s(cbs));
y(cbs) = -1 + ss*sin(s(cbs));

end

end

When calling cardioidWithEllipseModel, ensure that the semiaxes values are small
enough, so that the elliptic hole appears entirely within the outer cardioid. Otherwise, the
geometry becomes invalid.
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For example, call the function for the ellipse with the major semiaxis rr = 0.5 and the
minor semiaxis ss = 0.25. This function call returns the following geometry and the
solution.

cardioidWithEllipseModel(0.5,0.25)
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Geometry from polyshape
This example shows how to create a polygonal geometry using the MATLAB polyshape
function. Then use the triangulated representation of the geometry as an input mesh for
the geometryFromMesh function.

Create and plot a polyshape object of a square with a hole.

t = pi/12:pi/12:2*pi;
pgon = polyshape({[-0.5 -0.5 0.5 0.5], 0.25*cos(t)}, ...
                 {[0.5 -0.5 -0.5 0.5], 0.25*sin(t)})

pgon = 
  polyshape with properties:

      Vertices: [29x2 double]
    NumRegions: 1
      NumHoles: 1

plot(pgon)
axis equal
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Create a triangulation representation of this object.

tr = triangulation(pgon);

Create a PDE model.

model = createpde;

With the triangulation data as a mesh, use the geometryFromMesh function to create a
geometry. Plot the geometry.

tnodes = tr.Points';
telements = tr.ConnectivityList';
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geometryFromMesh(model,tnodes,telements);
pdegplot(model)

Plot the mesh.

figure
pdemesh(model)
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Because the triangulation data resulted in a low-quality mesh, generate a new finer mesh
for further analysis.

generateMesh(model)

ans = 
  FEMesh with properties:

             Nodes: [2x1259 double]
          Elements: [6x579 double]
    MaxElementSize: 0.0566
    MinElementSize: 0.0283
     MeshGradation: 1.5000
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    GeometricOrder: 'quadratic'

Plot the mesh.

figure
pdemesh(model)
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STL File Import
This example shows how to add a geometry to your PDE model by importing an STL file,
and then plot the geometry. Generally, you create the STL file by exporting from a CAD
system, such as SolidWorks®. For best results, export a fine (not coarse) STL file in
binary (not ASCII) format. After importing, view the geometry using the pdegplot
function. To see the face IDs, set the FaceLabels name-value pair to 'on'.

View the geometry examples included with Partial Differential Equation Toolbox™.

model = createpde;
importGeometry(model,'Torus.stl');
pdegplot(model,'FaceLabels','on')
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model = createpde;
importGeometry(model,'Block.stl');
pdegplot(model,'FaceLabels','on')

model = createpde;
importGeometry(model,'Plate10x10x1.stl');
pdegplot(model,'FaceLabels','on')
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model = createpde;
importGeometry(model,'Tetrahedron.stl');
pdegplot(model,'FaceLabels','on')
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model = createpde;
importGeometry(model,'BracketWithHole.stl');
pdegplot(model,'FaceLabels','on')
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model = createpde;
importGeometry(model,'BracketTwoHoles.stl');
pdegplot(model,'FaceLabels','on')
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To see hidden portions of the geometry, rotate the figure using Rotate 3D button

or the view function. You can rotate the angle bracket to obtain the following view.

pdegplot(model,'FaceLabels','on')
view([-24 -19])
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model = createpde;
importGeometry(model,'ForearmLink.stl');
pdegplot(model,'FaceLabels','on');
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pdegplot(model,'FaceLabels','on','FaceAlpha',0.5)
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When you import a planar STL geometry, the toolbox converts it to a 2-D geometry by
mapping it to the X-Y plane.

model = createpde;
importGeometry(model,'PlateHolePlanar.stl');
pdegplot(model,'EdgeLabels','on')
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Geometry from Triangulated Mesh

3-D Geometry from a Finite Element Mesh
This example shows how to import a 3-D mesh into a PDE model. Importing a mesh
creates the corresponding geometry in the model.

The tetmesh file that ships with your software contains a 3-D mesh. Load the data into
your Workspace.

load tetmesh

Examine the node and element sizes.

size(tet)

ans = 1×2

        4969           4

size(X)

ans = 1×2

        1456           3

The data is transposed from the required form as described in geometryFromMesh.

Create data matrices of the appropriate sizes.

nodes = X';
elements = tet';

Create a PDE model and import the mesh.

model = createpde();
geometryFromMesh(model,nodes,elements);

The model contains the imported mesh.

model.Mesh
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ans = 
  FEMesh with properties:

             Nodes: [3x1456 double]
          Elements: [4x4969 double]
    MaxElementSize: 8.2971
    MinElementSize: 1.9044
     MeshGradation: []
    GeometricOrder: 'linear'

View the geometry and face numbers.

pdegplot(model,'FaceLabels','on','FaceAlpha',0.5)
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2-D Multidomain Geometry
Create a 2-D multidomain geometry from a mesh.

Load information about nodes, elements, and element-to-domain correspondence into
your workspace. The file MultidomainMesh2D ships with your software.

load MultidomainMesh2D

Create a PDE model.

model = createpde;

Import the mesh into the model.

geometryFromMesh(model,nodes,elements,ElementIdToRegionId);

View the geometry and face numbers.

pdegplot(model,'FaceLabels','on')
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Geometry from alphaShape
Create a 3-D geometry using the MATLAB alphaShape function. First, create an
alphaShape object of a block with a cylindrical hole. Then import the geometry into a PDE
model from the alphaShape boundary.

Create a 2-D mesh grid.

[xg, yg] = meshgrid(-3:0.25:3);
xg = xg(:);
yg = yg(:);

Create a unit disk. Remove all the mesh grid points that fall inside the unit disk, and
include the unit disk points.

t = (pi/24:pi/24:2*pi)';
x = cos(t);
y = sin(t);
circShp = alphaShape(x,y,2);
in = inShape(circShp,xg,yg);
xg = [xg(~in); cos(t)];
yg = [yg(~in); sin(t)];

Create 3-D copies of the remaining mesh grid points, with the z-coordinates ranging from
0 through 1. Combine the points into an alphaShape object.

zg = ones(numel(xg),1);
xg = repmat(xg,5,1);
yg = repmat(yg,5,1);
zg = zg*(0:.25:1);
zg = zg(:);
shp = alphaShape(xg,yg,zg);

Obtain a surface mesh of the alphaShape object.

[elements,nodes] = boundaryFacets(shp);

Put the data in the correct shape for geometryFromMesh.

nodes = nodes';
elements = elements';

Create a PDE model and import the surface mesh.
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model = createpde();
geometryFromMesh(model,nodes,elements);

View the geometry and face numbers.

pdegplot(model,'FaceLabels','on','FaceAlpha',0.5)

To use the geometry in an analysis, create a volume mesh.

generateMesh(model);
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Cuboids, Cylinders, and Spheres
Create 3-D geometries formed by one or more cubic, cylindrical, and spherical cells by
using the multicuboid, multicylinder, and multisphere functions, respectively.
With these functions, you can create stacked or nested geometries. You also can create
geometries where some cells are empty; for example, hollow cylinders, cubes, or spheres.

All cells in a geometry must be of the same type: either cuboids, or cylinders, or spheres.
These functions do not combine cells of different types in one geometry.

Single Sphere
Create a geometry that consists of a single sphere and include this geometry in a PDE
model.

Use the multisphere function to create a single sphere. The resulting geometry consists
of one cell.

gm = multisphere(5)

gm = 
  DiscreteGeometry with properties:

       NumCells: 1
       NumFaces: 1
       NumEdges: 0
    NumVertices: 0

Create a PDE model.

model = createpde

model = 
  PDEModel with properties:

           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: []
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
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           SolverOptions: [1x1 PDESolverOptions]

Include the geometry in the model.

model.Geometry = gm

model = 
  PDEModel with properties:

           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: [1x1 DiscreteGeometry]
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Plot the geometry.

pdegplot(model,'CellLabels','on')
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Nested Cuboids of Same Height
Create a geometry that consists of three nested cuboids of the same height and include
this geometry in a PDE model.

Create the geometry by using the multicuboid function. The resulting geometry
consists of three cells.

gm = multicuboid([2 3 5],[4 6 10],3)

gm = 
  DiscreteGeometry with properties:
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       NumCells: 3
       NumFaces: 18
       NumEdges: 36
    NumVertices: 24

Create a PDE model.

model = createpde

model = 
  PDEModel with properties:

           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: []
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Include the geometry in the model.

model.Geometry = gm

model = 
  PDEModel with properties:

           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: [1x1 DiscreteGeometry]
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Plot the geometry.

pdegplot(model,'CellLabels','on','FaceAlpha',0.5)
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Stacked Cylinders
Create a geometry that consists of three stacked cylinders and include this geometry in a
PDE model.

Create the geometry by using the multicylinder function with the ZOffset argument.
The resulting geometry consists of four cells stacked on top of each other.

gm = multicylinder(10,[1 2 3 4],'ZOffset',[0 1 3 6])

gm = 
  DiscreteGeometry with properties:
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       NumCells: 4
       NumFaces: 9
       NumEdges: 5
    NumVertices: 5

Create a PDE model.

model = createpde

model = 
  PDEModel with properties:

           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: []
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Include the geometry in the model.

model.Geometry = gm

model = 
  PDEModel with properties:

           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: [1x1 DiscreteGeometry]
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Plot the geometry.

pdegplot(model,'CellLabels','on','FaceAlpha',0.5)
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Hollow Cylinder
Create a hollow cylinder and include it as a geometry in a PDE model.

Create a hollow cylinder by using the multicylinder function with the Void argument.
The resulting geometry consists of one cell.

gm = multicylinder([9 10],10,'Void',[true,false])

gm = 
  DiscreteGeometry with properties:

       NumCells: 1
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       NumFaces: 4
       NumEdges: 4
    NumVertices: 4

Create a PDE model.

model = createpde

model = 
  PDEModel with properties:

           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: []
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Include the geometry in the model.

model.Geometry = gm

model = 
  PDEModel with properties:

           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: [1x1 DiscreteGeometry]
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Plot the geometry.

pdegplot(model,'CellLabels','on','FaceAlpha',0.5)
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Put Equations in Divergence Form
In this section...
“Coefficient Matching for Divergence Form” on page 2-71
“Boundary Conditions Can Affect the c Coefficient” on page 2-72
“Some Equations Cannot Be Converted” on page 2-73

Coefficient Matching for Divergence Form
As explained in “Equations You Can Solve Using PDE Toolbox” on page 1-6, Partial
Differential Equation Toolbox solvers address equations of the form

−∇ ⋅ c∇u + au = f

or variants that have derivatives with respect to time, or that have eigenvalues, or are
systems of equations. These equations are in divergence form, where the differential
operator begins ∇ ·. The coefficients a, c, and f are functions of position (x, y, z) and
possibly of the solution u.

However, you can have equations in a form with all the derivatives explicitly expanded,
such as

1 + x2 ∂2u
∂x2 − 3xy ∂

2u
∂x∂y +

1 + y2

2
∂2u
∂y2 = 0

In order to transform this expanded equation into toolbox format, you can try to match
the coefficients of the equation in divergence form to the expanded form. In divergence
form, if

c =
c1 c3
c2 c4

then

∇ · c∇u = c1uxx + c2 + c3 uxy + c4uyy

+
∂c1
∂x +

∂c2
∂y ux +

∂c3
∂x +

∂c4
∂y uy
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Matching coefficients in the uxx and uyy terms in −∇ ⋅ c∇u  to the equation, you get

c1 = − 1 + x2

c4 = − 1 + y2 /2

Then looking at the coefficients of ux and uy, which should be zero, you get

∂c1
∂x +

∂c2
∂y = − 2x +

∂c2
∂y

so
c2 = 2xy .
∂c3
∂x +

∂c4
∂y =

∂c3
∂x − y

so
c3 = xy

This completes the conversion of the equation to the divergence form

−∇ ⋅ c∇u = 0

Boundary Conditions Can Affect the c Coefficient
The c coefficient appears in the generalized Neumann condition

n · c∇u + qu = g

So when you derive a divergence form of the c coefficient, keep in mind that this
coefficient appears elsewhere.

For example, consider the 2-D Poisson equation –uxx – uyy = f. Obviously, you can take
c = 1. But there are other c matrices that lead to the same equation: any that have
c(2) + c(3) = 0.

∇ · c∇u = ∇ ·
c1 c3
c2 c4

ux
uy

= ∂
∂x c1ux + c3uy + ∂

∂y c2ux + c4uy

= c1uxx + c4uyy + c2 + c3 uxy
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So there is freedom in choosing a c matrix. If you have a Neumann boundary condition
such as

n · c∇u = 2

the boundary condition depends on which version of c you use. In this case, make sure
that you take a version of c that is compatible with both the equation and the boundary
condition.

Some Equations Cannot Be Converted
Sometimes it is not possible to find a conversion to a divergence form such as

−∇ ⋅ c∇u + au = f

For example, consider the equation

∂2u
∂x2 + cos(x + y)

4
∂2u
∂x∂y + 1

2
∂2u
∂y2 = 0

By simple coefficient matching, you see that the coefficients c1 and c4 are –1 and –1/2
respectively. However, there are no c2 and c3 that satisfy the remaining equations,

c2 + c3 = −cos(x + y)
4

∂c1
∂x +

∂c2
∂y =

∂c2
∂y = 0

∂c3
∂x +

∂c4
∂y =

∂c3
∂x = 0

See Also

Related Examples
• “Equations You Can Solve Using PDE Toolbox” on page 1-6
• “Solve Problems Using PDEModel Objects” on page 2-6
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Specify Scalar PDE Coefficients in Character Form

Note THIS PAGE DESCRIBES THE LEGACY WORKFLOW. New features might not be
compatible with the legacy workflow. For the corresponding step in the recommended
workflow, see the recommended examples on the “PDE Coefficients” page.

Write a text expression using these conventions:

• 'x' — x-coordinate
• 'y' — y-coordinate
• 'z' — z-coordinate (3-D geometry)
• 'u' — Solution of equation
• 'ux' — Derivative of u in the x-direction
• 'uy' — Derivative of u in the y-direction
• 'uz' — Derivative of u in the z-direction (3-D geometry)
• 't' — Time (parabolic and hyperbolic equations)
• 'sd' — Subdomain number (not used in 3-D geometry)

For example, you could use this vector of characters to represent a coefficient:

'(x + y)./(x.^2 + y.^2 + 1) + 3 + sin(t)./(1 + u.^4)'

Note Use .*, ./, and .^ for multiplication, division, and exponentiation operations. The
text expressions operate on row vectors, so the operations must make sense for row
vectors. For 2-D geometry, the row vectors are the values at the triangle centroids in the
mesh.

You can write MATLAB functions for coefficients as well as plain text expressions. For
example, suppose your coefficient f is given by the file fcoeff.m:

function f = fcoeff(x,y,t,sd)

f = (x.*y)./(1 + x.^2 + y.^2); % f on subdomain 1
f = f + log(1 + t); % include time
r = (sd == 2); % subdomain 2
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f2 = cos(x + y); % coefficient on subdomain 2 
f(r) = f2(r); % f on subdomain 2

Represent this function in the parabolic solver, for example:

u1 = parabolic(u0,tlist,b,p,e,t,c,a,'fcoeff(x,y,t,sd)',d)

Caution In function form, t represents triangles, and time represents time. In character
form, t represents time, and triangles do not enter into the form.

There is a simple way to write a text expression for multiple subdomains without using
'sd' or a function. Separate the formulas for the different subdomains with the '!'
character. Generally use the same number of expressions as subdomains. However, if an
expression does not depend on the subdomain number, you can give just one expression.

For example, an expression for an input (a, c, f, or d) with three subdomains:

'2 + tanh(x.*y)!cosh(x)./(1 + x.^2 + y.^2)!x.^2 + y.^2'

The coefficient c is a 2-by-2 matrix. You can give c in any of the following forms:

• Scalar or single vector of characters — The software interprets c as a diagonal matrix:

c 0
0 c

• Two-element column vector or two-row text array — The software interprets c as a
diagonal matrix:

c(1) 0
0 c(2)

• Three-element column vector or three-row text array — The software interprets c as a
symmetric matrix:

c(1) c(2)
c(2) c(3)

• Four-element column vector or four-row text array — The software interprets c as a
full matrix:

c(1) c(3)
c(2) c(4)
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For example, c as a symmetric matrix with cos(xy) on the off-diagonal terms:

c = char('x.^2+y.^2',...
    'cos(x.*y)',...
    'u./(1+x.^2+y.^2)')

To include subdomains separated by '!', include the '!' in each row. For example,

c = char('1 + x.^2 + y.^2!x.^2 + y.^2',...
    'cos(x.*y)!sin(x.*y)',...
    'u./(1 + x.^2 + y.^2)!u.*(x.^2 + y.^2)')

Caution Do not use spaces when specifying coefficients in the PDE Modeler app. The
parser can misinterpret a space as a vector separator, as when a MATLAB vector uses a
space to separate elements of a vector.

For elliptic problems, when you include 'u', 'ux', 'uy', or 'uz', you must use the
pdenonlin solver instead of assempde. In the PDE Modeler app, select Solve >
Parameters > Use nonlinear solver.
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Coefficients for Scalar PDEs in PDE Modeler App
To enter coefficients for your PDE, select PDE > PDE Specification.

Enter text expressions using these conventions:

• x — x-coordinate
• y — y-coordinate
• u — Solution of equation
• ux — Derivative of u in the x-direction
• uy — Derivative of u in the y-direction
• t — Time (parabolic and hyperbolic equations)
• sd — Subdomain number

For example, you could use this expression to represent a coefficient:

(x + y)./(x.^2 + y.^2 + 1) + 3 + sin(t)./(1 + u.^4)

For elliptic problems, when you include u, ux, or uy, you must use the nonlinear solver.
Select Solve > Parameters > Use nonlinear solver.

Note
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• Do not use quotes or unnecessary spaces in your entries. The parser can misinterpret
a space as a vector separator, as when a MATLAB vector uses a space to separate
elements of a vector.

• Use .*, ./, and .^ for multiplication, division, and exponentiation operations. The text
expressions operate on row vectors, so the operations must make sense for row
vectors. The row vectors are the values at the triangle centroids in the mesh.

You can write MATLAB functions for coefficients as well as plain text expressions. For
example, suppose your coefficient f is given by the file fcoeff.m.

function f = fcoeff(x,y,t,sd)

f = (x.*y)./(1 + x.^2 + y.^2); % f on subdomain 1
f = f + log(1 + t); % include time
r = (sd == 2); % subdomain 2
f2 = cos(x + y); % coefficient on subdomain 2 
f(r) = f2(r); % f on subdomain 2

Use fcoeff(x,y,t,sd) as the f coefficient in the parabolic solver.

The coefficient c is a 2-by-2 matrix. You can give 1-, 2-, 3-, or 4-element matrix
expressions. Separate the expressions for elements by spaces. These expressions mean:

•
1-element expression: 

c 0
0 c

•
2-element expression: 

c(1) 0
0 c(2)
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•
3-element expression: 

c(1) c(2)
c(2) c(3)

•
4-element expression: 

c(1) c(3)
c(2) c(4)

For example, c is a symmetric matrix with constant diagonal entries and cos(xy) as the
off-diagonal terms:

1.1 cos(x.*y) 5.5

This corresponds to coefficients for the parabolic equation

∂u
∂t − ∇ ·

1.1 cos(xy)
cos(xy) 5.5

∇u = 10.
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Specify 2-D Scalar Coefficients in Function Form

Note THIS PAGE DESCRIBES THE LEGACY WORKFLOW. New features might not be
compatible with the legacy workflow. For the corresponding step in the recommended
workflow, see the recommended examples on the “PDE Coefficients” page.

Coefficients as the Result of a Program
Usually, the simplest way to give coefficients as the result of a program is to use a
character expression as described in “Specify Scalar PDE Coefficients in Character Form”
on page 2-74. For the most detailed control over coefficients, though, you can write a
function form of coefficients.

A coefficient in function form for 2-D geometry has the syntax

coeff = coeffunction(p,t,u,time)

coeff represents any coefficient: c, a, f, or d.

Your program evaluates the return coeff as a row vector of the function values at the
centroids of the triangles t. For help calculating these values, see “Calculate Coefficients
in Function Form” on page 2-81.

• p and t are the node points and triangles of the mesh. For a description of these data
structures, see “Mesh Data” on page 2-233. In brief, each column of p contains the x-
and y-values of a point, and each column of t contains the indices of three points in p
and the subdomain label of that triangle.

• u is a row vector containing the solution at the points p. u is [] if the coefficients do
not depend on the solution or its derivatives.

• time is the time of the solution, a scalar. time is [] if the coefficients do not depend
on time.

Caution In function form, t represents triangles, and time represents time. In character
form, t represents time, and triangles do not enter into the form.
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Pass the coefficient function to the solver as 'coeffunction' or as a function handle
@coeffunction. In the PDE Modeler app, pass the coefficient as coeffunction
without quotes, because the PDE Modeler app interprets all entries as characters.

If your coefficients depend on u or time, then when u or time are NaN, ensure that the
corresponding coeff consist of a vector of NaN of the correct size. This signals to solvers,
such as parabolic, to use a time-dependent or solution-dependent algorithm.

For elliptic problems, if any coefficient depends on u or its gradient, you must use the
pdenonlin solver instead of assempde. In the PDE Modeler app, select Solve >
Parameters > Use nonlinear solver.

Calculate Coefficients in Function Form
X- and Y-Values

The x- and y-values of the centroid of a triangle t are the mean values of the entries of the
points p in t. To get row vectors xpts and ypts containing the mean values:

% Triangle point indices
it1 = t(1,:);
it2 = t(2,:);
it3 = t(3,:);

% Find centroids of triangles
xpts = (p(1,it1) + p(1,it2) + p(1,it3))/3;
ypts = (p(2,it1) + p(2,it2) + p(2,it3))/3;

Interpolated u

The pdeintrp function linearly interpolates the values of u at the centroids of t, based
on the values at the points p.

uintrp = pdeintrp(p,t,u); % Interpolated values at centroids

The output uintrp is a row vector with the same number of columns as t. Use uintrp
as the solution value in your coefficient calculations.

Gradient or Derivatives of u

The pdegrad function approximates the gradient of u.

[ux,uy] = pdegrad(p,t,u); % Approximate derivatives
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The outputs ux and uy are row vectors with the same number of columns as t.

Subdomains

If your coefficients depend on the subdomain label, check the subdomain number for each
triangle. Subdomains are the last (fourth) row of the triangle matrix. So the row vector of
subdomain numbers is:

subd = t(4,:);

You can see the subdomain labels by using the pdegplot function with the
SubdomainLabels name-value pair set to 'on':

pdegplot(g,'SubdomainLabels','on')

2 Setting Up Your PDE

2-82



Specify 3-D PDE Coefficients in Function Form

Note THIS PAGE DESCRIBES THE LEGACY WORKFLOW. New features might not be
compatible with the legacy workflow. For the corresponding step in the recommended
workflow, see the recommended examples on the “PDE Coefficients” page.

Usually, the simplest way to give coefficients as the result of a program is to use a
character expression. For this approach, see “Specify Scalar PDE Coefficients in
Character Form” on page 2-74. For more detailed control over coefficients, though, you
can write coefficients in function form.

A coefficient in function form for 3-D geometry uses this syntax:

coeff = myfun(location,state)

coeff represents any coefficient: c, a, f, or d. Partial Differential Equation Toolbox
solvers pass the location and state data to your function.

• location is a structure with these fields:

• location.x
• location.y
• location.z

The fields represent the x-, y-, and z- coordinates of points for which your function
calculates coefficient values. The location fields are row vectors.

• state is a structure with these fields:

• state.u
• state.ux
• state.uy
• state.uz
• state.t

The state.u field represents the current value of the solution u. The state.ux,
state.uy, and state.uz fields are estimates of the solution’s partial derivatives
(∂u/∂x, ∂u/∂y, and ∂u/∂z) at the corresponding points of the location structure. The
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solution and gradient estimates are row vectors. The state.t field is a scalar
representing time for the parabolic and hyperbolic solvers.

The coeff output of your function is an NC-by-M matrix, where

• NC is the length of a coefficient column vector.

• f — NC is the same as the number of equations, N.
• a or d — NC can be 1, N, N(N+1)/2, or N2 (see “a or d Coefficient for Systems” on

page 2-147).
• c — NC can have many different values in the range 1 to 9N2 (see “c Coefficient for

Systems” on page 2-122).
• M is the length of any of the location fields. This is also the length of the state.u
fields.

Your function must compute in a vectorized fashion. In other words, it must return the
matrix of values for every point in location. For example, in an N = 1 problem where
the f coefficient is 1 + x2, one possible function is:

function fcoeff = ffunction(location,state)

fcoeff = 1 + location.x.^2;

To pass this coefficient to the parabolic solver, set the coefficient to @ffunction. For
example:

f = @ffunction;
% Assume the other inputs are defined
u = parabolic(u0,tlist,model,c,a,f,d);

If you need a constant value, use the size of location.x as the number of columns of the
matrix. For an N = 3 problem:

function fcoeff = ffunction(location,state)

fcoeff = ones(3,length(location.x));
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Solve PDE with Coefficients in Functional Form

Note THIS PAGE DESCRIBES THE LEGACY WORKFLOW. New features might not be
compatible with the legacy workflow. For the corresponding step in the recommended
workflow, see the recommended examples on the “PDE Coefficients” page.

This example shows how to write PDE coefficients in character form and in functional
form for 2-D geometry.

Geometry
The geometry is a rectangle with a circular hole. Create a PDE model container, and
incorporate the geometry into the container.

model = createpde(1);

% Rectangle is code 3, 4 sides,
% followed by x-coordinates and then y-coordinates
R1 = [3,4,-1,1,1,-1,-.4,-.4,.4,.4]';
% Circle is code 1, center (.5,0), radius .2
C1 = [1,.5,0,.2]';
% Pad C1 with zeros to enable concatenation with R1
C1 = [C1;zeros(length(R1)-length(C1),1)];
geom = [R1,C1];
% Names for the two geometric objects
ns = (char('R1','C1'))';
% Set formula
sf = 'R1 - C1';
% Create geometry
gd = decsg(geom,sf,ns);

% Include the geometry in the model
geometryFromEdges(model,gd);
% View geometry
pdegplot(model,'EdgeLabels','on')
xlim([-1.1 1.1])
axis equal

 Solve PDE with Coefficients in Functional Form

2-85



PDE Coefficients
The PDE is parabolic,

with the following coefficients:

• d = 5
• a = 0
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• f is a linear ramp up to 10, holds at 10, then ramps back down to 0:

•

Write a function for the f coefficient. function f = framp(t)

if t <= 0.1
    f = 10*t;
elseif t <= 0.9
    f = 1;
else
    f = 10-10*t;
end
f = 10*f;
end

Boundary Conditions
The boundary conditions on the outer boundary (segments 1 through 4) are Dirichlet,
with the value , where  is time. Suppose the circular boundary
(segments 5 through 8) has a generalized Neumann condition, with  and

.

myufun = @(region,state)state.time*(region.x - region.y);
mygfun = @(region,state)(region.x.^2 + region.y.^2);
applyBoundaryCondition(model,'edge',1:4,'u',myufun,'Vectorized','on');
applyBoundaryCondition(model,'edge',5:8,'q',1,'g',mygfun,'Vectorized','on');

The boundary conditions are the same as in “Boundary Conditions for Scalar PDE” on
page 2-197. That description uses the older function form for specifying boundary
conditions, which is no longer recommended. This description uses the recommended
object form.

Initial Conditions

The initial condition is  at $ t = 0$.
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u0 = 0;

Mesh
Create the mesh.

generateMesh(model,'GeometricOrder','linear');

Parabolic Solution Times
Set the time steps for the parabolic solver to 50 steps from time 0 to time 1.

tlist = linspace(0,1,50);

Solution
Solve the parabolic PDE.

d = 5;
a = 0;
f = 'framp(t)';
c = '1 + x.^2 + y.^2';
u = parabolic(u0,tlist,model,c,a,f,d);

120 successful steps
9 failed attempts
260 function evaluations
1 partial derivatives
35 LU decompositions
259 solutions of linear systems

View an animation of the solution.

for tt = 1:size(u,2) % number of steps
    pdeplot(model,'XYData',u(:,tt),'ZData',u(:,tt),'ColorMap','jet')
    axis([-1 1 -1/2 1/2 -1.5 1.5 -1.5 1.5]) % use fixed axis
    title(['Step ' num2str(tt)])
    view(-45,22)
    drawnow
    pause(.1)
end
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Alternative Coefficient Syntax
Equivalently, you can write a function for the coefficient f in the syntax described in
“Specify 2-D Scalar Coefficients in Function Form” on page 2-80.

function f = framp2(p,t,u,time)

if time <= 0.1
    f = 10*time;
elseif time <= 0.9
    f = 1;
else
    f = 10 - 10*time;
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end
f = 10*f;
end

Call this function by setting

f = @framp2;
u = parabolic(u0,tlist,model,c,a,f,d);

120 successful steps
9 failed attempts
260 function evaluations
1 partial derivatives
35 LU decompositions
259 solutions of linear systems

You can also write a function for the coefficient c, though it is more complicated than the
character formulation. function c = cfunc(p,t,u,time)

% Triangle point indices
it1 = t(1,:);
it2 = t(2,:);
it3 = t(3,:);

% Find centroids of triangles
xpts = (p(1,it1) + p(1,it2) + p(1,it3))/3;
ypts = (p(2,it1) + p(2,it2) + p(2,it3))/3;

c = 1 + xpts.^2 + ypts.^2;
end

Call this function by setting

c = @cfunc;
u = parabolic(u0,tlist,model,c,a,f,d);

120 successful steps
9 failed attempts
260 function evaluations
1 partial derivatives
35 LU decompositions
259 solutions of linear systems
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Coefficients for Systems of PDEs in the PDE Modeler App
You can enter coefficients for a system with N = 2 equations in the PDE Modeler app. To
do so, open the PDE Modeler app and select Generic System.

Then select PDE > PDE Specification.
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Enter character expressions for coefficients using the form in “Coefficients for Scalar
PDEs in PDE Modeler App” on page 2-77, with additional options for nonlinear equations.
The additional options are:

• Represent the ith component of the solution u using 'u(i)' for i = 1 or 2.
• Similarly, represent the ith components of the gradients of the solution u using

'ux(i)' and 'uy(i)' for i = 1 or 2.

Note For elliptic problems, when you include coefficients u(i), ux(i), or uy(i), you
must use the nonlinear solver. Select Solve > Parameters > Use nonlinear solver.

Do not use quotes or unnecessary spaces in your entries.

For higher-dimensional systems, do not use the PDE Modeler app. Represent your
problem coefficients at the command line.

You can enter scalars into the c matrix, corresponding to these equations:

−∇ · c11∇u1 − ∇ · c12∇u2 + a11u1 + a12u2 = f1
−∇ · c21∇u1 − ∇ · c22∇u2 + a21u1 + a22u2 = f2

If you need matrix versions of any of the cij coefficients, enter expressions separated by
spaces. You can give 1-, 2-, 3-, or 4-element matrix expressions. These mean:

•
1-element expression: 

c 0
0 c

•
2-element expression: 

c(1) 0
0 c(2)

•
3-element expression: 

c(1) c(2)
c(2) c(3)

•
4-element expression: 

c(1) c(3)
c(2) c(4)

For example, these expressions show one of each type (1-, 2-, 3-, and 4-element
expressions)
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These expressions correspond to the equations

−∇ ·
4 + cos(xy) 0

0 4 + cos(xy)
∇u1 − ∇ ·

−1 0
0 1

∇u2 = 1

−∇ ·
.1 .2
.2 .3

∇u1 − ∇ ·
7 .6
.5 exp(x− y)

∇u2 = 2
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f Coefficient for Systems

Note THIS PAGE DESCRIBES THE LEGACY WORKFLOW. New features might not be
compatible with the legacy workflow. For the corresponding step in the recommended
workflow, see “f Coefficient for specifyCoefficients” on page 2-97.

This section describes how to write the coefficient f in the equation

−∇ ⋅ c⊗ ∇u + au = f

or in similar equations. The number of rows in f indicates N, the number of equations,
see “Equations You Can Solve Using Legacy Functions” on page 1-3. Give f as any of the
following:

• A column vector with N components. For example, if N = 3, f could be:

f = [3;4;10];
• A character array with N rows. The rows of the character array are MATLAB

expressions as described in “Specify Scalar PDE Coefficients in Character Form” on
page 2-74, with additional options for nonlinear equations. The additional options are:

• Represent the ith component of the solution u using 'u(i)'.
• Similarly, represent the ith components of the gradients of the solution u using

'ux(i)', 'uy(i)' and 'uz(i)'.

Pad the rows with spaces so each row has the same number of characters (char does
this automatically). For example, if N = 3, f could be:

f = char('sin(x)+cos(y)', ...
         'cosh(x.*y)*(1+u(1).^2)', ...
         'x.*y./(1+x.^2+y.^2)')

f =
sin(x) + cos(y)         
cosh(x.*y)*(1 + u(1).^2)
x.*y./(1 + x.^2 + y.^2)   

• For 2-D geometry, a function as described in “Specify 2-D Scalar Coefficients in
Function Form” on page 2-80. The function should return a matrix of size N-by-Nt,
where Nt is the number of triangles in the mesh. The function should evaluate f at the
triangle centroids, as in “Specify 2-D Scalar Coefficients in Function Form” on page 2-
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80. Give solvers the function name as 'filename', or as a function handle
@filename, where filename.m is a file on your MATLAB path. For details on writing
the function, see “Calculate Coefficients in Function Form” on page 2-81.

For example, if N = 3, f could be:

function f = fcoeffunction(p,t,u,time)

N = 3; % Number of equations
% Triangle point indices
it1 = t(1,:);
it2 = t(2,:);
it3 = t(3,:);

% Find centroids of triangles
xpts = (p(1,it1) + p(1,it2) + p(1,it3))/3;
ypts = (p(2,it1) + p(2,it2) + p(2,it3))/3;

[ux,uy] = pdegrad(p,t,u); % Approximate derivatives
uintrp = pdeintrp(p,t,u); % Interpolated values at centroids

nt = size(t,2); % Number of columns
f = zeros(N,nt); % Allocate f

% Now the particular functional form of f
f(1,:) = xpts - ypts + uintrp(1,:);
f(2,:) = 1 + tanh(ux(1,:)) + tanh(uy(3,:));
f(3,:) = (5 + uintrp(3,:)).*sqrt(xpts.^2 + ypts.^2);

Because this function depends on the solution u, if the equation is elliptic, use the
pdenonlin solver. The initial value can be all 0s in the case of Dirichlet boundary
conditions:

np = size(p,2); % number of points
u0 = zeros(N*np,1); % initial guess

• For 3-D geometry, a function as described in “Specify 3-D PDE Coefficients in Function
Form” on page 2-83. The function should return a matrix of size N-by-Nr, where Nr is
the number of points in the region that the solver passes. The function should evaluate
f at these points. Give solvers the function as a function handle @filename, where
filename.m is a file on your MATLAB path, or is an anonymous function.

Caution It is not reliable to specify f as a scalar or a single vector of characters.
Sometimes the toolbox can expand the single input to a vector or character array with N
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identical rows. But you can get an error when the toolbox fails to determine N. Instead of
a scalar or a single vector of characters, for reliability specify f as a column vector or
character array with N rows.
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f Coefficient for specifyCoefficients
This section describes how to write the coefficient f in the equation

m∂
2u
∂t2 + d∂u∂t − ∇ · c∇u + au = f

or in similar equations. The question is how to write the coefficient f for inclusion in the
PDE model via specifyCoefficients.

N is the number of equations, see “Equations You Can Solve Using PDE Toolbox” on page
1-6. Give f as either of the following:

• If f is constant, give a column vector with N components. For example, if N = 3, f
could be:

f = [3;4;10];
• If f is not constant, give a function handle. The function must be of the form

fcoeffunction(location,state)

solvepde passes the location and state structures to fcoeffunction. The
function must return a matrix of size N-by-Nr, where Nr is the number of points in the
location that solvepde passes. Nr is equal to the length of the location.x or any
other location field. The function should evaluate f at these points.

Pass the coefficient to specifyCoefficients as a function handle, such as

specifyCoefficients(model,'f',@fcoeffunction,...)

• location is a structure with these fields:

• location.x
• location.y
• location.z
• location.subdomain

The fields x, y, and z represent the x-, y-, and z- coordinates of points for which
your function calculates coefficient values. The subdomain field represents the
subdomain numbers, which currently apply only to 2-D models. The location fields
are row vectors.

 f Coefficient for specifyCoefficients

2-97



• state is a structure with these fields:

• state.u
• state.ux
• state.uy
• state.uz
• state.time

The state.u field represents the current value of the solution u. The state.ux,
state.uy, and state.uz fields are estimates of the solution’s partial derivatives
(∂u/∂x, ∂u/∂y, and ∂u/∂z) at the corresponding points of the location structure. The
solution and gradient estimates are N-by-Nr matrices. The state.time field is a
scalar representing time for time-dependent models.

For example, if N = 3, f could be:

function f = fcoeffunction(location,state)

N = 3; % Number of equations
nr = length(location.x); % Number of columns
f = zeros(N,nr); % Allocate f

% Now the particular functional form of f
f(1,:) = location.x - location.y + state.u(1,:);
f(2,:) = 1 + tanh(state.ux(1,:)) + tanh(state.uy(3,:));
f(3,:) = (5 + state.u(3,:)).*sqrt(location.x.^2 + location.y.^2);

This represents the coefficient function

f =
x− y + u(1)

1 + tanh(∂u(1)/ ∂x) + tanh(∂u(3)/ ∂y)

(5 + u(3)) x2 + y2

See Also

Related Examples
• “m, d, or a Coefficient for specifyCoefficients” on page 2-142
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• “c Coefficient for specifyCoefficients” on page 2-100
• “Solve Problems Using PDEModel Objects” on page 2-6
• “Deflection of Piezoelectric Actuator” on page 3-12
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c Coefficient for specifyCoefficients

In this section...
“Overview of the c Coefficient” on page 2-100
“Definition of the c Tensor Elements” on page 2-101
“Some c Vectors Can Be Short” on page 2-104
“Functional Form” on page 2-118

Overview of the c Coefficient
This topic describes how to write the coefficient c in equations such as

m∂
2u
∂t2 + d∂u∂t − ∇ · c∇u + au = f

The topic applies to the recommended workflow for including coefficients in your model
using specifyCoefficients.

For 2-D systems, c is a tensor with 4N2 elements. For 3-D systems, c is a tensor with 9N2

elements. For a definition of the tensor elements, see “Definition of the c Tensor
Elements” on page 2-101. N is the number of equations, see “Equations You Can Solve
Using PDE Toolbox” on page 1-6.

To write the coefficient c for inclusion in the PDE model via specifyCoefficients,
give c as either of the following:

• If c is constant, give a column vector representing the elements in the tensor.
• If c is not constant, give a function handle. The function must be of the form

ccoeffunction(location,state)

solvepde or solvepdeeig pass the location and state structures to
ccoeffunction. The function must return a matrix of size N1-by-Nr, where:

• N1 is the length of the vector representing the c coefficient. There are several
possible values of N1, detailed in “Some c Vectors Can Be Short” on page 2-104.
For 2-D geometry, 1 ≤ N1 ≤ 4N2, and for 3-D geometry, 1 ≤ N1 ≤ 9N2.
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• Nr is the number of points in the location that the solver passes. Nr is equal to the
length of the location.x or any other location field. The function should
evaluate c at these points.

Definition of the c Tensor Elements
For 2-D systems, the notation ∇ ⋅ (c⊗ ∇u) represents an N-by-1 matrix with an (i,1)-
component

∑
j = 1

N ∂
∂x ci, j, 1, 1

∂
∂x + ∂

∂x ci, j, 1, 2
∂
∂y + ∂

∂y ci, j, 2, 1
∂
∂x + ∂

∂y ci, j, 2, 2
∂
∂y u j

For 3-D systems, the notation ∇ ⋅ (c⊗ ∇u) represents an N-by-1 matrix with an (i,1)-
component

∑
j = 1

N ∂
∂x ci, j, 1, 1

∂
∂x + ∂

∂x ci, j, 1, 2
∂
∂y + ∂

∂x ci, j, 1, 3
∂
∂z u j

+ ∑
j = 1

N ∂
∂y ci, j, 2, 1

∂
∂x + ∂

∂y ci, j, 2, 2
∂
∂y + ∂

∂y ci, j, 2, 3
∂
∂z u j

+ ∑
j = 1

N ∂
∂z ci, j, 3, 1

∂
∂x + ∂

∂z ci, j, 3, 2
∂
∂y + ∂

∂z ci, j, 3, 3
∂
∂z u j

All representations of the c coefficient begin with a “flattening” of the tensor to a matrix.
For 2-D systems, the N-by-N-by-2-by-2 tensor flattens to a 2N-by-2N matrix, where the
matrix is logically an N-by-N matrix of 2-by-2 blocks.

c(1, 1, 1, 1) c(1, 1, 1, 2) c(1, 2, 1, 1) c(1, 2, 1, 2) ⋯ c(1, N, 1, 1) c(1, N, 1, 2)
c(1, 1, 2, 1) c(1, 1, 2, 2) c(1, 2, 2, 1) c(1, 2, 2, 2) ⋯ c(1, N, 2, 1) c(1, N, 2, 2)

c(2, 1, 1, 1) c(2, 1, 1, 2) c(2, 2, 1, 1) c(2, 2, 1, 2) ⋯ c(2, N, 1, 1) c(2, N, 1, 2)
c(2, 1, 2, 1) c(2, 1, 2, 2) c(2, 2, 2, 1) c(2, 2, 2, 2) ⋯ c(2, N, 2, 1) c(2, N, 2, 2)

⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮
c(N, 1, 1, 1) c(N, 1, 1, 2) c(N, 2, 1, 1) c(N, 2, 1, 2) ⋯ c(N, N, 1, 1) c(N, N, 1, 2)
c(N, 1, 2, 1) c(N, 1, 2, 2) c(N, 2, 2, 1) c(N, 2, 2, 2) ⋯ c(N, N, 2, 1) c(N, N, 2, 2)

For 3-D systems, the N-by-N-by-3-by-3 tensor flattens to a 3N-by-3N matrix, where the
matrix is logically an N-by-N matrix of 3-by-3 blocks.
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c(1, 1, 1, 1) c(1, 1, 1, 2) c(1, 1, 1, 3) c(1, 2, 1, 1) c(1, 2, 1, 2) c(1, 2, 1, 3) ⋯ c(1, N, 1, 1) c(1, N, 1, 2) c(1, N, 1, 3)
c(1, 1, 2, 1) c(1, 1, 2, 2) c(1, 1, 2, 3) c(1, 2, 2, 1) c(1, 2, 2, 2) c(1, 2, 2, 3) ⋯ c(1, N, 2, 1) c(1, N, 2, 2) c(1, N, 2, 3)
c(1, 1, 3, 1) c(1, 1, 3, 2) c(1, 1, 3, 3) c(1, 2, 3, 1) c(1, 2, 3, 2) c(1, 2, 3, 3) ⋯ c(1, N, 3, 1) c(1, N, 3, 2) c(1, N, 3, 3)

c(2, 1, 1, 1) c(2, 1, 1, 2) c(2, 1, 1, 3) c(2, 2, 1, 1) c(2, 2, 1, 2) c(2, 2, 1, 3) ⋯ c(2, N, 1, 1) c(2, N, 1, 2) c(2, N, 1, 3)
c(2, 1, 2, 1) c(2, 1, 2, 2) c(2, 1, 2, 3) c(2, 2, 2, 1) c(2, 2, 2, 2) c(2, 2, 2, 3) ⋯ c(2, N, 2, 1) c(2, N, 2, 2) c(2, N, 2, 3)
c(2, 1, 3, 1) c(2, 1, 3, 2) c(2, 1, 3, 3) c(2, 2, 3, 1) c(2, 2, 3, 2) c(2, 2, 3, 3) ⋯ c(2, N, 3, 1) c(2, N, 3, 2) c(2, N, 3, 3)

⋮ ⋮ ⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮ ⋮
c(N, 1, 1, 1) c(N, 1, 1, 2) c(N, 1, 1, 3) c(N, 2, 1, 1) c(N, 2, 1, 2) c(N, 2, 1, 3) ⋯ c(N, N, 1, 1) c(N, N, 1, 2) c(N, N, 1, 3)
c(N, 1, 2, 1) c(N, 1, 2, 2) c(N, 1, 2, 3) c(N, 2, 2, 1) c(N, 2, 2, 2) c(N, 2, 2, 3) ⋯ c(N, N, 2, 1) c(N, N, 2, 2) c(N, N, 2, 3)
c(N, 1, 3, 1) c(N, 1, 3, 2) c(N, 1, 3, 3) c(N, 2, 3, 1) c(N, 2, 3, 2) c(N, 2, 3, 3) ⋯ c(N, N, 3, 1) c(N, N, 3, 2) c(N, N, 3, 3)

These matrices further get flattened into a column vector. First the N-by-N matrices
of 2-by-2 and 3-by-3 blocks are transformed into "vectors" of 2-by-2 and 3-by-3 blocks.
Then the blocks are turned into vectors in the usual column-wise way.

The coefficient vector c relates to the tensor c as follows. For 2-D systems,
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c(1) c(3) c(4N + 1) c(4N + 3) ⋯ c(4N(N − 1) + 1) c(4N(N − 1) + 3)
c(2) c(4) c(4N + 2) c(4N + 4) ⋯ c(4N(N − 1) + 2) c(4N(N − 1) + 4)

c(5) c(7) c(4N + 5) c(4N + 7) ⋯ c(4N(N − 1) + 5) c(4N(N − 1) + 7)
c(6) c(8) c(4N + 6) c(4N + 8) ⋯ c(4N(N − 1) + 6) c(4N(N − 1) + 8)

⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮
c(4N − 3) c(4N − 1) c(8N − 3) c(8N − 1) ⋯ c(4N2− 3) c(4N2− 1)

c(4N − 2) c(4N) c(8N − 2) c(8N) ⋯ c(4N2− 2) c(4N2)

Coefficient c(i,j,k,l) is in row (4N(j–1) + 4i + 2l + k – 6) of the vector c.

For 3-D systems,
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c(1) c(4) c(7) c(9N + 1) c(9N + 4) c(9N + 7) ⋯ c(9N(N − 1) + 1) c(9N(N − 1) + 4) c(9N(N − 1) + 7)
c(2) c(5) c(8) c(9N + 2) c(9N + 5) c(9N + 8) ⋯ c(9N(N − 1) + 2) c(9N(N − 1) + 5) c(9N(N − 1) + 8)
c(3) c(6) c(9) c(9N + 3) c(9N + 6) c(9N + 9) ⋯ c(9N(N − 1) + 3) c(9N(N − 1) + 6) c(9N(N − 1) + 9)

c(10) c(13) c(16) c(9N + 10) c(9N + 13) c(9N + 16) ⋯ c(9N(N − 1) + 10) c(9N(N − 1) + 13) c(9N(N − 1) + 16)
c(11) c(14) c(17) c(9N + 11) c(9N + 14) c(9N + 17) ⋯ c(9N(N − 1) + 11) c(9N(N − 1) + 14) c(9N(N − 1) + 17)
c(12) c(15) c(18) c(9N + 12) c(9N + 15) c(9N + 18) ⋯ c(9N(N − 1) + 12) c(9N(N − 1) + 15) c(9N(N − 1) + 18)
⋮ ⋮ ⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮ ⋮

c(9N − 8) c(9N − 5) c(9N − 2) c(18N − 8) c(18N − 5) c(18N − 2) ⋯ c(9N2− 8) c(9N2− 5) c(9N2− 2)

c(9N − 7) c(9N − 4) c(9N − 1) c(18N − 7) c(18N − 4) c(18N − 1) ⋯ c(9N2− 7) c(9N2− 4) c(9N2− 1)

c(9N − 6) c(9N − 3) c(9N) c(18N − 6) c(18N − 3) c(18N) ⋯ c(9N2− 6) c(9N2− 3) c(9N2)

Coefficient c(i,j,k,l) is in row (9N(j–1) + 9i + 3l + k – 12) of the vector c.

Some c Vectors Can Be Short
Often, your tensor c has structure, such as symmetric or block diagonal. In many cases,
you can represent c using a smaller vector than one with 4N2 components for 2-D or 9N2

components for 3-D. The following sections give the possibilities.

• “2-D Systems” on page 2-105
• “3-D Systems” on page 2-110
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2-D Systems

• “Scalar c, 2-D Systems” on page 2-105
• “Two-Element Column Vector c, 2-D Systems” on page 2-105
• “Three-Element Column Vector c, 2-D Systems” on page 2-106
• “Four-Element Column Vector c, 2-D Systems” on page 2-106
• “N-Element Column Vector c, 2-D Systems” on page 2-107
• “2N-Element Column Vector c, 2-D Systems” on page 2-108
• “3N-Element Column Vector c, 2-D Systems” on page 2-108
• “4N-Element Column Vector c, 2-D Systems” on page 2-109
• “2N(2N+1)/2-Element Column Vector c, 2-D Systems” on page 2-109
• “4N2-Element Column Vector c, 2-D Systems” on page 2-110

Scalar c, 2-D Systems

The software interprets a scalar c as a diagonal matrix, with c(i,i,1,1) and c(i,i,2,2) equal
to the scalar, and all other entries 0.

c 0 0 0 ⋯ 0 0
0 c 0 0 ⋯ 0 0

0 0 c 0 ⋯ 0 0
0 0 0 c ⋯ 0 0

⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮
0 0 0 0 ⋯ c 0
0 0 0 0 ⋯ 0 c

Two-Element Column Vector c, 2-D Systems

The software interprets a two-element column vector c as a diagonal matrix, with c(i,i,1,1)
and c(i,i,2,2) as the two entries, and all other entries 0.
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c(1) 0 0 0 ⋯ 0 0
0 c(2) 0 0 ⋯ 0 0

0 0 c(1) 0 ⋯ 0 0
0 0 0 c(2) ⋯ 0 0

⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮
0 0 0 0 ⋯ c(1) 0
0 0 0 0 ⋯ 0 c(2)

Three-Element Column Vector c, 2-D Systems

The software interprets a three-element column vector c as a symmetric block diagonal
matrix, with c(i,i,1,1) = c(1), c(i,i,2,2) = c(3), and c(i,i,1,2) = c(i,i,2,1) = c(2).

c(1) c(2) 0 0 ⋯ 0 0
c(2) c(3) 0 0 ⋯ 0 0

0 0 c(1) c(2) ⋯ 0 0
0 0 c(2) c(3) ⋯ 0 0

⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮
0 0 0 0 ⋯ c(1) c(2)
0 0 0 0 ⋯ c(2) c(3)

Four-Element Column Vector c, 2-D Systems

The software interprets a four-element column vector c as a block diagonal matrix.

c(1) c(3) 0 0 ⋯ 0 0
c(2) c(4) 0 0 ⋯ 0 0

0 0 c(1) c(3) ⋯ 0 0
0 0 c(2) c(4) ⋯ 0 0

⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮
0 0 0 0 ⋯ c(1) c(3)
0 0 0 0 ⋯ c(2) c(4)
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N-Element Column Vector c, 2-D Systems

The software interprets an N-element column vector c as a diagonal matrix.

c(1) 0 0 0 ⋯ 0 0
0 c(1) 0 0 ⋯ 0 0

0 0 c(2) 0 ⋯ 0 0
0 0 0 c(2) ⋯ 0 0

⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮
0 0 0 0 ⋯ c(N) 0
0 0 0 0 ⋯ 0 c(N)

Caution If N = 2, 3, or 4, the 2-, 3-, or 4-element column vector form takes precedence
over the N-element form. For example, if N = 3, and you have a c matrix of the form

c1 0 0 0 0 0
0 c1 0 0 0 0
0 0 c2 0 0 0
0 0 0 c2 0 0
0 0 0 0 c3 0
0 0 0 0 0 c3

you cannot use the N-element form of c. Instead, you must use the 2N-element form. If
you give c as the vector [c1;c2;c3], the software interprets c as a 3-element form:

c1 c2 0 0 0 0
c2 c3 0 0 0 0
0 0 c1 c2 0 0
0 0 c2 c3 0 0
0 0 0 0 c1 c2
0 0 0 0 c2 c3

Instead, use the 2N-element form [c1;c1;c2;c2;c3;c3].
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2N-Element Column Vector c, 2-D Systems

The software interprets a 2N-element column vector c as a diagonal matrix.

c(1) 0 0 0 ⋯ 0 0
0 c(2) 0 0 ⋯ 0 0

0 0 c(3) 0 ⋯ 0 0
0 0 0 c(4) ⋯ 0 0

⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮
0 0 0 0 ⋯ c(2N − 1) 0
0 0 0 0 ⋯ 0 c(2N)

Caution If N = 2, the 4-element form takes precedence over the 2N-element form. For
example, if your c matrix is

c1 0 0 0
0 c2 0 0
0 0 c3 0
0 0 0 c4

you cannot give c as [c1;c2;c3;c4], because the software interprets this vector as the
4-element form

c1 c3 0 0
c2 c4 0 0
0 0 c1 c3
0 0 c2 c4

Instead, use the 3N-element form [c1;0;c2;c3;0;c4] or the 4N-element form
[c1;0;0;c2;c3;0;0;c4].

3N-Element Column Vector c, 2-D Systems

The software interprets a 3N-element column vector c as a symmetric block diagonal
matrix.
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c(1) c(2) 0 0 ⋯ 0 0
c(2) c(3) 0 0 ⋯ 0 0

0 0 c(4) c(5) ⋯ 0 0
0 0 c(5) c(6) ⋯ 0 0

⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮
0 0 0 0 ⋯ c(3N − 2) c(3N − 1)
0 0 0 0 ⋯ c(3N − 1) c(3N)

Coefficient c(i,j,k,l) is in row (3i + k + l – 4) of the vector c.
4N-Element Column Vector c, 2-D Systems

The software interprets a 4N-element column vector c as a block diagonal matrix.

c(1) c(3) 0 0 ⋯ 0 0
c(2) c(4) 0 0 ⋯ 0 0

0 0 c(5) c(7) ⋯ 0 0
0 0 c(6) c(8) ⋯ 0 0

⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮
0 0 0 0 ⋯ c(4N − 3) c(4N − 1)
0 0 0 0 ⋯ c(4N − 2) c(4N)

Coefficient c(i,j,k,l) is in row (4i + 2l + k – 6) of the vector c.
2N(2N+1)/2-Element Column Vector c, 2-D Systems

The software interprets a 2N(2N+1)/2-element column vector c as a symmetric matrix. In
the following diagram, • means the entry is symmetric.

c(1) c(2) c(4) c(6) ⋯ c((N − 1)(2N − 1) + 1) c((N − 1)(2N − 1) + 3)
• c(3) c(5) c(7) ⋯ c((N − 1)(2N − 1) + 2) c((N − 1)(2N − 1) + 4)

• • c(8) c(9) ⋯ c((N − 1)(2N − 1) + 5) c((N − 1)(2N − 1) + 7)
• • • c(10) ⋯ c((N − 1)(2N − 1) + 6) c((N − 1)(2N − 1) + 8)

⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮
• • • • ⋯ c(N(2N + 1) − 2) c(N(2N + 1) − 1)
• • • • ⋯ • c(N(2N + 1))
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Coefficient c(i,j,k,l), for i < j, is in row (2j2 – 3j + 4i + 2l + k – 5) of the vector c. For i = j,
coefficient c(i,j,k,l) is in row (2i2 + i + l + k – 4) of the vector c.

4N2-Element Column Vector c, 2-D Systems

The software interprets a 4N2-element column vector c as a matrix.

c(1) c(3) c(4N + 1) c(4N + 3) ⋯ c(4N(N − 1) + 1) c(4N(N − 1) + 3)
c(2) c(4) c(4N + 2) c(4N + 4) ⋯ c(4N(N − 1) + 2) c(4N(N − 1) + 4)

c(5) c(7) c(4N + 5) c(4N + 7) ⋯ c(4N(N − 1) + 5) c(4N(N − 1) + 7)
c(6) c(8) c(4N + 6) c(4N + 8) ⋯ c(4N(N − 1) + 6) c(4N(N − 1) + 8)

⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮
c(4N − 3) c(4N − 1) c(8N − 3) c(8N − 1) ⋯ c(4N2− 3) c(4N2− 1)

c(4N − 2) c(4N) c(8N − 2) c(8N) ⋯ c(4N2− 2) c(4N2)

Coefficient c(i,j,k,l) is in row (4N(j–1) + 4i + 2l + k – 6) of the vector c.

3-D Systems

• “Scalar c, 3-D Systems” on page 2-110
• “Three-Element Column Vector c, 3-D Systems” on page 2-111
• “Six-Element Column Vector c, 3-D Systems” on page 2-111
• “Nine-Element Column Vector c, 3-D Systems” on page 2-112
• “N-Element Column Vector c, 3-D Systems” on page 2-112
• “3N-Element Column Vector c, 3-D Systems” on page 2-114
• “6N-Element Column Vector c, 3-D Systems” on page 2-115
• “9N-Element Column Vector c, 3-D Systems” on page 2-116
• “3N(3N+1)/2-Element Column Vector c, 3-D Systems” on page 2-116
• “9N2-Element Column Vector c, 3-D Systems” on page 2-117

Scalar c, 3-D Systems

The software interprets a scalar c as a diagonal matrix, with c(i,i,1,1), c(i,i,2,2), and
c(i,i,3,3) equal to the scalar, and all other entries 0.
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c 0 0 0 0 0 ⋯ 0 0 0
0 c 0 0 0 0 ⋯ 0 0 0
0 0 c 0 0 0 ⋯ 0 0 0

0 0 0 c 0 0 ⋯ 0 0 0
0 0 0 0 c 0 ⋯ 0 0 0
0 0 0 0 0 c ⋯ 0 0 0
⋮ ⋮ ⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮ ⋮
0 0 0 0 0 0 ⋯ c 0 0
0 0 0 0 0 0 ⋯ 0 c 0
0 0 0 0 0 0 ⋯ 0 0 c

Three-Element Column Vector c, 3-D Systems

The software interprets a three-element column vector c as a diagonal matrix, with
c(i,i,1,1), c(i,i,2,2), and c(i,i,3,3) as the three entries, and all other entries 0.

c(1) 0 0 0 0 0 ⋯ 0 0 0
0 c(2) 0 0 0 0 ⋯ 0 0 0
0 0 c(3) 0 0 0 ⋯ 0 0 0

0 0 0 c(1) 0 0 ⋯ 0 0 0
0 0 0 0 c(2) 0 ⋯ 0 0 0
0 0 0 0 0 c(3) ⋯ 0 0 0
⋮ ⋮ ⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮ ⋮
0 0 0 0 0 0 ⋯ c(1) 0 0
0 0 0 0 0 0 ⋯ 0 c(2) 0
0 0 0 0 0 0 ⋯ 0 0 c(3)

Six-Element Column Vector c, 3-D Systems

The software interprets a six-element column vector c as a symmetric block diagonal
matrix, with

c(i,i,1,1) = c(1)
c(i,i,2,2) = c(3)
c(i,i,1,2) = c(i,i,2,1) = c(2)
c(i,i,1,3) = c(i,i,3,1) = c(4)
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c(i,i,2,3) = c(i,i,3,2) = c(5)
c(i,i,3,3) = c(6).

In the following diagram, • means the entry is symmetric.

c(1) c(2) c(4) 0 0 0 ⋯ 0 0 0
• c(3) c(5) 0 0 0 ⋯ 0 0 0
• • c(6) 0 0 0 ⋯ 0 0 0

0 0 0 c(1) c(2) c(4) ⋯ 0 0 0
0 0 0 • c(3) c(5) ⋯ 0 0 0
0 0 0 • • c(6) ⋯ 0 0 0
⋮ ⋮ ⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮ ⋮
0 0 0 0 0 0 ⋯ c(1) c(2) c(4)
0 0 0 0 0 0 ⋯ • c(3) c(5)
0 0 0 0 0 0 ⋯ • • c(6)

Nine-Element Column Vector c, 3-D Systems

The software interprets a nine-element column vector c as a block diagonal matrix.

c(1) c(4) c(7) 0 0 0 ⋯ 0 0 0
c(2) c(5) c(8) 0 0 0 ⋯ 0 0 0
c(3) c(6) c(9) 0 0 0 ⋯ 0 0 0

0 0 0 c(1) c(4) c(7) ⋯ 0 0 0
0 0 0 c(2) c(5) c(8) ⋯ 0 0 0
0 0 0 c(3) c(6) c(9) ⋯ 0 0 0
⋮ ⋮ ⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮ ⋮
0 0 0 0 0 0 ⋯ c(1) c(4) c(7)
0 0 0 0 0 0 ⋯ c(2) c(5) c(8)
0 0 0 0 0 0 ⋯ c(3) c(6) c(3)

N-Element Column Vector c, 3-D Systems

The software interprets an N-element column vector c as a diagonal matrix.
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c(1) 0 0 0 0 0 ⋯ 0 0 0
0 c(1) 0 0 0 0 ⋯ 0 0 0
0 0 c(1) 0 0 0 ⋯ 0 0 0

0 0 0 c(2) 0 0 ⋯ 0 0 0
0 0 0 0 c(2) 0 ⋯ 0 0 0
0 0 0 0 0 c(2) ⋯ 0 0 0
⋮ ⋮ ⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮ ⋮
0 0 0 0 0 0 ⋯ c(N) 0 0
0 0 0 0 0 0 ⋯ 0 c(N) 0
0 0 0 0 0 0 ⋯ 0 0 c(N)

Caution If N = 3, 6, or 9, the 3-, 6-, or 9-element column vector form takes precedence
over the N-element form. For example, if N = 3, and you have a c matrix of the form

c(1) 0 0 0 0 0 0 0 0
0 c(1) 0 0 0 0 0 0 0
0 0 c(1) 0 0 0 0 0 0

0 0 0 c(2) 0 0 0 0 0
0 0 0 0 c(2) 0 0 0 0
0 0 0 0 0 c(2) 0 0 0

0 0 0 0 0 0 c(3) 0 0
0 0 0 0 0 0 0 c(3) 0
0 0 0 0 0 0 0 0 c(3)

you cannot use the N-element form of c. If you give c as the vector [c1;c2;c3], the
software interprets c as a 3-element form:
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c(1) 0 0 0 0 0 0 0 0
0 c(2) 0 0 0 0 0 0 0
0 0 c(3) 0 0 0 0 0 0

0 0 0 c(1) 0 0 0 0 0
0 0 0 0 c(2) 0 0 0 0
0 0 0 0 0 c(3) 0 0 0

0 0 0 0 0 0 c(1) 0 0
0 0 0 0 0 0 0 c(2) 0
0 0 0 0 0 0 0 0 c(3)

Instead, use one of these forms:

• 6N-element form — [c1;0;c1;0;0;c1;c2;0;c2;0;0;c2;c3;0;c3;0;0;c3]
• 9N-element form —

[c1;0;0;0;c1;0;0;0;c1;c2;0;0;0;c2;0;0;0;c2;c3;0;0;0;c3;0;0;0;c3]

3N-Element Column Vector c, 3-D Systems

The software interprets a 3N-element column vector c as a diagonal matrix.

c(1) 0 0 0 0 0 ⋯ 0 0 0
0 c(2) 0 0 0 0 ⋯ 0 0 0
0 0 c(3) 0 0 0 ⋯ 0 0 0

0 0 0 c(4) 0 0 ⋯ 0 0 0
0 0 0 0 c(5) 0 ⋯ 0 0 0
0 0 0 0 0 c(6) ⋯ 0 0 0
⋮ ⋮ ⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮ ⋮
0 0 0 0 0 0 ⋯ c(3N − 2) 0 0
0 0 0 0 0 0 ⋯ 0 c(3N − 1) 0
0 0 0 0 0 0 ⋯ 0 0 c(3N)

Caution If N = 3, the 9-element form takes precedence over the 3N-element form. For
example, if your c matrix is
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c(1) 0 0 0 0 0 0 0 0
0 c(2) 0 0 0 0 0 0 0
0 0 c(3) 0 0 0 0 0 0

0 0 0 c(4) 0 0 0 0 0
0 0 0 0 c(5) 0 0 0 0
0 0 0 0 0 c(6) 0 0 0

0 0 0 0 0 0 c(7) 0 0
0 0 0 0 0 0 0 c(8) 0
0 0 0 0 0 0 0 0 c(9)

you cannot give c as [c1;c2;c3;c4;c5;c6;c7;c8;c9], because the software
interprets this vector as the 9-element form

c(1) c(4) c(7) 0 0 0 0 0 0
c(2) c(5) c(8) 0 0 0 0 0 0
c(3) c(6) c(9) 0 0 0 0 0 0

0 0 0 c(1) c(4) c(7) 0 0 0
0 0 0 c(2) c(5) c(8) 0 0 0
0 0 0 c(3) c(6) c(9) 0 0 0

0 0 0 0 0 0 c(1) c(4) c(7)
0 0 0 0 0 0 c(2) c(5) c(8)
0 0 0 0 0 0 c(3) c(6) c(3)

Instead, use one of these forms:

• 6N-element form — [c1;0;c2;0;0;c3;c4;0;c5;0;0;c6;c7;0;c8;0;0;c9]
• 9N-element form —

[c1;0;0;0;c2;0;0;0;c3;c4;0;0;0;c5;0;0;0;c6;c7;0;0;0;c8;0;0;0;c9]

6N-Element Column Vector c, 3-D Systems

The software interprets a 6N-element column vector c as a symmetric block diagonal
matrix. In the following diagram, • means the entry is symmetric.
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c(1) c(2) c(4) 0 0 0 ⋯ 0 0 0
• c(3) c(5) 0 0 0 ⋯ 0 0 0
• • c(6) 0 0 0 ⋯ 0 0 0

0 0 0 c(7) c(8) c(10) ⋯ 0 0 0
0 0 0 • c(9) c(11) ⋯ 0 0 0
0 0 0 • • c(12) ⋯ 0 0 0
⋮ ⋮ ⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮ ⋮
0 0 0 0 0 0 ⋯ c(6N − 5) c(6N − 4) c(6N − 2)
0 0 0 0 0 0 ⋯ • c(6N − 3) c(6N − 1)
0 0 0 0 0 0 ⋯ • • c(6N)

Coefficient c(i,j,k,l) is in row (6i + k + 1/2l(l–1) – 6) of the vector c.

9N-Element Column Vector c, 3-D Systems

The software interprets a 9N-element column vector c as a block diagonal matrix.

c(1) c(4) c(7) 0 0 0 ⋯ 0 0 0
c(2) c(5) c(8) 0 0 0 ⋯ 0 0 0
c(3) c(6) c(9) 0 0 0 ⋯ 0 0 0

0 0 0 c(10) c(13) c(16) ⋯ 0 0 0
0 0 0 c(11) c(14) c(17) ⋯ 0 0 0
0 0 0 c(12) c(15) c(18) ⋯ 0 0 0
⋮ ⋮ ⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮ ⋮
0 0 0 0 0 0 ⋯ c(9N − 8) c(9N − 5) c(9N − 2)
0 0 0 0 0 0 ⋯ c(9N − 7) c(9N − 4) c(9N − 1)
0 0 0 0 0 0 ⋯ c(9N − 6) c(9N − 3) c(9N)

Coefficient c(i,j,k,l) is in row (9i + 3l + k – 12) of the vector c.

3N(3N+1)/2-Element Column Vector c, 3-D Systems

The software interprets a 3N(3N+1)/2-element column vector c as a symmetric matrix. In
the following diagram, • means the entry is symmetric.
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c(1) c(2) c(4) c(7) c(10) c(13) ⋯ c(3(N − 1)(3(N − 1) + 1)/2 + 1 c(3(N − 1)(3(N − 1) + 1)/2 + 4 c(3(N − 1)(3(N − 1) + 1)/2 + 7
• c(3) c(5) c(8) c(11) c(14) ⋯ c(3(N − 1)(3(N − 1) + 1)/2 + 2 c(3(N − 1)(3(N − 1) + 1)/2 + 5 c(3(N − 1)(3(N − 1) + 1)/2 + 8
• • c(6) c(9) c(12) c(15) ⋯ c(3(N − 1)(3(N − 1) + 1)/2 + 3 c(3(N − 1)(3(N − 1) + 1)/2 + 6 c(3(N − 1)(3(N − 1) + 1)/2 + 9

• • • c(16) c(17) c(19) ⋯ c(3(N − 1)(3(N − 1) + 1)/2 + 10 c(3(N − 1)(3(N − 1) + 1)/2 + 13 c(3(N − 1)(3(N − 1) + 1)/2 + 16
• • • • c(18) c(20) ⋯ c(3(N − 1)(3(N − 1) + 1)/2 + 11 c(3(N − 1)(3(N − 1) + 1)/2 + 14 c(3(N − 1)(3(N − 1) + 1)/2 + 17
• • • • • c(21) ⋯ c(3(N − 1)(3(N − 1) + 1)/2 + 12 c(3(N − 1)(3(N − 1) + 1)/2 + 15 c(3(N − 1)(3(N − 1) + 1)/2 + 18
⋮ ⋮ ⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮ ⋮
• • • • • • ⋯ c(3N(3N + 1)/2 − 5) c(3N(3N + 1)/2 − 4) c(3N(3N + 1)/2 − 2)
• • • • • • ⋯ • c(3N(3N + 1)/2 − 3) c(3N(3N + 1)/2 − 1)
• • • • • • ⋯ • • c(3N(3N + 1)/2)

Coefficient c(i,j,k,l), for i < j, is in row (9(j–1)(j–2)/2 + 6(j–1) + 9i + 3l + k – 12) of the
vector c. For i = j, coefficient c(i,j,k,l) is in row (9(i–1)(i–2)/2 + 15(i–1) + 1/2l(l–1) + k) of
the vector c.

9N2-Element Column Vector c, 3-D Systems

The software interprets a 9N2-element column vector c as a matrix.
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c(1) c(4) c(7) c(9N + 1) c(9N + 4) c(9N + 7) ⋯ c(9N(N − 1) + 1) c(9N(N − 1) + 4) c(9N(N − 1) + 7)
c(2) c(5) c(8) c(9N + 2) c(9N + 5) c(9N + 8) ⋯ c(9N(N − 1) + 2) c(9N(N − 1) + 5) c(9N(N − 1) + 8)
c(3) c(6) c(9) c(9N + 3) c(9N + 6) c(9N + 9) ⋯ c(9N(N − 1) + 3) c(9N(N − 1) + 6) c(9N(N − 1) + 9)

c(10) c(13) c(16) c(9N + 10) c(9N + 13) c(9N + 16) ⋯ c(9N(N − 1) + 10) c(9N(N − 1) + 13) c(9N(N − 1) + 16)
c(11) c(14) c(17) c(9N + 11) c(9N + 14) c(9N + 17) ⋯ c(9N(N − 1) + 11) c(9N(N − 1) + 14) c(9N(N − 1) + 17)
c(12) c(15) c(18) c(9N + 12) c(9N + 15) c(9N + 18) ⋯ c(9N(N − 1) + 12) c(9N(N − 1) + 15) c(9N(N − 1) + 18)
⋮ ⋮ ⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮ ⋮

c(9N − 8) c(9N − 5) c(9N − 2) c(18N − 8) c(18N − 5) c(18N − 2) ⋯ c(9N2− 8) c(9N2− 5) c(9N2− 2)

c(9N − 7) c(9N − 4) c(9N − 1) c(18N − 7) c(18N − 4) c(18N − 1) ⋯ c(9N2− 7) c(9N2− 4) c(9N2− 1)

c(9N − 6) c(9N − 3) c(9N) c(18N − 6) c(18N − 3) c(18N) ⋯ c(9N2− 6) c(9N2− 3) c(9N2)

Coefficient c(i,j,k,l) is in row (9N(j–1) + 9i + 3l + k – 12) of the vector c.

Functional Form
If your c coefficient is not constant, represent it as a function of the form

ccoeffunction(location,state)

solvepde or solvepdeeig pass the location and state structures to
ccoeffunction. The function must return a matrix of size N1-by-Nr, where:
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• N1 is the number of coefficients you pass to the solver. There are several possible
values of N1, detailed in “Some c Vectors Can Be Short” on page 2-104. For 2-D
geometry, 1 ≤ N1 ≤ 4N2, and for 3-D geometry, 1 ≤ N1 ≤ 9N2.

• Nr is the number of points in the location that the solver passes. Nr is equal to the
length of the location.x or any other location field. The function should evaluate
c at these points.

Pass the coefficient to specifyCoefficients as a function handle, such as

specifyCoefficients(model,'c',@ccoeffunction,...)

• location is a structure with these fields:

• location.x
• location.y
• location.z
• location.subdomain

The fields x, y, and z represent the x-, y-, and z- coordinates of points for which your
function calculates coefficient values. The subdomain field represents the subdomain
numbers, which currently apply only to 2-D models. The location fields are row
vectors.

• state is a structure with these fields:

• state.u
• state.ux
• state.uy
• state.uz
• state.time

The state.u field represents the current value of the solution u. The state.ux,
state.uy, and state.uz fields are estimates of the solution’s partial derivatives
(∂u/∂x, ∂u/∂y, and ∂u/∂z) at the corresponding points of the location structure. The
solution and gradient estimates are N-by-Nr matrices. The state.time field is a
scalar representing time for time-dependent models.

For example, suppose N = 3, and you have 2-D geometry. Suppose your c matrix is of the
form
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c =

1 2
2 8

1 + x2 + y2 u(2)
1 + u(1)2 + u(3)2

u(2)
1 + u(1)2 + u(3)2

1 + x2 + y2

s1(x, y) −1
−1 s1(x, y)

where unlisted elements are zero. Here s1(x,y) is 5 in subdomain 1, and is 10 in
subdomain 2.

This c is a symmetric, block-diagonal matrix with different coefficients in each block. So it
is natural to represent c as a “3N-Element Column Vector c, 2-D Systems” on page 2-108:

c(1) c(2) 0 0 ⋯ 0 0
c(2) c(3) 0 0 ⋯ 0 0

0 0 c(4) c(5) ⋯ 0 0
0 0 c(5) c(6) ⋯ 0 0

⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮
0 0 0 0 ⋯ c(3N − 2) c(3N − 1)
0 0 0 0 ⋯ c(3N − 1) c(3N)

For that form, the following function is appropriate.

function cmatrix = ccoeffunction(location,state)

n1 = 9;
nr = numel(location.x);
cmatrix = zeros(n1,nr);
cmatrix(1,:) = ones(1,nr);
cmatrix(2,:) = 2*ones(1,nr);
cmatrix(3,:) = 8*ones(1,nr);
cmatrix(4,:) = 1+location.x.^2 + location.y.^2;
cmatrix(5,:) = state.u(2,:)./(1 + state.u(1,:).^2 + state.u(3,:).^2);
cmatrix(6,:) = cmatrix(4,:);
cmatrix(7,:) = 5*location.subdomain;
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cmatrix(8,:) = -ones(1,nr);
cmatrix(9,:) = cmatrix(7,:);

To include this function as your c coefficient, pass the function handle @ccoeffunction:

specifyCoefficients(model,'c',@ccoeffunction,...

See Also

Related Examples
• “Solve Problems Using PDEModel Objects” on page 2-6
• “f Coefficient for specifyCoefficients” on page 2-97
• “m, d, or a Coefficient for specifyCoefficients” on page 2-142
• “Deflection of Piezoelectric Actuator” on page 3-12
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c Coefficient for Systems

Note THIS PAGE DESCRIBES THE LEGACY WORKFLOW. New features might not be
compatible with the legacy workflow. For the corresponding step in the recommended
workflow, see “c Coefficient for specifyCoefficients” on page 2-100.

In this section...
“c as Tensor, Matrix, and Vector” on page 2-122
“2-D Systems” on page 2-127
“3-D Systems” on page 2-132

c as Tensor, Matrix, and Vector
This topic describes how to write the coefficient c in equations such as

−∇ ⋅ c⊗ ∇u + au = f

For 2-D systems, the coefficient c is an N-by-N-by-2-by-2 tensor with components c(i,j,k,l).
N is the number of equations (see “Equations You Can Solve Using Legacy Functions” on
page 1-3). For 3-D systems, c is an N-by-N-by-3-by-3 tensor.

For 2-D systems, the notation ∇ ⋅ (c⊗ ∇u) represents an N-by-1 matrix with an (i,1)-
component

∑
j = 1

N ∂
∂x ci, j, 1, 1

∂
∂x + ∂

∂x ci, j, 1, 2
∂
∂y + ∂

∂y ci, j, 2, 1
∂
∂x + ∂

∂y ci, j, 2, 2
∂
∂y u j

For 3-D systems, the notation ∇ ⋅ (c⊗ ∇u) represents an N-by-1 matrix with an (i,1)-
component
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∑
j = 1

N ∂
∂x ci, j, 1, 1

∂
∂x + ∂

∂x ci, j, 1, 2
∂
∂y + ∂

∂x ci, j, 1, 3
∂
∂z u j

+ ∑
j = 1

N ∂
∂y ci, j, 2, 1

∂
∂x + ∂

∂y ci, j, 2, 2
∂
∂y + ∂

∂y ci, j, 2, 3
∂
∂z u j

+ ∑
j = 1

N ∂
∂z ci, j, 3, 1

∂
∂x + ∂

∂z ci, j, 3, 2
∂
∂y + ∂

∂z ci, j, 3, 3
∂
∂z u j

All representations of the c coefficient begin with a “flattening” of the tensor to a matrix.
For 2-D systems, the N-by-N-by-2-by-2 tensor flattens to a 2N-by-2N matrix, where the
matrix is logically an N-by-N matrix of 2-by-2 blocks.

c(1, 1, 1, 1) c(1, 1, 1, 2) c(1, 2, 1, 1) c(1, 2, 1, 2) ⋯ c(1, N, 1, 1) c(1, N, 1, 2)
c(1, 1, 2, 1) c(1, 1, 2, 2) c(1, 2, 2, 1) c(1, 2, 2, 2) ⋯ c(1, N, 2, 1) c(1, N, 2, 2)

c(2, 1, 1, 1) c(2, 1, 1, 2) c(2, 2, 1, 1) c(2, 2, 1, 2) ⋯ c(2, N, 1, 1) c(2, N, 1, 2)
c(2, 1, 2, 1) c(2, 1, 2, 2) c(2, 2, 2, 1) c(2, 2, 2, 2) ⋯ c(2, N, 2, 1) c(2, N, 2, 2)

⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮
c(N, 1, 1, 1) c(N, 1, 1, 2) c(N, 2, 1, 1) c(N, 2, 1, 2) ⋯ c(N, N, 1, 1) c(N, N, 1, 2)
c(N, 1, 2, 1) c(N, 1, 2, 2) c(N, 2, 2, 1) c(N, 2, 2, 2) ⋯ c(N, N, 2, 1) c(N, N, 2, 2)

For 3-D systems, the N-by-N-by-3-by-3 tensor flattens to a 3N-by-3N matrix, where the
matrix is logically an N-by-N matrix of 3-by-3 blocks.
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c(1, 1, 1, 1) c(1, 1, 1, 2) c(1, 1, 1, 3) c(1, 2, 1, 1) c(1, 2, 1, 2) c(1, 2, 1, 3) ⋯ c(1, N, 1, 1) c(1, N, 1, 2) c(1, N, 1, 3)
c(1, 1, 2, 1) c(1, 1, 2, 2) c(1, 1, 2, 3) c(1, 2, 2, 1) c(1, 2, 2, 2) c(1, 2, 2, 3) ⋯ c(1, N, 2, 1) c(1, N, 2, 2) c(1, N, 2, 3)
c(1, 1, 3, 1) c(1, 1, 3, 2) c(1, 1, 3, 3) c(1, 2, 3, 1) c(1, 2, 3, 2) c(1, 2, 3, 3) ⋯ c(1, N, 3, 1) c(1, N, 3, 2) c(1, N, 3, 3)

c(2, 1, 1, 1) c(2, 1, 1, 2) c(2, 1, 1, 3) c(2, 2, 1, 1) c(2, 2, 1, 2) c(2, 2, 1, 3) ⋯ c(2, N, 1, 1) c(2, N, 1, 2) c(2, N, 1, 3)
c(2, 1, 2, 1) c(2, 1, 2, 2) c(2, 1, 2, 3) c(2, 2, 2, 1) c(2, 2, 2, 2) c(2, 2, 2, 3) ⋯ c(2, N, 2, 1) c(2, N, 2, 2) c(2, N, 2, 3)
c(2, 1, 3, 1) c(2, 1, 3, 2) c(2, 1, 3, 3) c(2, 2, 3, 1) c(2, 2, 3, 2) c(2, 2, 3, 3) ⋯ c(2, N, 3, 1) c(2, N, 3, 2) c(2, N, 3, 3)

⋮ ⋮ ⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮ ⋮
c(N, 1, 1, 1) c(N, 1, 1, 2) c(N, 1, 1, 3) c(N, 2, 1, 1) c(N, 2, 1, 2) c(N, 2, 1, 3) ⋯ c(N, N, 1, 1) c(N, N, 1, 2) c(N, N, 1, 3)
c(N, 1, 2, 1) c(N, 1, 2, 2) c(N, 1, 2, 3) c(N, 2, 2, 1) c(N, 2, 2, 2) c(N, 2, 2, 3) ⋯ c(N, N, 2, 1) c(N, N, 2, 2) c(N, N, 2, 3)
c(N, 1, 3, 1) c(N, 1, 3, 2) c(N, 1, 3, 3) c(N, 2, 3, 1) c(N, 2, 3, 2) c(N, 2, 3, 3) ⋯ c(N, N, 3, 1) c(N, N, 3, 2) c(N, N, 3, 3)

These matrices further get flattened into a column vector. First the N-by-N matrices
of 2-by-2 and 3-by-3 blocks are transformed into "vectors" of 2-by-2 and 3-by-3 blocks.
Then the blocks are turned into vectors in the usual column-wise way.

The coefficient vector c relates to the tensor c as follows. For 2-D systems,

2 Setting Up Your PDE

2-124



c(1) c(3) c(4N + 1) c(4N + 3) ⋯ c(4N(N − 1) + 1) c(4N(N − 1) + 3)
c(2) c(4) c(4N + 2) c(4N + 4) ⋯ c(4N(N − 1) + 2) c(4N(N − 1) + 4)

c(5) c(7) c(4N + 5) c(4N + 7) ⋯ c(4N(N − 1) + 5) c(4N(N − 1) + 7)
c(6) c(8) c(4N + 6) c(4N + 8) ⋯ c(4N(N − 1) + 6) c(4N(N − 1) + 8)

⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮
c(4N − 3) c(4N − 1) c(8N − 3) c(8N − 1) ⋯ c(4N2− 3) c(4N2− 1)

c(4N − 2) c(4N) c(8N − 2) c(8N) ⋯ c(4N2− 2) c(4N2)

Coefficient c(i,j,k,l) is in row (4N(j–1) + 4i + 2l + k – 6) of the vector c.

For 3-D systems,
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c(1) c(4) c(7) c(9N + 1) c(9N + 4) c(9N + 7) ⋯ c(9N(N − 1) + 1) c(9N(N − 1) + 4) c(9N(N − 1) + 7)
c(2) c(5) c(8) c(9N + 2) c(9N + 5) c(9N + 8) ⋯ c(9N(N − 1) + 2) c(9N(N − 1) + 5) c(9N(N − 1) + 8)
c(3) c(6) c(9) c(9N + 3) c(9N + 6) c(9N + 9) ⋯ c(9N(N − 1) + 3) c(9N(N − 1) + 6) c(9N(N − 1) + 9)

c(10) c(13) c(16) c(9N + 10) c(9N + 13) c(9N + 16) ⋯ c(9N(N − 1) + 10) c(9N(N − 1) + 13) c(9N(N − 1) + 16)
c(11) c(14) c(17) c(9N + 11) c(9N + 14) c(9N + 17) ⋯ c(9N(N − 1) + 11) c(9N(N − 1) + 14) c(9N(N − 1) + 17)
c(12) c(15) c(18) c(9N + 12) c(9N + 15) c(9N + 18) ⋯ c(9N(N − 1) + 12) c(9N(N − 1) + 15) c(9N(N − 1) + 18)
⋮ ⋮ ⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮ ⋮

c(9N − 8) c(9N − 5) c(9N − 2) c(18N − 8) c(18N − 5) c(18N − 2) ⋯ c(9N2− 8) c(9N2− 5) c(9N2− 2)

c(9N − 7) c(9N − 4) c(9N − 1) c(18N − 7) c(18N − 4) c(18N − 1) ⋯ c(9N2− 7) c(9N2− 4) c(9N2− 1)

c(9N − 6) c(9N − 3) c(9N) c(18N − 6) c(18N − 3) c(18N) ⋯ c(9N2− 6) c(9N2− 3) c(9N2)

Coefficient c(i,j,k,l) is in row (9N(j–1) + 9i + 3l + k – 12) of the vector c.

Express c as numbers, text expressions, or functions, as in “f Coefficient for Systems” on
page 2-94.

Often, your tensor c has structure, such as symmetric or block diagonal. In many cases,
you can represent c using a smaller vector than one with 4N2 components for 2-D or 9N2

components for 3-D.

The number of rows in the matrix can differ from 4N2 for 2-D or 9N2 for 3-D, as described
in “2-D Systems” on page 2-127 and “3-D Systems” on page 2-132.
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In function form for 2-D systems, the number of columns is Nt, which is the number of
triangles or tetrahedra in the mesh. The function should evaluate c at the triangle or
tetrahedron centroids, as in “Specify 2-D Scalar Coefficients in Function Form” on page 2-
80. Give solvers the function name as 'filename', or as a function handle @filename,
where filename.m is a file on your MATLAB path. For details on writing the function,
see “Calculate Coefficients in Function Form” on page 2-81.

For the function form of coefficients of 3-D systems, see “Specify 3-D PDE Coefficients in
Function Form” on page 2-83.

2-D Systems
• “Scalar c, 2-D Systems” on page 2-127
• “Two-Element Column Vector c, 2-D Systems” on page 2-128
• “Three-Element Column Vector c, 2-D Systems” on page 2-128
• “Four-Element Column Vector c, 2-D Systems” on page 2-128
• “N-Element Column Vector c, 2-D Systems” on page 2-129
• “2N-Element Column Vector c, 2-D Systems” on page 2-130
• “3N-Element Column Vector c, 2-D Systems” on page 2-131
• “4N-Element Column Vector c, 2-D Systems” on page 2-131
• “2N(2N+1)/2-Element Column Vector c, 2-D Systems” on page 2-132
• “4N2-Element Column Vector c, 2-D Systems” on page 2-132

Scalar c, 2-D Systems

The software interprets a scalar c as a diagonal matrix, with c(i,i,1,1) and c(i,i,2,2) equal
to the scalar, and all other entries 0.

c 0 0 0 ⋯ 0 0
0 c 0 0 ⋯ 0 0

0 0 c 0 ⋯ 0 0
0 0 0 c ⋯ 0 0

⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮
0 0 0 0 ⋯ c 0
0 0 0 0 ⋯ 0 c
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Two-Element Column Vector c, 2-D Systems

The software interprets a two-element column vector c as a diagonal matrix, with c(i,i,1,1)
and c(i,i,2,2) as the two entries, and all other entries 0.

c(1) 0 0 0 ⋯ 0 0
0 c(2) 0 0 ⋯ 0 0

0 0 c(1) 0 ⋯ 0 0
0 0 0 c(2) ⋯ 0 0

⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮
0 0 0 0 ⋯ c(1) 0
0 0 0 0 ⋯ 0 c(2)

Three-Element Column Vector c, 2-D Systems

The software interprets a three-element column vector c as a symmetric block diagonal
matrix, with c(i,i,1,1) = c(1), c(i,i,2,2) = c(3), and c(i,i,1,2) = c(i,i,2,1) = c(2).

c(1) c(2) 0 0 ⋯ 0 0
c(2) c(3) 0 0 ⋯ 0 0

0 0 c(1) c(2) ⋯ 0 0
0 0 c(2) c(3) ⋯ 0 0

⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮
0 0 0 0 ⋯ c(1) c(2)
0 0 0 0 ⋯ c(2) c(3)

Four-Element Column Vector c, 2-D Systems

The software interprets a four-element column vector c as a block diagonal matrix.
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c(1) c(3) 0 0 ⋯ 0 0
c(2) c(4) 0 0 ⋯ 0 0

0 0 c(1) c(3) ⋯ 0 0
0 0 c(2) c(4) ⋯ 0 0

⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮
0 0 0 0 ⋯ c(1) c(3)
0 0 0 0 ⋯ c(2) c(4)

N-Element Column Vector c, 2-D Systems

The software interprets an N-element column vector c as a diagonal matrix.

c(1) 0 0 0 ⋯ 0 0
0 c(1) 0 0 ⋯ 0 0

0 0 c(2) 0 ⋯ 0 0
0 0 0 c(2) ⋯ 0 0

⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮
0 0 0 0 ⋯ c(N) 0
0 0 0 0 ⋯ 0 c(N)

Caution If N = 2, 3, or 4, the 2-, 3-, or 4-element column vector form takes precedence
over the N-element form. For example, if N = 3, and you have a c matrix of the form

c1 0 0 0 0 0
0 c1 0 0 0 0
0 0 c2 0 0 0
0 0 0 c2 0 0
0 0 0 0 c3 0
0 0 0 0 0 c3

you cannot use the N-element form of c. Instead, you must use the 2N-element form. If
you give c as the vector [c1;c2;c3], the software interprets c as a 3-element form:
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c1 c2 0 0 0 0
c2 c3 0 0 0 0
0 0 c1 c2 0 0
0 0 c2 c3 0 0
0 0 0 0 c1 c2
0 0 0 0 c2 c3

Instead, use the 2N-element form [c1;c1;c2;c2;c3;c3].

2N-Element Column Vector c, 2-D Systems

The software interprets a 2N-element column vector c as a diagonal matrix.

c(1) 0 0 0 ⋯ 0 0
0 c(2) 0 0 ⋯ 0 0

0 0 c(3) 0 ⋯ 0 0
0 0 0 c(4) ⋯ 0 0

⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮
0 0 0 0 ⋯ c(2N − 1) 0
0 0 0 0 ⋯ 0 c(2N)

Caution If N = 2, the 4-element form takes precedence over the 2N-element form. For
example, if your c matrix is

c1 0 0 0
0 c2 0 0
0 0 c3 0
0 0 0 c4

you cannot give c as [c1;c2;c3;c4], because the software interprets this vector as the
4-element form
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c1 c3 0 0
c2 c4 0 0
0 0 c1 c3
0 0 c2 c4

Instead, use the 3N-element form [c1;0;c2;c3;0;c4] or the 4N-element form
[c1;0;0;c2;c3;0;0;c4].

3N-Element Column Vector c, 2-D Systems

The software interprets a 3N-element column vector c as a symmetric block diagonal
matrix.

c(1) c(2) 0 0 ⋯ 0 0
c(2) c(3) 0 0 ⋯ 0 0

0 0 c(4) c(5) ⋯ 0 0
0 0 c(5) c(6) ⋯ 0 0

⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮
0 0 0 0 ⋯ c(3N − 2) c(3N − 1)
0 0 0 0 ⋯ c(3N − 1) c(3N)

Coefficient c(i,j,k,l) is in row (3i + k + l – 4) of the vector c.

4N-Element Column Vector c, 2-D Systems

The software interprets a 4N-element column vector c as a block diagonal matrix.

c(1) c(3) 0 0 ⋯ 0 0
c(2) c(4) 0 0 ⋯ 0 0

0 0 c(5) c(7) ⋯ 0 0
0 0 c(6) c(8) ⋯ 0 0

⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮
0 0 0 0 ⋯ c(4N − 3) c(4N − 1)
0 0 0 0 ⋯ c(4N − 2) c(4N)

Coefficient c(i,j,k,l) is in row (4i + 2l + k – 6) of the vector c.
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2N(2N+1)/2-Element Column Vector c, 2-D Systems

The software interprets a 2N(2N+1)/2-element column vector c as a symmetric matrix. In
the following diagram, • means the entry is symmetric.

c(1) c(2) c(4) c(6) ⋯ c((N − 1)(2N − 1) + 1) c((N − 1)(2N − 1) + 3)
• c(3) c(5) c(7) ⋯ c((N − 1)(2N − 1) + 2) c((N − 1)(2N − 1) + 4)

• • c(8) c(9) ⋯ c((N − 1)(2N − 1) + 5) c((N − 1)(2N − 1) + 7)
• • • c(10) ⋯ c((N − 1)(2N − 1) + 6) c((N − 1)(2N − 1) + 8)

⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮
• • • • ⋯ c(N(2N + 1) − 2) c(N(2N + 1) − 1)
• • • • ⋯ • c(N(2N + 1))

Coefficient c(i,j,k,l), for i < j, is in row (2j2 – 3j + 4i + 2l + k – 5) of the vector c. For i = j,
coefficient c(i,j,k,l) is in row (2i2 + i + l + k – 4) of the vector c.

4N2-Element Column Vector c, 2-D Systems

The software interprets a 4N2-element column vector c as a matrix.

c(1) c(3) c(4N + 1) c(4N + 3) ⋯ c(4N(N − 1) + 1) c(4N(N − 1) + 3)
c(2) c(4) c(4N + 2) c(4N + 4) ⋯ c(4N(N − 1) + 2) c(4N(N − 1) + 4)

c(5) c(7) c(4N + 5) c(4N + 7) ⋯ c(4N(N − 1) + 5) c(4N(N − 1) + 7)
c(6) c(8) c(4N + 6) c(4N + 8) ⋯ c(4N(N − 1) + 6) c(4N(N − 1) + 8)

⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮
c(4N − 3) c(4N − 1) c(8N − 3) c(8N − 1) ⋯ c(4N2− 3) c(4N2− 1)

c(4N − 2) c(4N) c(8N − 2) c(8N) ⋯ c(4N2− 2) c(4N2)

Coefficient c(i,j,k,l) is in row (4N(j–1) + 4i + 2l + k – 6) of the vector c.

3-D Systems
• “Scalar c, 3-D Systems” on page 2-133
• “Three-Element Column Vector c, 3-D Systems” on page 2-133
• “Six-Element Column Vector c, 3-D Systems” on page 2-134
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• “Nine-Element Column Vector c, 3-D Systems” on page 2-135
• “N-Element Column Vector c, 3-D Systems” on page 2-135
• “3N-Element Column Vector c, 3-D Systems” on page 2-136
• “6N-Element Column Vector c, 3-D Systems” on page 2-138
• “9N-Element Column Vector c, 3-D Systems” on page 2-139
• “3N(3N+1)/2-Element Column Vector c, 3-D Systems” on page 2-139
• “9N2-Element Column Vector c, 3-D Systems” on page 2-140

Scalar c, 3-D Systems

The software interprets a scalar c as a diagonal matrix, with c(i,i,1,1), c(i,i,2,2), and
c(i,i,3,3) equal to the scalar, and all other entries 0.

c 0 0 0 0 0 ⋯ 0 0 0
0 c 0 0 0 0 ⋯ 0 0 0
0 0 c 0 0 0 ⋯ 0 0 0

0 0 0 c 0 0 ⋯ 0 0 0
0 0 0 0 c 0 ⋯ 0 0 0
0 0 0 0 0 c ⋯ 0 0 0
⋮ ⋮ ⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮ ⋮
0 0 0 0 0 0 ⋯ c 0 0
0 0 0 0 0 0 ⋯ 0 c 0
0 0 0 0 0 0 ⋯ 0 0 c

Three-Element Column Vector c, 3-D Systems

The software interprets a three-element column vector c as a diagonal matrix, with
c(i,i,1,1), c(i,i,2,2), and c(i,i,3,3) as the three entries, and all other entries 0.
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c(1) 0 0 0 0 0 ⋯ 0 0 0
0 c(2) 0 0 0 0 ⋯ 0 0 0
0 0 c(3) 0 0 0 ⋯ 0 0 0

0 0 0 c(1) 0 0 ⋯ 0 0 0
0 0 0 0 c(2) 0 ⋯ 0 0 0
0 0 0 0 0 c(3) ⋯ 0 0 0
⋮ ⋮ ⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮ ⋮
0 0 0 0 0 0 ⋯ c(1) 0 0
0 0 0 0 0 0 ⋯ 0 c(2) 0
0 0 0 0 0 0 ⋯ 0 0 c(3)

Six-Element Column Vector c, 3-D Systems

The software interprets a six-element column vector c as a symmetric block diagonal
matrix, with

c(i,i,1,1) = c(1)
c(i,i,2,2) = c(3)
c(i,i,1,2) = c(i,i,2,1) = c(2)
c(i,i,1,3) = c(i,i,3,1) = c(4)
c(i,i,2,3) = c(i,i,3,2) = c(5)
c(i,i,3,3) = c(6).

In the following diagram, • means the entry is symmetric.

c(1) c(2) c(4) 0 0 0 ⋯ 0 0 0
• c(3) c(5) 0 0 0 ⋯ 0 0 0
• • c(6) 0 0 0 ⋯ 0 0 0

0 0 0 c(1) c(2) c(4) ⋯ 0 0 0
0 0 0 • c(3) c(5) ⋯ 0 0 0
0 0 0 • • c(6) ⋯ 0 0 0
⋮ ⋮ ⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮ ⋮
0 0 0 0 0 0 ⋯ c(1) c(2) c(4)
0 0 0 0 0 0 ⋯ • c(3) c(5)
0 0 0 0 0 0 ⋯ • • c(6)
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Nine-Element Column Vector c, 3-D Systems

The software interprets a nine-element column vector c as a block diagonal matrix.

c(1) c(4) c(7) 0 0 0 ⋯ 0 0 0
c(2) c(5) c(8) 0 0 0 ⋯ 0 0 0
c(3) c(6) c(9) 0 0 0 ⋯ 0 0 0

0 0 0 c(1) c(4) c(7) ⋯ 0 0 0
0 0 0 c(2) c(5) c(8) ⋯ 0 0 0
0 0 0 c(3) c(6) c(9) ⋯ 0 0 0
⋮ ⋮ ⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮ ⋮
0 0 0 0 0 0 ⋯ c(1) c(4) c(7)
0 0 0 0 0 0 ⋯ c(2) c(5) c(8)
0 0 0 0 0 0 ⋯ c(3) c(6) c(3)

N-Element Column Vector c, 3-D Systems

The software interprets an N-element column vector c as a diagonal matrix.

c(1) 0 0 0 0 0 ⋯ 0 0 0
0 c(1) 0 0 0 0 ⋯ 0 0 0
0 0 c(1) 0 0 0 ⋯ 0 0 0

0 0 0 c(2) 0 0 ⋯ 0 0 0
0 0 0 0 c(2) 0 ⋯ 0 0 0
0 0 0 0 0 c(2) ⋯ 0 0 0
⋮ ⋮ ⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮ ⋮
0 0 0 0 0 0 ⋯ c(N) 0 0
0 0 0 0 0 0 ⋯ 0 c(N) 0
0 0 0 0 0 0 ⋯ 0 0 c(N)

Caution If N = 3, 6, or 9, the 3-, 6-, or 9-element column vector form takes precedence
over the N-element form. For example, if N = 3, and you have a c matrix of the form
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c(1) 0 0 0 0 0 0 0 0
0 c(1) 0 0 0 0 0 0 0
0 0 c(1) 0 0 0 0 0 0

0 0 0 c(2) 0 0 0 0 0
0 0 0 0 c(2) 0 0 0 0
0 0 0 0 0 c(2) 0 0 0

0 0 0 0 0 0 c(3) 0 0
0 0 0 0 0 0 0 c(3) 0
0 0 0 0 0 0 0 0 c(3)

you cannot use the N-element form of c. If you give c as the vector [c1;c2;c3], the
software interprets c as a 3-element form:

c(1) 0 0 0 0 0 0 0 0
0 c(2) 0 0 0 0 0 0 0
0 0 c(3) 0 0 0 0 0 0

0 0 0 c(1) 0 0 0 0 0
0 0 0 0 c(2) 0 0 0 0
0 0 0 0 0 c(3) 0 0 0

0 0 0 0 0 0 c(1) 0 0
0 0 0 0 0 0 0 c(2) 0
0 0 0 0 0 0 0 0 c(3)

Instead, use one of these forms:

• 6N-element form — [c1;0;c1;0;0;c1;c2;0;c2;0;0;c2;c3;0;c3;0;0;c3]
• 9N-element form —

[c1;0;0;0;c1;0;0;0;c1;c2;0;0;0;c2;0;0;0;c2;c3;0;0;0;c3;0;0;0;c3]

3N-Element Column Vector c, 3-D Systems

The software interprets a 3N-element column vector c as a diagonal matrix.
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c(1) 0 0 0 0 0 ⋯ 0 0 0
0 c(2) 0 0 0 0 ⋯ 0 0 0
0 0 c(3) 0 0 0 ⋯ 0 0 0

0 0 0 c(4) 0 0 ⋯ 0 0 0
0 0 0 0 c(5) 0 ⋯ 0 0 0
0 0 0 0 0 c(6) ⋯ 0 0 0
⋮ ⋮ ⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮ ⋮
0 0 0 0 0 0 ⋯ c(3N − 2) 0 0
0 0 0 0 0 0 ⋯ 0 c(3N − 1) 0
0 0 0 0 0 0 ⋯ 0 0 c(3N)

Caution If N = 3, the 9-element form takes precedence over the 3N-element form. For
example, if your c matrix is

c(1) 0 0 0 0 0 0 0 0
0 c(2) 0 0 0 0 0 0 0
0 0 c(3) 0 0 0 0 0 0

0 0 0 c(4) 0 0 0 0 0
0 0 0 0 c(5) 0 0 0 0
0 0 0 0 0 c(6) 0 0 0

0 0 0 0 0 0 c(7) 0 0
0 0 0 0 0 0 0 c(8) 0
0 0 0 0 0 0 0 0 c(9)

you cannot give c as [c1;c2;c3;c4;c5;c6;c7;c8;c9], because the software
interprets this vector as the 9-element form
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c(1) c(4) c(7) 0 0 0 0 0 0
c(2) c(5) c(8) 0 0 0 0 0 0
c(3) c(6) c(9) 0 0 0 0 0 0

0 0 0 c(1) c(4) c(7) 0 0 0
0 0 0 c(2) c(5) c(8) 0 0 0
0 0 0 c(3) c(6) c(9) 0 0 0

0 0 0 0 0 0 c(1) c(4) c(7)
0 0 0 0 0 0 c(2) c(5) c(8)
0 0 0 0 0 0 c(3) c(6) c(3)

Instead, use one of these forms:

• 6N-element form — [c1;0;c2;0;0;c3;c4;0;c5;0;0;c6;c7;0;c8;0;0;c9]
• 9N-element form —

[c1;0;0;0;c2;0;0;0;c3;c4;0;0;0;c5;0;0;0;c6;c7;0;0;0;c8;0;0;0;c9]

6N-Element Column Vector c, 3-D Systems

The software interprets a 6N-element column vector c as a symmetric block diagonal
matrix. In the following diagram, • means the entry is symmetric.

c(1) c(2) c(4) 0 0 0 ⋯ 0 0 0
• c(3) c(5) 0 0 0 ⋯ 0 0 0
• • c(6) 0 0 0 ⋯ 0 0 0

0 0 0 c(7) c(8) c(10) ⋯ 0 0 0
0 0 0 • c(9) c(11) ⋯ 0 0 0
0 0 0 • • c(12) ⋯ 0 0 0
⋮ ⋮ ⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮ ⋮
0 0 0 0 0 0 ⋯ c(6N − 5) c(6N − 4) c(6N − 2)
0 0 0 0 0 0 ⋯ • c(6N − 3) c(6N − 1)
0 0 0 0 0 0 ⋯ • • c(6N)

Coefficient c(i,j,k,l) is in row (6i + k + 1/2l(l–1) – 6) of the vector c.
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9N-Element Column Vector c, 3-D Systems

The software interprets a 9N-element column vector c as a block diagonal matrix.

c(1) c(4) c(7) 0 0 0 ⋯ 0 0 0
c(2) c(5) c(8) 0 0 0 ⋯ 0 0 0
c(3) c(6) c(9) 0 0 0 ⋯ 0 0 0

0 0 0 c(10) c(13) c(16) ⋯ 0 0 0
0 0 0 c(11) c(14) c(17) ⋯ 0 0 0
0 0 0 c(12) c(15) c(18) ⋯ 0 0 0
⋮ ⋮ ⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮ ⋮
0 0 0 0 0 0 ⋯ c(9N − 8) c(9N − 5) c(9N − 2)
0 0 0 0 0 0 ⋯ c(9N − 7) c(9N − 4) c(9N − 1)
0 0 0 0 0 0 ⋯ c(9N − 6) c(9N − 3) c(9N)

Coefficient c(i,j,k,l) is in row (9i + 3l + k – 12) of the vector c.

3N(3N+1)/2-Element Column Vector c, 3-D Systems

The software interprets a 3N(3N+1)/2-element column vector c as a symmetric matrix. In
the following diagram, • means the entry is symmetric.
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c(1) c(2) c(4) c(7) c(10) c(13) ⋯ c(3(N − 1)(3(N − 1) + 1)/2 + 1 c(3(N − 1)(3(N − 1) + 1)/2 + 4 c(3(N − 1)(3(N − 1) + 1)/2 + 7
• c(3) c(5) c(8) c(11) c(14) ⋯ c(3(N − 1)(3(N − 1) + 1)/2 + 2 c(3(N − 1)(3(N − 1) + 1)/2 + 5 c(3(N − 1)(3(N − 1) + 1)/2 + 8
• • c(6) c(9) c(12) c(15) ⋯ c(3(N − 1)(3(N − 1) + 1)/2 + 3 c(3(N − 1)(3(N − 1) + 1)/2 + 6 c(3(N − 1)(3(N − 1) + 1)/2 + 9

• • • c(16) c(17) c(19) ⋯ c(3(N − 1)(3(N − 1) + 1)/2 + 10 c(3(N − 1)(3(N − 1) + 1)/2 + 13 c(3(N − 1)(3(N − 1) + 1)/2 + 16
• • • • c(18) c(20) ⋯ c(3(N − 1)(3(N − 1) + 1)/2 + 11 c(3(N − 1)(3(N − 1) + 1)/2 + 14 c(3(N − 1)(3(N − 1) + 1)/2 + 17
• • • • • c(21) ⋯ c(3(N − 1)(3(N − 1) + 1)/2 + 12 c(3(N − 1)(3(N − 1) + 1)/2 + 15 c(3(N − 1)(3(N − 1) + 1)/2 + 18
⋮ ⋮ ⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮ ⋮
• • • • • • ⋯ c(3N(3N + 1)/2 − 5) c(3N(3N + 1)/2 − 4) c(3N(3N + 1)/2 − 2)
• • • • • • ⋯ • c(3N(3N + 1)/2 − 3) c(3N(3N + 1)/2 − 1)
• • • • • • ⋯ • • c(3N(3N + 1)/2)

Coefficient c(i,j,k,l), for i < j, is in row (9(j–1)(j–2)/2 + 6(j–1) + 9i + 3l + k – 12) of the
vector c. For i = j, coefficient c(i,j,k,l) is in row (9(i–1)(i–2)/2 + 15(i–1) + 1/2l(l–1) + k) of
the vector c.

9N2-Element Column Vector c, 3-D Systems

The software interprets a 9N2-element column vector c as a matrix.
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c(1) c(4) c(7) c(9N + 1) c(9N + 4) c(9N + 7) ⋯ c(9N(N − 1) + 1) c(9N(N − 1) + 4) c(9N(N − 1) + 7)
c(2) c(5) c(8) c(9N + 2) c(9N + 5) c(9N + 8) ⋯ c(9N(N − 1) + 2) c(9N(N − 1) + 5) c(9N(N − 1) + 8)
c(3) c(6) c(9) c(9N + 3) c(9N + 6) c(9N + 9) ⋯ c(9N(N − 1) + 3) c(9N(N − 1) + 6) c(9N(N − 1) + 9)

c(10) c(13) c(16) c(9N + 10) c(9N + 13) c(9N + 16) ⋯ c(9N(N − 1) + 10) c(9N(N − 1) + 13) c(9N(N − 1) + 16)
c(11) c(14) c(17) c(9N + 11) c(9N + 14) c(9N + 17) ⋯ c(9N(N − 1) + 11) c(9N(N − 1) + 14) c(9N(N − 1) + 17)
c(12) c(15) c(18) c(9N + 12) c(9N + 15) c(9N + 18) ⋯ c(9N(N − 1) + 12) c(9N(N − 1) + 15) c(9N(N − 1) + 18)
⋮ ⋮ ⋮ ⋮ ⋮ ⋮ ⋱ ⋮ ⋮ ⋮

c(9N − 8) c(9N − 5) c(9N − 2) c(18N − 8) c(18N − 5) c(18N − 2) ⋯ c(9N2− 8) c(9N2− 5) c(9N2− 2)

c(9N − 7) c(9N − 4) c(9N − 1) c(18N − 7) c(18N − 4) c(18N − 1) ⋯ c(9N2− 7) c(9N2− 4) c(9N2− 1)

c(9N − 6) c(9N − 3) c(9N) c(18N − 6) c(18N − 3) c(18N) ⋯ c(9N2− 6) c(9N2− 3) c(9N2)

Coefficient c(i,j,k,l) is in row (9N(j–1) + 9i + 3l + k – 12) of the vector c.
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m, d, or a Coefficient for specifyCoefficients
In this section...
“Coefficients m, d, or a” on page 2-142
“Short m, d, or a vectors” on page 2-143
“Nonconstant m, d, or a” on page 2-144

Coefficients m, d, or a
This section describes how to write the m, d, or a coefficients in the system of equations

m∂2u
∂t2 + d∂u∂t − ∇ · c⊗ ∇u + au = f

or in the eigenvalue system

−∇ · c⊗ ∇u + au = λdu
or

−∇ · c⊗ ∇u + au = λ2mu

The topic applies to the recommended workflow for including coefficients in your model
using specifyCoefficients.

If there are N equations in the system, then these coefficients represent N-by-N matrices.

For constant (numeric) coefficient matrices, represent each coefficient using a column
vector with N2 components. This column vector represents, for example, m(:).

For nonconstant coefficient matrices, see “Nonconstant m, d, or a” on page 2-144.

Note The d coefficient takes a special matrix form when m is nonzero. See “d Coefficient
When m is Nonzero” on page 5-927.
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Short m, d, or a vectors
Sometimes, your m, d, or a matrices are diagonal or symmetric. In these cases, you can
represent m, d, or a using a smaller vector than one with N2 components. The following
sections give the possibilities.

• “Scalar m, d, or a” on page 2-143
• “N-Element Column Vector m, d, or a” on page 2-143
• “N(N+1)/2-Element Column Vector m, d, or a” on page 2-143
• “N2-Element Column Vector m, d, or a” on page 2-144

Scalar m, d, or a

The software interprets a scalar m, d, or a as a diagonal matrix.

a 0 ⋯ 0
0 a ⋯ 0
⋮ ⋮ ⋱ ⋮
0 0 ⋯ a

N-Element Column Vector m, d, or a

The software interprets an N-element column vector m, d, or a as a diagonal matrix.

d(1) 0 ⋯ 0
0 d(2) ⋯ 0
⋮ ⋮ ⋱ ⋮
0 0 ⋯ d(N)

N(N+1)/2-Element Column Vector m, d, or a

The software interprets an N(N+1)/2-element column vector m, d, or a as a symmetric
matrix. In the following diagram, • means the entry is symmetric.

a(1) a(2) a(4) ⋯ a(N(N − 1)/2)
• a(3) a(5) ⋯ a(N(N − 1)/2 + 1)
• • a(6) ⋯ a(N(N − 1)/2 + 2)
⋮ ⋮ ⋮ ⋱ ⋮
• • • ⋯ a(N(N + 1)/2)
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Coefficient a(i,j) is in row (j(j–1)/2+i) of the vector a.

N2-Element Column Vector m, d, or a

The software interprets an N2-element column vector m, d, or a as a matrix.

d(1) d(N + 1) ⋯ d(N2− N + 1)

d(2) d(N + 2) ⋯ d(N2− N + 2)
⋮ ⋮ ⋱ ⋮

d(N) d(2N) ⋯ d(N2)

Coefficient a(i,j) is in row (N(j–1)+i) of the vector a.

Nonconstant m, d, or a

Note If both m and d are nonzero, then d must be a constant scalar or vector, not a
function.

If any of the m, d, or a coefficients is not constant, represent it as a function of the form

dcoeffunction(location,state)

solvepde or solvepdeeig pass the location and state structures to
dcoeffunction. The function must return a matrix of size N1-by-Nr, where:

• N1 is the length of the vector representing the coefficient. There are several possible
values of N1, detailed in “Short m, d, or a vectors” on page 2-143. 1 ≤ N1 ≤ N2.

• Nr is the number of points in the location that the solver passes. Nr is equal to the
length of the location.x or any other location field. The function should evaluate
m, d, or a at these points.

Pass the coefficient to specifyCoefficients as a function handle, such as

specifyCoefficients(model,'d',@dcoeffunction,...)

• location is a structure with these fields:

• location.x
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• location.y
• location.z
• location.subdomain

The fields x, y, and z represent the x-, y-, and z- coordinates of points for which your
function calculates coefficient values. The subdomain field represents the subdomain
numbers, which currently apply only to 2-D models. The location fields are row
vectors.

• state is a structure with these fields:

• state.u
• state.ux
• state.uy
• state.uz
• state.time

The state.u field represents the current value of the solution u. The state.ux,
state.uy, and state.uz fields are estimates of the solution’s partial derivatives
(∂u/∂x, ∂u/∂y, and ∂u/∂z) at the corresponding points of the location structure. The
solution and gradient estimates are N-by-Nr matrices. The state.time field is a
scalar representing time for time-dependent models.

For example, suppose N = 3, and you have 2-D geometry. Suppose your d matrix is of the
form

d =
1 s1(x, y) x2 + y2

s1(x, y) 4 −1

x2 + y2 −1 9

where s1(x,y) is 5 in subdomain 1, and is 10 in subdomain 2.

This d is a symmetric matrix. So it is natural to represent d as a “N(N+1)/2-Element
Column Vector m, d, or a” on page 2-143:
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a(1) a(2) a(4) ⋯ a(N(N − 1)/2)
• a(3) a(5) ⋯ a(N(N − 1)/2 + 1)
• • a(6) ⋯ a(N(N − 1)/2 + 2)
⋮ ⋮ ⋮ ⋱ ⋮
• • • ⋯ a(N(N + 1)/2)

For that form, the following function is appropriate.

function dmatrix = dcoeffunction(location,state)

n1 = 6;
nr = numel(location.x);
dmatrix = zeros(n1,nr);
dmatrix(1,:) = ones(1,nr);
dmatrix(2,:) = 5*location.subdomain;
dmatrix(3,:) = 4*ones(1,nr);
dmatrix(4,:) = sqrt(location.x.^2 + location.y.^2);
dmatrix(5,:) = -ones(1,nr);
dmatrix(6,:) = 9*ones(1,nr);

To include this function as your d coefficient, pass the function handle @dcoeffunction:

specifyCoefficients(model,'d',@dcoeffunction,...

See Also

Related Examples
• “f Coefficient for specifyCoefficients” on page 2-97
• “c Coefficient for specifyCoefficients” on page 2-100
• “Solve Problems Using PDEModel Objects” on page 2-6
• “Deflection of Piezoelectric Actuator” on page 3-12
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a or d Coefficient for Systems

Note THIS PAGE DESCRIBES THE LEGACY WORKFLOW. New features might not be
compatible with the legacy workflow. For the corresponding step in the recommended
workflow, see “m, d, or a Coefficient for specifyCoefficients” on page 2-142.

In this section...
“Coefficients a or d” on page 2-147
“Scalar a or d” on page 2-148
“N-Element Column Vector a or d” on page 2-148
“N(N+1)/2-Element Column Vector a or d” on page 2-148
“N2-Element Column Vector a or d” on page 2-149

Coefficients a or d
This section describes how to write the coefficients a or d in the equation

d∂u∂t − ∇ ⋅ c⊗ ∇u + au = f

or in similar equations. a and d are N-by-N matrices, where N is the number of equations,
see “Equations You Can Solve Using Legacy Functions” on page 1-3.

Express the coefficients as numbers, text expressions, or functions, as in “f Coefficient for
Systems” on page 2-94.

The number of rows in the matrix is either 1, N, N(N+1)/2, or N2, as described in the next
few sections. If you choose to express the coefficients in functional form, the number of
columns is Nt, which is the number of triangles in the mesh. The function should evaluate
a or d at the triangle centroids, as in “Specify 2-D Scalar Coefficients in Function Form”
on page 2-80. Give solvers the function name as 'filename', or as a function handle
@filename, where filename.m is a file on your MATLAB path. For details on how to
write the function, see “Calculate Coefficients in Function Form” on page 2-81.

Often, a or d have structure, either as symmetric or diagonal. In these cases, you can
represent a or d using fewer than N2 rows.
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Scalar a or d
The software interprets a scalar a or d as a diagonal matrix.

a 0 ⋯ 0
0 a ⋯ 0
⋮ ⋮ ⋱ ⋮
0 0 ⋯ a

N-Element Column Vector a or d
The software interprets an N-element column vector a or d as a diagonal matrix.

d(1) 0 ⋯ 0
0 d(2) ⋯ 0
⋮ ⋮ ⋱ ⋮
0 0 ⋯ d(N)

For example, if N = 3, a or d could be

a = char('sin(x) + cos(y)','cosh(x.*y)','x.*y./(1+x.^2+y.^2)') % or d

a =

sin(x) + cos(y)    
cosh(x.*y)         
x.*y./(1+x.^2+y.^2)

N(N+1)/2-Element Column Vector a or d
The software interprets an N(N+1)/2-element column vector a or d as a symmetric
matrix. In the following diagram, • means the entry is symmetric.

a(1) a(2) a(4) ⋯ a(N(N − 1)/2)
• a(3) a(5) ⋯ a(N(N − 1)/2 + 1)
• • a(6) ⋯ a(N(N − 1)/2 + 2)
⋮ ⋮ ⋮ ⋱ ⋮
• • • ⋯ a(N(N + 1)/2)
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Coefficient a(i,j) is in row (j(j–1)/2+i) of the vector a.

N2-Element Column Vector a or d
The software interprets an N2-element column vector a or d as a matrix.

d(1) d(N + 1) ⋯ d(N2− N + 1)

d(2) d(N + 2) ⋯ d(N2− N + 2)
⋮ ⋮ ⋱ ⋮

d(N) d(2N) ⋯ d(N2)

Coefficient a(i,j) is in row (N(j–1)+i) of the vector a.
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View, Edit, and Delete PDE Coefficients

View Coefficients
A PDE model stores coefficients in its EquationCoefficients property. Suppose model
is the name of your model. Obtain the coefficients:

coeffs = model.EquationCoefficients;

To see the active coefficient assignment for a region, call the findCoefficients
function. For example, create a model and view the geometry.

model = createpde();
geometryFromEdges(model,@lshapeg);
pdegplot(model,'FaceLabels','on')
ylim([-1.1,1.1])
axis equal
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Specify constant coefficients over all the regions in the model.

specifyCoefficients(model,'m',0,'d',0,'c',1,'a',0,'f',2);

Specify a different f coefficient on each subregion.

specifyCoefficients(model,'m',0,'d',0,'c',1,'a',0,'f',3,'Face',2);
specifyCoefficients(model,'m',0,'d',0,'c',1,'a',0,'f',4,'Face',3);

Change the specification to have nonzero a on region 2.

specifyCoefficients(model,'m',0,'d',0,'c',1,'a',1,'f',3,'Face',2);

View the coefficient assignment for region 2.
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coeffs = model.EquationCoefficients;
findCoefficients(coeffs,'Face',2)

ans = 
  CoefficientAssignment with properties:

    RegionType: 'face'
      RegionID: 2
             m: 0
             d: 0
             c: 1
             a: 1
             f: 3

This shows the "last assignment wins" characteristic.

View the coefficient assignment for region 1.

findCoefficients(coeffs,'Face',1)

ans = 
  CoefficientAssignment with properties:

    RegionType: 'face'
      RegionID: [1 2 3]
             m: 0
             d: 0
             c: 1
             a: 0
             f: 2

The active coefficient assignment for region 1 includes all three regions, though this
assignment is no longer active for regions 2 and 3.

Delete Existing Coefficients
To delete all the coefficients in your PDE model, use delete. Suppose model is the name
of your model. Remove all coefficients from model.

delete(model.EquationCoefficients)
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To delete specific coefficient assignments, delete them from the
model.EquationCoefficients.CoefficientAssignments vector.

coefv = model.EquationCoefficients.CoefficientAssignments;
delete(coefv(2))

Tip You do not need to delete coefficients; you can override them by calling
specifyCoefficients again. However, deleting unused assignments can make your
model smaller.

Change a Coefficient Assignment
To change a coefficient assignment, you need the coefficient handle. To get the coefficient
handle:

• Retain the handle when using specifyCoefficients. For example,

coefh1 = specifyCoefficients(model,'m',m,'d',d,'c',c,'a',a,'f',f);
• Obtain the handle using findCoefficients. For example,

coeffs = model.EquationCoefficients;
coefh1 = findCoefficients(coeffs,'face',2);

You can change any property of the coefficient handle. For example,

coefh1.RegionID = [1,3];
coefh1.a = 2;
coefh1.c = @ccoeffun;

Note Editing an existing assignment in this way does not change its priority. For
example, if the active coefficient in region 3 was assigned after coefh1, then editing
coefh1 to include region 3 does not make coefh1 the active coefficient in region 3.
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Set Initial Conditions
What Are Initial Conditions?
The term initial condition has two meanings:

• For time-dependent problems, the initial condition is the solution u at the initial time,
and also the initial time-derivative if the m coefficient is nonzero. Set the initial
condition in the model using setInitialConditions.

• For nonlinear stationary problems, the initial condition is a guess or approximation of
the solution u at the initial iteration of the nonlinear solver. Set the initial condition in
the model using setInitialConditions.

If you do not specify the initial condition for a stationary problem, solvepde uses the
zero function for the initial iteration.

Constant Initial Conditions
For a system of N equations, you can give constant initial conditions as either a scalar or
as a vector with N components. For example, if the initial condition is u = 15 for all
components, use the following command.

setInitialConditions(model,15);

If N = 3, and the initial condition is 15 for the first equation, 0 for the second equation,
and –3 for the third equation, use the following commands.

u0 = [15,0,-3];
setInitialConditions(model,u0);

If the m coefficient is nonzero, give an initial condition for the time derivative as well. Set
this initial derivative in the same form as the first initial condition. For example, if the
initial derivative of the solution is [4,3,0], use the following commands.

u0 = [15,0,-3];
ut0 = [4,3,0];
setInitialConditions(model,u0,ut0);

Nonconstant Initial Conditions
If your initial conditions are not constant, set them by writing a function of the form.
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function u0 = initfun(location)

solvepde passes location as a structure with fields location.x, location.y, and,
for 3-D problems, location.z. initfun must return a matrix u0 of size N-by-M, where
N is the number of equations in your PDE and M = length(location.x). The fields in
location are row vectors.

For example, suppose you have a 2-D problem with N = 2 equations:

∂2u
∂t2 − ∇ · ∇u =

3 + x
4 − x− y

u(0) = 4 + x2 + y2

0
∂u
∂t (0) =

0
sin(xy)

This problem has m = 1, c = 1, and f = 
3 + x

4 − x− y
. Because m is nonzero, give both an

initial value of u and an initial value of the derivative of u.

Write the following function files. Save them to a location on your MATLAB path.

function uinit = u0fun(location)

M = length(location.x);
uinit = zeros(2,M);
uinit(1,:) = 4 + location.x.^2 + location.y.^2;

function utinit = ut0fun(location)

M = length(location.x);
utinit = zeros(2,M);
utinit(2,:) = sin(location.x.*location.y);

Pass the initial conditions to your PDE model:

u0 = @u0fun;
ut0 = @ut0fun;
setInitialConditions(model,u0,ut0);
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Nodal Initial Conditions
You can use results of previous analysis as nodal initial conditions for your current model.
The geometry and mesh of the model you used to obtain the results and the current model
must be the same. For example, solve a time-dependent PDE problem for times from t0 to
t1 with a time step tstep.

results = solvepde(model,t0:tstep:t1);

If later you need to solve this PDE problem for times from t1 to t2, you can use results
to set initial conditions. If you do not explicitly specify the time step,
setInitialConditions uses results corresponding to the last solution time, t1.

setInitialConditions(model,results)

To use results for a particular solution time instead of the last one, specify the solution
time index as a third parameter of setInitialConditions. For example, to use the
solution at time t0 + 10*tstep, specify 11 as the third parameter.

setInitialConditions(model,results,11)

See Also

Related Examples
• “Solve Problems Using PDEModel Objects” on page 2-6
• “Wave Equation on Square Domain”
• “Inhomogeneous Heat Equation on Square Domain”
• “Heat Distribution in Circular Cylindrical Rod”
• “Heat Transfer Problem with Temperature-Dependent Properties”
• “Dynamic Analysis of Clamped Beam”
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View, Edit, and Delete Initial Conditions

View Initial Conditions
A PDE model stores initial conditions in its InitialConditions property. Suppose
model is the name of your model. Obtain the initial conditions:

inits = model.InitialConditions;

To see the active initial conditions assignment for a region, call the
findInitialConditions function. For example, create a model and view the geometry.

model = createpde();
geometryFromEdges(model,@lshapeg);
pdegplot(model,'FaceLabels','on')
ylim([-1.1,1.1])
axis equal
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Specify constant initial conditions over all the regions in the model.

setInitialConditions(model,2);

Specify a different initial condition on each subregion.

setInitialConditions(model,3,'Face',2);
setInitialConditions(model,4,'Face',3);

View the initial condition assignment for region 2.

ics = model.InitialConditions;
findInitialConditions(ics,'Face',2)
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ans = 
  GeometricInitialConditions with properties:

           RegionType: 'face'
             RegionID: 2
         InitialValue: 3
    InitialDerivative: []

This shows the "last assignment wins" characteristic.

View the initial conditions assignment for region 1.

findInitialConditions(ics,'Face',1)

ans = 
  GeometricInitialConditions with properties:

           RegionType: 'face'
             RegionID: [1 2 3]
         InitialValue: 2
    InitialDerivative: []

The active initial conditions assignment for region 1 includes all three regions, though
this assignment is no longer active for regions 2 and 3.

Delete Existing Initial Conditions
To delete all the initial conditions in your PDE model, use delete. Suppose model is the
name of your model. Remove all initial conditions from model.

delete(model.InitialConditions)

To delete specific initial conditions assignments, delete them from the
model.InitialConditions.InitialConditionAssignments vector.

icv = model.InitialConditions.InitialConditionAssignments;
delete(icv(2))
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Tip You do not need to delete initial conditions; you can override them by calling
setInitialConditions again. However, deleting unused assignments can make your
model smaller.

Change an Initial Conditions Assignment
To change an initial conditions assignment, you need the initial conditions handle. To get
the initial condition handle:

• Retain the handle when using setInitialConditions. For example,

ics1 = setInitialConditions(model,2);
• Obtain the handle using findInitialConditions. For example,

ics = model.InitialConditions;
ics1 = findInitialConditions(ics,'Face',2);

You can change any property of the initial conditions handle. For example,

ics1.RegionID = [1,3];
ics1.InitialValue = 2;
ics1.InitialDerivative = @ut0fun;

Note Editing an existing assignment in this way does not change its priority. For
example, if the active initial conditions in region 3 was assigned after ics1, then editing
ics1 to include region 3 does not make ics1 the active initial condition in region 3.
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Solve PDEs with Initial Conditions

Note THIS PAGE DESCRIBES THE LEGACY WORKFLOW. New features might not be
compatible with the legacy workflow. For the corresponding step in the recommended
workflow, see “Set Initial Conditions” on page 2-154.

What Are Initial Conditions?
Initial conditions has two meanings:

• For the parabolic and hyperbolic solvers, the initial condition u0 is the solution u
at the initial time. You must specify the initial condition for these solvers. Pass the
initial condition in the first argument or arguments.

u = parabolic(u0,...
or
u = hyperbolic(u0,ut0,...

For the hyperbolic solver, you must also specify ut0, which is the value of the
derivative of u with respect to time at the initial time. ut0 has the same form as u0.

• For nonlinear elliptic problems, the initial condition u0 is a guess or approximation of
the solution u at the initial iteration of the pdenonlin nonlinear solver. You pass u0 in
the 'U0' name-value pair.

u = pdenonlin(b,p,e,t,c,a,f,'U0',u0)

If you do not specify initial conditions, pdenonlin uses the zero function for the initial
iteration.

Constant Initial Conditions
You can specify initial conditions as a constant by passing a scalar or character vector.

• For scalar problems or systems of equations, give a scalar as the initial condition. For
example, set u0 to 5 for an initial condition of 5 in every component.

• For systems of N equations, give a character vector initial condition with N rows. For
example, if there are N = 3 equations, you can give initial conditions
u0 = char('3','-3','0').
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Initial Conditions in Character Form
You can specify text expressions for the initial conditions. The initial conditions are
functions of x and y alone, and, for 3-D problems, z. The text expressions represent
vectors at nodal points, so use .* for multiplication, ./ for division, and .^ for
exponentiation.

For example, if you have an initial condition

u(x, y) = xycos(x)
1 + x2 + y2

then you can use this expression for the initial condition.

'x.*y.*cos(x)./(1 + x.^2 + y.^2)'

For a system of N > 1 equations, use a text array with one row for each component, such
as

char('x.^2 + 5*cos(x.*y)',...
    'tanh(x.*y)./(1 + z.^2)')

Initial Conditions at Mesh Nodes
Pass u0 as a column vector of values at the mesh nodes. The nodes are either
model.Mesh.Nodes, or the p data from initmesh or meshToPet. See “Mesh Data” on
page 2-233.

Tip For reliability, the initial conditions and boundary conditions should be consistent.

The size of the column vector u0 depends on the number of equations, N, and on the
number of nodes in the mesh, Np.

For scalar u, specify a column vector of length Np. The value of element k corresponds to
the node p(k).

For a system of N equations, specify a column vector of N*Np elements. The first Np
elements contain the values of component 1, where the value of element k corresponds to
node p(k). The next Np points contain the values of component 2, etc. It can be
convenient to first represent the initial conditions u0 as an Np-by-N matrix, where the first
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column contains entries for component 1, the second column contains entries for
component 2, etc. The final representation of the initial conditions is u0(:).

For example, suppose you have a function myfun(x,y) that calculates the value of the
initial condition u0(x,y) as a row vector of length N for a 2-D problem. Suppose that p is
the usual mesh node data (see “Mesh Data” on page 2-233). Compute the initial
conditions for all mesh nodes p.

% Assume N and p exist; N = 1 for a scalar problem
np = size(p,2); % Number of mesh points
u0 = zeros(np,N); % Allocate initial matrix
for k = 1:np
    x = p(1,k);
    y = p(2,k);
    u0(k,:) = myfun(x,y); % Fill in row k
end
u0 = u0(:); % Convert to column form

Specify u0 as the initial condition.
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No Boundary Conditions Between Subdomains
There are two types of boundaries:

• Boundaries between the interior of the region and the exterior of the region
• Boundaries between subdomains - these are boundaries in the interior of the region

Boundary conditions, either Dirichlet or generalized Neumann, apply only to boundaries
between the interior and exterior of the region. This is because the toolbox formulation
uses the weak form of PDEs. See “Finite Element Method Basics” on page 1-18. In the
weak formulation you do not specify boundary conditions between subdomains, even if
coefficients are discontinuous between subdomains. So the toolbox does not support
defining boundary conditions on subdomain boundaries.

For example, look at a rectangular region with a circular subdomain. The red numbers
are the subdomain labels, the black numbers are the edge segment labels.

% Rectangle is code 3, 4 sides, followed by x-coordinates and then y-coordinates
R1 = [3,4,-1,1,1,-1,-.4,-.4,.4,.4]';
% Circle is code 1, center (.5,0), radius .2
C1 = [1,.5,0,.2]';
% Pad C1 with zeros to enable concatenation with R1
C1 = [C1;zeros(length(R1)-length(C1),1)];
geom = [R1,C1];

% Names for the two geometric objects
ns = (char('R1','C1'))';

% Set formula
sf = 'R1 + C1';

% Create geometry
gd = decsg(geom,sf,ns);

% View geometry
pdegplot(gd,'EdgeLabels','on','SubdomainLabels','on')
xlim([-1.1 1.1])
axis equal
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You need not give boundary conditions on segments 5, 6, 7, and 8, because these are
subdomain boundaries, not exterior boundaries.

However, if the circle is a hole, meaning it is not part of the region, then you do give
boundary conditions on segments 5, 6, 7, and 8.
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Identify Boundary Labels
You can see the edge labels by using the pdegplot function with the EdgeLabels name-
value pair set to 'on':

pdegplot(g,'EdgeLabels','on')

For 3-D problems, set the FaceLabels name-value pair to 'on'.

For example, look at the edge labels for a simple annulus geometry:

e1 = [4;0;0;1;.5;0]; % Outside ellipse
e2 = [4;0;0;.5;.25;0]; % Inside ellipse
ee = [e1 e2]; % Both ellipses
lbls = char('outside','inside'); % Ellipse labels
lbls = lbls'; % Change to columns
sf = 'outside-inside'; % Set formula
dl = decsg(ee,sf,lbls); % Geometry now done
pdegplot(dl,'EdgeLabels','on')
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Boundary Matrix for 2-D Geometry

Note THIS PAGE DESCRIBES THE LEGACY WORKFLOW. New features might not be
compatible with the legacy workflow. For the corresponding step in the recommended
workflow, see “Specify Boundary Conditions” on page 2-174.

Boundary Matrix Specification
The Boundary Condition matrix is created internally in the PDE Modeler app (actually a
function called by the PDE Modeler app) and then used from the function assemb for
assembling the contributions from the boundary to the matrices Q, G, H, and R. The
Boundary Condition matrix can also be saved as a boundary file for later use with
“Boundary Conditions by Writing Functions” on page 2-197.

For each column in the Decomposed Geometry matrix (see “Decomposed Geometry Data
Structure” on page 2-15) there must be a corresponding column in the Boundary
Condition matrix. The format of each column is:

• Row one contains the dimension N of the system.
• Row two contains the number M of Dirichlet boundary conditions.
• Row three to 3 + N2 – 1 contain the lengths for the vectors of characters representing

q. The lengths are stored in column-wise order with respect to q.
• Row 3 + N2 to 3 + N2 +N – 1 contain the lengths for the vectors of characters

representing g.
• Row 3 + N2 + N to 3 + N2 + N + MN – 1 contain the lengths for the vectors of

characters representing h. The lengths are stored in column-wise order with respect
to h.

• Row 3 + N2 + N + MN to 3 + N2 + N + MN + M – 1 contain the lengths for the
vectors of characters representing r.

The following rows contain text expressions representing the actual boundary condition
functions. The vectors of characters have the lengths according to above. The MATLAB
text expressions are stored in column-wise order with respect to matrices h and q. There
are no separation characters between the vectors of characters. You can insert MATLAB
expressions containing the following variables:

• The 2-D coordinates x and y.
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• A boundary segment parameter s, proportional to arc length. s is 0 at the start of the
boundary segment and increases to 1 along the boundary segment in the direction
indicated by the arrow.

• The outward normal vector components nx and ny. If you need the tangential vector, it
can be expressed using nx and ny since tx = –ny and ty = nx.

• The solution u (only if the input argument u has been specified).
• The time t (only if the input argument time has been specified).

It is not possible to explicitly refer to the time derivative of the solution in the boundary
conditions.

One Column of a Boundary Matrix
The following examples describe the format of the boundary condition matrix for one
column of the Decomposed Geometry matrix. For a boundary in a scalar PDE (N = 1) with
Neumann boundary condition (M = 0)

n · c∇u = − x2

the boundary condition would be represented by the column vector

[1 0 1 5 '0' '-x.^2']' 

No lengths are stored for h or r.

Also for a scalar PDE, the Dirichlet boundary condition

u = x2 – y2

is stored in the column vector

[1 1 1 1 1 9 '0' '0' '1' 'x.^2-y.^2']' 

For a system (N = 2) with mixed boundary conditions (M = 1):

h11 h12 u = r1

n · c⊗ ∇u +
q11 q12
q21 q22

u =
g1
g2

+ s

the column appears similar to the following example:
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2
1
lq11
lq21
lq12
lq22
lg1
lg2
lh11
lh12
lr1
q11 ...
q21 ...
q12 ...
q22 ...
g1 ...
g2 ...
h11 ...
h12 ...
r1 ...

lq11, lq21, . . . denote lengths of the MATLAB text expressions, and q11, q21, . . .
denote the actual expressions.

You can easily create your own examples by trying out the PDE Modeler app. Enter
boundary conditions by double-clicking on boundaries in boundary mode, and then export
the Boundary Condition matrix to the MATLAB workspace by selecting the Export
Decomposed Geometry, Boundary Cond's option from the Boundary menu.

Create Boundary Condition Matrices Programmatically
The following example shows you how to create the boundary condition matrices for the
Dirichlet boundary condition u = x2− y2 on the boundary of a circular disk.

1 Create the following function in your working folder:

function [x,y] = circ_geom(bs,s)
%CIRC_GEOM Creates a geometry file for a unit circle.

% Number of boundary segments
nbs = 4;

if nargin == 0 % Number of boundary segments
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    x = nbs;
elseif nargin == 1 % Create 4 boundary segments
    dl = [0     pi/2  pi      3*pi/2
        pi/2  pi    3*pi/2  2*pi
        1     1     1       1
        0     0     0       0];
    x = dl(:,bs);

else % Coordinates of edge segment points
    z = exp(i*s);
    x = real(z);
    y = imag(z);
end

2 Create a second function in your working folder that finds the boundary condition
matrices, Q, G, H, and R:

function assemb_example
% Use ASSEMB to find the boundary condition matrices.

% Describe the geometry using four boundary segments
figure(1)
pdegplot('circ_geom')
axis equal 

% Initialize the mesh
[p,e,t] = initmesh('circ_geom','Hmax',0.4); 
figure(2)

% Plot the mesh
pdemesh(p,e,t) 
axis equal

% Define the boundary condition vector, b, 
% for the boundary condition u = x^2-y^2.
% For each boundary segment, the boundary 
% condition vector is
b = [1 1 1 1 1 9 '0' '0' '1' 'x.^2-y.^2']';

% Create a boundary condition matrix that 
% represents all of the boundary segments.
b = repmat(b,1,4);          
                    
% Use ASSEMB to find the boundary condition 
% matrices. Since there are only Dirichlet 
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% boundary conditions, Q and G are empty.
[Q,G,H,R] = assemb(b,p,e)

3 Run the function assemb_example.m.

The function returns the four boundary condition matrices.

Q =

   All zero sparse: 41-by-41

G =

   All zero sparse: 41-by-1

H =

   (1,1)        1
   (2,2)        1
   (3,3)        1
   (4,4)        1
   (5,5)        1
   (6,6)        1
   (7,7)        1
   (8,8)        1
   (9,9)        1
  (10,10)       1
  (11,11)       1
  (12,12)       1
  (13,13)       1
  (14,14)       1
  (15,15)       1
  (16,16)       1

R =

   (1,1)       1.0000
   (2,1)      -1.0000
   (3,1)       1.0000
   (4,1)      -1.0000
   (5,1)       0.0000
   (6,1)      -0.0000
   (7,1)       0.0000
   (8,1)      -0.0000
   (9,1)       0.7071
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  (10,1)      -0.7071
  (11,1)      -0.7071
  (12,1)       0.7071
  (13,1)       0.7071
  (14,1)      -0.7071
  (15,1)      -0.7071
  (16,1)       0.7071

Q and G are all zero sparse matrices because the problem has only Dirichlet boundary
conditions and neither generalized Neumann nor mixed boundary conditions apply.

See Also

Related Examples
• “Specify Boundary Conditions” on page 2-174

 See Also

2-173



Specify Boundary Conditions
Before you create boundary conditions, you need to create a PDEModel container. For
details, see “Solve Problems Using Legacy PDEModel Objects” on page 2-3. Suppose that
you have a container named model, and that the geometry is stored in model. Examine
the geometry to see the label of each edge or face.

pdegplot(model,'EdgeLabels','on') % for 2-D
pdegplot(model,'FaceLabels','on') % for 3-D

Now you can specify the boundary conditions for each edge or face. If you have a system
of PDEs, you can set a different boundary condition for each component on each boundary
edge or face. If the boundary condition is a function of position, time, or the solution u,
set boundary conditions by using the syntax in “Nonconstant Boundary Conditions” on
page 2-179.

If you do not specify a boundary condition for an edge or face, the default is the Neumann
boundary condition with the zero values for 'g' and 'q'.

Dirichlet Boundary Conditions
Scalar PDEs

The Dirichlet boundary condition implies that the solution u on a particular edge or face
satisfies the equation

hu = r,

where h and r are functions defined on ∂Ω, and can be functions of space (x, y, and, in 3-
D, z), the solution u, and, for time-dependent equations, time. Often, you take h = 1, and
set r to the appropriate value. You can specify Dirichlet boundary conditions as the value
of the solution u on the boundary or as a pair of the parameters h and r.

Suppose that you have a PDE model named model, and edges or faces [e1,e2,e3],
where the solution u must equal 2. Specify this boundary condition as follows.

% For 3-D geometry:
applyBoundaryCondition(model,'dirichlet','Face',[e1,e2,e3],'u',2);
% For 2-D geometry:
applyBoundaryCondition(model,'dirichlet','Edge',[e1,e2,e3],'u',2);
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If the solution on edges or faces [e1,e2,e3] satisfies the equation 2u = 3, specify the
boundary condition as follows.

% For 3-D geometry:
applyBoundaryCondition(model,'dirichlet','Face',[e1,e2,e3],'r',3,'h',2);
% For 2-D geometry:
applyBoundaryCondition(model,'dirichlet','Edge',[e1,e2,e3],'r',3,'h',2);

• If you do not specify 'r', applyBoundaryCondition sets its value to 0.
• If you do not specify 'h', applyBoundaryCondition sets its value to 1.

Systems of PDEs

The Dirichlet boundary condition for a system of PDEs is hu = r, where h is a matrix, u is
the solution vector, and r is a vector.

Suppose that you have a PDE model named model, and edge or face labels [e1,e2,e3]
where the first component of the solution u must equal 1, while the second and third
components must equal 2. Specify this boundary condition as follows.

% For 3-D geometry:
applyBoundaryCondition(model,'dirichlet','Face',[e1,e2,e3],...
                       'u',[1,2,2],'EquationIndex',[1,2,3]);
% For 2-D geometry:
applyBoundaryCondition(model,'dirichlet','Edge',[e1,e2,e3],...
                       'u',[1,2,2],'EquationIndex',[1,2,3]);

• The 'u' and 'EquationIndex' arguments must have the same length.
• If you exclude the 'EquationIndex' argument, the 'u' argument must have length

N.
• If you exclude the 'u' argument, applyBoundaryCondition sets the components in

'EquationIndex' to 0.

Suppose that you have a PDE model named model, and edge or face labels [e1,e2,e3]
where the first, second, and third components of the solution u must satisfy the equations
2u1 = 3, 4u2 = 5, and 6u3 = 7, respectively. Specify this boundary condition as follows.

H0 = [2 0 0;
      0 4 0;
      0 0 6];
R0 = [3;5;7];
% For 3-D geometry:
applyBoundaryCondition(model,'dirichlet', ...
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                             'Face',[e1,e2,e3], ...
                             'h',H0,'r',R0);
% For 2-D geometry:
applyBoundaryCondition(model,'dirichlet', ...
                             'Edge',[e1,e2,e3], ...
                             'h',H0,'r',R0);

• The 'r' parameter must be a numeric vector of length N. If you do not specify 'r',
applyBoundaryCondition sets the values to 0.

• The 'h' parameter can be an N-by-N numeric matrix or a vector of length N2

corresponding to the linear indexing form of the N-by-N matrix. For details about the
linear indexing form, see “Array Indexing” (MATLAB). If you do not specify 'h',
applyBoundaryCondition sets the value to the identity matrix.

Neumann Boundary Conditions
Scalar PDEs

Generalized Neumann boundary conditions imply that the solution u on the edge or face
satisfies the equation

n · c∇u + qu = g

The coefficient c is the same as the coefficient of the second-order differential operator in
the PDE equation

−∇ ⋅ c∇u + au = f  on domain Ω

n  is the outward unit normal. q and g are functions defined on ∂Ω, and can be functions of
space (x, y, and, in 3-D, z), the solution u, and, for time-dependent equations, time.

Suppose that you have a PDE model named model, and edges or faces [e1,e2,e3]
where the solution u must satisfy the Neumann boundary condition with q = 2 and g =
3. Specify this boundary condition as follows.

% For 3-D geometry:
applyBoundaryCondition(model,'neumann','Face',[e1,e2,e3],'q',2,'g',3);
% For 2-D geometry:
applyBoundaryCondition(model,'neumann','Edge',[e1,e2,e3],'q',2,'g',3);

• If you do not specify 'g', applyBoundaryCondition sets its value to 0.
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• If you do not specify 'q', applyBoundaryCondition sets its value to 0.

Systems of PDEs

Neumann boundary conditions for a system of PDEs is n · c⊗ ∇u + qu = g. For 2-D
systems, the notation n · c⊗ ∇u  means the N-by-1 vector with (i,1)-component

∑
j = 1

N
cos(α)ci, j, 1, 1

∂
∂x + cos(α)ci, j, 1, 2

∂
∂y + sin(α)ci, j, 2, 1

∂
∂x + sin(α)ci, j, 2, 2

∂
∂y u j

where the outward normal vector of the boundary n = cos(α), sin(α) .

For 3-D systems, the notation n · c⊗ ∇u  means the N-by-1 vector with (i,1)-component

∑
j = 1

N
sin φ cos θ ci, j, 1, 1

∂
∂x + sin φ cos θ ci, j, 1, 2

∂
∂y + sin φ cos θ ci, j, 1, 3

∂
∂z u j

+ ∑
j = 1

N
sin φ sin θ ci, j, 2, 1

∂
∂x + sin φ sin θ ci, j, 2, 2

∂
∂y + sin φ sin θ ci, j, 2, 3

∂
∂z u j

+ ∑
j = 1

N
cos θ ci, j, 3, 1

∂
∂x + cos θ ci, j, 3, 2

∂
∂y + cos θ ci, j, 3, 3

∂
∂z u j

where the outward normal vector of the boundary n = sin(φ)cos(θ), sin(φ)sin(θ), cos(φ) .
For each edge or face segment, there are a total of N boundary conditions.

Suppose that you have a PDE model named model, and edges or faces [e1,e2,e3]
where the first component of the solution u must satisfy the Neumann boundary condition
with q = 2 and g = 3, and the second component must satisfy the Neumann boundary
condition with q = 4 and g = 5. Specify this boundary condition as follows.

Q = [2 0; 0 4];
G = [3;5];
% For 3-D geometry:
applyBoundaryCondition(model,'neumann','Face',[e1,e2,e3],'q',Q,'g',G);
% For 2-D geometry:
applyBoundaryCondition(model,'neumann','Edge',[e1,e2,e3],'q',Q,'g',G);

• The 'g' parameter must be a numeric vector of length N. If you do not specify 'g',
applyBoundaryCondition sets the values to 0.

• The 'q' parameter can be an N-by-N numeric matrix or a vector of length N2

corresponding to the linear indexing form of the N-by-N matrix. For details about the
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linear indexing form, see “Array Indexing” (MATLAB). If you do not specify 'q',
applyBoundaryCondition sets the values to 0.

Mixed Boundary Conditions
If some equations in your system of PDEs must satisfy the Dirichlet boundary condition
and some must satisfy the Neumann boundary condition for the same geometric region,
use the 'mixed' parameter to apply boundary conditions in one call. Note that
applyBoundaryCondition uses the default Neumann boundary condition with g = 0
and q = 0 for equations for which you do not explicitly specify a boundary condition.

Suppose that you have a PDE model named model, and edge or face labels [e1,e2,e3]
where the first component of the solution u must equal 11, the second component must
equal 22, and the third component must satisfy the Neumann boundary condition with q
= 3 and g = 4. Express this boundary condition as follows.

Q = [0 0 0; 0 0 0; 0 0 3];
G = [0;0;4];
% For 3-D geometry:
applyBoundaryCondition(model,'mixed','Face',[e1,e2,e3],...
                       'u',[11,22],'EquationIndex',[1,2],...
                       'q',Q,'g',G);
% For 2-D geometry:
applyBoundaryCondition(model,'mixed',...
                             'Edge',[e1,e2,e3],'u',[11,22],...
                             'EquationIndex',[1,2],'q',Q,'g',G);

Suppose that you have a PDE model named model, and edges or faces [e1,e2,e3]
where the first component of the solution u must satisfy the Dirichlet boundary condition
2u1 = 3, the second component must satisfy the Neumann boundary condition with q = 4
and g = 5, and the third component must satisfy the Neumann boundary condition with
q = 6 and g = 7. Express this boundary condition as follows.

h = [2 0 0; 0 0 0; 0 0 0];
r = [3;0;0];
Q = [0 0 0; 0 4 0; 0 0 6];
G = [0;5;7];
% For 3-D geometry:
applyBoundaryCondition(model,'mixed', ...
                             'Face',[e1,e2,e3], ...
                             'h',h,'r',r,'q',Q,'g',G);
% For 2-D geometry:
applyBoundaryCondition(model,'mixed', ...
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                             'Edge',[e1,e2,e3], ...
                             'h',h,'r',r,'q',Q,'g',G);

Nonconstant Boundary Conditions
Use functions to express nonconstant boundary conditions.

applyBoundaryCondition(model,'dirichlet', ...
                             'Edge',1, ...
                             'r',@myrfun);
applyBoundaryCondition(model,'neumann', ...
                             'Face',2, ...
                             'g',@mygfun,'q',@myqfun);
applyBoundaryCondition(model,'mixed', ...
                             'Edge',[3,4], ...
                             'u',@myufun, ...
                             'EquationIndex',[2,3]);

Each function must have the following syntax.

function bcMatrix = myfun(location,state)

Partial Differential Equation Toolbox solvers pass the location and state data to your
function.

• location — A structure containing the following fields. If you pass a name-value pair
to applyBoundaryCondition with Vectorized set to 'on', then location can
contain several evaluation points. If you do not set Vectorized or use
Vectorized,'off', then solvers pass just one evaluation point in each call.

• location.x — The x-coordinate of the point or points
• location.y — The y-coordinate of the point or points
• location.z — For 3-D geometry, the z-coordinate of the point or points

Furthermore, if there are Neumann conditions, then solvers pass the following data in
the location structure.

• location.nx — x-component of the normal vector at the evaluation point or
points

• location.ny — y-component of the normal vector at the evaluation point or
points
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• location.nz — For 3-D geometry, z-component of the normal vector at the
evaluation point or points

• state — For transient or nonlinear problems.

• state.u contains the solution vector at evaluation points. state.u is an N-by-M
matrix, where each column corresponds to one evaluation point, and M is the
number of evaluation points.

• state.time contains the time at evaluation points. state.time is a scalar.

Your function returns bcMatrix. This matrix has the following form, depending on the
boundary condition type.

• 'u' — N1-by-M matrix, where each column corresponds to one evaluation point, and
M is the number of evaluation points. N1 is the length of the 'EquationIndex'
argument. If there is no 'EquationIndex' argument, then N1 = N.

• 'r' or 'g' — N-by-M matrix, where each column corresponds to one evaluation point,
and M is the number of evaluation points.

• 'h' or 'q' — N2-by-M matrix, where each column corresponds to one evaluation point
via linear indexing of the underlying N-by-N matrix, and M is the number of evaluation
points. Alternatively, an N-by-N-by-M array, where each evaluation point is an N-by-N
matrix. For details about linear indexing, see “Array Indexing” (MATLAB).

If boundary conditions depend on state.u or state.time, ensure that your function
returns a matrix of NaN of the correct size when state.u or state.time are NaN.
Solvers check whether a problem is nonlinear or time-dependent by passing NaN state
values, and looking for returned NaN values.

See “Solve PDEs with Nonconstant Boundary Conditions” on page 2-186.
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Solve PDEs with Constant Boundary Conditions
This example shows how to apply various constant boundary condition specifications for
both scalar PDEs and systems of PDEs.

Geometry

All the specifications use the same 2-D geometry, which is a rectangle with a circular hole.

% Rectangle is code 3, 4 sides, followed by x-coordinates and then y-coordinates
R1 = [3,4,-1,1,1,-1,-.4,-.4,.4,.4]';
% Circle is code 1, center (.5,0), radius .2
C1 = [1,.5,0,.2]';
% Pad C1 with zeros to enable concatenation with R1
C1 = [C1;zeros(length(R1)-length(C1),1)];
geom = [R1,C1];

% Names for the two geometric objects
ns = (char('R1','C1'))';

% Set formula
sf = 'R1 - C1';

% Create geometry
g = decsg(geom,sf,ns);

% Create geometry model
model = createpde;

% Include the geometry in the model and view the geometry
geometryFromEdges(model,g);
pdegplot(model,'EdgeLabels','on')
xlim([-1.1 1.1])
axis equal
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Scalar Problem

Suppose that edge 3 has Dirichlet conditions with value 32, edge 1 has Dirichlet
conditions with value 72, and all other edges have Neumann boundary conditions with q
= 0, g = -1.

applyBoundaryCondition(model,'dirichlet','edge',3,'u',32);
applyBoundaryCondition(model,'dirichlet','edge',1,'u',72);
applyBoundaryCondition(model,'neumann','edge',[2,4:8],'g',-1);

This completes the boundary condition specification.
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Solve an elliptic PDE with these boundary conditions with c = 1, a = 0, and f = 10.
Because the shorter rectangular side has length 0.8, to ensure that the mesh is not too
coarse choose a maximum mesh size Hmax = 0.1.

specifyCoefficients(model,'m',0,'d',0,'c',1,'a',0,'f',10);
generateMesh(model,'Hmax',0.1);
results = solvepde(model);
u = results.NodalSolution;
pdeplot(model,'XYData',u,'ZData',u)
view(-23,8)

System of PDEs

Suppose that the system has N = 2.
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• Edge 3 has Dirichlet conditions with values [32,72].
• Edge 1 has Dirichlet conditions with values [72,32].
• Edge 4 has a Dirichlet condition for the first component with value 52, and has a

Neumann condition for the second component with q = 0, g = -1.
• Edge 2 has Neumann boundary conditions with q = [1,2;3,4] and g = [5,-6].
• The circular edges (edges 5 through 8) have q = 0 and g = 0.

model = createpde(2);
geometryFromEdges(model,g);

applyBoundaryCondition(model,'dirichlet','edge',3,'u',[32,72]);
applyBoundaryCondition(model,'dirichlet','edge',1,'u',[72,32]);
applyBoundaryCondition(model,'mixed','edge',4,'u',52,'EquationIndex',1,'g',[0,-1]);
Q2 = [1,2;3,4];
G2 = [5,-6];
applyBoundaryCondition(model,'neumann','edge',2,'q',Q2,'g',G2);

% The next step is optional, because it sets 'g' to its default value
applyBoundaryCondition(model,'neumann','edge',5:8,'g',[0,0]);

This completes the boundary condition specification.

Solve an elliptic PDE with these boundary conditions using c = 1, a = 0, and f =
[10;-10]. Because the shorter rectangular side has length 0.8, to ensure that the mesh
is not too coarse choose a maximum mesh size Hmax = 0.1.

specifyCoefficients(model,'m',0,'d',0,'c',1,'a',0,'f', [10;-10]);
generateMesh(model,'Hmax',0.1);
results = solvepde(model);
u = results.NodalSolution;
pdeplot(model,'XYData',u(:,2),'ZData',u(:,2))
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See Also

More About
• “Specify Boundary Conditions” on page 2-174
• “Solve PDEs with Nonconstant Boundary Conditions” on page 2-186
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Solve PDEs with Nonconstant Boundary Conditions
This example shows how to write functions for a nonconstant boundary condition
specification.

Geometry

All the specifications use the same geometry, which is a rectangle with a circular hole.

% Rectangle is code 3, 4 sides, followed by x-coordinates and then y-coordinates
R1 = [3,4,-1,1,1,-1,-.4,-.4,.4,.4]';
% Circle is code 1, center (.5,0), radius .2
C1 = [1,.5,0,.2]';
% Pad C1 with zeros to enable concatenation with R1
C1 = [C1;zeros(length(R1)-length(C1),1)];
geom = [R1,C1];

% Names for the two geometric objects
ns = (char('R1','C1'))';

% Set formula
sf = 'R1-C1';

% Create geometry
g = decsg(geom,sf,ns);

% Create geometry model
model = createpde;

% Include the geometry in the model and view the geometry
geometryFromEdges(model,g);
pdegplot(model,'EdgeLabels','on')
xlim([-1.1 1.1])
axis equal
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Scalar Problem

• Edge 3 has Dirichlet conditions with value 32.
• Edge 1 has Dirichlet conditions with value 72.
• Edges 2 and 4 have Dirichlet conditions that linearly interpolate between edges 1 and

3.
• The circular edges (5 through 8) have Neumann conditions with q = 0, g = -1.

applyBoundaryCondition(model,'dirichlet','Edge',3,'u',32);
applyBoundaryCondition(model,'dirichlet','Edge',1,'u',72);
applyBoundaryCondition(model,'neumann','Edge',5:8,'g',-1); % q = 0 by default
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Edges 2 and 4 need functions that perform the linear interpolation. Each edge can use the
same function that returns the value u x, y = 52 + 20x.

You can implement this simple interpolation in an anonymous function.

myufunction = @(location,state)52 + 20*location.x;

Include the function for edges 2 and 4. To help speed the solver, allow a vectorized
evaluation.

applyBoundaryCondition(model,'dirichlet','Edge',[2,4],...
                                         'u',myufunction,...
                                         'Vectorized','on');

Solve an elliptic PDE with these boundary conditions, using the parameters c = 1, a =
0, and | f = 10|. Because the shorter rectangular side has length 0.8, to ensure that the
mesh is not too coarse choose a maximum mesh size Hmax = 0.1.

specifyCoefficients(model,'m',0,'d',0,'c',1,'a',0,'f',10);
generateMesh(model,'Hmax',0.1);
results = solvepde(model);
u = results.NodalSolution;
pdeplot(model,'XYData',u)
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System of PDEs

Suppose that the system has N = 2.

• Edge 3 has Dirichlet conditions with values [32,72].
• Edge 1 has Dirichlet conditions with values [72,32].
• Edges 2 and 4 have Dirichlet conditions that interpolate between the conditions on

edges 1 and 3, and include a sinusoidal variation.
• Circular edges (edges 5 through 8) have q = 0 and g = -10.

model = createpde(2);
geometryFromEdges(model,g);
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applyBoundaryCondition(model,'dirichlet','Edge',3,'u',[32,72]);
applyBoundaryCondition(model,'dirichlet','Edge',1,'u',[72,32]);
applyBoundaryCondition(model,'neumann','Edge',5:8,'g',[-10,-10]);

The first component of edges 2 and 4 satisfies the equation u1 x = 52 + 20x + 10sin πx3 .

The second component satisfies u2 x = 52 − 20x− 10sin πx3 .

Write a function file myufun.m that incorporates these equations in the syntax described
in “Nonconstant Boundary Conditions” on page 2-179.

function bcMatrix = myufun(location,state)
bcMatrix = [52 + 20*location.x + 10*sin(pi*(location.x.^3));
    52 - 20*location.x - 10*sin(pi*(location.x.^3))]; % OK to vectorize
end

Include this function in the edge 2 and edge 4 boundary condition.

applyBoundaryCondition(model,'dirichlet','Edge',[2,4],...
                                         'u',@myufun,...
                                         'Vectorized','on');

Solve an elliptic PDE with these boundary conditions, with the parameters c = 1, a = 0,
and f = (10,-10). Because the shorter rectangular side has length 0.8, to ensure that
the mesh is not too coarse choose a maximum mesh size Hmax = 0.1.

specifyCoefficients(model,'m',0,'d',0,'c',1,'a',0,'f',[10;-10]);
generateMesh(model,'Hmax',0.1);
results = solvepde(model);
u = results.NodalSolution;

subplot(1,2,1)
pdeplot(model,'XYData',u(:,1),'ZData',u(:,1),'ColorBar','off')
view(-9,24)
subplot(1,2,2)
pdeplot(model,'XYData',u(:,2),'ZData',u(:,2),'ColorBar','off')
view(-9,24)
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View, Edit, and Delete Boundary Conditions
In this section...
“View Boundary Conditions” on page 2-192
“Delete Existing Boundary Conditions” on page 2-195
“Change a Boundary Conditions Assignment” on page 2-195

View Boundary Conditions
A PDE model stores boundary conditions in its BoundaryConditions property. To obtain
the boundary conditions stored in the PDE model called model, use this syntax:

BCs = model.BoundaryConditions;

To see the active boundary condition assignment for a region, call the
findBoundaryConditions function.

For example, create a model and view the geometry.

model = createpde(3);
importGeometry(model,'Block.stl');
pdegplot(model,'FaceLabels','on','FaceAlpha',0.5)
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Set zero Dirichlet conditions for all equations and all regions in the model.

applyBoundaryCondition(model,'dirichlet','Face',1:6,'u',[0,0,0]);

On face 3, set the Neumann boundary condition for equation 1 and Dirichlet boundary
condition for equations 2 and 3.

h = [0 0 0;0 1 0;0 0 1];
r = [0;3;3];
q = [1 0 0;0 0 0;0 0 0];
g = [10;0;0];
applyBoundaryCondition(model,'mixed','Face',3,'h',h,'r',r,'g',g,'q',q);
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View the boundary condition assignment for face 3. The result shows that the active
boundary condition is the last assignment.

BCs = model.BoundaryConditions;
findBoundaryConditions(BCs,'Face',3)

ans = 
  BoundaryCondition with properties:

           BCType: 'mixed'
       RegionType: 'Face'
         RegionID: 3
                r: [3x1 double]
                h: [3x3 double]
                g: [3x1 double]
                q: [3x3 double]
                u: []
    EquationIndex: []
       Vectorized: 'off'

View the boundary conditions assignment for face 1.

findBoundaryConditions(BCs,'Face',1)

ans = 
  BoundaryCondition with properties:

           BCType: 'dirichlet'
       RegionType: 'Face'
         RegionID: [1 2 3 4 5 6]
                r: []
                h: []
                g: []
                q: []
                u: [0 0 0]
    EquationIndex: []
       Vectorized: 'off'

The active boundary conditions assignment for face 1 includes all six faces, though this
assignment is no longer active for face 3.
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Delete Existing Boundary Conditions
To remove all the boundary conditions in the PDE model called pdem, use delete.

delete(pdem.BoundaryConditions)

To remove specific boundary conditions assignments from pdem, delete them from the
pdem.BoundaryConditions.BoundaryConditionAssignments vector. For example,

BCv = pdem.BoundaryConditions.BoundaryConditionAssignments;
delete(BCv(2))

Tip You do not need to delete boundary conditions; you can override them by calling
applyBoundaryCondition again. However, removing unused assignments can make
your model more concise.

Change a Boundary Conditions Assignment
To change a boundary conditions assignment, you need the boundary condition’s handle.
To get the boundary condition’s handle:

• Retain the handle when using applyBoundaryCondition. For example,

bc1 = applyBoundaryCondition(model,'dirichlet', ...
                                   'Face',1:6, ...
                                   'u',[0 0 0]);

• Obtain the handle using findBoundaryConditions. For example,

BCs = model.BoundaryConditions;
bc1 = findBoundaryConditions(BCs,'Face',2)

bc1 = 

  BoundaryCondition with properties:

           BCType: 'dirichlet'
       RegionType: 'Face'
         RegionID: [1 2 3 4 5 6]
                r: []
                h: []
                g: []
                q: []

 View, Edit, and Delete Boundary Conditions

2-195



                u: [0 0 0]
    EquationIndex: []
       Vectorized: 'off'

You can change any property of the boundary conditions handle. For example,

bc1.BCType = 'neumann';
bc1.u = [];
bc1.g = [0 0 0];
bc1.q = [0 0 0];
bc1

bc1 = 

  BoundaryCondition with properties:

           BCType: 'neumann'
       RegionType: 'Face'
         RegionID: [1 2 3 4 5 6]
                r: []
                h: []
                g: [0 0 0]
                q: [0 0 0]
                u: []
    EquationIndex: []
       Vectorized: 'off'

Note Editing an existing assignment in this way does not change its priority. For
example, if the active boundary condition was assigned after bc1, then editing bc1 does
not make bc1 the active boundary condition.

See Also

Related Examples
• “Specify Boundary Conditions” on page 2-174
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Boundary Conditions by Writing Functions

Note THIS PAGE DESCRIBES THE LEGACY WORKFLOW. New features might not be
compatible with the legacy workflow. For the corresponding step in the recommended
workflow, see “Specify Boundary Conditions” on page 2-174.

About Boundary Conditions by Writing Functions
This section shows how to express boundary conditions for 2-D geometry using the legacy
function syntax. However, the recommended way to express boundary conditions is to use
“Specify Boundary Conditions” on page 2-174.

To use this legacy syntax, write the functions using the templates in “Boundary
Conditions for Scalar PDE” on page 2-197 or “Boundary Conditions for PDE Systems” on
page 2-202.

Boundary Conditions for Scalar PDE
For a scalar PDE, some boundary segments can have Dirichlet conditions, and some
boundary segments can have generalized Neumann conditions.

Dirichlet boundary conditions are

hu = r,

where h and r can be functions of x, y, the solution u, the edge segment index, and, for
parabolic and hyperbolic equations, time.

Generalized Neumann boundary conditions are n · c∇u + qu = g on ∂Ω.

n  is the outward unit normal. g and q are functions defined on ∂Ω, and can be functions of
x, y, the solution u, the edge segment index, and, for parabolic and hyperbolic equations,
time.

To write a function file, say pdebound.m, use the following syntax:

[qmatrix,gmatrix,hmatrix,rmatrix] = pdebound(p,e,u,time)
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Your function returns matrices qmatrix, gmatrix, hmatrix, and rmatrix, based on
these inputs:

• p — Points in the mesh (“Mesh Data” on page 2-233)
• e — Finite element edges in the mesh, a subset of all the edges (“Mesh Data” on page

2-233)
• u — Solution of the PDE
• time — Time, for parabolic or hyperbolic PDE only

If your boundary conditions do not depend on u or time, those inputs are []. If your
boundary conditions do depend on u or time, then when u or time are NaN, ensure that
the outputs such as qmatrix consist of matrices of NaN of the correct size. This signals to
solvers, such as parabolic, to use a time-dependent or solution-dependent algorithm.

Before specifying boundary conditions, you need to know the boundary labels. See
“Identify Boundary Labels” on page 2-166.

The PDE solver, such as assempde or adaptmesh, passes a matrix p of points and e of
edges. e has seven rows and ne columns, where you do not necessarily know in advance
the size ne.

• p is a 2-by-Np matrix, where p(1,k) is the x-coordinate of point k, and p(2,k) is the
y-coordinate of point k.

• e is a 7-by-ne matrix, where

• e(1,k) is the index of the first point of edge k.
• e(2,k) is the index of the second point of edge k.
• e(5,k) is the label of the geometry edge of edge k (see “Identify Boundary Labels”

on page 2-166).

e contains an entry for every finite element edge that lies on an exterior boundary.

Use the following template for your boundary file.

function [qmatrix,gmatrix,hmatrix,rmatrix] = pdebound(p,e,u,time)

ne = size(e,2); % number of edges
qmatrix = zeros(1,ne);
gmatrix = qmatrix;
hmatrix = zeros(1,2*ne);
rmatrix = hmatrix;
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for k = 1:ne
    x1 = p(1,e(1,k)); % x at first point in segment
    x2 = p(1,e(2,k)); % x at second point in segment
    xm = (x1 + x2)/2; % x at segment midpoint
    y1 = p(2,e(1,k)); % y at first point in segment
    y2 = p(2,e(2,k)); % y at second point in segment
    ym = (y1 + y2)/2; % y at segment midpoint
    switch e(5,k)
        case {some_edge_labels}
            % Fill in hmatrix,rmatrix or qmatrix,gmatrix
        case {another_list_of_edge_labels}
            % Fill in hmatrix,rmatrix or qmatrix,gmatrix
        otherwise
            % Fill in hmatrix,rmatrix or qmatrix,gmatrix
    end
end

For each column k in e, entry k of rmatrix is the value of rmatrix at the first point in
the edge, and entry ne + k is the value at the second point in the edge. For example, if
r = x2 + y4, then write these lines:

rmatrix(k) = x1^2 + y1^4;
rmatrix(k+ne) = x2^2 + y2^4;

The syntax for hmatrix is identical: entry k of hmatrix is the value of r at the first point
in the edge, and entry k + ne is the value at the second point in the edge.

For each column k in e, entry k of qmatrix is the value of qmatrix at the midpoint in
the edge. For example, if q = x2 + y4, then write these lines:

qmatrix(k) = xm^2 + ym^4;

The syntax for gmatrix is identical: entry k of gmatrix is the value of gmatrix at the
midpoint in the edge.

If the coefficients depend on the solution u, use the element u(e(1,k)) as the solution
value at the first point of edge k, and u(e(2,k)) as the solution value at the second
point of edge k.

For example, consider the following geometry, a rectangle with a circular hole.

% Rectangle is code 3, 4 sides,
% followed by x-coordinates and then y-coordinates
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R1 = [3,4,-1,1,1,-1,-.4,-.4,.4,.4]';
% Circle is code 1, center (.5,0), radius .2
C1 = [1,.5,0,.2]';
% Pad C1 with zeros to enable concatenation with R1
C1 = [C1;zeros(length(R1)-length(C1),1)];
geom = [R1,C1];

% Names for the two geometric objects
ns = (char('R1','C1'))';

% Set formula
sf = 'R1-C1';

% Create geometry
gd = decsg(geom,sf,ns);

% View geometry
pdegplot(gd,'EdgeLabels','on')
xlim([-1.1 1.1])
axis equal
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Suppose the boundary conditions on the outer boundary (segments 1 through 4) are
Dirichlet, with the value u(x,y) = t(x – y), where t is time. Suppose the circular boundary
(segments 5 through 8) has a generalized Neumann condition, with q = 1 and g = x2 + y2.

Write the following boundary file to represent the boundary conditions:

function [qmatrix,gmatrix,hmatrix,rmatrix] = pdebound(p,e,u,time)

ne = size(e,2); % number of edges
qmatrix = zeros(1,ne);
gmatrix = qmatrix;
hmatrix = zeros(1,2*ne);
rmatrix = hmatrix;
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for k = 1:ne
    x1 = p(1,e(1,k)); % x at first point in segment
    x2 = p(1,e(2,k)); % x at second point in segment
    xm = (x1 + x2)/2; % x at segment midpoint
    y1 = p(2,e(1,k)); % y at first point in segment
    y2 = p(2,e(2,k)); % y at second point in segment
    ym = (y1 + y2)/2; % y at segment midpoint
    switch e(5,k)
        case {1,2,3,4} % rectangle boundaries
            hmatrix(k) = 1;
            hmatrix(k+ne) = 1;
            rmatrix(k) = time*(x1 - y1);
            rmatrix(k+ne) = time*(x2 - y2);
        otherwise % same as case {5,6,7,8}, circle boundaries
            qmatrix(k) = 1;
            gmatrix(k) = xm^2 + ym^2;
    end
end

Boundary Conditions for PDE Systems
The general mixed-boundary conditions for PDE systems of N equations (see “Equations
You Can Solve Using Legacy Functions” on page 1-3) are

hu = r
n · c⊗ ∇u + qu = g + h′μ

The notation n · c⊗ ∇u  means the N-by-1 matrix with (i,1)-component

∑
j = 1

N
cos(α)ci, j, 1, 1

∂
∂x + cos(α)ci, j, 1, 2

∂
∂y + sin(α)ci, j, 2, 1

∂
∂x + sin(α)ci, j, 2, 2

∂
∂y u j

where the outward normal vector of the boundary n = cos(α), sin(α) . For each edge
segment there are M Dirichlet conditions and the h-matrix is M-by-N, M ≥ 0. The
generalized Neumann condition contains a source h′μ where the solver computes
Lagrange multipliers µ such that the Dirichlet conditions are satisfied.

To write a function file, say pdebound.m, use the following syntax:

[qmatrix,gmatrix,hmatrix,rmatrix] = pdebound(p,e,u,time)

Your function returns matrices qmatrix, gmatrix, hmatrix, and rmatrix, based on
these inputs:
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• p — Points in the mesh (“Mesh Data” on page 2-233)
• e — Finite element edges in the mesh, a subset of all the edges (“Mesh Data” on page

2-233)
• u — Solution of the PDE
• time — Time, for parabolic or hyperbolic PDE only

If your boundary conditions do not depend on u or time, those inputs are []. If your
boundary conditions do depend on u or time, then when u or time are NaN, ensure that
the outputs such as qmatrix consist of matrices of NaN of the correct size. This signals to
solvers, such as parabolic, to use a time-dependent or solution-dependent algorithm.

Before specifying boundary conditions, you need to know the boundary labels. See
“Identify Boundary Labels” on page 2-166.

A PDE solver, such as assempde or adaptmesh, passes a matrix p of points and e of
edges. e has seven rows and ne columns, where you do not necessarily know in advance
the size ne.

• p is a 2-by-Np matrix, where p(1,k) is the x-coordinate of point k, and p(2,k) is the
y-coordinate of point k.

• e is a 7-by-ne matrix, where

• e(1,k) is the index of the first point of edge k.
• e(2,k) is the index of the second point of edge k.
• e(5,k) is the label of the geometry edge of edge k (see “Identify Boundary Labels”

on page 2-166).

e contains an entry for every finite element edge that lies on an exterior boundary.

Let N be the dimension of the system of PDEs; see “Equations You Can Solve Using
Legacy Functions” on page 1-3. Use the following template for your boundary file.

function [qmatrix,gmatrix,hmatrix,rmatrix] = pdebound(p,e,u,time)

N = 3; % Set N = the number of equations
ne = size(e,2); % number of edges
qmatrix = zeros(N^2,ne);
gmatrix = zeros(N,ne);
hmatrix = zeros(N^2,2*ne);
rmatrix = zeros(N,2*ne);
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for k = 1:ne
    x1 = p(1,e(1,k)); % x at first point in segment
    x2 = p(1,e(2,k)); % x at second point in segment
    xm = (x1 + x2)/2; % x at segment midpoint
    y1 = p(2,e(1,k)); % y at first point in segment
    y2 = p(2,e(2,k)); % y at second point in segment
    ym = (y1 + y2)/2; % y at segment midpoint
    switch e(5,k)
        case {some_edge_labels}
            % Fill in hmatrix,rmatrix or qmatrix,gmatrix
        case {another_list_of_edge_labels}
            % Fill in hmatrix,rmatrix or qmatrix,gmatrix
        otherwise
            % Fill in hmatrix,rmatrix or qmatrix,gmatrix
        
    end
end

For the boundary file, you represent the matrix h for each edge segment as a vector,
taking the matrix column-wise, as hmatrix(:). Column k of hmatrix corresponds to the
matrix at the first edge point e(1,k), and column k + ne corresponds to the matrix at
the second edge point e(2,k).

Similarly, you represent each vector r for an edge as a column in the matrix rmatrix.
Column k corresponds to the vector at the first edge point e(1,k), and column k + ne
corresponds to the vector at the second edge point e(2,k).

Represent the entries for the matrix q for each edge segment as a vector, qmatrix(:),
similar to the matrix hmatrix(:). Similarly, represent g for each edge segment is a
column vector in the matrix gmatrix. Unlike h and r, which have two columns for each
segment, q and g have just one column for each segment, which is the value of the
function at the midpoint of the edge segment.

For example, consider the following geometry, a rectangle with a circular hole.

% Rectangle is code 3, 4 sides,
% followed by x-coordinates and then y-coordinates
R1 = [3,4,-1,1,1,-1,-.4,-.4,.4,.4]';
% Circle is code 1, center (.5,0), radius .2
C1 = [1,.5,0,.2]';
% Pad C1 with zeros to enable concatenation with R1
C1 = [C1;zeros(length(R1)-length(C1),1)];
geom = [R1,C1];
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% Names for the two geometric objects
ns = (char('R1','C1'))';

% Set formula
sf = 'R1-C1';

% Create geometry
gd = decsg(geom,sf,ns);

% View geometry
pdegplot(gd,'EdgeLabels','on')
xlim([-1.1 1.1])
axis equal
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Suppose N = 3. Suppose the boundary conditions are mixed. There is M = 1 Dirichlet
condition:

• The first component of u = 0 on the rectangular segments (numbers 1–4). So h(1,1) =
1 and r(1) = 0 for those segments.

• The second components of u = 0 on the circular segments (numbers 5–8). So
h(2,2) = 1 and r(2) = 0 for those segments.

• On the rectangular segments (numbers 1–4),

q =
0 1 1
0 0 0
1 1 0

and

g =
1 + x2

0
1 + y2

• On the circular segments (numbers 5–8),

q =
0 1 + x2 2 + y2

0 0 0
1 + x4 1 + y4 0

and

g =
cos(πx)

0
tanh(x + y)

Write the following boundary file to represent the boundary conditions:

function [qmatrix,gmatrix,hmatrix,rmatrix] = pdebound(p,e,u,time)

N = 3;
ne = size(e,2); % number of edges
qmatrix = zeros(N^2,ne);
gmatrix = zeros(N,ne);
hmatrix = zeros(N^2,2*ne);
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rmatrix = zeros(N,2*ne);

for k = 1:ne
    x1 = p(1,e(1,k)); % x at first point in segment
    x2 = p(1,e(2,k)); % x at second point in segment
    xm = (x1 + x2)/2; % x at segment midpoint
    y1 = p(2,e(1,k)); % y at first point in segment
    y2 = p(2,e(2,k)); % y at second point in segment
    ym = (y1 + y2)/2; % y at segment midpoint
    switch e(5,k)
        case {1,2,3,4}
            hk = zeros(N);
            hk(1,1) = 1;
            hk = hk(:);
            hmatrix(:,k) = hk;
            hmatrix(:,k+ne) = hk;
            
            rk = zeros(N,1); % Not strictly necessary
            rmatrix(:,k) = rk; % These are already 0
            rmatrix(:,k+ne) = rk;
            
            qk = zeros(N);
            qk(1,2) = 1;
            qk(1,3) = 1;
            qk(3,1) = 1;
            qk(3,2) = 1;
            qk = qk(:);
            qmatrix(:,k) = qk;
            
            gk = zeros(N,1);
            gk(1) = 1+xm^2;
            gk(3) = 1+ym^2;
            gmatrix(:,k) = gk;
            
        case {5,6,7,8}
            hk = zeros(N);
            hk(2,2) = 1;
            hk = hk(:);
            hmatrix(:,k) = hk;
            hmatrix(:,k+ne) = hk;
            
            rk = zeros(N,1); % Not strictly necessary
            rmatrix(:,k) = rk; % These are already 0
            rmatrix(:,k+ne) = rk;
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            qk = zeros(N);
            qk(1,2) = 1+xm^2;
            qk(1,3) = 2+ym^2;
            qk(3,1) = 1+xm^4;
            qk(3,2) = 1+ym^4;
            qk = qk(:);
            qmatrix(:,k) = qk;
            
            gk = zeros(N,1);
            gk(1) = cos(pi*xm);
            gk(3) = tanh(xm*ym);
            gmatrix(:,k) = gk;
            
        end
end
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Generate Mesh
The generateMesh function creates a triangular mesh for a 2-D geometry and a
tetrahedral mesh for a 3-D geometry. By default, the mesh generator uses internal
algorithms to choose suitable sizing parameters for a particular geometry. You also can
use additional arguments to specify the following parameters explicitly:

• Target maximum mesh edge length, which is an approximate upper bound on the mesh
edge lengths. Note that occasionally, some elements can have edges longer than this
parameter.

• Target minimum mesh edge length, which is an approximate lower bound on the mesh
edge lengths. Note that occasionally, some elements can have edges shorter than this
parameter.

• Mesh growth rate, which is the rate at which the mesh size increases away from the
small parts of the geometry. The value must be between 1 and 2. This ratio
corresponds to the edge length of two successive elements. The default value is 1.5,
that is, the mesh size increases by 50%.

• Quadratic or linear geometric order. A quadratic element has nodes at its corners and
edge centers, while a linear element has nodes only at its corners.

Create a PDE model.

model = createpde;

Include and plot the following geometry.

importGeometry(model,'PlateSquareHolePlanar.stl');
pdegplot(model)
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Generate a default mesh. For this geometry, the default target maximum and minimum
mesh edge lengths are 8.9443 and 4.4721, respectively.

mesh_default = generateMesh(model)

mesh_default = 
  FEMesh with properties:

             Nodes: [2x1218 double]
          Elements: [6x574 double]
    MaxElementSize: 8.9443
    MinElementSize: 4.4721
     MeshGradation: 1.5000
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    GeometricOrder: 'quadratic'

View the mesh.

figure
pdemesh(mesh_default)

For comparison, create a mesh with the target maximum element edge length of 20.

mesh_Hmax = generateMesh(model,'Hmax',20)

mesh_Hmax = 
  FEMesh with properties:
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             Nodes: [2x286 double]
          Elements: [6x126 double]
    MaxElementSize: 20
    MinElementSize: 10
     MeshGradation: 1.5000
    GeometricOrder: 'quadratic'

figure
pdemesh(mesh_Hmax)

Now create a mesh with the target minimum element edge length of 0.5.

mesh_Hmin = generateMesh(model,'Hmin',0.5)
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mesh_Hmin = 
  FEMesh with properties:

             Nodes: [2x1378 double]
          Elements: [6x654 double]
    MaxElementSize: 8.9443
    MinElementSize: 0.5000
     MeshGradation: 1.5000
    GeometricOrder: 'quadratic'

figure
pdemesh(mesh_Hmin)
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Create a mesh, specifying both the maximum and minimum element edge lengths instead
of using the default values.

mesh_HminHmax = generateMesh(model,'Hmax',20,'Hmin',0.5)

mesh_HminHmax = 
  FEMesh with properties:

             Nodes: [2x458 double]
          Elements: [6x212 double]
    MaxElementSize: 20
    MinElementSize: 0.5000
     MeshGradation: 1.5000
    GeometricOrder: 'quadratic'

View the mesh.

figure
pdemesh(mesh_HminHmax)
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Create a mesh with the same maximum and minimum element edge lengths, but with the
growth rate of 1.9 instead of the default value of 1.5.

mesh_Hgrad = generateMesh(model,'Hmax',20,'Hmin',0.5,'Hgrad',1.9)

mesh_Hgrad = 
  FEMesh with properties:

             Nodes: [2x390 double]
          Elements: [6x178 double]
    MaxElementSize: 20
    MinElementSize: 0.5000
     MeshGradation: 1.9000
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    GeometricOrder: 'quadratic'

figure
pdemesh(mesh_Hgrad)

You also can choose the geometric order of the mesh. The toolbox can generate meshes
made up of quadratic or linear elements. By default, it uses quadratic meshes, which have
nodes at both the edge centers and corner nodes.

mesh_quadratic = generateMesh(model,'Hmax',50);
figure
pdemesh(mesh_quadratic,'NodeLabels','on')
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hold on
plot(mesh_quadratic.Nodes(1,:),mesh_quadratic.Nodes(2,:),'ok','MarkerFaceColor','g')  

To save memory or solve a 2-D problem using a legacy solver, override the default
quadratic geometric order. Legacy PDE solvers require linear triangular meshes for 2-D
geometries.

mesh_linear = generateMesh(model,'Hmax',50,'GeometricOrder','linear');
figure
pdemesh(mesh_linear,'NodeLabels','on')
hold on
plot(mesh_linear.Nodes(1,:),mesh_linear.Nodes(2,:),'ok','MarkerFaceColor','g')  
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Find Mesh Elements and Nodes by Location
Partial Differential Equation Toolbox™ allows you to find mesh elements and nodes by
their geometric location or proximity to a particular point or node. This example works
with a group of elements and nodes located within the specified bounding disk.

Create a steady-state thermal model.

thermalmodel = createpde('thermal','steadystate');

Import and plot the geometry.

importGeometry(thermalmodel,'PlateHolePlanar.stl');
pdegplot(thermalmodel,'FaceLabels','on','EdgeLabels','on')
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Assign the thermal conductivity of the material.

thermalProperties(thermalmodel,'ThermalConductivity',1);

Apply a constant temperature of 20∘C to the left edge and a constant temperature of
−10∘Cto the right edge. All other edges are insulated by default.

thermalBC(thermalmodel,'Edge',4,'Temperature',20);
thermalBC(thermalmodel,'Edge',1,'Temperature',-10);

Generate a mesh and solve the problem. For this example, use a linear mesh to better see
the nodes on the mesh plots. Additional nodes on a quadratic mesh make it difficult to see
the plots in this example clearly.

mesh = generateMesh(thermalmodel,'GeometricOrder','linear');
thermalresults = solve(thermalmodel);

The solver finds the temperatures and temperature gradients at all nodal locations. Plot
the temperatures.

pdeplot(thermalmodel,'XYData',thermalresults.Temperature)
axis equal
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Suppose you need to analyze the results around the center hole more closely. First, find
the nodes and elements located next to the hole by using the findNodes and
findElements functions. For example, find nodes and elements located within the radius
of 2.5 from the center [5 10].

Nr = findNodes(mesh,'radius',[5 10],2.5);
Er = findElements(mesh,'radius',[5 10],2.5);

Highlight the nodes within this radius on the mesh plot using a green marker.

figure
pdemesh(thermalmodel)
hold on
plot(mesh.Nodes(1,Nr),mesh.Nodes(2,Nr),'or','MarkerFaceColor','g')
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Find the minimal and maximal temperatures within the specified radius.

[Temps_disk] = thermalresults.Temperature(Nr);
[T_min,index_min] = min(Temps_disk);
[T_max,index_max] = max(Temps_disk);
T_min

T_min = -2.1698

T_max

T_max = 12.2420

Find the IDs of the nodes corresponding to the minimal and maximal temperatures. Plot
these nodes on the mesh plot.
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nodeIDmin = Nr(index_min);
nodeIDmax = Nr(index_max);

figure
pdemesh(thermalmodel)
hold on
plot(mesh.Nodes(1,nodeIDmin),mesh.Nodes(2,nodeIDmin),'or','MarkerFaceColor','b')
plot(mesh.Nodes(1,nodeIDmax),mesh.Nodes(2,nodeIDmax),'or','MarkerFaceColor','r')

Now highlight the elements within the specified radius on the mesh plot using a green
marker.

figure
pdemesh(thermalmodel)
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hold on
pdemesh(mesh.Nodes,mesh.Elements(:,Er),'EdgeColor','green')

Show the solution for only these elements.

figure
pdeplot(mesh.Nodes,mesh.Elements(:,Er),'XYData',thermalresults.Temperature)
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Assess Quality of Mesh Elements
Partial Differential Equation Toolbox™ uses the finite element method to solve PDE
problems. This method discretizes a geometric domain into a collection of simple shapes
that make up a mesh. The quality of the mesh is crucial for obtaining an accurate
approximation of a solution.

Typically, PDE solvers work best with meshes made up of elements that have an
equilateral shape. Such meshes are ideal. In reality, creating an ideal mesh for most 2-D
and 3-D geometries is impossible because geometries have tiny or narrow regions and
sharp angles. For such regions, a mesh generator creates meshes with some elements
that are much smaller than the rest of mesh elements or have drastically different side
lengths.

As mesh elements become distorted, numeric approximations of a solution typically
become less accurate. Refining a mesh using smaller elements produces better shaped
elements and, therefore, more accurate results. However, it also can be computationally
expensive.

Checking if the mesh is of good quality before running an analysis is a good practice,
especially for simulations that take a long time. The toolbox provides the meshQuality
function for this task.

meshQuality evaluates the shape quality of mesh elements and returns numbers from 0
to 1 for each mesh element. The value 1 corresponds to the optimal shape of the element.
By default, the meshQuality function combines several criteria when evaluating the
shape quality. In addition to the default metric, you can use the aspect-ratio metric,
which is based solely on the ratio of the minimum dimension of an element to its
maximum dimension.

Create a PDE model.

model = createpde;

Include and plot the torus geometry.

importGeometry(model,'Torus.stl');
pdegplot(model)
camlight right
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Generate a coarse mesh.

mesh = generateMesh(model,'Hmax',10);

Evaluate the shape quality of all mesh elements.

Q = meshQuality(mesh);

Find the elements with quality values less than 0.3.

elemIDs = find(Q < 0.3);

Highlight these elements in blue on the mesh plot.

figure
pdemesh(mesh,'FaceAlpha',0.5)
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hold on
pdemesh(mesh.Nodes,mesh.Elements(:,elemIDs),'FaceColor','blue','EdgeColor','blue')

Determine how much of the total mesh volume belongs to elements with quality values
less than 0.3. Return the result as a percentage.

mv03_percent = volume(mesh,elemIDs)/volume(mesh)*100

mv03_percent = 0.0198

Evaluate the shape quality of the mesh elements by using the ratio of minimal to maximal
dimension for each element.

Q = meshQuality(mesh,'aspect-ratio');
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Find the elements with quality values less than 0.3.

elemIDs = find(Q < 0.3);

Highlight these elements in blue on the mesh plot.

figure
pdemesh(mesh,'FaceAlpha',0.5)
hold on
pdemesh(mesh.Nodes,mesh.Elements(:,elemIDs),'FaceColor','blue','EdgeColor','blue')
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Mesh Data as [p,e,t] Triples
Partial Differential Equation Toolbox uses meshes with triangular elements for 2-D
geometries and meshes with tetrahedral elements for 3-D geometries. Earlier versions of
Partial Differential Equation Toolbox use meshes in the form of a [p,e,t] triple. The
matrices p, e, and t represent the points (nodes), elements, and triangles or tetrahedra of
a mesh, respectively. Later versions of the toolbox support the [p,e,t] meshes for
compatibility reasons.

Note  New features might not be compatible with the legacy workflow. For description of
the mesh data in the recommended workflow, see “Mesh Data” on page 2-233.

The mesh data for a 2-D mesh has these components:

• p (points, the mesh nodes) is a 2-by-Np matrix of nodes, where Np is the number of
nodes in the mesh. Each column p(:,k) consists of the x-coordinate of point k in
p(1,k) and the y-coordinate of point k in p(2,k).

• e (edges) is a 7-by-Ne matrix of edges, where Ne is the number of edges in the mesh.
The mesh edges in e and the edges of the geometry have a one-to-one
correspondence. The e matrix represents the discrete edges of the geometry in the
same manner as the t matrix represents the discrete faces. Each column in the e
matrix represents one edge.

• e(1,k) is the index of the first point in mesh edge k.
• e(2,k) is the index of the second point in mesh edge k.
• e(3,k) is the parameter value at the first point of edge k. The parameter value is

related to the arc length along the geometric edge.
• e(4,k) is the parameter value at the second point of edge k.
• e(5,k) is the ID of the geometric edge containing the mesh edge. You can see

edge IDs by using the command pdegplot(geom,'EdgeLabels','on').
• e(6,k) is the subdomain number on the left side of the edge. The direction along

the edge is given by increasing parameter values. The subdomain 0 is the exterior
of the geometry.

• e(7,k) is the subdomain number on the right side of the edge.
• t (triangles) is a 4-by-Nt matrix of triangles or a 7-by-Nt matrix of triangles,

depending on whether you call generateMesh with the GeometricOrder name-
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value pair set to 'quadratic' or 'linear', respectively. initmesh creates only
'linear' elements, which have size 4-by-Nt. Nt is the number of triangles in the
mesh. Each column of t contains the indices of the points in p that form the triangle.
The exception is the last entry in the column, which is the subdomain number. Triangle
points are ordered as shown.

•

The mesh data for a 3-D mesh has these components:

• p (points, the mesh nodes) is a 3-by-Np matrix of nodes, where Np is the number of
nodes in the mesh. Each column p(:,k) consists of the x-coordinate of point k in
p(1,k), the y-coordinate of point k in p(2,k), and the z-coordinate of point k in
p(3,k).

• e is an object that associates the mesh faces with the geometry boundaries. Partial
Differential Equation Toolbox functions use this association when converting the
boundary conditions, which you set on geometry boundaries, to the mesh boundary
faces.

• t (tetrahedra) is either an 11-by-Nt matrix of tetrahedra or a 5-by-Nt matrix of
tetrahedra, depending on whether you call generateMesh with the GeometricOrder
name-value pair set to 'quadratic' or 'linear', respectively. Nt is the number of
tetrahedra in the mesh. Each column of t contains the indices of the points in p that
form the tetrahedron. The exception is the last element in the column, which is the
subdomain number. Tetrahedron points are ordered as shown.
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You can create a [p,e,t] mesh by using one of these approaches:

• Use the initmesh function to create a 2-D [p,e,t] mesh.
• Use the generateMesh function to create a 2-D or 3-D mesh as a FEMesh object.

Then use the meshToPet function to convert the mesh to a [p,e,t] mesh.
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Mesh Data
Partial Differential Equation Toolbox uses meshes with triangular elements for 2-D
geometries and meshes with tetrahedral elements for 3-D geometries. In both cases, it
uses quadratic elements by default, and provides the option to switch to linear elements.
A mesh always consists of elements of the same type. The toolbox does not support mixed
meshes.

The triangles in 2-D meshes are specified by three nodes for linear elements or six nodes
for quadratic elements. A triangle representing a linear element has nodes at the corners.
A triangle representing a quadratic element has nodes at its corners and edge centers.

The tetrahedra in 3-D meshes are specified by four nodes for linear elements or 10 nodes
for quadratic elements. A tetrahedron representing a linear element has nodes at the
corners. A tetrahedron representing a quadratic element has nodes at its corners and
edge centers.
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The model container object stores the parameters of the PDE model. The toolbox offers
several types of model container objects, each for a particular application area. For
example, for linear elasticity problems, the model container is a StructuralModel
object, and for heat transfer problems, the model container is a ThermalModel object.
For general PDE problems, the toolbox uses the PDEModel object.

The Mesh property of the model container object stores mesh data. The Mesh property
contains a FEMesh object. FEMesh include information on the nodes and elements of the
mesh, mesh growth rate, and target minimum and maximum element size. The properties
also indicate whether the mesh is linear or quadratic. You can specify these mesh
parameters when creating a mesh.

To generate a mesh for your PDE model, use the generateMesh function.

By default, generateMesh uses the quadratic geometric order, which typically produces
more accurate results than the linear geometric order. To switch to the linear geometric
order, call the mesh generator and set the GeometricOrder name-value pair to
'linear'.
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Solving PDEs

• “von Mises Effective Stress and Displacements” on page 3-3
• “Clamped, Square Isotropic Plate with Uniform Pressure Load” on page 3-7
• “Deflection of Piezoelectric Actuator” on page 3-12
• “Dynamics of Damped Cantilever Beam” on page 3-25
• “Dynamic Analysis of Clamped Beam” on page 3-38
• “Finite Element Analysis of Electrostatically Actuated MEMS Device” on page 3-48
• “Deflection Analysis of Bracket” on page 3-65
• “Vibration of Square Plate” on page 3-75
• “Structural Dynamics of Tuning Fork” on page 3-80
• “Modal Superposition Method for Structural Dynamics Problem” on page 3-91
• “Stress Concentration in Plate with Circular Hole” on page 3-96
• “Thermal Deflection of Bimetallic Beam” on page 3-106
• “Electrostatic Potential in Air-Filled Frame” on page 3-114
• “Linear Elasticity Equations” on page 3-117
• “Magnetic Field in Two-Pole Electric Motor” on page 3-124
• “Scattering Problem” on page 3-130
• “AC Power Electromagnetics Equations” on page 3-136
• “Skin Effect in Copper Wire with Circular Cross Section” on page 3-138
• “Current Density Between Two Metallic Conductors” on page 3-146
• “Heat Transfer Between Two Squares Made of Different Materials: PDE Modeler App”

on page 3-149
• “Nonlinear Heat Transfer in Thin Plate” on page 3-153
• “Poisson's Equation on Unit Disk: PDE Modeler App” on page 3-163
• “Poisson's Equation on Unit Disk” on page 3-169
• “Scattering Problem: PDE Modeler App” on page 3-179
• “Minimal Surface Problem” on page 3-184
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• “Minimal Surface Problem: PDE Modeler App” on page 3-189
• “Poisson's Equation with Point Source and Adaptive Mesh Refinement” on page 3-191
• “Heat Transfer in Block with Cavity: PDE Modeler App” on page 3-197
• “Heat Transfer in Block with Cavity” on page 3-202
• “Heat Transfer Problem with Temperature-Dependent Properties” on page 3-206
• “Heat Conduction in Multidomain Geometry with Nonuniform Heat Flux”

on page 3-216
• “Inhomogeneous Heat Equation on Square Domain” on page 3-224
• “Heat Distribution in Circular Cylindrical Rod” on page 3-229
• “Heat Distribution in Circular Cylindrical Rod: PDE Modeler App” on page 3-239
• “Wave Equation on Square Domain” on page 3-243
• “Wave Equation on Square Domain: PDE Modeler App” on page 3-248
• “Eigenvalues and Eigenmodes of L-Shaped Membrane” on page 3-251
• “Eigenvalues and Eigenmodes of L-Shaped Membrane: PDE Modeler App”

on page 3-257
• “L-Shaped Membrane with Rounded Corner” on page 3-260
• “Eigenvalues and Eigenmodes of Square” on page 3-263
• “Eigenvalues and Eigenmodes of Square: PDE Modeler App” on page 3-270
• “Vibration of Circular Membrane” on page 3-273
• “Solve PDEs Programmatically” on page 3-278
• “Plot 2-D Solutions and Their Gradients” on page 3-284
• “Plot 3-D Solutions and Their Gradients” on page 3-295
• “Dimensions of Solutions, Gradients, and Fluxes” on page 3-317

3 Solving PDEs

3-2



von Mises Effective Stress and Displacements
This example shows how to compute the displacements u and v and the von Mises
effective stress for a steel plate that is clamped along a right-angle inset at the lower-left
corner, and pulled along a rounded cut at the upper-right corner. The example uses the
PDE Modeler app. The app also lets you compute and visualize other properties, such as
the x- and y-direction strains and stresses and the shear stress.

Consider a steel plate that is clamped along a right-angle inset at the lower-left corner,
and pulled along a rounded cut at the upper-right corner. All other sides are free. The
steel plate has the following properties:

• Dimensions 1 m-by-1 m-by 0.001 m;
• Inset is 1/3-by-1/3 m
• The rounded cut runs from (2/3, 1) to (1, 2/3)
• Young's modulus: 196 · 103 (MN/m2)
• Poisson's ratio: 0.31.

The curved boundary is subjected to an outward normal load of 500 N/m. To specify a
surface traction, divide the load by the thickness (0.001 m). Thus, the surface traction is
0.5 MN/m2. The force unit in this example is MN.

To solve this problem in the PDE Modeler app, follow these steps:

1 Draw a polygon with corners (0 1), (2/3,1), (1,2/3), (1,0), (1/3,0), (1/3,1/3), (0,1/3) and
a circle with the center (2/3, 2/3) and radius 1/3.

pdepoly([0 2/3 1 1 1/3 1/3 0],[1 1 2/3 0 0 1/3 1/3])
pdecirc(2/3,2/3,1/3)

2 Set the x-axis limit to [-0.5 1.5] and y-axis limit to [0 1.2]. To do this, select
Options > Axes Limits and set the corresponding ranges.

3 Model the geometry by entering P1+C1 in the Set formula field.
4 Set the application mode to Structural Mechanics, Plane Stress.
5 Remove all subdomain borders. To do this, switch to the boundary mode by selecting

Boundary > Boundary Mode. Then select Boundary > Remove All Subdomain
Borders.

6 Display the edge labels by selecting Boundary > Show Edge Labels.
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7 Specify the boundary conditions. To do this, select Boundary > Specify Boundary
Conditions.

• For convenience, first specify the Neumann boundary condition g1 = g2 = 0,
q11 = q12 = q21 = q22 = 0 (no normal stress) for all boundaries. Use Edit >
Select All to select all boundaries.

• For the two clamped boundaries at the inset in the lower left (edges 4 and 5),
specify the Dirichlet boundary condition with zero displacements: h11 = 1, h12
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= 0, h21 = 0, h22 = 1, r1 = 0, r2 = 0. Use Shift+click to select several
boundaries.

• For the rounded cut (edge 7), specify the Neumann boundary condition: g1 =
0.5*nx, g2 = 0.5*ny, q11 = q12 = q21 = q22 = 0.

8 Specify the coefficients by selecting PDE > PDE Specification or clicking the PDE
button on the toolbar. Specify E = 196E3 and nu = 0.31. The material is
homogeneous, so the same values E and nu apply to the entire 2-D domain. Because
there are no volume forces, specify Kx = Ky = 0. The elliptic type of PDE for plane
stress does not use density, so you can specify any value. For example, specify pho =
0.

9 Initialize the mesh by selecting Mesh > Initialize Mesh. Refine the mesh by
selecting Mesh > Refine Mesh.

10 Refining the mesh in areas where the gradient of the solution (the stress) is large. To
do this, select Solve > Parameters. In the resulting dialog box, select Adaptive
mode. Use the default adaptation options: the Worst triangles triangle selection
method with the Worst triangle fraction set to 0.5.

11 Solve the PDE by selecting Solve > Solve PDE or clicking the = button on the
toolbar.

12 Plot the von Mises effective stress using color. Plot the displacement vector field (u,v)
using a deformed mesh. To do this:

a Select Plot > Parameters.
b In the resulting dialog box, select the Color and Deformed mesh options. Select

von Mises from the Color drop-down menu. Select Show Mesh to observe the
refined mesh in large stress areas.
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By selecting other options from the Color drop-down menu, you can visualize different
strain and stress properties, such as the x- and y-direction strains and stresses, the shear
stress, and the principal stresses and strains. You also can plot combinations of scalar and
vector properties by using color, height, vector field arrows, and displacements in a 3-D
plot to represent different properties.
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Clamped, Square Isotropic Plate with Uniform Pressure
Load

This example shows how to calculate the deflection of a structural plate acted on by a
pressure loading.

PDE and Boundary Conditions For A Thin Plate

The partial differential equation for a thin, isotropic plate with a pressure loading is

∇2(D∇2w) = − p

where D is the bending stiffness of the plate given by

D = Eh3

12(1 − ν2)

and E is the modulus of elasticity, ν is Poisson's ratio, and h is the plate thickness. The
transverse deflection of the plate is w and p is the pressure load.

The boundary conditions for the clamped boundaries are w = 0 and w′ = 0 where w′ is the
derivative of w in a direction normal to the boundary.

The Partial Differential Equation Toolbox™ cannot directly solve the fourth order plate
equation shown above but this can be converted to the following two second order partial
differential equations.

∇2w = v

D∇2v = − p

where v is a new dependent variable. However, it is not obvious how to specify boundary
conditions for this second order system. We cannot directly specify boundary conditions
for both w and w′. Instead, we directly prescribe w′ to be zero and use the following
technique to define v′ in such a way to insure that w also equals zero on the boundary.
Stiff "springs" that apply a transverse shear force to the plate edge are distributed along
the boundary. The shear force along the boundary due to these springs can be written
n ⋅ D∇v = − kw where n is the normal to the boundary and k is the stiffness of the
springs. The value of k must be large enough that w is approximately zero at all points on
the boundary but not so large that numerical errors result because the stiffness matrix is
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ill-conditioned. This expression is a generalized Neumann boundary condition supported
by Partial Differential Equation Toolbox™

In the Partial Differential Equation Toolbox™ definition for an elliptic system, the w and v
dependent variables are u(1) and u(2). The two second order partial differential equations
can be rewritten as

−∇2u1 + u2 = 0

−D∇2u2 = p

which is the form supported by the toolbox. The input corresponding to this formulation is
shown in the sections below.

Create the PDE Model

Create a pde model for a PDE with two dependent variables.

numberOfPDE = 2;
model = createpde(numberOfPDE);

Problem Parameters

E = 1.0e6; % modulus of elasticity
nu = .3; % Poisson's ratio
thick = .1; % plate thickness
len = 10.0; % side length for the square plate
hmax = len/20; % mesh size parameter
D = E*thick^3/(12*(1 - nu^2));
pres = 2; % external pressure

Geometry Creation

For a single square, the geometry and mesh are easily defined as shown below.

gdm = [3 4 0 len len 0 0 0 len len]';
g = decsg(gdm,'S1',('S1')');

Create a geometry entity.

geometryFromEdges(model,g);

Plot the geometry and display the edge labels for use in the boundary condition definition.
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figure; 
pdegplot(model,'EdgeLabels','on');
ylim([-1,11])
axis equal
title 'Geometry With Edge Labels Displayed';

Coefficient Definition

The documentation on PDE coefficients shows the required formats for the a and c
matrices. The most convenient form for c in this example is nc = 3N from the table where
N is the number of differential equations. In this example N = 2. The c tensor, in the form
of an N × N matrix of 2 × 2 submatrices is shown below.
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c(1) c(2) ⋅ ⋅
⋅ c(3) ⋅ ⋅
⋅ ⋅ c(4) c(5)
⋅ ⋅ ⋅ c(6)

The six-row by one-column c matrix is defined below. The entries in the full 2 × 2 a matrix
and the 2 × 1 f vector follow directly from the definition of the two-equation system shown
above.

c = [1 0 1 D 0 D]';
a = [0 0 1 0]';
f = [0 pres]';
specifyCoefficients(model,'m',0,'d',0,'c',c,'a',a,'f',f);

Boundary Conditions

k = 1e7; % spring stiffness

Define distributed springs on all four edges.

bOuter = applyBoundaryCondition(model,'neumann','Edge',(1:4),...
                                     'g',[0 0],'q',[0 0; k 0]);

Mesh generation

generateMesh(model, 'Hmax', hmax);

Finite Element and Analytical Solutions

The solution is calculated using the solvepde function and the transverse deflection is
plotted using the pdeplot function. For comparison, the transverse deflection at the
plate center is also calculated using an analytical solution to this problem.

res = solvepde(model);
u = res.NodalSolution;
numNodes = size(model.Mesh.Nodes,2);
figure
pdeplot(model,'XYData',u(1:numNodes),'Contour','on');
title 'Transverse Deflection'
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numNodes = size(model.Mesh.Nodes,2);
fprintf('Transverse deflection at plate center(PDE Toolbox) = %12.4e\n',...
                                                  min(u(1:numNodes,1)));

Transverse deflection at plate center(PDE Toolbox) =  -2.7632e-01

Compute analytical solution.

wMax = -.0138*pres*len^4/(E*thick^3);
fprintf('Transverse deflection at plate center(analytical) = %12.4e\n', wMax);

Transverse deflection at plate center(analytical) =  -2.7600e-01
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Deflection of Piezoelectric Actuator
This example shows how to solve a coupled elasticity-electrostatics problem.

Piezoelectric materials deform when a voltage is applied. Conversely, a voltage is
produced when a piezoelectric material is deformed. Analysis of a piezoelectric part
requires the solution of a set of coupled partial differential equations with deflections and
electrical potential as dependent variables. One of the main objectives of this example is
to show how such a system of coupled partial differential equations can be solved using
PDE Toolbox.

PDE For a Piezoelectric Solid

The elastic behavior of the solid is described by the equilibrium equations

−∇ ⋅ σ = f

where σ is the stress tensor and f  is the body force vector. The electrostatic behavior of
the solid is described by Gauss' Law

∇ ⋅ D = ρ

where D is the electric displacement and ρ is the distributed, free charge. These two PDE
systems can be combined into the following single system

−∇ ⋅
σ
D

=
f
−ρ

In 2D, σ has the components σ11, σ22, and σ12 = σ21 and D has the components D1 and D2.

The constitutive equations for the material define the stress tensor and electric
displacement vector in terms of the strain tensor and electric field. For a 2D, orthotropic,
piezoelectric material under plane stress conditions these are commonly written as

σ11
σ22
σ12
D1
D2

=

C11 C12 e11 e31
C12 C22 e13 e33

G12 e14 e34

e11 e13 e14 −ℰ1

e31 e33 e34 −ℰ2

ϵ11
ϵ22
γ12
−E1
−E2
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where Ci j are the elastic coefficients, ℰi are the electrical permittivities, and ei j are the
piezoelectric stress coefficients. The piezoelectric stress coefficients are written to
conform to conventional notation in piezoelectric materials where the z-direction (3-
direction) is aligned with the "poled" direction of the material. For the 2D analysis, we
want the poled direction to be aligned with the y-axis.

Finally, the strain vector can be written in terms of the x-displacement, u, and y-
displacement, v as

ϵ11
ϵ22
γ12

=

∂u
∂x
∂v
∂y

∂u
∂y + ∂v

∂x

and the electric field written in terms of the electrical potential, ϕ, as

E1
E2

= −

∂ϕ
∂x
∂ϕ
∂y

See reference 2, for example, for a more complete description of the piezoelectric
equations.

The strain-displacement equations and electric field equations above can be substituted
into the constitutive equations to yield a system of equations for the stresses and
electrical displacements in terms of displacement and electrical potential derivatives. If
the resulting equations are substituted into the PDE system equations, we have a system
of equations that involve the divergence of the displacement and electrical potential
derivatives. Arranging these equations to match the form required by PDE Toolbox will be
the topic for the next section.

Converting the Equations to PDE Toolbox Form

The PDE Toolbox requires a system of elliptic equations to be expressed in the form

−∇ ⋅ c⊗ ∇u + au = f

or in tensor form
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− ∂
∂xk

ci jkl
∂u j
∂xl

+ ai ju j = f i

where summation is implied by repeated indices. For the 2D piezoelectric system
described above, the PDE Toolbox system vector u is

u =
u
v
ϕ

This is an N = 3 system. The gradient of u is given by

∇u =

∂u
∂x
∂u
∂y
∂v
∂x
∂v
∂y
∂ϕ
∂x
∂ϕ
∂y

The documentation for the function assempde shows that it is convenient to view the
tensor ci jkl as an N × N matrix of 2 × 2 submatrices. The most convenient form for the c
input argument for this symmetric, N = 3 system has 21 rows in c and is described in
detail in the PDE Toolbox documentation. It is repeated here for convenience.

c(1) c(2) c(4) c(6) c(11) c(13)
⋅ c(3) c(5) c(7) c(12) c(14)
⋅ ⋅ c(8) c(9) c(15) c(17)
⋅ ⋅ ⋅ c(10) c(16) c(18)
⋅ ⋅ ⋅ ⋅ c(19) c(20)
⋅ ⋅ ⋅ ⋅ ⋅ c(21)
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For the purposes of mapping terms from constitutive equations to the form required by
PDE Toolbox it is useful to write the c tensor and solution gradient in the following form

c1111 c1112 c1211 c1212 c1311 c1312
⋅ c1122 c1221 c1222 c1321 c1322
⋅ ⋅ c2211 c2212 c2311 c2312

⋅ ⋅ ⋅ c2222 c2321 c2322
⋅ ⋅ ⋅ ⋅ c3311 c3312

⋅ ⋅ ⋅ ⋅ ⋅ c3322

∂u
∂x
∂u
∂y
∂v
∂x
∂v
∂y
∂ϕ
∂x
∂ϕ
∂y

From this equation the traditional constitutive coefficients can be mapped to the form
required for the PDE Toolbox c matrix. Note the minus sign in the equations for electric
field. This minus must be incorporated into the c matrix to match the PDE Toolbox
convention. This is shown explicitly below.

C11 ⋅ ⋅ C12 e11 e31
⋅ G12 G12 ⋅ e14 e34
⋅ ⋅ G12 ⋅ e14 e34

⋅ ⋅ ⋅ C22 e13 e33

⋅ ⋅ ⋅ ⋅ −ℰ1 ⋅
⋅ ⋅ ⋅ ⋅ ⋅ −ℰ2

∂u
∂x
∂u
∂y
∂v
∂x
∂v
∂y
∂ϕ
∂x
∂ϕ
∂y

Piezoelectric Bimorph Actuator Model

Now that we have defined the equations for a 2D piezoelectric material, we are ready to
apply these to a specific model. The model is a two-layer cantilever beam that has been
extensively studied (e.g. refs 1 and 2). It is defined as a "bimorph" because although both
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layers are made of the same Polyvinylidene Fluoride (PVDF) material, in the top layer the
polarization direction points down (minus y direction) and in the bottom layer, it points
up. A schematic of the cantilever beam is shown in the figure below.

This figure is not to scale; the actual thickness/length ratio is 100 so the beam is very
slender. When a voltage is applied between the lower and upper surfaces of the beam, it
deflects in the y-direction; one layer shortens and the other layer lengthens. Devices of
this type can be designed to provide the required motion or force for different
applications.

Create a PDE Model with three dependent variables

The first step in solving a PDE problem is to create a PDE Model. This is a container that
holds the number of equations, geometry, mesh, and boundary conditions for your PDE.
The equations of linear elasticity have three components, so the number of equations in
this model is three.

N = 3;
model = createpde(N);
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Geometry Creation

The simple two-layer geometry of the beam can be created by defining the sum of two
rectangles.

L = 100e-3; % beam length in meters
H = 1e-3; % overall height of the beam
H2 = H/2; % height of each layer in meters

The two lines below contain the columns of the geometry description matrix (GDM) for
the two rectangular layers. The GDM is the first input argument to decsg and describes
the basic geometric entities in the model.

topLayer = [3 4 0 L L 0 0 0 H2 H2];
bottomLayer = [3 4 0 L L 0 -H2 -H2 0 0];
gdm = [topLayer; bottomLayer]';
g = decsg(gdm, 'R1+R2', ['R1'; 'R2']');

Create a geometry entity and append to the PDE model.

geometryFromEdges(model,g);

figure; 
pdegplot(model, 'EdgeLabels', 'on', 'FaceLabels', 'on');
xlabel('X-coordinate, meters')
ylabel('Y-coordinate, meters')
axis([-.1*L, 1.1*L, -4*H2, 4*H2])
axis square
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Material Properties and Coefficient Specification

The material in both layers of the beam is Polyvinylidene Fluoride (PVDF), a thermoplastic
polymer with piezoelectric behavior.

E = 2.0e9; % Elastic modulus, N/m^2
NU = 0.29; % Poisson's ratio
G = 0.775e9; % Shear modulus, N/m^2
d31 = 2.2e-11; % Piezoelectric strain coefficients, C/N
d33 = -3.0e-11;

Specify relative electrical permittivity of the material at constant stress.

relPermittivity = 12;
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Specify electrical permittivity of vacuum.

permittivityFreeSpace = 8.854187817620e-12; % F/m
C11 = E/(1-NU^2); 
C12 = NU*C11;
c2d = [C11 C12 0; C12 C11 0; 0 0 G];
pzeD = [0 d31; 0 d33; 0 0];

The piezoelectric strain coefficients for PVDF are given above but the constitutive
relations in the finite element formulation require the piezoelectric stress coefficients.
These are calculated on the next line (for details see, for example, reference 2).

pzeE = c2d*pzeD;
D_const_stress = [relPermittivity 0; 0 relPermittivity]*permittivityFreeSpace;

Convert dielectric matrix from constant stress to constant strain

D_const_strain = D_const_stress - pzeD'*pzeE;

As discussed above, it is convenient to view the 21 coefficients required by assempde as a
3 x 3 array of 2 x 2 submatrices. The cij matrices defined below are the 2 x 2 submatrices
in the upper triangle of this array.

c11 = [c2d(1,1) c2d(1,3) c2d(3,3)];
c12 = [c2d(1,3) c2d(1,2); c2d(3,3) c2d(2,3)];
c22 = [c2d(3,3) c2d(2,3) c2d(2,2)];
c13 = [pzeE(1,1) pzeE(1,2); pzeE(3,1) pzeE(3,2)];
c23 = [pzeE(3,1) pzeE(3,2); pzeE(2,1) pzeE(2,2)];
c33 = [D_const_strain(1,1) D_const_strain(2,1) D_const_strain(2,2)];
ctop = [c11(:); c12(:); c22(:); -c13(:); -c23(:); -c33(:)];
cbot = [c11(:); c12(:); c22(:);  c13(:);  c23(:); -c33(:)];

f = [0 0 0]';
specifyCoefficients(model, 'm', 0,'d', 0,'c', ctop, 'a', 0, 'f', f,'Face',2);
specifyCoefficients(model, 'm', 0,'d', 0,'c', cbot, 'a', 0, 'f', f,'Face',1);

Boundary Condition Definition

For this example, the top geometry edge (edge 1) has the voltage prescribed as 100 volts.
The bottom geometry edge (edge 2) has the voltage prescribed as 0 volts (i.e. grounded).
The left geometry edge (edges 6 and 7) have the u and v displacements equal zero (i.e.
clamped). The stress and charge are zero on the right geometry edge (i.e. q = 0).

V = 100;
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Set the voltage (solution component 3) on the top edge to V.

voltTop = applyBoundaryCondition(model,'mixed','Edge',1,...
                                               'u',V,...
                                               'EquationIndex',3);

Set the voltage (solution component 3) on the bottom edge to zero.

voltBot = applyBoundaryCondition(model,'mixed','Edge',2,...
                                               'u',0,...
                                               'EquationIndex',3);

Set the x and y displacements (solution components 1 and 2) on the left end (geometry
edges 6 and 7) to zero.

clampLeft = applyBoundaryCondition(model,'mixed','Edge',6:7,...
                                                 'u',[0 0],...
                                                 'EquationIndex',1:2);

Mesh Generation

We need a relatively fine mesh to accurately model the bending of the beam.

hmax = 5e-04;
msh = generateMesh(model,'Hmax',hmax,...
                         'GeometricOrder','quadratic',...
                         'MesherVersion','R2013a');

Finite Element Solution

result = solvepde(model);

Extract the NodalSolution property from the result, this has the x-deflection in column
1, the y-deflection in column 2, and the electrical potential in column 3. Find the
minimum y-deflection, and plot the solution components.

rs = result.NodalSolution;
feTipDeflection = min(rs(:,2));
fprintf('Finite element tip deflection is: %12.4e\n', feTipDeflection);

Finite element tip deflection is:  -3.2900e-05

varsToPlot = char('X-Deflection, meters', 'Y-Deflection, meters', ...
  'Electrical Potential, Volts');
for i = 1:size(varsToPlot,1)
  figure;
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  pdeplot(model, 'XYData', rs(:,i), 'Contour', 'on');
  title(varsToPlot(i,:))
  % scale the axes to make it easier to view the contours
  axis([0, L, -4*H2, 4*H2])
  xlabel('X-Coordinate, meters')

  ylabel('Y-Coordinate, meters')
  axis square
end
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Analytical Solution

A simple, approximate, analytical solution was obtained for this problem in reference 1.

tipDeflection = -3*d31*V*L^2/(8*H2^2);
fprintf('Analytical tip deflection is: %12.4e\n', tipDeflection);

Analytical tip deflection is:  -3.3000e-05

Summary

The color contour plots of x-deflection and y-deflection show the standard behavior of the
classical cantilever beam solution. The linear distribution of voltage through the thickness
of the beam is as expected. There is good agreement between the PDE Toolbox finite
element solution and the analytical solution from reference 1.
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Although this example shows a very specific coupled elasticity-electrostatic model, the
general approach here can be used for many other systems of coupled PDEs. The key to
applying PDE Toolbox to these types of coupled systems is the systematic, multi-step
coefficient mapping procedure described above.
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Dynamics of Damped Cantilever Beam
This example shows how to include damping in the transient analysis of a simple
cantilever beam.

The beam is modeled with a plane stress elasticity formulation. The damping model is
basic viscous damping distributed uniformly through the volume of the beam. Several
transient analyses are performed where the beam is deformed into an initial shape and
then released at time, t = 0. Analyses with and without damping are considered. Two
initial displacement shapes are considered. In the first, the beam is deformed into a shape
corresponding to the lowest vibration mode. In the second, the beam is deformed by
applying an external load at the tip of the beam. No additional loading is applied in this
example so, in the damped cases, the displacement of the beam decays as a function of
time due to the damping.

The transient analyses are performed using the PDE Toolbox hyperbolic function. One
form of this function allows a transient analysis to be performed with the stiffness, mass,
and damping matrices and load vectors as input. Typically these matrices and vectors are
calculated using other PDE Toolbox functions. That approach will be demonstrated in this
example.

A particularly simple way to construct a damping matrix is by using what is commonly
referred to as Rayleigh damping. With Rayleigh damping, the damping matrix is defined
as a linear combination of the mass and stiffness matrices:

D = αM + βK

It is common to express damping as a percentage of critical damping, ξ, for a selected
vibration frequency. For a given frequency, ωi, the following expression relates ξ to α and
β.

ξ = α
2ωi

+
βωi
2

In this example, we will define ξ = 0 . 03 (three percent of critical damping) and β equal
zero so that α can be calculated as α = 2 × . 03ωi

This example specifies values of parameters using the imperial system of units. You can
replace them with values specified in the metric system. If you do so, ensure that you
specify all values throughout the example using the same system.
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Beam Parameters

Specify the beam dimensions. It is 5 inches long and 0.1 inches thick.

width = 5; 
height = 0.1;

Specify that the material is steel.

E = 3.0e7; 
nu = 0.3; 
rho = 0.3/386;

Calculate the coefficient matrix from the material properties.

G = E/(2.*(1+nu));
mu = 2.0*G*nu/(1-nu);

From beam theory, there is a simple expression for the lowest vibration frequency of the
cantilever beam.

I = height^3/12; 
A = height;

eigValAnalytical = 1.8751^4*E*I/(rho*A*width^4); 
freqAnalytical = sqrt(eigValAnalytical)/(2*pi);

Problem Setup

Create a PDEModel with two independent variables to represent the analysis.

numberOfPDE = 2;
model = createpde(numberOfPDE);

Create a simple rectangular geometry.

gdm = [3;4;0;width;width;0;0;0;height;height];
g = decsg(gdm,'S1',('S1')');

Plot the geometry and display the edge labels for use in the boundary condition definition.

figure; 
pdegplot(g,'EdgeLabels','on'); 
axis equal
title 'Geometry With Edge Labels Displayed'
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Provide the model with a definition of the geometry.

geometryFromEdges(model,g);

Specify the coefficients by deriving them from the material properties.

c = [2*G+mu;0;G;0;G;mu;0;G;0;2*G+mu];
f = [0;0];
a = 0;
m = rho;
specifyCoefficients(model,'m',m,'d',0,'c',c,'a',a,'f',f);

Specify the following boundary condition to clamp (displacements equal zero) the left
beam-edge.
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applyBoundaryCondition(model,'dirichlet','Edge',4,'u',[0 0]);

Define a maximum element size (5 elements through the beam thickness) and generate a
mesh.

hmax = height/5;
msh=generateMesh(model,'Hmax',hmax,'MesherVersion','R2013a');

Calculation of Vibration Modes and Frequencies

Use solvepdeeig and then compute the lowest-frequency vibration mode.

res = solvepdeeig(model, [0,1e6]');

              Basis= 10,  Time=   1.17,  New conv eig=  2
End of sweep: Basis= 10,  Time=   1.19,  New conv eig=  2
              Basis= 12,  Time=   2.03,  New conv eig=  1
End of sweep: Basis= 12,  Time=   2.11,  New conv eig=  1

eigenVec = res.Eigenvectors;
eigenVal = res.Eigenvalues;

Color plot of y-displacement of the lowest-frequency vibration mode.

freqNumerical = sqrt(eigenVal(1))./(2*pi);
longestPeriod = 1/freqNumerical;

Plot the deformed shape of the beam with the displacements scaled by an arbitrary factor.

scaleFactor = 20;
figure;
[p,e,t] = meshToPet(msh);
pdeplot(p+scaleFactor*eigenVec',e,t,'XYData',real(eigenVec(:,2)));
title('Lowest Frequency Vibration Mode');
axis equal
xlabel('Inches');
ylabel('Inches');
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drawnow

fprintf('Lowest beam frequency (Hz). Analytical = %8.3e, Numerical = %8.3e\n', ...
  freqAnalytical,freqNumerical);

Lowest beam frequency (Hz). Analytical = 1.269e+02, Numerical = 1.269e+02

Transient Analysis, Initial Displacement From First Mode Shape

In the first two transient analyses, we define an initial displacement. in the shape of the
lowest vibration mode. By doing this, we convert the PDE to a single ODE with time as
the independent variable. The solution to this ODE is the same as that of the classical
spring-mass-damper system with a frequency equal the frequency of this vibration mode.
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Thus we are able to compare the numerical solution with the analytical solution to this
well-known problem.

For convenience, we will scale the eigenvector shape so that y-displacement at the tip
is .1 inches. This makes the transient history plots simpler.

uEigenTip = eigenVec(2,2);
u0TipDisp = .1;

u0 = u0TipDisp/uEigenTip*eigenVec;

First solve the undamped system.

Calculate the solution for three full periods.

tlist = 0:longestPeriod/100:3*longestPeriod;

Create a function handle that can be used to provide initial conditions.

R = createPDEResults(model, u0(:));
ice = icEvaluator(R);

Set the initial conditions and solve the system.

setInitialConditions(model, @ice.computeIC, 0);
tres = solvepde(model,tlist);

The displacement at the tip is a sinusoidal function of time with amplitude equal to the
initial y-displacement. This agrees with the solution to the simple spring-mass system.

titl = 'Initial Displacements from Lowest Eigenvector, Undamped Solution';
cantileverBeamTransientPlot(tres,titl);
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Now solve the system with damping equal to 3% of critical for this lowest vibration
frequency.

fem = assembleFEMatrices(model);
zeta = .03; 
omega = 2*pi*freqNumerical; 
alpha = 2*zeta*omega;
dampmat = alpha*fem.M;
specifyCoefficients(model,'m',m,'d',dampmat,'c',c,'a',a,'f',f);
tres = solvepde(model,tlist);

This figure shows the y-displacement at the tip as a function of time. Superimposed on
this plot is a second curve which shows the envelope of the maximum amplitude as a
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function of time, calculated from the solution to the single degree-of-freedom ODE. As
expected, the PDE solution agrees well with the analytical solution.

titl = 'Initial Displacements from Lowest Eigenvector, Damped Solution';
cantileverBeamTransientPlot(tres,titl);
hold on;
plot(tlist,u0TipDisp*exp(-zeta*omega*tlist),'Color','r');
legend('PDE','ODE Amplitude Decay','Location','southeast');

Transient Analysis, Initial Displacement From Static Solution

It would be very unusual for a structure to be loaded such that the displacement is equal
to a multiple of one of its vibration modes. In this more realistic example, we solve the
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transient equations with the initial displacement shape calculated from the static solution
of the cantilever beam with a vertical load at the tip.

Perform a static analysis with vertical tip load equal one. Follow the model building steps
as before.

P = 1.0;
pdeTipLoad = createpde(2);
pg = geometryFromEdges(pdeTipLoad,g);

Specify the equation to solve.

specifyCoefficients(pdeTipLoad,'m',0,'d',0,'c',c,'a',a,'f',f);
tipLoad = applyBoundaryCondition(pdeTipLoad,'neumann','Edge',2,'g',[0 P/height]);
clampedEdge = applyBoundaryCondition(pdeTipLoad,'dirichlet','Edge',4,'u',[0,0]);
msh=generateMesh(pdeTipLoad,'Hmax',hmax,'MesherVersion','R2013a');

statres = solvepde(pdeTipLoad);

To make comparison with the eigenvector case clearer, we will also scale this static
solution so that the maximum y-displacement at the tip equals .1 inches.

u = statres.NodalSolution;
uEigenTip = u(2,2); 
u0TipDisp = 0.1;
u0 = u0TipDisp/uEigenTip*u;

Calculate the undamped solution with the initial displacement from the static analysis.

specifyCoefficients(model, 'm', m, 'd', 0, 'c', c, 'a', a, 'f', f);

Set the initial conditions and solve the system.

R = createPDEResults(model, u0(:));
ice = icEvaluator(R);
setInitialConditions(model, @ice.computeIC, 0);
tres = solvepde(model,tlist);

The displacement is no longer a pure sinusoidal wave. The static solution that we are
using as the initial conditions is similar to the lowest eigenvector but higher-frequency
modes are also contributing to the transient solution.

titl = 'Initial Displacements from Static Solution, Undamped Solution';
cantileverBeamTransientPlot(tres,titl);
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Calculate the damped solution with the initial displacement from the static analysis. The
damping matrix is the same as that used in the eigenvector case, above.

specifyCoefficients(model, 'm', m, 'd', dampmat, 'c', c, 'a', a, 'f', f);
tres = solvepde(model,tlist);

Plot the tip displacement from this solution as a function of time. Again we superimpose a
curve of the damped amplitude as a function of time obtained from an analytical solution
to the single degree-of-freedom ODE. Because the initial condition differs from the lowest
eigenvector, this analytical solution only approximates the amplitude of the PDE solution.

titl = 'Initial Displacements from Static Solution, Damped Solution';
cantileverBeamTransientPlot(tres,titl);
hold on;
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plot(tlist,u0TipDisp*exp(-zeta*omega*tlist),'Color','r');
legend('PDE','ODE Amplitude Decay','Location','southeast');

Utility Plot Function

Utility function for creating the plots of tip y-displacement as a function of time.

type cantileverBeamTransientPlot.m

function cantileverBeamTransientPlot( tdres, titl )
%CANTILEVERBEAMTRANSIENTPLOT Plot y-displacement at the beam tip
%   tdres - Time-dependent results object representing displacements as a function of time
%   titl plot title
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% Copyright 2013-2015 The MathWorks, Inc.

tlist = tdres.SolutionTimes;
uu = tdres.NodalSolution;
utip = uu(2,2,:);
figure; plot(tlist, utip(:)); grid on;
title(titl); xlabel('Time, seconds');
ylabel('Y-displacement at beam tip, inches');
drawnow;
end

Function Handle for Specifying Initial Condition (IC)

The evaluation function returns the value of the IC at any point within the mesh. A results
object represents the values and the interpolation function that it provided is used to
compute the ICs.

type icEvaluator.m

classdef icEvaluator
% icEvaluator Evaluates Initial Conditions data at requested locations
% ICE = icEvaluator(R) Creates an initial conditions evaluator from a 
% results object. The evaluator provides a function that can be called at 
% specific locations within the geometry. This class customized to represent
% a stationary solution.
%
% icEvaluator methods:
%    computeIC - Computes ICs at locations within the geometric domain
%

% Copyright 2015 The MathWorks, Inc.              
    properties
        Results;           
    end

    methods
        function obj = icEvaluator(R)                 
            obj.Results = R;                                                                                                                                 
        end
                
        function ic = computeIC(obj,locations)
            is2d = size(obj.Results.Mesh.Nodes, 1) == 2;
            if is2d
                querypts = [locations.x; locations.y];
            else
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                  querypts = [locations.x; locations.y; locations.z];
            end
            numeqns = size(obj.Results.NodalSolution,2);
            if numeqns == 1 
                ic = interpolateSolution(obj.Results, querypts);
            else       
                ic = zeros(numeqns, numel(locations.x));
                for i = 1:numeqns
                    ic(i,:) = interpolateSolution(obj.Results, querypts, i);
                end             
            end           
        end       
    end    
end
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Dynamic Analysis of Clamped Beam
This example shows how to analyze the dynamic behavior of a beam clamped at both ends
and loaded with a uniform pressure load.

The pressure load is suddenly applied at time equal zero and the magnitude is high
enough to produce deflections on the same order as the beam thickness.

Accurately predicting this type of behavior requires a geometrically-nonlinear formulation
of the elasticity equations. One of the main purposes of this example is to show how PDE
Toolbox can be used to solve a problem in nonlinear elasticity. The analysis will be
performed with both linear and nonlinear formulations to demonstrate the importance of
the latter.

This example specifies values of parameters using the imperial system of units. You can
replace them with values specified in the metric system. If you do so, ensure that you
specify all values throughout the example using the same system.

Equations

This section describes the equations of geometrically nonlinear elasticity. One approach
to handling the large deflections is to consider the elasticity equations in the deformed
position. However, PDE Toolbox formulates the equations based on the original geometry.
This motivates using a Lagrangian formulation of nonlinear elasticity where stresses,
strains, and coordinates refer to the original geometry.

The Lagrangian formulation of the equilibrium equations can be written

ρü− ∇ ⋅ (F ⋅ S) = f

where ρ is the material density, u is the displacement vector, F is the deformation
gradient, S is the second Piola-Kirchoff stress tensor, and f  is the body force vector. This
equation can also be written in the following tensor form:

ρüi−
∂
∂x j

∂ui
∂xk

+ δik Sk j = f i

Although large deflections are accounted for in this formulation, it is assumed that the
strains remain small so that linear elastic constitutive relations apply. Also, the material is
assumed to be isotropic. For the 2D plane stress case, the constitutive relations may be
written in matrix form:
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S11
S22
S12

=
C11 C12
C12 C22

2G12

E11
E22
E12

where Ei j is the Green-Lagrange strain tensor defined as

Ei j = 1
2
∂ui
∂x j

+
∂u j
∂xi

+
∂uk
∂xi

∂uk
∂x j

For an isotropic material

C11 = C22 = E
1 − ν2

C12 = Eν
1 − ν2

G12 = E
2(1 + ν)

where E is Young's modulus and ν is Poisson's ratio.

Readers who are interested in more details about the Lagrangian formulation for
nonlinear elasticity can consult, for example, reference 1.

The equations presented above completely define the geometrically nonlinear plane stress
problem. The work required to convert them to a form acceptable to PDE Toolbox is
considerably simplified by using the MATLAB Symbolic Math Toolbox. Symbolic Math
Toolbox can perform the necessary algebraic manipulations and output a MATLAB
function defining the c-coefficient that can be passed to PDE Toolbox functions. This
function, cCoefficientLagrangePlaneStress, is shown in the appendix below.

Problem Setup

Create the PDE model.

N = 2; % Two PDE in plane stress elasticity
model = createpde(N);

Define the geometry. First, specify the length and thickness of the beam,
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blength = 5; % Beam length, in.
height = .1; % Thickness of the beam, in.

A drawing of the clamped beam is shown in the figure below.

Since the beam geometry and loading are symmetric about the beam center(x =
blength/2), the model can be simplified by considering only the right-half of the beam.

l2 = blength/2;
h2 = height/2;

Create the edges of the rectangle representing the beam with these two statements.

rect = [3 4 0 l2 l2 0 -h2 -h2  h2 h2]';
g = decsg(rect,'R1',('R1')');

The geometryFromEdges function creates a geometry object from the edges and stores
it within the model.

pg = geometryFromEdges(model,g);

Plot the geometry and display the edge labels. The edge labels are needed for edge
identification when applying boundary conditions.

figure
pdegplot(g,'EdgeLabels','on');
title('Geometry With Edge Labels Displayed');

Scale the plot so the labels are viewable.
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axis([-.1 1.1*l2 -5*h2 5*h2]);

Derive the equation coefficients using the material properties. For the linear case, the c-
coefficient matrix is constant.

E = 3.0e7; % Young's modulus of the material, lbs/in^2
gnu = .3; % Poisson's ratio of the material
rho = .3/386; % Density of the material
G = E/(2.*(1+gnu));
mu = 2*G*gnu/(1-gnu);
c = [2*G+mu; 0; G;   0; G; mu; 0;  G; 0; 2*G+mu];
f = [0 0]'; % No body forces
specifyCoefficients(model, 'm', rho, 'd', 0, 'c', c, 'a', 0, 'f', f);
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Apply the boundary conditions. Symmetry condition is x-displacement equal zero at left
edge.

symBC = applyBoundaryCondition(model,'mixed','Edge',4,'u',0,'EquationIndex',1);

x- and y-displacements equal zero along right edge.

clampedBC = applyBoundaryCondition(model,'dirichlet','Edge',2,'u',[0 0]);

Apply a constant vertical stress along the top edge.

sigma = 2e2;
presBC = applyBoundaryCondition(model,'neumann','Edge',3,'g',[0 sigma]);

Set the zero initial displacements and velocities.

setInitialConditions(model,0,0);

Generate a mesh with approximately eight elements through the thickness of the beam.

generateMesh(model,'Hmax',height/8,'MesherVersion','R2013a');

Linear Solution

Set up the analysis timespan. Here, tfinal is the final time in the analysis.

tfinal = 3e-3;
tlist = linspace(0,tfinal,100);

Compute the time-dependent solution.

result = solvepde(model,tlist);

Interpolate the solution at the geometry center for the y-component (component 2) at all
times.

xc = 1.25;
yc = 0;
u4Linear = interpolateSolution(result,xc,yc,2,1:length(tlist));

Nonlinear Solution

Specify the coefficients for the nonlinear case. The
cCoefficientLagrangePlaneStress function takes the isotropic material properties
and location and state structures, and returns a c-matrix for a nonlinear plane-stress
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analysis. Small strains are assumed; i.e. E and ν are independent of the solution. PDE
Toolbox calls user-defined coefficient functions with the arguments location and state. The
function cCoefficientLagrangePlaneStress expects the arguments E, gnu, location,
state. c is defined below as an anonymous function to provide an interface between these
two function signatures. (The function cCoefficientLagrangePlaneStress can be
used with any geometric nonlinear plane stress analysis of a model made from an
isotropic material.)

c  = @(location, state) cCoefficientLagrangePlaneStress(E,gnu,location,state);

specifyCoefficients(model, 'm', rho, 'd', 0, 'c', c, 'a', 0 , 'f', f);

Compute the time-dependent solution.

result = solvepde(model,tlist);

As before, interpolate the solution at the geometry center for the y-component
(component 2) at all times.

u4NonLinear = interpolateSolution(result,xc,yc,2,1:length(tlist));

Plot Solutions

The figure below shows the y-deflection at the center of the beam as a function of time.
The nonlinear analysis computes displacements that are substantially less than the linear
analysis. This "stress stiffening" effect is also reflected in the higher oscillation frequency
from the nonlinear analysis.

figure
plot(tlist,u4Linear(:),tlist,u4NonLinear(:));
legend('Linear','Nonlinear');
title 'Deflection at Beam Center'
xlabel 'Time, seconds'
ylabel 'Deflection, inches'
grid on
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Appendix - Nonlinear C-Coefficient Function

The function cCoefficientLagrangePlaneStress calculates the c-coefficient matrix
for a large displacement Lagrangian plane stress formulation.

type cCoefficientLagrangePlaneStress

function c = cCoefficientLagrangePlaneStress(E, nu, loc, state)
%cCoefficientLagrangePlaneStress Calculate c-coefficient for nonlinear plane stress
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% Calculate the c-coefficient for a geometrically nonlinear Lagrangian formulation 
% of plane stress elasticity. The strain measure is the Green-Lagrange strain
% tensor. The stress is the second Piola-Kirchoff stress tensor. The material
% is assumed to be isotropic with linear behavior (Hooke's law applies).
% 
% E  - Young's modulus of the linear isotropic material
% nu - Poisson's ratio for the material
% p  - matrix of point (node) locations
% t  - element connectivity matrix
% u  - current displacement vector

%    This function was generated by the Symbolic Math Toolbox version 6.0.
%    31-Jan-2014 09:50:09

% Copyright 2014-2015 The MathWorks, Inc.

ux = reshape(state.ux,2,[]);
uy = reshape(state.uy,2,[]);

dudx=ux(1,:); 
dvdx=ux(2,:);
dudy=uy(1,:);  
dvdy=uy(2,:);
 
% if(~isempty(u))
%   [ux,uy] = pdegrad(p,t,u);
%   dudx=ux(1,:); dudy=uy(1,:); dvdx=ux(2,:); dvdy=uy(2,:);
% else
%   dudx = zeros(1, size(t,2)); dudy=dudx; dvdx=dudx; dvdy=dudx;
% end

t4 = 1/(nu^2-1);
t6 = 1/(1+nu);
t7 = E*dudy.*t4*.25;
t8 = dudx+1.0;
t9 = E*dudy.*t4.*t8*.25;
t10 = dvdy+1.0;
t11 = t7+t9-E*dvdx.*t6.*t10*.25;
t12 = dvdy.*2.0;
t13 = dudx.^2;
t14 = dudy.^2;
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t15 = dvdy.^2;
t16 = dvdx.^2;
t17 = E*dvdx.*t4.*(1.0./2.0);
t18 = E*dudx.*dvdx.*t4*.25;
t19 = t17+t18-E*dudy.*t6*.25-E*dudy.*dvdy.*t6.*(1.0./8.0);
t20 = E*dudy.*dvdx.*nu.*t4*.25;
t21 = t20-E*t6.*(1.0./2.0)-E*dudx.*t6*.25-E*dvdy.*t6*.25-E*dudx.*dvdy.*t6.*(1.0./8.0);
t22 = dudx.*2.0;
t23 = dvdy+2.0;
t24 = nu-1.0;
t25 = E*nu.*t4;
t26 = E*dudx.*nu.*t4.*(1.0./2.0);
t27 = E*dvdy.*nu.*t4.*(1.0./2.0);
t28 = E*dudx.*dvdy.*nu.*t4*.25;
t29 = t25+t26+t27+t28-E*dudy.*dvdx.*t6.*(1.0./8.0);
t30 = E*dudy.*t4.*t23.*(1.0./8.0);
t31 = E*dudy.*dvdy.*t4.*(1.0./8.0);
t32 = t7+t30+t31-E*dvdx.*t6.*(1.0./8.0)-E*dvdx.*t4.*t8.*t24.*(1.0./8.0);
t33 = dudy.*2.0;
t34 = dvdx.*2.0;
t35 = dudx.*dudy.*2.0;
t36 = dvdx.*dvdy;
t37 = t33+t34+t35+t36;
t38 = 1.0./t24;
t39 = E*dvdx.*t23.*t38.*(1.0./8.0);
t40 = t39-E*t6.*t37.*(1.0./8.0);
out1 = [E*t4.*(dudx.*6.0+t13.*2.0+t14+t16+4.0)*.25+E*nu.*t4.*(t12+t15)*.25;
  t11;
  t19;
  t29;
  t11;
  E*t4.*(t12+t13+t14.*2.0+t15+t22+2.0)*.25+E*nu.*t4.*(t16-2.0)*.25;
  t21;
  t32;
  t19;
  t21;
  E*t4.*(t12+t13+t15+t16.*2.0+t22+2.0)*.25+E*nu.*t4.*(t14-2.0)*.25;
  t40;
  t29;
  t32;
  t40;
  E*t4.*(dvdy.*6.0+t14+t15.*2.0+t16+4.0)*.25+E*nu.*t4.*(t13+t22)*.25];

c = -out1([1 5 6 9 10 13 14 11 15 16], :);
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end
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Finite Element Analysis of Electrostatically Actuated
MEMS Device

This example shows a simple approach to the coupled electromechanical finite element
analysis of an electrostatically actuated micro-electromechanical (MEMS) device. For
simplicity, this example uses the relaxation-based algorithm rather than the Newton
method to couple the electrostatic and the mechanical domains.

MEMS Devices

MEMS devices typically consist of movable thin beams or electrodes with a high aspect
ratio that are suspended over a fixed electrode.

Actuation, switching, and other signal and information processing functions can use the
electrode deformation caused by the application of voltage between the movable and
fixed electrodes. FEM provides a convenient tool for characterizing the inner workings of
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MEMS devices, and can predict temperatures, stresses, dynamic response
characteristics, and possible failure mechanisms. One of the most common MEMS
switches is the series of cantilever beams suspended over a ground electrode.

This example uses the following geometry to model a MEMS switch. The top electrode is
150 μm in length and 2 μm in thickness. The Young’s modulus E is 170 GPa, and the
Poisson ratio υ is 0.34. The bottom electrode is 50 μm in length and 2 μm in thickness,
and is located 100 μm from the leftmost end of the top electrode. The gap between the
top and bottom electrodes is 2 μm.
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A voltage applied between the top electrode and the ground plane induces electrostatic
charges on the surface of the conductors which, in turn, leads to electrostatic forces
acting normal to the surface of the conductors. Because the ground plane is fixed, the
electrostatic forces deform only the top electrode. When the beam deforms, the charge
redistributes on the surface of the conductors. The resultant electrostatic forces and the
deformation of the beam also change. This process continues until the system reaches a
state of equilibrium.

Approach for Coupled Electromechanical Analysis

For simplicity, this example uses the relaxation-based algorithm rather than the Newton
method to couple the electrostatic and the mechanical domains. The example follows
these steps:

1. Solve the electrostatic FEA problem in the nondeformed geometry with the constant
potential V0 on the movable electrode.

2. Compute the load and boundary conditions for the mechanical solution by using the
calculated values of the charge density along the movable electrode. The electrostatic
pressure on the movable electrode is given by

P = 1
2ϵ D

2
,
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where D  is the magnitude of the electric flux density and ϵ is the electric permittivity
next to the movable electrode.

3. Compute the deformation of the movable electrode by solving the mechanical FEA
problem.

4. Update the charge density along the movable electrode by using the calculated
displacement of the movable electrode,

Ddef x ≈ D0 x G
G− v(x) ,

where Ddef x  is the magnitude of the electric flux density in the deformed electrode,
D0 x  is the magnitude of the electric flux density in the undeformed electrode, G is the

distance between the movable and fixed electrodes in the absence of actuation, and v x is
the displacement of the movable electrode at position x along its axis.

5. Repeat steps 2–4 until the electrode deformation values in the last two iterations
converge.

Electrostatic Analysis

In the electrostatic analysis part of this example, you compute the electric potential
around the electrodes.

First, create the cantilever switch geometry by using the constructive solid geometry
(CSG) modeling approach. The geometry for electrostatic analysis consists of three
rectangles represented by a matrix. Each column of the matrix describes a basic shape.

rect_domain = [3,4,1.75e-4,1.75e-4,-1.75e-4,-1.75e-4,-1.7e-5,1.3e-5,1.3e-5,-1.7e-5]';
rect_movable = [3,4,7.5e-5,7.5e-5,-7.5e-5,-7.5e-5,2.0e-6,4.0e-6,4.0e-6,2.0e-6]';
rect_fixed = [3,4,7.5e-5,7.5e-5,2.5e-5,2.5e-5,-2.0e-6,0,0,-2.0e-6]';
gd = [rect_domain,rect_movable,rect_fixed];

Create a name for each basic shape. Specify the names as a matrix whose columns
contain the names of the corresponding columns in the basic shape matrix.

ns = char('rect_domain','rect_movable','rect_fixed');
ns = ns';

Create a formula describing the unions and intersections of basic shapes.

sf = 'rect_domain-(rect_movable+rect_fixed)';
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Create the geometry by using the decsg function.

dl = decsg(gd,sf,ns);

Create a PDE model and include the geometry in the model.

model = createpde;
geometryFromEdges(model,dl);

Plot the geometry.

pdegplot(model,'EdgeLabels','on','FaceLabels','on')
xlabel('x-coordinate, meters')
ylabel('y-coordinate, meters')
axis([-2e-4, 2e-4,-4e-5, 4e-5])
axis square
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The edge numbers in this geometry are as follows:

• Movable electrode: E3, E7, E11, E12
• Fixed electrode: E4, E8, E9, E10
• Domain boundary: E1, E2, E5, E6

Set constant potential values of 20 V to the movable electrode and 0 V to the fixed
electrode and domain boundary.

V0 = 0;
V1 = 20;
applyBoundaryCondition(model,'dirichlet','Edge',[4,8,9,10],'u',V0);
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applyBoundaryCondition(model,'dirichlet','Edge',[1,2,5,6],'u',V0);
applyBoundaryCondition(model,'dirichlet','Edge',[3,7,11,12],'u',V1);

The PDE governing this problem is the Poisson equation,

−∇ ⋅ (ϵ∇V) = ρ,

where ϵ is the coefficient of permittivity and ρ is the charge density. The coefficient of
permittivity does not affect the result in this example as long as the coefficient is
constant. Assuming that there is no charge in the domain, you can simplify the Poisson
equation to the Laplace equation,

ΔV = 0.

Specify the coefficients.

specifyCoefficients(model,'m',0,'d',0,'c',1,'a',0,'f',0);

Generate a relatively fine mesh.

hmax = 5e-6;
generateMesh(model,'Hmax',hmax);
pdeplot(model)
xlabel('x-coordinate, meters')
ylabel('y-coordinate, meters')
axis([-2e-4, 2e-4,-4e-5, 4e-5])
axis square
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Solve the model.

results = solvepde(model);

Plot the electric potential in the exterior domain.

u = results.NodalSolution;
figure
pdeplot(model,'XYData',results.NodalSolution,...
              'ColorMap','jet');

title('Electric Potential');
xlabel('x-coordinate, meters')
ylabel('y-coordinate, meters')
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axis([-2e-4, 2e-4,-4e-5, 4e-5])
axis square

Mechanical Analysis

In the mechanical analysis part of this example, you compute the deformation of the
movable electrode.

Create a structural model.

structuralmodel = createpde('structural','static-planestress');

Create the movable electrode geometry and include it in the model. Plot the geometry.
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dl = decsg(rect_movable);
geometryFromEdges(structuralmodel,dl);
pdegplot(structuralmodel,'EdgeLabels','on')
xlabel('x-coordinate, meters')
ylabel('y-coordinate, meters')
axis([-1e-4, 1e-4,-1e-5, 1e-5])
axis square

Specify the structural properties: the Young's modulus E is 170 GPa and the Poisson ratio
ν is 0.34.

structuralProperties(structuralmodel,'YoungsModulus',170e9, ...
                                     'PoissonsRatio',0.34);
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Specify the pressure as a boundary load on the edges. The pressure tends to draw the
conductor into the field regardless of the sign of the surface charge. For the definition of
the CalculateElectrostaticPressure function, see the Electrostatic Pressure
Function section at the bottom of this page.

pressureFcn = @(location,state) - ...
                CalculateElectrostaticPressure(results,[],location);
structuralBoundaryLoad(structuralmodel,'Edge',[1,2,4], ...
                                       'Pressure',pressureFcn, ...
                                       'Vectorized','on');

Specify that the movable electrode is fixed at edge 3.

structuralBC(structuralmodel,'Edge',3,'Constraint','fixed');

Generate a mesh.

hmax = 1e-6;
generateMesh(structuralmodel,'Hmax',hmax);
pdeplot(structuralmodel);
xlabel('x-coordinate, meters')
ylabel('y-coordinate, meters')
axis([-1e-4, 1e-4,-1e-5, 1e-5])
axis square
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Solve the equations.

R = solve(structuralmodel);

Plot the displacement for the movable electrode.

pdeplot(structuralmodel,'XYData',R.VonMisesStress, ...
                        'Deformation',R.Displacement, ...
                        'DeformationScaleFactor',10, ...
                        'ColorMap','jet');

title('von Mises Stress in Deflected Electrode')
xlabel('x-coordinate, meters')
ylabel('y-coordinate, meters')
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axis([-1e-4, 1e-4,-1e-5, 1e-5])
axis square

Find the maximal displacement.

maxdisp = max(abs(R.Displacement.uy));
fprintf('Finite element maximal tip deflection is: %12.4e\n', maxdisp);

Finite element maximal tip deflection is:   1.5632e-07

Repeatedly update the charge density along the movable electrode and solve the model
until the electrode deformation values converge.

olddisp = 0;
while abs((maxdisp-olddisp)/maxdisp) > 1e-10
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% Impose boundary conditions
    pressureFcn = @(location,state) - ...
                    CalculateElectrostaticPressure(results, R, location);
    bl = structuralBoundaryLoad(structuralmodel,'Edge',[1,2,4], ...
                                                'Pressure',pressureFcn, ...
                                                'Vectorized','on');
% Solve the equations
    R = solve(structuralmodel);
    olddisp = maxdisp;
    maxdisp = max(abs(R.Displacement.uy));
    delete(bl)
end

Plot the displacement.

pdeplot(structuralmodel,'XYData',R.VonMisesStress, ...
                        'Deformation',R.Displacement, ...
                        'DeformationScaleFactor',10, ...
                        'ColorMap','jet');

title('von Mises Stress in Deflected Electrode')
xlabel('x-coordinate, meters')
ylabel('y-coordinate, meters')
axis([-1e-4, 1e-4,-1e-5, 1e-5])
axis square
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Find the maximal displacement.

maxdisp = max(abs(R.Displacement.uy));
fprintf('Finite element maximal tip deflection is: %12.4e\n', maxdisp);

Finite element maximal tip deflection is:   1.8164e-07
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Electrostatic Pressure Function

The electrostatic pressure on the movable electrode is given by

P = 1
2ϵ D

2
,

where D = ϵ E  is the magnitude of the electric flux density, ϵ is the electric permittivity
next to the movable electrode, and E  is the magnitude of the electric field. The electric
field E is the gradient of the electric potential V:

E = − ∇V.

Solve the mechanical FEA to compute the deformation of the movable electrode. Using
the calculated displacement of the movable electrode, update the charge density along
the movable electrode.

Ddef x ≈ D0 x G
G− v(x) ,

where Ddef x  is the magnitude of the electric flux density in the deformed electrode,
D0 x  is the magnitude of the electric flux density in the undeformed electrode, G is the

distance between the movable and fixed electrodes in the absence of actuation, and v x is
the displacement of the movable electrode at position x along its axis. Initially, the
movable electrode is undeformed, v x = 0, and therefore, Ddef x ≈ D0 x .

function ePressure = ...
    CalculateElectrostaticPressure(elecResults,structResults,location)
% Function to compute electrostatic pressure.
% structuralBoundaryLoad is used to specify the pressure load
% on the movable electrode.
% Inputs:
% elecResults: Electrostatic FEA results
% structResults: Mechanical FEA results (optional)
% location: The x,y coordinate where pressure is obtained
%
% Output:
% ePressure: Electrostatic pressure at location
%
% location.x : The x-coordinate of the points
% location.y : The y-coordinate of the points
xq = location.x;
yq = location.y;
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% Compute the magnitude of the electric field from the potential
% difference.
[gradx,grady] = evaluateGradient(elecResults,xq,yq);
absE = sqrt(gradx.^2 + grady.^2);

% The permittivity of vacuum is 8.854*10^-12 farad/meter.
epsilon0 = 8.854e-12;

% Compute the magnitude of the electric flux density.
absD0 = epsilon0*absE;
absD = absD0;

% If structResults (deformation) is available,
% update the charge density along the movable electrode.
if ~isempty(structResults)
    % Displacement of the movable electrode at position x
    intrpDisp = interpolateDisplacement(structResults,xq,yq);
    vdisp = abs(intrpDisp.uy);
    G = 2e-6; % Gap 2 micron
    absD = absD0.*G./(G-vdisp);
end

% Compute the electrostatic pressure.
ePressure = absD.^2/(2*epsilon0);

end
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Deflection Analysis of Bracket
This example shows how to analyze a 3-D mechanical part under an applied load using
finite element analysis (FEA) and determine the maximal deflection.

Create a Structural Analysis Model

The first step in solving a linear elasticity problem is to create a structural analysis model.
This is a container that holds the geometry, structural material properties, body and
boundary loads, boundary constraints, and mesh.

model = createpde('structural','static-solid');

Import the Geometry

Import an STL file of a simple bracket model using the importGeometry function. This
function reconstructs the faces, edges and vertices of the model. It can merge some faces
and edges, so the numbers can differ from those of the parent CAD model.

importGeometry(model,'BracketWithHole.stl');

Plot the geometry and turn on face labels. You will need the face labels to define the
boundary conditions.

figure
pdegplot(model,'FaceLabels','on')
view(30,30);
title('Bracket with Face Labels')
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figure
pdegplot(model,'FaceLabels','on')
view(-134,-32)
title('Bracket with Face Labels, Rear View')
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Specify Structural Properties of the Material

Specify Young's modulus and Poisson's ratio for this material.

structuralProperties(model,'Cell',1,'YoungsModulus',200e9, ...
                                    'PoissonsRatio',0.3);

Define the Boundary Conditions

The problem has two boundary conditions: the back face (face 4) is immobile and the
front face has an applied load. All other boundary conditions, by default, are free
boundaries.

structuralBC(model,'Face',4,'Constraint','fixed');
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Apply a distributed load in the negative z-direction to the front face (face 8).

distributedLoad = 1e4; % Applied load in Pascals
structuralBoundaryLoad (model,'Face',8,'SurfaceTraction',[0;0;-distributedLoad]);

Create a Mesh

Create a mesh that uses 10-node tetrahedral elements with quadratic interpolation
functions. This element type is significantly more accurate than the linear interpolation
(four-node) elements, particularly in elasticity analyses that involve bending.

bracketThickness = 1e-2; % Thickness of horizontal plate with hole, meters
generateMesh(model,'Hmax',bracketThickness);
figure
pdeplot3D(model)
title('Mesh with Quadratic Tetrahedral Elements');
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Calculate the Solution

Use solve to calculate the solution.

result = solve(model);

Examine the Solution

Find the maximal deflection of the bracket in the z direction.

minUz = min(result.Displacement.uz);
fprintf('Maximal deflection in the z-direction is %g meters.', minUz)

Maximal deflection in the z-direction is -4.48952e-05 meters.
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Plot Components of the Displacement

To see the solution, plot the components of the solution vector. The maximal deflections
are in the z-direction. Because the part and the loading are symmetric, the x-
displacement and z-displacement are symmetric, and the y-displacement is antisymmetric
with respect to the center line.

Here, the plotting routine uses the 'jet' colormap, which has blue as the color
representing the lowest value and red representing the highest value. The bracket
loading causes face 8 to dip down, so the maximum z-displacement appears blue.

figure
pdeplot3D(model,'ColorMapData',result.Displacement.ux)
title('x-displacement')
colormap('jet')
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figure
pdeplot3D(model,'ColorMapData',result.Displacement.uy)
title('y-displacement')
colormap('jet')
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figure
pdeplot3D(model,'ColorMapData',result.Displacement.uz)
title('z-displacement')
colormap('jet')
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Plot von Mises Stress

Plot values of the von Mises Stress at nodal locations. Use the same jet colormap.

figure
pdeplot3D(model,'ColorMapData',result.VonMisesStress)
title('von Mises stress')
colormap('jet')
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Vibration of Square Plate
This example shows how to calculate the vibration modes and frequencies of a 3-D simply
supported, square, elastic plate.

The dimensions and material properties of the plate are taken from a standard finite
element benchmark problem published by NAFEMS, FV52 (See Reference).

First, create a structural model container for your 3-D modal analysis problem. This is a
container that holds the geometry, properties of the material, body loads, boundary loads,
boundary constraints, and mesh.

model = createpde('structural','modal-solid');

Import an STL file of a simple plate model using the importGeometry function. This
function reconstructs the faces, edges, and vertices of the model. It can merge some faces
and edges, so the numbers can differ from those of the parent CAD model.

importGeometry(model,'Plate10x10x1.stl');

Plot the geometry and turn on face labels. You need the face labels when defining the
boundary conditions.

figure
hc = pdegplot(model,'FaceLabels','on');
hc(1).FaceAlpha = 0.5;
title('Plate with Face Labels')
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Define the elastic modulus of steel, Poisson's ratio, and the material density.

structuralProperties(model,'YoungsModulus',200e9, ...
                           'PoissonsRatio',0.3, ...
                           'MassDensity',8000);

In this example, the only boundary condition is the zero z-displacement on the four edge
faces. These edge faces have labels 1 through 4.

structuralBC(model,'Face',1:4,'ZDisplacement',0);

Create and plot a mesh. Specify the target minimum edge length so that there is one row
of elements per plate thickness.
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generateMesh(model,'Hmin',1.3);
figure 
pdeplot3D(model);
title('Mesh with Quadratic Tetrahedral Elements');

For comparison with the published values, load the reference frequencies in Hz.

refFreqHz = [0 0 0 45.897 109.44 109.44 167.89 193.59 206.19 206.19];

Solve the problem for the specified frequency range. Define the upper limit as slightly
larger than the highest reference frequency and the lower limit as slightly smaller than
the lowest reference frequency.

maxFreq = 1.1*refFreqHz(end)*2*pi;
result = solve(model,'FrequencyRange',[-0.1 maxFreq]);
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Calculate frequencies in Hz.

freqHz = result.NaturalFrequencies/(2*pi);

Compare the reference and computed frequencies (in Hz) for the lowest 10 modes. The
lowest three mode shapes correspond to rigid-body motion of the plate. Their frequencies
are close to zero.

tfreqHz = table(refFreqHz.',freqHz(1:10));
tfreqHz.Properties.VariableNames = {'Reference','Computed'};
disp(tfreqHz);

    Reference     Computed 
    _________    __________

          0      7.8693e-06
          0      1.0498e-05
          0      1.2203e-05
     45.897          44.871
     109.44          109.74
     109.44          109.77
     167.89          168.59
     193.59          193.74
     206.19          207.51
     206.19          207.52

You see good agreement between the computed and published frequencies.

Plot the third component (z-component) of the solution for the seven lowest nonzero-
frequency modes.

h = figure;
h.Position = [100,100,900,600];
numToPrint = min(length(freqHz),length(refFreqHz));
for i = 4:numToPrint
    subplot(4,2,i-3);
    pdeplot3D(model,'ColorMapData',result.ModeShapes.uz(:,i));
    axis equal
    title(sprintf(['Mode=%d, z-displacement\n', ...
    'Frequency(Hz): Ref=%g FEM=%g'], ...
    i,refFreqHz(i),freqHz(i)));
end
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Structural Dynamics of Tuning Fork
Perform modal and transient analysis of a tuning fork.

A tuning fork is a U-shaped beam. When struck on one of its prongs or tines, it vibrates at
its fundamental (first) frequency and produces an audible sound.

The first flexible mode of a tuning fork is characterized by symmetric vibration of the
tines: they move towards and away from each other simultaneously, balancing the forces
at the base where they intersect. The fundamental mode of vibration does not produce
any bending effect on the handle attached at the intersection of tines. The lack of bending
at the base enables easy handling of tuning fork without influencing its dynamics.

Transverse vibration of the tines causes the handle to vibrate axially at the fundamental
frequency. This axial vibration can be used to amplify the audible sound by bringing the
end of the handle in contact with a larger surface area, like a metal table top. The next
higher mode with symmetric mode shape is about 6.25 times the fundamental frequency.
Therefore, a properly excited tuning fork tends to vibrate with a dominant frequency
corresponding to fundamental frequency, producing a pure audible tone. This example
simulates these aspects of the tuning fork dynamics by performing a modal analysis and a
transient dynamics simulation.

You can find the helper functions animateSixTuningForkModes and tuningForkFFT
and the geometry file TuningFork.stl under matlab/R20XXx/examples/pde/main.

Modal Analysis of Tuning Fork

Find natural frequencies and mode shapes for the fundamental mode of a tuning fork and
the next several modes. Show the lack of bending effect on the fork handle at the
fundamental frequency.

First, create a structural model for modal analysis of a solid tuning fork.

model = createpde('structural','modal-solid');

To perform unconstrained modal analysis of a structure, it is enough to specify geometry,
mesh, and material properties. First, import and plot the tuning fork geometry.

importGeometry(model,'TuningFork.stl');
figure
pdegplot(model)
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Specify the Young's modulus, Poisson's ratio, and mass density to model linear elastic
material behavior. Specify all physical properties in consistent units.

E = 210E9;
nu = 0.3;
rho = 8000;
structuralProperties(model,'YoungsModulus',E, ...
                           'PoissonsRatio',nu, ...
                           'MassDensity',rho);

Generate a mesh.

generateMesh(model,'Hmax',0.001);
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Solve the model for a chosen frequency range. Specify the lower frequency limit below
zero so that all modes with frequencies near zero appear in the solution.

RF = solve(model,'FrequencyRange',[-1,4000]*2*pi);

By default, the solver returns circular frequencies.

modeID = 1:numel(RF.NaturalFrequencies);

Express the resulting frequencies in Hz by dividing them by 2π. Display the frequencies in
a table.

tmodalResults = table(modeID.',RF.NaturalFrequencies/2/pi);
tmodalResults.Properties.VariableNames = {'Mode','Frequency'};
disp(tmodalResults);

    Mode    Frequency
    ____    _________

      1     0.0043502
      2     0.0057641
      3     0.0060113
      4     0.0063511
      5     0.0064692
      6     0.0080954
      7        460.42
      8        706.34
      9        1911.5
     10        2105.5
     11        2906.5
     12        3814.7

Because there are no boundary constraints in this example, modal results include the
rigid body modes. The first six near-zero frequencies indicate the six rigid body modes of
a 3-D solid body. The first flexible mode is the seventh mode with a frequency around 460
Hz.

The best way to visualize mode shapes is to animate the harmonic motion at their
respective frequencies. The animateSixTuningForkModes function animates the six
flexible modes, which are modes 7 through 12 in the modal results RF.

frames  = animateSixTuningForkModes(RF);
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To play the animation, use the following command:

movie(figure('units','normalized','outerposition',[0 0 1
1]),frames,5,30)

In the first mode, two oscillating tines of the tuning fork balance out transverse forces at
the handle. The next mode with this effect is the fifth flexible mode with the frequency
2906.5 Hz. This frequency is about 6.25 times greater than the fundamental frequency
460 Hz.

Transient Analysis of Tuning Fork

Simulate the dynamics of a tuning fork being gently and quickly struck on one of its tines.
Analyze vibration of tines over time and axial vibration of the handle.

First, create a structural transient analysis model.
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tmodel = createpde('structural','transient-solid');

Import the same tuning fork geometry you used for the modal analysis.

importGeometry(tmodel,'TuningFork.stl');

Generate a mesh.

mesh = generateMesh(tmodel,'Hmax',0.005);

Specify the Young's modulus, Poisson's ratio, and mass density.

structuralProperties(tmodel,'YoungsModulus',E, ...
                            'PoissonsRatio',nu, ...
                            'MassDensity',rho);

Identify faces for applying boundary constraints and loads by plotting the geometry with
the face labels.

figure('units','normalized','outerposition',[0 0 1 1])
pdegplot(tmodel,'FaceLabels','on')
view(-50,15)
title 'Geometry with Face Labels'
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Impose sufficient boundary constraints to prevent rigid body motion under applied
loading. Typically, you hold a tuning fork by hand or mount it on a table. A simplified
approximation to this boundary condition is fixing a region near the intersection of tines
and the handle (faces 21 and 22).

structuralBC(tmodel,'Face',[21,22],'Constraint','fixed');

Approximate an impulse loading on a face of a tine by applying a pressure load for a very
small fraction of the time period of the fundamental mode. By using this very short
pressure pulse, you ensure that only the fundamental mode of a tuning fork is excited. To
evaluate the time period T of the fundamental mode, use the results of modal analysis.

T = 2*pi/RF.NaturalFrequencies(7);

Specify the pressure loading on a tine as a short rectangular pressure pulse.

structuralBoundaryLoad(tmodel,'Face',11,'Pressure',5E6,'EndTime',T/300);

 Structural Dynamics of Tuning Fork

3-85



Apply zero displacement and velocity as initial conditions.

structuralIC(tmodel,'Displacement',[0;0;0],'Velocity',[0;0;0]);

Solve the transient model for 50 periods of the fundamental mode. Sample the dynamics
60 times per period of the fundamental mode.

ncycle = 50;
samplingFrequency = 60/T;
tlist = linspace(0,ncycle*T,ncycle*T*samplingFrequency);
R = solve(tmodel,tlist)

R = 
  TransientStructuralResults with properties:

     Displacement: [1×1 struct]
         Velocity: [1×1 struct]
     Acceleration: [1×1 struct]
    SolutionTimes: [1×3000 double]
             Mesh: [1×1 FEMesh]

Plot the time-series of the vibration of the tine tip, which is face 12. Find nodes on the tip
face and plot the y-component of the displacement over time, using one of these nodes.

excitedTineTipNodes = findNodes(mesh,'region','Face',12);
tipDisp = R.Displacement.uy(excitedTineTipNodes(1),:);

figure
plot(R.SolutionTimes,tipDisp)
title('Transverse Displacement at Tine Tip')
xlim([0,0.1])
xlabel('Time')
ylabel('Y-Displacement')
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Perform fast Fourier transform (FFT) on the tip displacement time-series to see that the
vibration frequency of the tuning fork is close to its fundamental frequency. A small
deviation from the fundamental frequency computed in an unconstrained modal analysis
appears because of constraints imposed in the transient analysis.

[fTip,PTip] = tuningForkFFT(tipDisp,samplingFrequency);
figure
plot(fTip,PTip) 
title({'Single-sided Amplitude Spectrum', 'of Tip Vibration'})
xlabel('f (Hz)')
ylabel('|P1(f)|')
xlim([0,4000])
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Transverse vibration of tines causes the handle to vibrate axially with the same frequency.
To observe this vibration, plot the axial displacement time-series of the end face of the
handle.

baseNodes = tmodel.Mesh.findNodes('region','Face',6);
baseDisp = R.Displacement.ux(baseNodes(1),:);
figure
plot(R.SolutionTimes,baseDisp)
title('Axial Displacement at the End of Handle')
xlim([0,0.1])
ylabel('X-Displacement')
xlabel('Time')
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Perform an FFT of the time-series of the axial vibration of the handle. This vibration
frequency is also close to its fundamental frequency.

[fBase,PBase] = tuningForkFFT(baseDisp,samplingFrequency);
figure
plot(fBase,PBase) 
title({'Single-sided Amplitude Spectrum', 'of Base Vibration'})
xlabel('f (Hz)')
ylabel('|P1(f)|')
xlim([0,4000])

 Structural Dynamics of Tuning Fork

3-89



3 Solving PDEs

3-90



Modal Superposition Method for Structural Dynamics
Problem

This example shows how to solve a structural dynamics problem by using modal analysis
results. Solve for the transient response at the center of a 3-D beam under a harmonic
load on one of its corners. Compare the direct integration results with the results
obtained by modal superposition.

Modal Analysis

Create a modal analysis model for a 3-D problem.

modelM = createpde('structural','modal-solid');

Create the geometry and include it in the model. Plot the geometry and display the edge
and vertex labels.

gm = multicuboid(0.05,0.003,0.003);
modelM.Geometry=gm;
pdegplot(modelM,'EdgeLabels','on','VertexLabels','on');
view([95 5])
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Generate a mesh.

msh = generateMesh(modelM);

Specify the Young's modulus, Poisson's ratio, and mass density of the material.

structuralProperties(modelM,'YoungsModulus',210E9, ...
                            'PoissonsRatio',0.3, ...
                            'MassDensity',7800);

Specify minimal constraints on one end of the beam to prevent rigid body modes. For
example, specify that edge 4 and vertex 7 are fixed boundaries.

structuralBC(modelM,'Edge',4,'Constraint','fixed');
structuralBC(modelM,'Vertex',7,'Constraint','fixed');
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Solve the problem for the frequency range from 0 to 500000. The recommended approach
is to use a value that is slightly smaller than the expected lowest frequency. Thus, use -0.1
instead of 0.

Rm = solve(modelM,'FrequencyRange',[-0.1,500000]);

Transient Analysis

Create a transient analysis model for a 3-D problem.

modelD = createpde('structural','transient-solid');

Use the same geometry and mesh as for the modal analysis.

modelD.Geometry = gm;
modelD.Mesh = msh;

Specify the same values for the Young's modulus, Poisson's ratio, and mass density of the
material.

structuralProperties(modelD,'YoungsModulus',210E9, ...
                            'PoissonsRatio',0.3, ...
                            'MassDensity',7800);

Specify the same minimal constraints on one end of the beam to prevent rigid body
modes.

structuralBC(modelD,'Edge',4,'Constraint','fixed');
structuralBC(modelD,'Vertex',7,'Constraint','fixed');

Apply a sinusoidal force on the corner opposite the constrained edge and vertex.

structuralBoundaryLoad(modelD,'Vertex',5,'Force',[0,0,10],'Frequency',7600);

Specify the zero initial displacement and velocity.

structuralIC(modelD,'Velocity',[0;0;0],'Displacement',[0;0;0]);

Specify the relative and absolute tolerances for the solver.

modelD.SolverOptions.RelativeTolerance = 1E-5;
modelD.SolverOptions.AbsoluteTolerance = 1E-9;

Solve the model using the default direct integration method.
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tlist = linspace(0,0.004,120);
Rd = solve(modelD,tlist)

Rd = 
  TransientStructuralResults with properties:

     Displacement: [1x1 struct]
         Velocity: [1x1 struct]
     Acceleration: [1x1 struct]
    SolutionTimes: [1x120 double]
             Mesh: [1x1 FEMesh]

Now, solve the model using the modal results.

tlist = linspace(0,0.004,120);
Rdm = solve(modelD,tlist,'ModalResults',Rm)

Rdm = 
  TransientStructuralResults with properties:

     Displacement: [1x1 struct]
         Velocity: [1x1 struct]
     Acceleration: [1x1 struct]
    SolutionTimes: [1x120 double]
             Mesh: [1x1 FEMesh]

Interpolate the displacement at the center of the beam.

intrpUd = interpolateDisplacement(Rd,0,0,0.0015);
intrpUdm = interpolateDisplacement(Rdm,0,0,0.0015);

Compare the direct integration results with the results obtained by modal superposition.

plot(Rd.SolutionTimes,intrpUd.uz,'bo')
hold on
plot(Rdm.SolutionTimes,intrpUdm.uz,'rx')
grid on
legend('Direct integration', 'Modal superposition')
xlabel('Time');
ylabel('Center of beam displacement')
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Stress Concentration in Plate with Circular Hole
Perform a 2-D plane-stress elasticity analysis.

A thin rectangular plate under a uniaxial tension has a uniform stress distribution.
Introducing a circular hole in the plate disturbs the uniform stress distribution near the
hole, resulting in a significantly higher than average stress. Such a thin plate, subject to
in-plane loading, can be analyzed as a 2-D plane-stress elasticity problem. In theory, if the
plate is infinite, then the stress near the hole is three times higher than the average
stress. For a rectangular plate of finite width, the stress concentration factor is a function
of the ratio of hole diameter to the plate width. This example approximates the stress
concentration factor using a plate of a finite width.

Create Structural Model and Include Geometry

Create a structural model for static plane-stress analysis.

model = createpde('structural','static-planestress');

The plate must be sufficiently long, so that the applied loads and boundary conditions are
far from the circular hole. This condition ensures that a state of uniform tension prevails
in the far field and, therefore, approximates an infinitely long plate. In this example the
length of the plate is four times greater than its width. Specify the following geometric
parameters of the problem.

radius = 20.0;
width = 50.0;
totalLength = 4*width;

Define the geometry description matrix (GDM) for the rectangle and circle.

R1 = [3 4 -totalLength  totalLength ...
           totalLength -totalLength ...
          -width -width width width]'; 
C1 = [1 0 0 radius 0 0 0 0 0 0]';

Define the combined GDM, name-space matrix, and set formula to construct decomposed
geometry using decsg.

gdm = [R1 C1];
ns = char('R1','C1');
g = decsg(gdm,'R1 - C1',ns');

Create the geometry and include it into the structural model.
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geometryFromEdges(model,g);

Plot the geometry displaying edge labels.

figure
pdegplot(model,'EdgeLabel','on');
axis([-1.2*totalLength 1.2*totalLength -1.2*width 1.2*width])
title 'Geometry with Edge Labels';

Plot the geometry displaying vertex labels.

figure
pdegplot(model,'VertexLabels','on');
axis([-1.2*totalLength 1.2*totalLength -1.2*width 1.2*width])
title 'Geometry with Vertex Labels';
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Specify Model Parameters

Specify the Young's modulus and Poisson's ratio to model linear elastic material behavior.
Remember to specify physical properties in consistent units.

structuralProperties(model,'YoungsModulus',200E3,'PoissonsRatio',0.25);

Restrain all rigid-body motions of the plate by specifying sufficient constraints. For static
analysis, the constraints must also resist the motion induced by applied load.

Set the x-component of displacement on the left edge (edge 3) to zero to resist the
applied load. Set the y-component of displacement at the bottom left corner (vertex 3) to
zero to restraint the rigid body motion.
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structuralBC(model,'Edge',3,'XDisplacement',0);
structuralBC(model,'Vertex',3,'YDisplacement',0);

Apply the surface traction with a non-zero x-component on the right edge of the plate.

structuralBoundaryLoad(model,'Edge',1,'SurfaceTraction',[100;0]);

Generate Mesh and Solve

To capture the gradation in solution accurately, use a fine mesh. Generate the mesh, using
Hmax to control the mesh size.

generateMesh(model,'Hmax',radius/6);

Plot the mesh.

figure
pdemesh(model)

 Stress Concentration in Plate with Circular Hole

3-99



Solve the plane-stress elasticity model.

R = solve(model);

Plot Stress Contours

Plot the x-component of the normal stress distribution. The stress is equal to applied
tension far away from the circular boundary. The maximum value of stress occurs near
the circular boundary.

figure
pdeplot(model,'XYData',R.Stress.sxx,'ColorMap','jet')
axis equal
title 'Normal Stress Along x-Direction';
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Interpolate Stress

To see the details of the stress variation near the circular boundary, first define a set of
points on the boundary.

thetaHole = linspace(0,2*pi,200);
xr = radius*cos(thetaHole);
yr = radius*sin(thetaHole);
CircleCoordinates = [xr;yr];

Then interpolate stress values at these points by using interpolateStress. This
function returns a structure array with its fields containing interpolated stress values.

stressHole = interpolateStress(R,CircleCoordinates);
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Plot the normal direction stress versus angular position of the interpolation points.

figure
plot(thetaHole,stressHole.sxx)
xlabel('\theta')
ylabel('\sigma_{xx}')
title 'Normal Stress Around Circular Boundary';

Solve the Same Problem Using Symmetric Model

The plate with a hole model has two axes of symmetry. Therefore, you can model a
quarter of the geometry. The following model solves a quadrant of the full model with
appropriate boundary conditions.
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Create a structural model for the static plane-stress analysis.

symModel = createpde('structural','static-planestress');

Create the geometry that represents one quadrant of the original model. You do not need
to create additional edges to constrain the model properly.

R1 = [3 4 0 totalLength/2 totalLength/2 ...
      0 0 0 width width]';
C1 = [1 0 0 radius 0 0 0 0 0 0]'; 
gm = [R1 C1];
sf = 'R1-C1';
ns = char('R1','C1');
g = decsg(gm,sf,ns');
geometryFromEdges(symModel,g);

Plot the geometry displaying the edge labels.

figure
pdegplot(symModel,'EdgeLabel','on');
axis equal
title 'Symmetric Quadrant with Edge Labels';
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Specify structural properties of the material.

structuralProperties(symModel,'YoungsModulus',200E3, ...
                              'PoissonsRatio',0.25);

Apply symmetric constraints on the edges 3 and 4.

structuralBC(symModel,'Edge',[3 4],'Constraint','symmetric');

Apply surface traction on the edge 1.

structuralBoundaryLoad(symModel,'Edge',1,'SurfaceTraction',[100;0]);

Generate mesh and solve the symmetric plane-stress model.

3 Solving PDEs

3-104



generateMesh(symModel,'Hmax',radius/6);
Rsym = solve(symModel);

Plot the x-component of the normal stress distribution. The results are identical to the
first quadrant of the full model.

figure
pdeplot(symModel,'XYData',Rsym.Stress.sxx,'ColorMap','jet');
axis equal
title 'Normal Stress Along x-Direction for Symmetric Model';
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Thermal Deflection of Bimetallic Beam
This example shows how to solve a coupled thermo-elasticity problem. Thermal expansion
or contraction in mechanical components and structures occurs due to temperature
changes in the operating environment. Thermal stress is a secondary manifestation: the
structure experiences stresses when structural constraints prevent free thermal
expansion or contraction of the component. Deflection of a bimetallic beam is a common
physics experiment. A typical bimetallic beam consists of two materials bonded together.
The coefficients of thermal expansion (CTE) of these materials are significantly different.

This example finds the deflection of a bimetallic beam using a structural finite-element
model. The example compares this deflection to the analytic solution based on beam
theory approximation.

Create a static structural model.

structuralmodel = createpde('structural','static-solid');

Create a beam geometry with the following dimensions.

L = 0.1; % m
W = 5E-3; % m
H = 1E-3; % m
gm = multicuboid(L,W,[H,H],'Zoffset',[0,H]);

Include the geometry in the structural model.
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structuralmodel.Geometry = gm;

Plot the geometry.

figure
pdegplot(structuralmodel)

Identify the cell labels of the cells for which you want to specify material properties.

First, display the cell label for the bottom cell. To see the cell label clearly, zoom onto the
left end of the beam and rotate the geometry as follows.

figure
pdegplot(structuralmodel,'CellLabels','on')
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axis([-L/2 -L/3 -W/2 W/2 0 2*H])
view([0 0])
zticks([])

Now, display the cell label for the top cell. To see the cell label clearly, zoom onto the right
end of the beam and rotate the geometry as follows.

figure
pdegplot(structuralmodel,'CellLabels','on')
axis([L/3 L/2 -W/2 W/2 0 2*H])
view([0 0])
zticks([])
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Specify the Young's modulus, Poisson's ratio, and linear coefficient of thermal expansion
to model linear elastic material behavior. To maintain unit consistency, specify all physical
properties in SI units.

Assign the material properties of copper to the bottom cell.

Ec = 137E9; % N/m^2
nuc = 0.28;
CTEc = 20.00E-6; % m/m-C
structuralProperties(structuralmodel,'Cell',1, ...
                                     'YoungsModulus',Ec, ...
                                     'PoissonsRatio',nuc, ...
                                     'CTE',CTEc);
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Assign the material properties of invar to the top cell.

Ei = 130E9; % N/m^2
nui = 0.354;
CTEi = 1.2E-6; % m/m-C
structuralProperties(structuralmodel,'Cell',2, ...
                                     'YoungsModulus',Ei, ...
                                     'PoissonsRatio',nui, ...
                                     'CTE',CTEi);

For this example, assume that the left end of the beam is fixed. To impose this boundary
condition, display the face labels on the left end of the beam.

figure
pdegplot(structuralmodel,'faceLabels','on','FaceAlpha',0.25)
axis([-L/2 -L/3 -W/2 W/2 0 2*H])
view([60 10])
xticks([])
yticks([])
zticks([])
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Apply a fixed boundary condition on faces 5 and 10.

structuralBC(structuralmodel,'Face',[5,10],'Constraint','fixed');

Apply the temperature change as a thermal load. Use a reference temperature of 25
degrees Celsius and an operating temperature of 125 degrees Celsius. Thus, the
temperature change for this model is 100 degrees Celsius.

structuralBodyLoad(structuralmodel,'Temperature',125);
structuralmodel.ReferenceTemperature = 25;

Generate a mesh and solve the model.

generateMesh(structuralmodel,'Hmax',H/2);
R = solve(structuralmodel);
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Plot the deflected shape of the bimetallic beam with the magnitude of displacement as the
color map data.

figure
pdeplot3D(structuralmodel,'ColorMapData',R.Displacement.Magnitude, ...
                          'Deformation',R.Displacement, ...
                          'DeformationScaleFactor',2)
title('Deflection of Invar-Copper Beam')

Compute the deflection analytically, based on beam theory. The deflection of the strip is

δ =
6Δ T αc− αi L2

K1
, where K1 = 14 +

Ec
Ei

+
Ei
Ec

, Δ T is the temperature difference, αc and αi
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are the coefficients of thermal expansion of copper and invar, Ec and Ei are the Young's
modulus of copper and invar, and L is the length of the strip.

K1 = 14 + (Ec/Ei)+ (Ei/Ec);
deflectionAnalytical = 3*(CTEc - CTEi)*100*2*H*L^2/(H^2*K1);

Compare the analytical results and the results obtained in this example. The results are
comparable because of the large aspect ratio.

PDEToobox_Deflection = max(R.Displacement.uz);
percentError = 100*(PDEToobox_Deflection - ...
                    deflectionAnalytical)/PDEToobox_Deflection;

bimetallicResults = table(PDEToobox_Deflection, ...
                          deflectionAnalytical,percentError);
bimetallicResults.Properties.VariableNames = {'PDEToolbox', ...
                                              'Analytical', ...
                                              'PercentageError'};
disp(bimetallicResults)

    PDEToolbox    Analytical    PercentageError
    __________    __________    _______________

    0.0071061     0.0070488         0.80608    
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Electrostatic Potential in Air-Filled Frame
Find the electrostatic potential in an air-filled annular quadrilateral frame using the PDE
Modeler app. For this example, use the following parameters:

• Inner square side is 0.2 m
• Outer square side is 0.5 m
• Electrostatic potential at the inner boundary is 1000V
• Electrostatic potential at the outer boundary is 0V

The PDE governing this problem is the Poisson equation

–∇ · (ε∇V) = ρ.

The PDE Modeler app uses the relative permittivity εr = ε/ε0, where ε0 is the absolute
dielectric permittivity of a vacuum (8.854 · 10-12 farad/meter). The relative permittivity for
the air is 1.00059. Note that the coefficient of permittivity does not affect the result in
this example as long as the coefficient is constant.

Assuming that there is no charge in the domain, you can simplify the Poisson equation to
the Laplace equation,

ΔV = 0.

Here, the boundary conditions are the Dirichlet boundary conditions V = 1000 at the
inner boundary and V = 0 at the outer boundary.

To solve this problem in the PDE Modeler app, follow these steps:

1 Draw the following two squares.

pderect([-0.1 0.1 -0.1 0.1])
pderect([-0.25 0.25 -0.25 0.25])

2 Set both x- and y-axis limits to [-0.3 0.3]. To do this, select Options > Axes
Limits and set the corresponding ranges. Then select Options > Axes Equal.

3 Model the frame by entering SQ2-SQ1 in the Set formula field.
4 Set the application mode to Electrostatics.
5 Specify the boundary conditions. To do this, switch to the boundary mode by

selecting Boundary > Boundary Mode. Use Shift+click to select several
boundaries. Then select Boundary > Specify Boundary Conditions.
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• For the inner boundaries, use the Dirichlet boundary condition with h = 1 and r
= 1000.

• For the outer boundaries, use the Dirichlet boundary condition with h = 1 and r
= 0.

6 Specify the coefficients by selecting PDE > PDE Specification or clicking the PDE
button on the toolbar. Specify epsilon = 1 and rho = 0.

7 Initialize the mesh by selecting Mesh > Initialize Mesh.
8 Solve the PDE by selecting Solve > Solve PDE or clicking the = button on the

toolbar.
9 Plot the equipotential lines using a contour plot. To do this, select Plot >

Parameters and choose the contour plot in the resulting dialog box.
10 Improve the accuracy of the solution by refining the mesh close to the reentrant

corners where the gradients are steep. To do this, select Solve > Parameters. Select
Adaptive mode, use the Worst triangles selection method, and set the maximum
number of triangles to 500. Select Mesh > Refine Mesh.

11 Solve the PDE using the refined mesh. To display equipotential lines at every 100th
volt, select Plot > Parameters and enter 0:100:1000 in the Contour plot levels
field.
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Linear Elasticity Equations

In this section...
“Summary of the Equations of Linear Elasticity” on page 3-117
“3D Linear Elasticity Problem” on page 3-118
“Plane Stress” on page 3-121
“Plane Strain” on page 3-122

Summary of the Equations of Linear Elasticity
The stiffness matrix of linear elastic isotropic material contains two parameters:

• E, Young's modulus (elastic modulus)
• ν, Poisson’s ratio

Define the following quantities.

σ = stress
f = body force
ε = strain
u = displacement

The equilibrium equation is

−∇ · σ = f

The linearized, small-displacement strain-displacement relationship is

ε = 1
2 ∇u + ∇uT

The balance of angular momentum states that stress is symmetric:

σi j = σ ji

The Voigt notation for the constitutive equation of the linear isotropic model is
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σ11
σ22
σ33
σ23
σ13
σ12

= E
1 + ν 1 − 2ν

1 − ν ν ν 0 0 0
ν 1 − ν ν 0 0 0
ν ν 1 − ν 0 0 0
0 0 0 1 − 2ν 0 0
0 0 0 0 1 − 2ν 0
0 0 0 0 0 1 − 2ν

ε11
ε22
ε33
ε23
ε13
ε12

The expanded form uses all the entries in σ and ε takes symmetry into account.

σ11
σ12
σ13
σ21
σ22
σ23
σ31
σ32
σ33

= E
1 + ν 1 − 2ν

1 − ν 0 0 0 ν 0 0 0 ν
• 1 − 2ν 0 0 0 0 0 0 0
• • 1 − 2ν 0 0 0 0 0 0
• • • 1 − 2ν 0 0 0 0 0
• • • • 1 − ν 0 0 0 ν
• • • • • 1 − 2ν 0 0 0
• • • • • • 1 − 2ν 0 0
• • • • • • • 1 − 2ν 0
• • • • • • • • 1 − ν

ε11
ε12
ε13
ε21
ε22
ε23
ε31
ε32
ε33
 (3-1)

In the preceding diagram, • means the entry is symmetric.

3D Linear Elasticity Problem
The toolbox form for the equation is

−∇ · c⊗ ∇u = f

But the equations in the summary do not have ∇u alone, it appears together with its
transpose:

ε = 1
2 ∇u + ∇uT

It is a straightforward exercise to convert this equation for strain ε to ∇u. In column
vector form,
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∇u =

∂ux/ ∂x
∂ux/ ∂y
∂ux/ ∂z
∂uy/ ∂x
∂uy/ ∂y
∂uy/ ∂z
∂uz/ ∂x
∂uz/ ∂y
∂uz/ ∂z

Therefore, you can write the strain-displacement equation as

ε =

1 0 0 0 0 0 0 0 0

0 1
2 0 1

2 0 0 0 0 0

0 0 1
2 0 0 0 1

2 0 0

0 1
2 0 1

2 0 0 0 0 0

0 0 0 0 1 0 0 0 0

0 0 0 0 0 1
2 0 1

2 0

0 0 1
2 0 0 0 1

2 0 0

0 0 0 0 0 1
2 0 1

2 0

0 0 0 0 0 0 0 0 1

∇u ≡ A∇u

where A stands for the displayed matrix. So rewriting “Equation 3-1”, and recalling that •
means an entry is symmetric, you can write the stiffness tensor as
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σ = E
1 + ν 1 − 2ν

1 − ν 0 0 0 ν 0 0 0 ν
• 1 − 2ν 0 0 0 0 0 0 0
• • 1 − 2ν 0 0 0 0 0 0
• • • 1 − 2ν 0 0 0 0 0
• • • • 1 − ν 0 0 0 ν
• • • • • 1 − 2ν 0 0 0
• • • • • • 1 − 2ν 0 0
• • • • • • • 1 − 2ν 0
• • • • • • • • 1 − ν

A∇u

= E
1 + ν 1 − 2ν

1 − ν 0 0 0 ν 0 0 0 ν
0 1/2 − ν 0 1/2 − ν 0 0 0 0 0
0 0 1/2 − ν 0 0 0 1/2 − ν 0 0
0 1/2 − ν 0 1/2 − ν 0 0 0 0 0
ν 0 0 0 1 − ν 0 0 0 ν
0 0 0 0 0 1/2 − ν 0 1/2 − ν 0
0 0 1/2 − ν 0 0 0 1/2 − ν 0 0
0 0 0 0 0 1/2 − ν 0 1/2 − ν 0
ν 0 0 0 ν 0 0 0 1 − ν

∇u

Make the definitions

μ = E
2(1 + ν)

λ = Eν
(1 + ν)(1 − 2ν)

E(1 − ν)
(1 + ν)(1 − 2ν) = 2μ + λ

and the equation becomes
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σ =

2μ + λ 0 0 0 λ 0 0 0 λ
0 μ 0 μ 0 0 0 0 0
0 0 μ 0 0 0 μ 0 0
0 μ 0 μ 0 0 0 0 0
λ 0 0 0 2μ + λ 0 0 0 λ
0 0 0 0 0 μ 0 μ 0
0 0 μ 0 0 0 μ 0 0
0 0 0 0 0 μ 0 μ 0
λ 0 0 0 λ 0 0 0 2μ + λ

∇u ≡ c∇u

If you are solving a 3-D linear elasticity problem by using PDEModel instead of
StructuralModel, use the elasticityC3D(E,nu) function (included in your software)
to obtain the c coefficient. This function uses the linearized, small-displacement
assumption for an isotropic material. For examples that use this function, see Vibration of
a Square Plate.

Plane Stress
Plane stress is a condition that prevails in a flat plate in the x-y plane, loaded only in its
own plane and without z-direction restraint. For plane stress, σ13 = σ23 = σ31 = σ32 = σ33
= 0. Assuming isotropic conditions, the Hooke's law for plane stress gives the following
strain-stress relation:

ε11
ε22

2ε12

= 1
E

1 −ν 0
−ν 1 0
0 0 2 + 2ν

σ11
σ22
σ12

Inverting this equation, obtain the stress-strain relation:

σ11
σ22
σ12

= E
1 − ν2

1 ν 0
ν 1 0

0 0 1 − ν
2

ε11
ε22
2ε12

Convert the equation for strain ε to ∇u.
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ε =

1 0 0 0

0 1
2

1
2 0

0 1
2

1
2 0

0 0 0 1

∇u ≡ A∇u

Now you can rewrite the stiffness matrix as

σ11
σ12
σ21
σ22

=

E
1 − ν2 0 0 Eν

1 − ν2

0 E
2 1 + ν

E
2 1 + ν 0

0 E
2 1 + ν

E
2 1 + ν 0

Eν
1 − ν2 0 0 E

1 − ν2

∇u =

2μ μ + λ
2μ + λ 0 0 2λμ

2μ + λ
0 μ μ 0
0 μ μ 0

2λμ
2μ + λ 0 0 2μ μ + λ

2μ + λ

∇u

Plane Strain
Plane strain is a deformation state where there are no displacements in the z-direction,
and the displacements in the x- and y-directions are functions of x and y but not z. The
stress-strain relation is only slightly different from the plane stress case, and the same set
of material parameters is used.

For plane strain, ε13 = ε23 = ε31 = ε32 = ε33 = 0. Assuming isotropic conditions, the stress-
strain relation can be written as follows:

σ11
σ22
σ12

= E
1 + ν 1 − 2ν

1 − ν ν 0
ν 1 − ν 0

0 0 1 − 2ν
2

ε11
ε22

2ε12

Convert the equation for strain ε to ∇u.
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ε =

1 0 0 0

0 1
2

1
2 0

0 1
2

1
2 0

0 0 0 1

∇u ≡ A∇u

Now you can rewrite the stiffness matrix as

σ11
σ12
σ21
σ22

=

E 1 − ν
1 + ν 1 − 2ν 0 0 Eν

1 + ν 1 − 2ν

0 E
2 1 + ν

E
2 1 + ν 0

0 E
2 1 + ν

E
2 1 + ν 0

Eν
1 + ν 1 − 2ν 0 0 E 1 − ν

1 + ν 1 − 2ν

∇u =

2μ + λ 0 0 λ
0 μ μ 0
0 μ μ 0
λ 0 0 2μ + λ

∇u
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Magnetic Field in Two-Pole Electric Motor
Find the static magnetic field induced by the stator windings in a two-pole electric motor.
The example uses the PDE Modeler app. Assuming that the motor is long and end effects
are negligible, you can use a 2-D model. The geometry consists of three regions:

• Two ferromagnetic pieces: the stator and the rotor (transformer steel)
• The air gap between the stator and the rotor
• The armature copper coil carrying the DC current

Magnetic permeability of the air and copper is close to the magnetic permeability of a
vacuum, μ0 = 4π*10-7 H/m. In this example, use the magnetic permeability μ = μ0 for both
the air gap and copper coil. For the stator and the rotor, μ is
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μ = μ0
μmax

1 + c ∇A 2 + μmin

where µmax = 5000, µmin = 200, and c = 0.05. The current density J is 0 everywhere except
in the coil, where it is 10 A/m2.

The geometry of the problem makes the magnetic vector potential A symmetric with
respect to y and antisymmetric with respect to x. Therefore, you can limit the domain to x
≥ 0, y ≥ 0 with the Neumann boundary condition

n ⋅ 1
μ ∇A = 0

on the x-axis and the Dirichlet boundary condition A = 0 on the y-axis. Because the field
outside the motor is negligible, you can use the Dirichlet boundary condition A = 0 on the
exterior boundary.

To solve this problem in the PDE Modeler app, follow these steps:

1 Set the x-axis limits to [-1.5 1.5] and the y-axis limits to [-1 1]. To do this, select
Options > Axes Limits and set the corresponding ranges.

2 Set the application mode to Magnetostatics.
3 Create the geometry. The geometry of this electric motor is complex. The model is a

union of five circles and two rectangles. The reduction to the first quadrant is
achieved by intersection with a square. To draw the geometry, enter the following
commands in the MATLAB Command Window:

pdecirc(0,0,1,'C1') 
pdecirc(0,0,0.8,'C2') 
pdecirc(0,0,0.6,'C3')
pdecirc(0,0,0.5,'C4') 
pdecirc(0,0,0.4,'C5') 
pderect([-0.2 0.2 0.2 0.9],'R1') 
pderect([-0.1 0.1 0.2 0.9],'R2') 
pderect([0 1 0 1],'SQ1') 
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4 Reduce the model to the first quadrant. To do this, enter
(C1+C2+C3+C4+C5+R1+R2)*SQ1 in the Set formula field.

5 Remove unnecessary subdomain borders. To do this, switch to the boundary mode by
selecting Boundary > Boundary Mode. Using Shift+click, select borders, and then
select Boundary > Remove Subdomain Border until the geometry consists of four
subdomains: the rotor (subdomain 1), the stator (subdomain 2), the air gap
(subdomain 3), and the coil (subdomain 4). The numbering of your subdomains can
differ. If you do not see the numbers, select Boundary > Show Subdomain Labels.
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6 Specify the boundary conditions. To do this, select the boundaries along the x-axis.
Select Boundary > Specify Boundary Conditions. In the resulting dialog box,
specify a Neumann boundary condition with g = 0 and q = 0.

All other boundaries have a Dirichlet boundary condition with h = 1 and r = 0, which
is the default boundary condition in the PDE Modeler app.

7 Specify the coefficients by selecting PDE > PDE Specification or clicking the PDE
button on the toolbar. Double-click each subdomain and specify the following
coefficients:

• Coil: µ = 4*pi*10^(-7) H/m, J = 10 A/m2.
• Stator and rotor: µ = 4*pi*10^(-7)*(5000./(1+0.05*(ux.^2+uy.^2))

+200) H/m, where ux.^2+uy.^2 equals to |∇A |2, J = 0 (no current).
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• Air gap: µ = 4*pi*10^(-7) H/m, J = 0.
8 Initialize the mesh by selecting Mesh > Initialize Mesh.
9 Choose the nonlinear solver. To do this, select Solve > Parameters and check Use

nonlinear solver. Here, you also can adjust the tolerance parameter and choose to
use the adaptive solver together with the nonlinear solver.

10 Solve the PDE by selecting Solve > Solve PDE or clicking the = button on the
toolbar.

11 Plot the magnetic flux density B using arrows and the equipotential lines of the
magnetostatic potential A using a contour plot. To do this, select Plot > Parameters
and choose the contour and arrows plots in the resulting dialog box. Using Options
> Axes Limits, adjust the axes limits as needed. For example, use the Auto check
box.

The plot shows that the magnetic flux is parallel to the equipotential lines of the
magnetostatic potential.
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Scattering Problem
This example shows how to solve a simple scattering problem, where you compute the
waves reflected by a square object illuminated by incident waves that are coming from
the left. This example uses the programmatic workflow. For the PDE Modeler app
solution, see “Scattering Problem: PDE Modeler App” on page 3-179.

For this problem, assume an infinite horizontal membrane subjected to small vertical
displacements U. The membrane is fixed at the object boundary. The medium is
homogeneous, and the phase velocity (propagation speed) of a wave, α, is constant. The
wave equation is

∂2U
∂t2 − α2 ▵ U = 0

The solution U is the sum of the incident wave V and the reflected wave R:

U = V + R

When the illumination is harmonic in time, you can compute the field by solving a single
steady problem. Assume that the incident wave is a plane wave traveling in the -x
direction:

V x, y, t = ei −kx− ωt = e−ikx ⋅ e−iωt

The reflected wave can be decomposed into spatial and time components:

R x, y, t = r x, y e−iωt

Now you can rewrite the wave equation as the Helmholtz equation for the spatial
component of the reflected wave with the wave number k = ω/α:

−Δr − k2r = 0

The Dirichlet boundary condition for the boundary of the object is U = 0, or in terms of
the incident and reflected waves, R = -V. For the time-harmonic solution and the incident
wave traveling in the -x direction, you can write this boundary condition as follows:

r x, y = − e−ikx
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The reflected wave R travels outward from the object. The condition at the outer
computational boundary must allow waves to pass without reflection. Such conditions are
usually called nonreflecting. As x  approaches infinity, R approximately satisfies the one-
way wave equation

∂R
∂t + αξ ⋅ ∇R = 0

This equation considers only the waves moving in the positive ξ-direction. Here, ξ is the
radial distance from the object. With the time-harmonic solution, this equation turns into
the generalized Neumann boundary condition

ξ ⋅ ∇r − ikr = 0

To solve the scattering problem using the programmatic workflow, first create a PDE
model with a single dependent variable.

numberOfPDE = 1;
model = createpde(numberOfPDE);

Specify the variables that define the problem:

• g: A geometry specification function. For more information, see the documentation
section Parametrized Function for 2-D Geometry Creation and the code for
scatterg.m.

• k, c, a, f: The coefficients and inhomogeneous term.

g = @scatterg;
k = 60;
c = 1;
a = -k^2;
f = 0;

Convert the geometry and append it to the model.

geometryFromEdges(model,g);

Plot the geometry and display the edge labels for use in the boundary condition definition.

figure; 
pdegplot(model,'EdgeLabels','on'); 
axis equal
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title 'Geometry with Edge Labels Displayed';
ylim([0,1])

Apply the boundary conditions.

bOuter = applyBoundaryCondition(model,'neumann','Edge',(5:8),'g',0,'q',-60i);
innerBCFunc = @(loc,state)-exp(-1i*k*loc.x);
bInner = applyBoundaryCondition(model,'dirichlet','Edge',(1:4),'u',innerBCFunc);

Specify the coefficients.

specifyCoefficients(model,'m',0,'d',0,'c',c,'a',a,'f',f);

Generate a mesh.
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generateMesh(model,'Hmax',0.02);
figure
pdemesh(model); 
axis equal

Solve for the complex amplitude. The real part of vector u stores an approximation to a
real-valued solution of the Helmholtz equation.

result = solvepde(model);
u = result.NodalSolution;

Plot the solution.
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figure
pdeplot(model,'XYData',real(u),'Mesh','off');
colormap(jet)

Using the solution to the Helmholtz equation, create an animation showing the
corresponding solution to the time-dependent wave equation.

figure
m = 10;
maxu = max(abs(u));
for j = 1:m
    uu = real(exp(-j*2*pi/m*sqrt(-1))*u);
    pdeplot(model,'XYData',uu,'ColorBar','off','Mesh','off');
    colormap(jet)
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    caxis([-maxu maxu]);
    axis tight
    ax = gca;
    ax.DataAspectRatio = [1 1 1]; 
    axis off
    M(j) = getframe;
end

To play the movie, use the movie(M) command.

 Scattering Problem

3-135



AC Power Electromagnetics Equations
Consider a homogeneous dielectric with the coefficient of dielectricity ε, the magnetic
permeability µ, and no charge at any point. The fields must satisfy a special set of general
Maxwell's equations:

∇ × E = − μ∂H∂t

∇ × H = ε∂E∂t + J

Here, E is the electric field, H is the magnetic field, and J is the current density. In the
absence of a current, you can eliminate H from the first set and E from the second set
and see that both fields satisfy wave equations with the wave speed εμ:

ΔE− εμ∂
2E
∂t2 = 0

ΔH− εμ∂
2H
∂t2 = 0

Consider the case of a charge-free homogeneous dielectric with the coefficient of
dielectricity ε, magnetic permeability µ, and conductivity σ. The current density is

J = σE

and the waves are damped by the Ohmic resistance,

ΔE− μσ∂E∂t − εμ∂
2E
∂t2 = 0

Equations for H are similar.

For time-harmonic fields, use the complex form of the equations, replacing E with

Ece jωt

For a plane, the electric field is Ec = 0, 0, Ec ,   J = 0, 0, Je jωt , and the magnetic field is

H = Hx, Hy, 0 = −1
jμσ ∇ × Ec
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The scalar equation for Ec becomes

−∇ · 1
μ ∇Ec + jωσ − ω2ε Ec = 0

The PDE Modeler app uses this equation when it is in the AC Power Electromagnetics
application mode . The equation is a complex Helmholtz equation that describes the
propagation of plane electromagnetic waves in imperfect dielectrics and good conductors
(σ » ωε). A complex permittivity εc can be defined as εc = ε ⁻ jσ/ω. The conditions at
material interfaces with abrupt changes of ε and µ are the natural conditions for the
variational formulation and need no special attention.

The boundary conditions associated with this mode are:

• The Dirichlet boundary condition specifying the value of the electric field Ec on the
boundary

• The Neumann boundary condition specifying the normal derivative of Ec, which is
equivalent to specifying the tangential component of the magnetic field H:

Ht = j
ωn · 1

μ ∇Ec

The solution is the electric field E. Using the solution, you can compute the current
density J = σE and the magnetic flux density

B = j
ω ∇ × E

Using the PDE Modeler app, you can plot the electric field E, the current density J, the
magnetic field H, and the magnetic flux density B. You also can plot the resistive heating
rate

Q = Ec
2/σ

You can plot the magnetic field and the magnetic flux density as vector fields by using
arrows.

References
[1] Popovic, B. D., Introductory Engineering Electromagnetics. Reading, MA: Addison-

Wesley, 1971.
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Skin Effect in Copper Wire with Circular Cross Section
This example shows the skin effect when a wire with a circular cross section carries AC
current. In a solid conductor, such as the wire, AC current travels near the surface of a
wire and avoids the area close to the center of the wire. This effect is called the skin
effect. The example uses the PDE Modeler app.

The Helmholtz equation

−∇ · 1
μ ∇Ec + jωσ − ω2ε Ec = 0

describes the propagation of plane electromagnetic waves in imperfect dielectrics and
good conductors (σ » ωε). The coefficient of dielectricity is ε = 8.8*10-12 F/m. The
conductivity of copper is σ = 57 * 106 S/m. The magnetic permeability of copper is close
to the magnetic permeability of a vacuum, µ = 4π*10–7 H/m. The ω2ε-term is negligible at
the line frequency (50 Hz).

Due to induction, the current density in the interior of the conductor is smaller than at
the outer surface, where it is set to JS = 1. The Dirichlet condition for the electric field is
Ec = 1/σ. In this case, the analytical solution is

J = JS
J0 kr
J0 kR

Here,

k = jωμσ,

R is the radius of the wire, r is the distance from the center line, and J0(x) is the first
Bessel function of zeroth order.

To solve this problem in the PDE Modeler app, follow these steps:

1 Draw a circle with a radius of 0.1. The circle represents a cross section of the
conductor.

pdecirc(0,0.05,0.1)
2 Set the x-axis limit to [-0.2 0.2] and the y-axis limit to [-0.1 0.2]. To do this,

select Options > Axes Limits and set the corresponding ranges. Then select
Options > Axes Equal.
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3 Set the application mode to AC Power Electromagnetics.
4 Specify the Dirichlet boundary condition E = JS/σ = 1/σ for the boundary of the circle.

To do this:

a Switch to the boundary mode by selecting Boundary > Boundary Mode.
b Select all boundaries by using Edit > Select All.
c Select Boundary > Specify Boundary Conditions.
d Specify h = 1 and r = 1/57E6.

5 Specify the PDE coefficients. To do this, switch to the PDE mode by selecting PDE >
PDE Mode. Then select PDE > PDE Specification or click the PDE button on the
toolbar. Specify the following values:

• Angular frequency omega = 2*pi*50
• Magnetic permeability mu = 4*pi*1E-7
• Conductivity sigma = 57E6
• Coefficient of dielectricity epsilon = 8.8E-12

6 Initialize the mesh by selecting Mesh > Initialize Mesh.
7 Solve the PDE by selecting Solve > Solve PDE or clicking the = button on the

toolbar.

The solution of the AC power electromagnetics equation is complex. When plotting
the solution, you get a warning message.

8 Plot the current density as a 3-D plot. To do this:

a Select Plot > Parameters.
b Select the Color and Height(3-D plot) options.
c Select current density from the Property drop-down menu for both the

Color and Height(3-D plot) options.
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d Select Show Mesh to observe the mesh.

Due to the skin effect, the current density at the surface of the conductor is much
higher than in the conductor's interior.

9 Improve the accuracy of the solution close to the surface by using adaptive mesh
refinement. To do this:

a Select Solve > Parameters.
b In the resulting dialog box, select Adaptive mode.
c Set the maximum numbers of triangles to Inf.
d Set the maximum numbers of refinements to 1.
e Select the Worst triangles selection method.
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10 Recompute the solution five times. Each time, the adaptive solver refines the area
with the largest errors. The number of triangles is printed at the command line.

11 Plot the current density as a 3-D plot.

12 These plots show the real part of the solution, but the solution vector is the full
complex solution. Plot the imaginary part of the solution. To do this:

a Select Plot > Parameters.
b Select the Color and Height(3-D plot) options.
c Select user entry from the Property drop-down menu for both Color and

Height(3-D plot) options.
d Type imag(u) in the corresponding User entry fields.
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e Select Show Mesh to observe the mesh.
f

13 Observe that the skin effect depends on the frequency of the alternating current.
When you increase or decrease the frequency, the skin "depth" increases or
decreases, respectively. At high frequencies, only a thin layer on the surface of the
wire conducts the current. At very low frequencies (approaching DC conditions),
almost the entire cross section area of the wire conducts the current.

Find the solution for the angular frequencies omega = 2*pi*1000, omega =
2*pi*50, and omega = 1E-6. Plot the real parts of the solutions in 2-D.
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Current density for omega = 2*pi*1000
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Current density for omega = 2*pi*50
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Current density for omega = 1E-6
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Current Density Between Two Metallic Conductors
Two circular metallic conductors are placed on a brine-soaked blotting paper which
serves as a plane, thin conductor. The physical model for this problem consists of the
Laplace equation

–∇ · (σ∇V) = 0

for the electric potential V and these boundary conditions:

• V = 1 on the left circular conductor
• V = –1 on the right circular conductor
• the natural Neumann boundary condition on the outer boundaries

∂V
∂n = 0

The conductivity is σ = 1.

To solve this equation in the PDE Modeler app, follow these steps:

1 Model the geometry: draw the rectangle with corners at (-1.2,-0.6), (1.2,-0.6),
(1.2,0.6), and (-1.2,0.6), and two circles with a radius of 0.3 and centers at (-0.6,0)
and (0.6,0). The rectangle represents the blotting paper, and the circles represent the
conductors.

pderect([-1.2 1.2 -0.6 0.6])
pdecirc(-0.6,0,0.3)
pdecirc(0.6,0,0.3)

2 Model the geometry by entering R1-(C1+C2) in the Set formula field.
3 Set the application mode to Conductive Media DC.
4 Specify the boundary conditions. To do this, switch to the boundary mode by

selecting Boundary > Boundary Mode. Use Shift+click to select several
boundaries. Then select Boundary > Specify Boundary Conditions.

• For the rectangle, use the Neumann boundary condition with g = 0 and q = 0.
• For the left circle, use the Dirichlet boundary condition with h = 1 and r = 1.
• For the right circle, use the Dirichlet boundary condition with h = 1 and r = -1.

5 Specify the coefficients by selecting PDE > PDE Specification or clicking the PDE
button on the toolbar. Specify sigma = 1 and q = 0.
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6 Initialize the mesh by selecting Mesh > Initialize Mesh.
7 Refine the mesh by selecting Mesh > Refine Mesh.
8 Improve the triangle quality by selecting Mesh > Jiggle Mesh.
9 Solve the PDE by selecting Solve > Solve PDE or clicking the = button on the

toolbar. The resulting potential is zero along the y-axis, which, for this problem, is a
vertical line of antisymmetry.

10 Plot the current density J. To do this:
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a Select Plot > Parameters.
b In the resulting dialog box, select the Color, Contour, and Arrows options.
c Set the Arrows value to current density.

The current flows, as expected, from the conductor with a positive potential to the
conductor with a negative potential. The conductivity σ is isotropic, and the
equipotential lines are orthogonal to the current lines.
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Heat Transfer Between Two Squares Made of Different
Materials: PDE Modeler App

Solve the following heat transfer problem with different material parameters. This
example uses the PDE Modeler app. For the command-line solutions see “Heat Transfer
Between Two Squares Made of Different Materials” on page 5-170.

The 2-D geometry for this problem is a square with an embedded diamond (a square with
45 degrees rotation). PDE governing this problem is a parabolic heat equation:

ρC∂T∂t − ∇ ⋅ k∇T = Q + h Text− T

where ρ is the density, C is the heat capacity, k is the coefficient of heat conduction, Q is
the heat source, h is convective heat transfer coefficient, and Text is the external
temperature.

To solve this problem in the PDE Modeler app, follow these steps:

1 Model the geometry: draw the square region with corners in (0,0), (3,0), (3,3), and
(0,3) and the diamond-shaped region with corners in (1.5,0.5), (2.5,1.5), (1.5,2.5), and
(0.5,1.5).

pderect([0 3 0 3])
pdepoly([1.5 2.5 1.5 0.5],[0.5 1.5 2.5 1.5])

2 Set the x-axis limit to [-1.5 4.5] and y-axis limit to [-0.5 3.5]. To do this, select
Options > Axes Limits and set the corresponding ranges.

3 Set the application mode to Heat Transfer.
4 The temperature is kept at 0 on all the outer boundaries, so you do not have to

change the default Dirichlet boundary condition T = 0.
5 Specify the coefficients. To do this, select PDE > PDE Mode. Then click each region

and select PDE > PDE Specification or click the PDE button on the toolbar. Since
you are solving the parabolic heat equation, select the Parabolic type of PDE for
both regions. For the square region, specify the following coefficients:

• Density, pho = 2
• Heat capacity, C = 0.1
• Coefficient of heat conduction, k = 10
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• Heat source, Q = 0
• Convective heat transfer coefficient, h = 0
• External temperature, Text = 0

For the diamond-shaped region, specify the following coefficients:

• Density, pho = 1
• Heat capacity, C = 0.1
• Coefficient of heat conduction, k = 2
• Heat source, Q = 4
• Convective heat transfer coefficient, h = 0
• External temperature, Text = 0

6 Initialize the mesh by selecting Mesh > Initialize Mesh. For a more accurate
solution, refine the mesh by selecting Mesh > Refine Mesh.

7 Set the initial value and the solution time. To do this, select Solve > Parameters.

The dynamics for this problem is very fast — the temperature reaches steady state in
about 0.1 time units. To capture the interesting part of the dynamics, set time to
logspace(-2,-1,10). This gives 10 logarithmically spaced numbers between 0.01
and 0.1. Set the initial value of the temperature u(t0) to 0.

8 Solve the equation by selecting Solve > Solve PDE or clicking the = button on the
toolbar.

9 Plot the solution. By default, the app plots the temperature distribution at the last
time. The best way to visualize the dynamic behavior of the temperature is to animate
the solution. To do this, select Plot > Parameters and select the Animation and
Height (3-D plot) options to animate a 3-D plot. Also, you can select the Plot in x-y
grid option to use a rectangular grid instead of the default triangular grid. Using a
rectangular grid instead of a triangular grid speeds up the animation process
significantly.

You can also plot isothermal lines using a contour plot and the heat flux vector field
using arrows.

a Select Plot > Parameters.
b In the resulting dialog box, deselect the Animation, and Height (3-D plot), and

Plot in x-y grid options.
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c Change the colormap to hot by using the corresponding drop-down menu in the
same dialog box.

d To obtain the first plot, select the Color and Contour options.
e For the second plot, select the Color and Arrows and set their values to

temperature and heat flux, respectively.

Isothermal Lines
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Temperature and Heat Flux
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Nonlinear Heat Transfer in Thin Plate
This example shows how to perform a heat transfer analysis of a thin plate.

The plate is square and the temperature is fixed along the bottom edge. No heat is
transferred from the other three edges (i.e. they are insulated). Heat is transferred from
both the top and bottom faces of the plate by convection and radiation. Because radiation
is included, the problem is nonlinear. One of the purposes of this example is to show how
to handle nonlinearities in PDE problems.

Both a steady state and a transient analysis are performed. In a steady state analysis we
are interested in the final temperature at different points in the plate after it has reached
an equilibrium state. In a transient analysis we are interested in the temperature in the
plate as a function of time. One question that can be answered by this transient analysis
is how long does it take for the plate to reach an equilibrium temperature.

Heat Transfer Equations for the Plate

The plate has planar dimensions one meter by one meter and is 1 cm thick. Because the
plate is relatively thin compared with the planar dimensions, the temperature can be
assumed constant in the thickness direction; the resulting problem is 2D.

Convection and radiation heat transfer are assumed to take place between the two faces
of the plate and a specified ambient temperature.

The amount of heat transferred from each plate face per unit area due to convection is
defined as

Qc = hc(T − Ta)

where Ta is the ambient temperature, T is the temperature at a particular x and y location
on the plate surface, and hc is a specified convection coefficient.

The amount of heat transferred from each plate face per unit area due to radiation is
defined as

Qr = ϵσ(T4− Ta
4)

where ϵ is the emissivity of the face and σ is the Stefan-Boltzmann constant. Because the
heat transferred due to radiation is proportional to the fourth power of the surface
temperature, the problem is nonlinear.
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The PDE describing the temperature in this thin plate is

ρCptz
∂T
∂t − ktz∇2T + 2Qc + 2Qr = 0

where ρ is the material density, Cp is the specific heat, tz is the plate thickness, and the
factors of two account for the heat transfer from both plate faces.

It is convenient to rewrite this equation in the form expected by PDE Toolbox

ρCptz
∂T
∂t − ktz∇2T + 2hcT + 2ϵσT4 = 2hcTa + 2ϵσTa

4

Problem Setup

The plate is composed of copper which has the following properties:

k = 400; % thermal conductivity of copper, W/(m-K)
rho = 8960; % density of copper, kg/m^3
specificHeat = 386; % specific heat of copper, J/(kg-K)
thick = .01; % plate thickness in meters
stefanBoltz = 5.670373e-8; % Stefan-Boltzmann constant, W/(m^2-K^4)
hCoeff = 1; % Convection coefficient, W/(m^2-K)
% The ambient temperature is assumed to be 300 degrees-Kelvin.
ta = 300;
emiss = .5; % emissivity of the plate surface

Create the PDE model with a single dependent variable.

numberOfPDE = 1;
model = createpde(numberOfPDE);

For a square, the geometry and mesh are easily defined as shown below.

width = 1; 
height = 1;

Define the square by giving the 4 x-locations followed by the 4 y-locations of the corners.

gdm = [3 4 0 width width 0 0 0 height height]';
g = decsg(gdm, 'S1', ('S1')');

Convert the DECSG geometry into a geometry object on doing so it is appended to the
PDEModel
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geometryFromEdges(model,g);

Plot the geometry and display the edge labels for use in the boundary condition definition.

figure; 
pdegplot(model,'EdgeLabels','on'); 
axis([-.1 1.1 -.1 1.1]);
title 'Geometry With Edge Labels Displayed';

Specify the coefficients. The expressions for the coefficients required by PDE Toolbox can
easily be identified by comparing the equation above with the scalar parabolic equation in
the PDE Toolbox documentation.

c = thick*k;
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Because of the radiation boundary condition, the "a" coefficient is a function of the
temperature, u. It is defined as a MATLAB expression so it can be evaluated for different
values of u during the analysis.

a = @(~,state) 2*hCoeff + 2*emiss*stefanBoltz*state.u.^3;
f = 2*hCoeff*ta + 2*emiss*stefanBoltz*ta^4;
d = thick*rho*specificHeat;
specifyCoefficients(model,'m',0,'d',0,'c',c,'a',a,'f',f);

The bottom edge of the plate is set to 1000 degrees-Kelvin.

Apply the boundary conditions. Three of the plate edges are insulated. Because a
Neumann boundary condition equal zero is the default in the finite element formulation,
the boundary conditions on these edges do not need to be set explicitly. A Dirichlet
condition is set on all nodes on the bottom edge, edge 1,

applyBoundaryCondition(model,'dirichlet','Edge',1,'u',1000);

Specify the initial guess.

setInitialConditions(model,0);

Create the triangular mesh on the square with approximately ten elements in each
direction.

hmax = .1; % element size
msh = generateMesh(model,'Hmax',hmax);
figure; 
pdeplot(model); 
axis equal
title 'Plate With Triangular Element Mesh'
xlabel 'X-coordinate, meters'
ylabel 'Y-coordinate, meters'
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Steady State Solution

Because the a and f coefficients are functions of temperature (due to the radiation
boundary conditions), solvepde automatically picks the nonlinear solver to obtain the
solution.

R = solvepde(model);
u = R.NodalSolution;
figure; 
pdeplot(model,'XYData',u,'Contour','on','ColorMap','jet');
title 'Temperature In The Plate, Steady State Solution'
xlabel 'X-coordinate, meters'
ylabel 'Y-coordinate, meters'
axis equal
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p = msh.Nodes;
plotAlongY(p,u,0);
title 'Temperature As a Function of the Y-Coordinate'
xlabel 'Y-coordinate, meters'
ylabel 'Temperature, degrees-Kelvin'
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fprintf('Temperature at the top edge of the plate = %5.1f degrees-K\n', ...
  u(4));

Temperature at the top edge of the plate = 449.8 degrees-K

Transient Solution

Include the d coefficient.

specifyCoefficients(model,'m',0,'d',d,'c',c,'a',a,'f',f);
endTime = 5000;
tlist = 0:50:endTime;
numNodes = size(p,2);

Set the initial temperature of all nodes to ambient, 300 K.
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u0(1:numNodes) = 300;

Set the initial temperature on the bottom edge E1 to the value of the constant BC, 1000
K.

setInitialConditions(model,1000,'edge',1);

Set the following solver options.

model.SolverOptions.RelativeTolerance = 1.0e-3; 
model.SolverOptions.AbsoluteTolerance = 1.0e-4;

Solve the problem by using solvepde. The solver automatically picks the parabolic solver
to obtain the solution.

R = solvepde(model,tlist);
u = R.NodalSolution;
figure; 
plot(tlist,u(3, :)); 
grid on
title 'Temperature Along the Top Edge of the Plate as a Function of Time'
xlabel 'Time, seconds'
ylabel 'Temperature, degrees-Kelvin'
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figure;
pdeplot(model,'XYData',u(:,end),'Contour','on','ColorMap','jet');
title(sprintf('Temperature In The Plate, Transient Solution( %d seconds)\n', ...
  tlist(1,end)));
xlabel 'X-coordinate, meters'
ylabel 'Y-coordinate, meters'
axis equal;
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fprintf('\nTemperature at the top edge(t=%5.1f secs)=%5.1f degrees-K\n', ...
  tlist(1,end), u(4,end));

Temperature at the top edge(t=5000.0 secs)=441.8 degrees-K

Summary

The plots of temperature in the plate from the steady state and transient solution at the
ending time are very close. That is, after around 5000 seconds, the transient solution has
reached the steady state values. The temperatures from the two solutions at the top edge
of the plate agree to within one percent.
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Poisson's Equation on Unit Disk: PDE Modeler App
This example shows how to solve the Poisson's equation on a unit disk and evaluate the
numeric solution error.

This example uses the PDE Modeler app. For a programmatic workflow, see “Poisson's
Equation on Unit Disk” on page 3-169. Because the app and the programmatic workflow
use different meshers, they yield slightly different results.

The problem formulation is –Δu = 1 in Ω, u = 0 on ∂Ω, where Ω is the unit disk. The exact
solution is

u x, y = 1 − x2− y2

4

To solve this problem in the PDE Modeler app, follow these steps:

1 Open the PDE Modeler app by using the pdeModeler command.
2 Display grid lines by selecting Options > Grid.
3 Align new shapes to the grid lines by selecting Options > Snap.
4 Draw a circle with the radius 1 and the center at (0,0). To do this, first click the

 button. Then right-click the origin and drag to draw a circle. Right-clicking
constrains the shape you draw so that it is a circle rather than an ellipse. If the circle
is not a perfect unit circle, double-click it. In the resulting dialog box, specify the
exact center location and radius of the circle.

5 Check that the application mode is set to Generic Scalar.
6 Specify the boundary conditions. To do this, switch to boundary mode by clicking the

 button or selecting Boundary > Boundary Mode. Select all boundaries by
selecting Edit > Select All. Then select Boundary > Specify Boundary
Conditions and specify the Dirichlet boundary condition u = 0. This boundary
condition is the default (h = 1, r = 0), so you do not need to change it.

7 Specify the coefficients by selecting PDE > PDE Specification or clicking the PDE
button on the toolbar. Specify c = 1, a = 0, and f = 1.

8 Specify the maximum edge size for the mesh by selecting Mesh > Parameters. Set
the maximum edge size to 0.1.
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9
Initialize the mesh by selecting Mesh > Initialize Mesh or clicking the  button.

10 Solve the PDE by selecting Solve > Solve PDE or clicking the = button on the
toolbar. The toolbox assembles the PDE problem, solves it, and plots the solution.
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11 Compare the numerical solution to the exact solution:

a Select Plot > Parameters.
b In the resulting dialog box, select user entry from the Color drop-down menu.
c Plot the absolute error in the solution by typing the MATLAB expression u-(1-

x.^2-y.^2)/4 in the User entry field.

 Poisson's Equation on Unit Disk: PDE Modeler App

3-165



12
Refine the mesh by selecting Mesh > Refine Mesh or clicking the  button.
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13 Compare the numerical solution to the exact solution for the refined mesh. Plot the
absolute error.
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14 Export the mesh data and the solution to the MATLAB workspace by selecting Mesh
> Export Mesh and Solve > Export Solution, respectively.
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Poisson's Equation on Unit Disk
This example shows how to numerically solve a Poisson's equation, compare the
numerical solution with the exact solution, and refine the mesh until the solutions are
close.

The example uses the solvepde function. For the PDE Modeler app solution, see
“Poisson's Equation on Unit Disk: PDE Modeler App” on page 3-163. Because the app and
the programmatic workflow use different meshers, they yield slightly different results.

The Poisson equation on a unit disk with zero Dirichlet boundary condition can be written
as −Δu = 1 in Ω, u = 0 on δΩ, where Ω is the unit disk. The exact solution is

u(x, y) = 1 − x2− y2

4 .

For most PDEs, the exact solution is not known. However, the Poisson's equation on a unit
disk has a known, exact solution that you can use to see how the error decreases as you
refine the mesh.

Problem Definition

Create the PDE model and include the geometry.

model = createpde();
geometryFromEdges(model,@circleg);

Plot the geometry and display the edge labels for use in the boundary condition definition.

figure 
pdegplot(model,'EdgeLabels','on'); 
axis equal
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Specify zero Dirichlet boundary conditions on all edges.

applyBoundaryCondition(model,'dirichlet','Edge',1:model.Geometry.NumEdges,'u',0);

Specify the coefficients.

specifyCoefficients(model,'m',0,'d',0,'c',1,'a',0,'f',1);

Solution and Error with a Coarse Mesh

Create a mesh with target maximum element size 0.1.

hmax = 0.1;
generateMesh(model,'Hmax',hmax);
figure
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pdemesh(model); 
axis equal

Solve the PDE and plot the solution.

results = solvepde(model);
u = results.NodalSolution;
pdeplot(model,'XYData',u)
title('Numerical Solution');
xlabel('x')
ylabel('y')
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Compare this result with the exact analytical solution and plot the error.

p = model.Mesh.Nodes;
exact = (1 - p(1,:).^2 - p(2,:).^2)/4;
pdeplot(model,'XYData',u - exact')
title('Error');
xlabel('x')
ylabel('y')
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Solutions and Errors with Refined Meshes

Solve the equation while refining the mesh in each iteration and comparing the result
with the exact solution. Each refinement halves the Hmax value. Refine the mesh until the
infinity norm of the error vector is less than 5 ⋅ 10−7.

hmax = 0.1;
error = [];
err = 1;
while err > 5e-7 % run until error <= 5e-7
    generateMesh(model,'Hmax',hmax); % refine mesh
    results = solvepde(model);
    u = results.NodalSolution;
    p = model.Mesh.Nodes;

 Poisson's Equation on Unit Disk

3-173



    exact = (1 - p(1,:).^2 - p(2,:).^2)/4; 
    err = norm(u - exact',inf); % compare with exact solution
    error = [error err]; % keep history of err
    hmax = hmax/2;
end

Plot the infinity norm of the error vector for each iteration. The value of the error
decreases in each iteration.

plot(error,'rx','MarkerSize',12);
ax = gca;
ax.XTick = 1:numel(error);
title('Error History');
xlabel('Iteration');
ylabel('Norm of Error');
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Plot the final mesh and its corresponding solution.

figure
pdemesh(model); 
axis equal
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figure
pdeplot(model,'XYData',u)
title('Numerical Solution');
xlabel('x')
ylabel('y')
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Compare the result with the exact analytical solution and plot the error.

p = model.Mesh.Nodes;
exact = (1 - p(1,:).^2 - p(2,:).^2)/4;
pdeplot(model,'XYData',u - exact')
title('Error');
xlabel('x')
ylabel('y')

 Poisson's Equation on Unit Disk

3-177



3 Solving PDEs

3-178



Scattering Problem: PDE Modeler App
This example shows how to solve a simple scattering problem, where you compute the
waves reflected by a square object illuminated by incident waves that are coming from
the left. This example uses the PDE Modeler app. For the programmatic workflow, see
“Scattering Problem” on page 3-130.

For this problem, assume an infinite horizontal membrane subjected to small vertical
displacements U. The membrane is fixed at the object boundary. The medium is
homogeneous, and the phase velocity (propagation speed) of a wave, α, is constant. The
wave equation is

∂2U
∂t2 − α2ΔU = 0

The solution U is the sum of the incident wave V and the reflected wave R:

U = V + R

When the illumination is harmonic in time, you can compute the field by solving a single
steady problem. Assume that the incident wave is a plane wave traveling in the –x
direction:

V(x, y, t) = ei −kx− ωt = e−ikxe−iωt

The reflected wave can be decomposed into spatial and time components:

R x, y, t = r x, y e−iωt

Now you can rewrite the wave equation as the Helmholtz equation for the spatial
component of the reflected wave with the wave number k = ω/α:

–Δr – k2r = 0

The Dirichlet boundary condition for the boundary of the object is U = 0, or in terms of
the incident and reflected waves, R = -V. For the time-harmonic solution and the incident
wave traveling in the –x direction, you can write this boundary condition as follows:

r x, y = − e−ikx

The reflected wave R travels outward from the object. The condition at the outer
computational boundary must allow waves to pass without reflection. Such conditions are
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usually called nonreflecting. As x  approaches infinity, R approximately satisfies the one-
way wave equation

∂R
∂t + αξ · ∇R = 0

This equation considers only the waves moving in the positive ξ-direction. Here, ξ is the
radial distance from the object. With the time-harmonic solution, this equation turns into
the generalized Neumann boundary condition

ξ · ∇r = ikr

To solve the scattering problem in the PDE Modeler app, follow these steps:

1 Open the PDE Modeler app by using the pdeModeler command.
2 Set the x-axis limit to [0.1 1.5] and the y-axis limit to [0 1]. To do this, select

Options > Axes Limits and set the corresponding ranges.
3 Display grid lines. To do this:

a Select Options > Grid Spacing and clear the Auto checkboxes.
b Enter X-axis linear spacing as 0.1:0.05:1.5 and Y-axis linear spacing as

0:0.05:1.
c Select Options > Grid.

4 Align new shapes to the grid lines by selecting Options > Snap.
5 Draw a square with sides of length 0.1 and a center in [0.8 0.5]. To do this, first

click the  button. Then right-click the origin and drag to draw a square. Right-
clicking constrains the shape you draw so that it is a square rather than a rectangle.
If the square is not a perfect square, double-click it. In the resulting dialog box,
specify the exact location of the bottom left corner and the side length.

6 Rotate the square by 45 degrees. To do this, select Draw > Rotate... and enter 45 in
the resulting dialog box. The rotated square represents the illuminated object.

7 Draw a circle with a radius of 0.45 and a center in [0.8 0.5]. To do this, first click

the  button. Then right-click the origin and drag to draw a circle. Right-clicking
constrains the shape you draw so that it is a circle rather than an ellipse. If the circle
is not a perfect unit circle, double-click it. In the resulting dialog box, specify the
exact center location and radius of the circle.
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8 Model the geometry by entering C1-SQ1 in the Set formula field.
9 Check that the application mode is set to Generic Scalar.
10 Specify the boundary conditions. To do this, switch to the boundary mode by

selecting Boundary > Boundary Mode. Use Shift+click to select several
boundaries. Then select Boundary > Specify Boundary Conditions.

• For the perimeter of the circle, the boundary condition is the Neumann boundary
condition with q = -ik, where the wave number k = 60 corresponds to a
wavelength of about 0.1 units. Enter g = 0 and q = -60*i.

• For the perimeter of the square, the boundary condition is the Dirichlet boundary
condition:

r = − v x, y = − eika ⋅ x

In this problem, because the reflected wave travels in the –x direction, the
boundary condition is r = –e–ikx. Enter h = 1 and r = -exp(-i*60*x).

11 Specify the coefficients by selecting PDE > PDE Specification or clicking the PDE
button on the toolbar. The Helmholtz equation is a wave equation, but in Partial
Differential Equation Toolbox you can treat it as an elliptic equation with a = -k2.
Specify c = 1, a = -3600, and f = 0.

12 Initialize the mesh by selecting Mesh > Initialize Mesh.

For sufficient accuracy, you need about 10 finite elements per wavelength. The outer
boundary must be located a few object diameters away from the object itself. Refine
the mesh by selecting Mesh > Refine Mesh. Refine the mesh two more times to
achieve the required resolution.

13 Solve the PDE by selecting Solve > Solve PDE or clicking the = button on the
toolbar.

The solution is complex. When plotting the solution, you get a warning message.
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14 Plot the reflected waves. Change the colormap to jet by selecting Plot >
Parameters and then selecting jet from the Colormap drop-down menu.

15 Animate the solution for the time-dependent wave equation. To do this:

a Export the mesh data and the solution to the MATLAB workspace by selecting
Mesh > Export Mesh and Solve > Export Solution, respectively.

b Enter the following commands in the MATLAB Command Window.

figure
maxu = max(abs(u)); 
m = 10;
for j = 1:m, 
   uu = real(exp(-j*2*pi/10*sqrt(-1))*u); 
   pdeplot(p,e,t,'XYData',uu,'ColorBar','off','Mesh','off');
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   colormap(jet)
   caxis([-maxu maxu]);
   axis tight
   ax = gca;
   ax.DataAspectRatio = [1 1 1]; 
   axis off
   M(:,j) = getframe; 
 end
movie(M);
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Minimal Surface Problem
This example shows how to solve the minimal surface equation

−∇ ⋅ 1
1 + ∇u 2 ∇u = 0

on the unit disk Ω = x, y x2 + y2 ≤ 1 , with u(x, y) = x2 on the boundary ∂Ω.

This example uses the programmatic workflow. For the PDE Modeler app solution, see
“Minimal Surface Problem: PDE Modeler App” on page 3-189.

An elliptic equation in the toolbox form is

−∇ ⋅ (c∇u) + au = f .

Therefore, for the minimal surface problem, the coefficients are as follows:

c = 1
1 + ∇u 2 , a = 0, f = 0 .

Because the coefficient c is a function of the solution u, the minimal surface problem is a
nonlinear elliptic problem.

To solve the minimal surface problem using the programmatic workflow, first create a
PDE model with a single dependent variable.

numberOfPDE = 1;
model = createpde(numberOfPDE);

Create the geometry and include it in the model. The circleg function represents this
geometry.

geometryFromEdges(model,@circleg);

Plot the geometry displaying the edge labels.

pdegplot(model,'EdgeLabels','on'); 
axis equal
title 'Geometry with Edge Labels';
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Specify the coefficients.

a = 0;
f = 0;
cCoef = @(region,state) 1./sqrt(1+state.ux.^2 + state.uy.^2);
specifyCoefficients(model,'m',0,'d',0,'c',cCoef,'a',a,'f',f);

Specify the boundary conditions using the function u(x, y) = x2.

bcMatrix = @(region,~)region.x.^2;
applyBoundaryCondition(model,'dirichlet',...
                             'Edge',1:model.Geometry.NumEdges,...
                             'u',bcMatrix);
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Generate a mesh.

generateMesh(model,'Hmax',0.1);
figure; 
pdemesh(model); 
axis equal

Solve the problem by using the solvepde function. Because the problem is nonlinear,
solvepde invokes a nonlinear solver. Observe the solver progress by setting the
SolverOptions.ReportStatistics property of the model to 'on'.

model.SolverOptions.ReportStatistics = 'on';
result = solvepde(model);
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Iteration     Residual     Step size  Jacobian: Full
   0          1.8540e-02
   1          2.8715e-04   1.0000000
   2          1.2145e-06   1.0000000

u = result.NodalSolution;

Plot the solution.

figure; 
pdeplot(model,'XYData',u,'ZData',u);
xlabel 'x'
ylabel 'y'
zlabel 'u(x,y)'
title 'Minimal Surface'
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Minimal Surface Problem: PDE Modeler App
This example shows how to solve the minimal surface equation

−∇ ⋅ 1
1 + ∇u 2 ∇u = 0

on the unit disk Ω = {(x,y) | x2 + y2 ≤ 1}, with u = x2 on the boundary ∂Ω.

This example uses the PDE Modeler app. For the programmatic workflow, see “Minimal
Surface Problem” on page 3-184.

An elliptic equation in the toolbox form is

−∇ ⋅ c∇u + au = f

Therefore, for the minimal surface problem the coefficients are as follows:

c = 1
1 + ∇u 2 ,  a = 0,  f = 0

Because the coefficient c is a function of the solution u, the minimal surface problem is a
nonlinear elliptic problem.

To solve the minimal surface problem in the PDE Modeler app, follow these steps:

1 Model the surface as a unit circle.

pdecirc([0 0 1])
2 Check that the application mode is set to Generic Scalar.
3 Specify the boundary conditions. To do this:

a
Switch to boundary mode by clicking the  button or selecting Boundary
> Boundary Mode.

b Select all boundaries by selecting Edit > Select All.
c Select Boundary > Specify Boundary Conditions.
d Specify the Dirichlet boundary condition u = x2. To do this, specify h = 1, r =

x.^2.
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4 Specify the coefficients by selecting PDE > PDE Specification or clicking the PDE
button on the toolbar. Specify c = 1./sqrt(1+ux.^2+uy.^2), a = 0, and f = 0.

5 Initialize the mesh by selecting Mesh > Initialize Mesh.
6 Refine the mesh by selecting Mesh > Refine Mesh.
7 Choose the nonlinear solver. To do this, select Solve > Parameters and check Use

nonlinear solver. Set the tolerance parameter to 0.001.
8 Solve the PDE by selecting Solve > Solve PDE or clicking the = button on the

toolbar.
9 Plot the solution in 3-D. To do this, select PlotParameters. In the resulting dialog

box, select Height (3-D plot).
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Poisson's Equation with Point Source and Adaptive
Mesh Refinement

This example shows how to solve a Poisson's equation with a delta-function point source
on the unit disk using the adaptmesh function.

Specifically, solve the Poisson's equation

−Δu = δ(x, y)

on the unit disk with zero Dirichlet boundary conditions. The exact solution expressed in
polar coordinates is

u(r, θ) = log(r)
2π ,

which is singular at the origin.

By using adaptive mesh refinement, Partial Equation Toolbox™ can accurately find the
solution everywhere away from the origin.

The following variables define the problem:

• c, a: The coefficients of the PDE.
• f: A function that captures a point source at the origin. It returns 1/area for the

triangle containing the origin and 0 for other triangles.

c = 1;
a = 0;
f = @circlef;

Create a PDE Model with a single dependent variable.

numberOfPDE = 1;
model = createpde(numberOfPDE);

Create a geometry and include it in the model. For more information, see the |circleg| and
|pdegeom| pages.

g = @circleg;
geometryFromEdges(model,g);

Plot the geometry and display the edge labels.

 Poisson's Equation with Point Source and Adaptive Mesh Refinement

3-191



figure; 
pdegplot(model,'EdgeLabels','on'); 
axis equal
title 'Geometry With Edge Labels Displayed';

Specify the zero solution at all four outer edges of the circle.

applyBoundaryCondition(model,'dirichlet','Edge',(1:4),'u',0);

adaptmesh solves elliptic PDEs using the adaptive mesh generation. The 'tripick'
parameter lets you specify a function that returns which triangles will be refined in the
next iteration. circlepick returns triangles with computed error estimates greater a
given tolerance. The tolerance is provided to circlepick using the 'par' parameter.
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[u,p,e,t] = adaptmesh(g,model,c,a,f,'tripick','circlepick','maxt',2000,'par',1e-3);

Number of triangles: 258
Number of triangles: 515
Number of triangles: 747
Number of triangles: 1003
Number of triangles: 1243
Number of triangles: 1481
Number of triangles: 1705
Number of triangles: 1943
Number of triangles: 2155

Maximum number of triangles obtained.

Plot the finest mesh.

figure; 
pdemesh(p,e,t); 
axis equal
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Plot the error values.

x = p(1,:)';
y = p(2,:)';
r = sqrt(x.^2+y.^2);
uu = -log(r)/2/pi;
figure;
pdeplot(p,e,t,'XYData',u-uu,'ZData',u-uu,'Mesh','off');
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Plot the FEM solution on the finest mesh.

figure;
pdeplot(p,e,t,'XYData',u,'ZData',u,'Mesh','off');
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Heat Transfer in Block with Cavity: PDE Modeler App
This example shows how to solve a heat equation that describes the diffusion of heat in a
body. This example uses the PDE Modeler app. For programmatic workflow, see “Heat
Transfer in Block with Cavity” on page 3-202.

Consider a block containing a rectangular crack or cavity. The left side of the block is
heated to 100 degrees centigrade. At the right side of the block, heat flows from the block
to the surrounding air at a constant rate, for example -10 W/m2. All the other boundaries
are insulated. The temperature in the block at the starting time t0 = 0 is 0 degrees. The
goal is to model the heat distribution during the first five seconds.

The PDE governing this problem is a parabolic heat equation. Partial Differential Equation
Toolbox solves the generic parabolic PDE of the form

d∂u∂t − ∇ ⋅ c∇u + au = f

The heat equation has the form:

d∂u∂t − Δu = 0

To solve this problem in the PDE Modeler app, follow these steps:

1 Open the PDE Modeler app by using the pdeModeler command.

pdeModeler
2 Model the geometry: draw a rectangle with corners (-0.5,-0.8), (0.5,-0.8), (0.5,0.8),

and (-0.5,0.8) and a rectangle with corners (-0.05,-0.4), (0.05,-0.4), (0.05,0.4), and
(-0.05,0.4). Draw the first rectangle by using the pderect function.

pderect([-0.5 0.5 -0.8 0.8])
3 Display grid lines with extra ticks at -0.05 and 0.05. To do this, select Options >

Grid Spacing, clear the Auto checkbox, and enter X-axis extra ticks at -0.05 and
0.05. Then select Options > Grid.
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4 Set the x-axis limit to [-0.6 0.6] and y-axis limit to [-1 1]. To do this, select
Options > Axes Limits and set the corresponding ranges.

5 Select Options > Snap to align any new shape to the grid lines. Then draw the
rectangle with corners (-0.05,-0.4), (0.05,-0.4), (0.05,0.4), and (-0.05,0.4)

6 Model the geometry by entering R1-R2 in the Set formula field.
7 Check that the application mode is set to Generic Scalar.
8 Specify the boundary conditions. To do this, switch to the boundary mode by

selecting Boundary > Boundary Mode. Then select Boundary > Specify
Boundary Conditions and specify the Neumann boundary condition.

• For convenience, first specify the insulating Neumann boundary condition ∂u/∂n =
0 for all boundaries. To do this, select all boundaries by using Edit > Select All
and specify g = 0, q = 0.

• Specify the Dirichlet boundary condition u = 100 for the left side of the block. To
do this, specify h = 1, r = 100.

• Specify the Neumann boundary condition ∂u/∂n = –10 for the right side of the
block. To do this, specify g = -10, q = 0.
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9 Specify the coefficients by selecting PDE > PDE Specification or clicking the PDE
button on the toolbar. Heat equation is a parabolic equation, so select the Parabolic
type of PDE. Specify c = 1, a = 0, f = 0, and d = 1.

10 Initialize the mesh by selecting Mesh > Initialize Mesh. Refine the mesh by
selecting Mesh > Refine Mesh.

11 Set the initial value to 0, the solution time to 5 seconds, and compute the solution
every 0.5 seconds. To do this, select Solve > Parameters. In the Solve Parameters
dialog box, set time to 0:0.5:5, and u(t0) to 0.

12 Solve the PDE by selecting Solve > Solve PDE or clicking the = button on the
toolbar. The app solves the heat equation at 11 different times from 0 to 5 seconds
and displays the heat distribution at the end of the time span.

13 Plot isothermal lines using a contour plot and the heat flux vector field using arrows
and change the colormap to hot. To do this:

a Select Plot > Parameters.
b In the resulting dialog box, select the Color, Contour, and Arrows options.

Select -c*grad(u) from Arrows drop-down menu.
c Change the colormap to hot by using the corresponding drop-down menu in the

same dialog box.
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14 Use an animated plot to visualize the dynamic behavior of the temperature. For this,
select Plot > Parameters and then select the Animation option.

15 The temperature in the block rises very quickly. To improve the animation and focus
on the first second, change the list of times to the MATLAB expression
logspace(-2,0.5,20). To do this, select Solve > Parameters. In the Solve
Parameters dialog box, set time to logspace(-2,0.5,20).
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16 You can explore the solution by varying the parameters of the model and plotting the
results. For example, change the heat capacity coefficient d and the heat flow at the
right boundary to see how these parameters affect the heat distribution.
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Heat Transfer in Block with Cavity
This example shows how to solve for the heat distribution in a block with cavity using the
programmatic workflow. For the PDE Modeler app solution, see “Heat Transfer in Block
with Cavity: PDE Modeler App” on page 3-197.

Consider a block containing a rectangular crack or cavity. The left side of the block is
heated to 100 degrees centigrade. At the right side of the block, heat flows from the block
to the surrounding air at a constant rate, for example −10W /m2. All the other boundaries
are insulated. The temperature in the block at the starting time t0 = 0 is 0 degrees. The
goal is to model the heat distribution during the first five seconds.

The crackg.m file describes the geometry of the block.

thermalmodel = createpde('thermal','transient');
geometryFromEdges(thermalmodel,@crackg);

Plot the geometry with edge labels.

pdegplot(thermalmodel,'EdgeLabels','on');
ylim([-1,1])
axis equal
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Assume that the block has these thermal properties.

thermalProperties(thermalmodel,'ThermalConductivity',1,...
                               'MassDensity',1,...
                               'SpecificHeat',1);

Set the boundary conditions to have the solution u equal to 20 on the left edge (edge 6),
and g equal to -10 on the right edge (edge 1). The boundary condition on edge 1
corresponds to constant heat flow to the exterior. The toolbox uses the default insulating
boundary condition for all other boundaries.

thermalBC(thermalmodel,'Edge',6,'Temperature',20);
thermalBC(thermalmodel,'Edge',1,'HeatFlux',-10);
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Set an initial value of 0 for the temperature.

thermalIC(thermalmodel,0);

Set solution times to be 0 to 5 in steps of 1/2.

tlist = 0:0.5:5;

Create a mesh and solve the problem.

generateMesh(thermalmodel);
thermalresults = solve(thermalmodel,tlist);
T = thermalresults.Temperature;

Compute the heat flux density. Plot the solution at t = 5.0 seconds with isothermal lines
using a contour plot, and plot the heat flux vector field using arrows.

[qx,qy] = evaluateHeatFlux(thermalresults);
pdeplot(thermalmodel,'XYData',T(:,end),'Contour','on',...
                     'FlowData',[qx(:,end),qy(:,end)],'ColorMap','hot')
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Heat Transfer Problem with Temperature-Dependent
Properties

This example shows how to solve the heat equation with a temperature-dependent
thermal conductivity. The example shows an idealized thermal analysis of a rectangular
block with a rectangular cavity in the center.

The partial differential equation for transient conduction heat transfer is:

ρCp
∂T
∂t − ∇ ⋅ (k∇T) = f

where T is the temperature, ρ is the material density, Cp is the specific heat, and k is the
thermal conductivity. f  is the heat generated inside the body which is zero in this
example.

Steady-State Solution: Constant Thermal Conductivity

Create a steady-state thermal model.

thermalmodelS = createpde('thermal','steadystate');

Create a 2-D geometry by drawing one rectangle the size of the block and a second
rectangle the size of the slot.

r1 = [3 4 -.5 .5 .5 -.5  -.8 -.8 .8 .8];
r2 = [3 4 -.05 .05 .05 -.05  -.4 -.4 .4 .4];
gdm = [r1; r2]';

Subtract the second rectangle from the first to create the block with a slot.

g = decsg(gdm,'R1-R2',['R1'; 'R2']');

Convert the decsg format into a geometry object. Include the geometry in the model.

geometryFromEdges(thermalmodelS,g);

Plot the geometry with edge labels displayed. The edge labels will be used below in the
function for defining boundary conditions.

figure
pdegplot(thermalmodelS,'EdgeLabels','on'); 
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axis([-.9 .9 -.9 .9]);
title 'Block Geometry With Edge Labels Displayed'

Set the temperature on the left edge to 100 degrees. On the right edge, there is a
prescribed heat flux out of the block. The top and bottom edges and the edges inside the
cavity are all insulated, that is, no heat is transferred across these edges.

thermalBC(thermalmodelS,'Edge',6,'Temperature',100);
thermalBC(thermalmodelS,'Edge',1,'HeatFlux',-10);

Specify the thermal conductivity of the material. First, consider the constant thermal
conductivity, for example, equal one. Later, consider a case where the thermal
conductivity is a function of temperature.
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thermalProperties(thermalmodelS,'ThermalConductivity',1);

Create a mesh with elements no larger than 0.2.

generateMesh(thermalmodelS,'Hmax',0.2);
figure 
pdeplot(thermalmodelS); 
axis equal
title 'Block With Finite Element Mesh Displayed'

Calculate the steady-state solution.

R = solve(thermalmodelS);
T = R.Temperature;
figure
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pdeplot(thermalmodelS,'XYData',T,'Contour','on','ColorMap','hot'); 
axis equal
title 'Temperature, Steady State Solution'

Transient Solution: Constant Thermal Conductivity

Create a transient thermal model and include the geometry.

thermalmodelT = createpde('thermal','transient');

r1 = [3 4 -.5 .5 .5 -.5  -.8 -.8 .8 .8];
r2 = [3 4 -.05 .05 .05 -.05  -.4 -.4 .4 .4];
gdm = [r1; r2]';
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g = decsg(gdm,'R1-R2',['R1'; 'R2']');
geometryFromEdges(thermalmodelT,g);

Specify thermal conductivity, mass density, and specific heat of the material.

thermalProperties(thermalmodelT,'ThermalConductivity',1,...
                                'MassDensity',1,...
                                'SpecificHeat',1);

Define boundary conditions. In the transient cases, the temperature on the left edge is
zero at time=0 and ramps to 100 degrees over .5 seconds. You can find the helper
function transientBCHeatedBlock under matlab/R20XXx/examples/pde/main.

thermalBC(thermalmodelT,'Edge',6,'Temperature',@transientBCHeatedBlock);

On the right edge, there is a prescribed heat flux out of the block.

thermalBC(thermalmodelT,'Edge',1,'HeatFlux',-10);

The top and bottom edges as well as the edges inside the cavity are all insulated, that is
no heat is transferred across these edges.

Create a mesh with elements no larger than 0.2.

msh = generateMesh(thermalmodelT,'Hmax',0.2);
figure 
pdeplot(thermalmodelT); 
axis equal
title 'Block With Finite Element Mesh Displayed'
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Calculate the transient solution. Perform a transient analysis from zero to five seconds.
The toolbox saves the solution every .1 seconds so that plots of the results as functions of
time can be created.

tlist = 0:.1:5;
thermalIC(thermalmodelT,0);
R = solve(thermalmodelT,tlist);
T = R.Temperature;

Two plots are useful in understanding the results from this transient analysis. The first is
a plot of the temperature at the final time. The second is a plot of the temperature at a
specific point in the block, in this case near the center of the right edge, as a function of
time. To identify a node near the center of the right edge, it is convenient to define this
short utility function.
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getClosestNode = @(p,x,y) min((p(1,:) - x).^2 + (p(2,:) - y).^2);

Call this function to get a node near the center of the right edge.

[~,nid] = getClosestNode( msh.Nodes, .5, 0 );

The two plots are shown side-by-side in the figure below. The temperature distribution at
this time is very similar to that obtained from the steady-state solution above. At the right
edge, for times less than about one-half second, the temperature is less than zero. This is
because heat is leaving the block faster than it is arriving from the left edge. At times
greater than about three seconds, the temperature has essentially reached steady-state.

h = figure;
h.Position = [1 1 2 1].*h.Position;
subplot(1,2,1); 
axis equal
pdeplot(thermalmodelT,'XYData',T(:,end),'Contour','on','ColorMap','hot'); 
axis equal
title 'Temperature, Final Time, Transient Solution'
subplot(1,2,2); 
axis equal
plot(tlist, T(nid,:)); 
grid on
title 'Temperature at Right Edge as a Function of Time';
xlabel 'Time, seconds'
ylabel 'Temperature, degrees-Celsius'
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Steady State Solution: Temperature-Dependent Thermal Conductivity

It is not uncommon for material properties to be functions of the dependent variables. For
example, assume that the thermal conductivity is a simple linear function of temperature:

k = @(~,state) 0.3+0.003*state.u;

In this case, the variable u is the temperature. For this example, assume that the density
and specific heat are not functions of temperature.

thermalProperties(thermalmodelS,'ThermalConductivity',k);

Calculate the steady-state solution. Compared with the constant-conductivity case, the
temperature on the right-hand edge is lower. This is due to the lower conductivity in
regions with lower temperature.

R = solve(thermalmodelS);
T = R.Temperature;
figure
pdeplot(thermalmodelS,'XYData',T,'Contour','on','ColorMap','hot');  
axis equal
title 'Temperature, Steady State Solution'
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Transient Solution: Temperature-Dependent Thermal Conductivity

Now perform a transient analysis with the temperature-dependent conductivity.

thermalProperties(thermalmodelT,'ThermalConductivity',k,...
                                'MassDensity',1,...
                                'SpecificHeat',1);

Use the same timespan tlist = 0:.1:5 as for the linear case.

thermalIC(thermalmodelT,0);
R = solve(thermalmodelT,tlist);
T = R.Temperature;
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Plot the temperature at the final time step and the temperature at the right edge as a
function of time. The plot of temperature at the final time step is only slightly different
from the comparable plot from the linear analysis: temperature at the right edge is
slightly lower than the linear case. The plot of temperature as a function of time is
considerably different from the linear case. Because of the lower conductivity at lower
temperatures, the heat takes longer to reach the right edge of the block. In the linear
case, the temperature is essentially constant at around three seconds but for this
nonlinear case, the temperature curve is just beginning to flatten at five seconds.

h = figure;
h.Position = [1 1 2 1].*h.Position;
subplot(1,2,1); 
axis equal
pdeplot(thermalmodelT,'XYData',T(:,end),'Contour','on','ColorMap','hot'); 
axis equal
title 'Temperature, Final Time, Transient Solution'
subplot(1,2,2); 
axis equal
plot(tlist(1:size(T,2)), T(nid,:)); 
grid on
title 'Temperature at Right Edge as a Function of Time (Nonlinear)';
xlabel 'Time, seconds'
ylabel 'Temperature, degrees-Celsius'
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Heat Conduction in Multidomain Geometry with
Nonuniform Heat Flux

This example shows how to perform a 3-D transient heat conduction analysis of a hollow
sphere made of three different layers of material.

The sphere is subject to a nonuniform external heat flux.

The physical properties and geometry of this problem are described in Singh, Jain, and
Rizwan-uddin [1], which also has an analytical solution for this problem. The inner face of
the sphere has a temperature of zero at all times. The outer hemisphere with positive y
value has a nonuniform heat flux defined by

qouter = θ2(π − θ)2ϕ2(π − ϕ)2

0 ≤ θ ≤ π, 0 ≤ ϕ ≤ π .

θ and ϕ are azimuthal and elevation angles of points in the sphere. Initially, the
temperature at all points in the sphere is zero.

Create a thermal model for transient thermal analysis.

thermalmodel = createpde('thermal','transient');

Create a multilayered sphere using the multisphere function. Assign the resulting
geometry to the thermal model. The sphere has three layers of material with a hollow
inner core.

gm = multisphere([1,2,4,6],'Void',[true,false,false,false]);
thermalmodel.Geometry = gm;

Plot the geometry and show the cell labels and face labels. Use a FaceAlpha of 0.25 so
that labels of the interior layers are visible.

figure('Position',[10,10,800,400]);
subplot(1,2,1)
pdegplot(thermalmodel,'FaceAlpha',0.25,'CellLabel','on')
title('Geometry with Cell Labels')
subplot(1,2,2)
pdegplot(thermalmodel,'FaceAlpha',0.25,'FaceLabel','on')
title('Geometry with Face Labels')
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Generate a mesh for the geometry. Choose a mesh size that is coarse enough to speed the
solution, but fine enough to represent the geometry reasonably accurately.

generateMesh(thermalmodel,'Hmax',1);

Specify the thermal conductivity, mass density, and specific heat for each layer of the
sphere. The material properties are dimensionless values, not given by realistic material
properties.

thermalProperties(thermalmodel,'Cell',1,'ThermalConductivity',1, ...
                                        'MassDensity',1, ...
                                        'SpecificHeat',1);
thermalProperties(thermalmodel,'Cell',2,'ThermalConductivity',2, ...
                                        'MassDensity',1, ...
                                        'SpecificHeat',0.5);
thermalProperties(thermalmodel,'Cell',3,'ThermalConductivity',4, ...
                                        'MassDensity',1, ...
                                        'SpecificHeat',4/9);

Specify boundary conditions. The innermost face has a temperature of zero at all times.

thermalBC(thermalmodel,'Face',1,'Temperature',0);
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The outer surface of the sphere has an external heat flux. Use the functional form of
thermal boundary conditions to define the heat flux.

function Qflux = externalHeatFlux(region,~)

[phi,theta,~] = cart2sph(region.x,region.y,region.z);

theta = pi/2 - theta; % transform to 0 <= theta <= pi

ids = phi > 0;

Qflux = zeros(size(region.x));

Qflux(ids) = theta(ids).^2.*(pi - theta(ids)).^2.*phi(ids).^2.*(pi -
phi(ids)).^2;

end

Plot the flux on the surface.

[phi,theta,r] = meshgrid(linspace(0,2*pi),linspace(-pi/2,pi/2),6);
[x,y,z] = sph2cart(phi,theta,r);
region.x = x;
region.y = y;
region.z = z;
flux = externalHeatFlux(region,[]);
figure
surf(x,y,z,flux,'LineStyle','none')
axis equal
view(130,10)
colorbar
xlabel 'x'
ylabel 'y'
zlabel 'z'
title('External Flux')
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Include this boundary condition in the model.

thermalBC(thermalmodel,'Face',4,'HeatFlux',@externalHeatFlux,'Vectorized','on');

Define the initial temperature to be zero at all points.

thermalIC(thermalmodel,0);

Define a time-step vector and solve the transient thermal problem.

tlist = [0,2,5:5:50];
R = solve(thermalmodel,tlist);
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To plot contours at several times, with the contour levels being the same for all plots,
determine the range of temperatures in the solution. The minimum temperature is zero
because it is the boundary condition on the inner face of the sphere.

Tmin = 0;

Find the maximum temperature from the final time-step solution.

Tmax = max(R.Temperature(:,end));

Plot contours in the range Tmin to Tmax at the times in tlist.

h = figure;
for i = 1:numel(tlist)
    pdeplot3D(thermalmodel,'ColorMapData',R.Temperature(:,i))
    caxis([Tmin,Tmax])
    view(130,10)
    title(['Temperature at Time ' num2str(tlist(i))]);
    M(i) = getframe;
   
end
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To see a movie of the contours when running this example on your computer, execute the
following line:

movie(M,2)

Visualize the temperature contours on the cross-section. First, define a rectangular grid
of points on the y − z plane where x = 0.

[YG,ZG] = meshgrid(linspace(-6,6,100),linspace(-6,6,100));
XG = zeros(size(YG));

Interpolate the temperature at the grid points. Perform interpolation for several time
steps to observe the evolution of the temperature contours.
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tIndex = [2,3,5,7,9,11];
varNames = {'Time_index','Time_step'};
index_step = table(tIndex.',tlist(tIndex).','VariableNames',varNames);
disp(index_step);

    Time_index    Time_step
    __________    _________

         2            2    
         3            5    
         5           15    
         7           25    
         9           35    
        11           45    

TG = interpolateTemperature(R,XG,YG,ZG,tIndex);

Define the geometric spherical layers on the cross-section.

t = linspace(0,2*pi);
ylayer1 = cos(t); zlayer1 = sin(t);
ylayer2 = 2*cos(t); zlayer2 = 2*sin(t);
ylayer3 = 4*cos(t); zlayer3 = 4*sin(t);
ylayer4 = 6*cos(t); zlayer4 = 6*sin(t);

Plot the contours in the range Tmin to Tmax for the time steps corresponding to the time
indices tIndex.

figure('Position',[10,10,1000,550]);
for i = 1:numel(tIndex)
    subplot(2,3,i)
    contour(YG,ZG,reshape(TG(:,i),size(YG)),'ShowText','on')
    colorbar
    title(['Temperature at Time ' num2str(tlist(tIndex(i)))]);
    hold on
    caxis([Tmin,Tmax])
    axis equal
    % Plot boundaries of spherical layers for reference.
    plot(ylayer1,zlayer1,'k','LineWidth',1.5)
    plot(ylayer2,zlayer2,'k','LineWidth',1.5)
    plot(ylayer3,zlayer3,'k','LineWidth',1.5)
    plot(ylayer4,zlayer4,'k','LineWidth',1.5)
end
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Inhomogeneous Heat Equation on Square Domain
This example shows how to solve the heat equation with a source term.

The basic heat equation with a unit source term is

∂u
∂t − Δu = 1

This equation is solved on a square domain with a discontinuous initial condition and zero
temperatures on the boundaries.

Create a transient thermal model.

thermalmodel = createpde('thermal','transient');

Create a square geometry centered at x = 0 and y = 0 with sides of length 2. Include a
circle of radius 0.4 concentric with the square.

R1 = [3;4;-1;1;1;-1;-1;-1;1;1];
C1 = [1;0;0;0.4];
C1 = [C1;zeros(length(R1) - length(C1),1)];
gd = [R1,C1];
sf = 'R1+C1';
ns = char('R1','C1')';
g = decsg(gd,sf,ns);

Append the geometry to the model.

geometryFromEdges(thermalmodel,g);

Specify thermal properties of the material.

thermalProperties(thermalmodel,'ThermalConductivity',1,...
                               'MassDensity',1,...
                               'SpecificHeat',1);

Specify internal heat source.

internalHeatSource(thermalmodel,1);

Plot the geometry and display the edge labels for use in the boundary condition definition.

figure
pdegplot(thermalmodel,'EdgeLabels','on','FaceLabels','on')
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axis([-1.1 1.1 -1.1 1.1]);
axis equal
title 'Geometry With Edge and Subdomain Labels'

Set zero temperatures on all four outer edges of the square.

thermalBC(thermalmodel,'Edge',1:4,'Temperature',0);

The discontinuous initial value is 1 inside the circle and zero outside. Specify zero initial
temperature everywhere.

thermalIC(thermalmodel,0);

Specify non-zero initial temperature inside the circle (Face 2).
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thermalIC(thermalmodel,1,'Face',2);

Generate and plot a mesh.

msh = generateMesh(thermalmodel);
figure;
pdemesh(thermalmodel); 
axis equal

Find the solution at 20 points in time between 0 and 0.1.

nframes = 20;
tlist = linspace(0,0.1,nframes);
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thermalmodel.SolverOptions.ReportStatistics ='on';
result = solve(thermalmodel,tlist);

99 successful steps
0 failed attempts
200 function evaluations
1 partial derivatives
20 LU decompositions
199 solutions of linear systems

T = result.Temperature;

Plot the solution.

figure
Tmax = max(max(T));
Tmin = min(min(T));
for j = 1:nframes
    pdeplot(thermalmodel,'XYData',T(:,j),'ZData',T(:,j));
    caxis([Tmin Tmax]);
    axis([-1 1 -1 1 0 1]);
    Mv(j) = getframe;
end
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To play the animation, use the movie(Mv,1) command.
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Heat Distribution in Circular Cylindrical Rod
This example shows how to analyze a 3-D axisymmetric model by using a 2-D model.

The model geometry, material properties, and boundary conditions must all be symmetric
about a single axis for this simplification from 3-D to 2-D to be appropriate. Because of
this symmetry, a cylindrical coordinate system is the most convenient form for defining
the partial differential equation. However, Partial Differential Equation Toolbox™ expects
the equations in a Cartesian system. One of the main goals of this example is to show how
to express the PDE defined in a cylindrical system in a Cartesian form that Partial
Differential Equation Toolbox™ can handle.

This particular example shows heat transfer in a rod with a circular cross section. There
is a heat source at the left end of the rod and a fixed temperature at the right end. The
outer surface of the rod exchanges heat with the environment due to convection. In
addition, heat is generated within the rod due to radioactive decay.

We would like to calculate the temperature in the rod as a function of time. The parabolic
equation describing heat transfer is

ρC∂u∂t − ∇ ⋅ (k∇u) = q,

where \rho, C, andk are the density, specific heat, and thermal conductivity of the
material, respectively, u is the temperature, and q is the heat generated in the rod.

Since the problem is axisymmetric, it is convenient to write this equation in a cylindrical
coordinate system.

ρC∂u∂t −
1
r
∂
∂r kr ∂u∂r − 1

r2
∂
∂θ k∂u∂θ − ∂

∂z k∂u∂z = q,

where r, θ, and z are the three coordinate variables of the cylindrical system. Because the
problem is axisymmetric, ∂u/ ∂θ = 0 and after multiplying by r the equation can be
rewritten

rρC∂u∂t −
∂
∂r kr ∂u∂r − ∂

∂z kr ∂u∂z = rq .

The equation can be converted to the form supported by PDE Toolbox if r is defined as y
and z is defined as x. Rewriting the above equation gives
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ρCy∂u∂t − ∇ ⋅ (ky∇u) = qy .

Steady State Solution

In transient problems of this type it is often useful to first compute the steady state
solution-- the solution to the time-independent, elliptic equation. If the final time in the
transient analysis is sufficiently large, the transient solution at the final time should be
close to this steady state solution. This provides a valuable check on the accuracy of the
transient analysis.

Create a thermal model for steady-state analysis.

thermalModelS = createpde('thermal');

The 2-D model is a rectangular strip whose y-dimension extends from the axis of
symmetry to the outer surface and x-dimension extends over the actual length of the rod
(from -1.5 m to 1.5 m). The geometry and mesh for this rectangular section are easily
defined by specifying the x and y locations of the four corners as shown below.

g = decsg([3 4 -1.5 1.5 1.5 -1.5 0 0 .2 .2]');

Convert the geometry and append it to the thermal model.

geometryFromEdges(thermalModelS,g);

The rod is composed of a material with the following thermal properties.

k = 40; % thermal conductivity, W/(m-degree C)
rho = 7800; % density, kg/m^3
cp = 500; % specific heat, W-s/(kg-degree C)
q = 20000; % heat source, W/m^3

PDE Toolbox allows definition of the non-constant coefficients as function of spatial
coordinates and solution.

kFunc = @(region,state) k*region.y;
cFunc = @(region,state) cp*region.y;
qFunc = @(region,state) q*region.y;

For a steady-state analysis, specify the thermal conductivity of the material.

thermalProperties(thermalModelS,'ThermalConductivity',kFunc);

Specify internal heat source.
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internalHeatSource(thermalModelS,qFunc);

When defining boundary conditions below, it is necessary to know the edge numbers for
the boundary edges of the geometry. A convenient way to obtain these edge numbers is to
plot the geometry using pdegplot with option edgeLabels set to 'on'.

figure
pdegplot(thermalModelS,'EdgeLabels','on');
axis equal
xlim([-2 2]);
title 'Rod Section Geometry With Edge Labels Displayed';

Define the boundary conditions. Edge 1, which is the edge at y equal zero, is along the
axis of symmetry so there is no heat transferred in the direction normal to this edge. This
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boundary is modeled by the default as an insulated boundary. Edge 2 is kept at a constant
temperature T = 100 C. Boundary conditions for the edges 3 and 4 are functions of y.

thermalBC(thermalModelS,'Edge',2,'Temperature',100);

outerCC = @(region,~) 50*region.y;
thermalBC(thermalModelS,'Edge',3,...
                       'ConvectionCoefficient',outerCC,...
                       'AmbientTemperature',100);
                   
leftHF = @(region,~) 5000*region.y;
thermalBC(thermalModelS,'Edge',4,'HeatFlux',leftHF);

Generate the mesh.

generateMesh(thermalModelS,'Hmax',0.1);
figure; 
pdeplot(thermalModelS); 
axis equal
title 'Rod Section With Triangular Element Mesh'
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Solve the model and plot the result.

result = solve(thermalModelS);
T = result.Temperature;
figure; 
pdeplot(thermalModelS,'XYData',T,'Contour','on'); 
axis equal
title 'Steady State Temperature';
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Transient Solution

Create a thermal model for transient analysis, include the geometry, and mesh.

thermalModelT = createpde('thermal','transient');

g = decsg([3 4 -1.5 1.5 1.5 -1.5 0 0 .2 .2]');
geometryFromEdges(thermalModelT,g);

generateMesh(thermalModelT,'Hmax',0.1);

For a transient analysis, specify the thermal conductivity, mass density, specific heat of
the material.
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thermalProperties(thermalModelT,'ThermalConductivity',kFunc,...
                                'MassDensity',rho,...
                                'SpecificHeat',cFunc);

Specify internal heat source and boundary conditions.

internalHeatSource(thermalModelT,qFunc);

thermalBC(thermalModelT,'Edge',2,'Temperature',100);
thermalBC(thermalModelT,'Edge',3,...
                        'ConvectionCoefficient',outerCC,...
                        'AmbientTemperature',100);
thermalBC(thermalModelT,'Edge',4,'HeatFlux',leftHF);

Compute the transient solution for solution times from t = 0 to t = 20000 seconds. Initial
temperature in the rod is zero.

tfinal = 20000;
tlist = 0:100:tfinal;
thermalIC(thermalModelT,0);
thermalModelT.SolverOptions.ReportStatistics = 'on';

result = solve(thermalModelT,tlist);

114 successful steps
1 failed attempts
232 function evaluations
1 partial derivatives
22 LU decompositions
231 solutions of linear systems

T = result.Temperature;

Plot the solution at t = 20000.

figure; 
pdeplot(thermalModelT,'XYData',T(:,end),'Contour','on'); 
axis equal
title(sprintf('Transient Temperature at Final Time (%g seconds)',tfinal));
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The steady state solution and the transient solution at 20000 seconds are in close
agreement. This can be seen by comparing the two figures.

The third figure below shows the temperature at the left end of the rod as a function of
time. The outer surface of the rod is exposed to the environment with a constant
temperature of 100 degrees-C. Consequently, when the surface temperature of the rod is
less than 100, the rod is being heated by the environment and when greater than 100,
cooled. When the rod temperature is less than 100 degrees, the outer surface is slightly
warmer than the inner axis but when the temperature is around 100 degrees, the outer
surface becomes cooler than the interior of the rod.

Find nodes on the left end of the rod and on the center axis and outer surface using their
coordinate values.
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p = thermalModelT.Mesh.Nodes;
nodesLeftEnd  = find(p(1,:) < -1.5+eps);
nodeCenter = nodesLeftEnd(p(2,nodesLeftEnd) < eps);
nodeOuter = nodesLeftEnd(p(2,nodesLeftEnd) > 0.2-eps);

figure; 
plot(tlist,T(nodeCenter,:)); 
hold all 
plot(tlist,T(nodeOuter,:),'--');
title 'Temperature at Left End as a Function of Time'
xlabel 'Time, seconds'
ylabel 'Temperature, degrees-C'
grid on;
legend('Center Axis','Outer Surface','Location','SouthEast');
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Heat Distribution in Circular Cylindrical Rod: PDE
Modeler App

Solve a 3-D parabolic PDE problem by reducing the problem to 2-D using coordinate
transformation. This example uses the PDE Modeler app. For the command-line solution,
see “Heat Distribution in Circular Cylindrical Rod”.

Consider a cylindrical radioactive rod. Heat is continuously added at the left end of the
rod, while the right end is kept at a constant temperature. At the outer boundary, heat is
exchanged with the surroundings by transfer. At the same time, heat is uniformly
produced in the whole rod due to radioactive processes. Assuming that the initial
temperature is zero leads to the following equation:

ρC∂u∂t − ∇ · k∇u = q

Here, ρ, C, and k are the density, thermal capacity, and thermal conductivity of the
material, u is the temperature, and q is the heat generated in the rod.

Since the problem is axisymmetric, it is convenient to write this equation in a cylindrical
coordinate system.

ρC∂u∂t −
1
r
∂
∂r kr ∂u∂r − 1

r2
∂
∂θ k∂u∂θ − ∂

∂z k∂u∂z = q

Here r, θ, and  z are the three coordinate variables of the cylindrical system. Because the
problem is axisymmetric, ∂u/ ∂θ = 0.

This is a cylindrical problem, and Partial Differential Equation Toolbox requires equations
to be in Cartesian coordinates. To transform the equation to the Cartesian coordinates,
first multiply both sides of the equation by r:

ρrC∂u∂t −
∂
∂r kr ∂u∂r − ∂

∂z kr ∂u∂z = qr

Then define r as y and z as x:

ρyC∂u∂t − ∇ · ky∇u = qy

For this example, use these parameters:
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• Density, ρ = 7800 kg/m3

• Thermal capacity, C = 500 W·s/kg·ºC
• Thermal conductivity, k = 40 W/mºC
• Radioactive heat source, q = 20000 W/m3

• Temperature at the right end, T_right = 100 ºC
• Heat flux at the left end, HF_left = 5000 W/m2

• Surrounding temperature at the outer boundary, T_outer = 100 ºC
• Heat transfer coefficient, h_outer = 50 W/m2·ºC

To solve this problem in the PDE Modeler app, follow these steps:

1 Model the rod as a rectangle with corners in (-1.5,0), (1.5,0), (1.5,0.2), and (-1.5,0.2).
Here, the x-axis represents the z direction, and the y-axis represents the r direction.

pderect([-1.5,1.5,0,0.2])
2 Specify the boundary conditions. To do this, double-click the boundaries to open the

Boundary Condition dialog box. The PDE Modeler app requires boundary
conditions in a particular form. Thus, Neumann boundary conditions must be in the
form n · c∇u + qu = g, and Dirichlet boundary conditions must be in the form
hu = r. Also, because both sides of the equation are multiplied by r = y, multiply
coefficients for the boundary conditions by y.

• For the left end, use the Neumann condition n · k∇u = HF_lef t = 5000. Specify
g = 5000*y and q = 0.

• For the right end, use the Dirichlet condition u = T_right = 100. Specify h = 1
and r = 100.

• For the outer boundary, use the Neumann condition
n · k∇u = h_outer T_outer − u = 50 100 − u . Specify g = 50*y*100 and q =
50*y.

• The cylinder axis r  = 0 is not a boundary in the original problem, but in the 2-D
treatment it has become one. Use the artificial Neumann boundary condition for
the axis, n · k∇u = 0. Specify g = 0 and q = 0.

3 Specify the coefficients by selecting PDE > PDE Specification or click the PDE
button on the toolbar. Heat equation is a parabolic equation, so select the Parabolic
type of PDE. Because both sides of the equation are multiplied by r = y, multiply the
coefficients by y and enter the following values: c = 40*y, a = 0, f = 20000*y,
and d = 7800*500*y.
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4 Initialize the mesh by selecting Mesh > Initialize Mesh.
5 Set the initial value to 0, the solution time to 20000 seconds, and compute the

solution every 100 seconds. To do this, select Solve > Parameters. In the Solve
Parameters dialog box, set time to 0:100:20000, and u(t0) to 0.

6 Solve the equation by selecting Solve > Solve PDE or clicking the = button on the
toolbar.

7 Plot the solution, using the color and contour plot. To do this, select Plot >
Parameters and choose the color and contour plots in the resulting dialog box.
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You can explore the solution by varying the parameters of the model and plotting the
results. For example, you can:

• Show the solution when u does not depend on time, that is, the steady state solution.
To do this, open the PDE Specification dialog box, and change the PDE type to
Elliptic. The resulting steady state solution is in close agreement with the transient
solution at 20000 seconds.

• Show the steady state solution without cooling on the outer boundary: the heat
transfer coefficient is zero. To do this, set the Neumann boundary condition at the
outer boundary (the top side of the rectangle) to g = 0 and q = 0. The resulting plot
shows that the temperature rises to more than 2500 on the left end of the rod.
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Wave Equation on Square Domain
This example shows how to solve the wave equation using the solvepde function.

The standard second-order wave equation is

∂2u
∂t2 − ∇ ⋅ ∇u = 0 .

To express this in toolbox form, note that the solvepde function solves problems of the
form

m∂
2u
∂t2 − ∇ ⋅ (c∇u) + au = f .

So the standard wave equation has coefficients m = 1, c = 1, a = 0, and f = 0.

c = 1;
a = 0;
f = 0;
m = 1;

Solve the problem on a square domain. The squareg function describes this geometry.
Create a model object and include the geometry. Plot the geometry and view the edge
labels.

numberOfPDE = 1;
model = createpde(numberOfPDE);
geometryFromEdges(model,@squareg);
pdegplot(model,'EdgeLabels','on'); 
ylim([-1.1 1.1]);
axis equal
title 'Geometry With Edge Labels Displayed';
xlabel x
ylabel y
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Specify PDE coefficients.

specifyCoefficients(model,'m',m,'d',0,'c',c,'a',a,'f',f);

Set zero Dirichlet boundary conditions on the left (edge 4) and right (edge 2) and zero
Neumann boundary conditions on the top (edge 1) and bottom (edge 3).

applyBoundaryCondition(model,'dirichlet','Edge',[2,4],'u',0);
applyBoundaryCondition(model,'neumann','Edge',([1 3]),'g',0);

Create and view a finite element mesh for the problem.

generateMesh(model);
figure
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pdemesh(model);
ylim([-1.1 1.1]);
axis equal
xlabel x
ylabel y

Set the following initial conditions:

• u(x, 0) = arctan cos πx
2 .

• ∂u
∂t t = 0

= 3sin(πx)exp sin πy
2 .
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u0 = @(location) atan(cos(pi/2*location.x));
ut0 = @(location) 3*sin(pi*location.x).*exp(sin(pi/2*location.y));
setInitialConditions(model,u0,ut0);

This choice avoids putting energy into the higher vibration modes and permits a
reasonable time step size.

Specify the solution times as 31 equally-spaced points in time from 0 to 5.

n = 31;
tlist = linspace(0,5,n);

Set the SolverOptions.ReportStatistics of model to 'on'.

model.SolverOptions.ReportStatistics ='on';
result = solvepde(model,tlist);

459 successful steps
38 failed attempts
993 function evaluations
1 partial derivatives
114 LU decompositions
992 solutions of linear systems

u = result.NodalSolution;

Create an animation to visualize the solution for all time steps. Keep a fixed vertical scale
by first calculating the maximum and minimum values of u over all times, and scale all
plots to use those z-axis limits.

figure
umax = max(max(u));
umin = min(min(u));
for i = 1:n
    pdeplot(model,'XYData',u(:,i),'ZData',u(:,i),'ZStyle','continuous',...
                  'Mesh','off','XYGrid','on','ColorBar','off');
    axis([-1 1 -1 1 umin umax]); 
    caxis([umin umax]);
    xlabel x
    ylabel y
    zlabel u
    M(i) = getframe;
end
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To play the animation, use the movie(M) command.
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Wave Equation on Square Domain: PDE Modeler App
This example shows how to solve a wave equation for transverse vibrations of a
membrane on a square. The membrane is fixed at the left and right sides, and is free at
the upper and lower sides. This example uses the PDE Modeler app. For a programmatic
workflow, see “Wave Equation on Square Domain”.

A wave equation is a hyperbolic PDE:

∂2u
∂t2 − Δu = 0

To solve this problem in the PDE Modeler app, follow these steps:

1 Open the PDE Modeler app by using the pdeModeler command.
2 Display grid lines by selecting Options > Grid.
3 Align new shapes to the grid lines by selecting Options > Snap.
4 Draw a square with the corners at (-1,-1), (-1,1), (1,1), and (1,-1). To do this, first click

the  button. Then click one of the corners using the right mouse button and
drag to draw a square. The right mouse button constrains the shape you draw to be a
square rather than a rectangle.

You also can use the pderect function:

pderect([-1 1 -1 1])
5 Check that the application mode is set to Generic Scalar.
6 Specify the boundary conditions. To do this, switch to boundary mode by clicking the

 button or selecting Boundary > Boundary Mode. Select the left and right
boundaries. Then select Boundary > Specify Boundary Conditions and specify the
Dirichlet boundary condition u = 0. This boundary condition is the default one (h =
1, r = 0), so you do not need to change it.

For the bottom and top boundaries, set the Neumann boundary condition ∂u/∂n = 0.
To do this, set g = 0, q = 0.

7 Specify the coefficients by selecting PDEPDE Specification or clicking the PDE
button on the toolbar. Select the Hyperbolic type of PDE, and specify c = 1, a = 0,
f = 0, and d = 1.

3 Solving PDEs

3-248



8 Initialize the mesh by selecting Mesh > Initialize Mesh. Refine the mesh by
selecting Mesh > Refine Mesh.

9 Set the solution times. To do this, select Solve > Parameters. Create linearly spaced
time vector from 0 to 5 seconds by setting the solution time to linspace(0,5,31).

10 In the same dialog box, specify initial conditions for the wave equation. For a well-
behaved solution, the initial values must match the boundary conditions. If the initial
time is t = 0, then the following initial values that satisfy the boundary conditions:
atan(cos(pi/2*x)) for u(0) and 3*sin(pi*x).*exp(sin(pi/2*y)) for ∂u/∂t,

The inverse tangent function and exponential function introduce more modes into the
solution.

11 Solve the PDE by selecting Solve > Solve PDE or clicking the = button on the
toolbar. The app solves the heat equation at times from 0 to 5 seconds and displays
the result at the end of the time span.
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12 Visualize the solution as a 3-D static and animated plots. To do this:

a Select Plot > Parameters.
b In the resulting dialog box, select the Color and Height (3-D plot) options.
c To visualize the dynamic behavior of the wave, select Animation in the same

dialog box. If the animation progress is too slow, select the Plot in x-y grid
option. An x-y grid can speed up the animation process significantly.
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Eigenvalues and Eigenmodes of L-Shaped Membrane
This example shows how to calculate eigenvalues and eigenvectors using the
programmatic workflow. For the PDE Modeler app solution, see “Eigenvalues and
Eigenmodes of L-Shaped Membrane: PDE Modeler App” on page 3-257.

The eigenvalue problem is −Δu = λu. This example computes all eigenmodes with
eigenvalues smaller than 100.

Create a model and include this geometry. The geometry of the L-shaped membrane is
described in the file lshapeg.

model = createpde();
geometryFromEdges(model,@lshapeg);

Set zero Dirichlet boundary conditions on all edges.

applyBoundaryCondition(model,'dirichlet','Edge',1:model.Geometry.NumEdges,'u',0);

Specify the coefficients for the problem: d = 1 and c = 1. All other coefficients are equal
to zero.

specifyCoefficients(model,'m',0,'d',1,'c',1,'a',0,'f',0);

Set the interval [0 100] as the region for the eigenvalues in the solution.

r = [0 100];

Create a mesh and solve the problem.

generateMesh(model,'Hmax',0.05);
results = solvepdeeig(model,r);

              Basis= 10,  Time=   0.39,  New conv eig=  0
              Basis= 11,  Time=   0.39,  New conv eig=  0
              Basis= 12,  Time=   0.39,  New conv eig=  0
              Basis= 13,  Time=   0.39,  New conv eig=  0
              Basis= 14,  Time=   0.48,  New conv eig=  0
              Basis= 15,  Time=   0.48,  New conv eig=  0
              Basis= 16,  Time=   0.48,  New conv eig=  0
              Basis= 17,  Time=   0.55,  New conv eig=  0
              Basis= 18,  Time=   0.55,  New conv eig=  1
              Basis= 19,  Time=   0.55,  New conv eig=  1
              Basis= 20,  Time=   0.55,  New conv eig=  1
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              Basis= 21,  Time=   0.80,  New conv eig=  1
              Basis= 22,  Time=   0.80,  New conv eig=  3
              Basis= 23,  Time=   0.91,  New conv eig=  3
              Basis= 24,  Time=   0.91,  New conv eig=  4
              Basis= 25,  Time=   0.92,  New conv eig=  5
              Basis= 26,  Time=   0.92,  New conv eig=  6
              Basis= 27,  Time=   0.92,  New conv eig=  6
              Basis= 28,  Time=   1.03,  New conv eig=  6
              Basis= 29,  Time=   1.03,  New conv eig=  7
              Basis= 30,  Time=   1.09,  New conv eig=  7
              Basis= 31,  Time=   1.11,  New conv eig= 10
              Basis= 32,  Time=   1.11,  New conv eig= 10
              Basis= 33,  Time=   1.11,  New conv eig= 11
              Basis= 34,  Time=   1.11,  New conv eig= 11
              Basis= 35,  Time=   1.22,  New conv eig= 14
              Basis= 36,  Time=   1.30,  New conv eig= 14
              Basis= 37,  Time=   1.30,  New conv eig= 14
              Basis= 38,  Time=   1.31,  New conv eig= 14
              Basis= 39,  Time=   1.31,  New conv eig= 14
              Basis= 40,  Time=   1.56,  New conv eig= 14
              Basis= 41,  Time=   1.89,  New conv eig= 15
              Basis= 42,  Time=   1.89,  New conv eig= 15
              Basis= 43,  Time=   2.14,  New conv eig= 15
              Basis= 44,  Time=   2.14,  New conv eig= 16
              Basis= 45,  Time=   2.14,  New conv eig= 16
              Basis= 46,  Time=   2.17,  New conv eig= 16
              Basis= 47,  Time=   2.20,  New conv eig= 16
              Basis= 48,  Time=   2.20,  New conv eig= 17
              Basis= 49,  Time=   2.23,  New conv eig= 18
              Basis= 50,  Time=   2.39,  New conv eig= 18
              Basis= 51,  Time=   2.53,  New conv eig= 18
              Basis= 52,  Time=   2.53,  New conv eig= 18
              Basis= 53,  Time=   2.53,  New conv eig= 18
              Basis= 54,  Time=   2.69,  New conv eig= 21
End of sweep: Basis= 54,  Time=   2.69,  New conv eig= 21
              Basis= 31,  Time=   3.31,  New conv eig=  0
              Basis= 32,  Time=   3.33,  New conv eig=  0
              Basis= 33,  Time=   3.47,  New conv eig=  0
End of sweep: Basis= 33,  Time=   3.47,  New conv eig=  0

There are 19 eigenvalues smaller than 100.

length(results.Eigenvalues)

ans = 19
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Plot the first eigenmode and compare it to the MATLAB's membrane function. Multiply
the PDE solution by -1, so that the plots look similar instead of being inverted.

u = results.Eigenvectors;
pdeplot(model,'XYData',-u(:,1),'ZData',-u(:,1));

figure
membrane(1,20,9,9)
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Eigenvectors can be multiplied by any scalar and remain eigenvectors. This explains the
difference in scale that you see.

membrane can produce the first 12 eigenfunctions for the L-shaped membrane. Compare
the 12th eigenmodes.

figure 
pdeplot(model,'XYData',u(:,12),'ZData',u(:,12));
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figure 
membrane(12,20,9,9)
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Eigenvalues and Eigenmodes of L-Shaped Membrane:
PDE Modeler App

This example shows how to compute all eigenmodes with eigenvalues smaller than 100
for the eigenmode PDE problem

–Δu = λu

on the geometry of the L-shaped membrane. The boundary condition is the Dirichlet
condition u = 0. This example uses the PDE Modeler app. For a programmatic workflow,
see “Eigenvalues and Eigenmodes of L-Shaped Membrane” on page 3-251.

To solve this problem in the PDE Modeler app, follow these steps:

1 Draw a polygon with the corners (0,0), (–1,0), (–1,–1), (1,–1), (1,1), and (0,1) by using
the pdepoly function.

pdepoly([0,-1,-1,1,1,0],[0,0,-1,-1,1,1])

2 Check that the application mode is set to Generic Scalar.
3 Use the default Dirichlet boundary condition u = 0 for all boundaries. To verify it,

switch to boundary mode by selecting Boundary > Boundary Mode. Use Edit >
Select all to select all boundaries. Select Boundary > Specify Boundary
Conditions and verify that the boundary condition is the Dirichlet condition with h =
1, r = 0.

4 Specify the coefficients by selecting PDE > PDE Specification or clicking the PDE
button on the toolbar. This is an eigenvalue problem, so select the Eigenmodes type
of PDE. The general eigenvalue PDE is described by −∇ ⋅ c∇u + au = λdu. Thus, for
this problem, use the default coefficients c = 1, a = 0, and d = 1.

5 Specify the maximum edge size for the mesh by selecting Mesh > Parameters. Set
the maximum edge size value to 0.05.

6 Initialize the mesh by selecting Mesh > Initialize Mesh.
7 Specify the eigenvalue range by selecting Solve > Parameters. In the resulting

dialog box, use the default eigenvalue range [0 100].
8 Solve the PDE by selecting Solve > Solve PDE or clicking the = button on the

toolbar. By default, the app plots the first eigenfunction.
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9 Plot other eigenfunctions by selecting Plot > Parameters and then selecting the
corresponding eigenvalue from the drop-down list at the bottom of the dialog box.
For example, plot the fifth eigenfunction in the specified range.
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L-Shaped Membrane with Rounded Corner
This example shows how to compute all eigenvalues smaller than 100 and their
corresponding eigenvectors. Consider the eigenvalue problem

–Δu = λu

on an L-shaped membrane with a rounded inner corner. The boundary condition is the
Dirichlet condition u = 0.

To solve this problem in the PDE Modeler app, follow these steps:

1 Draw an L-shaped membrane as a polygon with the corners (0,0), (–1,0), (–1,–1), (1,–
1), (1,1), and (0,1) by using the pdepoly function.

pdepoly([0 -1 -1 1 1 0],[0 0 -1 -1 1 1])
2 Draw a circle and a square as follows.

pdecirc(-0.5,0.5,0.5,'C1') 
pderect([-0.5 0 0.5 0],'SQ1')

3 Model the geometry with the rounded corner by entering P1+SQ1-C1 in the Set
formula field.

4 Check that the application mode is set to Generic Scalar.
5 Remove unnecessary subdomain borders by selecting Boundary > Remove All

Subdomain Borders.
6 Use the default Dirichlet boundary condition u = 0 for all boundaries. To check the

boundary condition, switch to boundary mode by selecting Boundary > Boundary
Mode. Use Edit > Select all to select all boundaries. Select Boundary > Specify
Boundary Conditions and verify that the boundary condition is the Dirichlet
condition with h = 1, r = 0.

7 Specify the coefficients by selecting PDE > PDE Specification or clicking the PDE
button on the toolbar. This is an eigenvalue problem, so select the Eigenmodes as
the type of PDE. The general eigenvalue PDE is described by −∇ ⋅ c∇u + au = λdu.
Thus, for this problem, use the default coefficients c = 1, a = 0, and d = 1.

8 Specify the maximum edge size for the mesh by selecting Mesh > Parameters. Set
the maximum edge size value to 0.05.

9 Initialize the mesh by selecting Mesh > Initialize Mesh.
10 Specify the eigenvalue range by selecting Solve > Parameters. In the resulting

dialog box, use the default eigenvalue range [0 100].
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11 Solve the PDE by selecting Solve > Solve PDE or clicking the = button on the
toolbar. By default, the app plots the first eigenfunction as a color plot.

12 Plot the same eigenfunction as a contour plot. To do this:

a Select Plot > Parameters.
b Clear the Color option and select the Contour option.
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Eigenvalues and Eigenmodes of Square
This example shows how to compute the eigenvalues and eigenmodes of a square domain
using the programmatic workflow. For the PDE Modeler app solution, see “Eigenvalues
and Eigenmodes of Square: PDE Modeler App” on page 3-270.

The eigenvalue PDE problem is −Δu = λu. This example finds the eigenvalues smaller
than 10 and the corresponding eigenmodes.

Create a model. Import and plot the geometry. The geometry description file for this
problem is called squareg.m.

model = createpde();
geometryFromEdges(model,@squareg);

pdegplot(model,'EdgeLabels','on')
ylim([-1.5,1.5])
axis equal
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Specify the Dirichlet boundary condition u = 0 for the left boundary.

applyBoundaryCondition(model,'dirichlet','Edge',4,'u',0);

Specify the zero Neumann boundary condition for the upper and lower boundary.

applyBoundaryCondition(model,'neumann','Edge',[1,3],'g',0,'q',0);

Specify the generalized Neumann condition ∂u∂n −
3
4u = 0 for the right boundary.

applyBoundaryCondition(model,'neumann','Edge',2,'g',0,'q',-3/4);

The eigenvalue PDE coefficients for this problem are c = 1, a = 0, and d = 1. You can
enter the eigenvalue range r as the vector [-Inf 10].
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specifyCoefficients(model,'m',0,'d',1,'c',1,'a',0,'f',0);
r = [-Inf,10];

Create a mesh and solve the problem.

generateMesh(model,'Hmax',0.05);
results = solvepdeeig(model,r);

              Basis= 10,  Time=   1.11,  New conv eig=  0
              Basis= 11,  Time=   1.11,  New conv eig=  0
              Basis= 12,  Time=   1.14,  New conv eig=  1
              Basis= 13,  Time=   1.14,  New conv eig=  1
              Basis= 14,  Time=   1.28,  New conv eig=  1
              Basis= 15,  Time=   1.36,  New conv eig=  1
              Basis= 16,  Time=   1.36,  New conv eig=  1
              Basis= 17,  Time=   1.45,  New conv eig=  1
              Basis= 18,  Time=   1.45,  New conv eig=  2
              Basis= 19,  Time=   1.58,  New conv eig=  2
              Basis= 20,  Time=   1.58,  New conv eig=  2
              Basis= 21,  Time=   1.72,  New conv eig=  3
              Basis= 22,  Time=   1.86,  New conv eig=  3
              Basis= 23,  Time=   1.86,  New conv eig=  4
              Basis= 24,  Time=   1.88,  New conv eig=  6
End of sweep: Basis= 24,  Time=   1.88,  New conv eig=  3
              Basis= 13,  Time=   2.22,  New conv eig=  0
              Basis= 14,  Time=   2.22,  New conv eig=  0
              Basis= 15,  Time=   2.22,  New conv eig=  0
              Basis= 16,  Time=   2.22,  New conv eig=  0
              Basis= 17,  Time=   2.34,  New conv eig=  0
              Basis= 18,  Time=   2.44,  New conv eig=  0
              Basis= 19,  Time=   2.44,  New conv eig=  0
              Basis= 20,  Time=   2.44,  New conv eig=  0
              Basis= 21,  Time=   2.45,  New conv eig=  0
              Basis= 22,  Time=   2.45,  New conv eig=  1
              Basis= 23,  Time=   2.70,  New conv eig=  2
End of sweep: Basis= 23,  Time=   2.70,  New conv eig=  0
              Basis= 13,  Time=   2.75,  New conv eig=  1
End of sweep: Basis= 13,  Time=   2.75,  New conv eig=  1
              Basis= 14,  Time=   2.95,  New conv eig=  0
              Basis= 15,  Time=   2.95,  New conv eig=  0
              Basis= 16,  Time=   3.00,  New conv eig=  0
              Basis= 17,  Time=   3.08,  New conv eig=  0
              Basis= 18,  Time=   3.08,  New conv eig=  0
              Basis= 19,  Time=   3.23,  New conv eig=  0
              Basis= 20,  Time=   3.23,  New conv eig=  0
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              Basis= 21,  Time=   3.31,  New conv eig=  0
              Basis= 22,  Time=   3.33,  New conv eig=  0
              Basis= 23,  Time=   3.33,  New conv eig=  1
End of sweep: Basis= 23,  Time=   3.33,  New conv eig=  0
              Basis= 14,  Time=   3.66,  New conv eig=  1
End of sweep: Basis= 14,  Time=   3.66,  New conv eig=  1
              Basis= 15,  Time=   3.97,  New conv eig=  0
              Basis= 16,  Time=   3.97,  New conv eig=  0
              Basis= 17,  Time=   4.09,  New conv eig=  0
End of sweep: Basis= 17,  Time=   4.09,  New conv eig=  0

There are six eigenvalues smaller than 10 for this problem.

l = results.Eigenvalues

l = 5×1

   -0.4146
    2.0528
    4.8019
    7.2693
    9.4550

Plot the first and last eigenfunctions in the specified range.

u = results.Eigenvectors;
pdeplot(model,'XYData',u(:,1));
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pdeplot(model,'XYData',u(:,length(l)));
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This problem is separable, meaning

u(x, y) = f (x)g(y) .

The functions f and g are eigenfunctions in the x and y directions, respectively. In the x
direction, the first eigenmode is a slowly increasing exponential function. The higher
modes include sinusoids. In the y direction, the first eigenmode is a straight line
(constant), the second is half a cosine, the third is a full cosine, the fourth is one and a
half full cosines, etc. These eigenmodes in the y direction are associated with the
eigenvalues

0, π2

4 , 4π2

4 , 9π2

4 , . . .
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It is possible to trace the preceding eigenvalues in the eigenvalues of the solution.
Looking at a plot of the first eigenmode, you can see that it is made up of the first
eigenmodes in the x and y directions. The second eigenmode is made up of the first
eigenmode in the x direction and the second eigenmode in the y direction.

Look at the difference between the first and the second eigenvalue compared to π2/4:

l(2) - l(1) - pi^2/4

ans = 1.6751e-07

Likewise, the fifth eigenmode is made up of the first eigenmode in the x direction and the
third eigenmode in the y direction. As expected, l(5)-l(1) is approximately equal to π2:

l(5) - l(1) - pi^2

ans = 6.2135e-06

You can explore higher modes by increasing the search range to include eigenvalues
greater than 10.
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Eigenvalues and Eigenmodes of Square: PDE Modeler
App

This example shows how to compute the eigenvalues and eigenmodes of a square with the
corners (-1,-1), (-1,1), (1,1), and (1,-1). This example uses the PDE Modeler app. For
programmatic workflow, see “Eigenvalues and Eigenmodes of Square” on page 3-263.

The eigenvalue PDE problem is −Δu = λu. Find the eigenvalues smaller than 10 and the
corresponding eigenmodes.

To solve this problem in the PDE Modeler app, follow these steps:

1 Draw a square with the corners (-1,-1), (-1,1), (1,1), and (1,-1) by using the pderect
function.

pderect([-1 1 -1 1])
2 Check that the application mode is set to Generic Scalar.
3 Specify the boundary conditions. To do this, switch to the boundary mode by

selecting Boundary > Boundary Mode. Double-click the boundary to specify the
boundary condition.

• Specify the Dirichlet condition u = 0 for the left boundary. To do this, specify h =
1, r = 0.

• Specify the Neumann condition ∂u∂n = 0 for the upper and lower boundary. To do
this, specify g = 0, q = 0.

• Specify the generalized Neumann condition ∂u∂n −
3
4u = 0 for the right boundary.

To do this, specify g = 0, q = -3/4.
4 Specify the coefficients by selecting PDE > PDE Specification or clicking the PDE

button on the toolbar. This is a eigenvalue problem, so select the Eigenmodes type
of PDE. The general eigenvalue PDE is described by −∇ ⋅ c∇u + au = λdu. Thus, for
this problem, the coefficients are c = 1, a = 0, and d = 1.

5 Specify the maximum edge size for the mesh by selecting Mesh > Parameters. Set
the maximum edge size value to 0.05.

6 Initialize the mesh by selecting Mesh > Initialize Mesh.
7 Specify the eigenvalue range by selecting Solve > Parameters. In the resulting

dialog box, enter the eigenvalue range as the MATLAB vector [-Inf 10].
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8 Solve the PDE by selecting Solve > Solve PDE or clicking the = button on the
toolbar. By default, the app plots the first eigenfunction.

9 Plot other eigenfunctions by selecting Plot > Parameters and then selecting the
corresponding eigenvalue from the drop-down list at the bottom of the dialog box.
For example, plot the last eigenfunction in the specified range.

 Eigenvalues and Eigenmodes of Square: PDE Modeler App

3-271



10 Export the eigenfunctions and eigenvalues to the MATLAB workspace by using the
Solve > Export Solution.
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Vibration of Circular Membrane
This example shows how to calculate the vibration modes of a circular membrane by
using the MATLAB eigs function.

The calculation of vibration modes requires the solution of the eigenvalue partial
differential equation (PDE). In this example the solution of the eigenvalue problem is
performed using both the PDE Toolbox's solvepdeeig solver and the core MATLAB's
eigs eigensolver.

The main objective of this example is to show how eigs can be used with PDE Toolbox.
Generally, the eigenvalues calculated by solvepdeeig and eigs are practically identical.
However, sometimes, it is simply more convenient to use eigs than solvepdeeig. One
example of this is when it is desired to calculate a specified number of eigenvalues in the
vicinity of a user-specified target value. solvepdeeig requires that a lower and upper
bound surrounding this target value be specified. eigs requires only that the target
eigenvalue and the desired number of eigenvalues be specified.

Create a PDE model.

numberOfPDE = 1;
model = createpde(numberOfPDE);

Create a geometry object and include it in the PDE model. The geometry is a circle.

radius = 2;
g = decsg([1 0 0 radius]','C1',('C1')');

geometryFromEdges(model,g);

Plot the geometry and display the edge labels.

figure; 
pdegplot(model,'EdgeLabels','on'); 
axis equal
title 'Geometry With Edge Labels Displayed';
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Specify the coefficients.

c = 1e2;
a = 0;
f = 0;
d = 10;
specifyCoefficients(model,'m',0,'d',d,'c',c,'a',a,'f',f);

Specify the boundary conditions: the solution is zero at all four outer edges of the circle.

bOuter = applyBoundaryCondition(model,'dirichlet','Edge',(1:4),'u',0);

Generate a mesh.

generateMesh(model,'Hmax',0.2);
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Use assembleFEMatrices to calculate the global finite element mass and stiffness
matrices with boundary conditions imposed using nullspace approach.

FEMatrices = assembleFEMatrices(model,'nullspace');
K = FEMatrices.Kc;
B = FEMatrices.B;
M = FEMatrices.M;

Solve the eigenvalue problem by using the eigs function.

sigma = 1e2; 
numberEigenvalues = 5;
[eigenvectorsEigs,eigenvaluesEigs] = eigs(K,M,numberEigenvalues,sigma);

Reshape the diagonal eigenvaluesEigs matrix into a vector.

eigenvaluesEigs = diag(eigenvaluesEigs);

Find the largest eigenvalue and its index in the eigenvalues vector.

[maxEigenvaluesEigs, maxIndex] = max(eigenvaluesEigs);

Transform the eigenvectors with constrained equations removed to the full eigenvector
including constrained equations.

eigenvectorsEigs = B*eigenvectorsEigs;

Solve the eigenvalue problem by using the solvepdeeig function. Set the range for
solvepdeeig to be slightly larger than the range from eigs.

r = [min(eigenvaluesEigs)*.99 max(eigenvaluesEigs)*1.01];
result = solvepdeeig(model,r);

              Basis= 10,  Time=   0.27,  New conv eig=  0
              Basis= 13,  Time=   0.27,  New conv eig=  2
              Basis= 16,  Time=   0.30,  New conv eig=  2
              Basis= 19,  Time=   0.31,  New conv eig=  2
              Basis= 22,  Time=   0.33,  New conv eig=  3
              Basis= 25,  Time=   0.47,  New conv eig=  3
              Basis= 28,  Time=   0.47,  New conv eig=  5
End of sweep: Basis= 28,  Time=   0.47,  New conv eig=  5
              Basis= 15,  Time=   0.53,  New conv eig=  0
End of sweep: Basis= 15,  Time=   0.55,  New conv eig=  0

eigenvectorsPde = result.Eigenvectors;
eigenvaluesPde = result.Eigenvalues;
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Compare the Solutions Computed by eigs and solvepdeeig.

eigenValueDiff = sort(eigenvaluesPde) - sort(eigenvaluesEigs);
fprintf('Maximum difference in eigenvalues from solvepdeeig and eigs: %e\n', ...
  norm(eigenValueDiff,inf));

Maximum difference in eigenvalues from solvepdeeig and eigs: 5.258016e-13

As you can see, both functions calculate the same eigenvalues. For any eigenvalue, the
eigenvector can be multiplied by an arbitrary scalar. The eigs and solvepdeeig
functions choose a different arbitrary scalar for normalizing their eigenvectors as shown
in the figure below.

h = figure;
h.Position = [1 1 2 1].*h.Position;
subplot(1,2,1); 
axis equal
pdeplot(model,'XYData', eigenvectorsEigs(:,maxIndex),'Contour','on');
title(sprintf('eigs eigenvector, eigenvalue: %12.4e', eigenvaluesEigs(maxIndex)));
xlabel('x'); 
ylabel('y');
subplot(1,2,2); 
axis equal
pdeplot(model,'XYData',eigenvectorsPde(:,end),'Contour','on');
title(sprintf('solvepdeeig eigenvector, eigenvalue: %12.4e',eigenvaluesPde(end)));
xlabel('x'); 
ylabel('y');
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Solve PDEs Programmatically

Note THIS PAGE DESCRIBES AN ALTERNATIVE LEGACY WORKFLOW
APPLICABLE ONLY FOR 2-D PROBLEMS. For the recommended workflow, see “Solve
Problems Using PDEModel Objects” on page 2-6. The workflow described on this page is
an alternative to the legacy workflow described in “Solve Problems Using Legacy
PDEModel Objects” on page 2-3.

When You Need Programmatic Solutions
Although the PDE Modeler app provides a convenient working environment, there are
situations where the flexibility of using the command-line functions is needed. These
include:

• 3-D geometry
• Geometrical shapes other than straight lines, circular arcs, and elliptical arcs
• Nonstandard boundary conditions
• Complicated PDE or boundary condition coefficients
• More than two dependent variables in the system case
• Nonlocal solution constraints
• Special solution data processing and presentation itemize

The PDE Modeler app can still be a valuable aid in some of the situations presented
previously, if part of the modeling is done using the PDE Modeler app and then made
available for command-line use through the extensive data export facilities of the PDE
Modeler app.

Data Structures in Partial Differential Equation Toolbox
The process of defining your problem and solving it is reflected in the design of the PDE
Modeler app. A number of data structures define different aspects of the problem, and the
various processing stages produce new data structures out of old ones. See the following
figure.

The rectangles are functions, and ellipses are data represented by matrices or files.
Arrows indicate data necessary for the functions.
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As there is a definite direction in this diagram, you can cut into it by presenting the
needed data sets, and then continue downward. In the following sections, we give
pointers to descriptions of the precise formats of the various data structures and files.
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Constructive Solid Geometry Model

A Constructive Solid Geometry (CSG) model is specified by a Geometry Description
matrix, a set formula, and a Name Space matrix. For a description of these data
structures, see the reference page for decsg. At this level, the problem geometry is
defined by overlapping solid objects. These can be created by drawing the CSG model in
the PDE Modeler app and then exporting the data using the Export Geometry
Description, Set Formula, Labels option from the Draw menu.

Decomposed Geometry

A decomposed geometry is specified by either a Decomposed Geometry matrix, or by a
Geometry file. Here, the geometry is described as a set of disjoint minimal regions
bounded by boundary segments and border segments. A Decomposed Geometry matrix
can be created from a CSG model by using the function decsg. It can also be exported
from the PDE Modeler app by selecting the Export Decomposed Geometry, Boundary
Cond's option from the Boundary menu. A Geometry file equivalent to a given
Decomposed Geometry matrix can be created using the wgeom function. A decomposed
geometry can be visualized with the pdegplot function. For descriptions of the data
structures of the Decomposed Geometry matrix and Geometry file, see the reference page
for decsg and “Geometry”.

Boundary Conditions

These are specified by either a Boundary Condition matrix, or a Boundary file. Boundary
conditions are given as functions on boundary segments. A Boundary Condition matrix
can be exported from the PDE Modeler app by selecting the Export Decomposed
Geometry, Boundary Cond's option from the Boundary menu. For a description of the
data structures of the Boundary Condition matrix and Boundary file, see the reference
pages for assemb and see “Boundary Conditions”.

Equation Coefficients

The PDE is specified by either a Coefficient matrix or a Coefficient file for each of the PDE
coefficients c, a, f, and d. The coefficients are functions on the subdomains. Coefficients
can be exported from the PDE Modeler app by selecting the Export PDE Coefficient
option from the PDE menu. For the details on the equation coefficient data structures,
see the reference page for assempde, and see “PDE Coefficients”.

Mesh

A triangular mesh is described by the mesh data which consists of a Point matrix, an Edge
matrix, and a Triangle matrix. In the mesh, minimal regions are triangulated into
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subdomains, and border segments and boundary segments are broken up into edges.
Mesh data is created from a decomposed geometry by the function initmesh and can be
altered by the functions refinemesh and jigglemesh. The Export Mesh option from
the Mesh menu provides another way of creating mesh data. The adaptmesh function
creates mesh data as part of the solution process. The mesh may be plotted with the
pdemesh function. For details on the mesh data representation, see the reference page
for initmesh and see “Mesh Data” on page 2-233.

Solution

The solution of a PDE problem is represented by the solution vector. A solution gives the
value at each mesh point of each dependent variable, perhaps at several points in time, or
connected with different eigenvalues. Solution vectors are produced from the mesh, the
boundary conditions, and the equation coefficients by assempde, pdenonlin,
adaptmesh, parabolic, hyperbolic, and pdeeig. The Export Solution option from
the Solve menu exports solutions to the workspace. Since the meaning of a solution
vector is dependent on its corresponding mesh data, they are always used together when
a solution is presented. For details on solution vectors, see the reference page for
assempde.

Post Processing and Presentation

Given a solution/mesh pair, a variety of tools is provided for the visualization and
processing of the data. pdeintrp and pdeprtni can be used to interpolate between
functions defined at triangle nodes and functions defined at triangle midpoints. tri2grid
interpolates a functions from a triangular mesh to a rectangular grid. Use
pdeInterpolant and evaluate for more general interpolation. pdegrad and
pdecgrad compute gradients of the solution. pdeplot has a large number of options for
plotting the solution. pdecont and pdesurf are convenient shorthands for pdeplot.

Tips for Solving PDEs Programmatically
Use the export facilities of the PDE Modeler app as much as you can. They provide data
structures with the correct syntax, and these are good starting points that you can modify
to suit your needs.

Working with the system matrices and vectors produced by assema and assemb can
sometimes be valuable. When solving the same equation for different loads or boundary
conditions, it pays to assemble the stiffness matrix only once. Point loads on a particular
node can be implemented by adding the load to the corresponding row in the right side
vector. A nonlocal constraint can be incorporated into the H and R matrices.
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An example of a handwritten Coefficient file is circlef.m, which produces a point load.
You can find the full example in Poisson's Equation with Point Source and Adaptive Mesh
Refinement and on the assempde reference page.

The routines for adaptive mesh generation and solution are powerful but can lead to
dense meshes and thus long computation times. Setting the Ngen parameter to one limits
you to a single refinement step. This step can then be repeated to show the progress of
the refinement. The Maxt parameter helps you stop before the adaptive solver generates
too many triangles. An example of a handwritten triangle selection function is
circlepick, used in Poisson's Equation with Point Source and Adaptive Mesh
Refinement. Remember that you always need a decomposed geometry with adaptmesh.

Deformed meshes are easily plotted by adding offsets to the Point matrix p. Assuming two
variables stored in the solution vector u:

np = size(p,2); 
pdemesh(p+scale*[u(1:np) u(np+1:np+np)]',e,t)

The time evolution of eigenmodes is obtained by, e.g.,

u1 = u(:,mode)*cos(sqrt(l(mode))*tlist); % hyperbolic 

for positive eigenvalues in hyperbolic problems, or

u1 = u(:,mode)*exp(-l(mode)*tlist); % parabolic

in parabolic problems. This makes nice animations, perhaps together with deformed mesh
plots.
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Plot 2-D Solutions and Their Gradients
Plot Solutions Without Explicit Interpolation

To quickly visualize a 2-D scalar PDE solution, use the pdeplot function. This function lets
you plot the solution without explicitly interpolating the solution. For example, solve the
scalar elliptic problem −∇u = 1 on the L-shaped membrane with zero Dirichlet boundary
conditions and plot the solution.

Create the PDE model, 2-D geometry, and mesh. Specify boundary conditions and
coefficients. Solve the PDE problem.

model = createpde;
geometryFromEdges(model,@lshapeg);
applyBoundaryCondition(model,'dirichlet','edge',1:model.Geometry.NumEdges,'u',0);
c = 1;
a = 0;
f = 1;
specifyCoefficients(model,'m',0,'d',0,'c',c,'a',a,'f',f);
generateMesh(model);

results = solvepde(model);

Use pdeplot to plot the solution.

u = results.NodalSolution;
pdeplot(model,'XYData',u,'ZData',u,'Mesh','on')
xlabel('x')
ylabel('y')
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To get a smoother solution surface, specify the maximum size of the mesh triangles by
using the Hmax argument. Then solve the PDE problem using this new mesh, and plot the
solution again.

generateMesh(model,'Hmax',0.05);
results = solvepde(model);
u = results.NodalSolution;

pdeplot(model,'XYData',u,'ZData',u,'Mesh','on')
xlabel('x')
ylabel('y')
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Interpolate and Plot Solutions and Gradients

Alternatively, you can interpolate the solution and, if needed, its gradient in separate
steps, and then plot the results by using MATLAB™ functions, such as surf, mesh,
quiver, and so on. For example, solve the same scalar elliptic problem −Δu = 1 on the L-
shaped membrane with zero Dirichlet boundary conditions. Interpolate the solution and
its gradient, and then plot the results.

Create the PDE model, 2-D geometry, and mesh. Specify boundary conditions and
coefficients. Solve the PDE problem.

model = createpde;
geometryFromEdges(model,@lshapeg);
applyBoundaryCondition(model,'dirichlet','edge',1:model.Geometry.NumEdges,'u',0);
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c = 1;
a = 0;
f = 1;
specifyCoefficients(model,'m',0,'d',0,'c',c,'a',a,'f',f);
generateMesh(model,'Hmax',0.05);
results = solvepde(model);

Interpolate the solution and its gradients to a dense grid from -1 to 1 in each direction.

v = linspace(-1,1,101);
[X,Y] = meshgrid(v);
querypoints = [X(:),Y(:)]';
uintrp = interpolateSolution(results,querypoints);

Plot the resulting solution on a mesh.

uintrp = reshape(uintrp,size(X));
mesh(X,Y,uintrp)
xlabel('x')
ylabel('y')
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Interpolate gradients of the solution to the grid from -1 to 1 in each direction. Plot the
result using quiver.

[gradx,grady] = evaluateGradient(results,querypoints);
figure
quiver(X(:),Y(:),gradx,grady)
xlabel('x')
ylabel('y')
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Zoom in to see more details. For example, restrict the range to [-0.2,0.2] in each
direction.

axis([-0.2 0.2 -0.2 0.2])
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Plot the solution and the gradients on the same range.

figure
h1 = meshc(X,Y,uintrp);
set(h1,'FaceColor','g','EdgeColor','b')
xlabel('x')
ylabel('y')
alpha(0.5)
hold on

Z = -0.05*ones(size(X));
gradz = zeros(size(gradx));

h2 = quiver3(X(:),Y(:),Z(:),gradx,grady,gradz);
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set(h2,'Color','r')
axis([-0.2,0.2,-0.2,0.2])

Slice of the solution plot along the line x = y.

figure
mesh(X,Y,uintrp)
xlabel('x')
ylabel('y')
alpha(0.25)
hold on

z = linspace(0,0.15,101);
Z = meshgrid(z);
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surf(X,X,Z')

view([-20 -45 15])
colormap winter

Plot the interpolated solution along the line.

figure
xq = v;
yq = v;
uintrp = interpolateSolution(results,xq,yq);

plot3(xq,yq,uintrp)
grid on

3 Solving PDEs

3-292



xlabel('x')
ylabel('y')

Interpolate gradients of the solution along the same line and add them to the solution
plot.

[gradx,grady] = evaluateGradient(results,xq,yq);

gradx = reshape(gradx,size(xq));
grady = reshape(grady,size(yq));

hold on
quiver(xq,yq,gradx,grady)
view([-20 -45 75])
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Plot 3-D Solutions and Their Gradients

Types of 3-D Solution Plots
There are several types of plots for solutions when you have 3-D geometry.

• Surface plot — Sometimes you want to examine the solution on the surface of the
geometry. For example, in a stress or strain calculation, the most interesting data can
appear on the geometry surface. For an example, see “Surface Plot” on page 3-295.

For a colored surface plot of a scalar solution, set the pdeplot3D colormapdata to
the solution u:

pdeplot3D(model,'ColorMapData',u)

• Plot on a 2-D slice — To examine the solution on the interior of the geometry, define a
2-D grid that intersects the geometry, and interpolate the solution onto the grid. For
examples, see “2-D Slices Through 3-D Geometry” on page 3-298 and “Contour Slices
Through 3-D Solution” on page 3-303. While these two examples show planar grid
slices, you can also slice on a curved grid.

• Streamline or quiver plots — Plot the gradient of the solution as streamlines or a
quiver. See “Plots of Gradients and Streamlines” on page 3-310.

• You can use any MATLAB plotting command to create 3-D plots. See “Techniques for
Visualizing Scalar Volume Data” (MATLAB) and “Visualizing Vector Volume Data”
(MATLAB).

For other plot types, see the pdeplot3D reference page.

Surface Plot
This example shows how to obtain a surface plot of a solution with 3-D geometry and N >
1.

Import a tetrahedral geometry to a model with N = 2 equations and view its faces.

model = createpde(2);
importGeometry(model,'Tetrahedron.stl');
pdegplot(model,'FaceLabels','on','FaceAlpha',0.5)
view(-40,24)
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Create a problem with zero Dirichlet boundary conditions on face 4.

applyBoundaryCondition(model,'dirichlet','face',4,'u',[0,0]);

Create coefficients for the problem, where f = [1;10] and c is a symmetric matrix in
6N form.

f = [1;10];
a = 0;
c = [2;0;4;1;3;8;1;0;2;1;2;4];
specifyCoefficients(model,'m',0,'d',0,'c',c,'a',a,'f',f);

Create a mesh for the solution.

generateMesh(model);
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Solve the problem.

results = solvepde(model);
u = results.NodalSolution;

Plot the two components of the solution.

pdeplot3D(model,'ColorMapData',u(:,1))
view(-175,4)
title('u(1)')

figure
pdeplot3D(model,'ColorMapData',u(:,2))
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view(-175,4)
title('u(2)')

2-D Slices Through 3-D Geometry
This example shows how to obtain plots from 2-D slices through a 3-D geometry.

The problem is

∂u
∂t − Δu = f
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on a 3-D slab with dimensions 10-by-10-by-1, where u = 0 at time t = 0, boundary
conditions are Dirichlet, and

f x, y, z = 1 + y + 10z2

Set Up and Solve the PDE

Define a function for the nonlinear f coefficient in the syntax as given in “f Coefficient for
specifyCoefficients” on page 2-97.

function bcMatrix = myfffun(region,state)

bcMatrix = 1+10*region.z.^2+region.y;

Import the geometry and examine the face labels.

model = createpde;
g = importGeometry(model,'Plate10x10x1.stl');
pdegplot(g,'FaceLabels','on','FaceAlpha',0.5)
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The faces are numbered 1 through 6.

Create the coefficients and boundary conditions.

c = 1;
a = 0;
d = 1;
f = @myfffun;
specifyCoefficients(model,'m',0,'d',d,'c',c,'a',a,'f',f);

applyBoundaryCondition(model,'dirichlet','face',1:6,'u',0);

Set a zero initial condition.

setInitialConditions(model,0);
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Create a mesh with sides no longer than 0.3.

generateMesh(model,'Hmax',0.3);

Set times from 0 through 0.2 and solve the PDE.

tlist = 0:0.02:0.2;
results = solvepde(model,tlist);

Plot Slices Through the Solution

Create a grid of (x,y,z) points, where x = 5, y ranges from 0 through 10, and z ranges
from 0 through 1. Interpolate the solution to these grid points and all times.

yy = 0:0.5:10;
zz = 0:0.25:1;
[YY,ZZ] = meshgrid(yy,zz);
XX = 5*ones(size(YY));
uintrp = interpolateSolution(results,XX,YY,ZZ,1:length(tlist));

The solution matrix uintrp has 11 columns, one for each time in tlist. Take the
interpolated solution for the second column, which corresponds to time 0.02.

usol = uintrp(:,2);

The elements of usol come from interpolating the solution to the XX, YY, and ZZ
matrices, which are each 5-by-21, corresponding to z-by-y variables. Reshape usol to
the same 5-by-21 size, and make a surface plot of the solution. Also make surface plots
corresponding to times 0.06, 0.10, and 0.20.

figure
usol = reshape(usol,size(XX));
subplot(2,2,1)
surf(usol)
title('t = 0.02')
zlim([0,1.5])
xlim([1,21])
ylim([1,5])

usol = uintrp(:,4);
usol = reshape(usol,size(XX));
subplot(2,2,2)
surf(usol)
title('t = 0.06')
zlim([0,1.5])

 Plot 3-D Solutions and Their Gradients

3-301



xlim([1,21])
ylim([1,5])

usol = uintrp(:,6);
usol = reshape(usol,size(XX));
subplot(2,2,3)
surf(usol)
title('t = 0.10')
zlim([0,1.5])
xlim([1,21])
ylim([1,5])

usol = uintrp(:,11);
usol = reshape(usol,size(XX));
subplot(2,2,4)
surf(usol)
title('t = 0.20')
zlim([0,1.5])
xlim([1,21])
ylim([1,5])
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Contour Slices Through 3-D Solution
This example shows how to create contour slices in various directions through a solution
in 3-D geometry.

Set Up and Solve the PDE

The problem is to solve Poisson's equation with zero Dirichlet boundary conditions for a
complicated geometry. Poisson's equation is

−∇ ⋅ ∇u = f .

Partial Differential Equation Toolbox™ solves equations in the form
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−∇ ⋅ ∇(cu) + au = f .

So you can represent the problem by setting c = 1 and a = 0. Arbitrarily set f = 10.

c = 1;
a = 0;
f = 10;

The first step in solving any 3-D PDE problem is to create a PDE Model. This is a
container that holds the number of equations, geometry, mesh, and boundary conditions
for your PDE. Create the model, then import the 'ForearmLink.stl' file and view the
geometry.

N = 1;
model = createpde(N);
importGeometry(model,'ForearmLink.stl');
pdegplot(model,'FaceAlpha',0.5)
view(-42,24)
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Specify PDE Coefficients

Include the PDE coefficients in model.

specifyCoefficients(model,'m',0,'d',0,'c',c,'a',a,'f',f);

Create zero Dirichlet boundary conditions on all faces.

applyBoundaryCondition(model,'dirichlet','Face',1:model.Geometry.NumFaces,'u',0);

Create a mesh and solve the PDE.

generateMesh(model);
result = solvepde(model);
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Plot the Solution as Contour Slices

Because the boundary conditions are u = 0 on all faces, the solution u is nonzero only in
the interior. To examine the interior, take a rectangular grid that covers the geometry
with a spacing of one unit in each coordinate direction.

[X,Y,Z] = meshgrid(0:135,0:35,0:61);

For plotting and analysis, create a PDEResults object from the solution. Interpolate the
result at every grid point.

V = interpolateSolution(result,X,Y,Z);
V = reshape(V,size(X));

Plot contour slices for various values of z.

figure
colormap jet
contourslice(X,Y,Z,V,[],[],0:5:60)
xlabel('x')
ylabel('y')
zlabel('z')
colorbar
view(-11,14)
axis equal
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Plot contour slices for various values of y.

figure
colormap jet
contourslice(X,Y,Z,V,[],1:6:31,[])
xlabel('x')
ylabel('y')
zlabel('z')
colorbar
view(-62,34)
axis equal

 Plot 3-D Solutions and Their Gradients

3-307



Save Memory by Evaluating As Needed

For large problems you can run out of memory when creating a fine 3-D grid.
Furthermore, it can be time-consuming to evaluate the solution on a full grid. To save
memory and time, evaluate only at the points you plot. You can also use this technique to
interpolate to tilted grids, or to other surfaces.

For example, interpolate the solution to a grid on the tilted plane 0 ≤ x ≤ 135, 0 ≤ y ≤ 35,
and z = x/10 + y/2. Plot both contours and colored surface data. Use a fine grid, with
spacing 0.2.

[X,Y] = meshgrid(0:0.2:135,0:0.2:35);
Z = X/10 + Y/2;
V = interpolateSolution(result,X,Y,Z);
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V = reshape(V,size(X));
figure
subplot(2,1,1)
contour(X,Y,V);
axis equal
title('Contour Plot on Tilted Plane')
xlabel('x')
ylabel('y')
colorbar
subplot(2,1,2)
surf(X,Y,V,'LineStyle','none');
axis equal
view(0,90)
title('Colored Plot on Tilted Plane')
xlabel('x')
ylabel('y')
colorbar
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Plots of Gradients and Streamlines
This example shows how to calculate the approximate gradients of a solution, and how to
use those gradients in a quiver plot or streamline plot.

The problem is the calculation of the mean exit time of a Brownian particle from a region
that contains absorbing (escape) boundaries and reflecting boundaries. For more
information, see Narrow escape problem. The PDE is Poisson's equation with constant
coefficients. The geometry is a simple rectangular solid. The solution u(x, y, z) represents
the mean time it takes a particle starting at position (x, y, z) to exit the region.
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Import and View the Geometry

model = createpde;
importGeometry(model,'Block.stl');
pdegplot(model,'FaceLabels','on','FaceAlpha',0.5)
view(-42,24)

Set Boundary Conditions

Set faces 1, 2, and 5 to be the places where the particle can escape. On these faces, the
solution u = 0. Keep the default reflecting boundary conditions on faces 3, 4, and 6.

applyBoundaryCondition(model,'dirichlet','Face',[1,2,5],'u',0);
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Create PDE Coefficients

The PDE is

−Δu = − ∇ ⋅ ∇u = 2

In Partial Differential Equation Toolbox™ syntax,

−∇ ⋅ c∇u + au = f

This equation translates to coefficients c = 1, a = 0, and f = 2. Enter the coefficients.

c = 1;
a = 0;
f = 2;
specifyCoefficients(model,'m',0,'d',0,'c',c','a',a,'f',f);

Create Mesh and Solve PDE

Initialize the mesh.

generateMesh(model);

Solve the PDE.

results = solvepde(model);

Examine the Solution in a Contour Slice Plot

Create a grid and interpolate the solution to the grid.

[X,Y,Z] = meshgrid(0:135,0:35,0:61);
V = interpolateSolution(results,X,Y,Z);
V = reshape(V,size(X));

Create a contour slice plot for five fixed values of the y-coordinate.

figure
colormap jet
contourslice(X,Y,Z,V,[],0:4:16,[])
xlabel('x')
ylabel('y')
zlabel('z')
xlim([0,100])
ylim([0,20])
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zlim([0,50])
axis equal
view(-50,22)
colorbar

The particle has the largest mean exit time near the point x, y, z = 100, 0, 0 .

Use Gradients for Quiver and Streamline Plots

Examine the solution in more detail by evaluating the gradient of the solution. Use a
rather coarse mesh so that you can see the details on the quiver and streamline plots.

[X,Y,Z] = meshgrid(1:9:99,1:3:20,1:6:50);
[gradx,grady,gradz] = evaluateGradient(results,X,Y,Z);
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Plot the gradient vectors. First reshape the approximate gradients to the shape of the
mesh.

gradx = reshape(gradx,size(X));
grady = reshape(grady,size(Y));
gradz = reshape(gradz,size(Z));

figure
quiver3(X,Y,Z,gradx,grady,gradz)
axis equal
xlabel 'x'
ylabel 'y'
zlabel 'z'
title('Quiver Plot of Estimated Gradient of Solution')
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Plot the streamlines of the approximate gradient. Start the streamlines from a sparser set
of initial points.

hold on
[sx,sy,sz] = meshgrid([1,46],1:6:20,1:12:50);
streamline(X,Y,Z,gradx,grady,gradz,sx,sy,sz)
title('Quiver Plot with Streamlines')
hold off

The streamlines show that small values of y and z give larger mean exit times. They also
show that the x-coordinate has a significant effect on u when x is small, but when x is
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greater than 40, the larger values have little effect on u. Similarly, when z is less than 20,
its values have little effect on u.

See Also

Related Examples
• “Solve Problems Using PDEModel Objects” on page 2-6
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Dimensions of Solutions, Gradients, and Fluxes
solvepde returns a StationaryResults or TimeDependentResults object whose
properties contain the solution and its gradient at the mesh nodes. You can interpolate
the solution and its gradient to other points in the geometry by using
interpolateSolution and evaluateGradient. You also can compute flux of the
solution at the mesh nodes and at arbitrary points by using evaluateCGradient.

Note solvepde does not compute components of flux of a PDE solution. To compute flux
of the solution at the mesh nodes, use evaluateCGradient.

solvepdeeig returns an EigenResults object whose properties contain the solution
eigenvectors calculated at the mesh nodes. You can interpolate the solution to other
points by using interpolateSolution.

The dimensions of the solution, its gradient, and flux of the solution depend on:

• The number of geometric evaluation points.

• For results returned by solvepde or solvepdeeig, this is the number of mesh
nodes.

• For results returned by interpolateSolution,evaluateGradient, and
evaluateCGradient this is the number of query points.

• The number of equations.

• For results returned by solvepde or solvepdeeig, this is the number of
equations in the system.

• For results returned by interpolateSolution,evaluateGradient, and
evaluateCGradient, this is the number of query equation indices.

• The number of times for a time-dependent problem or number of modes for an
eigenvalue problem.

• For results returned by solvepde, this is the number of solution times (specified
as an input to solvepde).

• For results returned by solvepdeeig, this is the number of eigenvalues.
• For results returned by interpolateSolution, evaluateGradient, and

evaluateCGradient, this is the number of query times for time-dependent
problems or query modes for eigenvalue problems.
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Suppose you have a problem in which:

• Np is the number of nodes in the mesh.
• Nt is the number of times for a time-dependent problem or number of modes for an

eigenvalue problem.
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• N is the number of equations in the system.

Suppose you also compute the solution, its gradient, or flux of the solution at other points
("query points") in the geometry by using interpolateSolution, evaluateGradient,
or evaluateCGradient, respectively. Here:

• Nqp is the number of query points.
• Nqt is the number of query times for a time-dependent problem or number of query

modes for an eigenvalue problem.
• Nq is the number of query equations indices.

The tables show how to index into the solution returned by solvepde or solvepdeeig,
where:

• iP contains the indices of nodes.
• iT contains the indices of times for a time-dependent problem or mode numbers for an

eigenvalue problem.
• iN contains the indices of equations.

The tables also show the dimensions of solutions, gradients, and flux of the solution at
nodal locations (returned by solvepde,solvepdeeig, and evaluateCGradient) and
the dimensions of interpolated solutions and gradients (returned by
interpolateSolution, evaluateGradient, and evaluateCGradient).

Stationary
PDE
problem

Access solution and components
of gradient

Size of
NodalSolution,
XGradients,
YGradients,
ZGradients, and
components of flux
at nodal points

Size of solution,
components of
gradient, and
components of flux
at query points

Scalar result.NodalSolution(iP)

result.XGradients(iP)

result.YGradients(iP)

result.ZGradients(iP)

Np-by-1 Nqp-by-1
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Stationary
PDE
problem

Access solution and components
of gradient

Size of
NodalSolution,
XGradients,
YGradients,
ZGradients, and
components of flux
at nodal points

Size of solution,
components of
gradient, and
components of flux
at query points

System,
N > 1

result.NodalSolution(iP,iN)

result.XGradients(iP,iN)

result.YGradients(iP,iN)

result.ZGradients(iP,iN)

Np-by-N Nqp-by-N

Time-
dependent
PDE
problem

Access solution and components
of gradient

Size of
NodalSolution,
XGradients,
YGradients,
ZGradients, and
components of flux
at nodal points

Size of solution,
components of
gradient, and
components of flux
at query points

Scalar result.NodalSolution(iP,iT)

result.XGradients(iP,iT)

result.YGradients(iP,iT)

result.ZGradients(iP,iT)

Np-by-Nt Nqp-by-Nqt

System,
N > 1

result.NodalSolution(iP,iN,i
T)

result.XGradients(iP,iN,iT)

result.YGradients(iP,iN,iT)

result.ZGradients(iP,iN,iT)

Np-by-N-by-Nt Nqp-by-Nq-by-Nqt
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PDE
eigenvalue
problem

Access eigenvectors Size of Eigenvectors Size of interpolated
eigenvectors

Scalar result.Eigenvectors(iP,iT) Np-by-Nt Nqp-by-Nqt
System,
N > 1

result.Eigenvectors(iP,iN,i
T)

Np-by-N-by-Nt Nqp-by-Nq-by-Nqt

See Also
EigenResults | StationaryResults | TimeDependentResults |
evaluateGradient | interpolateSolution | solvepde | solvepdeeig
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PDE Modeler App

You open the PDE Modeler app by entering pdeModeler at the command line. The main
components of the PDE Modeler app are the menus, the dialog boxes, and the toolbar.

• “Open the PDE Modeler App” on page 4-2
• “2-D Geometry Creation in PDE Modeler App” on page 4-3
• “Coefficients That Depend on Time and Space in the PDE Modeler App” on page 4-15
• “Specify Boundary Conditions in the PDE Modeler App” on page 4-21
• “Specify Mesh Parameters in the PDE Modeler App” on page 4-24
• “Adjust Solve Parameters in the PDE Modeler App” on page 4-26
• “Plot the Solution in the PDE Modeler App” on page 4-33
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Open the PDE Modeler App
You can open the PDE Modeler app using the Apps tab or typing the commands in the
MATLAB Command Window.

Use the Apps Tab

1 On the MATLAB Toolstrip, click the Apps tab.
2 On the Apps tab, click the down arrow at the end of the Apps section.
3 Under Math, Statistics and Optimization, click the PDE button.

Use Commands

• To open a blank PDE Modeler app window, type pdeModeler in the MATLAB
Command Window.

• To open the PDE Modeler app with a circle already drawn in it, type pdecirc in the
MATLAB Command Window.

• To open the PDE Modeler app with an ellipse already drawn in it, type pdeellip in
the MATLAB Command Window.

• To open the PDE Modeler app with a rectangle already drawn in it, type pderect in
the MATLAB Command Window.

• To open the PDE Modeler app with a polygon already drawn in it, type pdepoly in the
MATLAB Command Window.

You can use a sequence of drawing commands to create several basic shapes. For
example, the following commands create a circle, a rectangle, an ellipse, and a polygon:

pderect([-1.5,0,-1,0])
pdecirc(0,0,1)
pdepoly([-1,0,0,1,1,-1],[0,0,1,1,-1,-1])
pdeellip(0,0,1,0.3,pi)
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2-D Geometry Creation in PDE Modeler App

Create Basic Shapes
The PDE Modeler app lets you draw four basic shapes: a circle, an ellipse, a rectangle,
and a polygon. To draw a basic shape, use the Draw menu or one of the following buttons
on the toolbar. To cut, clear, copy, and paste the solid objects, use the Edit menu.

Draw a rectangle/square starting at a corner.

Using the left mouse button, drag to create a rectangle. Using the right mouse
button (or Ctrl+click), drag to create a square.
Draw a rectangle/square starting at the center.

Using the left mouse button, drag to create a rectangle. Using the right mouse
button (or Ctrl+click), drag to create a square.
Draw an ellipse/circle starting at the perimeter.

Using the left mouse button, drag to create an ellipse. Using the right mouse
button (or Ctrl+click), drag to create a circle.
Draw an ellipse/circle starting at the center.

Using the left mouse button, drag to create an ellipse. Using the right mouse
button (or Ctrl+click), drag to create a circle.
Draw a polygon.

Using the left mouse button, drag to create polygon edges. You can close the
polygon by pressing the right mouse button. Clicking at the starting vertex also
closes the polygon.

Alternatively, you can create a basic shape by typing one of the following commands in
the MATLAB Command Window:

• pdecirc draws a circle.
• pdeellip draws an ellipse.
• pderect draws a rectangle.
• pdepoly draws a polygon.
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These commands open the PDE Modeler app with the requested shape already drawn in
it. If the app is already open, these commands add the requested shape to the app
window without deleting any existing shapes.

You can use a sequence of drawing commands to create several basic shapes. For
example, these commands create a circle, a rectangle, an ellipse, and a polygon:

pderect([-1.5,0,-1,0])
pdecirc(0,0,1)
pdepoly([-1,0,0,1,1,-1],[0,0,1,1,-1,-1])
pdeellip(0,0,1,0.3,pi)

Select Several Shapes
• To select a single shape, click it using the left mouse button.
• To select several shapes and to deselect shapes, use Shift+click (or click using the

middle mouse button). Clicking outside of all shapes, deselects all shapes.
• To select all the intersecting shapes, click the intersection of these shapes.
• To select all shapes, use the Select All option from the Edit menu.

Rotate Shapes
To rotate a shape:

1 Select the shapes.
2 Select Rotate from the Draw menu.
3 In the resulting Rotate dialog box, enter the rotation angle in degrees. To rotate

counterclockwise, use positive values of rotation angles. To rotate clockwise, use
negative values.
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4 By default, the rotation center is the center-of-mass of the selected shapes. To use a
different rotation center, clear the Use center-of-mass option and enter a rotation
center (xc,yc) as a 1-by-2 vector, for example, [-0.4 0.3].

Create Complex Geometries
You can specify complex geometries by overlapping basic shapes. This approach is called
Constructive Solid Geometry (CSG). The PDE Modeler app lets you combine basic shapes
by using their unique names.

The app assigns a unique name to each shape. The names depend on the type of the
shape:

• For circles, the default names are C1, C2, C3, and so on.
• For ellipses, the default names are E1, E2, E3, and so on.
• For polygons, the default names are P1, P2, P3, and so on.
• For rectangles, the default names are R1, R2, R3, and so on.
• For squares, the default names are SQ1, SQ2, SQ3, and so on.

To change the name and parameters of a shape, first switch to the draw mode and then
double-click the shape. (Select Draw Mode from the Draw menu to switch to the draw
mode.) The resulting dialog box lets you change the name and parameters of the selected
shape. The name cannot contain spaces.
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Now you can combine basic shapes to create a complex geometry. To do this, use the Set
formula field located under the toolbar. Here you can specify a geometry by using the
names of basic shapes and the following operators:

• + is the set union operator.

For example, SQ1+C2 creates a geometry comprised of all points of the square SQ1
and all points of the circle C2.

• * is the set intersection operator.

For example, SQ1*C2 creates a geometry comprised of the points that belong to both
the square SQ1 and the circle C2.

• - is the set difference operator.

For example, SQ1-C2 creates a geometry comprised of the points of the square SQ1
that do not belong to the circle C2.

The operators + and * have the same precedence. The operator - has a higher
precedence. You can control the precedence by using parentheses. The resulting
geometrical model (called decomposed geometry) is the set of points for which the set
formula evaluates to true. By default, it is the union of all basic shapes.

Adjust Axes Limits and Grid
To adjust axes limits:
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• Select Axes Limits from the Options menu
• Specify the range of the x-axis and the y-axis as a 1-by-2 vector such as [-10 10]. If

you select Auto, the app uses automatic scaling for the corresponding axis.

• Apply the specified axes ranges by clicking Apply.
• Close the dialog box by clicking Close.

To add axis grid, the snap-to-grid feature, and zoom, use the Options menu. To adjust the
grid spacing:

• Select Grid Spacing from the Options menu.
• By default, the app uses automatic linear grid spacing. To enable editing the fields for

linear spacing and extra ticks, clear Auto.
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• Specify the grid spacing for the x-axis and y-axis. For example, change the default
linear spacing -1.5:0.5:1.5 to -1:0.2:1.

You also can add extra ticks to customize the grid and aid in drawing. To separate
extra tick entries, use spaces, commas, semicolons, or brackets.
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• Apply the specified grid spacing by clicking Apply.
• Close the dialog box by clicking Done.
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Create Geometry with Rounded Corners
1 Open the PDE Modeler app by using the pdeModeler command.
2 Display grid lines by selecting Options > Grid.
3 Align new shapes to the grid lines by selecting Options > Snap.
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4 Set the grid spacing for x-axis to -1.5:0.1:1.5 and for y-axis to -1:0.1:1. To do
this, select Options > Grid Spacing, clear the Auto checkboxes, and set the
corresponding ranges.

5 Draw a rectangle with the width 2, the height 1, and the top left corner at (–1,0.5). To

do this, first click the  button. Then click the point (–1,0.5) and drag to draw a
rectangle.

To edit the parameters of the rectangle, double-click it. In the resulting dialog box,
specify the exact parameters.

6 Draw four circles with the radius 0.2 and the centers at (–0.8,–0.3), (–0.8,0.3), (0.8,–

0.3), and (0.8,0.3).To do this, first click the  button. Then click the center of a
circle using the right mouse button and drag to draw a circle. The right mouse button
constrains the shape you draw to be a circle rather than an ellipse. If the circle is not
a perfect unit circle, then double-click it. In the resulting dialog box, specify the exact
center location and radius of the circle.

7 Add four squares with the side 0.2, one in each corner.
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8 Model the geometry with rounded corners by subtracting the small squares from the
rectangle, and then adding the circles. To do this, enter the following formula in the
Set formula field.

R1-(SQ1+SQ2+SQ3+SQ4)+C1+C2+C3+C4
9

Switch to the boundary mode by clicking the  button or selecting Boundary >
Boundary Mode. The CSG model is now decomposed using the set formula, and you
get a rectangle with rounded corners.
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10 Because of the intersection of the solid objects used in the initial CSG model, a
number of subdomain borders remain. They appear as gray lines. To remove these
borders, select Boundary > Remove All Subdomain Borders.
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Coefficients That Depend on Time and Space in the PDE
Modeler App

This example shows how to enter time- and coordinate-dependent coefficients in the PDE
Modeler app.

Solve the parabolic PDE,

d∂u∂t − ∇ ⋅ c∇u + au = f

with the following coefficients:

• d = 5
• a = 0
• f is a linear ramp up to 10, holds at 10, then ramps back down to 0:

f = 10 *
10t 0 ≤ t ≤ 0.1
1 0.1 ≤ t ≤ 0.9
10 − 10t 0.9 ≤ t ≤ 1

• c = 1 +.x2 + y2

To solve this equation in the PDE Modeler app, follow these steps:

1 Write the file framp.m and save it on your MATLAB path.

function f = framp(t)

if t <= 0.1
    f = 10*t;
elseif t <= 0.9
    f = 1;
else
    f = 10-10*t;
end
f = 10*f;

2 Open the PDE Modeler app by using the pdeModeler command.
3 Display grid lines by selecting Options > Grid.
4 Align new shapes to the grid lines by selecting Options > Snap.
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5 Draw a rectangle with the corners at (-1,-0.4), (-1,0.4), (1,0.4), and (1,-0.4). To do this,

first click the  button. Then click one of the corners using the left mouse button
and drag to draw a rectangle.

6 Draw a circle with the radius 0.2 and the center at (0.5,0). To do this, first click the

 button. Then right-click the origin and drag to draw a circle. Right-clicking
constrains the shape you draw so that it is a circle rather than an ellipse. If the circle
is not a perfect unit circle, double-click it. In the resulting dialog box, specify the
exact center location and radius of the circle.

7 Model the geometry by entering R1-C1 in the Set formula field.
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8 Check that the application mode is set to Generic Scalar.
9 Specify the boundary conditions. To do this, switch to the boundary mode by

selecting Boundary > Boundary Mode. Use Shift+click to select several
boundaries. Then select Boundary > Specify Boundary Conditions.

• For the rectangle, use the Dirichlet boundary condition with h = 1 and r =
t*(x-y).

• For the circle, use the Neumann boundary condition with g = x.^2+y.^2 and q
= 1.

10 Specify the coefficients by selecting PDE > PDE Specification or clicking the PDE
button on the toolbar. Select the Parabolic type of PDE. Specify c = 1+x.^2+y.^2,
a = 0, f = framp(t), and d = 5.

Note Do not include quotes or spaces when you specify your coefficients the PDE
Modeler app. The parser interprets all inputs as vectors of characters. It can
misinterpret a space as a vector separator, as when a MATLAB vector uses a space to
separate elements of a vector.

11 Initialize the mesh by selecting Mesh > Initialize Mesh.
12 Refine the mesh twice by selecting Mesh > Refine Mesh.
13 Improve the triangle quality by selecting Mesh > Jiggle Mesh.
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14 Set the initial value and the solution time. To do this, select Solve > Parameters.

In the resulting dialog box, set the time to linspace(0,1,50) and the initial value
u(t0) to 0.

15 Solve the equation by selecting Solve > Solve PDE or clicking the = button on the
toolbar.
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16 Visualize the solution as a 3-D static plot. To do this:

a Select Plot > Parameters.
b In the resulting dialog box, select the Color and Height (3-D plot) options.
c Select the Show mesh option.
d Change the colormap to jet by using the corresponding drop-down menu in the

same dialog box.
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See Also

Related Examples
• “Coefficients for Scalar PDEs in PDE Modeler App” on page 2-77
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Specify Boundary Conditions in the PDE Modeler App

Select Boundary Mode from the Boundary menu or click the  button. Then
select a boundary or multiple boundaries for which you are specifying the conditions.
Note that no if you do not select any boundaries, then the specified conditions apply to all
boundaries.

• To select a single boundary, click it using the left mouse button.
• To select several boundaries and to deselect them, use Shift+click (or click using the

middle mouse button).
• To select all boundaries, use the Select All option from the Edit menu.

Select Specify Boundary Conditions from the Boundary menu.

Specify Boundary Conditions opens a dialog box where you can specify the boundary
condition for the selected boundary segments. There are three different condition types:

• Generalized Neumann conditions, where the boundary condition is determined by the
coefficients q and g according to the following equation:

n · c∇u + qu = g .

In the system cases, q is a 2-by-2 matrix and g is a 2-by-1 vector.
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• Dirichlet conditions: u is specified on the boundary. The boundary condition equation
is hu = r, where h is a weight factor that can be applied (normally 1).

In the system cases, h is a 2-by-2 matrix and r is a 2-by-1 vector.
• Mixed boundary conditions (system cases only), which is a mix of Dirichlet and

Neumann conditions. q is a 2-by-2 matrix, g is a 2-by-1 vector, h is a 1-by-2 vector, and
r is a scalar.

The following figure shows the dialog box for the generic system PDE (Options >
Application > Generic System).

For boundary condition entries you can use the following variables in a valid MATLAB
expression:

• The 2-D coordinates x and y.
• A boundary segment parameter s, proportional to arc length. s is 0 at the start of the

boundary segment and increases to 1 along the boundary segment in the direction
indicated by the arrow.

• The outward normal vector components nx and ny. If you need the tangential vector, it
can be expressed using nx and ny since tx = –ny and ty = nx.
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• The solution u.
• The time t.

Note If the boundary condition is a function of the solution u, you must use the nonlinear
solver. If the boundary condition is a function of the time t, you must choose a parabolic
or hyperbolic PDE.

Examples: (100-80*s).*nx, and cos(x.^2)

In the nongeneric application modes, the Description column contains descriptions of
the physical interpretation of the boundary condition parameters.
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Specify Mesh Parameters in the PDE Modeler App
Select Parameters from the Mesh menu to open the following dialog box containing
mesh generation parameters.
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The parameters used by the mesh initialization algorithm are:

• Maximum edge size: Largest triangle edge length (approximately). This parameter is
optional and must be a real positive number.

• Mesh growth rate: The rate at which the mesh size increases away from small parts
of the geometry. The value must be between 1 and 2. The default value is 1.3, i.e., the
mesh size increases by 30%.

• Mesher version: Choose the geometry triangulation algorithm. R2013a is faster, and
can mesh more geometries. preR2013a gives the same mesh as previous toolbox
versions.

• Jiggle mesh: Toggles automatic jiggling of the initial mesh on/off.

The parameters used by the mesh jiggling algorithm are:

• Jiggle mode: Select a jiggle mode from a pop-up menu. Available modes are on,
optimize minimum, and optimize mean. on jiggles the mesh once. Using the jiggle
mode optimize minimum, the jiggling process is repeated until the minimum
triangle quality stops increasing or until the iteration limit is reached. The same
applies for the optimize mean option, but it tries to increase the mean triangle
quality.

• Number of jiggle iterations: Iteration limit for the optimize minimum and
optimize mean modes. Default: 20.

For the mesh refinement algorithm refinemesh, the Refinement method can be
regular or longest. The default refinement method is regular, which results in a
uniform mesh. The refinement method longest always refines the longest edge on each
triangle.

To initialize a triangular mesh, select Initialize Mesh from the Mesh menu or click the

 button. To refine a mesh, select Refine Mesh from the Mesh menu or click the

 button.
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Adjust Solve Parameters in the PDE Modeler App
To specify parameters for solving a PDE, select Parameters from the Solve menu. The
set of solve parameters differs depending on the type of PDE. After you adjust the
parameters, solve the PDE by selecting Solve PDE from the Solve menu or by clicking

the  button.
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Elliptic Equations

By default, no specific solve parameters are used, and the elliptic PDEs are solved using
the basic elliptic solver assempde. Optionally, the adaptive mesh generator and solver
adaptmesh can be used. For the adaptive mode, the following parameters are available:

• Adaptive mode. Toggle the adaptive mode on/off.
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• Maximum number of triangles. The maximum number of new triangles allowed
(can be set to Inf). A default value is calculated based on the current mesh.

• Maximum number of refinements. The maximum number of successive refinements
attempted.

• Triangle selection method. There are two triangle selection methods, described
below. You can also supply your own function.

• Worst triangles. This method picks all triangles that are worse than a fraction of
the value of the worst triangle (default: 0.5).

• Relative tolerance. This method picks triangles using a relative tolerance
criterion (default: 1E-3).

• User-defined function. Enter the name of a user-defined triangle selection
method. See Poisson's Equation with Point Source and Adaptive Mesh Refinement
for an example of a user-defined triangle selection method.

• Function parameter. The function parameter allows fine-tuning of the triangle
selection methods. For the worst triangle method (pdeadworst), it is the fraction of
the worst value that is used to determine which triangles to refine. For the relative
tolerance method, it is a tolerance parameter that controls how well the solution fits
the PDE.

• Refinement method. Can be regular or longest. See “Specify Mesh Parameters in
the PDE Modeler App” on page 4-24.

If the problem is nonlinear, i.e., parameters in the PDE are directly dependent on the
solution u, a nonlinear solver must be used. The following parameters are used:

• Use nonlinear solver. Toggle the nonlinear solver on/off.
• Nonlinear tolerance. Tolerance parameter for the nonlinear solver.
• Initial solution. An initial guess. Can be a constant or a function of x and y given as a

MATLAB expression that can be evaluated on the nodes of the current mesh.

Examples: 1, and exp(x.*y). Optional parameter, defaults to zero.
• Jacobian. Jacobian approximation method: fixed (the default), a fixed point iteration,

lumped, a “lumped” (diagonal) approximation, or full, the full Jacobian.
• Norm. The type of norm used for computing the residual. Enter as energy for an

energy norm, or as a real scalar p to give the lp norm. The default is Inf, the infinity
(maximum) norm.
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Note The adaptive mode and the nonlinear solver can be used together.

Parabolic Equations

The solve parameters for the parabolic PDEs are:

• Time. A MATLAB vector of times at which a solution to the parabolic PDE should be
generated. The relevant time span is dependent on the dynamics of the problem.

Examples: 0:10, and logspace(-2,0,20)
• u(t0). The initial value u(t0) for the parabolic PDE problem The initial value can be a

constant or a column vector of values on the nodes of the current mesh.
• Relative tolerance. Relative tolerance parameter for the ODE solver that is used for

solving the time-dependent part of the parabolic PDE problem.
• Absolute tolerance. Absolute tolerance parameter for the ODE solver that is used for

solving the time-dependent part of the parabolic PDE problem.
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Hyperbolic Equations

The solve parameters for the hyperbolic PDEs are:

• Time. A MATLAB vector of times at which a solution to the hyperbolic PDE should be
generated. The relevant time span is dependent on the dynamics of the problem.

Examples: 0:10, and logspace(-2,0,20).
• u(t0). The initial value u(t0) for the hyperbolic PDE problem. The initial value can be a

constant or a column vector of values on the nodes of the current mesh.
• u'(t0). The initial value u̇(t0) for the hyperbolic PDE problem. You can use the same

formats as for u(t0).
• Relative tolerance. Relative tolerance parameter for the ODE solver that is used for

solving the time-dependent part of the hyperbolic PDE problem.
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• Absolute tolerance. Absolute tolerance parameter for the ODE solver that is used for
solving the time-dependent part of the hyperbolic PDE problem.

Eigenvalue Equations
For the eigenvalue PDE, the only solve parameter is the Eigenvalue search range, a
two-element vector, defining an interval on the real axis as a search range for the
eigenvalues. The left side can be -Inf.

Examples: [0 100], [-Inf 50]

Nonlinear Equations
Before solving a nonlinear elliptic PDE in the PDE Modeler app, select SolveParameters.
Then select Use nonlinear solver and click OK.
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Plot the Solution in the PDE Modeler App
To plot a solution property, use the Plot menu. Use the Plot Selection dialog box to
select which property to plot, which plot style to use, and several other plot parameters.
If you have recorded a movie (animation) of the solution, you can export it to the
workspace.

To open the Plot Selection dialog box, select Parameters from the Plot menu or click

the  button.

Parameters opens a dialog box containing options controlling the plotting and
visualization.

The upper part of the dialog box contains four columns:

• Plot type (far left) contains a row of six different plot types, which can be used for
visualization:
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• Color. Visualization of a scalar property using colored surface objects.
• Contour. Visualization of a scalar property using colored contour lines. The

contour lines can also enhance the color visualization when both plot types (Color
and Contour) are checked. The contour lines are then drawn in black.

• Arrows. Visualization of a vector property using arrows.
• Deformed mesh. Visualization of a vector property by deforming the mesh using

the vector property. The deformation is automatically scaled to 10% of the problem
domain. This plot type is primarily intended for visualizing x- and y-displacements
(u and v) for problems in structural mechanics. If no other plot type is selected, the
deformed triangular mesh is displayed.

• Height (3-D plot). Visualization of a scalar property using height (z-axis) in a 3-D
plot. 3-D plots are plotted in separate figure windows. If the Color and Contour
plot types are not used, the 3-D plot is simply a mesh plot. You can visualize
another scalar property simultaneously using Color and/or Contour, which results
in a 3-D surface or contour plot.

• Animation. Animation of time-dependent solutions to parabolic and hyperbolic
problems. If you select this option, the solution is recorded and then animated in a
separate figure window using the MATLAB movie function.

A color bar is added to the plots to map the colors in the plot to the magnitude of the
property that is represented using color or contour lines.

• Property contains four pop-up menus containing lists of properties that are available
for plotting using the corresponding plot type. From the first pop-up menu you control
the property that is visualized using color and/or contour lines. The second and third
pop-up menus contain vector valued properties for visualization using arrows and
deformed mesh, respectively. From the fourth pop-up menu, finally, you control which
scalar property to visualize using z-height in a 3-D plot. The lists of properties are
dependent on the current application mode. For the generic scalar mode, you can
select the following scalar properties:

• u. The solution itself.
• abs(grad(u)). The absolute value of ∇u, evaluated at the center of each triangle.
• abs(c*grad(u)). The absolute value of c · ∇u, evaluated at the center of each

triangle.
• user entry. A MATLAB expression returning a vector of data defined on the nodes

or the triangles of the current triangular mesh. The solution u, its derivatives ux
and uy, the x and y components of c · ∇u, cux and cuy, and x and y are all
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available in the local workspace. You enter the expression into the edit box to the
right of the Property pop-up menu in the User entry column.

Examples: u.*u, x+y

The vector property pop-up menus contain the following properties in the generic
scalar case:

• -grad(u). The negative gradient of u, –∇u.
• -c*grad(u). c times the negative gradient of u, –c · ∇u.
• user entry. A MATLAB expression [px; py] returning a 2-by-ntri matrix of data
defined on the triangles of the current triangular mesh (ntri is the number of
triangles in the current mesh). The solution u, its derivatives ux and uy, the x and y
components of c · ∇u, cux and cuy, and x and y are all available in the local
workspace. Data defined on the nodes is interpolated to triangle centers. You enter
the expression into the edit field to the right of the Property pop-up menu in the
User entry column.

Examples: [ux;uy], [x;y]

For the generic system case, the properties available for visualization using color, contour
lines, or z-height are u, v, abs(u,v), and a user entry. For visualization using arrows or a
deformed mesh, you can choose (u,v) or a user entry. For applications in structural
mechanics, u and v are the x- and y-displacements, respectively.

The variables available in the local workspace for a user entered expression are the same
for all scalar and system modes (the solution is always referred to as u and, in the system
case, v).

• User entry contains four edit fields where you can enter your own expression, if you
select the user entry property from the corresponding pop-up menu to the left of the
edit fields. If the user entry property is not selected, the corresponding edit field is
disabled.

• Plot style contains three pop-up menus from which you can control the plot style for
the color, arrow, and height plot types respectively. The available plot styles for color
surface plots are

• Interpolated shading. A surface plot using the selected colormap and
interpolated shading, i.e., each triangular area is colored using a linear,
interpolated shading (the default).
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• Flat shading. A surface plot using the selected colormap and flat shading, i.e.,
each triangular area is colored using a constant color.

You can use two different arrow plot styles:

• Proportional. The length of the arrow corresponds to the magnitude of the
property that you visualize (the default).

• Normalized. The lengths of all arrows are normalized, i.e., all arrows have the
same length. This is useful when you are interested in the direction of the vector
field. The direction is clearly visible even in areas where the magnitude of the field
is very small.

For height (3-D plots), the available plot styles are:

• Continuous. Produces a “smooth” continuous plot by interpolating data from
triangle midpoints to the mesh nodes (the default).

• Discontinuous. Produces a discontinuous plot where data and z-height are
constant on each triangle.

A total of three properties of the solution—two scalar properties and one vector field—can
be visualized simultaneously. If the Height (3-D plot) option is turned off, the solution
plot is a 2-D plot and is plotted in the main axes of the PDE Modeler app. If the Height
(3-D plot) option is used, the solution plot is a 3-D plot in a separate figure window. If
possible, the 3-D plot uses an existing figure window. If you would like to plot in a new
figure window, simply type figure at the MATLAB command line.

Additional Plot Control Options
In the middle of the dialog box are a number of additional plot control options:

• Plot in x-y grid. If you select this option, the solution is converted from the original
triangular grid to a rectangular x-y grid. This is especially useful for animations since
it speeds up the process of recording the movie frames significantly.

• Show mesh. In the surface plots, the mesh is plotted using black color if you select
this option. By default, the mesh is hidden.

• Contour plot levels. For contour plots, the number of level curves, e.g., 15 or 20 can
be entered. Alternatively, you can enter a MATLAB vector of levels. The curves of the
contour plot are then drawn at those levels. The default is 20 contour level curves.

Examples: [0:100:1000], logspace(-1,1,30)
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• Colormap. Using the Colormap pop-up menu, you can select from a number of
different color maps: cool, gray, bone, pink, copper, hot, jet, hsv, prism, and
parula.

• Plot solution automatically. This option is normally selected. If turned off, there will
not be a display of a plot of the solution immediately upon solving the PDE. The new
solution, however, can be plotted using this dialog box.

For the parabolic and hyperbolic PDEs, the bottom right portion of the Plot Selection
dialog box contains the Time for plot parameter.

Time for plot. A pop-up menu allows you to select which of the solutions to plot by
selecting the corresponding time. By default, the last solution is plotted.

Also, the Animation plot type is enabled. In its property field you find an Options button.
If you press it, an additional dialog box appears. It contains parameters that control the
animation:

• Animation rate (fps). For the animation, this parameter controls the speed of the
movie in frames per second (fps).

• Number of repeats. The number of times the movie is played.
• Replay movie. If you select this option, the current movie is replayed without

rerecording the movie frames. If there is no current movie, this option is disabled.
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For eigenvalue problems, the bottom right part of the dialog box contains a pop-up menu
with all eigenvalues. The plotted solution is the eigenvector associated with the selected
eigenvalue. By default, the smallest eigenvalue is selected.

You can rotate the 3-D plots by clicking the plot and, while keeping the mouse button
down, moving the mouse. For guidance, a surrounding box appears. When you release the
mouse, the plot is redrawn using the new viewpoint. Initially, the solution is plotted using
-37.5 degrees horizontal rotation and 30 degrees elevation.

If you click the Plot button, the solution is plotted immediately using the current plot
setup. If there is no current solution available, the PDE is first solved. The new solution is
then plotted. The dialog box remains on the screen.

If you click the Done button, the dialog box is closed. The current setup is saved but no
additional plotting takes place.

If you click the Cancel button, the dialog box is closed. The setup remains unchanged
since the last plot.

Tooltip Displays for Mesh and Plots
In mesh mode, you can use the mouse to display the node number and the triangle
number at the position where you click. Press the left mouse button to display the node
number on the information line. Use the left mouse button and the Shift key to display
the triangle number on the information line.
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In plot mode, you can use the mouse to display the numerical value of the plotted
property at the position where you click. Press the left mouse button to display the
triangle number and the value of the plotted property on the information line.

The information remains on the information line until you release the mouse button.
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adaptmesh
Adaptive 2-D mesh generation and PDE solution

Note This page describes the legacy workflow. New features might not be compatible
with the legacy workflow. In the recommended workflow, see generateMesh for mesh
generation and solvepde for PDE solution.

Syntax
[u,p,e,t] = adaptmesh(g,b,c,a,f)
[u,p,e,t] = adaptmesh(g,b,c,a,f,'PropertyName',PropertyValue)

Description
[u,p,e,t] = adaptmesh(g,b,c,a,f) and [u,p,e,t] =
adaptmesh(g,b,c,a,f,'PropertyName',PropertyValue) perform adaptive mesh
generation and PDE solution for elliptic problems with 2-D geometry. Optional arguments
are given as property name/property value pairs.

The function produces a solution u to the elliptic scalar PDE problem

−∇ ⋅ c∇u + au = f

for (x,y) ∊ Ω, or the elliptic system PDE problem

−∇ ⋅ c⊗ ∇u + au = f

with the problem geometry and boundary conditions given by g and b. The mesh is
described by the p, e, and t matrices.

The solution u is represented as the solution vector u. If the PDE is scalar, meaning that is
has only one equation, then u is a column vector representing the solution u at each node
in the mesh. If the PDE is a system of N > 1 equations, then u is a column vector with
N*Np elements, where Np is the number of nodes in the mesh. The first Np elements of u
represent the solution of equation 1, the next Np elements represent the solution of
equation 2, and so on.
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The algorithm works by solving a sequence of PDE problems using refined triangular
meshes. The first triangular mesh generation is provided as an optional argument to
adaptmesh or obtained by a call to initmesh without options. Subsequent generations
of triangular meshes are obtained by solving the PDE problem, computing an error
estimate, selecting a set of triangles based on the error estimate, and then refining the
triangles. The solution to the PDE problem is then recomputed. The loop continues until
the triangle selection method selects no further triangles, until the maximum number of
triangles is attained, or until the maximum number of triangle generations is reached.

g describes the geometry of the PDE problem. g can be a decomposed geometry matrix,
the name of a geometry file, or a function handle to a geometry file. For details, see
“Three Ways to Create 2-D Geometry” on page 2-8.

b describes the boundary conditions of the PDE problem. For details, see “Boundary
Conditions by Writing Functions” on page 2-197.

The adapted triangular mesh of the PDE problem is given by the mesh data p, e, and t.
For details on the mesh data representation, see “Mesh Data as [p,e,t] Triples” on page 2-
230.

The coefficients c, a, and f of the PDE problem can be given in a wide variety of ways. In
the context of adaptmesh, the coefficients can depend on u if the nonlinear solver is
enabled using the property nonlin. The coefficients cannot depend on t, the time.

adaptmesh accepts the following property name-value pairs.

Property Value Default Description
Maxt positive integer inf Maximum number of new

triangles
Ngen positive integer 10 Maximum number of triangle

generations
Mesh p1, e1, t1 initmesh Initial mesh
Tripick MATLAB function pdeadworst Triangle selection method
Par numeric 0.5 Function parameter
Rmethod 'longest' |

'regular'
'longest' Triangle refinement method

Nonlin 'on' | 'off' 'off' Use nonlinear solver
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Property Value Default Description
Toln numeric 1e-4 Nonlinear tolerance
Init u0 0 Nonlinear initial value
Jac 'fixed | 'lumped' |

'full'
'fixed' Nonlinear Jacobian calculation

norm numeric | inf inf Nonlinear residual norm
MesherVersion 'R2013a' |

'preR2013a'
'preR2013a' Algorithm for generating initial

mesh

Par is passed to the Tripick function, which is described later. Normally it is used as
tolerance of how well the solution fits the equation.

No more than Ngen successive refinements are attempted. Refinement is also stopped
when the number of triangles in the mesh exceeds Maxt.

p1, e1, and t1 are the input mesh data. This triangular mesh is used as starting mesh for
the adaptive algorithm. For details on the mesh data representation, see initmesh. If no
initial mesh is provided, the result of a call to initmesh with no options is used as the
initial mesh.

The triangle selection method, Tripick, is a user-definable triangle selection method.
Given the error estimate computed by the function pdejmps, the triangle selection
method selects the triangles to be refined in the next triangle generation. The function is
called using the arguments p, t, cc, aa, ff, u, errf, and par. p and t represent the
current generation of triangles; cc, aa, and ff are the current coefficients for the PDE
problem, expanded to the triangle midpoints; u is the current solution; errf is the
computed error estimate; and par, the function parameter, is given to adaptmesh as
optional argument. The matrices cc, aa, ff, and errf all have Nt columns, where Nt is
the current number of triangles. The numbers of rows in cc, aa, and ff are exactly the
same as the input arguments c, a, and f. errf has one row for each equation in the
system. The two standard triangle selection methods are pdeadworst and pdeadgsc.
pdeadworst selects triangles where errf exceeds a fraction (the default is 0.5) of the
worst value, and pdeadgsc selects triangles using a relative tolerance criterion.

The refinement method is longest or regular. For details on the refinement method,
see refinemesh.
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The MesherVersion property chooses the algorithm for mesh generation. The 'R2013a'
algorithm runs faster and can triangulate more geometries than the 'preR2013a'
algorithm. Both algorithms use Delaunay triangulation.

The adaptive algorithm can also solve nonlinear PDE problems. For nonlinear PDE
problems, the Nonlin parameter must be set to on. The nonlinear tolerance Toln,
nonlinear initial value u0, nonlinear Jacobian calculation Jac, and nonlinear residual
norm Norm are passed to the nonlinear solver pdenonlin.

Examples

Adaptive Mesh Generation and Mesh Refinement

Solve the Laplace equation over a circle sector, with Dirichlet boundary conditions u =
cos(2/3atan2( y , x )) along the arc and u = 0 along the straight lines, and compare the
resulting solution to the exact solution. Set options so that adaptmesh refines the
triangles using the worst error criterion until it obtains a mesh with at least 500 triangles.

[u,p,e,t]=adaptmesh('cirsg','cirsb',1,0,0,'maxt',500,... 
                       'tripick','pdeadworst','ngen',inf); 

Number of triangles: 197
Number of triangles: 201
Number of triangles: 216
Number of triangles: 233
Number of triangles: 254
Number of triangles: 265
Number of triangles: 313
Number of triangles: 344
Number of triangles: 417
Number of triangles: 475
Number of triangles: 629

Maximum number of triangles obtained.

x=p(1,:); y=p(2,:); 
exact=((x.^2+y.^2).^(1/3).*cos(2/3*atan2(y,x)))'; 
max(abs(u-exact))

ans = 0.0028

size(t,2)
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ans = 629

The maximum absolute error is 0.0028, with 629 triangles.

pdemesh(p,e,t)

Test how many refinements you need with a uniform triangle net.

[p,e,t]=initmesh('cirsg'); 
[p,e,t]=refinemesh('cirsg',p,e,t); 
u=assempde('cirsb',p,e,t,1,0,0); 
x=p(1,:); y=p(2,:); 
exact=((x.^2+y.^2).^(1/3).*cos(2/3*atan2(y,x)))'; 
max(abs(u-exact))
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ans = 0.0121

size(t,2)

ans = 788

[p,e,t]=refinemesh('cirsg',p,e,t); 
u=assempde('cirsb',p,e,t,1,0,0); 
x=p(1,:); y=p(2,:); 
exact=((x.^2+y.^2).^(1/3).*cos(2/3*atan2(y,x)))'; 
max(abs(u-exact))

ans = 0.0078

size(t,2)

ans = 3152

pdemesh(p,e,t)
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Uniform refinement with 3152 triangles produces an error of 0.0078. This error is over
three times as large as that produced by the adaptive method (0.0028) with many fewer
triangles (629). Typically, a problem with regular solution has an O(h2) error. However,
this solution is singular since u ≈ r1/3 at the origin.

Diagnostics
Upon termination, one of the following messages is displayed:

• Adaption completed (This means that the Tripick function returned zero
triangles to refine.)
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• Maximum number of triangles obtained
• Maximum number of refinement passes obtained

Algorithms

Mesh Refinement for Improving Solution Accuracy
Partial Differential Equation Toolbox provides the refinemesh function for global,
uniform mesh refinement for 2-D geometries. It divides each triangle into four similar
triangles by creating new corners at the midsides, adjusting for curved boundaries. You
can assess the accuracy of the numerical solution by comparing results from a sequence
of successively refined meshes. If the solution is smooth enough, more accurate results
can be obtained by extrapolation.

The solutions of equations often have geometric features such as localized strong
gradients. An example of engineering importance in elasticity is the stress concentration
occurring at reentrant corners, such as the MATLAB L-shaped membrane. In such cases,
it is more economical to refine the mesh selectively, that is, only where it is needed. The
selection that is based on estimates of errors in the computed solutions is called adaptive
mesh refinement. See adaptmesh for an example of the computational savings where
global refinement needs more than 6000 elements to compete with an adaptively refined
mesh of 500 elements.

The adaptive refinement generates a sequence of solutions on successively finer meshes,
at each stage selecting and refining those elements that are judged to contribute most to
the error. The process is terminated when the maximum number of elements is exceeded,
when each triangle contributes less than a preset tolerance, or when an iteration limit is
reached. You can provide an initial mesh, or let adaptmesh call initmesh automatically.
You also choose selection and termination criteria parameters. The three components of
the algorithm are the error indicator function (which computes an estimate of the element
error contribution), the mesh refiner (which selects and subdivides elements), and the
termination criteria.

Error Estimate for FEM Solution
The adaptation is a feedback process. As such, it is easily applied to a larger range of
problems than those for which its design was tailored. You want estimates, selection
criteria, and so on to be optimal in the sense of giving the most accurate solution at fixed

 adaptmesh
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cost or lowest computational effort for a given accuracy. Such results have been proved
only for model problems, but generally, the equidistribution heuristic has been found near
optimal. Element sizes must be chosen so that each element contributes the same to the
error. The theory of adaptive schemes makes use of a priori bounds for solutions in terms
of the source function f. For nonelliptic problems, such bounds might not exist, while the
refinement scheme is still well defined and works well.

The error indicator function used in the software is an elementwise estimate of the
contribution, based on the work of C. Johnson et al. [1], [2]. For Poisson's equation –Δu = f
on Ω, the following error estimate for the FEM-solution uh holds in the L2-norm ⋅ :

∇(u− uh) ≤ α hf + βDh(uh)

where h = h(x) is the local mesh size, and

Dh(v) = ∑
τ ∈ E1

hτ
2 ∂v
∂nτ

2 1/2

The braced quantity is the jump in normal derivative of v across the edge τ, hτ is the
length of the edge τ, and the sum runs over Ei, the set of all interior edges of the
triangulation. The coefficients α and β are independent of the triangulation. This bound is
turned into an elementwise error indicator function E(K) for the element K by summing
the contributions from its edges.

The general form of the error indicator function for the elliptic equation

–∇ · (c∇u) + au = f  (5-1)

is

E K = α h f − au K + β 1
2 ∑

τ ∈ ∂K
hτ

2 nτ · c∇uh
2

1/2

where nτ is the unit normal of the edge τ and the braced term is the jump in flux across
the element edge. The L2 norm is computed over the element K. The pdejmps function
computes this error indicator.

Mesh Refinement Functions
Partial Differential Equation Toolbox software is geared to elliptic problems. For reasons
of accuracy and ill-conditioning, such problems require the elements not to deviate too
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much from being equilateral. Thus, even at essentially one-dimensional solution features,
such as boundary layers, the refinement technique must guarantee reasonably shaped
triangles.

When an element is refined, new nodes appear on its midsides, and if the neighbor
triangle is not refined in a similar way, it is said to have hanging nodes. The final
triangulation must have no hanging nodes, and they are removed by splitting neighbor
triangles. To avoid further deterioration of triangle quality in successive generations, the
"longest edge bisection" scheme is used by Rosenberg-Stenger [3], in which the longest
side of a triangle is always split, whenever any of the sides have hanging nodes. This
guarantees that no angle is ever smaller than half the smallest angle of the original
triangulation.

Two selection criteria can be used. One, pdeadworst, refines all elements with value of
the error indicator larger than half the worst of any element. The other, pdeadgsc,
refines all elements with an indicator value exceeding a user-defined dimensionless
tolerance. The comparison with the tolerance is properly scaled with respect to domain,
solution size, and so on.

Mesh Refinement Termination Criteria
For smooth solutions, error equidistribution can be achieved by the pdeadgsc selection if
the maximum number of elements is large enough. The pdeadworst adaptation only
terminates when the maximum number of elements has been exceeded or when the
iteration limit is reached. This mode is natural when the solution exhibits singularities.
The error indicator of the elements next to the singularity may never vanish, regardless of
element size, and equidistribution is too much to hope for.

References
[1] Johnson, C. Numerical Solution of Partial Differential Equations by the Finite Element

Method. Lund, Sweden: Studentlitteratur, 1987.

[2] Johnson, C., and K. Eriksson. Adaptive Finite Element Methods for Parabolic Problems
I: A Linear Model Problem. SIAM J. Numer. Anal, 28, (1991), pp. 43–77.

[3] Rosenberg, I.G., and F. Stenger, A lower bound on the angles of triangles constructed
by bisecting the longest side. Mathematics of Computation. Vol 29, Number 10,
1975, pp 390–395.

 adaptmesh

5-11



See Also
initmesh | refinemesh

Introduced before R2006a
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AnalyticGeometry Properties
2-D geometry description

Description
AnalyticGeometry describes 2-D geometry in the form of an object. A PDEModel object
has a Geometry property. For 2-D geometry, the Geometry property is an
AnalyticGeometry object.

Specify a 2-D geometry for your model using the geometryFromEdges function.

Properties
Properties

NumEdges — Number of geometry edges
positive integer

Number of geometry edges, returned as a positive integer.
Data Types: double

NumFaces — Number of geometry faces
positive integer

Number of geometry faces, returned as a positive integer. If your geometry is one
connected region, then NumFaces = 1.
Data Types: double

NumVertices — Number of geometry vertices
positive integer

Number of geometry vertices, returned as a positive integer.
Data Types: double

 AnalyticGeometry Properties
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See Also
PDEModel | geometryFromEdges

Topics
“Solve Problems Using PDEModel Objects” on page 2-6

Introduced in R2015a
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applyBoundaryCondition
Package: pde

Add boundary condition to PDEModel container

Syntax
applyBoundaryCondition(model,'dirichlet',RegionType,RegionID,
Name,Value)
applyBoundaryCondition(model,'neumann',RegionType,RegionID,
Name,Value)
applyBoundaryCondition(model,'mixed',RegionType,RegionID,Name,Value)
bc = applyBoundaryCondition( ___ )

Description
applyBoundaryCondition(model,'dirichlet',RegionType,RegionID,
Name,Value) adds a Dirichlet boundary condition to model. The boundary condition
applies to boundary regions of type RegionType with ID numbers in RegionID, and with
arguments r, h, u, EquationIndex specified in the Name,Value pairs. For Dirichlet
boundary conditions, specify either both arguments r and h, or the argument u. When
specifying u, you can also use EquationIndex.

applyBoundaryCondition(model,'neumann',RegionType,RegionID,
Name,Value) adds a Neumann boundary condition to model. The boundary condition
applies to boundary regions of type RegionType with ID numbers in RegionID, and with
values g and q specified in the Name,Value pairs.

applyBoundaryCondition(model,'mixed',RegionType,RegionID,Name,Value)
adds an individual boundary condition for each equation in a system of PDEs. The
boundary condition applies to boundary regions of type RegionType with ID numbers in
RegionID, and with values specified in the Name,Value pairs. For mixed boundary
conditions, you can use Name,Value pairs from both Dirichlet and Neumann boundary
conditions as needed.

bc = applyBoundaryCondition( ___ ) returns the boundary condition object.
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Examples

Dirichlet Boundary Conditions

Create a PDE model and geometry.

model = createpde(1);
R1 = [3,4,-1,1,1,-1,-.4,-.4,.4,.4]';
g = decsg(R1);
geometryFromEdges(model,g);

View the edge labels.

pdegplot(model,'EdgeLabels','on')
xlim([-1.2,1.2])
axis equal
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Apply zero Dirichlet condition on the edge 1.

applyBoundaryCondition(model,'dirichlet','Edge',1,'u',0);

On other edges, apply Dirichlet condition h*u = r, where h = 1 and r = 1.

applyBoundaryCondition(model,'dirichlet','Edge',2:4,'r',1,'h',1);

Neumann Boundary Conditions

Create a PDE model and geometry.

 applyBoundaryCondition
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model = createpde(2);
R1 = [3,4,-1,1,1,-1,-.4,-.4,.4,.4]';
g = decsg(R1);
geometryFromEdges(model,g);

View the edge labels.

pdegplot(model,'EdgeLabels','on')
xlim([-1.2,1.2])
axis equal

Apply the following Neumann boundary conditions on the edge 4.

applyBoundaryCondition(model,'neumann','Edge',4,'g',[0;.123],'q',[0;0;0;0]);
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Dirichlet and Neumann Boundary Conditions for Different Boundaries

Apply both types of boundary conditions to a scalar problem. First, create a PDE model
and import a simple block geometry.

model = createpde;
importGeometry(model,'Block.stl');

View the face labels.

pdegplot(model,'FaceLabels','on','FaceAlpha',0.5)

Set zero Dirichlet conditions on the narrow faces, which are labeled 1 through 4.
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applyBoundaryCondition(model,'dirichlet','Face',1:4,'u',0);

Set Neumann boundary conditions with opposite signs on faces 5 and 6.

applyBoundaryCondition(model,'neumann','Face',5,'g',1);
applyBoundaryCondition(model,'neumann','Face',6,'g',-1);

Solve an elliptic PDE with these boundary conditions, and plot the result.

specifyCoefficients(model,'m',0,'d',0,'c',1,'a',0,'f',0);
generateMesh(model);
results = solvepde(model);
u = results.NodalSolution;
pdeplot3D(model,'ColorMapData',u)
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Individual Boundary Conditions for Equations in a System

Create a PDE model and import a simple block geometry.

model = createpde(3);
importGeometry(model,'Block.stl');

View the face labels.

pdegplot(model,'FaceLabels','on','FaceAlpha',0.5)

Set zero Dirichlet conditions on faces 1 and 2.
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applyBoundaryCondition(model,'dirichlet','Face',1:2,'u',[0,0,0]);

Set Neumann boundary conditions with opposite signs on faces 4, 5, and 6.

applyBoundaryCondition(model,'neumann','Face',4:5,'g',[1;1;1]);
applyBoundaryCondition(model,'neumann','Face',6,'g',[-1;-1;-1]);

For face 3, apply generalized Neumann boundary condition for the first equation and
Dirichlet boundary conditions for the second and third equations.

h = [0 0 0;0 1 0;0 0 1];
r = [0;3;3];
q = [1 0 0;0 0 0;0 0 0];
g = [10;0;0];
applyBoundaryCondition(model,'mixed','Face',3,'h',h,'r',r,'g',g,'q',q);

Solve an elliptic PDE with these boundary conditions, and plot the result.

specifyCoefficients(model,'m',0,'d',0,'c',1,'a',0,'f',[0;0;0]);
generateMesh(model);
results = solvepde(model);
u = results.NodalSolution;
pdeplot3D(model,'ColorMapData',u(:,1))
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Input Arguments
model — PDE model
PDEModel object

PDE model, specified as a PDEModel object.
Example: model = createpde

RegionType — Geometric region type
'Face' for 3-D geometry | 'Edge' for 2-D geometry
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Geometric region type, specified as 'Face' for 3-D geometry or 'Edge' for 2-D
geometry.
Example: applyBoundaryCondition(model,'dirichlet','Face',3,'u',0)
Data Types: char | string

RegionID — Geometric region ID
vector of positive integers

Geometric region ID, specified as a vector of positive integers. Find the region IDs using
pdegplot with the 'FaceLabels' (3-D) or 'EdgeLabels' (2-D) value set to 'on'.
Example: applyBoundaryCondition(model,'dirichlet','Face',3:6,'u',0)
Data Types: double

Name-Value Pair Arguments
Example: applyBoundaryCondition(model,'dirichlet','Face',1:4,'u',0)

r — Dirichlet condition h*u = r
zeros(N,1) (default) | vector with N elements | function handle

Dirichlet condition h*u = r, specified as a vector with N elements or a function handle.
N is the number of PDEs in the system. For the syntax of the function handle form of r,
see “Nonconstant Boundary Conditions” on page 2-179.
Example: 'r',[0;4;-1]
Data Types: double | function_handle
Complex Number Support: Yes

h — Dirichlet condition h*u = r
eye(N) (default) | N-by-N matrix | vector with N^2 elements | function handle

Dirichlet condition h*u = r, specified as an N-by-N matrix, a vector with N^2 elements,
or a function handle. N is the number of PDEs in the system. For the syntax of the
function handle form of h, see “Nonconstant Boundary Conditions” on page 2-179.
Example: 'h',[2,1;1,2]
Data Types: double | function_handle
Complex Number Support: Yes
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g — Generalized Neumann condition n·(c×∇u) + qu = g
zeros(N,1) (default) | vector with N elements | function handle

Generalized Neumann condition n·(c×∇u) + qu = g, specified as a vector with N
elements or a function handle. N is the number of PDEs in the system. For scalar PDEs,
the generalized Neumann condition is n·(c∇u) + qu = g. For the syntax of the
function handle form of g, see “Nonconstant Boundary Conditions” on page 2-179.
Example: 'g',[3;2;-1]
Data Types: double | function_handle
Complex Number Support: Yes

q — Generalized Neumann condition n·(c×∇u) + qu = g
zeros(N) (default) | N-by-N matrix | vector with N^2 elements | function handle

Generalized Neumann condition n·(c×∇u) + qu = g, specified as an N-by-N matrix, a
vector with N^2 elements, or a function handle. N is the number of PDEs in the system.
For the syntax of the function handle form of q, see “Nonconstant Boundary Conditions”
on page 2-179.
Example: 'q',eye(3)
Data Types: double | function_handle
Complex Number Support: Yes

u — Dirichlet conditions
zeros(N,1) (default) | vector of up to N elements | function handle

Dirichlet conditions, specified as a vector of up to N elements or as a function handle. If u
has less than N elements, then you must also use EquationIndex. The u and
EquationIndex arguments must have the same length. If u has N elements, then
specifying EquationIndex is optional.

For the syntax of the function handle form of u, see “Nonconstant Boundary Conditions”
on page 2-179.
Example: applyBoundaryCondition(model,'dirichlet','Face',
[2,4,11],'u',0)

Data Types: double
Complex Number Support: Yes

EquationIndex — Index of the known u components
1:N (default) | vector of integers with entries from 1 to N
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Index of the known u components, specified as a vector of integers with entries from 1 to
N. EquationIndex and u must have the same length.

When using EquationIndex to specify Dirichlet boundary conditions for a subset of
components, use the mixed argument instead of dirichlet. The remaining components
satisfy the default Neumann boundary condition with the zero values for 'g' and 'q'.
Example: applyBoundaryCondition(model,'mixed','Face',[2,4,11],'u',
[3,-1],'EquationIndex',[2,3])

Data Types: double

Vectorized — Vectorized function evaluation
'off' (default) | 'on'

Vectorized function evaluation, specified as 'on' or 'off'. This evaluation applies when
you pass a function handle as an argument. To save time in function handle evaluation,
specify 'on', assuming that your function handle computes in a vectorized fashion. See
“Vectorization” (MATLAB). For details of this evaluation, see “Nonconstant Boundary
Conditions” on page 2-179.
Example: applyBoundaryCondition(model,'dirichlet','Face',
[2,4,11],'u',@ucalculator,'Vectorized','on')

Data Types: char | string

Output Arguments
bc — Boundary condition
BoundaryCondition object

Boundary condition, returned as a BoundaryCondition object. The model object contains
a vector of BoundaryCondition objects. bc is the last element of this vector.

Tips
• When there are multiple boundary condition assignments to the same geometric

region, the toolbox uses the last applied setting.
• To avoid assigning boundary conditions to a wrong region, ensure that you are using

the correct geometric region IDs by plotting and visually inspecting the geometry.

5 Functions — Alphabetical List

5-26



• If you do not specify a boundary condition for an edge or face, the default is the
Neumann boundary condition with the zero values for 'g' and 'q'.

See Also
BoundaryCondition | PDEModel | findBoundaryConditions

Topics
“Solve Problems Using PDEModel Objects” on page 2-6

Introduced in R2015a
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area
Package: pde

Area of 2-D mesh elements

Syntax
A = area(mesh)
[A,AE] = area(mesh)
A = area(mesh,elements)

Description
A = area(mesh) returns the area A of the entire mesh.

[A,AE] = area(mesh) also returns a row vector AE containing areas of each individual
element of the mesh.

A = area(mesh,elements) returns the combined area of the specified elements of the
mesh.

Examples

Area of Entire 2-D Mesh

Generate a 2-D mesh and find its area.

Create a PDE model.

model = createpde;

Include the geometry of the built-in function lshapeg. Plot the geometry.

geometryFromEdges(model,@lshapeg);
pdegplot(model,'FaceLabels','on')
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Generate a mesh and plot it.

mesh = generateMesh(model);
figure
pdemesh(model)

 area
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Compute the area of the entire mesh.

ma = area(mesh)

ma = 3.0000

Area of Individual Elements of 2-D Mesh

Generate a 2-D mesh and find the area of each element.

Create a PDE model.
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model = createpde;

Include the geometry of the built-in function lshapeg. Plot the geometry.

geometryFromEdges(model,@lshapeg);
pdegplot(model,'FaceLabels','on')

Generate a mesh and plot it.

mesh = generateMesh(model);
figure
pdemesh(model)
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Compute the area of the entire mesh and the area of each individual element of the mesh.
Display the areas of the first 5 elements.

[ma,mi] = area(mesh);
mi(1:5)

ans = 1×5

    0.0047    0.0054    0.0053    0.0048    0.0061
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Total Area of Group of Elements

Find the combined area of the elements associated with a particular face of a 2-D mesh.

Create a PDE model.

model = createpde;

Include the geometry of the built-in function lshapeg. Plot the geometry.

geometryFromEdges(model,@lshapeg);
pdegplot(model,'FaceLabels','on')

Generate a mesh and plot it.
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mesh = generateMesh(model);
figure
pdemesh(model)

Find the elements associated with face 1 and compute the total area of these elements.

Ef1 = findElements(mesh,'region','Face',1);
maf1 = area(mesh,Ef1)

maf1 = 1.0000

Find how much of the total mesh area belongs to these elements. Return the result as a
percentage.

maf1_percent = maf1/area(mesh)*100
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maf1_percent = 33.3333

Input Arguments
mesh — Mesh object
Mesh property of a PDEModel object | output of generateMesh

Mesh object, specified as the Mesh property of a PDEModel object or as the output of
generateMesh.
Example: model.Mesh

elements — Element IDs
positive integer | matrix of positive integers

Element IDs, specified as a positive integer or a matrix of positive integers.
Example: [10 68 81 97 113 130 136 164]

Output Arguments
A — Area
positive number

Area of the entire mesh or the combined area of the specified elements of the mesh,
returned as a positive number.

AE — Areas of individual elements
row vector of positive numbers

Areas of individual elements, returned as a row vector of positive numbers.

See Also
FEMesh Properties | findElements | findNodes | meshQuality | volume

Topics
“Finite Element Method Basics” on page 1-18
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Introduced in R2018a
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assema
(Not recommended) Assemble area integral contributions

Note assema is not recommended. Use assembleFEMatrices instead.

Syntax
[K,M,F] = assema(model,c,a,f)
[K,M,F] = assema(p,t,c,a,f)

Description
[K,M,F] = assema(model,c,a,f) assembles the stiffness matrix K, the mass matrix
M, and the load vector F using the mesh contained in model, and the PDE coefficients c,
a, and f.

[K,M,F] = assema(p,t,c,a,f) assembles the matrices from the mesh data in p and
t.

Examples

Assemble Finite Element Matrices

Assemble finite element matrices for an elliptic problem on complicated geometry.

The PDE is Poisson's equation,

−∇ ⋅ ∇u = 1 .

Partial Differential Equation Toolbox™ solves equations of the form

−∇ ⋅ (c∇u) + au = f .

So, represent Poisson's equation in toolbox syntax by setting c = 1, a = 0, and f = 1.
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c = 1;
a = 0;
f = 1;

Create a PDE model container. Import the ForearmLink.stl file into the model and
examine the geometry.

model = createpde;
importGeometry(model,'ForearmLink.stl');
pdegplot(model,'FaceAlpha',0.5)

Create a mesh for the model.

generateMesh(model);
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Create the finite element matrices from the mesh and the coefficients.

[K,M,F] = assema(model,c,a,f);

The returned matrix K is quite sparse. M has no nonzero entries.

disp(['Fraction of nonzero entries in K is ',num2str(nnz(K)/numel(K))])

Fraction of nonzero entries in K is 0.001094

disp(['Number of nonzero entries in M is ',num2str(nnz(M))])

Number of nonzero entries in M is 0

Assemble Finite Element Matrices Using [p,e,t] Mesh

Assemble finite element matrices for the 2-D L-shaped region, using the [p,e,t] mesh
representation.

Define the geometry using the lshapeg function included your software.

g = @lshapeg;

Use coefficients c = 1, a = 0, and f = 1.

c = 1;
a = 0;
f = 1;

Create a mesh and assemble the finite element matrices.

[p,e,t] = initmesh(g);
[K,M,F] = assema(p,t,c,a,f);

The returned matrix M has all zeros. The K matrix is quite sparse.

disp(['Fraction of nonzero entries in K is ',num2str(nnz(K)/numel(K))])

Fraction of nonzero entries in K is 0.042844

disp(['Number of nonzero entries in M is ',num2str(nnz(M))])

Number of nonzero entries in M is 0
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Input Arguments
model — PDE model
PDEModel object

PDE model, specified as a PDEModel object.
Example: model = createpde

c — PDE coefficient
scalar | matrix | character vector | character array | string scalar | string vector |
coefficient function

PDE coefficient, specified as a scalar, matrix, character vector, character array, string
scalar, string vector, or coefficient function. c represents the c coefficient in the scalar
PDE

−∇ ⋅ c∇u + au = f

or in the system of PDEs

−∇ ⋅ c⊗ ∇u + au = f

You can specifyc in various ways, detailed in “c Coefficient for Systems” on page 2-122.
See also “Specify Scalar PDE Coefficients in Character Form” on page 2-74, “Specify 2-D
Scalar Coefficients in Function Form” on page 2-80, and “Specify 3-D PDE Coefficients in
Function Form” on page 2-83.
Example: 'cosh(x+y.^2)'
Data Types: double | char | string | function_handle
Complex Number Support: Yes

a — PDE coefficient
scalar | matrix | character vector | character array | string scalar | string vector |
coefficient function

PDE coefficient, specified as a scalar, matrix, character vector, character array, string
scalar, string vector, or coefficient function. a represents the a coefficient in the scalar
PDE

−∇ ⋅ c∇u + au = f

5 Functions — Alphabetical List

5-40



or in the system of PDEs

−∇ ⋅ c⊗ ∇u + au = f

You can specifya in various ways, detailed in “a or d Coefficient for Systems” on page 2-
147. See also “Specify Scalar PDE Coefficients in Character Form” on page 2-74, “Specify
2-D Scalar Coefficients in Function Form” on page 2-80, and “Specify 3-D PDE
Coefficients in Function Form” on page 2-83.
Example: 2*eye(3)
Data Types: double | char | string | function_handle
Complex Number Support: Yes

f — PDE coefficient
scalar | matrix | character vector | character array | string scalar | string vector |
coefficient function

PDE coefficient, specified as a scalar, matrix, character vector, character array, string
scalar, string vector, or coefficient function. f represents the f coefficient in the scalar
PDE

−∇ ⋅ c∇u + au = f

or in the system of PDEs

−∇ ⋅ c⊗ ∇u + au = f

You can specifyf in various ways, detailed in “f Coefficient for Systems” on page 2-94. See
also “Specify Scalar PDE Coefficients in Character Form” on page 2-74, “Specify 2-D
Scalar Coefficients in Function Form” on page 2-80, and “Specify 3-D PDE Coefficients in
Function Form” on page 2-83.
Example: char('sin(x)';'cos(y)';'tan(z)')
Data Types: double | char | string | function_handle
Complex Number Support: Yes

p — Mesh points
matrix

Mesh points, specified as a 2-by-Np matrix of points, where Np is the number of points in
the mesh. For a description of the (p,e,t) matrices, see “Mesh Data” on page 2-233.
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Typically, you use the p, e, and t data exported from the PDE Modeler app, or generated
by initmesh or refinemesh.
Example: [p,e,t] = initmesh(gd)
Data Types: double

t — Mesh triangles
matrix

Mesh triangles, specified as a 4-by-Nt matrix of triangles, where Nt is the number of
triangles in the mesh. For a description of the (p,e,t) matrices, see “Mesh Data” on page
2-233.

Typically, you use the p, e, and t data exported from the PDE Modeler app, or generated
by initmesh or refinemesh.
Example: [p,e,t] = initmesh(gd)
Data Types: double

Output Arguments
K — Stiffness matrix
sparse matrix

Stiffness matrix, returned as a sparse matrix. See “Elliptic Equations” on page 5-77.

Typically, you use K in a subsequent call to assempde.

M — Mass matrix
sparse matrix

Mass matrix. returned as a sparse matrix. See “Elliptic Equations” on page 5-77.

Typically, you use M in a subsequent call to a solver such as assempde or hyperbolic.

F — Load vector
vector

Load vector, returned as a vector. See “Elliptic Equations” on page 5-77.

Typically, you use F in a subsequent call to assempde.
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See Also
assembleFEMatrices

Introduced before R2006a
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assemb
(Not recommended) Assemble boundary condition contributions

Note assemb is not recommended. Use assembleFEMatrices instead.

Syntax
[Q,G,H,R] = assemb(model)
[Q,G,H,R] = assemb(b,p,e)
[Q,G,H,R] = assemb( ___ ,[],sdl)

Description
[Q,G,H,R] = assemb(model) assembles the matrices Q and H, and the vectors G and
R. Q should be added to the system matrix and contains contributions from mixed
boundary conditions.

[Q,G,H,R] = assemb(b,p,e) assembles the matrices based on the boundary
conditions specified in b and the mesh data in p and e.

[Q,G,H,R] = assemb( ___ ,[],sdl), for any of the previous input arguments,
restricts the finite element matrices to those that include the subdomain specified by the
subdomain labels in sdl. The empty argument is required in this syntax for historic and
compatibility reasons.

Examples

Assemble Boundary Condition Matrices

Assemble the boundary condition matrices for an elliptic PDE.

The PDE is Poisson's equation,
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−∇ ⋅ ∇u = 1 .

Partial Differential Equation Toolbox™ solves equations of the form

−∇ ⋅ (c∇u) + au = f .

So, represent Poisson's equation in toolbox syntax by setting c = 1, a = 0, and f = 1.

c = 1;
a = 0;
f = 1;

Create a PDE model container. Import the ForearmLink.stl file into the model and
examine the geometry.

model = createpde;
importGeometry(model,'Block.stl'); 
h = pdegplot(model,'FaceLabels','on');
h(1).FaceAlpha = 0.5;
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Set zero Dirichlet boundary conditions on the narrow faces (numbered 1 through 4).

applyBoundaryCondition(model,'Face',1:4,'u',0);

Set a Neumann condition with g = -1 on face 6, and g = 1 on face 5.

applyBoundaryCondition(model,'Face',6,'g',-1);
applyBoundaryCondition(model,'Face',5,'g',1);

Create a mesh for the model.

generateMesh(model);

Create the boundary condition matrices for the model.
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[Q,G,H,R] = assemb(model);

The H matrix is quite sparse. The Q matrix has no nonzero entries.

disp(['Fraction of nonzero entries in H is ',num2str(nnz(H)/numel(H))])

Fraction of nonzero entries in H is 7.8796e-05

disp(['Number of nonzero entries in Q is ',num2str(nnz(Q))])

Number of nonzero entries in Q is 0

Assemble Boundary Matrices Using [p,e,t] Mesh

Assemble boundary condition matrices for the 2-D L-shaped region with Dirichlet
boundary conditions, using the [p,e,t] mesh representation.

Define the geometry and boundary conditions using functions included in your software.

g = @lshapeg;
b = @lshapeb;

Create a mesh for the geometry.

[p,e,t] = initmesh(g);

Create the boundary matrices.

[Q,G,H,R] = assemb(b,p,e);

Only one of the resulting matrices is nonzero, namely H. The H matrix is quite sparse.

disp(['Fraction of nonzero entries in H is ',num2str(nnz(H)/numel(H))])

Fraction of nonzero entries in H is 0.0066667

Input Arguments
model — PDE model
PDEModel object
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PDE model, specified as a PDEModel object.
Example: model = createpde

b — Boundary conditions
boundary matrix | boundary file

Boundary conditions, specified as a boundary matrix or boundary file. Pass a boundary file
as a function handle or as a file name.

• A boundary matrix is generally an export from the PDE Modeler app. For details of the
structure of this matrix, see “Boundary Matrix for 2-D Geometry” on page 2-168.

• A boundary file is a file that you write in the syntax specified in “Boundary Conditions
by Writing Functions” on page 2-197.

Example: b = 'circleb1', b = "circleb1", or b = @circleb1
Data Types: double | char | string | function_handle

p — Mesh points
matrix

Mesh points, specified as a 2-by-Np matrix of points, where Np is the number of points in
the mesh. For a description of the (p,e,t) matrices, see “Mesh Data” on page 2-233.

Typically, you use the p, e, and t data exported from the PDE Modeler app, or generated
by initmesh or refinemesh.
Example: [p,e,t] = initmesh(gd)
Data Types: double

e — Mesh edges
matrix

Mesh edges, specified as a 7-by-Ne matrix of edges, where Ne is the number of edges in
the mesh. For a description of the (p,e,t) matrices, see “Mesh Data” on page 2-233.

Typically, you use the p, e, and t data exported from the PDE Modeler app, or generated
by initmesh or refinemesh.
Example: [p,e,t] = initmesh(gd)
Data Types: double
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sdl — Subdomain labels
vector of positive integers

Subdomain labels, specified as a vector of positive integers. For 2-D geometry only. View
the subdomain labels in your geometry using the command

pdegplot(g,'SubdomainLabels','on')

Example: sdl = [1,3:5];
Data Types: double

Output Arguments
Q — Neumann boundary condition matrix
sparse matrix

Neumann boundary condition matrix, returned as a sparse matrix. See “Elliptic
Equations” on page 5-77.

Typically, you use Q in a subsequent call to a solver such as assempde or hyperbolic.

G — Neumann boundary condition vector
sparse vector

Neumann boundary condition vector, returned as a sparse vector. See “Elliptic Equations”
on page 5-77.

Typically, you use G in a subsequent call to a solver such as assempde or hyperbolic.

H — Dirichlet matrix
sparse matrix

Dirichlet matrix, returned as a sparse matrix. See “Algorithms” on page 5-50.

Typically, you use H in a subsequent call to assempde.

R — Dirichlet vector
sparse vector

Dirichlet vector, returned as a sparse vector. See “Algorithms” on page 5-50.
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Typically, you use R in a subsequent call to assempde.

Algorithms
As explained in “Elliptic Equations” on page 5-77, the finite element matrices and
vectors correspond to the reduced linear system and are the following.

• Q is the integral of the q boundary condition against the basis functions.
• G is the integral of the g boundary condition against the basis functions.
• H is the Dirichlet condition matrix representing hu = r.
• R is the Dirichlet condition vector for Hu = R.

For more information on the reduced linear system form of the finite element matrices,
see the assempde “Definitions” on page 5-76 section, and the linear algebra approach
detailed in “Systems of PDEs” on page 5-84.

See Also
assembleFEMatrices

Introduced before R2006a
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assembleFEMatrices
Assemble finite element matrices

Syntax
FEM = assembleFEMatrices(model)
FEM = assembleFEMatrices(model,bcmethod)

Description
FEM = assembleFEMatrices(model) returns a structural array containing finite
element matrices. Model attributes, such as coefficients, material properties, boundary
conditions, and so on, must not depend on time or solution.

FEM = assembleFEMatrices(model,bcmethod) assembles finite element matrices
and imposes boundary conditions using the method specified by bcmethod.

Examples

Finite Element Matrices for 2-D Problem

Create a PDE model for the Poisson equation on an L-shaped membrane with zero
Dirichlet boundary conditions.

model = createpde(1);
geometryFromEdges(model,@lshapeg);
specifyCoefficients(model,'m',0,'d',0,'c',1,'a',0,'f',1);
applyBoundaryCondition(model,'edge',1:model.Geometry.NumEdges,'u',0);

Generate a mesh and obtain the default finite element matrices for the problem and
mesh.

generateMesh(model,'Hmax',0.2);
FEM = assembleFEMatrices(model)
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FEM = struct with fields:
    K: [401x401 double]
    A: [401x401 double]
    F: [401x1 double]
    Q: [401x401 double]
    G: [401x1 double]
    H: [80x401 double]
    R: [80x1 double]
    M: [401x401 double]

Finite Element Matrices with nullspace Method

Create a PDE model for the Poisson equation on an L-shaped membrane with zero
Dirichlet boundary conditions.

model = createpde(1);
geometryFromEdges(model,@lshapeg);
specifyCoefficients(model,'m',0,'d',0,'c',1,'a',0,'f',1);
applyBoundaryCondition(model,'edge',1:model.Geometry.NumEdges,'u',0);

Generate a mesh and obtain the nullspace finite element matrices for the problem and
mesh.

generateMesh(model,'Hmax',0.2);
FEM = assembleFEMatrices(model,'nullspace')

FEM = struct with fields:
    Kc: [321x321 double]
    Fc: [321x1 double]
     B: [401x321 double]
    ud: [401x1 double]
     M: [321x321 double]

Obtain the solution to the PDE.

u = FEM.B*(FEM.Kc\FEM.Fc) + FEM.ud;

Compare this result to the solution given by solvepde. The two solutions are identical.

u1 = solvepde(model);
norm(u - u1.NodalSolution)
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ans = 0

Finite Element Matrices for Thermal Model

Assemble the intermediate finite element matrices for a thermal problem.

Create a transient thermal model and include the geometry of the built-in function
squareg.

thermalmodel = createpde('thermal','transient');
geometryFromEdges(thermalmodel,@squareg);

Plot the geometry with the edge labels.

pdegplot(thermalmodel,'EdgeLabels','on')
xlim([-1.1 1.1])
ylim([-1.1 1.1])
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Specify the thermal conductivity, mass density, and specific heat of the material.

thermalProperties(thermalmodel,'ThermalConductivity',0.2, ...
                               'MassDensity',2.7*10^(-6), ...
                               'SpecificHeat',920); 

Set the boundary and initial conditions.

thermalBC(thermalmodel,'Edge',1:4,'Temperature',100);
thermalIC(thermalmodel,0,'Face',1);

Generate a mesh and obtain the default finite element matrices.

generateMesh(thermalmodel);
FEM = assembleFEMatrices(thermalmodel)
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FEM = struct with fields:
    K: [1541x1541 double]
    A: [1541x1541 double]
    F: [1541x1 double]
    Q: [1541x1541 double]
    G: [1541x1 double]
    H: [144x1541 double]
    R: [144x1 double]
    M: [1541x1541 double]

Input Arguments
model — Model object
PDEModel object | ThermalModel object | StructuralModel object

Model object, specified as a PDEModel object, ThermalModel object, or
StructuralModel object.
Example: model = createpde(1)
Example: thermalmodel = createpde('thermal','steadystate')
Example: structuralmodel = createpde('structural','static-solid')

bcmethod — Method for including boundary conditions
'none' (default) | 'nullspace' | 'stiff-spring'

Method for including boundary conditions, specified as 'none', 'nullspace', or
'stiff-spring'. For more information, see “Algorithms” on page 5-56.
Example: FEM = assembleFEMatrices(model,'nullspace')
Data Types: char | string

Output Arguments
FEM — Finite element matrices
structural array

Finite element matrices, returned as a structural array. The fields in the structural array
depend on bcmethod as follows:
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• If the value is 'none', then the fields are K, A, F, Q, G, H, R, and M.
• If the value is 'nullspace', then the fields are Kc, Fc, B, ud, and M.
• If the value is 'stiff-spring', then the fields are Ks, Fs, and M.

For more information, see “Algorithms” on page 5-56.

Tips
• The mass matrix M is nonzero when the model is time-dependent. By using this matrix,

you can solve a model with Rayleigh damping. For an example, see “Dynamics of
Damped Cantilever Beam”.

• For a thermal model, the m and a coefficients are zeros. The thermal conductivity maps
to the c coefficient. The product of the mass density and the specific heat maps to the
d coefficient. The internal heat source maps to the f coefficient.

• For a structural model, the a coefficient is zero. The Young's modulus and Poisson's
ratio map to the c coefficient. The mass density maps to the m coefficient. The body
loads map to the f coefficient. When you specify the damping model by using the
Rayleigh damping parameters Alpha and Beta, the discretized damping matrix C is
computed by using the mass matrix M and the stiffness matrix K as C = Alpha*M
+Beta*K.

Algorithms
The full finite element matrices and vectors are as follows:

• K is the stiffness matrix, the integral of the c coefficient against the basis functions.
• M is the mass matrix, the integral of the m or d coefficient against the basis functions.
• A is the integral of the a coefficient against the basis functions.
• F is the integral of the f coefficient against the basis functions.
• Q is the integral of the q boundary condition against the basis functions.
• G is the integral of the g boundary condition against the basis functions.
• The H and R matrices come directly from the Dirichlet conditions and the mesh.

Given these matrices, the 'nullspace' technique generates the combined finite element
matrices [Kc,Fc,B,ud] as follows. The combined stiffness matrix is for the reduced linear
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system Kc = K + M + Q. The corresponding combined load vector is Fc = F + G. The
B matrix spans the null space of the columns of H (the Dirichlet condition matrix
representing hu = r). The R vector represents the Dirichlet conditions in Hu = R. The ud
vector represents the boundary condition solutions for the Dirichlet conditions.

From the 'nullspace' matrices, you can compute the solution u as

u = B*(Kc\Fc) + ud.

Note Internally, for time-independent problems, solvepde uses the 'nullspace'
technique, and calculates solutions using u = B*(Kc\Fc) + ud.

The 'stiff-spring' technique returns a matrix Ks and a vector Fs that together
represent a different type of combined finite element matrices. The approximate solution
u is u = Ks\Fs.

Compared to the 'nullspace' technique, the 'stiff-spring' technique generates
matrices more quickly, but generally gives less accurate solutions.

See Also
PDEModel | StructuralModel | ThermalModel | solve | solvepde

Topics
“Finite Element Method Basics” on page 1-18

Introduced in R2016a
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assempde
(Not recommended) Assemble finite element matrices and solve elliptic PDE

Note assempde is not recommended. Use solvepde instead.

Syntax
u = assempde(model,c,a,f)
u = assempde(b,p,e,t,c,a,f)

[Kc,Fc,B,ud] = assempde( ___ )
[Ks,Fs] = assempde( ___ )

[K,M,F,Q,G,H,R] = assempde( ___ )
[K,M,F,Q,G,H,R] = assempde( ___ ,[],sdl)

u = assempde(K,M,F,Q,G,H,R)
[Ks,Fs] = assempde(K,M,F,Q,G,H,R)
[Kc,Fc,B,ud] = assempde(K,M,F,Q,G,H,R)

Description
u = assempde(model,c,a,f) solves the PDE

−∇ ⋅ c∇u + au = f

with geometry, boundary conditions, and finite element mesh in model, and coefficients c,
a, and f. If the PDE is a system of equations (model.PDESystemSize > 1), then
assempde solves the system of equations

−∇ ⋅ c⊗ ∇u + au = f

u = assempde(b,p,e,t,c,a,f) solves the PDE with boundary conditions b, and finite
element mesh (p,e,t).

[Kc,Fc,B,ud] = assempde( ___ ), for any of the previous input syntaxes, assembles
finite element matrices using the reduced linear system form, which eliminates any
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Dirichlet boundary conditions from the system of linear equations. You can calculate the
solution u at node points by the command u = B*(Kc\Fc) + ud. See “Reduced Linear
System” on page 5-76.

[Ks,Fs] = assempde( ___ ) assembles finite element matrices that represent any
Dirichlet boundary conditions using a stiff-spring approximation. You can calculate the
solution u at node points by the command u = Ks\Fs. See “Stiff-Spring Approximation”
on page 5-76.

[K,M,F,Q,G,H,R] = assempde( ___ ) assembles finite element matrices that
represent the PDE problem. This syntax returns all the matrices involved in converting
the problem to finite element form. See “Algorithms” on page 5-77.

[K,M,F,Q,G,H,R] = assempde( ___ ,[],sdl) restricts the finite element matrices to
those that include the subdomain specified by the subdomain labels in sdl. The empty
argument is required in this syntax for historic and compatibility reasons.

u = assempde(K,M,F,Q,G,H,R) returns the solution u based on the full collection of
finite element matrices.

[Ks,Fs] = assempde(K,M,F,Q,G,H,R) returns finite element matrices that
approximate Dirichlet boundary conditions using the stiff-spring approximation. See
“Algorithms” on page 5-77.

[Kc,Fc,B,ud] = assempde(K,M,F,Q,G,H,R) returns finite element matrices that
eliminate any Dirichlet boundary conditions from the system of linear equations. See
“Algorithms” on page 5-77.

Examples

Solve a Scalar PDE

Solve an elliptic PDE on an L-shaped region.

Create a scalar PDE model. Incorporate the geometry of an L-shaped region.

model = createpde;
geometryFromEdges(model,@lshapeg);

Apply zero Dirichlet boundary conditions to all edges.
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applyBoundaryCondition(model,'Edge',1:model.Geometry.NumEdges,'u',0);

Generate a finite element mesh.

generateMesh(model,'GeometricOrder','linear');

Solve the PDE −∇ ⋅ c∇u + au = f  with parameters c = 1, a = 0, and f = 5.

c = 1;
a = 0;
f = 5;
u = assempde(model,c,a,f);

Plot the solution.

pdeplot(model,'XYData',u)
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3-D Elliptic Problem

Solve a 3-D elliptic PDE using a PDE model.

Create a PDE model container, import a 3-D geometry description, and view the geometry.

model = createpde;
importGeometry(model,'Block.stl');
pdegplot(model,'FaceLabels','on','FaceAlpha',0.5)
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Set zero Dirichlet conditions on faces 1 through 4 (the edges). Set Neumann conditions
with g = -1 on face 6 and g = 1 on face 5.

applyBoundaryCondition(model,'Face',1:4,'u',0);
applyBoundaryCondition(model,'Face',6,'g',-1);
applyBoundaryCondition(model,'Face',5,'g',1);

Set coefficients c = 1, a = 0, and f = 0.1.

c = 1;
a = 0;
f = 0.1;

Create a mesh and solve the problem.

5 Functions — Alphabetical List

5-62



generateMesh(model);
u = assempde(model,c,a,f);

Plot the solution on the surface.

pdeplot3D(model,'ColorMapData',u)

2-D PDE Using [p,e,t] Mesh

Solve a 2-D PDE using the older syntax for mesh.

Create a circle geometry.
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g = @circleg;

Set zero Dirichlet boundary conditions.

b = @circleb1;

Create a mesh for the geometry.

[p,e,t] = initmesh(g);

Solve the PDE −∇ ⋅ c∇u + au = f  with parameters c = 1, a = 0, and f = sin(x).

c = 1;
a = 0;
f = 'sin(x)';
u = assempde(b,p,e,t,c,a,f);

Plot the solution.

pdeplot(p,e,t,'XYData',u)
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Finite Element Matrices

Obtain the finite-element matrices that represent the problem using a reduced linear
algebra representation of Dirichlet boundary conditions.

Create a scalar PDE model. Import a simple 3-D geometry.

model = createpde;
importGeometry(model,'Block.stl');

Set zero Dirichlet boundary conditions on all the geometry faces.
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applyBoundaryCondition(model,'dirichlet','Face',1:model.Geometry.NumFaces,'u',0);

Generate a mesh for the geometry.

generateMesh(model);

Obtain finite element matrices K, F, B, and ud that represent the equation
−∇ ⋅ c∇u + au = f  with parameters c = 1, a = 0, and f = log 1 + x + y

1 + z .

c = 1;
a = 0;
f = 'log(1+x+y./(1+z))';
[K,F,B,ud] = assempde(model,c,a,f);

You can obtain the solution u of the PDE at mesh nodes by executing the command

u = B*(K\F) + ud;

Generally, this solution is slightly more accurate than the stiff-spring solution, as
calculated in the next example.

Stiff-Spring Finite Element Solution

Obtain the stiff-spring approximation of finite element matrices.

Create a scalar PDE model. Import a simple 3-D geometry.

model = createpde;
importGeometry(model,'Block.stl');

Set zero Dirichlet boundary conditions on all the geometry faces.

applyBoundaryCondition(model,'Face',1:model.Geometry.NumFaces,'u',0);

Generate a mesh for the geometry.

generateMesh(model);

Obtain finite element matrices Ks and Fs that represent the equation −∇ ⋅ c∇u + au = f
with parameters c = 1, a = 0, and f = log 1 + x + y

1 + z .
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c = 1;
a = 0;
f = 'log(1+x+y./(1+z))';
[Ks,Fs] = assempde(model,c,a,f);

You can obtain the solution u of the PDE at mesh nodes by executing the command

u = Ks\Fs;

Generally, this solution is slightly less accurate than the reduced linear algebra solution,
as calculated in the previous example.

Full Collection of Finite Element Matrices

Obtain the full collection of finite element matrices for an elliptic problem.

Import geometry and set up an elliptic problem with Dirichlet boundary conditions. The
Torus.stl geometry has only one face, so you need set only one boundary condition.

model = createpde();
importGeometry(model,'Torus.stl');
applyBoundaryCondition(model,'face',1,'u',0);
c = 1;
a = 0;
f = 1;
generateMesh(model);

Create the finite element matrices that represent this problem.

[K,M,F,Q,G,H,R] = assempde(model,c,a,f);

Most of the resulting matrices are quite sparse. G, M, Q, and R are all zero sparse
matrices.

howsparse = @(x)nnz(x)/numel(x);
disp(['Maximum fraction of nonzero entries in K or H is ',...
       num2str(max(howsparse(K),howsparse(H)))])

Maximum fraction of nonzero entries in K or H is 0.002006

To find the solution to the PDE, call assempde again.

u = assempde(K,M,F,Q,G,H,R);
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Input Arguments
model — PDE model
PDEModel object

PDE model, specified as a PDEModel object.
Example: model = createpde

c — PDE coefficient
scalar | matrix | character vector | character array | string scalar | string vector |
coefficient function

PDE coefficient, specified as a scalar, matrix, character vector, character array, string
scalar, string vector, or coefficient function. c represents the c coefficient in the scalar
PDE

−∇ ⋅ c∇u + au = f

or in the system of PDEs

−∇ ⋅ c⊗ ∇u + au = f

You can specifyc in various ways, detailed in “c Coefficient for Systems” on page 2-122.
See also “Specify Scalar PDE Coefficients in Character Form” on page 2-74, “Specify 2-D
Scalar Coefficients in Function Form” on page 2-80, and “Specify 3-D PDE Coefficients in
Function Form” on page 2-83.
Example: 'cosh(x+y.^2)'
Data Types: double | char | string | function_handle
Complex Number Support: Yes

a — PDE coefficient
scalar | matrix | character vector | character array | string scalar | string vector |
coefficient function

PDE coefficient, specified as a scalar, matrix, character vector, character array, string
scalar, string vector, or coefficient function. a represents the a coefficient in the scalar
PDE

−∇ ⋅ c∇u + au = f
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or in the system of PDEs

−∇ ⋅ c⊗ ∇u + au = f

You can specifya in various ways, detailed in “a or d Coefficient for Systems” on page 2-
147. See also “Specify Scalar PDE Coefficients in Character Form” on page 2-74, “Specify
2-D Scalar Coefficients in Function Form” on page 2-80, and “Specify 3-D PDE
Coefficients in Function Form” on page 2-83.
Example: 2*eye(3)
Data Types: double | char | string | function_handle
Complex Number Support: Yes

f — PDE coefficient
scalar | matrix | character vector | character array | string scalar | string vector |
coefficient function

PDE coefficient, specified as a scalar, matrix, character vector, character array, string
scalar, string vector, or coefficient function. f represents the f coefficient in the scalar
PDE

−∇ ⋅ c∇u + au = f

or in the system of PDEs

−∇ ⋅ c⊗ ∇u + au = f

You can specifyf in various ways, detailed in “f Coefficient for Systems” on page 2-94. See
also “Specify Scalar PDE Coefficients in Character Form” on page 2-74, “Specify 2-D
Scalar Coefficients in Function Form” on page 2-80, and “Specify 3-D PDE Coefficients in
Function Form” on page 2-83.
Example: char('sin(x)';'cos(y)';'tan(z)')
Data Types: double | char | string | function_handle
Complex Number Support: Yes

b — Boundary conditions
boundary matrix | boundary file

Boundary conditions, specified as a boundary matrix or boundary file. Pass a boundary file
as a function handle or as a file name.
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• A boundary matrix is generally an export from the PDE Modeler app. For details of the
structure of this matrix, see “Boundary Matrix for 2-D Geometry” on page 2-168.

• A boundary file is a file that you write in the syntax specified in “Boundary Conditions
by Writing Functions” on page 2-197.

Example: b = 'circleb1', b = "circleb1", or b = @circleb1
Data Types: double | char | string | function_handle

p — Mesh points
matrix

Mesh points, specified as a 2-by-Np matrix of points, where Np is the number of points in
the mesh. For a description of the (p,e,t) matrices, see “Mesh Data” on page 2-233.

Typically, you use the p, e, and t data exported from the PDE Modeler app, or generated
by initmesh or refinemesh.
Example: [p,e,t] = initmesh(gd)
Data Types: double

e — Mesh edges
matrix

Mesh edges, specified as a 7-by-Ne matrix of edges, where Ne is the number of edges in
the mesh. For a description of the (p,e,t) matrices, see “Mesh Data” on page 2-233.

Typically, you use the p, e, and t data exported from the PDE Modeler app, or generated
by initmesh or refinemesh.
Example: [p,e,t] = initmesh(gd)
Data Types: double

t — Mesh triangles
matrix

Mesh triangles, specified as a 4-by-Nt matrix of triangles, where Nt is the number of
triangles in the mesh. For a description of the (p,e,t) matrices, see “Mesh Data” on page
2-233.

Typically, you use the p, e, and t data exported from the PDE Modeler app, or generated
by initmesh or refinemesh.
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Example: [p,e,t] = initmesh(gd)
Data Types: double

K — Stiffness matrix
sparse matrix | full matrix

Stiffness matrix, specified as a sparse matrix or full matrix. Generally, you obtain K from a
previous call to assema or assempde. For the meaning of stiffness matrix, see “Elliptic
Equations” on page 5-77.
Example: [K,M,F,Q,G,H,R] = assempde(model,c,a,f)
Data Types: double
Complex Number Support: Yes

M — Mass matrix
sparse matrix | full matrix

Mass matrix, specified as a sparse matrix or full matrix. Generally, you obtain M from a
previous call to assema or assempde. For the meaning of mass matrix, see “Elliptic
Equations” on page 5-77.
Example: [K,M,F,Q,G,H,R] = assempde(model,c,a,f)
Data Types: double
Complex Number Support: Yes

F — Finite element f representation
vector

Finite element f representation, specified as a vector. Generally, you obtain F from a
previous call to assema or assempde. For the meaning of this representation, see
“Elliptic Equations” on page 5-77.
Example: [K,M,F,Q,G,H,R] = assempde(model,c,a,f)
Data Types: double
Complex Number Support: Yes

Q — Neumann boundary condition matrix
sparse matrix | full matrix

Neumann boundary condition matrix, specified as a sparse matrix or full matrix.
Generally, you obtain Q from a previous call to assemb or assempde. For the meaning of
this matrix, see “Elliptic Equations” on page 5-77.
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Example: [K,M,F,Q,G,H,R] = assempde(model,c,a,f)
Data Types: double
Complex Number Support: Yes

G — Neumann boundary condition vector
sparse vector | full vector

Neumann boundary condition vector, specified as a sparse vector or full vector. Generally,
you obtain G from a previous call to assemb or assempde. For the meaning of this vector,
see “Elliptic Equations” on page 5-77.
Example: [K,M,F,Q,G,H,R] = assempde(model,c,a,f)
Data Types: double
Complex Number Support: Yes

H — Dirichlet boundary condition matrix
sparse matrix | full matrix

Dirichlet boundary condition matrix, specified as a sparse matrix or full matrix. Generally,
you obtain H from a previous call to assemb or assempde. For the meaning of this matrix,
see “Algorithms” on page 5-77.
Example: [K,M,F,Q,G,H,R] = assempde(model,c,a,f)
Data Types: double
Complex Number Support: Yes

R — Dirichlet boundary condition vector
sparse vector | full vector

Dirichlet boundary condition vector, specified as a sparse vector or full vector. Generally,
you obtain R from a previous call to assemb or assempde. For the meaning of this vector,
see “Algorithms” on page 5-77.
Example: [K,M,F,Q,G,H,R] = assempde(model,c,a,f)
Data Types: double
Complex Number Support: Yes

sdl — Subdomain labels
vector of positive integers

Subdomain labels, specified as a vector of positive integers. For 2-D geometry only. View
the subdomain labels in your geometry using the command
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pdegplot(g,'SubdomainLabels','on')

Example: sdl = [1,3:5];
Data Types: double

Output Arguments
u — PDE solution
vector

PDE solution, returned as a vector.

• If the PDE is scalar, meaning only one equation, then u is a column vector
representing the solution u at each node in the mesh. u(i) is the solution at the ith
column of model.Mesh.Nodes or the ith column of p.

• If the PDE is a system of N > 1 equations, then u is a column vector with N*Np
elements, where Np is the number of nodes in the mesh. The first Np elements of u
represent the solution of equation 1, then next Np elements represent the solution of
equation 2, etc.

To obtain the solution at an arbitrary point in the geometry, use pdeInterpolant.

To plot the solution, use pdeplot for 2-D geometry, or see “Plot 3-D Solutions and Their
Gradients” on page 3-295.

Kc — Stiffness matrix
sparse matrix

Stiffness matrix, returned as a sparse matrix. See “Elliptic Equations” on page 5-77.

u1 = Kc\Fc returns the solution on the non-Dirichlet points. To obtain the solution u at
the nodes of the mesh,

u = B*(Kc\Fc) + ud

Generally, Kc, Fc, B, and ud make a slower but more accurate solution than Ks and Fs.

Fc — Load vector
vector

Load vector, returned as a vector. See “Elliptic Equations” on page 5-77.
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u = B*(Kc\Fc) + ud

Generally, Kc, Fc, B, and ud make a slower but more accurate solution than Ks and Fs.

B — Dirichlet nullspace
sparse matrix

Dirichlet nullspace, returned as a sparse matrix. See “Algorithms” on page 5-77.

u = B*(Kc\Fc) + ud

Generally, Kc, Fc, B, and ud make a slower but more accurate solution than Ks and Fs.

ud — Dirichlet vector
vector

Dirichlet vector, returned as a vector. See “Algorithms” on page 5-77.

u = B*(Kc\Fc) + ud

Generally, Kc, Fc, B, and ud make a slower but more accurate solution than Ks and Fs.

Ks — Stiffness matrix corresponding to the stiff-spring approximation for
Dirichlet boundary condition
sparse matrix

Finite element matrix for stiff-spring approximation, returned as a sparse matrix. See
“Algorithms” on page 5-77.

To obtain the solution u at the nodes of the mesh,

u = Ks\Fs.

Generally, Ks and Fs make a quicker but less accurate solution than Kc, Fc, B, and ud.

Fs — Load vector corresponding to the stiff-spring approximation for Dirichlet
boundary condition
vector

Load vector corresponding to the stiff-spring approximation for Dirichlet boundary
condition, returned as a vector. See “Algorithms” on page 5-77.

To obtain the solution u at the nodes of the mesh,
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u = Ks\Fs.

Generally, Ks and Fs make a quicker but less accurate solution than Kc, Fc, B, and ud.

K — Stiffness matrix
sparse matrix

Stiffness matrix, returned as a sparse matrix. See “Elliptic Equations” on page 5-77.

K represents the stiffness matrix alone, unlike Kc or Ks, which are stiffness matrices
combined with other terms to enable immediate solution of a PDE.

Typically, you use K in a subsequent call to a solver such as assempde or hyperbolic.

M — Mass matrix
sparse matrix

Mass matrix. returned as a sparse matrix. See “Elliptic Equations” on page 5-77.

Typically, you use M in a subsequent call to a solver such as assempde or hyperbolic.

F — Load vector
vector

Load vector, returned as a vector. See “Elliptic Equations” on page 5-77.

F represents the load vector alone, unlike Fc or Fs, which are load vectors combined with
other terms to enable immediate solution of a PDE.

Typically, you use F in a subsequent call to a solver such as assempde or hyperbolic.

Q — Neumann boundary condition matrix
sparse matrix

Neumann boundary condition matrix, returned as a sparse matrix. See “Elliptic
Equations” on page 5-77.

Typically, you use Q in a subsequent call to a solver such as assempde or hyperbolic.

G — Neumann boundary condition vector
sparse vector

Neumann boundary condition vector, returned as a sparse vector. See “Elliptic Equations”
on page 5-77.
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Typically, you use G in a subsequent call to a solver such as assempde or hyperbolic.

H — Dirichlet matrix
sparse matrix

Dirichlet matrix, returned as a sparse matrix. See “Algorithms” on page 5-77.

Typically, you use H in a subsequent call to a solver such as assempde or hyperbolic.

R — Dirichlet vector
sparse vector

Dirichlet vector, returned as a sparse vector. See “Algorithms” on page 5-77.

Typically, you use R in a subsequent call to a solver such as assempde or hyperbolic.

Definitions

Reduced Linear System
This form of the finite element matrices eliminates Dirichlet conditions from the problem
using a linear algebra approach. The finite element matrices reduce to the solution u =
B*(Kc\Fc) + ud, where B spans the null space of the columns of H (the Dirichlet
condition matrix representing hu = r). R is the Dirichlet condition vector for Hu = R. ud
is the vector of boundary condition solutions for the Dirichlet conditions. u1 = Kc\Fc
returns the solution on the non-Dirichlet points.

See “Systems of PDEs” on page 5-84 for details on the approach used to eliminate
Dirichlet conditions.

Stiff-Spring Approximation
This form of the finite element matrices converts Dirichlet boundary conditions to
Neumann boundary conditions using a stiff-spring approximation. Using this
approximation, assempde returns a matrix Ks and a vector Fs that represent the
combined finite element matrices. The approximate solution u is u = Ks\Fs.

See “Elliptic Equations” on page 5-77. For details of the stiff-spring approximation, see
“Systems of PDEs” on page 5-84.
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Algorithms

Elliptic Equations
Partial Differential Equation Toolbox solves equations of the form

m∂
2u
∂t2 + d∂u∂t − ∇ · c∇u + au = f

When the m and d coefficients are 0, this reduces to

−∇ ⋅ c∇u + au = f

which the documentation calls an elliptic equation, whether or not the equation is elliptic
in the mathematical sense. The equation holds in Ω, where Ω is a bounded domain in two
or three dimensions. c, a, f, and the unknown solution u are complex functions defined on
Ω. c can also be a 2-by-2 matrix function on Ω. The boundary conditions specify a
combination of u and its normal derivative on the boundary:

• Dirichlet: hu = r on the boundary ∂Ω.
• Generalized Neumann: n  · (c∇u) + qu = g on ∂Ω.
• Mixed: Only applicable to systems. A combination of Dirichlet and generalized

Neumann.

n  is the outward unit normal. g, q, h, and r are functions defined on ∂Ω.

Our nomenclature deviates slightly from the tradition for potential theory, where a
Neumann condition usually refers to the case q = 0 and our Neumann would be called a
mixed condition. In some contexts, the generalized Neumann boundary conditions is also
referred to as the Robin boundary conditions. In variational calculus, Dirichlet conditions
are also called essential boundary conditions and restrict the trial space. Neumann
conditions are also called natural conditions and arise as necessary conditions for a
solution. The variational form of the Partial Differential Equation Toolbox equation with
Neumann conditions is given below.

The approximate solution to the elliptic PDE is found in three steps:

1 Describe the geometry of the domain Ω and the boundary conditions. For 2-D
geometry, create geometry using the PDE Modeler app or through MATLAB files. For
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3-D geometry, import the geometry in STL file format. See “Geometry”, “STL File
Import” on page 2-46, and “Boundary Conditions”.

2 Build a triangular mesh on the domain Ω. The software has mesh generating and
mesh refining facilities. A mesh is described by three matrices of fixed format that
contain information about the mesh points, the boundary segments, and the
elements.

3 Discretize the PDE and the boundary conditions to obtain a linear system Ku = F. The
unknown vector u contains the values of the approximate solution at the mesh points,
the matrix K is assembled from the coefficients c, a, h, and q and the right-hand side
F contains, essentially, averages of f around each mesh point and contributions from
g. Once the matrices K and F are assembled, you have the entire MATLAB
environment at your disposal to solve the linear system and further process the
solution.

More elaborate applications make use of the Finite Element Method (FEM) specific
information returned by the different functions of the software. Therefore we quickly
summarize the theory and technique of FEM solvers to enable advanced applications to
make full use of the computed quantities.

FEM can be summarized in the following sentence: Project the weak form of the
differential equation onto a finite-dimensional function space. The rest of this section
deals with explaining the preceding statement.

We start with the weak form of the differential equation. Without restricting the
generality, we assume generalized Neumann conditions on the whole boundary, since
Dirichlet conditions can be approximated by generalized Neumann conditions. In the
simple case of a unit matrix h, setting g = qr and then letting q → ∞ yields the Dirichlet
condition because division with a very large q cancels the normal derivative terms. The
actual implementation is different, since the preceding procedure may create
conditioning problems. The mixed boundary condition of the system case requires a more
complicated treatment, described in “Systems of PDEs” on page 5-84.

Assume that u is a solution of the differential equation. Multiply the equation with an
arbitrary test function v and integrate on Ω:

∫
Ω

− ∇ · c∇u v + auv dx = ∫
Ω

f v dx

Integrate by parts (i.e., use Green's formula) to obtain
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∫
Ω

c∇u · ∇v + auv dx− ∫
∂Ω

n · c∇u v ds = ∫
Ω

f v dx

The boundary integral can be replaced by the boundary condition:

∫
Ω

c∇u · ∇v + auv dx− ∫
∂Ω

−qu + g v ds = ∫
Ω

f v dx

Replace the original problem with Find u such that

∫
Ω

c∇u · ∇v + auv− f v dx− ∫
∂Ω

−qu + g v ds = 0 ∀v

This equation is called the variational, or weak, form of the differential equation.
Obviously, any solution of the differential equation is also a solution of the variational
problem. The reverse is true under some restrictions on the domain and on the coefficient
functions. The solution of the variational problem is also called the weak solution of the
differential equation.

The solution u and the test functions v belong to some function space V. The next step is
to choose an Np-dimensional subspace VNp ⊂ V. Project the weak form of the differential
equation onto a finite-dimensional function space simply means requesting u and v to lie
in VNp rather than V. The solution of the finite dimensional problem turns out to be the
element of VNp that lies closest to the weak solution when measured in the energy norm.
Convergence is guaranteed if the space VNp tends to V as Np→∞. Since the differential
operator is linear, we demand that the variational equation is satisfied for Np test-
functions Φi ∊VNp that form a basis, i.e.,

∫
Ω

c∇u · ∇ϕi + auϕi− fϕi dx− ∫
∂Ω

−qu + g ϕi ds = 0, i = 1, ..., Np

Expand u in the same basis of VNp elements

u(x) = ∑
j = 1

Np
U jϕ j(x)

and obtain the system of equations
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∑
j = 1

Np ∫
Ω

c∇ϕ j · ∇ϕi + aϕ jϕi dx + ∫
∂Ω

qϕ jϕi ds U j = ∫
Ω

fϕi dx + ∫
∂Ω

gϕi ds,  i = 1, ... ,

Np

Use the following notations:

Ki, j = ∫
Ω

c∇ϕ j ⋅ ∇ϕi dx (stiffness matrix)

Mi, j = ∫
Ω

aϕ jϕi dx (mass matrix)

Qi, j = ∫
∂Ω

qϕ jϕi ds

Fi = ∫
Ω

fϕi dx

Gi = ∫
∂Ω

gϕi ds

and rewrite the system in the form

(K + M + Q)U = F + G.  (5-2)

K, M, and Q are Np-by-Np matrices, and F and G are Np-vectors. K, M, and F are produced
by assema, while Q, G are produced by assemb. When it is not necessary to distinguish
K, M, and Q or F and G, we collapse the notations to KU = F, which form the output of
assempde.

When the problem is self-adjoint and elliptic in the usual mathematical sense, the matrix
K + M + Q becomes symmetric and positive definite. Many common problems have these
characteristics, most notably those that can also be formulated as minimization problems.
For the case of a scalar equation, K, M, and Q are obviously symmetric. If c(x) ≥ δ > 0,
a(x) ≥ 0 and q(x) ≥ 0 with q(x) > 0 on some part of ∂Ω, then, if U ≠ 0.

UT K + M + Q U = ∫
Ω

c u 2 + au2 dx + ∫
∂Ω

qu2 ds > 0, if U ≠ 0
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UT(K + M + Q)U is the energy norm. There are many choices of the test-function spaces.
The software uses continuous functions that are linear on each element of a 2-D mesh,
and are linear or quadratic on elements of a 3-D mesh. Piecewise linearity guarantees
that the integrals defining the stiffness matrix K exist. Projection onto VNp is nothing
more than linear interpolation, and the evaluation of the solution inside an element is
done just in terms of the nodal values. If the mesh is uniformly refined, VNp approximates
the set of smooth functions on Ω.

A suitable basis for VNp in 2-D is the set of “tent” or “hat” functions ϕi. These are linear
on each element and take the value 0 at all nodes xj except for xi. For the definition of
basis functions for 3-D geometry, see “Finite Element Basis for 3-D” on page 5-88.
Requesting ϕi(xi) = 1 yields the very pleasant property

u xi = ∑
j = 1

Np
U jϕ j xi = Ui

That is, by solving the FEM system we obtain the nodal values of the approximate
solution. The basis function ϕi vanishes on all the elements that do not contain the node
xi. The immediate consequence is that the integrals appearing in Ki,j, Mi,j, Qi,j, Fi and Gi
only need to be computed on the elements that contain the node xi. Secondly, it means
that Ki,j andMi,j are zero unless xi and xj are vertices of the same element and thus K and
M are very sparse matrices. Their sparse structure depends on the ordering of the indices
of the mesh points.

The integrals in the FEM matrices are computed by adding the contributions from each
element to the corresponding entries (i.e., only if the corresponding mesh point is a
vertex of the element). This process is commonly called assembling, hence the name of
the function assempde.

The assembling routines scan the elements of the mesh. For each element they compute
the so-called local matrices and add their components to the correct positions in the
sparse matrices or vectors.

The discussion now specializes to triangular meshes in 2-D. The local 3-by-3 matrices
contain the integrals evaluated only on the current triangle. The coefficients are assumed
constant on the triangle and they are evaluated only in the triangle barycenter. The
integrals are computed using the midpoint rule. This approximation is optimal since it has
the same order of accuracy as the piecewise linear interpolation.

Consider a triangle given by the nodes P1, P2, and P3 as in the following figure.
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The Local Triangle P1P2P3

Note The local 3-by-3 matrices contain the integrals evaluated only on the current
triangle. The coefficients are assumed constant on the triangle and they are evaluated
only in the triangle barycenter.

The simplest computations are for the local mass matrix m:

mi, j = ∫
ΔP1P2P3

a Pc ϕi x ϕ j x dx = a Pc
area ΔP1P2P3

12 1 + δi, j

where Pc is the center of mass of Δ P1P2P3, i.e.,

Pc =
P1 + P2 + P3

3
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The contribution to the right side F is just

f i = f Pc
area ΔP1P2P3

3

For the local stiffness matrix we have to evaluate the gradients of the basis functions that
do not vanish on P1P2P3. Since the basis functions are linear on the triangle P1P2P3, the
gradients are constants. Denote the basis functions ϕ1, ϕ2, and ϕ3 such that ϕ(Pi) = 1. If P2
– P3 = [x1,y1]T then we have that

∇ϕ1 = 1
2 area ΔP1P2P3

y1
−x1

and after integration (taking c as a constant matrix on the triangle)

ki, j = 1
4 area ΔP1P2P3

y j, − x j c Pc
y1
−x1

If two vertices of the triangle lie on the boundary ∂Ω, they contribute to the line integrals
associated to the boundary conditions. If the two boundary points are P1 and P2, then we
have

Qi, j = q Pb
P1− P2

6 1 + δi, j , i, j = 1, 2

and

Gi = g Pb
P1− P2

2 , i = 1, 2

where Pb is the midpoint of P1P2.

For each triangle the vertices Pm of the local triangle correspond to the indices im of the
mesh points. The contributions of the individual triangle are added to the matrices such
that, e.g.,

Kim, int Kim, in + km, n, m, n = 1, 2, 3

This is done by the function assempde. The gradients and the areas of the triangles are
computed by the function pdetrg.
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The Dirichlet boundary conditions are treated in a slightly different manner. They are
eliminated from the linear system by a procedure that yields a symmetric, reduced
system. The function assempde can return matrices K, F, B, and ud such that the solution
is u = Bv + ud where Kv = F. u is an Np-vector, and if the rank of the Dirichlet conditions
is rD, then v has Np – rD components.

To summarize, assempde performs the following steps to obtain a solution u to an elliptic
PDE:

1 Generate the finite element matrices [K,M,F,Q,G,H,R]. This step is equivalent to calling
assema to generate the matrices K, M, and F, and also calling assemb to generate the
matrices Q, G, H, and R.

2 Generate the combined finite element matrices [Kc,Fc,B,ud]. The combined stiffness
matrix is for the reduced linear system, Kc = K + M + Q. The corresponding
combined load vector is Fc = F + G. The B matrix spans the null space of the
columns of H (the Dirichlet condition matrix representing hu = r). The R vector
represents the Dirichlet conditions in Hu = R. The ud vector represents boundary
condition solutions for the Dirichlet conditions.

3 Calculate the solution u via

u = B*(Kc\Fc) + ud.  (5-3)

assempde uses one of two algorithms for assembling a problem into combined finite
element matrix form. A reduced linear system form leads to immediate solution via linear
algebra. You choose the algorithm by the number of outputs. For the reduced linear
system form, request four outputs:

[Kc,Fc,B,ud] = assempde(_)  (5-4)

For the stiff-spring approximation, request two outputs:

[Ks,Fs] = assempde(_)  (5-5)

For details, see “Reduced Linear System” on page 5-76 and “Stiff-Spring Approximation”
on page 5-76.

Systems of PDEs
Partial Differential Equation Toolbox software can also handle systems of N partial
differential equations over the domain Ω. We have the elliptic system
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−∇ ⋅ c⊗ ∇u + au = f

the parabolic system

d∂u∂t − ∇ ⋅ c⊗ ∇u + au = f

the hyperbolic system

d∂
2u
∂t2 − ∇ ⋅ c⊗ ∇u + au = f

and the eigenvalue system

−∇ ⋅ c⊗ ∇u + au = λdu

where c is an N-by-N-by-D-by-D tensor, and D is the geometry dimensions, 2 or 3.

For 2-D systems, the notation ∇ ⋅ (c⊗ ∇u) represents an N-by-1 matrix with an (i,1)-
component

∑
j = 1

N ∂
∂x ci, j, 1, 1

∂
∂x + ∂

∂x ci, j, 1, 2
∂
∂y + ∂

∂y ci, j, 2, 1
∂
∂x + ∂

∂y ci, j, 2, 2
∂
∂y u j

For 3-D systems, the notation ∇ ⋅ (c⊗ ∇u) represents an N-by-1 matrix with an (i,1)-
component

∑
j = 1

N ∂
∂x ci, j, 1, 1

∂
∂x + ∂

∂x ci, j, 1, 2
∂
∂y + ∂

∂x ci, j, 1, 3
∂
∂z u j

+ ∑
j = 1

N ∂
∂y ci, j, 2, 1

∂
∂x + ∂

∂y ci, j, 2, 2
∂
∂y + ∂

∂y ci, j, 2, 3
∂
∂z u j

+ ∑
j = 1

N ∂
∂z ci, j, 3, 1

∂
∂x + ∂

∂z ci, j, 3, 2
∂
∂y + ∂

∂z ci, j, 3, 3
∂
∂z u j

The symbols a and d denote N-by-N matrices, and f denotes a column vector of length N.

The elements cijkl, aij, dij, and fi of c, a, d, and f are stored row-wise in the MATLAB
matrices c, a, d, and f. The case of identity, diagonal, and symmetric matrices are
handled as special cases. For the tensor cijkl this applies both to the indices i and j, and to
the indices k and l.
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Partial Differential Equation Toolbox software does not check the ellipticity of the
problem, and it is quite possible to define a system that is not elliptic in the mathematical
sense. The preceding procedure that describes the scalar case is applied to each
component of the system, yielding a symmetric positive definite system of equations
whenever the differential system possesses these characteristics.

The boundary conditions now in general are mixed, i.e., for each point on the boundary a
combination of Dirichlet and generalized Neumann conditions,

hu = r
n · c⊗ ∇u + qu = g + h′μ

For 2-D systems, the notation n · c⊗ ∇u  represents an N-by-1 matrix with (i,1)-
component

∑
j = 1

N
cos(α)ci, j, 1, 1

∂
∂x + cos(α)ci, j, 1, 2

∂
∂y + sin(α)ci, j, 2, 1

∂
∂x + sin(α)ci, j, 2, 2

∂
∂y u j

where the outward normal vector of the boundary is n = cos(α), sin(α) .

For 3-D systems, the notation n · c⊗ ∇u  represents an N-by-1 matrix with (i,1)-
component

∑
j = 1

N
cos(α)ci, j, 1, 1

∂
∂x + cos(α)ci, j, 1, 2

∂
∂y + cos(α)ci, j, 1, 3

∂
∂z u j

+ ∑
j = 1

N
cos(β)ci, j, 2, 1

∂
∂x + cos(β)ci, j, 2, 2

∂
∂y + cos(β)ci, j, 2, 3

∂
∂z u j

+ ∑
j = 1

N
cos(γ)ci, j, 3, 1

∂
∂x + cos(γ)ci, j, 3, 2

∂
∂y + cos(γ)ci, j, 3, 3

∂
∂z u j

where the outward normal to the boundary is

n = cos α , cos β , cos γ

There are M Dirichlet conditions and the h-matrix is M-by-N, M ≥ 0. The generalized
Neumann condition contains a source h′μ, where the Lagrange multipliers μ are
computed such that the Dirichlet conditions become satisfied. In a structural mechanics
problem, this term is exactly the reaction force necessary to satisfy the kinematic
constraints described by the Dirichlet conditions.
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The rest of this section details the treatment of the Dirichlet conditions and may be
skipped on a first reading.

Partial Differential Equation Toolbox software supports two implementations of Dirichlet
conditions. The simplest is the “Stiff Spring” model, so named for its interpretation in
solid mechanics. See “Elliptic Equations” on page 5-77 for the scalar case, which is
equivalent to a diagonal h-matrix. For the general case, Dirichlet conditions

hu = r  (5-6)

are approximated by adding a term

L(h′hu− h′r)

to the equations KU = F, where L is a large number such as 104 times a representative
size of the elements of K.

When this number is increased, hu = r will be more accurately satisfied, but the potential
ill-conditioning of the modified equations will become more serious.

The second method is also applicable to general mixed conditions with nondiagonal h,
and is free of the ill-conditioning, but is more involved computationally. Assume that there
are Np nodes in the mesh. Then the number of unknowns is NpN = Nu. When Dirichlet
boundary conditions fix some of the unknowns, the linear system can be correspondingly
reduced. This is easily done by removing rows and columns when u values are given, but
here we must treat the case when some linear combinations of the components of u are
given, hu = r. These are collected into HU = R where H is an M-by-Nu matrix and R is an
M-vector.

With the reaction force term the system becomes

KU +H´ µ = F  (5-7)

HU = R.  (5-8)

The constraints can be solved for M of the U-variables, the remaining called V, an Nu – M
vector. The null space of H is spanned by the columns of B, and U = BV + ud makes U
satisfy the Dirichlet conditions. A permutation to block-diagonal form exploits the sparsity
of H to speed up the following computation to find B in a numerically stable way. µ can be
eliminated by pre-multiplying by B´ since, by the construction, HB = 0 or B´H´ = 0. The
reduced system becomes

B´ KBV = B´ F – B´Kud  (5-9)
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which is symmetric and positive definite if K is.

Finite Element Basis for 3-D
The finite element method for 3-D geometry is similar to the 2-D method described in
“Elliptic Equations” on page 5-77. The main difference is that the elements in 3-D
geometry are tetrahedra, which means that the basis functions are different from those in
2-D geometry.

It is convenient to map a tetrahedron to a canonical tetrahedron with a local coordinate
system (r,s,t).

r s

t

p1

p2 p3

p4

In local coordinates, the point p1 is at (0,0,0), p2 is at (1,0,0), p3 is at (0,1,0), and p4 is at
(0,0,1).

For a linear tetrahedron, the basis functions are

ϕ1 = 1 − r − s− t
ϕ2 = r
ϕ3 = s
ϕ4 = t

For a quadratic tetrahedron, there are additional nodes at the edge midpoints.
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r s

t

p1

p2 p3

p4

p5

p6

p7

p8
p9 p10

The corresponding basis functions are

ϕ1 = 2 1 − r − s− t 2− 1 − r − s− t

ϕ2 = 2r2− r

ϕ3 = 2s2− s

ϕ4 = 2t2− t
ϕ5 = 4r 1 − r − s− t

ϕ6 = 4rs
ϕ7 = 4s 1 − r − s− t
ϕ8 = 4t 1 − r − s− t

ϕ9 = 4rt
ϕ10 = 4st

As in the 2-D case, a 3-D basis function ϕi takes the value 0 at all nodes j, except for node
i, where it takes the value 1.

See Also
assembleFEMatrices | solvepde
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Introduced before R2006a
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BodyLoadAssignment Properties
Body load assignments

Description
A BodyLoadAssignment object contains a description of the body loads for a structural
analysis model. A StructuralModel container has a vector of BodyLoadAssignment
objects in its BodyLoads.BodyLoadAssignments property.

To create body load assignments for your structural analysis model, use the
structuralBodyLoad function.

Properties
Properties of BodyLoadAssignment

RegionType — Region type
'Face' | 'Cell'

Region type, returned as 'Face' for a 2-D region or 'Cell' for a 3-D region.
Data Types: char

RegionID — Region ID
vector of positive integers

Region ID, returned as a vector of positive integers. To determine which ID corresponds
to which portion of the geometry, use the pdegplot function, setting 'FaceLabels' to
'on'.
Data Types: double

GravitationalAcceleration — Acceleration due to gravity
numeric vector

Acceleration due to gravity, returned as a numeric vector. This property must be specified
in units consistent with the geometry and material properties units.
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Example:
structuralBodyLoad(structuralmodel,'GravitationalAcceleration',
[0,0,-9.8])

Data Types: double

See Also
findBodyLoad | structuralBodyLoad

Introduced in R2017b
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BoundaryCondition Properties
Boundary condition for PDE model

Description
A BoundaryCondition object specifies the type of PDE boundary condition on a set of
geometry boundaries. A PDEModel object contains a vector of BoundaryCondition
objects in its BoundaryConditions property.

Specify boundary conditions for your model using the applyBoundaryCondition
function.

Properties
Properties

BCType — Type of boundary condition
'dirichlet' | 'neumann' | 'mixed'

Boundary type, returned as 'dirichlet', 'neumann', or 'mixed'.
Example: applyBoundaryCondition(model,'dirichlet','Face',3,'u',0)
Data Types: char

RegionType — Geometric region type
'Face' for 3-D geometry | 'Edge' for 2-D geometry

Geometric region type, returned as 'Face' for 3-D geometry or 'Edge' for 2-D
geometry.
Example: applyBoundaryCondition(model,'dirichlet','Face',3,'u',0)
Data Types: char

RegionID — Geometric region ID
vector of positive integers
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Geometric region ID, returned as a vector of positive integers. Find the region IDs using
pdegplot with the 'FaceLabels' (3-D) or 'EdgeLabels' (2-D) value set to 'on'.
Example: applyBoundaryCondition(model,'dirichlet','Face',3:6,'u',0)
Data Types: double

r — Dirichlet condition h*u = r
zeros(N,1) (default) | vector with N elements | function handle

Dirichlet condition h*u = r, returned as a vector with N elements or a function handle.
N is the number of PDEs in the system. For the syntax of the function handle form of r,
see “Nonconstant Boundary Conditions” on page 2-179.
Example: 'r',[0;4;-1]
Data Types: double | function_handle
Complex Number Support: Yes

h — Dirichlet condition h*u = r
eye(N) (default) | N-by-N matrix | vector with N^2 elements | function handle

Dirichlet condition h*u = r, returned as an N-by-N matrix, a vector with N^2 elements,
or a function handle. N is the number of PDEs in the system. For the syntax of the
function handle form of h, see “Nonconstant Boundary Conditions” on page 2-179.
Example: 'h',[2,1;1,2]
Data Types: double | function_handle
Complex Number Support: Yes

g — Generalized Neumann condition n·(c×∇u) + qu = g
zeros(N,1) (default) | vector with N elements | function handle

Generalized Neumann condition n·(c×∇u) + qu = g, returned as a vector with N
elements or a function handle. N is the number of PDEs in the system. For scalar PDEs,
the generalized Neumann condition is n·(c∇u) + qu = g. For the syntax of the
function handle form of g, see “Nonconstant Boundary Conditions” on page 2-179.
Example: 'g',[3;2;-1]
Data Types: double | function_handle
Complex Number Support: Yes

q — Generalized Neumann condition n·(c×∇u) + qu = g
zeros(N) (default) | N-by-N matrix | vector with N^2 elements | function handle
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Generalized Neumann condition n·(c×∇u) + qu = g, returned as an N-by-N matrix, a
vector with N^2 elements, or a function handle. N is the number of PDEs in the system.
For the syntax of the function handle form of q, see “Nonconstant Boundary Conditions”
on page 2-179.
Example: 'q',eye(3)
Data Types: double | function_handle
Complex Number Support: Yes

u — Dirichlet conditions
zeros(N,1) (default) | vector of up to N elements | function handle

Dirichlet conditions, returned as a vector of up to N elements or as a function handle. If u
has less than N elements, then you must also use EquationIndex. The u and
EquationIndex arguments must have the same length. If u has N elements, then
specifying EquationIndex is optional.

For the syntax of the function handle form of u, see “Nonconstant Boundary Conditions”
on page 2-179.
Example: applyBoundaryCondition(model,'dirichlet','Face',
[2,4,11],'u',0)

Data Types: double
Complex Number Support: Yes

EquationIndex — Index of the known u components
1:N (default) | vector of integers with entries from 1 to N

Index of the known u components, returned as a vector of integers with entries from 1 to
N. EquationIndex and u must have the same length.
Example: applyBoundaryCondition(model,'mixed','Face',[2,4,11],'u',
[3,-1],'EquationIndex',[2,3])

Data Types: double

Vectorized — Vectorized function evaluation
'off' (default) | 'on'

Vectorized function evaluation, returned as 'on' or 'off'. This evaluation applies when
you pass a function handle as an argument. To save time in function handle evaluation,
specify 'on', assuming that your function handle computes in a vectorized fashion. See
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“Vectorization” (MATLAB). For details of this evaluation, see “Nonconstant Boundary
Conditions” on page 2-179.
Example: applyBoundaryCondition(model,'dirichlet','Face',
[2,4,11],'u',@ucalculator,'Vectorized','on')

Data Types: char

See Also
PDEModel | applyBoundaryCondition | findBoundaryConditions

Topics
“Specify Boundary Conditions” on page 2-174
“View, Edit, and Delete Boundary Conditions” on page 2-192
“Solve Problems Using PDEModel Objects” on page 2-6

Introduced in R2015a
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CoefficientAssignment Properties
Coefficient assignments

Description
A CoefficientAssignment object contains a description of the PDE coefficients. A
PDEModel container has a vector of CoefficientAssignment objects in its
EquationCoefficients.CoefficientAssignments property.

Coefficients are the m, d, c, a, and f variables in the PDE

m∂
2u
∂t2 + d∂u∂t − ∇ · c∇u + au = f

or the eigenvalue problem

−∇ · c∇u + au = λdu
or

−∇ · c∇u + au = λ2mu

Create coefficients for your model using the specifyCoefficients function.

Properties
Properties

RegionType — Region type
'face' | 'cell'

Region type, returned as 'face' for a 2-D region, or 'cell' for a 3-D region.
Data Types: char

RegionID — Region ID
vector of positive integers
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Region ID, returned as a vector of positive integers. To determine which ID corresponds
to which portion of the geometry, use the pdegplot function. Set the 'FaceLabels'
name-value pair to 'on'.
Data Types: double

m — Second-order time derivative coefficient
scalar | column vector | function handle

Second-order time derivative coefficient, returned as a scalar, column vector, or function
handle. For details of the m coefficient specification, see “m, d, or a Coefficient for
specifyCoefficients” on page 2-142.
Data Types: double | function_handle
Complex Number Support: Yes

d — First-order time derivative coefficient
scalar | column vector | function handle

First-order time derivative coefficient, returned as a scalar, column vector, or function
handle. For details of the d coefficient specification, see “m, d, or a Coefficient for
specifyCoefficients” on page 2-142.
Data Types: double | function_handle
Complex Number Support: Yes

c — Second-order space derivative coefficient
scalar | column vector | function handle

Second-order space derivative coefficient, returned as a scalar, column vector, or function
handle. For details of the c coefficient specification, see “c Coefficient for
specifyCoefficients” on page 2-100.
Data Types: double | function_handle
Complex Number Support: Yes

a — Solution multiplier coefficient
scalar | column vector | function handle

Solution multiplier coefficient, returned as a scalar, column vector, or function handle. For
details of the a coefficient specification, see “m, d, or a Coefficient for specifyCoefficients”
on page 2-142.
Data Types: double | function_handle
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Complex Number Support: Yes

f — Source coefficient
scalar | column vector | function handle

Source coefficient, returned as a scalar, column vector, or function handle. For details of
the f coefficient specification, see “f Coefficient for specifyCoefficients” on page 2-97.
Data Types: double | function_handle
Complex Number Support: Yes

See Also
findCoefficients | specifyCoefficients

Topics
“PDE Coefficients”
“Solve Problems Using PDEModel Objects” on page 2-6

Introduced in R2016a
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createpde
Create model

Syntax
model = createpde(N)
thermalmodel = createpde('thermal',ThermalAnalysisType)
structuralmodel = createpde('structural',StructuralAnalysisType)

Description
model = createpde(N) returns a PDE model object for a system of N equations. A
complete PDE model object contains a description of the problem you want to solve,
including the geometry, mesh, and boundary conditions.

thermalmodel = createpde('thermal',ThermalAnalysisType) returns a
thermal analysis model for the specified analysis type.

structuralmodel = createpde('structural',StructuralAnalysisType)
returns a structural analysis model for the specified analysis type. This model lets you
solve small-strain linear elasticity problems.

Examples

Create PDE Model

Create a PDE model for a system of three equations.

model = createpde(3)

model = 
  PDEModel with properties:

           PDESystemSize: 3
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         IsTimeDependent: 0
                Geometry: []
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Create Scalar PDE Model

Create a model for a single (scalar) PDE.

model = createpde

model = 
  PDEModel with properties:

           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: []
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Create Thermal Model

Create a model for a steady-state thermal problem.

thermalmodel = createpde('thermal','steadystate')

thermalmodel = 
  ThermalModel with properties:

               AnalysisType: 'steadystate'
                   Geometry: []
         MaterialProperties: []
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                HeatSources: []
    StefanBoltzmannConstant: []
         BoundaryConditions: []
          InitialConditions: []
                       Mesh: []
              SolverOptions: [1x1 PDESolverOptions]

Create a model for a transient thermal problem.

thermalmodel = createpde('thermal','transient')

thermalmodel = 
  ThermalModel with properties:

               AnalysisType: 'transient'
                   Geometry: []
         MaterialProperties: []
                HeatSources: []
    StefanBoltzmannConstant: []
         BoundaryConditions: []
          InitialConditions: []
                       Mesh: []
              SolverOptions: [1x1 PDESolverOptions]

Create Structural Model

Create a static structural model for solving a solid (3-D) problem.

staticStructural = createpde('structural','static-solid')

staticStructural = 
  StructuralModel with properties:

            AnalysisType: 'static-solid'
                Geometry: []
      MaterialProperties: []
               BodyLoads: []
      BoundaryConditions: []
    ReferenceTemperature: []
                    Mesh: []
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Create a transient structural model for solving a plane-stress (2-D) problem.

transientStructural = createpde('structural','transient-planestress')

transientStructural = 
  StructuralModel with properties:

          AnalysisType: 'transient-planestress'
              Geometry: []
    MaterialProperties: []
             BodyLoads: []
    BoundaryConditions: []
         DampingModels: []
     InitialConditions: []
                  Mesh: []
         SolverOptions: [1x1 PDESolverOptions]

Create a modal analysis structural model for solving a plane-strain (2-D) problem.

modalStructural = createpde('structural','modal-planestrain')

modalStructural = 
  StructuralModel with properties:

          AnalysisType: 'modal-planestrain'
              Geometry: []
    MaterialProperties: []
    BoundaryConditions: []
                  Mesh: []

Input Arguments
N — Number of equations
1 (default) | positive integer

Number of equations, specified as a positive integer. You do not need to specify N for a
model where N = 1.
Example: model = createpde
Example: model = createpde(3);
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Data Types: double

ThermalAnalysisType — Type of thermal analysis
'steadystate' | 'transient'

Type of thermal analysis, specified as 'steadystate' or 'transient':

• 'steadystate' creates a steady-state thermal model. If you do not specify
AnalysisType for a thermal model, createpde creates a steady-state model.

• 'transient' creates a transient thermal model.

Example: model = createpde('thermal','transient')
Data Types: char | string

StructuralAnalysisType — Type of structural analysis
'static-solid' | 'static-planestress' | 'static-planestrain' |
'transient-solid' | 'transient-planestress' | 'transient-planestrain' |
'modal-solid' | 'modal-planestress' | 'modal-planestrain'

Type of analysis, specified as one of the following values.

For static analysis, use these values:

• 'static-solid' to create a structural model for static analysis of a solid (3-D)
problem.

• 'static-planestress' to create a structural model for static analysis of a plane-
stress problem.

• 'static-planestrain' to create a structural model for static analysis of a plane-
strain problem.

For transient analysis, use these values:

• 'transient-solid' to create a structural model for transient analysis of a solid (3-
D) problem.

• 'transient-planestress' to create a structural model for transient analysis of a
plane-stress problem.

• 'transient-planestrain' to create a structural model for transient analysis of a
plane-strain problem.

For modal analysis, use these values:
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• 'modal-solid' to create a structural model for modal analysis of a solid (3-D)
problem.

• 'modal-planestress' to create a structural model for modal analysis of a plane-
stress problem.

• 'modal-planestrain' to create a structural model for modal analysis of a plane-
strain problem.

Example: model = createpde('structural','static-solid')
Data Types: char | string

Output Arguments
model — PDE model
PDEModel object

PDE model , returned as a PDEModel object.
Example: model = createpde(2)

thermalmodel — Thermal model
ThermalModel object

Thermal model, returned as a ThermalModel object.
Example: thermalmodel = createpde('thermal')

structuralmodel — Structural model
StructuralModel object

Structural model, returned as a StructuralModel object.
Example: structuralmodel = createpde('structural','static-solid')

See Also
PDEModel | StructuralModel | ThermalModel

Topics
“Solve Problems Using PDEModel Objects” on page 2-6
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“Equations You Can Solve Using PDE Toolbox” on page 1-6
“Heat Transfer”
“Structural Mechanics”

Introduced in R2015a
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createPDEResults
Create solution object

Note This page describes the legacy workflow. New features might not be compatible
with the legacy workflow. For the corresponding step in the recommended workflow, see
solvepde and solvepdeeig.

The original (R2015b) version of createPDEResults had only one syntax, and created a
PDEResults object. Beginning with R2016a, you generally do not need to use
createPDEResults, because the solvepde and solvepdeeig functions return solution
objects. Furthermore, createPDEResults returns an object of a newer type than
PDEResults. If you open an existing PDEResults object, it is converted to a
StationaryResults object.

If you use one of the older solvers such as adaptmesh, then you can use
createPDEResults to obtain a solution object. Stationary and time-dependent solution
objects have gradients available, whereas PDEResults did not include gradients.

Syntax
results = createPDEResults(model,u)
results = createPDEResults(model,u,'stationary')
results = createPDEResults(model,u,utimes,'time-dependent')
results = createPDEResults(model,eigenvectors,eigenvalues,'eigen')

Description
results = createPDEResults(model,u) creates a StationaryResults solution
object from model and its solution u.

This syntax is equivalent to results = createPDEResults(model,
u,'stationary').
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results = createPDEResults(model,u,utimes,'time-dependent') creates a
TimeDependentResults solution object from model, its solution u, and the times
utimes.

results = createPDEResults(model,eigenvectors,eigenvalues,'eigen')
creates an EigenResults solution object from model, its eigenvector solution
eigenvectors, and its eigenvalues eigenvalues.

Examples

Results From an Elliptic Problem

Create a StationaryResults object from the solution to an elliptic system.

Create a PDE model for a system of three equations. Import the geometry of a bracket
and plot the face labels.

model = createpde(3);
importGeometry(model,'BracketWithHole.stl');
figure
pdegplot(model,'FaceLabels','on')
view(30,30)
title('Bracket with Face Labels')
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figure
pdegplot(model,'FaceLabels','on')
view(-134,-32)
title('Bracket with Face Labels, Rear View')
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Set boundary conditions: face 3 is immobile, and there is a force in the negative z
direction on face 6.

applyBoundaryCondition(model,'dirichlet','face',4,'u',[0,0,0]);
applyBoundaryCondition(model,'neumann','face',8,'g',[0,0,-1e4]);

Set coefficients that represent the equations of linear elasticity.

E = 200e9;
nu = 0.3;
c = elasticityC3D(E,nu);
a = 0;
f = [0;0;0];

Create a mesh and solve the problem.
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generateMesh(model,'Hmax',1e-2);
u = assempde(model,c,a,f);

Create a StationaryResults object from the solution.

results = createPDEResults(model,u)

results = 
  StationaryResults with properties:

    NodalSolution: [14002x3 double]
       XGradients: [14002x3 double]
       YGradients: [14002x3 double]
       ZGradients: [14002x3 double]
             Mesh: [1x1 FEMesh]

Plot the solution for the z-component, which is component 3.

pdeplot3D(model,'ColorMapData',results.NodalSolution(:,3))
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Results from a Time-Dependent Problem

Obtain a solution from a parabolic problem.

The problem models heat flow in a solid.

model = createpde();
importGeometry(model,'Tetrahedron.stl');
pdegplot(model,'FaceLabels','on','FaceAlpha',0.5)
view(45,45)
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Set the temperature on face 2 to 100. Leave the other boundary conditions at their
default values (insulating).

applyBoundaryCondition(model,'dirichlet','face',2,'u',100);

Set the coefficients to model a parabolic problem with 0 initial temperature.

d = 1;
c = 1;
a = 0;
f = 0;
u0 = 0;

Create a mesh and solve the PDE for times from 0 through 200 in steps of 10.
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tlist = 0:10:200;
generateMesh(model);
u = parabolic(u0,tlist,model,c,a,f,d);

168 successful steps
0 failed attempts
329 function evaluations
1 partial derivatives
28 LU decompositions
328 solutions of linear systems

Create a TimeDependentResults object from the solution.

results = createPDEResults(model,u,tlist,'time-dependent');

Plot the solution on the surface of the geometry at time 100.

pdeplot3D(model,'ColorMapData',results.NodalSolution(:,11))
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Results from an Eigenvalue Problem

Create an EigenResults object from the solution to an eigenvalue problem.

Create the geometry and mesh for the L-shaped membrane. Apply Dirichlet boundary
conditions to all edges.

model = createpde;
geometryFromEdges(model,@lshapeg);
generateMesh(model,'Hmax',0.05,'GeometricOrder','linear');
applyBoundaryCondition(model,'dirichlet','Edge',1:model.Geometry.NumEdges,'u',0);
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Solve the eigenvalue problem for coefficients c = 1, a = 0, and d = 1. Obtain solutions for
eigenvalues from 0 through 100.

c = 1;
a = 0;
d = 1;
r = [0,100];
[eigenvectors,eigenvalues] = pdeeig(model,c,a,d,r);

              Basis= 10,  Time=   0.17,  New conv eig=  0
              Basis= 14,  Time=   0.19,  New conv eig=  0
              Basis= 18,  Time=   0.30,  New conv eig=  1
              Basis= 22,  Time=   0.30,  New conv eig=  2
              Basis= 26,  Time=   0.31,  New conv eig=  3
              Basis= 30,  Time=   0.33,  New conv eig=  5
              Basis= 34,  Time=   0.34,  New conv eig=  5
              Basis= 38,  Time=   0.34,  New conv eig=  7
              Basis= 42,  Time=   0.36,  New conv eig=  8
              Basis= 46,  Time=   0.36,  New conv eig= 11
              Basis= 50,  Time=   0.38,  New conv eig= 12
              Basis= 54,  Time=   0.59,  New conv eig= 14
              Basis= 58,  Time=   0.59,  New conv eig= 14
              Basis= 62,  Time=   0.83,  New conv eig= 16
              Basis= 66,  Time=   1.00,  New conv eig= 18
End of sweep: Basis= 66,  Time=   1.00,  New conv eig= 17
              Basis= 27,  Time=   1.14,  New conv eig=  0
              Basis= 31,  Time=   1.16,  New conv eig=  0
              Basis= 35,  Time=   1.33,  New conv eig=  0
End of sweep: Basis= 35,  Time=   1.33,  New conv eig=  0

Create an EigenResults object from the solution.

results = createPDEResults(model,eigenvectors,eigenvalues,'eigen')

results = 
  EigenResults with properties:

    Eigenvectors: [1440x17 double]
     Eigenvalues: [17x1 double]
            Mesh: [1x1 FEMesh]

Plot the solution for mode 10.

pdeplot(model,'XYData',results.Eigenvectors(:,10))
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Input Arguments
model — PDE model
PDEModel object

PDE model, specified as a PDEModel object.
Example: model = createpde

u — PDE solution
vector | matrix
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PDE solution, specified as a vector or matrix.
Example: u = assempde(model,c,a,f);

utimes — Times for a PDE solution
monotone vector

Times for a PDE solution, specified as a monotone vector. These times should be the same
as the tlist times that you specified for the solution by the hyperbolic or parabolic
solvers.
Example: utimes = 0:0.2:5;

eigenvectors — Eigenvector solution
matrix

Eigenvector solution, specified as a matrix. Suppose

• Np is the number of mesh nodes
• N is the number of equations
• ev is the number of eigenvalues specified in eigenvalues

Then eigenvectors has size Np-by-N-by-ev. Each column of eigenvectors
corresponds to the eigenvectors of one eigenvalue. In each column, the first Np elements
correspond to the eigenvector of equation 1 evaluated at the mesh nodes, the next Np
elements correspond to equation 2, and so on.

eigenvalues — Eigenvalue solution
vector

Eigenvalue solution, specified as a vector.

Output Arguments
results — PDE solution
StationaryResults object (default) | TimeDependentResults object |
EigenResults object

PDE solution, specified as a StationaryResults object, a TimeDependentResults
object, or an EigenResults object. Create results using solvepde, solvepdeeig, or
createPDEResults.
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Example: results = solvepde(model)

Tips
• Dimensions of the returned solutions and gradients are the same as those returned by

solvepde and solvepdeeig. For details, see “Dimensions of Solutions, Gradients,
and Fluxes” on page 3-317.

Algorithms
The procedure for evaluating gradients at nodal locations is as follows:

1 Calculate the gradients at the Gauss points located inside each element.
2 Extrapolate the gradients at the nodal locations.
3 Average the value of the gradient from all elements that meet at the nodal point. This

step is needed because of the inter-element discontinuity of gradients. The elements
that connect at the same nodal point give different extrapolated values of the
gradient for the point. createPDEResults performs area-weighted averaging for 2-
D meshes and volume-weighted averaging for 3-D meshes.

See Also
EigenResults | StationaryResults | TimeDependentResults |
evaluateGradient | interpolateSolution
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Topics
“Linear Elasticity Equations” on page 3-117

Introduced in R2015b
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csgchk
Check validity of Geometry Description matrix

Syntax
gstat = csgchk(gd,xlim,ylim)
gstat = csgchk(gd)

Description
gstat = csgchk(gd,xlim,ylim) checks if the solid objects in the Geometry
Description matrix gd are valid, given optional real numbers xlim and ylim as current
length of the x- and y-axis, and using a special format for polygons. For a polygon, the last
vertex coordinate can be equal to the first one, to indicate a closed polygon. If xlim and
ylim are specified and if the first and the last vertices are not equal, the polygon is
considered as closed if these vertices are within a certain “closing distance.” These
optional input arguments are meant to be used only when calling csgchk from the PDE
Modeler app.

gstat = csgchk(gd) is identical to the preceding call, except for using the same
format of gd that is used by decsg. This call is recommended when using csgchk as a
command-line function.

gstat is a row vector of integers that indicates the validity status of the corresponding
solid objects, i.e., columns, in gd.

For a circle solid, gstat = 0 indicates that the circle has a positive radius, 1 indicates a
nonpositive radius, and 2 indicates that the circle is not unique.

For a polygon, gstat = 0 indicates that the polygon is closed and does not intersect
itself, i.e., it has a well-defined, unique interior region. 1 indicates an open and non-self-
intersecting polygon, 2 indicates a closed and self-intersecting polygon, and 3 indicates
an open and self-intersecting polygon.

For a rectangle solid, gstat is identical to that of a polygon. This is so because a
rectangle is considered as a polygon by csgchk.
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For an ellipse solid, gstat = 0 indicates that the ellipse has positive semiaxes, 1
indicates that at least one of the semiaxes is nonpositive, and 2 indicates that the ellipse
is not unique.

If gstat consists of zero entries only, then gd is valid and can be used as input argument
by decsg.

See Also
decsg

Introduced before R2006a
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csgdel
Delete borders between minimal regions

Syntax
[dl1,bt1] = csgdel(dl,bt,bl)
[dl1,bt1] = csgdel(dl,bt)

Description
[dl1,bt1] = csgdel(dl,bt,bl) deletes the border segments in the list bl. If the
consistency of the Decomposed Geometry matrix is not preserved by deleting the
elements in the list bl, additional border segments are deleted. Boundary segments
cannot be deleted.

For an explanation of the concepts or border segments, boundary segments, and minimal
regions, see decsg.

dl and dl1 are Decomposed Geometry matrices. For a description of the Decomposed
Geometry matrix, see decsg. The format of the Boolean tables bt and bt1 is also
described in the entry on decsg.

[dl1,bt1] = csgdel(dl,bt) deletes all border segments.

See Also
csgchk | decsg

Introduced before R2006a
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decsg
Decompose constructive solid geometry into minimal regions

Syntax
dl = decsg(gd,sf,ns)
dl = decsg(gd)
[dl,bt] = decsg( ___ )

Description
dl = decsg(gd,sf,ns) decomposes the geometry description matrix gd into the
geometry matrix dl and returns the minimal regions that satisfy the set formula sf. The
name-space matrix ns is a text matrix that relates the columns in gd to variable names in
sf.

Typically, you draw a geometry in the PDE Modeler app, then export it to the MATLAB
Command Window by selecting Export Geometry Description, Set Formula, Labels
from the Draw menu in the app. The resulting geometry description matrix gd represents
the CSG model. decsg analyzes the model and constructs a set of disjointed minimal
regions bounded by boundary segments and border segments. This set of minimal regions
constitutes the decomposed geometry and allows other Partial Differential Equation
Toolbox functions to work with the geometry.

Alternatively, you can use the decsg function when creating a geometry without using the
app. See “2-D Geometry Creation at Command Line” on page 2-10 for details.

To return all minimal regions (sf corresponds to the union of all shapes in gd), use the
shorter syntax dl = decsg(gd).

[dl,bt] = decsg( ___ ) returns a Boolean table (matrix) that relates the original
shapes to the minimal regions. A column in bt corresponds to the column with the same
index in gd. A row in bt corresponds to the index of a minimal region. You can use bt to
remove boundaries between subdomains.
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Examples

Decompose Geometry Created in PDE Modeler App

Create a 2-D geometry in the PDE Modeler app, then export it to the MATLAB workspace
and decompose it to minimal regions by using decsg.

Start the PDE Modeler app and draw a unit circle and a unit square.

pdecirc(0,0,1)
pderect([0 1 0 1])

Enter C1-SQ1 in the Set formula field.

Export the geometry description matrix, set formula, and name-space matrix to the
MATLAB workspace by selecting the Export Geometry Description option from the
Draw menu.

Decompose the exported geometry into minimal regions. The result is one minimal region
with five edge segments: three circle edge segments and two line edge segments.

dl = decsg(gd,sf,ns)

dl =
     2.0000   2.0000    1.0000    1.0000    1.0000
          0        0   -1.0000    0.0000    0.0000
     1.0000        0    0.0000    1.0000   -1.0000
          0   1.0000   -0.0000   -1.0000    1.0000
          0        0   -1.0000         0   -0.0000
          0        0    1.0000    1.0000    1.0000
     1.0000   1.0000         0         0         0
          0        0         0         0         0
          0        0         0         0         0
          0        0    1.0000    1.0000    1.0000

View the geometry. Display the edge labels and the subdomain labels.

pdegplot(dl,'EdgeLabels','on','SubdomainLabels','on')
axis equal
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For comparison, decompose the same geometry without specifying the set formula sf and
the name-space matrix ns. This syntax returns the union of all shapes in the geometry gd.

dl_all = decsg(gd)

dl_all =
    2.0000    2.0000    2.0000    2.0000    1.0000    1.0000    1.0000    1.0000
         0    1.0000    1.0000         0   -1.0000    0.0000    1.0000    0.0000
    1.0000    1.0000         0         0    0.0000    1.0000    0.0000   -1.0000
         0         0    1.0000    1.0000   -0.0000   -1.0000         0    1.0000
         0    1.0000    1.0000         0   -1.0000         0    1.0000   -0.0000
    3.0000    2.0000    2.0000    3.0000    1.0000    1.0000    3.0000    1.0000
    1.0000         0         0    1.0000         0         0    2.0000         0
         0         0         0         0         0         0         0         0
         0         0         0         0         0         0         0         0
         0         0         0         0    1.0000    1.0000    1.0000    1.0000

View the resulting geometry.
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pdegplot(dl_all,'EdgeLabels','on','SubdomainLabels','on')
axis equal

Remove Boundaries Between Subdomains

Start the PDE Modeler app and draw a unit circle and a unit square.

pdecirc(0,0,1) 
pderect([0 1 0 1])

Enter C1+SQ1 in the Set formula field.

Export the Geometry Description matrix, set formula, and Name Space matrix to the
MATLAB workspace by selecting the Export Geometry Description option from the
Draw menu.
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Decompose the exported geometry into minimal regions. Because the geometry is a union
of all regions, C1+SQ1, you can omit the arguments specifying the set formula and name-
space matrix when using decsg.

[dl,bt] = decsg(gd)

dl =
    2.0000    2.0000    2.0000    2.0000    1.0000    1.0000    1.0000    1.0000
         0    1.0000    1.0000         0   -1.0000    0.0000    1.0000    0.0000
    1.0000    1.0000         0         0    0.0000    1.0000    0.0000   -1.0000
         0         0    1.0000    1.0000   -0.0000   -1.0000         0    1.0000
         0    1.0000    1.0000         0   -1.0000         0    1.0000   -0.0000
    3.0000    2.0000    2.0000    3.0000    1.0000    1.0000    3.0000    1.0000
    1.0000         0         0    1.0000         0         0    2.0000         0
         0         0         0         0         0         0         0         0
         0         0         0         0         0         0         0         0
         0         0         0         0    1.0000    1.0000    1.0000    1.0000

bt =
     1     0
     0     1
     1     1

View the geometry. Display the edge labels and the subdomain labels.

pdegplot(dl,'EdgeLabels','on','SubdomainLabels','on')
axis equal
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Remove the subdomain boundaries by using the csgdel function.

[dl2,bt2] = csgdel(dl,bt);

View the resulting geometry.

figure
pdegplot(dl2,'EdgeLabels','on','SubdomainLabels','on')
axis equal
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Input Arguments
gd — Geometry description matrix
matrix of double-precision numbers

Geometry description matrix, specified as a matrix of double-precision numbers. The
number of columns corresponds to the number of shapes used to construct the geometry.
Each column in the geometry description matrix corresponds to a shape in the CSG
model. The model supports four types of shapes:

• For a circle, the first row contains 1. The second and third rows contain the x- and y-
coordinates of the center. The fourth row contains the radius of the circle.

• For a polygon, the first row contains 2. The second row contains n, which is the
number of line segments in the boundary of the polygon. The next n rows contain the
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x-coordinates of the starting points of the edges, and the n rows after that contain the
y-coordinates of the starting points of the edges.

• For a rectangle, the first row contains 3, and the second row contains 4. The next four
rows contain the x-coordinates of the starting points of the edges, and the four rows
after that contain the y-coordinates of the starting points of the edges.

• For an ellipse, the first row contains 4. The second and third rows contain the x- and y-
coordinates of the center. The fourth and fifth rows contain the semiaxes of the ellipse.
The sixth row contains the rotational angle of the ellipse, measured in radians.

All shapes in a geometry description matrix have the same number of rows. Rows that are
not required for a particular shape are filled with zeros.

When you export geometry from the PDE Modeler app by selecting Export Geometry
Description, Set Formula, Labels from the Draw menu in the app, you can use any
variable name for the exported geometry description matrix in the MATLAB workspace.
The default name is gd.
Data Types: double

sf — Set formula
character vector | string scalar

Set formula, specified as a character vector or a string including the names of shapes,
such as C1, SQ2, E3, and the operators +, *, and - corresponding to the set operations
union, intersection, and set difference, respectively. The operators + and * have the same
precedence. The operator - has a higher precedence. You can control the precedence by
using parentheses.

When you export geometry from the PDE Modeler app by selecting Export Geometry
Description, Set Formula, Labels from the Draw menu in the app, you can use any
variable name for the formula in the MATLAB workspace. The default name is sf.
Example: '(SQ1+C1)-C2'
Data Types: char | string

ns — Name-space matrix
matrix of double-precision numbers

Name-space matrix, specified as a matrix of double-precision numbers. The number of
columns corresponds to the number of shapes used to construct the geometry. Each
column in ns contains a sequence of characters padded with spaces. Each character
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column assigns a name to the corresponding geometric object in gd, so you can refer to a
specific object in gd in the set formula sf.

When you export geometry from the PDE Modeler app by selecting Export Geometry
Description, Set Formula, Labels from the Draw menu in the app, you can use any
variable name for the name-space matrix in the MATLAB workspace. The default name is
ns.
Data Types: double

Output Arguments
dl — Decomposed geometry matrix
matrix of double-precision numbers

Decomposed geometry matrix, returned as a matrix of double-precision numbers. It
contains a representation of the decomposed geometry in terms of disjointed minimal
regions constructed by the decsg algorithm. Each edge segment of the minimal regions
corresponds to a column in dl. Edge segments between minimal regions are border
segments. Outer boundaries are boundary segments. In each column, the second and
third rows contain the starting and ending x-coordinates. The fourth and fifth rows
contain the corresponding y-coordinates. The sixth and seventh rows contain left and
right minimal region labels with respect to the direction induced by the start and end
points (counterclockwise direction on circle and ellipse segments). There are three types
of possible edge segments in a minimal region:

• For circle edge segments, the first row is 1. The eighth and ninth rows contain the
coordinates of the center of the circle. The 10th row contains the radius.

• For line edge segments, the first row is 2.
• For ellipse edge segments, the first row is 4. The eighth and ninth rows contain the

coordinates of the center of the ellipse. The 10th and 11th rows contain the semiaxes
of the ellipse. The 12th row contains the rotational angle of the ellipse.

All shapes in a decomposed geometry matrix have the same number of rows. Rows that
are not required for a particular shape are filled with zeros.
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Row number Circle edge
segment

Line edge segment Ellipse edge
segment

1 1 2 4
2 starting x-coordinate starting x-coordinate starting x-coordinate
3 ending x-coordinate ending x-coordinate ending x-coordinate
4 starting y-coordinate starting y-coordinate starting y-coordinate
5 ending y-coordinate ending y-coordinate ending y-coordinate
6 left minimal region

label
left minimal region
label

left minimal region
label

7 right minimal region
label

right minimal region
label

right minimal region
label

8 x-coordinate of the
center

 x-coordinate of the
center

9 y-coordinate of the
center

 y-coordinate of the
center

10 radius of the circle  x-semiaxis before
rotation

11   y-semiaxis before
rotation

12   Angle in radians
between x-axis and
first semiaxis

Data Types: double

bt — Boolean table relating original shapes to minimal regions
matrix of 1s and 0s

Boolean table relating the original shapes to the minimal regions, returned as a matrix of
1s and 0s.
Data Types: double
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Limitations
• In rare cases decsg can error or create an invalid geometry because of the limitations

of its algorithm. Such issues can occur when two or more edges of a geometry
partially overlap, almost coincide, or are almost tangent.

Tips
• decsg does not check the input CSG model for correctness. It assumes that no circles

or ellipses are identical or degenerated and that no lines have zero length. Polygons
must not be self-intersecting. Use the function csgchk to check the CSG model.

• decsg returns NaN if it cannot evaluate the set formula sf.

See Also
PDE Modeler | csgchk | csgdel | geometryFromEdges | pdecirc | pdeellip |
pdepoly | pderect | wgeom

Topics
“2-D Geometry Creation at Command Line” on page 2-10
“Three Ways to Create 2-D Geometry” on page 2-8

Introduced before R2006a
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DiscreteGeometry Properties
3-D geometry description

Description
DiscreteGeometry describes 3-D geometry in the form of an object. A PDEModel object
has a Geometry property. For 3-D geometry, the Geometry property is a
DiscreteGeometry object.

You can use the importGeometry function or the geometryFromMesh function to
specify a 3-D geometry for your model.

You also can use the multicuboid, multicylinder, or multisphere functions to
create a geometry that you can later assign to your model. These functions let you create
multi-cellular geometries for modeling subdomains or single domains of cubic, cylindrical,
or spherical shapes, respectively. All cells must be of the same type: you cannot combine
cuboids, cylinders, and spheres in one geometry. To add a multi-cellular geometry to a
PDEModel, assign the DiscreteGeometry to the Geometry property of the model. For
example, create a PDE model and add the following geometry formed by three spheres to
the model.

model = createpde;
gm = multisphere([1,2,3]);
model.Geometry = gm;

Properties
Properties

NumCells — Number of geometry cells
positive integer

Number of geometry cells, returned as a positive integer.
Data Types: double

NumEdges — Number of geometry edges
positive integer
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Number of geometry edges, returned as a positive integer.
Data Types: double

NumFaces — Number of geometry faces
positive integer

Number of geometry faces, returned as a positive integer.
Data Types: double

NumVertices — Number of geometry vertices
positive integer

Number of geometry vertices, returned as a positive integer.
Data Types: double

See Also
PDEModel | geometryFromMesh | importGeometry | multicuboid | multicylinder
| multisphere

Topics
“Solve Problems Using PDEModel Objects” on page 2-6

Introduced in R2015a
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dst, idst
(Not recommended) Discrete sine transform

Note dst and idst are not recommended.

Syntax
y = dst(x)
y = dst(x,n)
x = idst(y)
x = idst(y,n)

Description
The dst function implements the following equation:

y(k) = ∑
n = 1

N
x(n)sin π kn

N + 1 , k = 1, ..., N

y = dst(x) computes the discrete sine transform of the columns of x. For best
performance speed, the number of rows in x should be 2m – 1, for some integer m.

y = dst(x,n) pads or truncates the vector x to length n before transforming.

If x is a matrix, the dst operation is applied to each column.

The idst function implements the following equation:

x(k) = 2
N + 1 ∑n = 1

N
y(n)sin π kn

N + 1 ,  k = 1, ..., N

x = idst(y) calculates the inverse discrete sine transform of the columns of y. For best
performance speed, the number of rows in y should be 2m – 1, for some integer m.

x = idst(y,n) pads or truncates the vector y to length n before transforming.
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If y is a matrix, the idst operation is applied to each column.

Introduced before R2006a
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EigenResults
PDE eigenvalue solution and derived quantities

Description
An EigenResults object contains the solution of a PDE eigenvalue problem in a form
convenient for plotting and postprocessing.

• Eigenvector values at the nodes appear in the Eigenvectors property.
• The eigenvalues appear in the Eigenvalues property.

Creation
There are several ways to create an EigenResults object:

• Solve an eigenvalue problem using the solvepdeeig function. This function returns a
PDE eigenvalue solution as an EigenResults object. This is the recommended
approach.

• Solve an eigenvalue problem using the pdeeig function. Then use the
createPDEResults function to obtain an EigenResults object from a PDE
eigenvalue solution returned by pdeeig. Note that pdeeig is a legacy function. It is
not recommended for solving eigenvalue problems.

Properties
Mesh — Finite element mesh
FEMesh object

Finite element mesh, returned as a FEMesh object.

Eigenvectors — Solution eigenvectors
matrix | 3-D array
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Solution eigenvectors, returned as a matrix or 3-D array. The solution is a matrix for
scalar eigenvalue problems, and a 3-D array for eigenvalue systems. For details, see
“Dimensions of Solutions, Gradients, and Fluxes” on page 3-317.
Data Types: double

Eigenvalues — Solution eigenvalues
vector

Solution eigenvalues, returned as a vector. The vector is in order by the real part of the
eigenvalues from smallest to largest.
Data Types: double

Object Functions
interpolateSolution Interpolate PDE solution to arbitrary points

Examples

Results from an Eigenvalue Problem

Obtain an EigenResults object from solvepdeeig.

Create the geometry for the L-shaped membrane. Apply zero Dirichlet boundary
conditions to all edges.

model = createpde;
geometryFromEdges(model,@lshapeg);
applyBoundaryCondition(model,'dirichlet','Edge',1:model.Geometry.NumEdges,'u',0);

Specify coefficients c = 1, a = 0, and d = 1.

specifyCoefficients(model,'m',0,'d',1,'c',1,'a',0,'f',0);

Create the mesh and solve the eigenvalue problem for eigenvalues from 0 through 100.

generateMesh(model,'Hmax',0.05);
ev = [0,100];
results = solvepdeeig(model,ev)
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              Basis= 10,  Time=   0.44,  New conv eig=  0
              Basis= 11,  Time=   0.44,  New conv eig=  0
              Basis= 12,  Time=   0.45,  New conv eig=  0
              Basis= 13,  Time=   0.45,  New conv eig=  0
              Basis= 14,  Time=   0.47,  New conv eig=  0
              Basis= 15,  Time=   0.47,  New conv eig=  0
              Basis= 16,  Time=   0.48,  New conv eig=  0
              Basis= 17,  Time=   0.48,  New conv eig=  0
              Basis= 18,  Time=   0.48,  New conv eig=  1
              Basis= 19,  Time=   0.50,  New conv eig=  1
              Basis= 20,  Time=   0.50,  New conv eig=  1
              Basis= 21,  Time=   0.67,  New conv eig=  1
              Basis= 22,  Time=   0.67,  New conv eig=  3
              Basis= 23,  Time=   0.67,  New conv eig=  3
              Basis= 24,  Time=   0.80,  New conv eig=  4
              Basis= 25,  Time=   0.80,  New conv eig=  5
              Basis= 26,  Time=   0.92,  New conv eig=  6
              Basis= 27,  Time=   0.92,  New conv eig=  6
              Basis= 28,  Time=   1.00,  New conv eig=  6
              Basis= 29,  Time=   1.00,  New conv eig=  7
              Basis= 30,  Time=   1.02,  New conv eig=  7
              Basis= 31,  Time=   1.03,  New conv eig= 10
              Basis= 32,  Time=   1.03,  New conv eig= 10
              Basis= 33,  Time=   1.13,  New conv eig= 11
              Basis= 34,  Time=   1.23,  New conv eig= 11
              Basis= 35,  Time=   1.23,  New conv eig= 14
              Basis= 36,  Time=   1.31,  New conv eig= 14
              Basis= 37,  Time=   1.34,  New conv eig= 14
              Basis= 38,  Time=   1.45,  New conv eig= 14
              Basis= 39,  Time=   1.45,  New conv eig= 14
              Basis= 40,  Time=   1.48,  New conv eig= 14
              Basis= 41,  Time=   1.48,  New conv eig= 15
              Basis= 42,  Time=   1.64,  New conv eig= 15
              Basis= 43,  Time=   1.77,  New conv eig= 15
              Basis= 44,  Time=   1.77,  New conv eig= 16
              Basis= 45,  Time=   1.94,  New conv eig= 16
              Basis= 46,  Time=   2.00,  New conv eig= 16
              Basis= 47,  Time=   2.02,  New conv eig= 16
              Basis= 48,  Time=   2.03,  New conv eig= 17
              Basis= 49,  Time=   2.22,  New conv eig= 18
              Basis= 50,  Time=   2.36,  New conv eig= 18
              Basis= 51,  Time=   2.36,  New conv eig= 18
              Basis= 52,  Time=   2.52,  New conv eig= 18
              Basis= 53,  Time=   2.56,  New conv eig= 18
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              Basis= 54,  Time=   2.61,  New conv eig= 21
End of sweep: Basis= 54,  Time=   2.61,  New conv eig= 21
              Basis= 31,  Time=   2.98,  New conv eig=  0
              Basis= 32,  Time=   3.20,  New conv eig=  0
              Basis= 33,  Time=   3.20,  New conv eig=  0
End of sweep: Basis= 33,  Time=   3.20,  New conv eig=  0

results = 
  EigenResults with properties:

    Eigenvectors: [5597x19 double]
     Eigenvalues: [19x1 double]
            Mesh: [1x1 FEMesh]

Plot the solution for mode 10.

pdeplot(model,'XYData',results.Eigenvectors(:,10))
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See Also
StationaryResults | TimeDependentResults | solvepdeeig

Topics
“Eigenvalues and Eigenmodes of L-Shaped Membrane” on page 3-251
“Eigenvalues and Eigenmodes of Square” on page 3-263
“Solve Problems Using PDEModel Objects” on page 2-6

Introduced in R2016a
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evaluate
Package: pde

Interpolate data to selected locations

Note This function supports the legacy workflow. Using the [p,e,t] representation of
FEMesh data is not recommended. Use interpolateSolution and
evaluateGradient to interpolate a PDE solution and its gradient to arbitrary points
without switching to a [p,e,t] representation.

Syntax
uOut = evaluate(F,pOut)
uOut = evaluate(F,x,y)
uOut = evaluate(F,x,y,z)

Description
uOut = evaluate(F,pOut) returns the interpolated values from the interpolant F at
the points pOut.

Note If a query point is outside the mesh, evaluate returns NaN for that point.

uOut = evaluate(F,x,y) returns the interpolated values from the interpolant F at the
points [x(k),y(k)], for k from 1 through numel(x). This syntax applies to 2-D
geometry.

uOut = evaluate(F,x,y,z) returns the interpolated values from the interpolant F at
the points [x(k),y(k),z(k)], for k from 1 through numel(x). This syntax applies to 3-
D geometry.
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Examples

Interpolate to a matrix of values

This example shows how to interpolate a solution to a scalar problem using a pOut matrix
of values.

Solve the equation −Δu = 1 on the unit disk with zero Dirichlet conditions.

g0 = [1;0;0;1]; % circle centered at (0,0) with radius 1
sf = 'C1';
g = decsg(g0,sf,sf'); % decomposed geometry matrix
problem = allzerobc(g); % zero Dirichlet conditions
[p,e,t] = initmesh(g);
c = 1;
a = 0;
f = 1;
u = assempde(problem,p,e,t,c,a,f); % solve the PDE

Construct an interpolator for the solution.

F = pdeInterpolant(p,t,u);

Generate a random set of coordinates in the unit square. Evaluate the interpolated
solution at the random points.

rng default % for reproducibility
pOut = rand(2,25); % 25 numbers between 0 and 1
uOut = evaluate(F,pOut);
numNaN = sum(isnan(uOut))

numNaN = 9

uOut contains some NaN entries because some points in pOut are outside of the unit disk.

Interpolate to x, y values

This example shows how to interpolate a solution to a scalar problem using x, y values.

Solve the equation −Δu = 1 on the unit disk with zero Dirichlet conditions.
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g0 = [1;0;0;1]; % circle centered at (0,0) with radius 1
sf = 'C1';
g = decsg(g0,sf,sf'); % decomposed geometry matrix
problem = allzerobc(g); % zero Dirichlet conditions
[p,e,t] = initmesh(g);
c = 1;
a = 0;
f = 1;
u = assempde(problem,p,e,t,c,a,f); % solve the PDE

Construct an interpolator for the solution.

F = pdeInterpolant(p,t,u); % create the interpolant

Evaluate the interpolated solution at grid points in the unit square with spacing 0.2.

[x,y] = meshgrid(0:0.2:1);
uOut = evaluate(F,x,y);
numNaN = sum(isnan(uOut))

numNaN = 12

uOut contains some NaN entries because some points in the unit square are outside of the
unit disk.

Interpolate a solution with multiple components

This example shows how to interpolate the solution to a system of N = 3 equations.

Solve the system of equations −Δu = f with Dirichlet boundary conditions on the unit
disk, where

f = sin(x) + cos(y), cosh(xy), xy
1 + x2 + y2

T
.

g0 = [1;0;0;1]; % circle centered at (0,0) with radius 1
sf = 'C1';
g = decsg(g0,sf,sf'); % decomposed geometry matrix
problem = allzerobc(g,3); % zero Dirichlet conditions, 3 components
[p,e,t] = initmesh(g);
c = 1;
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a = 0;
f = char('sin(x) + cos(y)','cosh(x.*y)','x.*y./(1+x.^2+y.^2)');
u = assempde(problem,p,e,t,c,a,f); % solve the PDE

Construct an interpolant for the solution.

F = pdeInterpolant(p,t,u); % create the interpolant

Interpolate the solution at a circle.

s = linspace(0,2*pi);
x = 0.5 + 0.4*cos(s);
y = 0.4*sin(s);
uOut = evaluate(F,x,y);

Plot the three solution components.

npts = length(x);
plot3(x,y,uOut(1:npts),'b')
hold on
plot3(x,y,uOut(npts+1:2*npts),'k')
plot3(x,y,uOut(2*npts+1:end),'r')
hold off
view(35,35)
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Interpolate a time-varying solution

This example shows how to interpolate a solution that depends on time.

Solve the equation

∂u
∂t − Δu = 1

on the unit disk with zero Dirichlet conditions and zero initial conditions. Solve at five
times from 0 to 1.
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g0 = [1;0;0;1]; % circle centered at (0,0) with radius 1
sf = 'C1';
g = decsg(g0,sf,sf'); % decomposed geometry matrix
problem = allzerobc(g); % zero Dirichlet conditions
[p,e,t] = initmesh(g);
c = 1;
a = 0;
f = 1;
d = 1;
tlist = 0:1/4:1;
u = parabolic(0,tlist,problem,p,e,t,c,a,f,d);

52 successful steps
0 failed attempts
106 function evaluations
1 partial derivatives
13 LU decompositions
105 solutions of linear systems

Construct an interpolant for the solution.

F = pdeInterpolant(p,t,u);

Interpolate the solution at x = 0.1, y = -0.1, and all available times.

x = 0.1;
y = -0.1;
uOut = evaluate(F,x,y)

uOut = 1×5

         0    0.1809    0.2278    0.2388    0.2413

The solution starts at 0 at time 0, as it should. It grows to about 1/4 at time 1.

Interpolate to a Grid

This example shows how to interpolate an elliptic solution to a grid.
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Define and Solve the Problem

Use the built-in geometry functions to create an L-shaped region with zero Dirichlet
boundary conditions. Solve an elliptic PDE with coefficients c = 1, a = 0, f = 1, with zero
Dirichlet boundary conditions.

[p,e,t] = initmesh('lshapeg'); % Predefined geometry
u = assempde('lshapeb',p,e,t,1,0,1); % Predefined boundary condition

Create an Interpolant

Create an interpolant for the solution.

F = pdeInterpolant(p,t,u);

Create a Grid for the Solution

xgrid = -1:0.1:1;
ygrid = -1:0.2:1;
[X,Y] = meshgrid(xgrid,ygrid);

The resulting grid has some points that are outside the L-shaped region.

Evaluate the Solution On the Grid

uout = evaluate(F,X,Y);

The interpolated solution uout is a column vector. You can reshape it to match the size of
X or Y. This gives a matrix, like the output of the tri2grid function.

Z = reshape(uout,size(X));

Input Arguments
F — Interpolant
output of pdeInterpolant

Interpolant, specified as the output of pdeInterpolant.
Example: F = pdeInterpolant(p,t,u)

pOut — Query points
matrix with two or three rows
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Query points, specified as a matrix with two or three rows. The first row represents the x
component of the query points, the second row represents the y component, and, for 3-D
geometry, the third row represents the z component. evaluate computes the interpolant
at each column of pOut. In other words, evaluate interpolates at the points pOut(:,k).
Example: pOut = [-1.5,0,1;
1,1,2.2]

Data Types: double

x — Query point component
vector or array

Query point component, specified as a vector or array. evaluate interpolates at either 2-
D points [x(k),y(k)] or at 3-D points [x(k),y(k),z(k)]. The x and y, and z arrays
must contain the same number of entries.

evaluate transforms query point components to the linear index representation, such as
x(:).
Example: x = -1:0.2:3
Data Types: double

y — Query point component
vector or array

Query point component, specified as a vector or array. evaluate interpolates at either 2-
D points [x(k),y(k)] or at 3-D points [x(k),y(k),z(k)]. The x and y, and z arrays
must contain the same number of entries.

evaluate transforms query point components to the linear index representation, such as
y(:).
Example: y = -1:0.2:3
Data Types: double

z — Query point component
vector or array

Query point component, specified as a vector or array. evaluate interpolates at either 2-
D points [x(k),y(k)] or at 3-D points [x(k),y(k),z(k)]. The x and y, and z arrays
must contain the same number of entries.
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evaluate transforms query point components to the linear index representation, such as
z(:).
Example: z = -1:0.2:3
Data Types: double

Output Arguments
uOut — Interpolated values
array

Interpolated values, returned as an array. uOut has the same number of columns as the
data u used in creating F. If u depends on time, uOut contains a column for each time
step. For time-independent u, uOut has one column.

The number of rows in uOut is the number of equations in the PDE system, N, times the
number of query points, pOut. The first pOut rows correspond to equation 1, the next
pOut rows correspond to equation 2, and so on.

If a query point is outside the mesh, evaluate returns NaN for that point.

Definitions

Element
An element is a basic unit in the finite-element method.

For 2-D problems, an element is a triangle in the model.Mesh.Element property. If the
triangle represents a linear element, it has nodes only at the triangle corners. If the
triangle represents a quadratic element, then it has nodes at the triangle corners and
edge centers.

For 3-D problems, an element is a tetrahedron with either four or ten points. A four-point
(linear) tetrahedron has nodes only at its corners. A ten-point (quadratic) tetrahedron has
nodes at its corners and at the center point of each edge.

For details, see “Mesh Data” on page 2-233.

5 Functions — Alphabetical List

5-152



Algorithms
For each point where a solution is requested (pOut), there are two steps in the
interpolation process. First, the element containing the point must be located and second,
interpolation within that element must be performed using the element shape functions
and the values of the solution at the element’s node points.

See Also
pdeInterpolant

Topics
“Mesh Data” on page 2-233

Introduced in R2014b
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evaluateCGradient
Package: pde

Evaluate flux of PDE solution

Syntax
[cgradx,cgrady] = evaluateCGradient(results,xq,yq)
[cgradx,cgrady,cgradz] = evaluateCGradient(results,xq,yq,zq)
[ ___ ] = evaluateCGradient(results,querypoints)

[ ___ ] = evaluateCGradient( ___ ,iU)

[ ___ ] = evaluateCGradient( ___ ,iT)

[cgradx,cgrady] = evaluateCGradient(results)
[cgradx,cgrady,cgradz] = evaluateCGradient(results)

Description
[cgradx,cgrady] = evaluateCGradient(results,xq,yq) returns the flux of PDE
solution for the stationary equation at the 2-D points specified in xq and yq. The flux of
the solution is the tensor product of c-coefficient and gradients of the PDE solution,
c⊗ ∇u.

[cgradx,cgrady,cgradz] = evaluateCGradient(results,xq,yq,zq) returns
the flux of PDE solution for the stationary equation at the 3-D points specified in xq, yq,
and zq.

[ ___ ] = evaluateCGradient(results,querypoints) returns the flux of PDE
solution for the stationary equation at the 2-D or 3-D points specified in querypoints.

[ ___ ] = evaluateCGradient( ___ ,iU) returns the flux of the solution of the PDE
system for equation indices (components) iU. When evaluating flux for a system of PDEs,
specify iU after the input arguments in any of the previous syntaxes.
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The first dimension of cgradx, cgrady, and, in the 3-D case, cgradz corresponds to
query points. The second dimension corresponds to equation indices iU.

[ ___ ] = evaluateCGradient( ___ ,iT) returns the flux of PDE solution for the time-
dependent equation or system of time-dependent equations at times iT. When evaluating
flux for a time-dependent PDE, specify iT after the input arguments in any of the previous
syntaxes. For a system of time-dependent PDEs, specify both equation indices
(components) iU and time indices iT.

The first dimension of cgradx, cgrady, and, in the 3-D case, cgradz corresponds to
query points. For a single time-dependent PDE, the second dimension corresponds to
time-steps iT. For a system of time-dependent PDEs, the second dimension corresponds
to equation indices iU, and the third dimension corresponds to time-steps iT.

[cgradx,cgrady] = evaluateCGradient(results) returns the flux of PDE solution
of a 2-D problem at the nodal points of the triangular mesh. The shape of output arrays,
cgradx and cgrady, depends on the number of PDEs for which results is the solution.
The first dimension of cgradx and cgrady represents the node indices. For a system of
stationary or time-dependent PDEs, the second dimension represents equation indices.
For a single time-dependent PDE, the second dimension represents time-steps. The third
dimension represents time-step indices for a system of time-dependent PDEs.

[cgradx,cgrady,cgradz] = evaluateCGradient(results) returns the flux of
PDE solution of a 3-D problem at the nodal points of the tetrahedral mesh. The first
dimension of cgradx, cgrady, and cgradz represents the node indices. The second
dimension represents the equation indices. For a system of stationary or time-dependent
PDEs, the second dimension represents equation indices. For a single time-dependent
PDE, the second dimension represents time-steps. The third dimension represents time-
step indices for a system of time-dependent PDEs.

Examples

Scalar Elliptic Problem

Solve the problem −Δu = 1 on the L-shaped membrane with zero Dirichlet boundary
conditions. Evaluate the tensor product of c-coefficient and gradients of the solution to a
scalar elliptic problem at nodal and arbitrary locations. Plot the results.

Create a PDE model and geometry for this problem.

 evaluateCGradient

5-155



model = createpde;
geometryFromEdges(model,@lshapeg);
pdegplot(model,'FaceLabels','on')

Specify boundary conditions and coefficients.

applyBoundaryCondition(model,'dirichlet','Edge',1:model.Geometry.NumEdges,'u',0);

specifyCoefficients(model,'m',0,'d',0,'c',10,'a',0,'f',1,'Face',1);
specifyCoefficients(model,'m',0,'d',0,'c',5,'a',0,'f',1,'Face',2);
specifyCoefficients(model,'m',0,'d',0,'c',1,'a',0,'f',1,'Face',3);

Mesh the geometry and solve the problem.
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generateMesh(model,'Hmax',0.05);
results = solvepde(model);
u = results.NodalSolution;

Compute the flux of the solution and plot the results.

[cgradx,cgrady] = evaluateCGradient(results);

figure
pdeplot(model,'XYData',u,'Contour','on','FlowData',[cgradx,cgrady])

Compute the flux of the solution on the grid from -1 to 1 in each direction using the query
points matrix.
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v = linspace(-1,1,37);
[X,Y] = meshgrid(v);
querypoints = [X(:),Y(:)]';

[cgradxq,cgradyq] = evaluateCGradient(results,querypoints);

Alternatively, you can specify the query points as X,Y instead of specifying them as a
matrix.

[cgradxq,cgradyq] = evaluateCGradient(results,X,Y);

Plot the result using the quiver plotting function.

figure
quiver(X(:),Y(:),cgradxq,cgradyq)
xlabel('x')
ylabel('y')
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Stress Components in a Cantilever Beam

Compute stresses in a cantilever beam subject to shear loading at free end.

Create a PDE model and geometry for this problem.

N = 3;
model = createpde(N);
importGeometry(model,'SquareBeam.STL');
pdegplot(model,'FaceLabels','on')
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Specify coefficients and apply boundary conditions.

E = 2.1e11;
nu = 0.3;
c = elasticityC3D(E, nu);
a = 0;
f = [0;0;0];
specifyCoefficients(model,'m',0,'d',0,'c',c,'a',a','f',f);

applyBoundaryCondition(model,'dirichlet','Face',6,'u',[0 0 0]);
applyBoundaryCondition(model,'neumann','Face',5,'g',[0,0,-3e3]);

Mesh the geometry and solve the problem.
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generateMesh(model,'Hmax',25,'GeometricOrder','quadratic');
results = solvepde(model);

Compute stress, that is, the product of c-coefficient and gradients of displacement.

[sig_xx,sig_yy,sig_zz] = evaluateCGradient(results);

Plot normal component of stress along x-direction. The top portion of the beam
experiences tension, and the bottom portion experiences compression.

figure
pdeplot3D(model,'ColorMapData',sig_xx(:,1))

Define a line across the beam from the bottom to the top at mid-span and mid-width.
Compute stresses along the line.
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zg = linspace(0, 100, 10);
xg = 250*ones(size(zg));
yg = 50*ones(size(zg));

[sig_xx,sig_xy,sig_xz] = evaluateCGradient(results,xg,yg,zg,1);

Plot the normal stress along x-direction.

figure
plot(sig_xx,zg)
grid on
xlabel('\sigma_{xx}')
ylabel('z')
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Stress Components in a Bracket

Compute stresses in an idealized 3-D mechanical part under an applied load. First, create
a PDE model for this problem.

N = 3;
model = createpde(N);

Import the geometry and plot it.

importGeometry(model,'BracketWithHole.stl');
figure
pdegplot(model,'FaceLabels','on')
view(30,30)
title('Bracket with Face Labels')
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figure
pdegplot(model,'FaceLabels','on')
view(-134,-32)
title('Bracket with Face Labels, Rear View')
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Specify coefficients and apply boundary conditions.

E = 200e9; % elastic modulus of steel in Pascals
nu = 0.3; % Poisson's ratio
c = elasticityC3D(E,nu);
a = 0;
f = [0;0;0]; % Assume all body forces are zero
specifyCoefficients(model,'m',0,'d',0,'c',c,'a',a,'f',f);

applyBoundaryCondition(model,'dirichlet','Face',4,'u',[0,0,0]);
distributedLoad = 1e4; % Applied load in Pascals
applyBoundaryCondition(model,'neumann','Face',8,'g',[0,0,-distributedLoad]);

Mesh the geometry and solve the problem.
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bracketThickness = 1e-2; % Thickness of horizontal plate with hole, meters
hmax = bracketThickness; % Maximum element length for a moderately fine mesh
generateMesh(model,'Hmax',hmax,'GeometricOrder','quadratic');

result = solvepde(model);

Create a grid. For this grid, compute the stress tensor, which is the product of c-
coefficient and gradients of displacement.

v = linspace(0,0.2,21);
[xq,yq,zq] = meshgrid(v);

[cgradx,cgrady,cgradz] = evaluateCGradient(result);

Extract individual components of stresses.

sxx = cgradx(:,1);
sxy = cgradx(:,2);
sxz = cgradx(:,3);

syx = cgrady(:,1);
syy = cgrady(:,2);
syz = cgrady(:,3);

szx = cgradz(:,1);
szy = cgradz(:,2);
szz = cgradz(:,3);

Compute von Mises stress.

sVonMises = sqrt( 0.5*( (sxx-syy).^2 + (syy -szz).^2 +...
           (szz-sxx).^2) + 3*(sxy.^2 + syz.^2 + szx.^2));

Plot von Mises stress. The maximum stress occurs at the weakest section. This section
has the least material to support the applied load.

pdeplot3D(model,'colormapdata',sVonMises)
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Heat Transfer Problem on a Square

Solve a 2-D transient heat transfer problem on a square domain and compute heat flow
across convective boundary.

Create a PDE model for this problem.

numberOfPDE = 1;
model = createpde(numberOfPDE);

Create the geometry.
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g = @squareg;
geometryFromEdges(model,g);
pdegplot(model,'EdgeLabels','on')
xlim([-1.2,1.2])
ylim([-1.2,1.2])
axis equal

Specify material properties and ambient conditions.

rho = 7800;
cp = 500;
k = 100;
Text = 25;
hext = 5000;
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Specify the coefficients. Apply insulated boundary conditions on three edges and the free
convection boundary condition on the right edge.

specifyCoefficients(model,'m',0,'d',rho*cp,'c',k,'a',0,'f',0);

applyBoundaryCondition(model,'neumann','Edge', [1,3,4],'q',0,'g',0);
applyBoundaryCondition(model,'neumann','Edge', 2,'q',hext,'g',Text*hext);

Set the initial conditions: uniform room temperature across domain and higher
temperature on the left edge.

setInitialConditions(model,25);
setInitialConditions(model, 100, 'Edge', 4);

Generate a mesh and solve the problem using 0:1000:200000 as a vector of times.

generateMesh(model);
tlist = 0:1000:200000;
results = solvepde(model,tlist);

Define a line at convection boundary to compute heat flux across it.

yg = -1:0.1:1;
xg = ones(size(yg));

Evaluate the product of c coefficient and spatial gradients at (xg,yg).

[qx,qy] = evaluateCGradient(results,xg,yg,1:length(tlist));

Spatially integrate gradients to obtain heat flow for each time-step.

HeatFlowX(1:length(tlist)) = -trapz(yg,qx(:,1:length(tlist)));

Plot convective heat flow over time.

figure
plot(tlist,HeatFlowX)
title('Heat flow across convection boundary')
xlabel('Time')
ylabel('Heat flow')
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Heat Transfer Between Two Squares Made of Different Materials

Solve the heat transfer problem for the following 2-D geometry consisting of a square and
a diamond made of different materials. Compute the heat flux density and plot it as a
vector field.

Create a PDE model for this problem.

numberOfPDE = 1;
model = createpde(numberOfPDE);

Create a geometry that consists of a square with an embedded diamond.
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SQ1 = [3; 4; 0; 3; 3; 0; 0; 0; 3; 3];
D1 = [2; 4; 0.5; 1.5; 2.5; 1.5; 1.5; 0.5; 1.5; 2.5];
gd = [SQ1,D1];
sf = 'SQ1+D1';
ns = char('SQ1','D1');
ns = ns';
dl = decsg(gd,sf,ns);

geometryFromEdges(model,dl);

pdegplot(model,'EdgeLabels','on','FaceLabels','on')
xlim([-1.5,4.5])
ylim([-0.5,3.5])
axis equal
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Set parameters for the square region.

rho_sq = 2;
C_sq = 0.1;
k_sq = 10;
Q_sq = 0;
h_sq = 0;

Set parameters for the diamond region.

rho_d = 1;
C_d = 0.1;
k_d = 2;
Q_d = 4;
h_d = 0;

Specify the coefficients for both subdomains. Apply the boundary and initial conditions.

specifyCoefficients(model,'m',0,'d',rho_sq*C_sq,'c',k_sq,'a',h_sq,'f',Q_sq,'Face',1);
specifyCoefficients(model,'m',0,'d',rho_d*C_d,'c',k_d,'a',h_d,'f',Q_d,'Face',2);

applyBoundaryCondition(model,'dirichlet','Edge',[1,2,7,8],'h',1,'r',0);

setInitialConditions(model,0);

Mesh the geometry and solve the problem. To capture the most dynamic part of heat
distribution process, solve the problem using logspace(-2,-1,10) as a vector of times.

generateMesh(model);

tlist = logspace(-2,-1,10);

results = solvepde(model,tlist);
u = results.NodalSolution;

Compute the heat flux density. Plot the solution with isothermal lines using a contour plot,
and plot the heat flux vector field using arrows. The direction of the heat flow (from
higher to lower temperatures) is opposite to the direction of c⊗ ∇u. Therefore, use -
cgradx and -cgrady to show the heat flow.

[cgradx,cgrady] = evaluateCGradient(results);

figure
pdeplot(model,'XYData',u(:,10),'Contour','on','FlowData',[-cgradx(:,10),-cgrady(:,10)],'ColorMap','hot')
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Input Arguments
results — PDE solution
StationaryResults object | TimeDependentResults object

PDE solution, specified as a StationaryResults object or a TimeDependentResults
object. Create results using solvepde or createPDEResults.
Example: results = solvepde(model)

xq — x-coordinate query points
real array
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x-coordinate query points, specified as a real array. evaluateCGradient evaluates the
tensor product of c-coefficient and gradients of the PDE solution at either the 2-D
coordinate points [xq(i),yq(i)] or at the 3-D coordinate points
[xq(i),yq(i),zq(i)]. So xq, yq, and (if present) zq must have the same number of
entries.

evaluateCGradient converts query points to column vectors xq(:), yq(:), and (if
present) zq(:). For a single stationary PDE, the result consists of column vectors of the
same size. To ensure that the dimensions of the returned x-, y-, and z-components are
consistent with the dimensions of the original query points, use reshape. For example,
use cgradx = reshape(cgradx,size(xq)).

For a time-dependent PDE or a system of PDEs, the first dimension of the resulting arrays
corresponds to spatial points specified by the column vectors xq(:), yq(:), and (if
present) zq(:).
Data Types: double

yq — y-coordinate query points
real array

y-coordinate query points, specified as a real array. evaluateCGradient evaluates the
tensor product of c-coefficient and gradients of the PDE solution at either the 2-D
coordinate points [xq(i),yq(i)] or at the 3-D coordinate points
[xq(i),yq(i),zq(i)]. So xq, yq, and (if present) zq must have the same number of
entries.

evaluateCGradient converts query points to column vectors xq(:), yq(:), and (if
present) zq(:). For a single stationary PDE, the result consists of column vectors of the
same size. To ensure that the dimensions of the returned x-, y-, and z-components are
consistent with the dimensions of the original query points, use reshape. For example,
use cgrady = reshape(cgrady,size(yq)).

For a time-dependent PDE or a system of PDEs, the first dimension of the resulting arrays
corresponds to spatial points specified by the column vectors xq(:), yq(:), and (if
present) zq(:).
Data Types: double

zq — z-coordinate query points
real array
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z-coordinate query points, specified as a real array. evaluateCGradient evaluates the
tensor product of c-coefficient and gradients of the PDE solution at the 3-D coordinate
points [xq(i),yq(i),zq(i)]. So xq, yq, and zq must have the same number of
entries.

evaluateCGradient converts query points to column vectors xq(:), yq(:), and
zq(:). For a single stationary PDE, the result consists of column vectors of the same size.
To ensure that the dimensions of the returned x-, y-, and z-components are consistent
with the dimensions of the original query points, use reshape. For example, use cgradz
= reshape(cgradz,size(zq)).

For a time-dependent PDE or a system of PDEs, the first dimension of the resulting arrays
corresponds to spatial points specified by the column vectors xq(:), yq(:), and (if
present) zq(:).
Data Types: double

querypoints — Query points
real matrix

Query points, specified as a real matrix with either two rows for 2-D geometry or three
rows for 3-D geometry. evaluateCGradient evaluates the tensor product of c-
coefficient and gradients of the PDE solution at the coordinate points
querypoints(:,i), so each column of querypoints contains exactly one 2-D or 3-D
query point.
Example: For 2-D geometry, querypoints = [0.5,0.5,0.75,0.75; 1,2,0,0.5]
Data Types: double

iT — Time indices
vector of positive integers

Time indices, specified as a vector of positive integers. Each entry in iT specifies a time
index.
Example: iT = 1:5:21 specifies every fifth time-step up to 21.
Data Types: double

iU — Equation indices
vector of positive integers

Equation indices, specified as a vector of positive integers. Each entry in iU specifies an
equation index.
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Example: iU = [1,5] specifies the indices for the first and fifth equations.
Data Types: double

Output Arguments
cgradx — x-component of the flux of the PDE solution
array

x-component of the flux of the PDE solution, returned as an array. The first array
dimension represents the node index. If results is a StationaryResults object, the
second array dimension represents the equation index for a system of PDEs. If results
is a TimeDependentResults object, the second array dimension represents either the
time-step for a single PDE or the equation index for a system of PDEs. The third array
dimension represents the time-step index for a system of time-dependent PDEs. For
information about the size of cgradx, see “Dimensions of Solutions, Gradients, and
Fluxes” on page 3-317.

For query points that are outside the geometry, cgradx = NaN.

cgrady — y-component of the flux of the PDE solution
array

y-component of the flux of the PDE solution, returned as an array. The first array
dimension represents the node index. If results is a StationaryResults object, the
second array dimension represents the equation index for a system of PDEs. If results
is a TimeDependentResults object, the second array dimension represents either the
time-step for a single PDE or the equation index for a system of PDEs. The third array
dimension represents the time-step index for a system of time-dependent PDEs. For
information about the size of cgrady, see “Dimensions of Solutions, Gradients, and
Fluxes” on page 3-317.

For query points that are outside the geometry, cgrady = NaN.

cgradz — z-component of the flux of the PDE solution
array

z-component of the flux of the PDE solution, returned as an array. The first array
dimension represents the node index. If results is a StationaryResults object, the
second array dimension represents the equation index for a system of PDEs. If results
is a TimeDependentResults object, the second array dimension represents either the
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time-step for a single PDE or the equation index for a system of PDEs. The third array
dimension represents the time-step index for a system of time-dependent PDEs. For
information about the size of cgradz, see “Dimensions of Solutions, Gradients, and
Fluxes” on page 3-317.

For query points that are outside the geometry, cgradz = NaN.

Tips
• While the results object contains the solution and its gradient (both calculated at

the nodal points of the triangular or tetrahedral mesh), it does not contain the flux of
the PDE solution. To compute the flux at the nodal locations, call
evaluateCGradient without specifying locations. By default, evaluateCGradient
uses nodal locations.

See Also
PDEModel | StationaryResults | TimeDependentResults | evaluateGradient |
interpolateSolution

Topics
“Deflection Analysis of Bracket”
“Dynamics of Damped Cantilever Beam”
“Heat Transfer Between Two Squares Made of Different Materials: PDE Modeler App” on
page 3-149

Introduced in R2016b
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evaluateGradient
Package: pde

Evaluate gradients of PDE solutions at arbitrary points

Syntax
[gradx,grady] = evaluateGradient(results,xq,yq)
[gradx,grady,gradz] = evaluateGradient(results,xq,yq,zq)
[ ___ ] = evaluateGradient(results,querypoints)

[ ___ ] = evaluateGradient( ___ ,iU)

[ ___ ] = evaluateGradient( ___ ,iT)

Description
[gradx,grady] = evaluateGradient(results,xq,yq) returns the interpolated
values of gradients of the PDE solution results at the 2-D points specified in xq and yq.

[gradx,grady,gradz] = evaluateGradient(results,xq,yq,zq) returns the
interpolated gradients at the 3-D points specified in xq, yq, and zq.

[ ___ ] = evaluateGradient(results,querypoints) returns the interpolated
values of the gradients at the points specified in querypoints.

[ ___ ] = evaluateGradient( ___ ,iU) returns the interpolated values of the
gradients for the system of equations for equation indices (components) iU. When solving
a system of elliptic PDEs, specify iU after the input arguments in any of the previous
syntaxes.

The first dimension of gradx, grady, and, in 3-D case, gradz corresponds to query
points. The second dimension corresponds to equation indices iU.

[ ___ ] = evaluateGradient( ___ ,iT) returns the interpolated values of the
gradients for the time-dependent equation or system of time-dependent equations at
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times iT. When evaluating gradient for a time-dependent PDE, specify iT after the input
arguments in any of the previous syntaxes. For a system of time-dependent equations,
specify both time indices iT and equation indices (components) iU.

The first dimension of gradx, grady, and, in 3-D case, gradz corresponds to query
points. For a single time-dependent PDE, the second dimension corresponds to time-steps
iT. For a system of time-dependent PDEs, the second dimension corresponds to equation
indices iU, and the third dimension corresponds to time-steps iT.

Examples

Evaluate Gradients for Scalar Elliptic Problem

Evaluate gradients of the solution to a scalar elliptic problem along a line. Plot the
results.

Create the solution to the problem −Δu = 1 on the L-shaped membrane with zero
Dirichlet boundary conditions.

model = createpde;
geometryFromEdges(model,@lshapeg);
applyBoundaryCondition(model,'dirichlet','Edge',1:model.Geometry.NumEdges,'u',0);
specifyCoefficients(model,'m',0,...
                          'd',0,...
                          'c',1,...
                          'a',0,...
                          'f',1);
generateMesh(model,'Hmax',0.05);
results = solvepde(model);

Evaluate gradients of the solution along the straight line from (x,y)=(-1,-1) to (1,1).
Plot the results as a quiver plot by using quiver.

xq = linspace(-1,1,101);
yq = xq;
[gradx,grady] = evaluateGradient(results,xq,yq);

gradx = reshape(gradx,size(xq));
grady = reshape(grady,size(yq));

quiver(xq,yq,gradx,grady)
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xlabel('x')
ylabel('y')

Evaluate Gradients for Poisson's Equation

Calculate gradients for the mean exit time of a Brownian particle from a region that
contains absorbing (escape) boundaries and reflecting boundaries. Use the Poisson's
equation with constant coefficients and 3-D rectangular block geometry to model this
problem.

Create the solution for this problem.
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model = createpde;
importGeometry(model,'Block.stl');
applyBoundaryCondition(model,'dirichlet','Face',[1,2,5],'u',0);
specifyCoefficients(model,'m',0,...
                          'd',0,...
                          'c',1,...
                          'a',0,...
                          'f',2);
generateMesh(model);
results = solvepde(model);

Create a grid and interpolate gradients of the solution to the grid.

[X,Y,Z] = meshgrid(1:16:100,1:6:20,1:7:50);
[gradx,grady,gradz] = evaluateGradient(results,X,Y,Z);

Reshape the gradients to the shape of the grid and plot the gradients.

gradx = reshape(gradx,size(X));
grady = reshape(grady,size(Y));
gradz = reshape(gradz,size(Z));

quiver3(X,Y,Z,gradx,grady,gradz)
axis equal
xlabel('x')
ylabel('y')
zlabel('z')
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Evaluate Gradients Using Query Matrix

Solve a scalar elliptic problem and interpolate gradients of the solution to a dense grid.
Use a query matrix to specify the grid.

Create the solution to the problem −Δu = 1 on the L-shaped membrane with zero
Dirichlet boundary conditions.

model = createpde;
geometryFromEdges(model,@lshapeg);
applyBoundaryCondition(model,'dirichlet','Edge',1:model.Geometry.NumEdges,'u',0);
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specifyCoefficients(model,'m',0,...
                          'd',0,...
                          'c',1,...
                          'a',0,...
                          'f',1);
generateMesh(model,'Hmax',0.05);
results = solvepde(model);

Interpolate gradients of the solution to the grid from -1 to 1 in each direction. Plot the
result using the quiver plotting function.

v = linspace(-1,1,101);
[X,Y] = meshgrid(v);
querypoints = [X(:),Y(:)]';

[gradx,grady] = evaluateGradient(results,querypoints);
quiver(X(:),Y(:),gradx,grady)
xlabel('x')
ylabel('y')
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Zoom in on a particular part of the plot to see more details. For example, limit the plotting
range to 0.2 in each direction.

axis([-0.2 0.2 -0.2 0.2])
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Evaluate Gradients of Solution of Elliptic System

Evaluate gradients of the solution to a two-component elliptic system and plot the results.

Create a PDE model for two components.

model = createpde(2);

Create the 2-D geometry as a rectangle with a circular hole in its center. For details about
creating the geometry, see the example in “Solve PDEs with Constant Boundary
Conditions” on page 2-181.
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R1 = [3,4,-0.3,0.3,0.3,-0.3,-0.3,-0.3,0.3,0.3]';
C1 = [1,0,0,0.1]';
C1 = [C1;zeros(length(R1)-length(C1),1)];
geom = [R1,C1];
ns = (char('R1','C1'))';
sf = 'R1 - C1';
g = decsg(geom,sf,ns);

Include the geometry in the model and view the geometry.

geometryFromEdges(model,g);
pdegplot(model,'EdgeLabels','on')
axis equal
axis([-0.4,0.4,-0.4,0.4])

5 Functions — Alphabetical List

5-186



Set the boundary conditions and coefficients.

specifyCoefficients(model,'m',0,...
                          'd',0,...
                          'c',1,...
                          'a',0,...
                          'f',[2; -2]);

applyBoundaryCondition(model,'dirichlet','Edge',3,'u',[-1,1]);
applyBoundaryCondition(model,'dirichlet','Edge',1,'u',[1,-1]);
applyBoundaryCondition(model,'neumann','Edge',[2,4:8],'g',[0,0]);

Create a mesh and solve the problem.

generateMesh(model,'Hmax',0.1);
results = solvepde(model);

Interpolate the gradients of the solution to the grid from -0.3 to 0.3 in each direction for
each of the two components.

v = linspace(-0.3,0.3,15);
[X,Y] = meshgrid(v);

[gradx,grady] = evaluateGradient(results,X,Y,[1,2]);

Plot the gradients for the first component.

figure
gradx1 = gradx(:,1);
grady1 = grady(:,1);
quiver(X(:),Y(:),gradx1,grady1)
title('Component 1')
axis equal
xlim([-0.3,0.3])
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Plot the gradients for the second component.

figure
gradx2 = gradx(:,2);
grady2 = grady(:,2);
quiver(X(:),Y(:),gradx2,grady2)
title('Component 2')
axis equal
xlim([-0.3,0.3])
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Evaluate Gradients of Solution of Hyperbolic System

Solve a system of hyperbolic PDEs and evaluate gradients.

Import slab geometry for a 3-D problem with three solution components. Plot the
geometry.

model = createpde(3);
importGeometry(model,'Plate10x10x1.stl');
pdegplot(model,'FaceLabels','on','FaceAlpha',0.5)
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Set boundary conditions such that face 2 is fixed (zero deflection in any direction) and
face 5 has a load of 1e3 in the positive z-direction. This load causes the slab to bend
upward. Set the initial condition that the solution is zero, and its derivative with respect
to time is also zero.

applyBoundaryCondition(model,'dirichlet','Face',2,'u',[0,0,0]);
applyBoundaryCondition(model,'neumann','Face',5,'g',[0,0,1e3]);
setInitialConditions(model,0,0);

Create PDE coefficients for the equations of linear elasticity. Set the material properties
to be similar to those of steel. See 3-D Linear Elasticity Equations in Toolbox Form.

E = 200e9;
nu = 0.3;
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specifyCoefficients(model,'m',1,...
                          'd',0,...
                          'c',elasticityC3D(E,nu),...
                          'a',0,...
                          'f',[0;0;0]);

Generate a mesh, setting Hmax to 1.

generateMesh(model,'Hmax',1);

Solve the problem for times 0 through 5e-3 in steps of 1e-4. You might have to wait a
few minutes for the solution.

tlist = 0:5e-4:5e-3;
results = solvepde(model,tlist);

Evaluate the gradients of the solution at fixed x- and z-coordinates in the centers of their
ranges, 5 and 0.5 respectively. Evaluate for y from 0 through 10 in steps of 0.2. Obtain
just component 3, the z-component.

yy = 0:0.2:10;
zz = 0.5*ones(size(yy));
xx = 10*zz;
component = 3;
[gradx,grady,gradz] = evaluateGradient(results,xx,yy,zz,component,1:length(tlist));

The three projections of the gradients of the solution are 51-by-1-by-51 arrays. Use
squeeze to remove the singleton dimension. Removing the singleton dimension
transforms these arrays to 51-by-51 matrices which simplifies indexing into them.

gradx = squeeze(gradx);
grady = squeeze(grady);
gradz = squeeze(gradz);

Plot the interpolated gradient component grady along the y axis for the following six
values from the time interval tlist.

figure
t = [1:2:11];
for i = t
  p(i) = plot(yy,grady(:,i),'DisplayName', strcat('t=', num2str(tlist(i))));
  hold on
end
legend(p(t))
xlabel('y')
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ylabel('grady')
ylim([-5e-6, 20e-6])

Input Arguments
results — PDE solution
StationaryResults object | TimeDependentResults object

PDE solution, specified as a StationaryResults object or a TimeDependentResults
object. Create results using solvepde or createPDEResults.
Example: results = solvepde(model)
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xq — x-coordinate query points
real array

x-coordinate query points, specified as a real array. evaluateGradient evaluates the
gradients of the solution at the 2-D coordinate points [xq(i),yq(i)] or at the 3-D
coordinate points [xq(i),yq(i),zq(i)]. So xq, yq, and (if present) zq must have the
same number of entries.

evaluateGradient converts query points to column vectors xq(:), yq(:), and (if
present) zq(:). For a single stationary PDE, the result consists of column vectors of the
same size. To ensure that the dimensions of the gradient components are consistent with
the dimensions of the original query points, use reshape. For example, use gradx =
reshape(gradx,size(xq)).

For a time-dependent PDE or a system of PDEs, the first dimension of the resulting arrays
corresponds to spatial points specified by the column vectors xq(:), yq(:), and (if
present) zq(:).
Data Types: double

yq — y-coordinate query points
real array

y-coordinate query points, specified as a real array. evaluateGradient evaluates the
gradients of the solution at the 2-D coordinate points [xq(i),yq(i)] or at the 3-D
coordinate points [xq(i),yq(i),zq(i)]. So xq, yq, and (if present) zq must have the
same number of entries.

evaluateGradient converts query points to column vectors xq(:), yq(:), and (if
present) zq(:). For a single stationary PDE, the result consists of column vectors of the
same size. To ensure that the dimensions of the gradient components are consistent with
the dimensions of the original query points, use reshape. For example, use grady =
reshape(grady,size(yq)).

For a time-dependent PDE or a system of PDEs, the first dimension of the resulting arrays
corresponds to spatial points specified by the column vectors xq(:), yq(:), and (if
present) zq(:).
Data Types: double

zq — z-coordinate query points
real array
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z-coordinate query points, specified as a real array. evaluateGradient evaluates the
gradients of the solution at the 3-D coordinate points [xq(i),yq(i),zq(i)]. So xq, yq,
and zq must have the same number of entries.

evaluateGradient converts query points to column vectors xq(:), yq(:), and (if
present) zq(:). For a single stationary PDE, the result consists of column vectors of the
same size. To ensure that the dimensions of the gradient components are consistent with
the dimensions of the original query points, use reshape. For example, use gradz =
reshape(gradz,size(zq)).

For a time-dependent PDE or a system of PDEs, the first dimension of the resulting arrays
corresponds to spatial points specified by the column vectors xq(:), yq(:), and (if
present) zq(:).
Data Types: double

querypoints — Query points
real matrix

Query points, specified as a real matrix with either two rows for 2-D geometry, or three
rows for 3-D geometry. evaluateGradient evaluates the gradients of the solution at the
coordinate points querypoints(:,i), so each column of querypoints contains exactly
one 2-D or 3-D query point.
Example: For 2-D geometry, querypoints = [0.5,0.5,0.75,0.75; 1,2,0,0.5]
Data Types: double

iU — Equation indices
vector of positive integers

Equation indices, specified as a vector of positive integers. Each entry in iU specifies an
equation index.
Example: iU = [1,5] specifies the indices for the first and fifth equations.
Data Types: double

iT — Time indices
vector of positive integers

Time indices, specified as a vector of positive integers. Each entry in iT specifies a time
index.
Example: iT = 1:5:21 specifies every fifth time-step up to 21.
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Data Types: double

Output Arguments
gradx — x-component of the gradient
array

x-component of the gradient, returned as an array. For query points that are outside the
geometry, gradx = NaN. For information about the size of gradx, see “Dimensions of
Solutions, Gradients, and Fluxes” on page 3-317.

grady — y-component of the gradient
array

y-component of the gradient, returned as an array. For query points that are outside the
geometry, grady = NaN. For information about the size of grady, see “Dimensions of
Solutions, Gradients, and Fluxes” on page 3-317.

gradz — z-component of the gradient
array

z-component of the gradient, returned as an array. For query points that are outside the
geometry, gradz = NaN. For information about the size of gradz, see “Dimensions of
Solutions, Gradients, and Fluxes” on page 3-317.

Tips
The results object contains the solution and its gradient calculated at the nodal points
of the triangular or tetrahedral mesh. You can access the solution and three components
of the gradient at nodal points by using dot notation.

interpolateSolution and evaluateGradient let you interpolate the solution and its
gradient to a custom grid, for example, specified by meshgrid.

See Also
PDEModel | StationaryResults | TimeDependentResults | contour |
evaluateCGradient | interpolateSolution | quiver | quiver3
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Topics
“Plot 2-D Solutions and Their Gradients” on page 3-284
“Plot 3-D Solutions and Their Gradients” on page 3-295
“Dimensions of Solutions, Gradients, and Fluxes” on page 3-317

Introduced in R2016a

5 Functions — Alphabetical List

5-196



evaluateHeatFlux
Package: pde

Evaluate heat flux of a thermal solution at nodal or arbitrary spatial locations

Syntax
[qx,qy] = evaluateHeatFlux(thermalresults,xq,yq)
[qx,qy,qz] = evaluateHeatFlux(thermalresults,xq,yq,zq)
[ ___ ] = evaluateHeatFlux(thermalresults,querypoints)

[ ___ ] = evaluateHeatFlux( ___ ,iT)

[qx,qy] = evaluateHeatFlux(thermalresults)
[qx,qy,qz] = evaluateHeatFlux(thermalresults)

Description
[qx,qy] = evaluateHeatFlux(thermalresults,xq,yq) returns the heat flux for a
thermal problem at the 2-D points specified in xq and yq. This syntax is valid for both the
steady-state and transient thermal models.

[qx,qy,qz] = evaluateHeatFlux(thermalresults,xq,yq,zq) returns the heat
flux for a thermal problem at the 3-D points specified in xq, yq, and zq. This syntax is
valid for both the steady-state and transient thermal models.

[ ___ ] = evaluateHeatFlux(thermalresults,querypoints) returns the heat flux
for a thermal problem at the 2-D or 3-D points specified in querypoints. This syntax is
valid for both the steady-state and transient thermal models.

[ ___ ] = evaluateHeatFlux( ___ ,iT) returns the heat flux for a thermal problem at
the times specified in iT. You can specify iT after the input arguments in any of the
previous syntaxes.

The first dimension of qx, qy, and, in the 3-D case, qz corresponds to query points. The
second dimension corresponds to time steps iT.
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[qx,qy] = evaluateHeatFlux(thermalresults) returns the heat flux for a 2-D
problem at the nodal points of the triangular mesh. The first dimension of qx and qy
represents the node indices. The second dimension represents time steps.

[qx,qy,qz] = evaluateHeatFlux(thermalresults) returns the heat flux for a 3-D
thermal problem at the nodal points of the tetrahedral mesh. The first dimension of qx,
qy, and qz represents the node indices. The second dimension represents time steps.

Examples

Heat Flux for 2-D Steady-State Thermal Model

For a 2-D steady-state thermal model, evaluate heat flux at the nodal locations and at the
points specified by x and y coordinates.

Create a thermal model for steady-state analysis.

thermalmodel = createpde('thermal');

Create the geometry and include it in the model.

R1 = [3,4,-1,1,1,-1,1,1,-1,-1]';
g = decsg(R1,'R1',('R1')');
geometryFromEdges(thermalmodel,g);
pdegplot(thermalmodel,'EdgeLabels','on')
xlim([-1.5 1.5])
axis equal
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Assuming that this geometry represents an iron plate, the thermal conductivity is
79 . 5 W /(mK).

thermalProperties(thermalmodel,'ThermalConductivity',79.5,'Face',1);

Apply a constant temperature of 500 K to the bottom of the plate (edge 3). Also, assume
that the top of the plate (edge 1) is insulated, and apply convection on the two sides of the
plate (edges 2 and 4).

thermalBC(thermalmodel,'Edge',3,'Temperature',500);
thermalBC(thermalmodel,'Edge',1,'HeatFlux',0);
thermalBC(thermalmodel,'Edge',[2 4], ...
                       'ConvectionCoefficient',25, ...
                       'AmbientTemperature',50);
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Mesh the geometry and solve the problem.

generateMesh(thermalmodel);
results = solve(thermalmodel)

results = 
  SteadyStateThermalResults with properties:

    Temperature: [1541x1 double]
     XGradients: [1541x1 double]
     YGradients: [1541x1 double]
     ZGradients: []
           Mesh: [1x1 FEMesh]

Evaluate heat flux at the nodal locations.

[qx,qy] = evaluateHeatFlux(results);

figure
pdeplot(thermalmodel,'FlowData',[qx qy])
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Create a grid specified by x and y coordinates, and evaluate heat flux to the grid.

v = linspace(-0.5,0.5,11);
[X,Y] = meshgrid(v);

[qx,qy] = evaluateHeatFlux(results,X,Y);

Reshape the qTx and qTy vectors, and plot the resulting heat flux.

qx = reshape(qx,size(X));
qy = reshape(qy,size(Y));
figure
quiver(X,Y,qx,qy)
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Alternatively, you can specify the grid by using a matrix of query points.

querypoints = [X(:) Y(:)]';
[qx,qy] = evaluateHeatFlux(results,querypoints);

qx = reshape(qx,size(X));
qy = reshape(qy,size(Y));
figure
quiver(X,Y,qx,qy)

5 Functions — Alphabetical List

5-202



Heat Flux for 3-D Steady-State Thermal Model

For a 3-D steady-state thermal model, evaluate heat flux at the nodal locations and at the
points specified by x, y, and z coordinates.

Create a thermal model for steady-state analysis.

thermalmodel = createpde('thermal');

Create the following 3-D geometry and include it in the model.
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importGeometry(thermalmodel,'Block.stl'); 
pdegplot(thermalmodel,'FaceLabels','on','FaceAlpha',0.5)
title('Copper block, cm')
axis equal

Assuming that this is a copper block, the thermal conductivity of the block is
approximately 4 W /(cmK).

thermalProperties(thermalmodel,'ThermalConductivity',4);

Apply a constant temperature of 373 K to the left side of the block (face 1) and a constant
temperature of 573 K to the right side of the block (face 3).

thermalBC(thermalmodel,'Face',1,'Temperature',373);
thermalBC(thermalmodel,'Face',3,'Temperature',573);
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Apply a heat flux boundary condition to the bottom of the block.

thermalBC(thermalmodel,'Face',4,'HeatFlux',-20);

Mesh the geometry and solve the problem.

generateMesh(thermalmodel);
thermalresults = solve(thermalmodel)

thermalresults = 
  SteadyStateThermalResults with properties:

    Temperature: [12691x1 double]
     XGradients: [12691x1 double]
     YGradients: [12691x1 double]
     ZGradients: [12691x1 double]
           Mesh: [1x1 FEMesh]

Evaluate heat flux at the nodal locations.

[qx,qy,qz] = evaluateHeatFlux(thermalresults);

figure
pdeplot3D(thermalmodel,'FlowData',[qx qy qz])
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Create a grid specified by x, y, and z coordinates, and evaluate heat flux to the grid.

[X,Y,Z] = meshgrid(1:26:100,1:6:20,1:11:50);

[qx,qy,qz] = evaluateHeatFlux(thermalresults,X,Y,Z);

Reshape the qx, qy, and qz vectors, and plot the resulting heat flux.

qx = reshape(qx,size(X));
qy = reshape(qy,size(Y));
qz = reshape(qz,size(Z));
figure
quiver3(X,Y,Z,qx,qy,qz)
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Alternatively, you can specify the grid by using a matrix of query points.

querypoints = [X(:) Y(:) Z(:)]';
[qx,qy,qz] = evaluateHeatFlux(thermalresults,querypoints);

qx = reshape(qx,size(X));
qy = reshape(qy,size(Y));
qz = reshape(qz,size(Z));
figure
quiver3(X,Y,Z,qx,qy,qz)
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Heat Flux for Transient Thermal Model on Square

Solve a 2-D transient heat transfer problem on a square domain, and compute heat flow
across a convective boundary.

Create a thermal model for this problem.

thermalmodel = createpde('thermal','transient');

Create the geometry and include it in the model.
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g = @squareg;
geometryFromEdges(thermalmodel,g);
pdegplot(thermalmodel,'EdgeLabels','on')
xlim([-1.2 1.2])
ylim([-1.2 1.2])
axis equal

Assign the following thermal properties: thermal conductivity is 100 W /(m∘C), mass
density is 7800 kg/m3, and specific heat is 500 J /(kg∘C).

thermalProperties(thermalmodel,'ThermalConductivity',100, ...
                               'MassDensity',7800, ...
                               'SpecificHeat',500);
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Apply insulated boundary conditions on three edges and the free convection boundary
condition on the right edge.

thermalBC(thermalmodel,'Edge',[1 3 4],'HeatFlux',0);
thermalBC(thermalmodel,'Edge',2,...
                       'ConvectionCoefficient',5000, ...
                       'AmbientTemperature',25);

Set the initial conditions: uniform room temperature across domain and higher
temperature on the top edge.

thermalIC(thermalmodel,25);
thermalIC(thermalmodel,100,'Edge',1);

Generate a mesh and solve the problem using 0:1000:200000 as a vector of times.

generateMesh(thermalmodel);
tlist = 0:1000:200000;
thermalresults = solve(thermalmodel,tlist)

thermalresults = 
  TransientThermalResults with properties:

      Temperature: [1541x201 double]
    SolutionTimes: [1x201 double]
       XGradients: [1541x201 double]
       YGradients: [1541x201 double]
       ZGradients: []
             Mesh: [1x1 FEMesh]

Create a grid specified by x and y coordinates, and evaluate heat flux to the grid.

v = linspace(-1,1,11);
[X,Y] = meshgrid(v);

[qx,qy] = evaluateHeatFlux(thermalresults,X,Y,1:length(tlist));

Reshape qx and qy, and plot the resulting heat flux for the 25th solution step.

tlist(25)

ans = 24000

figure
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quiver(X(:),Y(:),qx(:,25),qy(:,25));
xlim([-1,1])
axis equal

Heat Flux for Transient Thermal Model on Two Squares Made of Different
Materials

Solve the heat transfer problem for the following 2-D geometry consisting of a square and
a diamond made of different materials. Compute the heat flux, and plot it as a vector field.

Create a thermal model for transient analysis.
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thermalmodel = createpde('thermal','transient');

Create the geometry and include it in the model.

SQ1 = [3; 4; 0; 3; 3; 0; 0; 0; 3; 3];
D1 = [2; 4; 0.5; 1.5; 2.5; 1.5; 1.5; 0.5; 1.5; 2.5];
gd = [SQ1 D1];
sf = 'SQ1+D1';
ns = char('SQ1','D1');
ns = ns';
dl = decsg(gd,sf,ns);
geometryFromEdges(thermalmodel,dl);
pdegplot(thermalmodel,'EdgeLabels','on','FaceLabels','on')
xlim([-1.5 4.5])
ylim([-0.5 3.5])
axis equal
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For the square region, assign the following thermal properties: thermal conductivity is
10 W /(m∘C), mass density is 2 kg/m3, and specific heat is 0 . 1 J /(kg∘C).

thermalProperties(thermalmodel,'ThermalConductivity',10, ...
                               'MassDensity',2, ...
                               'SpecificHeat',0.1, ...
                               'Face',1);

For the diamond-shaped region, assign the following thermal properties: thermal
conductivity is 2 W /(m∘C), mass density is 1 kg/m3, and specific heat is 0 . 1 J /(kg∘C).

thermalProperties(thermalmodel,'ThermalConductivity',2, ...
                               'MassDensity',1, ...
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                               'SpecificHeat',0.1, ...
                               'Face',2);

Assume that the diamond-shaped region is a heat source with the density of 4 W /m3.

internalHeatSource(thermalmodel,4,'Face',2);

Apply a constant temperature of 0∘C to the sides of the square plate.

thermalBC(thermalmodel,'Temperature',0,'Edge',[1 2 7 8]);

Set the initial temperature to 0∘C.

thermalIC(thermalmodel,0);

Mesh the geometry and solve the problem.

generateMesh(thermalmodel);

The dynamic for this problem is very fast: the temperature reaches steady state in about
0.1 seconds. To capture the interesting part of the dynamics, set the solution time to
logspace(-2,-1,10). This gives 10 logarithmically spaced solution times between 0.01
and 0.1. Solve the equation.

tlist = logspace(-2,-1,10);
thermalresults = solve(thermalmodel,tlist);
temp = thermalresults.Temperature;

Compute the heat flux density. Plot the solution with isothermal lines using a contour plot,
and plot the heat flux vector field using arrows.

[qTx,qTy] = evaluateHeatFlux(thermalresults);

figure
pdeplot(thermalmodel,'XYData',temp(:,10),'Contour','on', ...
                     'FlowData',[qTx(:,10) qTy(:,10)], ...
                     'ColorMap','hot')
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Input Arguments
thermalresults — Solution of thermal problem
SteadyStateThermalResults object | TransientThermalResults object

Solution of a thermal problem, specified as a SteadyStateThermalResults object or a
TransientThermalResults object. Create thermalresults using the solve
function.
Example: thermalresults = solve(thermalmodel)
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xq — x-coordinate query points
real array

x-coordinate query points, specified as a real array. evaluateHeatFlux evaluates the
heat flux at the 2-D coordinate points [xq(i) yq(i)] or at the 3-D coordinate points
[xq(i) yq(i) zq(i)]. So xq, yq, and (if present) zq must have the same number of
entries.

evaluateHeatFlux converts query points to column vectors xq(:), yq(:), and (if
present) zq(:). It returns the heat flux in a form of a column vector of the same size. To
ensure that the dimensions of the returned solution are consistent with the dimensions of
the original query points, use reshape. For example, use qx =
reshape(qx,size(xq)).
Data Types: double

yq — y-coordinate query points
real array

y-coordinate query points, specified as a real array. evaluateHeatFlux evaluates the
heat flux at the 2-D coordinate points [xq(i) yq(i)] or at the 3-D coordinate points
[xq(i) yq(i) zq(i)]. So xq, yq, and (if present) zq must have the same number of
entries.

evaluateHeatFlux converts query points to column vectors xq(:), yq(:), and (if
present) zq(:). It returns the heat flux in a form of a column vector of the same size. To
ensure that the dimensions of the returned solution is consistent with the dimensions of
the original query points, use reshape. For example, use qy =
reshape(qy,size(yq)).
Data Types: double

zq — z-coordinate query points
real array

z-coordinate query points, specified as a real array. evaluateHeatFlux evaluates the
heat flux at the 3-D coordinate points [xq(i) yq(i) zq(i)]. So xq, yq, and zq must
have the same number of entries.

evaluateHeatFlux converts query points to column vectors xq(:), yq(:), and (if
present) zq(:). It returns the heat flux in a form of a column vector of the same size. To
ensure that the dimensions of the returned solution is consistent with the dimensions of
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the original query points, use reshape. For example, use qz =
reshape(qz,size(zq)).
Data Types: double

querypoints — Query points
real matrix

Query points, specified as a real matrix with two rows for 2-D geometry or three rows for
3-D geometry. evaluateHeatFlux evaluates the heat flux at the coordinate points
querypoints(:,i), so each column of querypoints contains exactly one 2-D or 3-D
query point.
Example: For 2-D geometry, querypoints = [0.5 0.5 0.75 0.75; 1 2 0 0.5]
Data Types: double

iT — Time indices
vector of positive integers

Time indices, specified as a vector of positive integers. Each entry in iT specifies a time
index.
Example: iT = 1:5:21 specifies every fifth time-step up to 21.
Data Types: double

Output Arguments
qx — x-component of the heat flux
array

x-component of the heat flux, returned as an array. The first array dimension represents
the node index. The second array dimension represents the time step.

For query points that are outside the geometry, qx = NaN.

qy — y-component of the heat flux
array

y-component of the heat flux, returned as an array. The first array dimension represents
the node index. The second array dimension represents the time step.
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For query points that are outside the geometry, qy = NaN.

qz — z-component of the heat flux
array

z-component of the heat flux, returned as an array. The first array dimension represents
the node index. The second array dimension represents the time step.

For query points that are outside the geometry, qz = NaN.

See Also
SteadyStateThermalResults | ThermalModel | TransientThermalResults |
evaluateHeatRate | evaluateTemperatureGradient | interpolateTemperature

Introduced in R2017a
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evaluateHeatRate
Package: pde

Evaluate integrated heat flow rate normal to specified boundary

Syntax
Qn = evaluateHeatRate(thermalresults,RegionType,RegionID)

Description
Qn = evaluateHeatRate(thermalresults,RegionType,RegionID) returns the
integrated heat flow rate normal to the boundary specified by RegionType and
RegionID.

Examples

Heat Flow From Face of Block

Compute the heat flow rate across a face of the block geometry.

Create a steady-state thermal model.

thermalmodel = createpde('thermal','steadystate');

Import the block geometry.

importGeometry(thermalmodel,'Block.stl');
pdegplot(thermalmodel,'FaceLabels','on','FaceAlpha',0.5)
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Specify the thermal conductivity of the block.

thermalProperties(thermalmodel,'ThermalConductivity',80);

Apply constant temperatures on the opposite ends of the block. All other faces are
insulated by default.

thermalBC(thermalmodel,'Face',1,'Temperature',100);
thermalBC(thermalmodel,'Face',3,'Temperature',50);

Generate mesh.

generateMesh(thermalmodel,'GeometricOrder','linear');

Solve the thermal model.
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thermalresults = solve(thermalmodel);

Compute the heat flow rate across face 3 of the block.

Qn = evaluateHeatRate(thermalresults,'Face',3)

Qn = 4.0000e+04

Convection Cooling of Sphere

Compute the heat flow rate across the surface of the cooling sphere.

Create a thermal model for transient analysis.

thermalmodel = createpde('thermal','transient');

Create a sphere of radius 1, and assign it to the thermal model.

gm = multisphere(1);
thermalmodel.Geometry = gm;

Generate mesh.

generateMesh(thermalmodel,'GeometricOrder','linear');

Specify thermal properties of the sphere.

thermalProperties(thermalmodel,'ThermalConductivity',80, ...
                               'SpecificHeat',460, ...
                               'MassDensity',7800);

Apply a convection boundary condition on the surface of the sphere.

thermalBC(thermalmodel,'Face',1,...
                       'ConvectionCoefficient',500, ...
                       'AmbientTemperature',30);

Set the initial temperature.

thermalIC(thermalmodel,800);

Solve the thermal model.
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tlist = 0:100:2000;
result = solve(thermalmodel,tlist);

Compute the heat flow rate across the surface of the sphere over time.

Qn = evaluateHeatRate(result,'Face',1);
plot(tlist,Qn)
xlabel('Time')
ylabel('Heat Flow Rate')
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Input Arguments
thermalresults — Solution of thermal problem
SteadyStateThermalResults object

Solution of a thermal problem, specified as a SteadyStateThermalResults object.
Create thermalresults using the solve function.
Example: thermalresults = solve(thermalmodel)

RegionType — Geometric region type
'Face' for 3-D geometry | 'Edge' for 2-D geometry

Geometric region type, specified as 'Face' for 3-D geometry or 'Edge' for 2-D
geometry.
Example: Qn = evaluateHeatRate(thermalresults,'Face',3)
Data Types: char | string

RegionID — Geometric region ID
positive integer

Geometric region ID, specified as a positive integer. Find the region IDs using the
pdegplot function with the 'FaceLabels' (3-D) or 'EdgeLabels' (2-D) value set to
'on'.
Example: Qn = evaluateHeatRate(thermalresults,'Face',3)
Data Types: double

Output Arguments
Qn — Heat flow rate
real number | vector of real numbers

Heat flow rate, returned as a real number or, for time-dependent results, a vector of real
numbers. This value represents the integrated heat flow rate, measured in energy per
unit time, flowing in the direction normal to the boundary. Qn is positive if the heat flows
out of the domain, and negative if the heat flows into the domain.
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See Also
SteadyStateThermalResults | ThermalModel | TransientThermalResults |
evaluateHeatFlux | evaluateTemperatureGradient | interpolateTemperature

Introduced in R2017a

5 Functions — Alphabetical List

5-224



evaluatePrincipalStrain
Package: pde

Evaluate principal strain at nodal locations

Syntax
pStrain = evaluatePrincipalStrain(structuralresults)

Description
pStrain = evaluatePrincipalStrain(structuralresults) evaluates principal
strain at nodal locations using strain values from structuralresults. For a dynamic
structural model, evaluatePrincipalStrain evaluates principal strain for all time-
steps.

Examples

Octahedral Shear Strain for Bimetallic Cable Under Tension

Solve a static structural model representing a bimetallic cable under tension, and
compute octahedral shear strain.

Create a structural model.

structuralmodel = createpde('structural','static-solid');

Create the geometry and include it in the model. Plot the geometry.

gm = multicylinder([0.01,0.015],0.05);
structuralmodel.Geometry = gm;
pdegplot(structuralmodel,'FaceLabels','on', ...
                         'CellLabels','on', ...
                         'FaceAlpha',0.5)
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Specify the Young's modulus and Poisson's ratio for each metal.

structuralProperties(structuralmodel,'Cell',1,'YoungsModulus',110E9, ...
                                              'PoissonsRatio',0.28);
structuralProperties(structuralmodel,'Cell',2,'YoungsModulus',210E9, ...
                                              'PoissonsRatio',0.3);

Specify that faces 1 and 4 are fixed boundaries.

structuralBC(structuralmodel,'Face',[1,4],'Constraint','fixed');

Specify the surface traction for faces 2 and 5.

structuralBoundaryLoad(structuralmodel,'Face',[2,5], ...
                                       'SurfaceTraction',[0;0;100]);

5 Functions — Alphabetical List

5-226



Generate a mesh and solve the problem.

generateMesh(structuralmodel);
structuralresults = solve(structuralmodel)

structuralresults = 
  StaticStructuralResults with properties:

      Displacement: [1x1 struct]
            Strain: [1x1 struct]
            Stress: [1x1 struct]
    VonMisesStress: [22306x1 double]
              Mesh: [1x1 FEMesh]

Evaluate the principal strain at nodal locations.

pStrain = evaluatePrincipalStrain(structuralresults);

Use the principal strain to evaluate the first and second invariant of strain.

I1 = pStrain.e1 + pStrain.e2 + pStrain.e3;
I2 = pStrain.e1.*pStrain.e2 + pStrain.e2.*pStrain.e3 + pStrain.e3.*pStrain.e1;
tauOct = sqrt(2*(I1.^2 -3*I2))/3;
pdeplot3D(structuralmodel,'ColorMapData',tauOct)
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Principal Strain for 3-D Structural Dynamic Problem

Evaluate the principal strain and octahedral shear strain in a beam under a harmonic
excitation.

Create a transient dynamic model for a 3-D problem.

structuralmodel = createpde('structural','transient-solid');

Create a geometry and include it in the model. Plot the geometry.
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gm = multicuboid(0.06,0.005,0.01);
structuralmodel.Geometry = gm;
pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.5)
view(50,20)

Specify the Young's modulus, Poisson's ratio, and mass density of the material.

structuralProperties(structuralmodel,'YoungsModulus',210E9, ...
                                     'PoissonsRatio',0.3, ...
                                     'MassDensity',7800);

Fix one end of the beam.

structuralBC(structuralmodel,'Face',5,'Constraint','fixed');
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Apply a sinusoidal displacement along the y-direction on the end opposite the fixed end of
the beam.

structuralBC(structuralmodel,'Face',3,'YDisplacement',1E-4,'Frequency',50);

Generate a mesh.

generateMesh(structuralmodel,'Hmax',0.01);

Specify the zero initial displacement and velocity.

structuralIC(structuralmodel,'Displacement',[0;0;0],'Velocity',[0;0;0]);

Solve the model.

tlist = 0:0.002:0.2;
structuralresults = solve(structuralmodel,tlist);

Evaluate the principal strain in the beam.

pStrain = evaluatePrincipalStrain(structuralresults);

Use the principal strain to evaluate the first and second invariants.

I1 = pStrain.e1 + pStrain.e2 + pStrain.e3;
I2 = pStrain.e1.*pStrain.e2 + pStrain.e2.*pStrain.e3 + pStrain.e3.*pStrain.e1;

Use the stress invariants to compute the octahedral shear strain.

tauOct = sqrt(2*(I1.^2 -3*I2))/3;

Plot the results.

figure
pdeplot3D(structuralmodel,'ColorMapData',tauOct(:,end))
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Input Arguments
structuralresults — Solution of structural analysis problem
StaticStructuralResults object | TransientStructuralResults object

Solution of the structural analysis problem, specified as a StaticStructuralResults
or TransientStructuralResults object. Create structuralresults by using the
solve function.
Example: structuralresults = solve(structuralmodel)
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Output Arguments
pStrain — Principal strain at nodal locations
structure array

Principal strain at the nodal locations, returned as a structure array.

See Also
StaticStructuralResults | StructuralModel | evaluatePrincipalStress |
evaluateReaction | interpolateDisplacement | interpolateStrain |
interpolateStress | interpolateVonMisesStress

Introduced in R2017b
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evaluatePrincipalStress
Package: pde

Evaluate principal stress at nodal locations

Syntax
pStress = evaluatePrincipalStress(structuralresults)

Description
pStress = evaluatePrincipalStress(structuralresults) evaluates principal
stress at nodal locations using stress values from structuralresults. For a dynamic
structural model, evaluatePrincipalStress evaluates principal stress for all time-
steps.

Examples

Octahedral Shear Stress for Bimetallic Cable Under Tension

Solve a static structural model representing a bimetallic cable under tension, and
compute octahedral shear stress.

Create a structural model.

structuralmodel = createpde('structural','static-solid');

Create a geometry and include it in the model. Plot the geometry.

gm = multicylinder([0.01,0.015],0.05);
structuralmodel.Geometry = gm;
pdegplot(structuralmodel,'FaceLabels','on', ...
                         'CellLabels','on', ...
                         'FaceAlpha',0.5)
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Specify the Young's modulus and Poisson's ratio for each metal.

structuralProperties(structuralmodel,'Cell',1,'YoungsModulus',110E9, ...
                                              'PoissonsRatio',0.28);
structuralProperties(structuralmodel,'Cell',2,'YoungsModulus',210E9, ...
                                              'PoissonsRatio',0.3);

Specify that faces 1 and 4 are fixed boundaries.

structuralBC(structuralmodel,'Face',[1,4],'Constraint','fixed');

Specify the surface traction for faces 2 and 5.

structuralBoundaryLoad(structuralmodel,'Face',[2,5], ...
                                       'SurfaceTraction',[0;0;100]);
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Generate a mesh and solve the problem.

generateMesh(structuralmodel);
structuralresults = solve(structuralmodel)

structuralresults = 
  StaticStructuralResults with properties:

      Displacement: [1x1 struct]
            Strain: [1x1 struct]
            Stress: [1x1 struct]
    VonMisesStress: [22306x1 double]
              Mesh: [1x1 FEMesh]

Evaluate the principal stress at nodal locations.

pStress = evaluatePrincipalStress(structuralresults);

Use the principal stress to evaluate the first and second invariant of stress.

I1 = pStress.s1 + pStress.s2 + pStress.s3;
I2 = pStress.s1.*pStress.s2 + pStress.s2.*pStress.s3 + pStress.s3.*pStress.s1;
tauOct = sqrt(2*(I1.^2 -3*I2))/3;
pdeplot3D(structuralmodel,'ColorMapData',tauOct)
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Principal Stress for 3-D Structural Dynamic Problem

Evaluate the principal stress and octahedral shear stress in a beam under a harmonic
excitation.

Create a transient dynamic model for a 3-D problem.

structuralmodel = createpde('structural','transient-solid');

Create the geometry and include it in the model. Plot the geometry.
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gm = multicuboid(0.06,0.005,0.01);
structuralmodel.Geometry = gm;
pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.5)
view(50,20)

Specify the Young's modulus, Poisson's ratio, and mass density of the material.

structuralProperties(structuralmodel,'YoungsModulus',210E9, ...
                                     'PoissonsRatio',0.3, ...
                                     'MassDensity',7800);

Fix one end of the beam.

structuralBC(structuralmodel,'Face',5,'Constraint','fixed');
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Apply a sinusoidal displacement along the y-direction on the end opposite the fixed end of
the beam.

structuralBC(structuralmodel,'Face',3,'YDisplacement',1E-4,'Frequency',50);

Generate a mesh.

generateMesh(structuralmodel,'Hmax',0.01);

Specify the zero initial displacement and velocity.

structuralIC(structuralmodel,'Displacement',[0;0;0],'Velocity',[0;0;0]);

Solve the model.

tlist = 0:0.002:0.2;
structuralresults = solve(structuralmodel,tlist);

Evaluate the principal stress in the beam.

pStress = evaluatePrincipalStress(structuralresults);

Use the principal stress to evaluate the first and second invariants.

I1 = pStress.s1 + pStress.s2 + pStress.s3;
I2 = pStress.s1.*pStress.s2 + pStress.s2.*pStress.s3 + pStress.s3.*pStress.s1;

Use the stress invariants to compute the octahedral shear stress.

tauOct = sqrt(2*(I1.^2 -3*I2))/3;

Plot the results.

figure
pdeplot3D(structuralmodel,'ColorMapData',tauOct(:,end))
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Input Arguments
structuralresults — Solution of structural analysis problem
StaticStructuralResults object | TransientStructuralResults object

Solution of the structural analysis problem, specified as a StaticStructuralResults
or TransientStructuralResults object. Create structuralresults by using the
solve function.
Example: structuralresults = solve(structuralmodel)
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Output Arguments
pStress — Principal stress at nodal locations
structure array

Principal stress at the nodal locations, returned as a structure array.

See Also
StaticStructuralResults | StructuralModel | evaluatePrincipalStrain |
evaluateReaction | interpolateDisplacement | interpolateStrain |
interpolateStress | interpolateVonMisesStress

Introduced in R2017b
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evaluateReaction
Package: pde

Evaluate reaction forces on boundary

Syntax
F = evaluateReaction(structuralresults,RegionType,RegionID)

Description
F = evaluateReaction(structuralresults,RegionType,RegionID) evaluates
reaction forces on the boundary specified by RegionType and RegionID. The function
uses the global Cartesian coordinate system. For a dynamic structural model,
evaluateReaction evaluates reaction forces for all time-steps.

Examples

Reaction Forces on Restrained End of Prismatic Bar

Create a static structural model.

structuralmodel = createpde('structural','static-solid');

Create a cuboid geometry and include it in the model. Plot the geometry.

structuralmodel.Geometry = multicuboid(0.01,0.01,0.05);
pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.5);
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Specify the Young's modulus and Poisson's ratio.

structuralProperties(structuralmodel,'YoungsModulus',210E9,'PoissonsRatio',0.3);

Fix one end of the bar and apply pressure to the opposite end.

structuralBC(structuralmodel,'Face',1,'Constraint','fixed')

ans = 
  StructuralBC with properties:

                RegionType: 'Face'
                  RegionID: 1
                Vectorized: 'off'
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   Boundary Constraints and Enforced Displacements
              Displacement: []
             XDisplacement: []
             YDisplacement: []
             ZDisplacement: []
                Constraint: "fixed"

   Boundary Loads
                     Force: []
           SurfaceTraction: []
                  Pressure: []
    TranslationalStiffness: []

structuralBoundaryLoad(structuralmodel,'Face',2,'Pressure',100)

ans = 
  StructuralBC with properties:

                RegionType: 'Face'
                  RegionID: 2
                Vectorized: 'off'

   Boundary Constraints and Enforced Displacements
              Displacement: []
             XDisplacement: []
             YDisplacement: []
             ZDisplacement: []
                Constraint: []

   Boundary Loads
                     Force: []
           SurfaceTraction: []
                  Pressure: 100
    TranslationalStiffness: []

Generate a mesh and solve the problem.

generateMesh(structuralmodel,'Hmax',0.003);
structuralresults = solve(structuralmodel);

Compute the reaction forces on the fixed end.

reaction = evaluateReaction(structuralresults,'Face',1)
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reaction = struct with fields:
    Fx: -1.8486e-06
    Fy: 1.8707e-06
    Fz: 0.0104

Reaction Forces for 3-D Structural Dynamic Problem

Evaluate the reaction forces at the fixed end of a beam subject to harmonic excitation.

Create a transient dynamic model for a 3-D problem.

structuralmodel = createpde('structural','transient-solid');

Create a geometry and include it in the model. Plot the geometry.

gm = multicuboid(0.06,0.005,0.01);
structuralmodel.Geometry = gm;
pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.5)
view(50,20)
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Specify the Young's modulus, Poisson's ratio, and mass density of the material.

structuralProperties(structuralmodel,'YoungsModulus',210E9, ...
                                     'PoissonsRatio',0.3, ...
                                     'MassDensity',7800);

Fix one end of the beam.

structuralBC(structuralmodel,'Face',5,'Constraint','fixed');

Apply a sinusoidal displacement along the y-direction on the end opposite the fixed end of
the beam.

structuralBC(structuralmodel,'Face',3,'YDisplacement',1E-4,'Frequency',50);
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Generate a mesh.

generateMesh(structuralmodel,'Hmax',0.01);

Specify the zero initial displacement and velocity.

structuralIC(structuralmodel,'Displacement',[0;0;0],'Velocity',[0;0;0]);

Solve the model.

tlist = 0:0.002:0.2;
structuralresults = solve(structuralmodel,tlist);

Compute the reaction forces on the fixed end.

reaction = evaluateReaction(structuralresults,'Face',5)

reaction = struct with fields:
    Fx: [101x1 double]
    Fy: [101x1 double]
    Fz: [101x1 double]

Input Arguments
structuralresults — Solution of structural analysis problem
StaticStructuralResults object | TransientStructuralResults object

Solution of the structural analysis problem, specified as a StaticStructuralResults
or TransientStructuralResults object. Create structuralresults by using the
solve function.
Example: structuralresults = solve(structuralmodel)

RegionType — Geometric region type
'Edge' for a 2-D model | 'Face' for a 3-D model

Geometric region type, specified as 'Edge' for a 2-D model or 'Face' for a 3-D model.
Example: evaluateReaction(structuralresults,'Face',2)
Data Types: char | string
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RegionID — Geometric region ID
vector of positive integers

Geometric region ID, specified as a vector of positive integers. Find the region IDs using
pdegplot, as shown in “Create Geometry and Remove Face Boundaries” on page 2-13 or
“STL File Import” on page 2-46.
Example: evaluateReaction(structuralresults,'Face',2)
Data Types: double

Output Arguments
F — Reaction forces
structure array

Reaction forces, returned as a structure array. The array fields represent the integrated
reaction forces and surface traction vector, which are computed by using the state of
stress on the boundary and the outward normal.

See Also
StaticStructuralResults | StructuralModel | evaluatePrincipalStrain |
evaluatePrincipalStress | interpolateDisplacement | interpolateStrain |
interpolateStress | interpolateVonMisesStress

Introduced in R2017b
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evaluateStrain
Package: pde

Evaluate strain for dynamic structural analysis problem

Syntax
nodalStrain = evaluateStrain(structuralresults)

Description
nodalStrain = evaluateStrain(structuralresults) evaluates strain at nodal
locations for all time steps.

Examples

Strain for 3-D Structural Dynamic Problem

Evaluate the strain in a beam under a harmonic excitation.

Create a transient dynamic model for a 3-D problem.

structuralmodel = createpde('structural','transient-solid');

Create the geometry and include it in the model. Plot the geometry.

gm = multicuboid(0.06,0.005,0.01);
structuralmodel.Geometry = gm;
pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.5)
view(50,20)
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Specify the Young's modulus, Poisson's ratio, and mass density of the material.

structuralProperties(structuralmodel,'YoungsModulus',210E9, ...
                                     'PoissonsRatio',0.3, ...
                                     'MassDensity',7800);

Fix one end of the beam.

structuralBC(structuralmodel,'Face',5,'Constraint','fixed');

Apply a sinusoidal displacement along the y-direction on the end opposite the fixed end of
the beam.

structuralBC(structuralmodel,'Face',3,'YDisplacement',1E-4,'Frequency',50);
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Generate a mesh.

generateMesh(structuralmodel,'Hmax',0.01);

Specify the zero initial displacement and velocity.

structuralIC(structuralmodel,'Displacement',[0,0,0],'Velocity',[0,0,0]);

Solve the model.

tlist = 0:0.002:0.2;
structuralresults = solve(structuralmodel,tlist);

Evaluate the strain in the beam.

strain = evaluateStrain(structuralresults);

Plot the normal strain along x-direction for the last time-step.

figure
pdeplot3D(structuralmodel,'ColorMapData',strain.exx(:,end))
title('x-Direction Normal Strain in the Beam of the Last Time-Step')
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Input Arguments
structuralresults — Solution of dynamic structural analysis problem
TransientStructuralResults object

Solution of a dynamic structural analysis problem, specified as a
TransientStructuralResults object. Create structuralresults by using the
solve function.
Example: structuralresults = solve(structuralmodel,tlist)
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Output Arguments
nodalStrain — Strain at nodes
structure array

Strain at the nodes, returned as a structure array with the fields representing the
components of strain tensor at nodal locations.

See Also
StructuralModel | TransientStructuralResults | evaluatePrincipalStrain |
evaluatePrincipalStress | evaluateReaction | evaluateStress |
evaluateVonMisesStress | interpolateAcceleration |
interpolateDisplacement | interpolateStrain | interpolateStress |
interpolateVelocity | interpolateVonMisesStress

Introduced in R2018a
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evaluateStress
Package: pde

Evaluate stress for dynamic structural analysis problem

Syntax
nodalStress = evaluateStress(structuralresults)

Description
nodalStress = evaluateStress(structuralresults) evaluates stress at nodal
locations for all time steps.

Examples

Stress for 3-D Structural Dynamic Problem

Evaluate the stress in a beam under a harmonic excitation.

Create a transient dynamic model for a 3-D problem.

structuralmodel = createpde('structural','transient-solid');

Create the geometry and include it in the model. Plot the geometry.

gm = multicuboid(0.06,0.005,0.01);
structuralmodel.Geometry = gm;
pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.5)
view(50,20)
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Specify the Young's modulus, Poisson's ratio, and mass density of the material.

structuralProperties(structuralmodel,'YoungsModulus',210E9, ...
                                     'PoissonsRatio',0.3, ...
                                     'MassDensity',7800);

Fix one end of the beam.

structuralBC(structuralmodel,'Face',5,'Constraint','fixed');

Apply a sinusoidal displacement along the y-direction on the end opposite the fixed end of
the beam.

structuralBC(structuralmodel,'Face',3,'YDisplacement',1E-4,'Frequency',50);
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Generate a mesh.

generateMesh(structuralmodel,'Hmax',0.01);

Specify the zero initial displacement and velocity.

structuralIC(structuralmodel,'Displacement',[0,0,0],'Velocity',[0,0,0]);

Solve the model.

tlist = 0:0.002:0.2;
structuralresults = solve(structuralmodel,tlist);

Evaluate stress in the beam.

stress = evaluateStress(structuralresults);

Plot the normal stress along x-direction for the last time-step.

figure
pdeplot3D(structuralmodel,'ColorMapData',stress.sxx(:,end))
title('x-Direction Normal Stress in the Beam of the Last Time-Step')
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Input Arguments
structuralresults — Solution of dynamic structural analysis problem
TransientStructuralResults object

Solution of a dynamic structural analysis problem, specified as a
TransientStructuralResults object. Create structuralresults by using the
solve function.
Example: structuralresults = solve(structuralmodel,tlist)
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Output Arguments
nodalStress — Stress at nodes
structure array

Stress at the nodes, returned as a structure array with the fields representing the
components of a stress tensor at nodal locations.

See Also
StructuralModel | TransientStructuralResults | evaluatePrincipalStrain |
evaluatePrincipalStress | evaluateReaction | evaluateStrain |
evaluateVonMisesStress | interpolateAcceleration |
interpolateDisplacement | interpolateStrain | interpolateStress |
interpolateVelocity | interpolateVonMisesStress

Introduced in R2018a
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evaluateTemperatureGradient
Package: pde

Evaluate temperature gradient of a thermal solution at arbitrary spatial locations

Syntax
[gradTx,gradTy] = evaluateTemperatureGradient(thermalresults,xq,yq)
[gradTx,gradTy,gradTz] = evaluateTemperatureGradient(thermalresults,
xq,yq,zq)
[ ___ ] = evaluateTemperatureGradient(thermalresults,querypoints)
[ ___ ] = evaluateTemperatureGradient( ___ ,iT)

Description
[gradTx,gradTy] = evaluateTemperatureGradient(thermalresults,xq,yq)
returns the interpolated values of temperature gradients of the thermal model solution
thermalresults at the 2-D points specified in xq and yq. This syntax is valid for both
the steady-state and transient thermal models.

[gradTx,gradTy,gradTz] = evaluateTemperatureGradient(thermalresults,
xq,yq,zq) returns the interpolated temperature gradients at the 3-D points specified in
xq, yq, and zq. This syntax is valid for both the steady-state and transient thermal
models.

[ ___ ] = evaluateTemperatureGradient(thermalresults,querypoints)
returns the interpolated values of the temperature gradients at the points specified in
querypoints. This syntax is valid for both the steady-state and transient thermal
models.

[ ___ ] = evaluateTemperatureGradient( ___ ,iT) returns the interpolated values
of the temperature gradients for the time-dependent equation at times iT. Specify iT
after the input arguments in any of the previous syntaxes.

The first dimension of gradTx, gradTy, and, in 3-D case, gradTz corresponds to query
points. The second dimension corresponds to time-steps iT.
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Examples

Temperature Gradients for 2-D Steady-State Thermal Model

For a 2-D steady-state thermal model, evaluate temperature gradients at the nodal
locations and at the points specified by x and y coordinates.

Create a thermal model for steady-state analysis.

thermalmodel = createpde('thermal');

Create the geometry and include it in the model.

R1 = [3,4,-1,1,1,-1,1,1,-1,-1]';
g = decsg(R1,'R1',('R1')');
geometryFromEdges(thermalmodel,g);
pdegplot(thermalmodel,'EdgeLabels','on')
xlim([-1.5 1.5])
axis equal
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Assuming that this geometry represents an iron plate, the thermal conductivity is
79 . 5 W /(mK).

thermalProperties(thermalmodel,'ThermalConductivity',79.5,'Face',1);

Apply a constant temperature of 300 K to the bottom of the plate (edge 3). Also, assume
that the top of the plate (edge 1) is insulated, and apply convection on the two sides of the
plate (edges 2 and 4).

thermalBC(thermalmodel,'Edge',3,'Temperature',300);
thermalBC(thermalmodel,'Edge',1,'HeatFlux',0);
thermalBC(thermalmodel,'Edge',[2 4], ...
                       'ConvectionCoefficient',25, ...
                       'AmbientTemperature',50);

5 Functions — Alphabetical List

5-260



Mesh the geometry and solve the problem.

generateMesh(thermalmodel);
results = solve(thermalmodel)

results = 
  SteadyStateThermalResults with properties:

    Temperature: [1541x1 double]
     XGradients: [1541x1 double]
     YGradients: [1541x1 double]
     ZGradients: []
           Mesh: [1x1 FEMesh]

The solver finds the temperatures and temperature gradients at the nodal locations. To
access these values, use results.Temperature, results.XGradients, and so on. For
example, plot the temperature gradients at nodal locations.

figure;
pdeplot(thermalmodel,'FlowData',[results.XGradients results.YGradients]);

 evaluateTemperatureGradient

5-261



Create a grid specified by x and y coordinates, and evaluate temperature gradients to the
grid.

v = linspace(-0.5,0.5,11);
[X,Y] = meshgrid(v);

[gradTx,gradTy] = evaluateTemperatureGradient(results,X,Y);

Reshape the gradTx and gradTy vectors, and plot the resulting temperature gradients.

gradTx = reshape(gradTx,size(X));
gradTy = reshape(gradTy,size(Y));
figure
quiver(X,Y,gradTx,gradTy)
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Alternatively, you can specify the grid by using a matrix of query points.

querypoints = [X(:) Y(:)]';
[gradTx,gradTy] = evaluateTemperatureGradient(results,querypoints);

gradTx = reshape(gradTx,size(X));
gradTy = reshape(gradTy,size(Y));
figure
quiver(X,Y,gradTx,gradTy)
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Temperature Gradients for 3-D Steady-State Thermal Model

For a 3-D steady-state thermal model, evaluate temperature gradients at the nodal
locations and at the points specified by x, y, and z coordinates.

Create a thermal model for steady-state analysis.

thermalmodel = createpde('thermal');

Create the following 3-D geometry and include it in the model.
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importGeometry(thermalmodel,'Block.stl'); 
pdegplot(thermalmodel,'FaceLabels','on','FaceAlpha',0.5)
title('Copper block, cm')
axis equal

Assuming that this is a copper block, the thermal conductivity of the block is
approximately 4 W /(cmK).

thermalProperties(thermalmodel,'ThermalConductivity',4);

Apply a constant temperature of 373 K to the left side of the block (edge 1) and a constant
temperature of 573 K to the right side of the block.

thermalBC(thermalmodel,'Face',1,'Temperature',373);
thermalBC(thermalmodel,'Face',3,'Temperature',573);
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Apply a heat flux boundary condition to the bottom of the block.

thermalBC(thermalmodel,'Face',4,'HeatFlux',-20);

Mesh the geometry and solve the problem.

generateMesh(thermalmodel);
thermalresults = solve(thermalmodel)

thermalresults = 
  SteadyStateThermalResults with properties:

    Temperature: [12691x1 double]
     XGradients: [12691x1 double]
     YGradients: [12691x1 double]
     ZGradients: [12691x1 double]
           Mesh: [1x1 FEMesh]

The solver finds the values of temperatures and temperature gradients at the nodal
locations. To access these values, use results.Temperature, results.XGradients,
and so on.

Create a grid specified by x, y, and z coordinates, and evaluate temperature gradients to
the grid.

[X,Y,Z] = meshgrid(1:26:100,1:6:20,1:11:50);

[gradTx,gradTy,gradTz] = evaluateTemperatureGradient(thermalresults,X,Y,Z);

Reshape the gradTx, gradTy, and gradTz vectors, and plot the resulting temperature
gradients.

gradTx = reshape(gradTx,size(X));
gradTy = reshape(gradTy,size(Y));
gradTz = reshape(gradTz,size(Z));

figure
quiver3(X,Y,Z,gradTx,gradTy,gradTz)
axis equal
xlabel('x')
ylabel('y')
zlabel('z')
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Alternatively, you can specify the grid by using a matrix of query points.

querypoints = [X(:) Y(:) Z(:)]';
[gradTx,gradTy,gradTz] = evaluateTemperatureGradient(thermalresults,querypoints);

gradTx = reshape(gradTx,size(X));
gradTy = reshape(gradTy,size(Y));
gradTz = reshape(gradTz,size(Z));

figure
quiver3(X,Y,Z,gradTx,gradTy,gradTz)
axis equal
xlabel('x')
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ylabel('y')
zlabel('z')

Temperature Gradients for Transient Thermal Model on Square

Solve a 2-D transient heat transfer problem on a square domain and compute
temperature gradients at the convective boundary.

Create a transient thermal model for this problem.

thermalmodel = createpde('thermal','transient');
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Create the geometry and include it in the model.

g = @squareg;
geometryFromEdges(thermalmodel,g);
pdegplot(thermalmodel,'EdgeLabels','on')
xlim([-1.2 1.2])
ylim([-1.2 1.2])
axis equal

Assign the following thermal properties: thermal conductivity is 100 W /(m∘C), mass
density is 7800 kg/m3, and specific heat is 500 J /(kg∘C).
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thermalProperties(thermalmodel,'ThermalConductivity',100, ...
                               'MassDensity',7800, ...
                               'SpecificHeat',500);

Apply insulated boundary conditions on three edges and the free convection boundary
condition on the right edge.

thermalBC(thermalmodel,'Edge',[1 3 4],'HeatFlux',0);
thermalBC(thermalmodel,'Edge',2, ...
                       'ConvectionCoefficient',5000, ...
                       'AmbientTemperature',25);

Set the initial conditions: uniform room temperature across domain and higher
temperature on the left edge.

thermalIC(thermalmodel,25);
thermalIC(thermalmodel,100,'Edge',4);

Generate a mesh and solve the problem using 0:1000:200000 as a vector of times.

generateMesh(thermalmodel);
tlist = 0:1000:200000;
thermalresults = solve(thermalmodel,tlist)

thermalresults = 
  TransientThermalResults with properties:

      Temperature: [1541x201 double]
    SolutionTimes: [1x201 double]
       XGradients: [1541x201 double]
       YGradients: [1541x201 double]
       ZGradients: []
             Mesh: [1x1 FEMesh]

Define a line at convection boundary and compute temperature gradients across that line.

X = -1:0.1:1;
Y = ones(size(X));

[gradTx,gradTy] = evaluateTemperatureGradient(thermalresults,X,Y,1:length(tlist));

Plot the interpolated gradient component gradTx along the x axis for the following
values from the time interval tlist.
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figure
t = [51:50:201];
for i = t
  p(i) = plot(X,gradTx(:,i),'DisplayName', strcat('t=', num2str(tlist(i))));
  hold on
end
legend(p(t))
xlabel('x')
ylabel('gradTx')
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Input Arguments
thermalresults — Solution of thermal problem
SteadyStateThermalResults object | TransientThermalResults object

Solution of a thermal problem, specified as a SteadyStateThermalResults object or a
TransientThermalResults object. Create thermalresults using the solve
function.
Example: thermalresults = solve(thermalmodel)

xq — x-coordinate query points
real array

x-coordinate query points, specified as a real array. evaluateTemperatureGradient
evaluates temperature gradient at the 2-D coordinate points [xq(i) yq(i)] or at the 3-
D coordinate points [xq(i) yq(i) zq(i)]. So xq, yq, and (if present) zq must have
the same number of entries.

evaluateTemperatureGradient converts query points to column vectors xq(:),
yq(:), and (if present) zq(:). It returns the temperature gradient in a form of a column
vector of the same size. To ensure that the dimensions of the returned solution is
consistent with the dimensions of the original query points, use reshape. For example,
use gradTx = reshape(gradTx,size(xq)).
Data Types: double

yq — y-coordinate query points
real array

y-coordinate query points, specified as a real array. evaluateTemperatureGradient
evaluates the temperature gradient at the 2-D coordinate points [xq(i) yq(i)] or at
the 3-D coordinate points [xq(i) yq(i) zq(i)]. So xq, yq, and (if present) zq must
have the same number of entries.

evaluateTemperatureGradient converts query points to column vectors xq(:),
yq(:), and (if present) zq(:). It returns the temperature gradient in a form of a column
vector of the same size. To ensure that the dimensions of the returned solution is
consistent with the dimensions of the original query points, use reshape. For example,
use gradTy = reshape(gradTy,size(yq)).
Data Types: double
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zq — z-coordinate query points
real array

z-coordinate query points, specified as a real array. evaluateTemperatureGradient
evaluates the temperature gradient at the 3-D coordinate points [xq(i) yq(i) zq(i)].
So xq, yq, and zq must have the same number of entries.

evaluateTemperatureGradient converts query points to column vectors xq(:),
yq(:), and (if present) zq(:). It returns the temperature gradient in a form of a column
vector of the same size. To ensure that the dimensions of the returned solution is
consistent with the dimensions of the original query points, use reshape. For example,
use gradTz = reshape(gradTz,size(zq)).
Data Types: double

querypoints — Query points
real matrix

Query points, specified as a real matrix with either two rows for 2-D geometry, or three
rows for 3-D geometry. evaluateTemperatureGradient evaluates the temperature
gradient at the coordinate points querypoints(:,i), so each column of querypoints
contains exactly one 2-D or 3-D query point.
Example: For 2-D geometry, querypoints = [0.5 0.5 0.75 0.75; 1 2 0 0.5]
Data Types: double

iT — Time indices
vector of positive integers

Time indices, specified as a vector of positive integers. Each entry in iT specifies a time
index.
Example: iT = 1:5:21 specifies every fifth time-step up to 21.
Data Types: double

Output Arguments
gradTx — x-component of the temperature gradient
matrix

 evaluateTemperatureGradient

5-273



x-component of the temperature gradient, returned as a matrix. For query points that are
outside the geometry, gradTx = NaN.

gradTy — y-component of the temperature gradient
matrix

y-component of the temperature gradient, returned as a matrix. For query points that are
outside the geometry, gradTy = NaN.

gradTz — z-component of the temperature gradient
matrix

z-component of the temperature gradient, returned as a matrix. For query points that are
outside the geometry, gradTz = NaN.

See Also
SteadyStateThermalResults | ThermalModel | TransientThermalResults |
evaluateHeatFlux | evaluateHeatRate | interpolateTemperature

Introduced in R2017a
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evaluateVonMisesStress
Package: pde

Evaluate von Mises stress for dynamic structural analysis problem

Syntax
vmStress = evaluateVonMisesStress(structuralresults)

Description
vmStress = evaluateVonMisesStress(structuralresults) evaluates von Mises
stress at nodal locations for all time steps.

Examples

von Mises Stress for 3-D Structural Dynamic Problem

Evaluate the von Mises stress in a beam under a harmonic excitation.

Create a transient dynamic model for a 3-D problem.

structuralmodel = createpde('structural','transient-solid');

Create the geometry and include it in the model. Plot the geometry.

gm = multicuboid(0.06,0.005,0.01);
structuralmodel.Geometry = gm;
pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.5)
view(50,20)
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Specify the Young's modulus, Poisson's ratio, and mass density of the material.

structuralProperties(structuralmodel,'YoungsModulus',210E9, ...
                                     'PoissonsRatio',0.3, ...
                                     'MassDensity',7800);

Fix one end of the beam.

structuralBC(structuralmodel,'Face',5,'Constraint','fixed');

Apply a sinusoidal displacement along the y-direction on the end opposite the fixed end of
the beam.

structuralBC(structuralmodel,'Face',3,'YDisplacement',1E-4,'Frequency',50);
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Generate a mesh.

generateMesh(structuralmodel,'Hmax',0.01);

Specify the zero initial displacement and velocity.

structuralIC(structuralmodel,'Displacement',[0;0;0],'Velocity',[0;0;0]);

Solve the model.

tlist = 0:0.002:0.2;
structuralresults = solve(structuralmodel,tlist);

Evaluate the von Mises stress in the beam.

vmStress = evaluateVonMisesStress(structuralresults);

Plot the von Mises stress for the last time-step.

figure
pdeplot3D(structuralmodel,'ColorMapData',vmStress(:,end))
title('von Mises Stress in the Beam for the Last Time-Step')
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Input Arguments
structuralresults — Solution of dynamic structural analysis problem
TransientStructuralResults object

Solution of a dynamic structural analysis problem, specified as a
TransientStructuralResults object. Create structuralresults by using the
solve function.
Example: structuralresults = solve(structuralmodel,tlist)
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Output Arguments
vmStress — Von Mises Stress at nodes
matrix

Von Mises Stress at the nodes, returned as a matrix. The rows of the matrix contain the
values of von Mises stress at nodal locations, while the columns correspond to the time
steps.

See Also
StructuralModel | TransientStructuralResults | evaluatePrincipalStrain |
evaluatePrincipalStress | evaluateReaction | evaluateStrain |
evaluateStress | interpolateAcceleration | interpolateDisplacement |
interpolateStrain | interpolateStress | interpolateVelocity |
interpolateVonMisesStress

Introduced in R2018a
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FEMesh Properties
Mesh object

Description
An FEMesh object contains a description of the finite element mesh. A PDEModel
container has an FEMesh object in its Mesh property.

Generate a mesh for your model using the generateMesh function.

Properties
Properties

Nodes — Mesh nodes
matrix

Mesh nodes, returned as a matrix. Nodes is a D-by-Nn matrix, where D is the number of
geometry dimensions (2 or 3), and Nn is the number of nodes in the mesh. Each column of
Nodes contains the x, y, and in 3-D, z coordinates for that mesh node.

2-D meshes have nodes at the mesh triangle corners for linear elements, and at the
corners and edge midpoints for 'quadratic' elements. 3-D meshes have nodes at
tetrahedral vertices, and the 'quadratic' elements have additional nodes at the center
points of each edge. See “Mesh Data” on page 2-233.
Data Types: double

Elements — Mesh elements
matrix

Mesh elements, returned as an M-by-Ne matrix, where Ne is the number of elements in the
mesh, and M is:

• 3 for 2-D triangles with 'linear' GeometricOrder
• 6 for 2-D triangles with 'quadratic' GeometricOrder
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• 4 for 3-D tetrahedra with 'linear' GeometricOrder
• 10 for 3-D tetrahedra with 'quadratic' GeometricOrder

Each column in Elements contains the indices of the nodes for that mesh element.
Data Types: double

MaxElementSize — Target maximum mesh element size
positive real number

Target maximum mesh element size, returned as a positive real number. The maximum
mesh element size is the length of the longest edge in the mesh. The generateMesh
Hmax name-value pair sets the target maximum size at the time it creates the mesh.
generateMesh can occasionally create a mesh with some elements that exceed
MaxElementSize by a few percent.
Data Types: double

MinElementSize — Target minimum mesh element size
positive real number

Target minimum mesh element size, returned as a positive real number. The minimum
mesh element size is the length of the shortest edge in the mesh. The Hmin name-value
pair passed to the generateMesh function sets the target minimum size the at the time it
creates the mesh. generateMesh can occasionally create a mesh with some elements
that are smaller than MinElementSize.
Data Types: double

MeshGradation — Mesh growth rate
1.5 (default) | scalar strictly between 1 and 2

Mesh growth rate, returned as a scalar strictly between 1 and 2.
Data Types: double

GeometricOrder — Element polynomial order
'linear' | 'quadratic'

Element polynomial order, returned as 'linear' or 'quadratic'. See Elements or
“Mesh Data” on page 2-233.
Data Types: double
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See Also
PDEModel | area | findElements | findNodes | generateMesh | meshQuality |
meshToPet | volume

Topics
“Solve Problems Using PDEModel Objects” on page 2-6
“Finite Element Method Basics” on page 1-18
“Mesh Data” on page 2-233

Introduced in R2015a
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findBodyLoad
Package: pde

Find body load assigned to geometric region

Syntax
bl = findBodyLoad(structuralmodel.BodyLoads,RegionType,RegionID)

Description
bl = findBodyLoad(structuralmodel.BodyLoads,RegionType,RegionID)
returns the body load assigned to a geometric region of the structural model. A body load
must use units consistent with the geometry and other model attributes.

Examples

Find Body Load

Create a structural model.

structuralModel = createpde('structural','static-solid');

Create and plot the geometry.

gm = multicuboid(0.5,0.1,0.1);
structuralModel.Geometry = gm;
pdegplot(structuralModel,'FaceAlpha',0.5)
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Specify the Young's modulus, Poisson's ratio, and mass density. Notice that the mass
density value is required for modeling gravitational effects.

structuralProperties(structuralModel,'YoungsModulus',210E3, ...
                                     'PoissonsRatio',0.3,...
                                     'MassDensity',2.7E-6);

Specify the gravity load on the beam.

structuralBodyLoad(structuralModel,'GravitationalAcceleration',[0;0;-9.8]);

Check the body load specification for cell 1.

findBodyLoad(structuralModel.BodyLoads,'Cell',1)
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ans = 
  BodyLoadAssignment with properties:

                   RegionType: 'Cell'
                     RegionID: 1
    GravitationalAcceleration: [3x1 double]
                  Temperature: []
                     TimeStep: []

Input Arguments
structuralmodel.BodyLoads — Body loads
BodyLoads property of StructuralModel object

Body loads of the model, specified as a BodyLoads property of a StructuralModel
object.

RegionType — Geometric region type
'Face' for a 2-D model | 'Cell' for a 3-D model

Geometric region type, specified as 'Face' for a 2-D model or 'Cell' for a 3-D model.
Example: findBodyLoad(structuralmodel.BodyLoads,'Cell',1)
Data Types: char | string

RegionID — Geometric region ID
vector of positive integers

Geometric region ID, specified as a vector of positive integers. Find the region IDs using
pdegplot, as shown in “Create Geometry and Remove Face Boundaries” on page 2-13 or
“STL File Import” on page 2-46.
Example: findBodyLoad(structuralmodel.BodyLoads,'Cell',1)
Data Types: double
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Output Arguments
bl — Body load assignment
BodyLoadAssignment object

Body load assignment, returned as a BodyLoadAssignment object. For details, see
BodyLoadAssignment Properties.

See Also
structuralBodyLoad

Introduced in R2017b
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findBoundaryConditions
Package: pde

Find boundary condition assignment for a geometric region

Syntax
BCregion = findBoundaryConditions(BCs,RegionType,RegionID)

Description
BCregion = findBoundaryConditions(BCs,RegionType,RegionID) returns
boundary condition BCregion assigned to the specified region.

Examples

Find Boundary Conditions for Particular Regions

Create a PDE model and import a simple block geometry. Plot the geometry displaying the
face labels.

model = createpde(3);
importGeometry(model,'Block.stl');
pdegplot(model,'FaceLabels','on','FaceAlpha',0.5)
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Set zero Dirichlet conditions on faces 1 and 2 for all equations.

applyBoundaryCondition(model,'dirichlet','Face',1:2,'u',[0,0,0]);

On face 3, set the Neumann boundary condition for equation 1 and Dirichlet boundary
condition for equations 2 and 3.

h = [0 0 0;0 1 0;0 0 1];
r = [0;3;3];
q = [1 0 0;0 0 0;0 0 0];
g = [10;0;0];
applyBoundaryCondition(model,'mixed','Face',3,'h',h,'r',r,'g',g,'q',q);

Set Neumann boundary conditions with opposite signs on faces 5 and 6 for all equations.
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applyBoundaryCondition(model,'neumann','Face',4:5,'g',[1;1;1]);
applyBoundaryCondition(model,'neumann','Face',6,'g',[-1;-1;-1]);

Check the boundary condition specification on face 1.

findBoundaryConditions(model.BoundaryConditions,'Face',1)

ans = 
  BoundaryCondition with properties:

           BCType: 'dirichlet'
       RegionType: 'Face'
         RegionID: [1 2]
                r: []
                h: []
                g: []
                q: []
                u: [0 0 0]
    EquationIndex: []
       Vectorized: 'off'

Check the boundary condition specification on face 3.

findBoundaryConditions(model.BoundaryConditions,'Face',3)

ans = 
  BoundaryCondition with properties:

           BCType: 'mixed'
       RegionType: 'Face'
         RegionID: 3
                r: [3x1 double]
                h: [3x3 double]
                g: [3x1 double]
                q: [3x3 double]
                u: []
    EquationIndex: []
       Vectorized: 'off'

Check the boundary condition specification on face 5.

findBoundaryConditions(model.BoundaryConditions,'Face',5)

ans = 
  BoundaryCondition with properties:
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           BCType: 'neumann'
       RegionType: 'Face'
         RegionID: [4 5]
                r: []
                h: []
                g: [3x1 double]
                q: []
                u: []
    EquationIndex: []
       Vectorized: 'off'

Input Arguments
BCs — Boundary conditions of a PDE model
BoundaryConditions property of a PDE model

Boundary conditions of a PDE model, specified as the BoundaryConditions property of
PDEModel.
Example: model.BoundaryConditions

RegionType — Geometric region type
'Face' for 3-D geometry | 'Edge' for 2-D geometry

Geometric region type, specified as 'Face' for 3-D geometry or 'Edge' for 2-D
geometry.
Example: findBoundaryConditions(model.BoundaryConditions,'Face',3)
Data Types: char | string

RegionID — Geometric region ID
vector of positive integers

Geometric region ID, specified as a vector of positive integers. Find the region IDs using
pdegplot with the 'FaceLabels' (3-D) or 'EdgeLabels' (2-D) value set to 'on'.
Example: findBoundaryConditions(model.BoundaryConditions,'Face',3)
Data Types: double
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Output Arguments
BCregion — Boundary condition for a particular region
BoundaryCondition object

Boundary condition for a particular region, returned as a BoundaryCondition object.

See Also
BoundaryCondition | applyBoundaryCondition

Topics
“Solve Problems Using PDEModel Objects” on page 2-6

Introduced in R2016b
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findCoefficients
Package: pde

Locate active PDE coefficients

Syntax
CA = findCoefficients(coeffs,RegionType,RegionID)

Description
CA = findCoefficients(coeffs,RegionType,RegionID) returns the active
coefficient assignment CA for the coefficients in the specified region.

Examples

Find the Active Coefficients for a Region

Create a PDE model that has a few subdomains.

model = createpde();
geometryFromEdges(model,@lshapeg);
pdegplot(model,'FaceLabels','on')
ylim([-1.1,1.1])
axis equal
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Set coefficients on each pair of regions.

specifyCoefficients(model,'m',0,'d',0,'c',12,'a',0,'f',1,'Face',[1,2]);
specifyCoefficients(model,'m',0,'d',0,'c',13,'a',0,'f',2,'Face',[1,3]);
specifyCoefficients(model,'m',0,'d',0,'c',23,'a',0,'f',3,'Face',[2,3]);

Check the coefficient specification for region 1.

coeffs = model.EquationCoefficients;
ca = findCoefficients(coeffs,'Face',1)

ca = 
  CoefficientAssignment with properties:

    RegionType: 'face'
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      RegionID: [1 3]
             m: 0
             d: 0
             c: 13
             a: 0
             f: 2

Input Arguments
coeffs — Model coefficients
EquationCoefficients property of a PDE model

Model coefficients, specified as the EquationCoefficients property of a PDE model.
Coefficients can be complex numbers.
Example: model.EquationCoefficients

RegionType — Geometric region type
'Face' for a 2-D model | 'Cell' for a 3-D model

Geometric region type, specified as 'Face' for a 2-D model, or 'Cell' for a 3-D model.
Example: ca = findCoefficients(coeffs,'Face',[1,3])
Data Types: char | string

RegionID — Region ID
vector of positive integers

Region ID, specified as a vector of positive integers. View the subdomain labels for a 2-D
model using pdegplot(model,'FaceLabels','on'). Currently, there are no
subdomains for 3-D models, so the only acceptable value for a 3-D model is 1.
Example: ca = findCoefficients(coeffs,'Face',[1,3])
Data Types: double
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Output Arguments
CA — Coefficient assignment
CoefficientAssignment object

Coefficient assignment, returned as a CoefficientAssignment object.

See Also
CoefficientAssignment | specifyCoefficients

Topics
“View, Edit, and Delete PDE Coefficients” on page 2-150
“Solve Problems Using PDEModel Objects” on page 2-6
“PDE Coefficients”

Introduced in R2016a
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findElements
Package: pde

Find mesh elements in specified region

Syntax
elemIDs = findElements(mesh,'region',RegionType,RegionID)
elemIDs = findElements(mesh,'box',xlim,ylim)
elemIDs = findElements(mesh,'box',xlim,ylim,zlim)
elemIDs = findElements(mesh,'radius',center,radius)
elemIDs = findElements(mesh,'attached',nodeID)

Description
elemIDs = findElements(mesh,'region',RegionType,RegionID) returns the
IDs of the mesh elements that belong to the specified geometric region.

elemIDs = findElements(mesh,'box',xlim,ylim) returns the IDs of the mesh
elements within a bounding box specified by xlim and ylim. Use this syntax for 2-D
meshes.

elemIDs = findElements(mesh,'box',xlim,ylim,zlim) returns the IDs of the
mesh elements located within a bounding box specified by xlim, ylim, and zlim. Use
this syntax for 3-D meshes.

elemIDs = findElements(mesh,'radius',center,radius) returns the IDs of
mesh elements located within a circle (for 2-D meshes) or sphere (for 3-D meshes)
specified by center and radius.

elemIDs = findElements(mesh,'attached',nodeID) returns the IDs of the mesh
elements attached to the specified node. Here, nodeID is the ID of a corner node. This
syntax ignores the IDs of the nodes located in the middle of element edges.

For multiple nodes, specify nodeID as a vector.
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Examples

Elements Associated with Particular Face

Find the elements associated with a geometric region.

Create a PDE model.

model = createpde;

Include the geometry of the built-in function lshapeg. Plot the geometry.

geometryFromEdges(model,@lshapeg);
pdegplot(model,'FaceLabels','on','EdgeLabels','on')
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Generate a mesh.

mesh = generateMesh(model,'Hmax',0.5);

Find the elements associated with face 2.

Ef2 = findElements(mesh,'region','Face',2);

Highlight these elements in green on the mesh plot.

figure
pdemesh(mesh,'ElementLabels','on')
hold on
pdemesh(mesh.Nodes,mesh.Elements(:,Ef2),'EdgeColor','green')
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Elements Within Bounding Box

Find the elements located within a specified box.

Create a PDE model.

model = createpde;

Import and plot the geometry.

importGeometry(model,'PlateHolePlanar.stl');
pdegplot(model)
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Generate a mesh.

mesh = generateMesh(model,'Hmax',2,'Hmin',0.4)

mesh = 
  FEMesh with properties:

             Nodes: [2x386 double]
          Elements: [6x172 double]
    MaxElementSize: 2
    MinElementSize: 0.4000
     MeshGradation: 1.5000
    GeometricOrder: 'quadratic'
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Find the elements located within the following box.

Eb = findElements(mesh,'box',[5 10],[10 20]);

Highlight these elements in green on the mesh plot.

figure
pdemesh(model)
hold on
pdemesh(mesh.Nodes,mesh.Elements(:,Eb),'EdgeColor','green')
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Elements Within Bounding Disk

Find the elements located within a specified disk.

Create a PDE model.

model = createpde;

Import and plot the geometry.

importGeometry(model,'PlateHolePlanar.stl');
pdegplot(model)

Generate a mesh.
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mesh = generateMesh(model,'Hmax',2,'Hmin',0.4,'GeometricOrder','linear')

mesh = 
  FEMesh with properties:

             Nodes: [2x107 double]
          Elements: [3x172 double]
    MaxElementSize: 2
    MinElementSize: 0.4000
     MeshGradation: 1.5000
    GeometricOrder: 'linear'

Find the elements located within radius 2 from the center [5,10].

Er = findElements(mesh,'radius',[5 10],2);

Highlight these elements in green on the mesh plot.

figure
pdemesh(model)
hold on
pdemesh(mesh.Nodes,mesh.Elements(:,Er),'EdgeColor','green')
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Elements Attached to Specified Nodes

Find the elements attached to a specified corner node.

Create a PDE model.

model = createpde;

Import and plot the geometry.

importGeometry(model,'PlateHolePlanar.stl');
pdegplot(model)
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Generate a linear triangular mesh by setting the geometric order value to linear. This
mesh contains only corner nodes.

mesh = generateMesh(model,'Hmax',2,'Hmin',0.4, ...
                          'GeometricOrder','linear');

Find the node closest to the point [15;10].

N_ID = findNodes(mesh,'nearest',[15;10])

N_ID = 10

Find the elements attached to this node.

En = findElements(mesh,'attached',N_ID)
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En = 1×3

    95    97    98

Highlight the node and the elements in green on the mesh plot.

figure
pdemesh(model)
hold on
plot(mesh.Nodes(1,N_ID),mesh.Nodes(2,N_ID),'or','Color','g', ...
                                           'MarkerFaceColor','g')
pdemesh(mesh.Nodes,mesh.Elements(:,En),'EdgeColor','green')
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Input Arguments
mesh — Mesh object
Mesh property of a PDEModel object | output of generateMesh

Mesh object, specified as the Mesh property of a PDEModel object or as the output of
generateMesh.
Example: model.Mesh

RegionType — Geometric region type
'Cell' for a 3-D model | 'Face' for a 2-D model

Geometric region type, specified as 'Cell' or 'Face'.
Example: findElements(mesh,'region','Face',1:3)
Data Types: char

RegionID — Geometric region ID
vector of positive integers

Geometric region ID, specified as a vector of positive integers. Find the region IDs using
pdegplot, as shown in “Create Geometry and Remove Face Boundaries” on page 2-13 or
“STL File Import” on page 2-46.
Example: findElements(mesh,'region','Face',1:3)
Data Types: double

xlim — x-limits of bounding box
two-element row vector

x-limits of the bounding box, specified as a two-element row vector. The first element of
xlim is the lower x-bound, and the second element is the upper x-bound.
Example: findElements(mesh,'box',[5 10],[10 20])
Data Types: double

ylim — y-limits of bounding box
two-element row vector

y-limits of the bounding box, specified as a two-element row vector. The first element of
ylim is the lower y-bound, and the second element is the upper y-bound.
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Example: findElements(mesh,'box',[5 10],[10 20])
Data Types: double

zlim — z-limits of bounding box
two-element row vector

z-limits of the bounding box, specified as a two-element row vector. The first element of
zlim is the lower z-bound, and the second element is the upper z-bound. You can specify
zlim only for 3-D meshes.
Example: findElements(mesh,'box',[5 10],[10 20],[1 2])
Data Types: double

center — Center of bounding circle or sphere
two-element row vector for a 2-D mesh | three-element row vector for a 3-D mesh

Center of the bounding circle or sphere, specified as a two-element row vector for a 2-D
mesh or three-element row vector for a 3-D mesh. The elements of these vectors contain
the coordinates of the center of a circle or a sphere.
Example: findElements(mesh,'radius',[0 0 0],0.5)
Data Types: double

radius — Radius of bounding circle or sphere
positive number

Radius of the bounding circle or sphere, specified as a positive number.
Example: findElements(mesh,'radius',[0 0 0],1)
Data Types: double

nodeID — ID of corner node of element
positive integer | vector of positive integers

ID of the corner node of the element, specified as a positive integer or a vector of positive
integers. The findElements function can find an ID of the element by the ID of the
corner node of the element. The function ignores IDs of the nodes located in the middle of
element edges. For multiple nodes, specify nodeID as a vector.
Example: findElements(mesh,'attached',[7 8 21])
Data Types: double
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Output Arguments
elemIDs — Element IDs
positive integer | row vector of positive integers

Element IDs, returned as a positive integer or a row vector of positive integers.

See Also
FEMesh Properties | area | findNodes | meshQuality | volume

Topics
“Finite Element Method Basics” on page 1-18

Introduced in R2018a

 findElements

5-309



findHeatSource
Package: pde

Find heat source assigned to a geometric region

Syntax
hsa = findHeatSource(thermalmodel.HeatSources,RegionType,RegionID)

Description
hsa = findHeatSource(thermalmodel.HeatSources,RegionType,RegionID)
returns the heat source value hsa assigned to the specified region.

Examples

Find Heat Sources for Faces of 2-D Geometry

Create a thermal model that has three faces.

thermalmodel = createpde('thermal');
geometryFromEdges(thermalmodel,@lshapeg);
pdegplot(thermalmodel,'FaceLabels','on')
ylim([-1.1 1.1])
axis equal
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Specify that face 1 generates heat at 10 W/m^3, face 2 generates heat at 20 W/m^3, and
face 3 generates heat at 30 W/m^3.

internalHeatSource(thermalmodel,10,'Face',1);
internalHeatSource(thermalmodel,20,'Face',2);
internalHeatSource(thermalmodel,30,'Face',3);

Check the heat source specification for face 1.

hsaFace1 = findHeatSource(thermalmodel.HeatSources,'Face',1)

hsaFace1 = 
  HeatSourceAssignment with properties:
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    RegionType: 'face'
      RegionID: 1
    HeatSource: 10

Check the heat source specification for faces 2 and 3.

hsa = findHeatSource(thermalmodel.HeatSources,'Face',[2 3]);
hsaFace2 = hsa(1)

hsaFace2 = 
  HeatSourceAssignment with properties:

    RegionType: 'face'
      RegionID: 2
    HeatSource: 20

hsaFace3 = hsa(2)

hsaFace3 = 
  HeatSourceAssignment with properties:

    RegionType: 'face'
      RegionID: 3
    HeatSource: 30

Find Heat Sources for Cells of 3-D Geometry

Create a geometry that consists of three stacked cylinders and include the geometry in a
thermal model.

gm = multicylinder(10,[1 2 3],'ZOffset',[0 1 3])

gm = 
  DiscreteGeometry with properties:

       NumCells: 3
       NumFaces: 7
       NumEdges: 4
    NumVertices: 4
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thermalmodel = createpde('thermal');
thermalmodel.Geometry = gm;
pdegplot(thermalmodel,'CellLabels','on','FaceAlpha',0.5)

Specify that the cylinder C1 generates heat at 10 W /m3, the cylinder C2 generates heat at
20 W /m3, and the cylinder C3 generates heat at 30 W /m3.

internalHeatSource(thermalmodel,10,'Cell',1);
internalHeatSource(thermalmodel,20,'Cell',2);
internalHeatSource(thermalmodel,30,'Cell',3);

Check the heat source specification for cell 1.

hsaCell1 = findHeatSource(thermalmodel.HeatSources,'Cell',1)
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hsaCell1 = 
  HeatSourceAssignment with properties:

    RegionType: 'cell'
      RegionID: 1
    HeatSource: 10

Check the heat source specification for cells 2 and 3.

hsa = findHeatSource(thermalmodel.HeatSources,'Cell',[2:3]);
hsaCell2 = hsa(1)

hsaCell2 = 
  HeatSourceAssignment with properties:

    RegionType: 'cell'
      RegionID: 2
    HeatSource: 20

hsaCell3 = hsa(2)

hsaCell3 = 
  HeatSourceAssignment with properties:

    RegionType: 'cell'
      RegionID: 3
    HeatSource: 30

Input Arguments
thermalmodel.HeatSources — Internal heat source of the model
HeatSources property of a thermal model

Internal heat source of the model, specified as the HeatSources property of a
ThermalModel object.

RegionType — Geometric region type
'Face' | 'Cell'

Geometric region type, specified as 'Face' for a 2-D model or 'Cell' for a 3-D model.
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Data Types: char | string

RegionID — Geometric region ID
vector of positive integers

Geometric region ID, specified as a vector of positive integers. Find the region IDs using
the pdegplot function, as shown in “Create Geometry and Remove Face Boundaries” on
page 2-13 or “STL File Import” on page 2-46.
Data Types: double

Output Arguments
hsa — Heat source assignment
HeatSourceAssignment object

Heat source assignment, returned as a HeatSourceAssignment object.

See Also
HeatSourceAssignment | internalHeatSource

Introduced in R2017a
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findInitialConditions
Package: pde

Locate active initial conditions

Syntax
ic = findInitialConditions(ics,RegionType,RegionID)

Description
ic = findInitialConditions(ics,RegionType,RegionID) returns the active
initial condition assignment ic for the initial conditions in the specified region.

Examples

Find the Active Initial Conditions

This example shows find the active initial conditions for a region.

Create a PDE model that has a few subdomains.

model = createpde();
geometryFromEdges(model,@lshapeg);
pdegplot(model,'FaceLabels','on')
ylim([-1.1,1.1])
axis equal
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Set initial conditions on each pair of regions.

setInitialConditions(model,12,'Face',[1,2]);
setInitialConditions(model,13,'Face',[1,3]);
setInitialConditions(model,23,'Face',[2,3]);

Check the initial conditions specification for region 1.

ics = model.InitialConditions;
ic = findInitialConditions(ics,'Face',1)

ic = 
  GeometricInitialConditions with properties:

           RegionType: 'face'
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             RegionID: [1 3]
         InitialValue: 13
    InitialDerivative: []

Input Arguments
ics — Model initial conditions
InitialConditions property of a PDE model

Model initial conditions, specified as the InitialConditions property of a PDE model.
Initial conditions can be complex numbers.
Example: model.InitialConditions

RegionType — Geometric region type
'Edge' for a 2-D model | 'Face' for a 2-D model or 3-D model | 'Cell' for a 3-D model

Geometric region type, specified as 'Edge' for a 2-D model, 'Face' for a 2-D model or
3-D model, or 'Cell' for a 3-D model.
Example: ca = findInitialConditions(ics,'Face',[1,3])
Data Types: char | string

RegionID — Region ID
vector of positive integers

Region ID, specified as a vector of positive integers. View the subdomain labels for a 2-D
model using pdegplot(model,'FaceLabels','on'). Currently, there are no
subdomains for 3-D models, so the only acceptable value for a 3-D model is 1.
Example: ca = findInitialConditions(ics,'Face',[1,3])
Data Types: double

Output Arguments
ic — Initial condition assignment
GeometricInitialConditions object | NodalInitialConditions object
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Initial condition assignment, returned as a GeometricInitialConditions or
NodalInitialConditions object.

See Also
GeometricInitialConditions | NodalInitialConditions | setInitialConditions

Topics
“View, Edit, and Delete Initial Conditions” on page 2-157
“Solve Problems Using PDEModel Objects” on page 2-6
“Initial Conditions”

Introduced in R2016a
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findNodes
Package: pde

Find mesh nodes in specified region

Syntax
nodes = findNodes(mesh,'region',RegionType,RegionID)
nodes = findNodes(mesh,'box',xlim,ylim)
nodes = findNodes(mesh,'box',xlim,ylim,zlim)
nodes = findNodes(mesh,'radius',center,radius)
nodes = findNodes(mesh,'nearest',point)

Description
nodes = findNodes(mesh,'region',RegionType,RegionID) returns the IDs of
the mesh nodes that belong to the specified geometric region.

nodes = findNodes(mesh,'box',xlim,ylim) returns the IDs of the mesh nodes
within a bounding box specified by xlim and ylim. Use this syntax for 2-D meshes.

nodes = findNodes(mesh,'box',xlim,ylim,zlim) returns the IDs of the mesh
nodes located within a bounding box specified by xlim, ylim, and zlim. Use this syntax
for 3-D meshes.

nodes = findNodes(mesh,'radius',center,radius) returns the IDs of mesh
nodes located within a circle (for 2-D meshes) or sphere (for 3-D meshes) specified by
center and radius.

nodes = findNodes(mesh,'nearest',point) returns the IDs of mesh nodes closest
to a query point or multiple query points with Cartesian coordinates specified by point.

Examples
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Nodes Associated with Particular Edges and Faces

Find the nodes associated with a geometric region.

Create a PDE model.

model = createpde;

Include the geometry of the built-in function lshapeg. Plot the geometry.

geometryFromEdges(model,@lshapeg);
pdegplot(model,'FaceLabels','on','EdgeLabels','on')

Generate a mesh.
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mesh = generateMesh(model,'Hmax',0.5);

Find the nodes associated with face 2.

Nf2 = findNodes(mesh,'region','Face',2);

Highlight these nodes in green on the mesh plot.

figure
pdemesh(model,'NodeLabels','on')
hold on
plot(mesh.Nodes(1,Nf2),mesh.Nodes(2,Nf2),'ok','MarkerFaceColor','g')  

Find the nodes associated with edges 5 and 7.
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Ne57 = findNodes(mesh,'region','Edge',[5 7]);

Highlight these nodes in green on the mesh plot.

figure
pdemesh(model,'NodeLabels','on')
hold on
plot(mesh.Nodes(1,Ne57),mesh.Nodes(2,Ne57),'or','MarkerFaceColor','g')

Nodes Within Bounding Box

Find the nodes located within a specified box.
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Create a PDE model.

model = createpde;

Import and plot the geometry.

importGeometry(model,'PlateHolePlanar.stl');
pdegplot(model)

Generate a mesh.

mesh = generateMesh(model,'Hmax',2,'Hmin',0.4,'GeometricOrder','linear');

Find the nodes located within the following box.
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Nb = findNodes(mesh,'box',[5 10],[10 20]);

Highlight these nodes in green on the mesh plot.

figure
pdemesh(model)
hold on
plot(mesh.Nodes(1,Nb),mesh.Nodes(2,Nb),'or','MarkerFaceColor','g')

Nodes Within Bounding Disk

Find the nodes located within a specified disk.
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Create a PDE model.

model = createpde;

Import and plot the geometry.

importGeometry(model,'PlateHolePlanar.stl');
pdegplot(model)

Generate a mesh.

mesh = generateMesh(model,'Hmax',2,'Hmin',0.4,'GeometricOrder','linear');

Find the nodes located within radius 2 from the center [5 10].
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Nb = findNodes(mesh,'radius',[5 10],2);

Highlight these nodes in green on the mesh plot.

figure
pdemesh(model)
hold on
plot(mesh.Nodes(1,Nb),mesh.Nodes(2,Nb),'or','MarkerFaceColor','g')

Nodes Closest to Specified Points

Find the node closest to a specified point and highlight it on the mesh plot.
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Create a PDE model.

model = createpde;

Import and plot the geometry.

importGeometry(model,'PlateHolePlanar.stl');
pdegplot(model)

Generate a mesh.

mesh = generateMesh(model,'Hmax',2,'Hmin',0.4);

Find the node closest to the point [15;10].
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N_ID = findNodes(mesh,'nearest',[15;10])

N_ID = 10

Highlight this node in green on the mesh plot.

figure
pdemesh(model)
hold on
plot(mesh.Nodes(1,N_ID),mesh.Nodes(2,N_ID),'or','MarkerFaceColor','g')
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Input Arguments
mesh — Mesh object
Mesh property of a PDEModel object | output of generateMesh

Mesh object, specified as the Mesh property of a PDEModel object or as the output of
generateMesh.
Example: model.Mesh

RegionType — Geometric region type
'Cell' | 'Face' | 'Edge' | 'Vertex'

Geometric region type, specified as 'Cell', 'Face', 'Edge', or 'Vertex'.
Example: findNodes(mesh,'region','Face',1:3)
Data Types: char

RegionID — Geometric region ID
vector of positive integers

Geometric region ID, specified as a vector of positive integers. Find the region IDs using
pdegplot, as shown in “Create Geometry and Remove Face Boundaries” on page 2-13 or
“STL File Import” on page 2-46.
Example: findNodes(mesh,'region','Face',1:3)
Data Types: double

xlim — x-limits of bounding box
two-element row vector

x-limits of the bounding box, specified as a two-element row vector. The first element of
xlim is the lower x-bound, and the second element is the upper x-bound.
Example: findNodes(mesh,'box',[5 10],[10 20])
Data Types: double

ylim — y-limits of bounding box
two-element row vector

y-limits of the bounding box, specified as a two-element row vector. The first element of
ylim is the lower y-bound, and the second element is the upper y-bound.
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Example: findNodes(mesh,'box',[5 10],[10 20])
Data Types: double

zlim — z-limits of bounding box
two-element row vector

z-limits of the bounding box, specified as a two-element row vector. The first element of
zlim is the lower z-bound, and the second element is the upper z-bound. You can specify
zlim only for 3-D meshes.
Example: findNodes(mesh,'box',[5 10],[10 20],[1 2])
Data Types: double

center — Center of bounding circle or sphere
two-element row vector for a 2-D mesh | three-element row vector for a 3-D mesh

Center of the bounding circle or sphere, specified as a two-element row vector for a 2-D
mesh or three-element row vector for a 3-D mesh. The elements of these vectors contain
the coordinates of the center of a circle or a sphere.
Example: findNodes(mesh,'radius',[0 0 0],0.5)
Data Types: double

radius — Radius of bounding circle or sphere
positive number

Radius of the bounding circle or sphere, specified as a positive number.
Example: findNodes(mesh,'radius',[0 0 0],0.5)
Data Types: double

point — Cartesian coordinates of query points
2-by-N or 3-by-N matrix

Cartesian coordinates of query points, specified as a 2-by-N or 3-by-N matrix. These
matrices contain the coordinates of the query points. Here, N is the number of query
points.
Example: findNodes(mesh,'nearest',[15 10.5 1; 12 10 1.2])
Data Types: double
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Output Arguments
nodes — Node IDs
positive integer | row vector of positive integers

Node IDs, returned as a positive integer or a row vector of positive integers.

See Also
FEMesh Properties | area | findElements | meshQuality | volume

Topics
“Finite Element Method Basics” on page 1-18

Introduced in R2018a
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findStructuralBC
Package: pde

Find structural boundary conditions and boundary loads assigned to geometric region

Syntax
sbca = findStructuralBC(structuralmodel.BoundaryConditions,
RegionType,RegionID)

Description
sbca = findStructuralBC(structuralmodel.BoundaryConditions,
RegionType,RegionID) returns the structural boundary conditions and boundary loads
assigned to the region specified by RegionType and RegionID. The function returns
structural boundary conditions assigned by structuralBC and boundary loads assigned
by structuralBoundaryLoad.

Examples

Find Structural Boundary Conditions

Find the structural boundary conditions for the faces of a 3-D geometry.

Create a structural model and include a block geometry.

structuralmodel = createpde('structural','static-solid');

Include the block geometry in the model and plot the geometry.

importGeometry(structuralmodel,'Block.stl');
pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.5)
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Specify the surface traction on face 1 of the block.

structuralBoundaryLoad(structuralmodel,'Face',1,'SurfaceTraction',[100;10;300]);

Specify the pressure on face 3 of the block.

structuralBoundaryLoad(structuralmodel,'Face',3,'Pressure',300);

Apply free constraint on faces 5 and 6 of the block.

structuralBC(structuralmodel,'Face',[5,6],'Constraint','free');

Check the boundary condition specification for faces 1 and 3.
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sbca = findStructuralBC(structuralmodel.BoundaryConditions,'Face',[1,3]);
sbcaFace1 = sbca(1)

sbcaFace1 = 
  StructuralBC with properties:

                RegionType: 'Face'
                  RegionID: 1
                Vectorized: 'off'

   Boundary Constraints and Enforced Displacements
              Displacement: []
             XDisplacement: []
             YDisplacement: []
             ZDisplacement: []
                Constraint: []

   Boundary Loads
                     Force: []
           SurfaceTraction: [3x1 double]
                  Pressure: []
    TranslationalStiffness: []

sbcaFace3 = sbca(2)

sbcaFace3 = 
  StructuralBC with properties:

                RegionType: 'Face'
                  RegionID: 3
                Vectorized: 'off'

   Boundary Constraints and Enforced Displacements
              Displacement: []
             XDisplacement: []
             YDisplacement: []
             ZDisplacement: []
                Constraint: []

   Boundary Loads
                     Force: []
           SurfaceTraction: []
                  Pressure: 300
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    TranslationalStiffness: []

Check the boundary condition specification for faces 5 and 6.

sbca = findStructuralBC(structuralmodel.BoundaryConditions,'Face',[5,6]);
sbcaFace5 = sbca(1)

sbcaFace5 = 
  StructuralBC with properties:

                RegionType: 'Face'
                  RegionID: [5 6]
                Vectorized: 'off'

   Boundary Constraints and Enforced Displacements
              Displacement: []
             XDisplacement: []
             YDisplacement: []
             ZDisplacement: []
                Constraint: "free"

   Boundary Loads
                     Force: []
           SurfaceTraction: []
                  Pressure: []
    TranslationalStiffness: []

sbcaFace6 = sbca(2)

sbcaFace6 = 
  StructuralBC with properties:

                RegionType: 'Face'
                  RegionID: [5 6]
                Vectorized: 'off'

   Boundary Constraints and Enforced Displacements
              Displacement: []
             XDisplacement: []
             YDisplacement: []
             ZDisplacement: []
                Constraint: "free"
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   Boundary Loads
                     Force: []
           SurfaceTraction: []
                  Pressure: []
    TranslationalStiffness: []

Input Arguments
structuralmodel.BoundaryConditions — Structural boundary conditions
BoundaryConditions property of StructuralModel object

Structural boundary conditions of the model, specified as the BoundaryConditions
property of a StructuralModel object.

RegionType — Geometric region type
'Edge' for a 2-D model | 'Face' for a 3-D model

Geometric region type, specified as 'Edge' for a 2-D model or 'Face' for a 3-D model.
Example: findStructuralBC(structuralmodel.BoundaryConditions,'Edge',1)
Data Types: char | string

RegionID — Geometric region ID
vector of positive integers

Geometric region ID, specified as a vector of positive integers. Find the region IDs using
pdegplot, as shown in “Create Geometry and Remove Face Boundaries” on page 2-13 or
“STL File Import” on page 2-46.
Example:
findStructuralBC(structuralmodel.BoundaryConditions,'Face',1:3)

Data Types: double

Output Arguments
sbca — Structural boundary conditions and boundary loads assignment
StructuralBC object
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Structural boundary conditions and boundary loads assignment, returned as a
StructuralBC object. For details, see StructuralBC Properties.

See Also
structuralBC | structuralBoundaryLoad

Introduced in R2017b
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findStructuralIC
Package: pde

Find initial displacement and velocity assigned to geometric region

Syntax
sica = findStructuralIC(structuralmodel.InitialConditions,
RegionType,RegionID)

Description
sica = findStructuralIC(structuralmodel.InitialConditions,
RegionType,RegionID) returns the initial displacement and velocity assigned to the
specified region.

Examples

Find Initial Conditions for Cells of 3-D Geometry

Find the initial displacement and velocity assigned to the cells of a 3-D geometry.

Create a transient dynamic model for a 3-D problem.

structuralmodel = createpde('structural','transient-solid');

Create the geometry consisting of the three nested cylinders and include it in the model.
Plot the geometry.

gm = multicylinder([5 10 15],2);
structuralmodel = createpde('structural','transient-solid');
structuralmodel.Geometry = gm;
pdegplot(structuralmodel,'CellLabels','on','FaceAlpha',0.5)
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Set the initial conditions for each cell. When you specify only the initial velocity or initial
displacement, structuralIC assumes that the omitted parameter is zero.

structuralIC(structuralmodel,'Displacement',[0;0;0],'Velocity',[0;0;0],'Cell',1);
structuralIC(structuralmodel,'Displacement',[0;0.1;0],'Cell',2);
structuralIC(structuralmodel,'Velocity',[0;0.2;0],'Cell',3);

Check the initial condition specification for cell 1.

SICACell1 = findStructuralIC(structuralmodel.InitialConditions,'Cell',1)

SICACell1 = 
  GeometricStructuralICs with properties:
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             RegionType: 'Cell'
               RegionID: 1
    InitialDisplacement: [3x1 double]
        InitialVelocity: [3x1 double]

SICACell1.InitialDisplacement

ans = 3×1

     0
     0
     0

SICACell1.InitialVelocity

ans = 3×1

     0
     0
     0

Find Initial Displacement Set as Previously Obtained Static Solution

Use a static solution as an initial condition for a dynamic structural model. Check and plot
the initial displacement.

Create a static model.

staticmodel = createpde('structural','static-solid');

Create the geometry and include it in the model. Plot the geometry.

gm = multicuboid(0.06,0.005,0.01);
staticmodel.Geometry = gm;
pdegplot(staticmodel,'FaceLabels','on','FaceAlpha',0.5)
view(50,20)
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Specify the Young's modulus, Poisson's ratio, and mass density.

structuralProperties(staticmodel,'YoungsModulus',210E9, ...
                                 'PoissonsRatio',0.3,...
                                 'MassDensity',7800);

Apply the boundary condition and static load.

structuralBC(staticmodel,'Face',5,'Constraint','fixed');
structuralBoundaryLoad(staticmodel,'Face',3,'SurfaceTraction',[0;1E6;0]);
generateMesh(staticmodel,'Hmax',0.02);
Rstatic = solve(staticmodel);

Create a dynamic model and assign geometry.
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dynamicmodel = createpde('structural','transient-solid');
gm = multicuboid(0.06,0.005,0.01);
dynamicmodel.Geometry = gm;

Apply the boundary condition.

structuralBC(dynamicmodel,'Face',5,'Constraint','fixed');

Specify the initial condition using the static solution.

generateMesh(dynamicmodel,'Hmax',0.02);
structuralIC(dynamicmodel,Rstatic)

ans = 
  NodalStructuralICs with properties:

    InitialDisplacement: [113x3 double]
        InitialVelocity: [113x3 double]

Check the initial condition specification for dynamicmodel.

sica = findStructuralIC(dynamicmodel.InitialConditions,'Cell',1)

sica = 
  NodalStructuralICs with properties:

    InitialDisplacement: [113x3 double]
        InitialVelocity: [113x3 double]

Plot the z-component of the initial displacement.

pdeplot3D(dynamicmodel,'ColorMapData',sica.InitialDisplacement(:,3))
title('Initial Displacement in the Z-direction')
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Input Arguments
structuralmodel.InitialConditions — Initial conditions
InitialConditions property of a StructuralModel object

Initial conditions of a transient structural model, specified as the InitialConditions
property of a StructuralModel object.

RegionType — Geometric region type
'Face' | 'Edge' | 'Vertex' | 'Cell' for a 3-D model
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Geometric region type, specified as 'Face', 'Edge', or 'Vertex' for a 2-D model or 3-
D model, or 'Cell' for a 3-D model.
Data Types: char

RegionID — Geometric region ID
vector of positive integers

Geometric region ID, specified as a vector of positive integers. Find the region IDs using
pdegplot, as shown in “Create Geometry and Remove Face Boundaries” on page 2-13 or
“STL File Import” on page 2-46.
Data Types: double

Output Arguments
sica — Structural initial condition assignment
GeometricStructuralICs object | NodalStructuralICs object

Structural initial condition for a particular region, returned as a
GeometricStructuralICs or NodalStructuralICs object. For details, see
GeometricStructuralICs Properties and NodalStructuralICs Properties.

See Also
GeometricStructuralICs Properties | NodalStructuralICs Properties | StructuralModel |
structuralIC

Introduced in R2018a
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findStructuralProperties
Package: pde

Find structural material properties assigned to geometric region

Syntax
smpa = findStructuralProperties(structuralmodel.MaterialProperties,
RegionType,RegionID)

Description
smpa = findStructuralProperties(structuralmodel.MaterialProperties,
RegionType,RegionID) returns the structural material properties assigned to the
specified region. Structural properties include the Young's modulus, Poisson's ratio, and
mass density of the material.

Examples

Find Young's Modulus and Poisson's Ratio

Find Young's modulus and Poisson's ratio for cells of a 3-D geometry.

Create a structural model.

structuralmodel = createpde('structural','static-solid');

Create the geometry consisting of three stacked cylinders and include it in the model.
Plot the geometry.

gm = multicylinder(10,[1 2 3],'ZOffset',[0 1 3]);
structuralmodel.Geometry = gm;
pdegplot(structuralmodel,'CellLabels','on','FaceAlpha',0.5)
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Assign different values of the Young's modulus and Poisson's ratio to each cell.

structuralProperties(structuralmodel,'Cell',1,'YoungsModulus',200E9, ...
                                              'PoissonsRatio',0.3);
structuralProperties(structuralmodel,'Cell',2,'YoungsModulus',210E9, ...
                                              'PoissonsRatio',0.3);
structuralProperties(structuralmodel,'Cell',3,'YoungsModulus',110E9, ...
                                              'PoissonsRatio',0.35);

Check the structural properties specification for cell 1.

mC1 = findStructuralProperties(structuralmodel.MaterialProperties,'Cell',1)

mC1 = 
  StructuralMaterialAssignment with properties:
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       RegionType: 'Cell'
         RegionID: 1
    YoungsModulus: 2.0000e+11
    PoissonsRatio: 0.3000
      MassDensity: []
              CTE: []

Check the structural properties specification for cells 2 and 3.

mC23 = findStructuralProperties(structuralmodel.MaterialProperties,'Cell',[2,3]);
mC2 = mC23(1)

mC2 = 
  StructuralMaterialAssignment with properties:

       RegionType: 'Cell'
         RegionID: 2
    YoungsModulus: 2.1000e+11
    PoissonsRatio: 0.3000
      MassDensity: []
              CTE: []

mC3 = mC23(2)

mC3 = 
  StructuralMaterialAssignment with properties:

       RegionType: 'Cell'
         RegionID: 3
    YoungsModulus: 1.1000e+11
    PoissonsRatio: 0.3500
      MassDensity: []
              CTE: []

Input Arguments
structuralmodel.MaterialProperties — Material properties
MaterialProperties property of StructuralModel object

5 Functions — Alphabetical List

5-348



Material properties of the model, specified as the MaterialProperties property of a
StructuralModel object.
Example: structuralmodel.MaterialProperties

RegionType — Geometric region type
'Face' for a 2-D model | 'Cell' for a 3-D model

Geometric region type, specified as 'Face' for a 2-D model or 'Cell' for a 3-D model.
Example:
findStructuralProperties(structuralmodel.MaterialProperties,'Cell',1
)

Data Types: char | string

RegionID — Geometric region ID
vector of positive integers

Geometric region ID, specified as a vector of positive integers. Find the region IDs using
pdegplot, as shown in “Create Geometry and Remove Face Boundaries” on page 2-13 or
“STL File Import” on page 2-46.
Example:
findStructuralProperties(structuralmodel.MaterialProperties,'Face',1
:3)

Data Types: double

Output Arguments
smpa — Material properties assignment
StructuralMaterialAssignment object

Material properties assignment, returned as a StructuralMaterialAssignment
object. For details, see StructuralMaterialAssignment Properties.

See Also
StructuralMaterialAssignment Properties | structuralProperties
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Introduced in R2017b
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findThermalBC
Package: pde

Find thermal boundary conditions assigned to a geometric region

Syntax
tbca = findThermalBC(thermalmodel.BoundaryConditions,RegionType,
RegionID)

Description
tbca = findThermalBC(thermalmodel.BoundaryConditions,RegionType,
RegionID) returns the thermal boundary condition assigned to the specified region.

Examples

Find Thermal Boundary Conditions for Edges of 2-D Geometry

Create a thermal model and include a square geometry.

thermalmodel = createpde('thermal');
geometryFromEdges(thermalmodel,@squareg);
pdegplot(thermalmodel,'EdgeLabels','on')
ylim([-1.1 1.1])
axis equal
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Apply temperature boundary conditions on edges 1 and 3 of the square.

thermalBC(thermalmodel,'Edge',[1 3],'Temperature',100);

Apply a heat flux boundary condition on edge 4 of the square.

thermalBC(thermalmodel,'Edge',4,'HeatFlux',20);

Check the boundary condition specification on edge 1.

tbcaEdge1 = findThermalBC(thermalmodel.BoundaryConditions,'Edge',1)

tbcaEdge1 = 
  ThermalBC with properties:
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               RegionType: 'Edge'
                 RegionID: [1 3]
              Temperature: 100
                 HeatFlux: []
    ConvectionCoefficient: []
               Emissivity: []
       AmbientTemperature: []
               Vectorized: 'off'

Check the boundary condition specifications on edges 3 and 4.

tbca = findThermalBC(thermalmodel.BoundaryConditions,'Edge',[3:4]);
tbcaEdge3 = tbca(1)

tbcaEdge3 = 
  ThermalBC with properties:

               RegionType: 'Edge'
                 RegionID: [1 3]
              Temperature: 100
                 HeatFlux: []
    ConvectionCoefficient: []
               Emissivity: []
       AmbientTemperature: []
               Vectorized: 'off'

tbcaEdge4 = tbca(2)

tbcaEdge4 = 
  ThermalBC with properties:

               RegionType: 'Edge'
                 RegionID: 4
              Temperature: []
                 HeatFlux: 20
    ConvectionCoefficient: []
               Emissivity: []
       AmbientTemperature: []
               Vectorized: 'off'
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Find Thermal Boundary Conditions for Faces of 3-D Geometry

Create a thermal model and include a block geometry.

thermalmodel = createpde('thermal','transient');
gm = importGeometry(thermalmodel,'Block.stl');
pdegplot(thermalmodel,'FaceLabels','on','FaceAlpha',0.5)

Apply temperature boundary condition on faces 1 and 3 of a block.

thermalBC(thermalmodel,'Face',1,'Temperature',100);
thermalBC(thermalmodel,'Face',3,'Temperature',300);

Apply convection boundary condition on faces 5 and 6 of a block.
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thermalBC(thermalmodel,'Face',[5,6],...
                       'ConvectionCoefficient',5,...
                       'AmbientTemperature',27);

Check the boundary condition specification on faces 1 and 3.

tbca = findThermalBC(thermalmodel.BoundaryConditions,'Face',[1,3]);
tbcaFace1 = tbca(1)

tbcaFace1 = 
  ThermalBC with properties:

               RegionType: 'Face'
                 RegionID: 1
              Temperature: 100
                 HeatFlux: []
    ConvectionCoefficient: []
               Emissivity: []
       AmbientTemperature: []
               Vectorized: 'off'

tbcaFace3 = tbca(2)

tbcaFace3 = 
  ThermalBC with properties:

               RegionType: 'Face'
                 RegionID: 3
              Temperature: 300
                 HeatFlux: []
    ConvectionCoefficient: []
               Emissivity: []
       AmbientTemperature: []
               Vectorized: 'off'

Check the boundary condition specifications on faces 5 and 6.

tbcaFace5 = findThermalBC(thermalmodel.BoundaryConditions,'Face',5)

tbcaFace5 = 
  ThermalBC with properties:

               RegionType: 'Face'
                 RegionID: [5 6]
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              Temperature: []
                 HeatFlux: []
    ConvectionCoefficient: 5
               Emissivity: []
       AmbientTemperature: 27
               Vectorized: 'off'

tbcaFace6 = findThermalBC(thermalmodel.BoundaryConditions,'Face',6)

tbcaFace6 = 
  ThermalBC with properties:

               RegionType: 'Face'
                 RegionID: [5 6]
              Temperature: []
                 HeatFlux: []
    ConvectionCoefficient: 5
               Emissivity: []
       AmbientTemperature: 27
               Vectorized: 'off'

Input Arguments
thermalmodel.BoundaryConditions — Boundary conditions of a thermal model
BoundaryConditions property of a thermal model

Boundary conditions of a thermal model, specified as the BoundaryConditions property
of a ThermalModel object.
Example: thermalmodel.BoundaryConditions

RegionType — Geometric region type
'Face' | 'Edge'

Geometric region type, specified as 'Face' for 3-D geometry or 'Edge' for 2-D
geometry.
Data Types: char | string

RegionID — Geometric region ID
vector of positive integers
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Geometric region ID, specified as a vector of positive integers. Find the region IDs using
pdegplot with the 'FaceLabels' (3-D) or 'EdgeLabels' (2-D) value set to 'on'.
Data Types: double

Output Arguments
tbca — Thermal boundary condition for a particular region
ThermalBC object

Thermal boundary condition for a particular region, returned as a ThermalBC object.

See Also
ThermalBC | thermalBC

Introduced in R2017a
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findThermalIC
Package: pde

Find thermal initial conditions assigned to a geometric region

Syntax
tica = findThermalIC(thermalmodel.InitialConditions,RegionType,
RegionID)

Description
tica = findThermalIC(thermalmodel.InitialConditions,RegionType,
RegionID) returns the thermal initial condition assigned to the specified region.

Examples

Find Initial Temperatures for Faces of 2-D Geometry

Create a transient thermal model that has three faces.

thermalmodel = createpde('thermal','transient');
geometryFromEdges(thermalmodel,@lshapeg);
pdegplot(thermalmodel,'FaceLabels','on')
ylim([-1.1 1.1])
axis equal
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Set initial temperatures for each face.

thermalIC(thermalmodel,10,'Face',1);
thermalIC(thermalmodel,20,'Face',2);
thermalIC(thermalmodel,30,'Face',3);

Check the initial condition specification for face 1.

ticaFace1 = findThermalIC(thermalmodel.InitialConditions,'Face',1)

ticaFace1 = 
  GeometricThermalICs with properties:

            RegionType: 'face'
              RegionID: 1
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    InitialTemperature: 10

Check the initial temperature specifications for faces 2 and 3.

tica = findThermalIC(thermalmodel.InitialConditions,'Face',[2 3]);
ticaFace2 = tica(1)

ticaFace2 = 
  GeometricThermalICs with properties:

            RegionType: 'face'
              RegionID: 2
    InitialTemperature: 20

ticaFace3 = tica(2)

ticaFace3 = 
  GeometricThermalICs with properties:

            RegionType: 'face'
              RegionID: 3
    InitialTemperature: 30

Find Initial Temperatures for Cells of 3-D Geometry

Create a geometry that consists of three nested cylinders and include the geometry in a
transient thermal model.

gm = multicylinder([5 10 15],2)

gm = 
  DiscreteGeometry with properties:

       NumCells: 3
       NumFaces: 9
       NumEdges: 6
    NumVertices: 6
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thermalmodel = createpde('thermal','transient');
thermalmodel.Geometry = gm;
pdegplot(thermalmodel,'CellLabels','on','FaceAlpha',0.5)

Set initial temperatures for each cell.

thermalIC(thermalmodel,0,'Cell',1);
thermalIC(thermalmodel,100,'Cell',2);
thermalIC(thermalmodel,0,'Cell',3);

Check the initial condition specification for cell 1.

ticaCell1 = findThermalIC(thermalmodel.InitialConditions,'Cell',1)
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ticaCell1 = 
  GeometricThermalICs with properties:

            RegionType: 'cell'
              RegionID: 1
    InitialTemperature: 0

Check the initial condition specification for cells 2 and 3.

tica = findThermalIC(thermalmodel.InitialConditions,'Cell',[2:3]);
ticaCell2 = tica(1)

ticaCell2 = 
  GeometricThermalICs with properties:

            RegionType: 'cell'
              RegionID: 2
    InitialTemperature: 100

ticaCell3 = tica(2)

ticaCell3 = 
  GeometricThermalICs with properties:

            RegionType: 'cell'
              RegionID: 3
    InitialTemperature: 0

Find Initial Temperature Set by Using Previously Obtained Solution

Create a thermal model and include a square geometry.

thermalmodel = createpde('thermal','transient');
gm = @squareg;
geometryFromEdges(thermalmodel,gm);
pdegplot(thermalmodel,'FaceLabels','on')
ylim([-1.1 1.1])
axis equal
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Specify material properties, heat source, set initial and boundary conditions.

thermalProperties(thermalmodel,'ThermalConductivity',500,...
                               'MassDensity',200,...
                               'SpecificHeat',100);
internalHeatSource(thermalmodel,2);                            
thermalBC(thermalmodel,'Edge',[1 3],'Temperature',100);
thermalIC(thermalmodel,0);

Generate a mesh and solve the problem.

generateMesh(thermalmodel);
tlist = 0:0.5:10;
result1 = solve(thermalmodel,tlist)
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result1 = 
  TransientThermalResults with properties:

      Temperature: [1541x21 double]
    SolutionTimes: [1x21 double]
       XGradients: [1541x21 double]
       YGradients: [1541x21 double]
       ZGradients: []
             Mesh: [1x1 FEMesh]

Check the currently active initial temperature specification.

tica = findThermalIC(thermalmodel.InitialConditions,'Face',1)

tica = 
  GeometricThermalICs with properties:

            RegionType: 'face'
              RegionID: 1
    InitialTemperature: 0

Now, resume the analysis and solve the problem for times from 10 to 15 seconds. Use the
previously obtained solution for 10 seconds as an initial condition. Since 10 seconds is the
last element in tlist, you do not need to specify the solution time index. By default,
thermalIC uses the last solution index.

ic = thermalIC(thermalmodel,result1);

Solve the problem

tlist = 10:0.5:15;
result2 = solve(thermalmodel,tlist);

Check the currently active initial temperature specification.

tica = findThermalIC(thermalmodel.InitialConditions,'Face',1)

tica = 
  NodalThermalICs with properties:

    InitialTemperature: [1541x1 double]

pdeplot(thermalmodel,'XYData',tica.InitialTemperature)
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Input Arguments
thermalmodel.InitialConditions — Initial conditions of a thermal model
InitialConditions property of a thermal model

Initial conditions of a thermal model, specified as the InitialConditions property of a
ThermalModel object.

RegionType — Geometric region type
'Edge' | 'Face' | 'Vertex' | 'Cell' for a 3-D model
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Geometric region type, specified as 'Edge', 'Face', or 'Vertex' for a 2-D model or 3-
D model, or 'Cell' for a 3-D model.
Data Types: char | string

RegionID — Geometric region ID
vector of positive integers

Geometric region ID, specified as a vector of positive integers. Find the region IDs using
the pdegplot function with the 'FaceLabels' (3-D) or 'EdgeLabels' (2-D) value set
to 'on'.
Data Types: double

Output Arguments
tica — Thermal initial condition for a particular region
GeometricThermalICs object | NodalThermalICs object

Thermal initial condition for a particular region, returned as a GeometricThermalICs or
NodalThermalICs object.

See Also
GeometricThermalICs | NodalThermalICs | thermalIC

Introduced in R2017a
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findThermalProperties
Package: pde

Find thermal material properties assigned to a geometric region

Syntax
tmpa = findThermalProperties(thermalmodel.MaterialProperties,
RegionType,RegionID)

Description
tmpa = findThermalProperties(thermalmodel.MaterialProperties,
RegionType,RegionID) returns thermal material properties tmpa assigned to the
specified region.

Examples

Find Thermal Conductivity, Mass Density, and Specific Heat for Faces of 2-D
Geometry

Create a transient thermal model that has three faces.

thermalmodel = createpde('thermal','transient');
geometryFromEdges(thermalmodel,@lshapeg);
pdegplot(thermalmodel,'FaceLabels','on')
ylim([-1.1,1.1])
axis equal
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For face 1, specify the following thermal properties:

• Thermal conductivity is 10 W/(m*C)
• Mass density is 1 kg/m^3
• Specific heat is 0.1 J/(kg*C)

thermalProperties(thermalmodel,'ThermalConductivity',10,...
                               'MassDensity',1,...
                               'SpecificHeat',0.1,...
                               'Face',1);

For face 2, specify the following thermal properties:
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• Thermal conductivity is 20 W/(m*C)
• Mass density is 2 kg/m^3
• Specific heat is 0.2 J/(kg*C)

thermalProperties(thermalmodel,'ThermalConductivity',20,...
                               'MassDensity',2,...
                               'SpecificHeat',0.2,...
                               'Face',2);

For face 1, specify the following thermal properties: thermal conductivity is 30 W/(m*C),
mass density is 3 kg/m^3, specific heat is 0.3 J/(kg*C).

• Thermal conductivity is 30 W/(m*C)
• Mass density is 3 kg/m^3
• Specific heat is 0.3 J/(kg*C)

thermalProperties(thermalmodel,'ThermalConductivity',30,...
                               'MassDensity',3,...
                               'SpecificHeat',0.3,...
                               'Face',3);

Check the material properties specification for face 1.

mpaFace1 = findThermalProperties(thermalmodel.MaterialProperties,'Face',1)

mpaFace1 = 
  ThermalMaterialAssignment with properties:

             RegionType: 'face'
               RegionID: 1
    ThermalConductivity: 10
            MassDensity: 1
           SpecificHeat: 0.1000

Check the heat source specification for faces 2 and 3.

mpa = findThermalProperties(thermalmodel.MaterialProperties,'Face',[2,3]);
mpaFace2 = mpa(1)

mpaFace2 = 
  ThermalMaterialAssignment with properties:
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             RegionType: 'face'
               RegionID: 2
    ThermalConductivity: 20
            MassDensity: 2
           SpecificHeat: 0.2000

mpaFace3 = mpa(2)

mpaFace3 = 
  ThermalMaterialAssignment with properties:

             RegionType: 'face'
               RegionID: 3
    ThermalConductivity: 30
            MassDensity: 3
           SpecificHeat: 0.3000

Find Thermal Conductivity for Cells of 3-D Geometry

Create a geometry that consists of three stacked cylinders and include the geometry in a
thermal model.

gm = multicylinder(10,[1 2 3],'ZOffset',[0 1 3])

gm = 
  DiscreteGeometry with properties:

       NumCells: 3
       NumFaces: 7
       NumEdges: 4
    NumVertices: 4

thermalmodel = createpde('thermal');
thermalmodel.Geometry = gm;
pdegplot(thermalmodel,'CellLabels','on','FaceAlpha',0.5)
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Thermal conductivity of the cylinder C1 is 10 W/(m*C).

thermalProperties(thermalmodel,'ThermalConductivity',10,'Cell',1);

Thermal conductivity of the cylinder C2 is 20 W/(m*C).

thermalProperties(thermalmodel,'ThermalConductivity',20,'Cell',2);

Thermal conductivity of the cylinder C3 is 30 W/(m*C).

thermalProperties(thermalmodel,'ThermalConductivity',30,'Cell',3);

Check the material properties specification for cell 1:

mpaCell1 = findThermalProperties(thermalmodel.MaterialProperties,'Cell',1)
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mpaCell1 = 
  ThermalMaterialAssignment with properties:

             RegionType: 'cell'
               RegionID: 1
    ThermalConductivity: 10
            MassDensity: []
           SpecificHeat: []

Check the heat source specification for cells 2 and 3:

mpa = findThermalProperties(thermalmodel.MaterialProperties,'Cell',2:3);
mpaCell2 = mpa(1)

mpaCell2 = 
  ThermalMaterialAssignment with properties:

             RegionType: 'cell'
               RegionID: 2
    ThermalConductivity: 20
            MassDensity: []
           SpecificHeat: []

mpaCell3 = mpa(2)

mpaCell3 = 
  ThermalMaterialAssignment with properties:

             RegionType: 'cell'
               RegionID: 3
    ThermalConductivity: 30
            MassDensity: []
           SpecificHeat: []

Input Arguments
thermalmodel.MaterialProperties — Material properties of the model
MaterialProperties property of a thermal model
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Material properties of the model, specified as the MaterialProperties property of a
thermal model.
Example: thermalmodel.MaterialProperties

RegionType — Geometric region type
'Face' for a 2-D model | 'Cell' for a 3-D model

Geometric region type, specified as 'Face' or 'Cell'.
Example:
findThermalProperties(thermalmodel.MaterialProperties,'Cell',1)

Data Types: char | string

RegionID — Geometric region ID
vector of positive integers

Geometric region ID, specified as a vector of positive integers. Find the region IDs using
pdegplot, as shown in “Create Geometry and Remove Face Boundaries” on page 2-13 or
“STL File Import” on page 2-46.
Example:
findThermalProperties(thermalmodel.MaterialProperties,'Face',1:3)

Data Types: double

Output Arguments
tmpa — Material properties assignment
ThermalMaterialAssignment object

Material properties assignment, returned as a ThermalMaterialAssignment object.

See Also
ThermalMaterialAssignment | thermalProperties

Introduced in R2017a
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generateMesh
Package: pde

Create triangular or tetrahedral mesh

Syntax
generateMesh(model)
generateMesh(model,Name,Value)
mesh = generateMesh( ___ )

Description
generateMesh(model) creates a mesh and stores it in the model object. model must
contain geometry. To include 2-D geometry in a model, use geometryFromEdges. To
include 3-D geometry, use importGeometry or geometryFromMesh.

generateMesh can return slightly different meshes in different releases. For example,
the number of elements in the mesh can change. Avoid writing code that relies on
explicitly specified node and element IDs.

generateMesh(model,Name,Value) modifies the mesh creation according to the
Name,Value arguments.

mesh = generateMesh( ___ ) also returns the mesh to the MATLAB workspace, using
any of the previous syntaxes.

Examples

Generate 2-D Mesh

Generate the default 2-D mesh for the L-shaped geometry.

Create a PDE model and include the L-shaped geometry.
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model = createpde(1);
geometryFromEdges(model,@lshapeg);

Generate the default mesh for the geometry.

generateMesh(model);

View the mesh.

pdeplot(model)
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Generate 3-D Mesh

Create a mesh that is finer than the default.

Create a PDE model and include the BracketTwoHoles geometry.

model = createpde(1);
importGeometry(model,'BracketTwoHoles.stl');

Generate a default mesh for comparison.

generateMesh(model)

ans = 
  FEMesh with properties:

             Nodes: [3x10003 double]
          Elements: [10x5774 double]
    MaxElementSize: 9.7980
    MinElementSize: 4.8990
     MeshGradation: 1.5000
    GeometricOrder: 'quadratic'

View the mesh.

pdeplot3D(model)
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Create a mesh with target maximum element size 5 instead of the default 7.3485.

generateMesh(model,'Hmax',5)

ans = 
  FEMesh with properties:

             Nodes: [3x66965 double]
          Elements: [10x44080 double]
    MaxElementSize: 5
    MinElementSize: 2.5000
     MeshGradation: 1.5000
    GeometricOrder: 'quadratic'
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View the mesh.

pdeplot3D(model)

Input Arguments
model — Model object
PDEModel object | ThermalModel object | StructuralModel object

Model object, specified as a PDEModel object, ThermalModel object, or
StructuralModel object.
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Example: model = createpde(1)
Example: thermalmodel = createpde('thermal','steadystate')
Example: structuralmodel = createpde('structural','static-solid')

Name-Value Pair Arguments
Specify optional comma-separated pairs of Name,Value arguments. Name is the
argument name and Value is the corresponding value. Name must appear inside quotes.
You can specify several name and value pair arguments in any order as
Name1,Value1,...,NameN,ValueN.
Example: generateMesh(model,'Hmax',0.25);

GeometricOrder — Element type
'quadratic' (default) | 'linear'

Element type, specified as the comma-separated pair consisting of 'GeometricOrder'
and 'linear' or 'quadratic'.

In general, 'quadratic' elements produce more accurate solutions. Override the
default 'quadratic' only to save memory or to solve a 2-D problem using a legacy
solver. Legacy PDE solvers use linear triangular mesh for 2-D geometries.
Example: generateMesh(model,'GeometricOrder','linear');
Data Types: char | string

Hgrad — Mesh growth rate
1.5 (default) | number greater than or equal to 1 and less than or equal to 2

Mesh growth rate, specified as the comma-separated pair consisting of Hgrad and a
number greater than or equal to 1 and less than or equal to 2.
Example: generateMesh(model,'Hgrad',1.3);
Data Types: double

Hmax — Target maximum mesh edge length
positive real number

Target maximum mesh edge length, specified as the comma-separated pair consisting of
Hmax and a positive real number.

 generateMesh

5-379



Hmax is an approximate upper bound on the mesh edge lengths. Occasionally,
generateMesh can create a mesh with some elements that exceed Hmax.

generateMesh estimates the default value of Hmax from overall dimensions of the
geometry.

Small Hmax values let you create finer meshes, but mesh generation can take a very long
time in this case. You can interrupt mesh generation by using Ctrl+C. Note that
generateMesh can take additional time to respond to the interrupt.
Example: generateMesh(model,'Hmax',0.25);
Data Types: double

Hmin — Target minimum mesh edge length
nonnegative real number

Target minimum mesh edge length, specified as the comma-separated pair consisting of
Hmin and a nonnegative real number.

Hmin is an approximate lower bound on the mesh edge lengths. Occasionally,
generateMesh can create a mesh with some elements that are smaller than Hmin.

generateMesh estimates the default value of Hmin from overall dimensions of the
geometry.
Example: generateMesh(model,'Hmin',0.05);
Data Types: double

Output Arguments
mesh — Mesh description
FEMesh object

Mesh description, returned as an FEMesh object. mesh is the same as model.Mesh.
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Definitions

Element
An element is a basic unit in the finite-element method.

For 2-D problems, an element is a triangle in the model.Mesh.Element property. If the
triangle represents a linear element, it has nodes only at the triangle corners. If the
triangle represents a quadratic element, then it has nodes at the triangle corners and
edge centers.

For 3-D problems, an element is a tetrahedron with either four or ten points. A four-point
(linear) tetrahedron has nodes only at its corners. A ten-point (quadratic) tetrahedron has
nodes at its corners and at the center point of each edge.

For details, see “Mesh Data” on page 2-233.

See Also
FEMesh | PDEModel | geometryFromEdges | importGeometry

Topics
“Solve Problems Using PDEModel Objects” on page 2-6
“Finite Element Method Basics” on page 1-18
“Mesh Data” on page 2-233
“Mesh Data as [p,e,t] Triples” on page 2-230

Introduced in R2015a
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GeometricInitialConditions Properties
Initial conditions over a region or region boundary

Description
A GeometricInitialConditions object contains a description of the initial conditions
over a geometric region or boundary of the region. A PDEModel container has a vector of
GeometricInitialConditions objects in its
InitialConditions.InitialConditionAssignments property.

Set initial conditions for your model using the setInitialConditions function.

Properties
Properties

RegionType — Region type
'face' | 'cell'

Region type, returned as 'face' for a 2-D region, or 'cell' for a 3-D region.
Data Types: char

RegionID — Region ID
vector of positive integers

Region ID, returned as a vector of positive integers. To determine which ID corresponds
to which portion of the geometry, use the pdegplot function. Set the 'FacenLabels'
name-value pair to 'on'.
Data Types: double

InitialValue — Initial value
scalar | vector | function handle

Initial value, returned as a scalar, vector, or function handle. For details, see
setInitialConditions.
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Data Types: double | function_handle
Complex Number Support: Yes

InitialDerivative — Initial derivative
scalar | vector | function handle

Initial derivative, returned as a scalar, vector, or function handle. For details, see
setInitialConditions.
Data Types: double | function_handle
Complex Number Support: Yes

See Also
NodalInitialConditions | findInitialConditions | setInitialConditions

Topics
“Set Initial Conditions” on page 2-154
“View, Edit, and Delete Initial Conditions” on page 2-157
“Solve Problems Using PDEModel Objects” on page 2-6

Introduced in R2016a
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GeometricStructuralICs Properties
Initial displacement and velocity over a region

Description
A GeometricStructuralICs object contains a description of the initial displacement
and velocity over a geometric region for a transient structural model. A
StructuralModel container has a vector of GeometricStructuralICs objects in its
InitialConditions.StructuralICAssignments property.

To set initial conditions for your structural model, use the structuralIC function.

Properties
Properties

RegionType — Geometric region type
'Face' | 'Edge' | 'Vertex' | 'Cell' for a 3-D model

Geometric region type, returned as 'Face', 'Edge', or 'Vertex' for a 2-D model or 3-D
model, or 'Cell' for a 3-D model.
Data Types: char

RegionID — Geometric region ID
vector of positive integers

Geometric region ID, returned as a vector of positive integers. Find the region IDs using
pdegplot, as shown in “Create Geometry and Remove Face Boundaries” on page 2-13 or
“STL File Import” on page 2-46.
Data Types: double

InitialDisplacement — Initial displacement
numeric vector | function handle

Initial displacement, returned as a numeric vector or function handle. For details, see
structuralIC.
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Data Types: double | function_handle

InitialVelocity — Initial velocity
numeric vector | function handle

Initial velocity, returned as a numeric vector or function handle. For details, see
structuralIC.
Data Types: double | function_handle

See Also
NodalStructuralICs Properties | findStructuralIC | structuralIC

Introduced in R2018a

 GeometricStructuralICs Properties

5-385



GeometricThermalICs Properties
Initial temperature over a region or region boundary

Description
A GeometricThermalICs object contains a description of the initial temperature over a
geometric region or a boundary of the region. A ThermalModel container has a vector of
GeometricThermalICs objects in its InitialConditions.ThermalICAssignments
property.

Set initial conditions for your model using the thermalIC function.

Properties
Properties

RegionType — Region type
'Vertex' | 'Edge' | 'Face' | 'Cell'

Region type, returned as 'Vertex', 'Edge', or 'Face' for a 2-D or 3-D region, or
'Cell' for a 3-D region.
Data Types: char

RegionID — Region ID
vector of positive integers

Region ID, returned as a vector of positive integers. To determine which ID corresponds
to which portion of the geometry, use the pdegplot function and setting the
'FaceLabels' name-value pair to 'on'.
Data Types: double

InitialTemperature — Initial temperature
scalar | vector | function handle

Initial temperature, returned as a scalar, vector, or function handle. For details, see
thermalIC.
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Data Types: double | function_handle

See Also
NodalThermalICs | findThermalIC | thermalIC

Introduced in R2017a
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NodalInitialConditions Properties
Initial conditions at mesh nodes

Description
A NodalInitialConditions object contains a description of the initial conditions at
mesh nodes. A PDEModel container has a vector of NodalInitialConditions objects
in its InitialConditions.InitialConditionAssignments property.

Set initial conditions for your model using the setInitialConditions function.

Properties
Properties

InitialValue — Initial value
scalar | vector | function handle

Initial value, returned as a scalar, vector, or function handle. For details, see
setInitialConditions.
Data Types: double | function_handle
Complex Number Support: Yes

InitialDerivative — Initial derivative
scalar | vector | function handle

Initial derivative, returned as a scalar, vector, or function handle. For details, see
setInitialConditions.
Data Types: double | function_handle
Complex Number Support: Yes

See Also
GeometricInitialConditions | findInitialConditions | setInitialConditions
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Topics
“Set Initial Conditions” on page 2-154
“View, Edit, and Delete Initial Conditions” on page 2-157
“Solve Problems Using PDEModel Objects” on page 2-6

Introduced in R2016b
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NodalStructuralICs Properties
Initial displacement and velocity at mesh nodes

Description
A NodalStructuralICs object contains a description of the initial displacement and
velocity at mesh nodes. A StructuralModel container has a vector of
GeometricStructuralICs objects in its
InitialConditions.StructuralICAssignments property.

To set initial conditions for your structural model, use the structuralIC function.

Properties
Properties

InitialDisplacement — Initial displacement
numeric vector | function handle

Initial displacement, returned as a numeric vector or function handle. For details, see
structuralIC.
Data Types: double | function_handle

InitialVelocity — Initial velocity
numeric vector | function handle

Initial velocity, returned as a numeric vector or function handle. For details, see
structuralIC.
Data Types: double | function_handle

See Also
GeometricStructuralICs Properties | findStructuralIC | structuralIC
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Introduced in R2018a
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NodalThermalICs Properties
Initial temperature at mesh nodes

Description
A NodalThermalICs object contains a description of the initial temperatures at mesh
nodes. A ThermalModel container has a vector of NodalThermalICs objects in its
InitialConditions.ThermalICAssignments property.

Set initial conditions for your model using the thermalIC function.

Properties
Properties

InitialTemperature — Initial temperature
scalar | vector | function handle

Initial temperature, returned as a scalar, vector, or function handle. For details, see
thermalIC.
Data Types: double | function_handle

See Also
GeometricThermalICs | findThermalIC | thermalIC

Introduced in R2017a
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geometryFromEdges
Package: pde

Create 2-D geometry

Syntax
geometryFromEdges(model,g)
pg = geometryFromEdges(model,g)

Description
geometryFromEdges(model,g) adds the 2-D geometry described in g to the model
container.

pg = geometryFromEdges(model,g) additionally returns the geometry to the
Workspace.

Examples

Geometry from Decomposed Solid Geometry

Create a decomposed solid geometry model and include it in a PDE model.

Create a default scalar PDE model.

model = createpde;

Define a circle in a rectangle, place these in one matrix, and create a set formula that
subtracts the circle from the rectangle.

R1 = [3,4,-1,1,1,-1,0.5,0.5,-0.75,-0.75]';
C1 = [1,0.5,-0.25,0.25]';
C1 = [C1;zeros(length(R1) - length(C1),1)];
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gm = [R1,C1];
sf = 'R1-C1';

Create the geometry.

ns = char('R1','C1');
ns = ns';
g = decsg(gm,sf,ns);

Include the geometry in the model and plot it.

geometryFromEdges(model,g);
pdegplot(model,'EdgeLabels','on')
axis equal
xlim([-1.1,1.1])
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Input Arguments
model — Model object
PDEModel object | ThermalModel object | StructuralModel object

Model object, specified as a PDEModel object, ThermalModel object, or
StructuralModel object.
Example: model = createpde(1)
Example: thermalmodel = createpde('thermal','steadystate')
Example: structuralmodel = createpde('structural','static-solid')

g — Geometry description
decomposed geometry matrix | name of a geometry function | handle to a geometry
function

Geometry description, specified as a decomposed geometry matrix, as the name of a
geometry function, or as a handle to a geometry function. For details, see “Three Ways to
Create 2-D Geometry” on page 2-8.
Example: geometryFromEdges(model,@circleg)
Data Types: double | char | function_handle

Output Arguments
pg — Geometry object
AnalyticGeometry object

Geometry object, returned as an AnalyticGeometry object. This object is stored in
model.Geometry.

See Also
AnalyticGeometry | PDEModel
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Topics
“Solve PDEs with Constant Boundary Conditions” on page 2-181
“Solve Problems Using PDEModel Objects” on page 2-6
“Geometry”

Introduced in R2015a
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geometryFromMesh
Package: pde

Create geometry from mesh

Syntax
geometryFromMesh(model,nodes,elements)
geometryFromMesh(model,nodes,elements,ElementIDToRegionID)
[G,mesh] = geometryFromMesh(model,nodes,elements)

Description
geometryFromMesh(model,nodes,elements) creates geometry within model. For
planar and volume triangulated meshes, this function also incorporates nodes in the
model.Mesh.Nodes property and elements in the model.Mesh.Elements property. To
replace the imported mesh with a mesh having a different target element size, use
generateMesh.

If elements represents a surface triangular mesh that bounds a closed volume, then
geometryFromMesh creates the geometry, but does not incorporate the mesh into the
corresponding properties of the model. To generate a mesh in this case, use
generateMesh.

geometryFromMesh(model,nodes,elements,ElementIDToRegionID) creates a
multidomain geometry. Here, ElementIDToRegionID specifies the subdomain IDs for
each element of the mesh.

[G,mesh] = geometryFromMesh(model,nodes,elements) returns a handle G to the
geometry in model.Geometry, and a handle mesh to the mesh in model.Mesh.

Examples
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Geometry from Volume Mesh

Import a tetrahedral mesh into a PDE model.

Load a tetrahedral mesh into your workspace. The tetmesh file ships with your software.
Put the data in the correct shape for geometryFromMesh.

load tetmesh
nodes = X';
elements = tet';

Create a PDE model and import the mesh into the model.

model = createpde();
geometryFromMesh(model,nodes,elements);

View the geometry and face numbers.

pdegplot(model,'FaceLabels','on','FaceAlpha',0.5)
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Geometry from Convex Hull

Create a geometric block from the convex hull of a mesh grid of points.

Create a 3-D mesh grid.

[x,y,z] = meshgrid(-2:4:2);

Create the convex hull.

x = x(:);
y = y(:);
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z = z(:);
K = convhull(x,y,z);

Put the data in the correct shape for geometryFromMesh.

nodes = [x';y';z'];
elements = K';

Create a PDE model and import the mesh.

model = createpde();
geometryFromMesh(model,nodes,elements);

View the geometry and face numbers.

pdegplot(model,'FaceLabels','on','FaceAlpha',0.5)
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Geometry from alphaShape

Create a 3-D geometry using the MATLAB alphaShape function. First, create an
alphaShape object of a block with a cylindrical hole. Then import the geometry into a PDE
model from the alphaShape boundary.

Create a 2-D mesh grid.

[xg, yg] = meshgrid(-3:0.25:3);
xg = xg(:);
yg = yg(:);
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Create a unit disk. Remove all the mesh grid points that fall inside the unit disk, and
include the unit disk points.

t = (pi/24:pi/24:2*pi)';
x = cos(t);
y = sin(t);
circShp = alphaShape(x,y,2);
in = inShape(circShp,xg,yg);
xg = [xg(~in); cos(t)];
yg = [yg(~in); sin(t)];

Create 3-D copies of the remaining mesh grid points, with the z-coordinates ranging from
0 through 1. Combine the points into an alphaShape object.

zg = ones(numel(xg),1);
xg = repmat(xg,5,1);
yg = repmat(yg,5,1);
zg = zg*(0:.25:1);
zg = zg(:);
shp = alphaShape(xg,yg,zg);

Obtain a surface mesh of the alphaShape object.

[elements,nodes] = boundaryFacets(shp);

Put the data in the correct shape for geometryFromMesh.

nodes = nodes';
elements = elements';

Create a PDE model and import the surface mesh.

model = createpde();
geometryFromMesh(model,nodes,elements);

View the geometry and face numbers.

pdegplot(model,'FaceLabels','on','FaceAlpha',0.5)

5 Functions — Alphabetical List

5-402



To use the geometry in an analysis, create a volume mesh.

generateMesh(model);

2-D Multidomain Geometry

Create a 2-D multidomain geometry from a mesh.

Load information about nodes, elements, and element-to-domain correspondence into
your workspace. The file MultidomainMesh2D ships with your software.

load MultidomainMesh2D
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Create a PDE model.

model = createpde;

Import the mesh into the model.

geometryFromMesh(model,nodes,elements,ElementIdToRegionId);

View the geometry and face numbers.

pdegplot(model,'FaceLabels','on')
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3-D Multidomain Geometry

Create a 3-D multidomain geometry from a mesh.

Load information about nodes, elements, and element-to-domain correspondence into
your workspace. The file MultidomainMesh3D ships with your software.

load MultidomainMesh3D

Create a PDE model.

model = createpde;

Import the mesh into the model.

geometryFromMesh(model,nodes,elements,ElementIdToRegionId);

View the geometry and cell numbers.

pdegplot(model,'CellLabels','on')
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Input Arguments
model — Model object
PDEModel object | ThermalModel object | StructuralModel object

Model object, specified as a PDEModel object, ThermalModel object, or
StructuralModel object.
Example: model = createpde(1)
Example: thermalmodel = createpde('thermal','steadystate')
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Example: structuralmodel = createpde('structural','static-solid')

nodes — Mesh nodes
matrix of real numbers

Mesh nodes, specified as a matrix of real numbers. The matrix size is 2-by-Nnodes for a 2-
D case and 3-by-Nnodes for a 3-D case. Nnodes is the number of nodes in the mesh.

Node j has x, y, and z coordinates in column j of nodes.
Data Types: double

elements — Mesh elements
3-by-Nelements integer matrix | 4-by-Nelements integer matrix | 10-by-Nelements
integer matrix

Mesh elements, specified as an integer matrix with 3, 4, or 10 rows, and Nelements
columns, where Nelements is the number of elements in the mesh.

• A mesh on the geometry surface has size 3-by-Nelements. Each column of elements
contains the indices of the triangle corner nodes for a surface element. In this case,
the resulting geometry does not contain a full mesh. Create the mesh using the
generateMesh function.

• Linear elements have size 4-by-Nelements. Each column of elements contains the
indices of the tetrahedral corner nodes for an element.

• Quadratic elements have size 10-by-Nelements. Each column of elements contains
the indices of the tetrahedral corner nodes and the tetrahedral edge midpoint nodes
for an element.

For details on node numbering for linear and quadratic elements, see “Mesh Data” on
page 2-233.
Data Types: double

ElementIDToRegionID — Domain information for each element
vector of positive integers

Domain information for each mesh element, specified as a vector of positive integers.
Each element is an ID of a geometric region for an element of the mesh. The length of this
vector equals the number of elements in the mesh.
Data Types: double
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Output Arguments
G — Geometry
handle to model.Geometry

Geometry, returned as a handle to model.Geometry. This geometry is of class
DiscreteGeometry.

mesh — Finite element mesh
handle to model.Mesh

Finite element mesh, returned as a handle to model.Mesh.

• If elements is a 3-by-Nelements matrix representing a surface mesh, then mesh is
[]. In this case, create a mesh for the geometry using the generateMesh function.

• If elements is a matrix with more than three rows representing a volume mesh, then
mesh has the same nodes and elements as the inputs. You can get a different mesh for
the geometry by using the generateMesh function.

See Also
DiscreteGeometry | alphaShape | generateMesh | importGeometry

Topics
“STL File Import” on page 2-46
“Solve Problems Using PDEModel Objects” on page 2-6

Introduced in R2015b
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HeatSourceAssignment Properties
Heat source assignments

Description
A HeatSourceAssignment object contains a description of the heat sources for a
thermal model. A ThermalModel container has a vector of HeatSourceAssignment
objects in its HeatSources.HeatSourceAssignments property.

Create heat source assignments for your thermal model using the internalHeatSource
function.

Properties
Properties

RegionType — Region type
'Face' | 'Cell'

Region type, returned as 'Face' for a 2-D region, or 'Cell' for a 3-D region.
Data Types: char

RegionID — Region ID
vector of positive integers

Region ID, returned as a vector of positive integers. To determine which ID corresponds
to which portion of the geometry, use the pdegplot function. Set the 'FaceLabels'
name-value pair to 'on'.
Data Types: double

HeatSource — Heat source value
number | function handle

Heat source value, returned as a number or a function handle. A heat source with a
negative value is called a heat sink.
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Data Types: double | function_handle

See Also
findHeatSource | internalHeatSource

Introduced in R2017a
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hyperbolic
(Not recommended) Solve hyperbolic PDE problem

Note hyperbolic is not recommended. Use solvepde instead.

Hyperbolic equation solver

Solves PDE problems of the type

d∂
2u
∂t2 − ∇ ⋅ c∇u + au = f

on a 2-D or 3-D region Ω, or the system PDE problem

d∂
2u
∂t2 − ∇ ⋅ c⊗ ∇u + au = f

The variables c, a, f, and d can depend on position, time, and the solution u and its
gradient.

Syntax
u = hyperbolic(u0,ut0,tlist,model,c,a,f,d)
u = hyperbolic(u0,ut0,tlist,b,p,e,t,c,a,f,d)
u = hyperbolic(u0,ut0,tlist,Kc,Fc,B,ud,M)
u = hyperbolic( ___ ,rtol)
u = hyperbolic( ___ ,rtol,atol)
u = hyperbolic(u0,ut0,tlist,Kc,Fc,B,ud,M, ___ ,'DampingMatrix',D)
u = hyperbolic( ___ ,'Stats','off')

Description
u = hyperbolic(u0,ut0,tlist,model,c,a,f,d) produces the solution to the FEM
formulation of the scalar PDE problem
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d∂
2u
∂t2 − ∇ ⋅ c∇u + au = f

on a 2-D or 3-D region Ω, or the system PDE problem

d∂
2u
∂t2 − ∇ ⋅ c⊗ ∇u + au = f

with geometry, mesh, and boundary conditions specified in model, with initial value u0
and initial derivative with respect to time ut0. The variables c, a, f, and d in the equation
correspond to the function coefficients c, a, f, and d respectively.

u = hyperbolic(u0,ut0,tlist,b,p,e,t,c,a,f,d) solves the problem using
boundary conditions b and finite element mesh specified in [p,e,t].

u = hyperbolic(u0,ut0,tlist,Kc,Fc,B,ud,M) solves the problem based on finite
element matrices that encode the equation, mesh, and boundary conditions.

u = hyperbolic( ___ ,rtol) and u = hyperbolic( ___ ,rtol,atol) modify the
solution process by passing to the ODE solver a relative tolerance rtol, and optionally an
absolute tolerance atol.

u = hyperbolic(u0,ut0,tlist,Kc,Fc,B,ud,M, ___ ,'DampingMatrix',D)
modifies the problem to include a damping matrix D.

u = hyperbolic( ___ ,'Stats','off') turns off the display of internal ODE solver
statistics during the solution process.

Examples

Hyperbolic Equation

Solve the wave equation

∂2u
∂t2 = Δu

on the square domain specified by squareg.
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Create a PDE model and import the geometry.

model = createpde;
geometryFromEdges(model,@squareg);
pdegplot(model,'EdgeLabels','on')
ylim([-1.1,1.1])
axis equal

Set Dirichlet boundary conditions u = 0 for x = ± 1, and Neumann boundary conditions

∇u ⋅ n = 0

for y = ± 1. (The Neumann boundary condition is the default condition, so the second
specification is redundant.)
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applyBoundaryCondition(model,'dirichlet','Edge',[2,4],'u',0);
applyBoundaryCondition(model,'neumann','Edge',[1,3],'g',0);

Set the initial conditions

u0 = 'atan(cos(pi/2*x))';
ut0 = '3*sin(pi*x).*exp(cos(pi*y))';

Set the solution times.

tlist = linspace(0,5,31);

Give coefficients for the problem.

c = 1;
a = 0;
f = 0;
d = 1;

Generate a mesh and solve the PDE.

generateMesh(model,'GeometricOrder','linear','Hmax',0.1);
u1 = hyperbolic(u0,ut0,tlist,model,c,a,f,d);

462 successful steps
51 failed attempts
1028 function evaluations
1 partial derivatives
135 LU decompositions
1027 solutions of linear systems

Plot the solution at the first and last times.

figure
pdeplot(model,'XYData',u1(:,1))
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figure
pdeplot(model,'XYData',u1(:,end))

 hyperbolic

5-415



For a version of this example with animation, see “Wave Equation on Square Domain”.

Hyperbolic Equation using Legacy Syntax

Solve the wave equation

∂2u
∂t2 = Δu
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on the square domain specified by squareg, using a geometry function to specify the
geometry, a boundary function to specify the boundary conditions, and using initmesh to
create the finite element mesh.

Specify the geometry as @squareg and plot the geometry.

g = @squareg;
pdegplot(g,'EdgeLabels','on')
ylim([-1.1,1.1])
axis equal

Set Dirichlet boundary conditions u = 0 for x = ± 1, and Neumann boundary conditions

∇u ⋅ n = 0
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for y = ± 1. (The Neumann boundary condition is the default condition, so the second
specification is redundant.)

The squareb3 function specifies these boundary conditions.

b = @squareb3;

Set the initial conditions

u0 = 'atan(cos(pi/2*x))';
ut0 = '3*sin(pi*x).*exp(cos(pi*y))';

Set the solution times.

tlist = linspace(0,5,31);

Give coefficients for the problem.

c = 1;
a = 0;
f = 0;
d = 1;

Create a mesh and solve the PDE.

[p,e,t] = initmesh(g);
u = hyperbolic(u0,ut0,tlist,b,p,e,t,c,a,f,d);

462 successful steps
70 failed attempts
1066 function evaluations
1 partial derivatives
156 LU decompositions
1065 solutions of linear systems

Plot the solution at the first and last times.

figure
pdeplot(p,e,t,'XYData',u(:,1))
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figure
pdeplot(p,e,t,'XYData',u(:,end))
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For a version of this example with animation, see “Wave Equation on Square Domain”.

Hyperbolic Solution Using Finite Element Matrices

Solve a hyperbolic problem using finite element matrices.

Create a model and import the BracketWithHole.stl geometry.

model = createpde();
importGeometry(model,'BracketWithHole.stl');
figure
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pdegplot(model,'FaceLabels','on')
view(30,30)
title('Bracket with Face Labels')

figure
pdegplot(model,'FaceLabels','on')
view(-134,-32)
title('Bracket with Face Labels, Rear View')
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Set coefficients c = 1, a = 0, f = 0.5, and d = 1.

c = 1;
a = 0;
f = 0.5;
d = 1;

Generate a mesh for the model.

generateMesh(model);

Create initial conditions and boundary conditions. The boundary condition for the rear
face is Dirichlet with value 0. All other faces have the default boundary condition. The
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initial condition is u(0) = 0, du/dt(0) = x/2. Give the initial condition on the
derivative by calculating the x-position of each node in xpts, and passing x/2.

applyBoundaryCondition(model,'Face',4,'u',0);
u0 = 0;
xpts = model.Mesh.Nodes(1,:);
ut0 = xpts(:)/2;

Create the associated finite element matrices.

[Kc,Fc,B,ud] = assempde(model,c,a,f);
[~,M,~] = assema(model,0,d,f);

Solve the PDE for times from 0 to 2.

tlist = linspace(0,5,50);
u = hyperbolic(u0,ut0,tlist,Kc,Fc,B,ud,M);

1493 successful steps
70 failed attempts
2972 function evaluations
1 partial derivatives
276 LU decompositions
2971 solutions of linear systems

View the solution at a few times. Scale all the plots to have the same color range by using
the caxis command.

umax = max(max(u));
umin = min(min(u));

subplot(2,2,1)
pdeplot3D(model,'ColorMapData',u(:,5))
caxis([umin umax])
title('Time 1/2')
subplot(2,2,2)
pdeplot3D(model,'ColorMapData',u(:,10))
caxis([umin umax])
title('Time 1')
subplot(2,2,3)
pdeplot3D(model,'ColorMapData',u(:,15))
caxis([umin umax])
title('Time 3/2')
subplot(2,2,4)
pdeplot3D(model,'ColorMapData',u(:,20))
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caxis([umin umax])
title('Time 2')

The solution seems to have a frequency of one, because the plots at times 1/2 and 3/2
show maximum values, and those at times 1 and 2 show minimum values.

Hyperbolic Equation with Damping

Solve a hyperbolic problem that includes damping. You must use the finite element matrix
form to use damping.

Create a model and import the BracketWithHole.stl geometry.
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model = createpde();
importGeometry(model,'BracketWithHole.stl');
figure
pdegplot(model,'FaceLabels','on')
view(30,30)
title('Bracket with Face Labels')

figure
pdegplot(model,'FaceLabels','on')
view(-134,-32)
title('Bracket with Face Labels, Rear View')
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Set coefficients c = 1, a = 0, f = 0.5, and d = 1.

c = 1;
a = 0;
f = 0.5;
d = 1;

Generate a mesh for the model.

generateMesh(model);

Create initial conditions and boundary conditions. The boundary condition for the rear
face is Dirichlet with value 0. All other faces have the default boundary condition. The
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initial condition is u(0) = 0, du/dt(0) = x/2. Give the initial condition on the
derivative by calculating the x-position of each node in xpts, and passing x/2.

applyBoundaryCondition(model,'Face',4,'u',0);
u0 = 0;
xpts = model.Mesh.Nodes(1,:);
ut0 = xpts(:)/2;

Create the associated finite element matrices.

[Kc,Fc,B,ud] = assempde(model,c,a,f);
[~,M,~] = assema(model,0,d,f);

Use a damping matrix that is 10% of the mass matrix.

Damping = 0.1*M;

Solve the PDE for times from 0 to 2.

tlist = linspace(0,5,50);
u = hyperbolic(u0,ut0,tlist,Kc,Fc,B,ud,M,'DampingMatrix',Damping);

1441 successful steps
70 failed attempts
2844 function evaluations
1 partial derivatives
288 LU decompositions
2843 solutions of linear systems

Plot the maximum value at each time. The oscillations damp slightly as time increases.

plot(max(u))
xlabel('Time')
ylabel('Maximum value')
title('Maximum of Solution')
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Input Arguments
u0 — Initial condition
vector | character vector | character array | string scalar | string vector

Initial condition, specified as a scalar, vector of nodal values, character vector, character
array, string scalar, or string vector. The initial condition is the value of the solution u at
the initial time, specified as a column vector of values at the nodes. The nodes are either
p in the [p,e,t] data structure, or are model.Mesh.Nodes. For details, see “Solve
PDEs with Initial Conditions” on page 2-161.
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• If the initial condition is a constant scalar v, specify u0 as v.
• If there are Np nodes in the mesh, and N equations in the system of PDEs, specify u0

as a column vector of Np*N elements, where the first Np elements correspond to the
first component of the solution u, the second Np elements correspond to the second
component of the solution u, etc.

• Give a text expression of a function, such as 'x.^2 + 5*cos(x.*y)'. If you have a
system of N > 1 equations, give a text array such as

char('x.^2 + 5*cos(x.*y)',...
    'tanh(x.*y)./(1+z.^2)')

Example: x.^2+5*cos(y.*x)
Data Types: double | char | string
Complex Number Support: Yes

ut0 — Initial derivative
vector | character vector | character array | string scalar | string vector

Initial derivative, specified as a vector, character vector, character array, string scalar, or
string vector. The initial gradient is the value of the derivative of the solution u at the
initial time, specified as a vector of values at the nodes. The nodes are either p in the
[p,e,t] data structure, or are model.Mesh.Nodes. See “Solve PDEs with Initial
Conditions” on page 2-161.

• If the initial derivative is a constant value v, specify u0 as v.
• If there are Np nodes in the mesh, and N equations in the system of PDEs, specify ut0

as a vector of Np*N elements, where the first Np elements correspond to the first
component of the solution u, the second Np elements correspond to the second
component of the solution u, etc.

• Give a text expression of a function, such as 'x.^2 + 5*cos(x.*y)'. If you have a
system of N > 1 equations, use a text array such as

char('x.^2 + 5*cos(x.*y)',...
    'tanh(x.*y)./(1+z.^2)')

For details, see “Solve PDEs with Initial Conditions” on page 2-161.
Example: p(1,:).^2+5*cos(p(2,:).*p(1,:))
Data Types: double | char | string
Complex Number Support: Yes
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tlist — Solution times
real vector

Solution times, specified as a real vector. The solver returns the solution to the PDE at the
solution times.
Example: 0:0.2:4
Data Types: double

model — PDE model
PDEModel object

PDE model, specified as a PDEModel object.
Example: model = createpde

c — PDE coefficient
scalar | matrix | character vector | character array | string scalar | string vector |
coefficient function

PDE coefficient, specified as a scalar, matrix, character vector, character array, string
scalar, string vector, or coefficient function. c represents the c coefficient in the scalar
PDE

d∂
2u
∂t2 − ∇ ⋅ c∇u + au = f

or in the system of PDEs

d∂
2u
∂t2 − ∇ ⋅ c⊗ ∇u + au = f

You can specifyc in various ways, detailed in “c Coefficient for Systems” on page 2-122.
See also “Specify Scalar PDE Coefficients in Character Form” on page 2-74, “Specify 2-D
Scalar Coefficients in Function Form” on page 2-80, and “Specify 3-D PDE Coefficients in
Function Form” on page 2-83.
Example: 'cosh(x+y.^2)'
Data Types: double | char | string | function_handle
Complex Number Support: Yes
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a — PDE coefficient
scalar | matrix | character vector | character array | string scalar | string vector |
coefficient function

PDE coefficient, specified as a scalar, matrix, character vector, character array, string
scalar, string vector, or coefficient function. a represents the a coefficient in the scalar
PDE

d∂
2u
∂t2 − ∇ ⋅ c∇u + au = f

or in the system of PDEs

d∂
2u
∂t2 − ∇ ⋅ c⊗ ∇u + au = f

There are a wide variety of ways of specifying a, detailed in “a or d Coefficient for
Systems” on page 2-147. See also “Specify Scalar PDE Coefficients in Character Form” on
page 2-74, “Specify 2-D Scalar Coefficients in Function Form” on page 2-80, and “Specify
3-D PDE Coefficients in Function Form” on page 2-83.
Example: 2*eye(3)
Data Types: double | char | string | function_handle
Complex Number Support: Yes

f — PDE coefficient
scalar | matrix | character vector | character array | string scalar | string vector |
coefficient function

PDE coefficient, specified as a scalar, matrix, character vector, character array, string
scalar, string vector, or coefficient function. f represents the f coefficient in the scalar
PDE

d∂
2u
∂t2 − ∇ ⋅ c∇u + au = f

or in the system of PDEs

d∂
2u
∂t2 − ∇ ⋅ c⊗ ∇u + au = f

 hyperbolic

5-431



You can specifyf in various ways, detailed in “f Coefficient for Systems” on page 2-94. See
also “Specify Scalar PDE Coefficients in Character Form” on page 2-74, “Specify 2-D
Scalar Coefficients in Function Form” on page 2-80, and “Specify 3-D PDE Coefficients in
Function Form” on page 2-83.
Example: char('sin(x)';'cos(y)';'tan(z)')
Data Types: double | char | string | function_handle
Complex Number Support: Yes

d — PDE coefficient
scalar | matrix | character vector | character array | string scalar | string vector |
coefficient function

PDE coefficient, specified as a scalar, matrix, character vector, character array, string
scalar, string vector, or coefficient function. d represents the d coefficient in the scalar
PDE

d∂
2u
∂t2 − ∇ ⋅ c∇u + au = f

or in the system of PDEs

d∂
2u
∂t2 − ∇ ⋅ c⊗ ∇u + au = f

You can specifyd in various ways, detailed in “a or d Coefficient for Systems” on page 2-
147. See also “Specify Scalar PDE Coefficients in Character Form” on page 2-74, “Specify
2-D Scalar Coefficients in Function Form” on page 2-80, and “Specify 3-D PDE
Coefficients in Function Form” on page 2-83.
Example: 2*eye(3)
Data Types: double | char | string | function_handle
Complex Number Support: Yes

b — Boundary conditions
boundary matrix | boundary file

Boundary conditions, specified as a boundary matrix or boundary file. Pass a boundary file
as a function handle or as a file name.
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• A boundary matrix is generally an export from the PDE Modeler app. For details of the
structure of this matrix, see “Boundary Matrix for 2-D Geometry” on page 2-168.

• A boundary file is a file that you write in the syntax specified in “Boundary Conditions
by Writing Functions” on page 2-197.

Example: b = 'circleb1', b = "circleb1", or b = @circleb1
Data Types: double | char | string | function_handle

p — Mesh points
matrix

Mesh points, specified as a 2-by-Np matrix of points, where Np is the number of points in
the mesh. For a description of the (p,e,t) matrices, see “Mesh Data” on page 2-233.

Typically, you use the p, e, and t data exported from the PDE Modeler app, or generated
by initmesh or refinemesh.
Example: [p,e,t] = initmesh(gd)
Data Types: double

e — Mesh edges
matrix

Mesh edges, specified as a 7-by-Ne matrix of edges, where Ne is the number of edges in
the mesh. For a description of the (p,e,t) matrices, see “Mesh Data” on page 2-233.

Typically, you use the p, e, and t data exported from the PDE Modeler app, or generated
by initmesh or refinemesh.
Example: [p,e,t] = initmesh(gd)
Data Types: double

t — Mesh triangles
matrix

Mesh triangles, specified as a 4-by-Nt matrix of triangles, where Nt is the number of
triangles in the mesh. For a description of the (p,e,t) matrices, see “Mesh Data” on page
2-233.

Typically, you use the p, e, and t data exported from the PDE Modeler app, or generated
by initmesh or refinemesh.
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Example: [p,e,t] = initmesh(gd)
Data Types: double

Kc — Stiffness matrix
sparse matrix | full matrix

Stiffness matrix, specified as a sparse matrix or as a full matrix. See “Elliptic Equations”
on page 5-77. Typically, Kc is the output of assempde.

Fc — Load vector
vector

Load vector, specified as a vector. See “Elliptic Equations” on page 5-77. Typically, Fc is
the output of assempde.

B — Dirichlet nullspace
sparse matrix

Dirichlet nullspace, returned as a sparse matrix. See “Algorithms” on page 5-77. Typically,
B is the output of assempde.

ud — Dirichlet vector
vector

Dirichlet vector, returned as a vector. See “Algorithms” on page 5-77. Typically, ud is the
output of assempde.

M — Mass matrix
sparse matrix | full matrix

Mass matrix. specified as a sparse matrix or a full matrix. See “Elliptic Equations” on
page 5-77.

To obtain the input matrices for pdeeig, hyperbolic or parabolic, run both assema
and assempde:

[Kc,Fc,B,ud] = assempde(model,c,a,f);
[~,M,~] = assema(model,0,d,f);

Note Create the M matrix using assema with d, not a, as the argument before f.
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Data Types: double
Complex Number Support: Yes

rtol — Relative tolerance for ODE solver
1e-3 (default) | positive real

Relative tolerance for ODE solver, specified as a positive real.
Example: 2e-4
Data Types: double

atol — Absolute tolerance for ODE solver
1e-6 (default) | positive real

Absolute tolerance for ODE solver, specified as a positive real.
Example: 2e-7
Data Types: double

D — Damping matrix
matrix

Damping matrix, specified as a matrix. D has the same size as the stiffness matrix Kc or
the mass matrix M. When you include D, hyperbolic solves the following ODE for the
variable v:

BTMBd2v
dt2 + BTDBdv

dt + Kv = F

with initial condition u0 and initial derivative ut0. Then hyperbolic returns the solution
u = B*v + ud.

For an example using D, see “Dynamics of Damped Cantilever Beam”.
Example: alpha*M + beta*K
Data Types: double
Complex Number Support: Yes
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Output Arguments
u — PDE solution
matrix

PDE solution, returned as a matrix. The matrix is Np*N-by-T, where Np is the number of
nodes in the mesh, N is the number of equations in the PDE (N = 1 for a scalar PDE), and
T is the number of solution times, meaning the length of tlist. The solution matrix has
the following structure.

• The first Np elements of each column in u represent the solution of equation 1, then
next Np elements represent the solution of equation 2, etc. The solution u is the value
at the corresponding node in the mesh.

• Column i of u represents the solution at time tlist(i).

To obtain the solution at an arbitrary point in the geometry, use pdeInterpolant.

To plot the solution, use pdeplot for 2-D geometry, or see “Plot 3-D Solutions and Their
Gradients” on page 3-295.

Algorithms
Hyperbolic Equations
Partial Differential Equation Toolbox solves equations of the form

m∂
2u
∂t2 + d∂u∂t − ∇ · c∇u + au = f

When the d coefficient is 0, but m is not, the documentation calls this a hyperbolic
equation, whether or not it is mathematically of the hyperbolic form.

Using the same ideas as for the parabolic equation, hyperbolic implements the
numerical solution of

m∂
2u
∂t2 − ∇ ⋅ c∇u + au = f

for x in Ω, where x represents a 2-D or 3-D point, with the initial conditions
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u x, 0 = u0 x
∂u
∂t x, 0 = v0 x

for all x in Ω, and usual boundary conditions. In particular, solutions of the equation utt -
cΔu = 0 are waves moving with speed c.

Using a given mesh of Ω, the method of lines yields the second order ODE system

Md2U
dt2 + KU = F

with the initial conditions

Ui 0 = u0 xi ∀i
d
dtUi 0 = v0 xi ∀i

after we eliminate the unknowns fixed by Dirichlet boundary conditions. As before, the
stiffness matrix K and the mass matrix M are assembled with the aid of the function
assempde from the problems

–∇ · (c∇u) + au = f and –∇ · (0∇u) + mu = 0.  (5-10)

hyperbolic internally calls assema, assemb, and assempde to create finite element
matrices corresponding to the problem. It calls ode15s to solve the resulting system of
ordinary differential equations.

Finite Element Basis for 3-D
The finite element method for 3-D geometry is similar to the 2-D method described in
“Elliptic Equations” on page 5-77. The main difference is that the elements in 3-D
geometry are tetrahedra, which means that the basis functions are different from those in
2-D geometry.

It is convenient to map a tetrahedron to a canonical tetrahedron with a local coordinate
system (r,s,t).
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r s

t

p1

p2 p3

p4

In local coordinates, the point p1 is at (0,0,0), p2 is at (1,0,0), p3 is at (0,1,0), and p4 is at
(0,0,1).

For a linear tetrahedron, the basis functions are

ϕ1 = 1 − r − s− t
ϕ2 = r
ϕ3 = s
ϕ4 = t

For a quadratic tetrahedron, there are additional nodes at the edge midpoints.
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r s

t

p1

p2 p3

p4

p5

p6

p7

p8
p9 p10

The corresponding basis functions are

ϕ1 = 2 1 − r − s− t 2− 1 − r − s− t

ϕ2 = 2r2− r

ϕ3 = 2s2− s

ϕ4 = 2t2− t
ϕ5 = 4r 1 − r − s− t

ϕ6 = 4rs
ϕ7 = 4s 1 − r − s− t
ϕ8 = 4t 1 − r − s− t

ϕ9 = 4rt
ϕ10 = 4st

As in the 2-D case, a 3-D basis function ϕi takes the value 0 at all nodes j, except for node
i, where it takes the value 1.

Systems of PDEs
Partial Differential Equation Toolbox software can also handle systems of N partial
differential equations over the domain Ω. We have the elliptic system
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−∇ ⋅ c⊗ ∇u + au = f

the parabolic system

d∂u∂t − ∇ ⋅ c⊗ ∇u + au = f

the hyperbolic system

d∂
2u
∂t2 − ∇ ⋅ c⊗ ∇u + au = f

and the eigenvalue system

−∇ ⋅ c⊗ ∇u + au = λdu

where c is an N-by-N-by-D-by-D tensor, and D is the geometry dimensions, 2 or 3.

For 2-D systems, the notation ∇ ⋅ (c⊗ ∇u) represents an N-by-1 matrix with an (i,1)-
component

∑
j = 1

N ∂
∂x ci, j, 1, 1

∂
∂x + ∂

∂x ci, j, 1, 2
∂
∂y + ∂

∂y ci, j, 2, 1
∂
∂x + ∂

∂y ci, j, 2, 2
∂
∂y u j

For 3-D systems, the notation ∇ ⋅ (c⊗ ∇u) represents an N-by-1 matrix with an (i,1)-
component

∑
j = 1

N ∂
∂x ci, j, 1, 1

∂
∂x + ∂

∂x ci, j, 1, 2
∂
∂y + ∂

∂x ci, j, 1, 3
∂
∂z u j

+ ∑
j = 1

N ∂
∂y ci, j, 2, 1

∂
∂x + ∂

∂y ci, j, 2, 2
∂
∂y + ∂

∂y ci, j, 2, 3
∂
∂z u j

+ ∑
j = 1

N ∂
∂z ci, j, 3, 1

∂
∂x + ∂

∂z ci, j, 3, 2
∂
∂y + ∂

∂z ci, j, 3, 3
∂
∂z u j

The symbols a and d denote N-by-N matrices, and f denotes a column vector of length N.

The elements cijkl, aij, dij, and fi of c, a, d, and f are stored row-wise in the MATLAB
matrices c, a, d, and f. The case of identity, diagonal, and symmetric matrices are
handled as special cases. For the tensor cijkl this applies both to the indices i and j, and to
the indices k and l.
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Partial Differential Equation Toolbox software does not check the ellipticity of the
problem, and it is quite possible to define a system that is not elliptic in the mathematical
sense. The preceding procedure that describes the scalar case is applied to each
component of the system, yielding a symmetric positive definite system of equations
whenever the differential system possesses these characteristics.

The boundary conditions now in general are mixed, i.e., for each point on the boundary a
combination of Dirichlet and generalized Neumann conditions,

hu = r
n · c⊗ ∇u + qu = g + h′μ

For 2-D systems, the notation n · c⊗ ∇u  represents an N-by-1 matrix with (i,1)-
component

∑
j = 1

N
cos(α)ci, j, 1, 1

∂
∂x + cos(α)ci, j, 1, 2

∂
∂y + sin(α)ci, j, 2, 1

∂
∂x + sin(α)ci, j, 2, 2

∂
∂y u j

where the outward normal vector of the boundary is n = cos(α), sin(α) .

For 3-D systems, the notation n · c⊗ ∇u  represents an N-by-1 matrix with (i,1)-
component

∑
j = 1

N
cos(α)ci, j, 1, 1

∂
∂x + cos(α)ci, j, 1, 2

∂
∂y + cos(α)ci, j, 1, 3

∂
∂z u j

+ ∑
j = 1

N
cos(β)ci, j, 2, 1

∂
∂x + cos(β)ci, j, 2, 2

∂
∂y + cos(β)ci, j, 2, 3

∂
∂z u j

+ ∑
j = 1

N
cos(γ)ci, j, 3, 1

∂
∂x + cos(γ)ci, j, 3, 2

∂
∂y + cos(γ)ci, j, 3, 3

∂
∂z u j

where the outward normal to the boundary is

n = cos α , cos β , cos γ

There are M Dirichlet conditions and the h-matrix is M-by-N, M ≥ 0. The generalized
Neumann condition contains a source h′μ, where the Lagrange multipliers μ are
computed such that the Dirichlet conditions become satisfied. In a structural mechanics
problem, this term is exactly the reaction force necessary to satisfy the kinematic
constraints described by the Dirichlet conditions.
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The rest of this section details the treatment of the Dirichlet conditions and may be
skipped on a first reading.

Partial Differential Equation Toolbox software supports two implementations of Dirichlet
conditions. The simplest is the “Stiff Spring” model, so named for its interpretation in
solid mechanics. See “Elliptic Equations” on page 5-77 for the scalar case, which is
equivalent to a diagonal h-matrix. For the general case, Dirichlet conditions

hu = r  (5-11)

are approximated by adding a term

L(h′hu− h′r)

to the equations KU = F, where L is a large number such as 104 times a representative
size of the elements of K.

When this number is increased, hu = r will be more accurately satisfied, but the potential
ill-conditioning of the modified equations will become more serious.

The second method is also applicable to general mixed conditions with nondiagonal h,
and is free of the ill-conditioning, but is more involved computationally. Assume that there
are Np nodes in the mesh. Then the number of unknowns is NpN = Nu. When Dirichlet
boundary conditions fix some of the unknowns, the linear system can be correspondingly
reduced. This is easily done by removing rows and columns when u values are given, but
here we must treat the case when some linear combinations of the components of u are
given, hu = r. These are collected into HU = R where H is an M-by-Nu matrix and R is an
M-vector.

With the reaction force term the system becomes

KU +H´ µ = F  (5-12)

HU = R.  (5-13)

The constraints can be solved for M of the U-variables, the remaining called V, an Nu – M
vector. The null space of H is spanned by the columns of B, and U = BV + ud makes U
satisfy the Dirichlet conditions. A permutation to block-diagonal form exploits the sparsity
of H to speed up the following computation to find B in a numerically stable way. µ can be
eliminated by pre-multiplying by B´ since, by the construction, HB = 0 or B´H´ = 0. The
reduced system becomes

B´ KBV = B´ F – B´Kud  (5-14)
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which is symmetric and positive definite if K is.

See Also
solvepde

Introduced before R2006a
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importGeometry
Package: pde

Import geometry from STL data

Syntax
importGeometry(model,geometryfile)
gd = importGeometry(model,geometryfile)

Description
importGeometry(model,geometryfile) creates a geometry container from the
specified STL geometry file, and includes the geometry in the model container.

gd = importGeometry(model,geometryfile) also returns the geometry to the
MATLAB workspace.

Examples

Import 3-D Geometry into PDE Container

Import STL geometry into a PDE model.

Create a PDEModel container for a system of three equations.

model = createpde(3);

Import geometry into the container.

importGeometry(model,'ForearmLink.stl');

View the geometry with face labels.

pdegplot(model,'FaceLabels','on')
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Import Planar Geometry into PDE Container

Import a planar STL geometry into a PDE model. When importing a planar geometry,
importGeometry converts it to a 2-D geometry by mapping it to the X-Y plane.

Create a PDEModel container.

model = createpde;

Import geometry into the container.

importGeometry(model,'PlateHolePlanar.stl')
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ans = 
  DiscreteGeometry with properties:

       NumCells: 0
       NumFaces: 1
       NumEdges: 5
    NumVertices: 5

View the geometry with edge labels.

pdegplot(model,'EdgeLabels','on')
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Input Arguments
model — Model object
PDEModel object | ThermalModel object | StructuralModel object

Model object, specified as a PDEModel object, ThermalModel object, or
StructuralModel object.
Example: model = createpde(1)
Example: thermalmodel = createpde('thermal','steadystate')
Example: structuralmodel = createpde('structural','static-solid')

geometryfile — Path to STL file
character vector | string scalar

Path to STL file, specified as a character vector or a string scalar ending with the file
extension .stl or .STL.
Example: '../geometries/Carburetor.stl'
Data Types: char | string

Output Arguments
gd — Geometry description
DiscreteGeometry object

Geometry description, returned as a DiscreteGeometry object. See DiscreteGeometry
for details.

Limitations
• importGeometry does not allow you to import a multidomain 3-D geometry unless all

of its subdomains are separate. In other words, the subdomains of the geometry
cannot have any common points. Because of this limitation, you cannot import nested
3-D geometries directly. As a workaround, you can import a mesh and then create a
multidomain geometry from the mesh by using the geometryFromMesh function.
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Tips
• STL format approximates the boundary of a CAD geometry by a collection of triangles,

and importGeometry reconstructs the faces and edges from this data.
Reconstruction from STL data is not precise and can result in a loss of edges and,
therefore, the merging of adjacent faces. Typically, lost edges are the edges between
two adjacent faces meeting at a small angle, or smooth edges bounding blend
surfaces. Usually, the loss of such edges does not affect the analysis workflow.

See Also
DiscreteGeometry | PDEModel | geometryFromMesh | pdegplot

Topics
“STL File Import” on page 2-46
“Solve Problems Using PDEModel Objects” on page 2-6

Introduced in R2015a
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initmesh
Create initial 2-D mesh

Note This page describes the legacy workflow. New features might not be compatible
with the legacy workflow. For the corresponding step in the recommended workflow, see
generateMesh.

Syntax
[p,e,t] = initmesh(g)

[p,e,t] = initmesh(g,'PropertyName',PropertyValue,...)

Description
[p,e,t] = initmesh(g) returns a triangular mesh using the 2-D geometry
specification g. initmesh uses a Delaunay triangulation algorithm. The mesh size is
determined from the shape of the geometry and from name-value pair settings.

g describes the geometry of the PDE problem. g can be a Decomposed Geometry matrix,
the name of a Geometry file, or a function handle to a Geometry file. For details, see
“Geometry”.

The outputs p, e, and t are the mesh data.

In the Point matrix p, the first and second rows contain x- and y-coordinates of the points
in the mesh.

In the Edge matrix e, the first and second rows contain indices of the starting and ending
point, the third and fourth rows contain the starting and ending parameter values, the
fifth row contains the edge segment number, and the sixth and seventh row contain the
left- and right-hand side subdomain numbers.

In the Triangle matrix t, the first three rows contain indices to the corner points, given in
counter clockwise order, and the fourth row contains the subdomain number.
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initmesh accepts the following name/value pairs.

Name Value Default Description
Hmax numeric estimate Maximum edge size
Hgrad numeric, strictly

between 1 and 2
1.3 Mesh growth rate

Box 'on' | 'off' 'off' Preserve bounding box
Init 'on' | 'off' 'off' Edge triangulation
Jiggle 'off' | 'mean'

| 'minimum' |
'on'

'mean' Call jigglemesh after
creating the mesh, with the
Opt name-value pair set to the
stated value. Exceptions:
'off' means do not call
jigglemesh, and 'on' means
call jigglemesh with Opt =
'off'.

JiggleIter numeric 10 Maximum iterations
MesherVersion 'R2013a' |

'preR2013a'
'preR2013a' Algorithm for generating initial

mesh

The Hmax property controls the size of the triangles on the mesh. initmesh creates a
mesh where triangle edge lengths are approximately Hmax or less.

The Hgrad property determines the mesh growth rate away from a small part of the
geometry. The default value is 1.3, i.e., a growth rate of 30%. Hgrad cannot be equal to
either of its bounds, 1 and 2.

Both the Box and Init property are related to the way the mesh algorithm works. By
turning on Box you can get a good idea of how the mesh generation algorithm works
within the bounding box. By turning on Init you can see the initial triangulation of the
boundaries. By using the command sequence

[p,e,t] = initmesh(dl,'hmax',inf,'init','on'); 
[uxy,tn,a2,a3] = tri2grid(p,t,zeros(size(p,2)),x,y); 
n = t(4,tn); 

you can determine the subdomain number n of the point xy. If the point is outside the
geometry, tn is NaN and the command n = t(4,tn) results in a failure.
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The Jiggle property is used to control whether jiggling of the mesh should be attempted
(see jigglemesh for details). Jiggling can be done until the minimum or the mean of the
quality of the triangles decreases. JiggleIter can be used to set an upper limit on the
number of iterations.

The MesherVersion property chooses the algorithm for mesh generation. The 'R2013a'
algorithm runs faster, and can triangulate more geometries than the 'preR2013a'
algorithm. Both algorithms use Delaunay triangulation.

Examples
Make a simple triangular mesh of the L-shaped membrane in the PDE Modeler app.
Before you do anything in the PDE Modeler app, set the Maximum edge size to inf in
the Mesh Parameters dialog box. You open the dialog box by selecting the Parameters
option from the Mesh menu. Also select the items Show Node Labels and Show
Triangle Labels in the Mesh menu. Then create the initial mesh by pressing the Δ
button. (This can also be done by selecting the Initialize Mesh option from the Mesh
menu.)

The following figure appears.
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The corresponding mesh data structures can be exported to the main workspace by
selecting the Export Mesh option from the Mesh menu.

p
p =
   -1    1   1   0   0   -1
   -1   -1   1   1   0    0

e
e =
   1   2   3   4   5   6
   2   3   4   5   6   1
   0   0   0   0   0   0
   1   1   1   1   1   1
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   1   2   3   4   5   6
   1   1   1   1   1   1
   0   0   0   0   0   0

t
t =
   1   2   3   1
   2   3   4   5
   5   5   5   6
   1   1   1   1

References
George, P. L., Automatic Mesh Generation — Application to Finite Element Methods,
Wiley, 1991.

See Also
decsg | jigglemesh | refinemesh

Topics
“Mesh Data” on page 2-233

Introduced before R2006a
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internalHeatSource
Package: pde

Specify internal heat source for a thermal model

Syntax
internalHeatSource(thermalmodel,heatSourceValue)
internalHeatSource(thermalmodel,heatSourceValue,RegionType,RegionID)
heatSource = internalHeatSource( ___ )

Description
internalHeatSource(thermalmodel,heatSourceValue) specifies an internal heat
source for the thermal model. This syntax declares that the entire geometry is a heat
source.

Note Use internalHeatSource for specifying internal heat generators, that is, for
specifying heat sources that belong to the geometry of the model. To specify a heat influx
from an external source, use the thermalBC function with the HeatFlux parameter.

internalHeatSource(thermalmodel,heatSourceValue,RegionType,RegionID)
specifies geometry regions of type RegionType with ID numbers in RegionID as heat
sources. Always specify heatSourceValue first, then specify RegionType and
RegionID.

heatSource = internalHeatSource( ___ ) returns the heat source object.

Examples
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Specify Internal Heat Generation on Entire Geometry

Create a transient thermal model.

thermalmodel = createpde('thermal','transient');

Import the geometry.

gm = importGeometry(thermalmodel,'SquareBeam.STL');

Set thermal conductivity to 0.2, mass density to 2700e-9, and specific heat to 920.

thermalProperties(thermalmodel,'ThermalConductivity',0.2, ...
                               'MassDensity',2700e-9, ...
                               'SpecificHeat',920)

ans = 
  ThermalMaterialAssignment with properties:

             RegionType: 'cell'
               RegionID: 1
    ThermalConductivity: 0.2000
            MassDensity: 2.7000e-06
           SpecificHeat: 920

Specify that the entire geometry generates heat at the rate 2e-4.

internalHeatSource(thermalmodel,2e-4)

ans = 
  HeatSourceAssignment with properties:

    RegionType: 'cell'
      RegionID: 1
    HeatSource: 2.0000e-04

Specify a Face of a 2-D Geometry as a Heat Source

Create a steady-state thermal model.

thermalModel = createpde('thermal','transient');
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Create the geometry.

SQ1 = [3; 4; 0; 3; 3; 0; 0; 0; 3; 3];
D1 = [2; 4; 0.5; 1.5; 2.5; 1.5; 1.5; 0.5; 1.5; 2.5];
gd = [SQ1 D1];
sf = 'SQ1+D1';
ns = char('SQ1','D1');
ns = ns';
dl = decsg(gd,sf,ns);

geometryFromEdges(thermalModel,dl);

Set thermal conductivity to 50, mass density to 2500, and specific heat to 600.

thermalProperties(thermalModel,'ThermalConductivity',50, ...
                               'MassDensity',2500, ...
                               'SpecificHeat',600);

Specify that face 1 generates heat at 25.

internalHeatSource(thermalModel,25,'Face',1)

ans = 
  HeatSourceAssignment with properties:

    RegionType: 'face'
      RegionID: 1
    HeatSource: 25

Specify Nonconstant Internal Heat Source

Use a function handle to specify an internal heat source that depends on coordinates.

Create a thermal model for transient analysis and include the geometry. The geometry is
a rod with a circular cross section. The 2-D model is a rectangular strip whose y-
dimension extends from the axis of symmetry to the outer surface, and whose x-dimension
extends over the actual length of the rod.

thermalmodel = createpde('thermal','transient');
g = decsg([3 4 -1.5 1.5 1.5 -1.5 0 0 .2 .2]');
geometryFromEdges(thermalmodel,g);
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The heat is generated within the rod due to the radioactive decay. Therefore, the entire
geometry is an internal nonlinear heat source and can be represented by a function of the
y-coordinate, for example, q = 2000y.

q = @(location,state)2000*location.y;

Specify the internal heat source for the transient model.

internalHeatSource(thermalmodel,q)

ans = 
  HeatSourceAssignment with properties:

    RegionType: 'face'
      RegionID: 1
    HeatSource: @(location,state)2000*location.y

Input Arguments
thermalmodel — Thermal model
ThermalModel object

Thermal model, specified as a ThermalModel object. The model contains the geometry,
mesh, thermal properties of the material, internal heat source, boundary conditions, and
initial conditions.
Example: thermalmodel = createpde('thermal','steadystate')

RegionType — Geometric region type
'Face' | 'Cell'

Geometric region type, specified as 'Face' for a 2-D model or 'Cell' for a 3-D model.
Example: internalHeatSource(thermalmodel,25,'Cell',1)
Data Types: char | string

RegionID — Geometric region ID
vector of positive integers
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Geometric region ID, specified as a vector of positive integers. Find the region IDs using
pdegplot, as shown in “Create Geometry and Remove Face Boundaries” on page 2-13 or
“STL File Import” on page 2-46.
Example: internalHeatSource(thermalmodel,25,'Cell',1:3)
Data Types: double

heatSourceValue — Heat source value
number | function handle

Heat source value, specified as a number or a function handle. Use a function handle to
specify the internal heat source that depends on space, time, or temperature. The
function must be of the form

heatSourceValue = heatSourceFun(location,state)

The solver passes location data as a structure array with the fields location.x,
location.y, and, for 3-D problems, location.z. The state data is a structure array
with the fields state.u, state.ux, state.uy, state.uz (for 3-D problems), and
state.time (for transient problems). The state.u field contains the solution vector.
The state.ux, state.uy, state.uz fields are estimates of the solution’s partial
derivatives at the corresponding points of the location structure. The state.time field
contains time at evaluation points.

heatSourceFun must return a row vector heatSourceValue with the number of
columns equal to the number of evaluation points, M = length(location.x).
Example: internalHeatSource(thermalmodel,25)
Data Types: double | function_handle

Output Arguments
heatSource — Handle to heat source
object

Handle to heat source, returned as an object. heatSourceValue associates the heat
source value with the geometric region.

See Also
thermalBC | thermalProperties
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Introduced in R2017a
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interpolateAcceleration
Package: pde

Interpolate acceleration at arbitrary spatial locations for all time steps for transient
structural model

Syntax
intrpAccel = interpolateAcceleration(structuralresults,xq,yq)
intrpAccel = interpolateAcceleration(structuralresults,xq,yq,zq)
intrpAccel = interpolateAcceleration(structuralresults,querypoints)

Description
intrpAccel = interpolateAcceleration(structuralresults,xq,yq) returns
the interpolated acceleration values at the 2-D points specified in xq and yq for all time-
steps.

intrpAccel = interpolateAcceleration(structuralresults,xq,yq,zq) uses
the 3-D points specified in xq, yq, and zq.

intrpAccel = interpolateAcceleration(structuralresults,querypoints)
uses the points specified in querypoints.

Examples

Interpolate Acceleration for 3-D Structural Dynamic Problem

Interpolate acceleration at the geometric center of a beam under a harmonic excitation

Create a transient dynamic model for a 3-D problem.

structuralmodel = createpde('structural','transient-solid');
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Create the geometry and include it in the model. Plot the geometry.

gm = multicuboid(0.06,0.005,0.01);
structuralmodel.Geometry = gm;
pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.5)
view(50,20)

Specify the Young's modulus, Poisson's ratio, and mass density of the material.

structuralProperties(structuralmodel,'YoungsModulus',210E9, ...
                                     'PoissonsRatio',0.3, ...
                                     'MassDensity',7800);

Fix one end of the beam.
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structuralBC(structuralmodel,'Face',5,'Constraint','fixed');

Apply a sinusoidal displacement along the y-direction on the end opposite the fixed end of
the beam.

structuralBC(structuralmodel,'Face',3,'YDisplacement',1E-4,'Frequency',50);

Generate a mesh.

generateMesh(structuralmodel,'Hmax',0.01);

Specify the zero initial displacement and velocity.

structuralIC(structuralmodel,'Displacement',[0;0;0],'Velocity',[0;0;0]);

Solve the model.

tlist = 0:0.002:0.2;
structuralresults = solve(structuralmodel,tlist);

Interpolate acceleration at the geometric center of the beam.

coordsMidSpan = [0;0;0.005];
intrpAccel = interpolateAcceleration(structuralresults,coordsMidSpan);

Plot the y-component of acceleration of the geometric center of the beam.

figure
plot(structuralresults.SolutionTimes,intrpAccel.ay)
title('Y-Acceleration of the Geometric Center of the Beam')
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Input Arguments
structuralresults — Solution of dynamic structural analysis problem
TransientStructuralResults object

Solution of the dynamic structural analysis problem, specified as a
TransientStructuralResults object. Create structuralresults by using the
solve function.
Example: structuralresults = solve(structuralmodel,tlist)
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xq — x-coordinate query points
real array

x-coordinate query points, specified as a real array. interpolateAcceleration
evaluates accelerations at the 2-D coordinate points [xq(i),yq(i)] or at the 3-D
coordinate points [xq(i),yq(i),zq(i)]. Therefore, xq, yq, and (if present) zq must
have the same number of entries.

interpolateAcceleration converts the query points to column vectors xq(:),
yq(:), and (if present) zq(:). The function returns accelerations as a structure array
with fields of the same size as these column vectors. To ensure that the dimensions of the
returned solution are consistent with the dimensions of the original query points, use the
reshape function. For example, use intrpAccel =
reshape(intrpAccel.ux,size(xq)).
Data Types: double

yq — y-coordinate query points
real array

y-coordinate query points, specified as a real array. interpolateAcceleration
evaluates accelerations at the 2-D coordinate points [xq(i),yq(i)] or at the 3-D
coordinate points [xq(i),yq(i),zq(i)]. Therefore, xq, yq, and (if present) zq must
have the same number of entries. Internally, interpolateAcceleration converts the
query points to the column vector yq(:).
Data Types: double

zq — z-coordinate query points
real array

z-coordinate query points, specified as a real array. interpolateAcceleration
evaluates accelerations at the 3-D coordinate points [xq(i),yq(i),zq(i)]. Therefore,
xq, yq, and zq must have the same number of entries. Internally,
interpolateAcceleration converts the query points to the column vector zq(:).
Data Types: double

querypoints — Query points
real matrix

Query points, specified as a real matrix with either two rows for 2-D geometry or three
rows for 3-D geometry. interpolateAcceleration evaluates accelerations at the
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coordinate points querypoints(:,i), so each column of querypoints contains exactly
one 2-D or 3-D query point.
Example: For 2-D geometry, querypoints = [0.5,0.5,0.75,0.75; 1,2,0,0.5]
Data Types: double

Output Arguments
intrpAccel — Accelerations at query points
structure array

Accelerations at the query points, returned as a structure array with fields representing
spatial components of acceleration at the query points. For query points that are outside
the geometry, intrpAccel returns NaN.

See Also
StructuralModel | TransientStructuralResults | evaluatePrincipalStrain |
evaluatePrincipalStress | evaluateReaction | evaluateStrain |
evaluateStress | evaluateVonMisesStress | interpolateDisplacement |
interpolateStrain | interpolateStress | interpolateVelocity |
interpolateVonMisesStress

Introduced in R2018a
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interpolateDisplacement
Package: pde

Interpolate displacement at arbitrary spatial locations

Syntax
intrpDisp = interpolateDisplacement(structuralresults,xq,yq)
intrpDisp = interpolateDisplacement(structuralresults,xq,yq,zq)
intrpDisp = interpolateDisplacement(structuralresults,querypoints)

Description
intrpDisp = interpolateDisplacement(structuralresults,xq,yq) returns
the interpolated displacement values at the 2-D points specified in xq and yq. For a
structural dynamic model, interpolateDisplacement returns the interpolated
displacement values for all time-steps.

intrpDisp = interpolateDisplacement(structuralresults,xq,yq,zq) uses
3-D points specified in xq, yq, and zq.

intrpDisp = interpolateDisplacement(structuralresults,querypoints)
uses points specified in querypoints.

Examples

Interpolate Displacement for Plane-Strain Problem

Create a structural analysis model for a plane-strain problem.

structuralmodel = createpde('structural','static-planestrain');

Include the square geometry in the model. Plot the geometry.
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geometryFromEdges(structuralmodel,@squareg);
pdegplot(structuralmodel,'EdgeLabels','on')
axis equal

Specify the Young's modulus and Poisson's ratio.

structuralProperties(structuralmodel,'PoissonsRatio',0.3, ...
                                     'YoungsModulus',210E3);

Specify the x-component of the enforced displacement for edge 1.

structuralBC(structuralmodel,'XDisplacement',0.001,'Edge',1);

Specify that edge 3 is a fixed boundary.
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structuralBC(structuralmodel,'Constraint','fixed','Edge',3);

Generate a mesh and solve the problem.

generateMesh(structuralmodel);
structuralresults = solve(structuralmodel);

Create a grid and interpolate the x- and y-components of the displacement to the grid.

v = linspace(-1,1,21);
[X,Y] = meshgrid(v);
intrpDisp = interpolateDisplacement(structuralresults,X,Y);

Reshape the displacement components to the shape of the grid. Plot the displacement.

ux = reshape(intrpDisp.ux,size(X));
uy = reshape(intrpDisp.uy,size(Y));
quiver(X,Y,ux,uy)
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Interpolate Displacement for 3-D Static Structural Analysis Problem

Solve a static structural model representing a bimetallic cable under tension, and
interpolate the displacement on a cross-section of the cable.

Create a static structural model for solving a solid (3-D) problem.

structuralmodel = createpde('structural','static-solid');

Create the geometry and include it in the model. Plot the geometry.
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gm = multicylinder([0.01,0.015],0.05);
structuralmodel.Geometry = gm;
pdegplot(structuralmodel,'FaceLabels','on','CellLabels','on','FaceAlpha',0.5)

Specify the Young's modulus and Poisson's ratio for each metal.

structuralProperties(structuralmodel,'Cell',1,'YoungsModulus',110E9, ...
                                              'PoissonsRatio',0.28);
structuralProperties(structuralmodel,'Cell',2,'YoungsModulus',210E9, ...
                                              'PoissonsRatio',0.3);

Specify that faces 1 and 4 are fixed boundaries.

structuralBC(structuralmodel,'Face',[1,4],'Constraint','fixed');
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Specify the surface traction for faces 2 and 5.

structuralBoundaryLoad(structuralmodel,'Face',[2,5],'SurfaceTraction',[0;0;100]);

Generate a mesh and solve the problem.

generateMesh(structuralmodel);
structuralresults = solve(structuralmodel)

structuralresults = 
  StaticStructuralResults with properties:

      Displacement: [1x1 struct]
            Strain: [1x1 struct]
            Stress: [1x1 struct]
    VonMisesStress: [22306x1 double]
              Mesh: [1x1 FEMesh]

Define coordinates of a midspan cross-section of the cable.

[X,Y] = meshgrid(linspace(-0.015,0.015,50));
Z = ones(size(X))*0.025;

Interpolate the displacement and plot the result.

intrpDisp = interpolateDisplacement(structuralresults,X,Y,Z);
surf(X,Y,reshape(intrpDisp.uz,size(X)))
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Alternatively, you can specify the grid by using a matrix of query points.

querypoints = [X(:),Y(:),Z(:)]';
intrpDisp = interpolateDisplacement(structuralresults,querypoints);
surf(X,Y,reshape(intrpDisp.uz,size(X)))
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Interpolate Displacement for Transient Structural Analysis Problem

Interpolate the displacement at the geometric center of a beam under a harmonic
excitation.

Create a transient dynamic model for a 3-D problem.

structuralmodel = createpde('structural','transient-solid');

Create the geometry and include it in the model. Plot the geometry.
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gm = multicuboid(0.06,0.005,0.01);
structuralmodel.Geometry = gm;
pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.5)
view(50,20)

Specify the Young's modulus, Poisson's ratio, and mass density of the material.

structuralProperties(structuralmodel,'YoungsModulus',210E9, ...
                                     'PoissonsRatio',0.3, ...
                                     'MassDensity',7800);

Fix one end of the beam.

structuralBC(structuralmodel,'Face',5,'Constraint','fixed');
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Apply a sinusoidal displacement along the y-direction on the end opposite the fixed end of
the beam.

structuralBC(structuralmodel,'Face',3,'YDisplacement',1E-4,'Frequency',50);

Generate a mesh.

generateMesh(structuralmodel,'Hmax',0.01);

Specify the zero initial displacement and velocity.

structuralIC(structuralmodel,'Displacement',[0;0;0],'Velocity',[0;0;0]);

Solve the model.

tlist = 0:0.002:0.2;
structuralresults = solve(structuralmodel,tlist);

Interpolate the displacement at the geometric center of the beam.

coordsMidSpan = [0;0;0.005];
intrpDisp = interpolateDisplacement(structuralresults,coordsMidSpan);

Plot the y-component of displacement of the geometric center of the beam.

figure
plot(structuralresults.SolutionTimes,intrpDisp.uy)
title('y-Displacement of the Geometric Center of the Beam')
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Input Arguments
structuralresults — Solution of structural analysis problem
StaticStructuralResults object | TransientStructuralResults object

Solution of the structural analysis problem, specified as a StaticStructuralResults
or TransientStructuralResults object. Create structuralresults by using the
solve function. For a TransientStructuralResults object,
interpolateDisplacement returns the interpolated displacement values for all time-
steps.
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Example: structuralresults = solve(structuralmodel)

xq — x-coordinate query points
real array

x-coordinate query points, specified as a real array. interpolateDisplacement
evaluates the displacements at the 2-D coordinate points [xq(i),yq(i)] or at the 3-D
coordinate points [xq(i),yq(i),zq(i)]. Therefore, xq, yq, and (if present) zq must
have the same number of entries.

interpolateDisplacement converts query points to column vectors xq(:), yq(:),
and (if present) zq(:). The function returns displacements as a structure array with
fields of the same size as these column vectors. To ensure that the dimensions of the
returned solution are consistent with the dimensions of the original query points, use the
reshape function. For example, use intrpDisp =
reshape(intrpDisp.ux,size(xq)).
Data Types: double

yq — y-coordinate query points
real array

y-coordinate query points, specified as a real array. interpolateDisplacement
evaluates the displacements at the 2-D coordinate points [xq(i),yq(i)] or at the 3-D
coordinate points [xq(i),yq(i),zq(i)]. Therefore, xq, yq, and (if present) zq must
have the same number of entries. Internally, interpolateDisplacement converts
query points to the column vector yq(:).
Data Types: double

zq — z-coordinate query points
real array

z-coordinate query points, specified as a real array. interpolateDisplacement
evaluates the displacements at the 3-D coordinate points [xq(i),yq(i),zq(i)].
Therefore, xq, yq, and zq must have the same number of entries. Internally,
interpolateDisplacement converts query points to the column vector zq(:).
Data Types: double

querypoints — Query points
real matrix
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Query points, specified as a real matrix with either two rows for 2-D geometry or three
rows for 3-D geometry. interpolateDisplacement evaluates the displacements at the
coordinate points querypoints(:,i), so each column of querypoints contains exactly
one 2-D or 3-D query point.
Example: For 2-D geometry, querypoints = [0.5,0.5,0.75,0.75; 1,2,0,0.5]
Data Types: double

Output Arguments
intrpDisp — Displacements at query points
structure array

Displacements at the query points, returned as a structure array with fields representing
spatial components of displacement at the query points. For query points that are outside
the geometry, intrpDisp returns NaN.

See Also
StaticStructuralResults | StructuralModel | TransientStructuralResults |
evaluatePrincipalStrain | evaluatePrincipalStress | evaluateReaction |
evaluateStrain | evaluateStress | evaluateVonMisesStress |
interpolateAcceleration | interpolateStrain | interpolateStress |
interpolateVelocity | interpolateVonMisesStress

Introduced in R2017b
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interpolateSolution
Package: pde

Interpolate PDE solution to arbitrary points

Syntax
uintrp = interpolateSolution(results,xq,yq)
uintrp = interpolateSolution(results,xq,yq,zq)
uintrp = interpolateSolution(results,querypoints)

uintrp = interpolateSolution( ___ ,iU)

uintrp = interpolateSolution( ___ ,iT)

Description
uintrp = interpolateSolution(results,xq,yq) returns the interpolated values
of the solution to the scalar stationary equation specified in results at the 2-D points
specified in xq and yq.

uintrp = interpolateSolution(results,xq,yq,zq) returns the interpolated
values at the 3-D points specified in xq, yq, and zq.

uintrp = interpolateSolution(results,querypoints) returns the interpolated
values at the points in querypoints.

uintrp = interpolateSolution( ___ ,iU), for any previous syntax, returns the
interpolated values of the solution to the system of stationary equations for equation
indices iU.

uintrp = interpolateSolution( ___ ,iT) returns the interpolated values of the
solution to the time-dependent or eigenvalue equation or system of such equations at
times or modal indices iT. For a system of time-dependent or eigenvalue equations,
specify both time/modal indices iT and equation indices iU
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Examples

Interpolate Scalar Stationary Results

Interpolate the solution to a scalar problem along a line and plot the result.

Create the solution to the problem −Δu = 1 on the L-shaped membrane with zero
Dirichlet boundary conditions.

model = createpde;
geometryFromEdges(model,@lshapeg);
applyBoundaryCondition(model,'dirichlet','Edge',1:model.Geometry.NumEdges,'u',0);
specifyCoefficients(model,'m',0,...
                          'd',0,...
                          'c',1,...
                          'a',0,...
                          'f',1);
generateMesh(model,'Hmax',0.05);
results = solvepde(model);

Interpolate the solution along the straight line from (x,y) = (-1,-1) to (1,1). Plot
the interpolated solution.

xq = linspace(-1,1,101);
yq = xq;

uintrp = interpolateSolution(results,xq,yq);
plot(xq,uintrp)

xlabel('x')
ylabel('u(x)')
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Interpolate Solution of Poisson's Equation

Calculate the mean exit time of a Brownian particle from a region that contains absorbing
(escape) boundaries and reflecting boundaries. Use the Poisson's equation with constant
coefficients and 3-D rectangular block geometry to model this problem.

Create the solution for this problem.

model = createpde;
importGeometry(model,'Block.stl');
applyBoundaryCondition(model,'dirichlet','Face',[1,2,5],'u',0);
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specifyCoefficients(model,'m',0,...
                          'd',0,...
                          'c',1,...
                          'a',0,...
                          'f',2);
generateMesh(model);
results = solvepde(model);

Create a grid and interpolate the solution to the grid.

[X,Y,Z] = meshgrid(0:135,0:35,0:61);
uintrp = interpolateSolution(results,X,Y,Z);
uintrp = reshape(uintrp,size(X));

Create a contour slice plot for five fixed values of the y coordinate.

contourslice(X,Y,Z,uintrp,[],0:4:16,[])
colormap jet
xlabel('x')
ylabel('y')
zlabel('z')
xlim([0,100])
ylim([0,20])
zlim([0,50])
axis equal
view(-50,22)
colorbar
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Interpolate Scalar Stationary Results Using Query Matrix

Solve a scalar stationary problem and interpolate the solution to a dense grid.

Create the solution to the problem −Δu = 1 on the L-shaped membrane with zero
Dirichlet boundary conditions.

model = createpde;
geometryFromEdges(model,@lshapeg);
applyBoundaryCondition(model,'dirichlet','Edge',1:model.Geometry.NumEdges,'u',0);
specifyCoefficients(model,'m',0,'d',0,'c',1,'a',0,'f',1);
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generateMesh(model,'Hmax',0.05);
results = solvepde(model);

Interpolate the solution on the grid from –1 to 1 in each direction.

v = linspace(-1,1,101);
[X,Y] = meshgrid(v);
querypoints = [X(:),Y(:)]';
uintrp = interpolateSolution(results,querypoints);

Plot the resulting interpolation on a mesh.

uintrp = reshape(uintrp,size(X));
mesh(X,Y,uintrp)
xlabel('x')
ylabel('y')
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Interpolate Stationary System

Create the solution to a two-component system and plot the two components along a
planar slice through the geometry.

Create a PDE model for two components. Import the geometry of a torus.

model = createpde(2);
importGeometry(model,'Torus.stl');
pdegplot(model,'FaceLabels','on');
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Set boundary conditions.

gfun = @(region,state)[0,region.z-40];
applyBoundaryCondition(model,'neumann','Face',1,'g',gfun);
ufun = @(region,state)[region.x-40,0];
applyBoundaryCondition(model,'dirichlet','Face',1,'u',ufun);

Set the problem coefficients.

specifyCoefficients(model,'m',0,...
                          'd',0,...
                          'c',[1;0;1;0;0;1;0;0;1;0;1;0;1;0;0;1;0;1;0;0;1],...
                          'a',0,...
                          'f',[1;1]);
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Create a mesh and solve the problem.

generateMesh(model);
results = solvepde(model);

Interpolate the results on a plane that slices the torus for each of the two components.

[X,Z] = meshgrid(0:100);
Y = 15*ones(size(X));
uintrp = interpolateSolution(results,X,Y,Z,[1,2]);

Plot the two components.

sol1 = reshape(uintrp(:,1),size(X));
sol2 = reshape(uintrp(:,2),size(X));
figure
surf(X,Z,sol1)
title('Component 1')

 interpolateSolution

5-487



figure
surf(X,Z,sol2)
title('Component 2')
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Interpolate Scalar Eigenvalue Results

Solve a scalar eigenvalue problem and interpolate one eigenvector to a grid.

Find the eigenvalues and eigenvectors for the L-shaped membrane.

model = createpde(1);
geometryFromEdges(model,@lshapeg);
applyBoundaryCondition(model,'dirichlet','Edge',1:model.Geometry.NumEdges,'u',0);
specifyCoefficients(model,'m',0,...
                          'd',1,...
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                          'c',1,...
                          'a',0,...
                          'f',0);
r = [0,100];
generateMesh(model,'Hmax',1/50);
results = solvepdeeig(model,r);

              Basis= 10,  Time=   3.05,  New conv eig=  0
              Basis= 11,  Time=   3.13,  New conv eig=  0
              Basis= 12,  Time=   3.19,  New conv eig=  0
              Basis= 13,  Time=   3.34,  New conv eig=  0
              Basis= 14,  Time=   3.45,  New conv eig=  0
              Basis= 15,  Time=   3.50,  New conv eig=  0
              Basis= 16,  Time=   3.52,  New conv eig=  0
              Basis= 17,  Time=   3.55,  New conv eig=  0
              Basis= 18,  Time=   3.59,  New conv eig=  1
              Basis= 19,  Time=   3.64,  New conv eig=  1
              Basis= 20,  Time=   3.75,  New conv eig=  1
              Basis= 21,  Time=   3.80,  New conv eig=  1
              Basis= 22,  Time=   3.83,  New conv eig=  1
              Basis= 23,  Time=   4.06,  New conv eig=  4
              Basis= 24,  Time=   4.17,  New conv eig=  4
              Basis= 25,  Time=   4.27,  New conv eig=  5
              Basis= 26,  Time=   4.31,  New conv eig=  6
              Basis= 27,  Time=   4.33,  New conv eig=  6
              Basis= 28,  Time=   4.41,  New conv eig=  6
              Basis= 29,  Time=   4.47,  New conv eig=  6
              Basis= 30,  Time=   4.53,  New conv eig=  7
              Basis= 31,  Time=   4.58,  New conv eig=  9
              Basis= 32,  Time=   4.73,  New conv eig= 10
              Basis= 33,  Time=   4.77,  New conv eig= 11
              Basis= 34,  Time=   4.83,  New conv eig= 11
              Basis= 35,  Time=   4.92,  New conv eig= 14
              Basis= 36,  Time=   5.05,  New conv eig= 14
              Basis= 37,  Time=   5.20,  New conv eig= 14
              Basis= 38,  Time=   5.27,  New conv eig= 14
              Basis= 39,  Time=   5.28,  New conv eig= 14
              Basis= 40,  Time=   5.39,  New conv eig= 14
              Basis= 41,  Time=   5.42,  New conv eig= 15
              Basis= 42,  Time=   5.45,  New conv eig= 15
              Basis= 43,  Time=   5.48,  New conv eig= 15
              Basis= 44,  Time=   5.59,  New conv eig= 15
              Basis= 45,  Time=   5.77,  New conv eig= 16
              Basis= 46,  Time=   5.89,  New conv eig= 16
              Basis= 47,  Time=   6.03,  New conv eig= 16
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              Basis= 48,  Time=   6.13,  New conv eig= 16
              Basis= 49,  Time=   6.20,  New conv eig= 17
              Basis= 50,  Time=   6.30,  New conv eig= 18
              Basis= 51,  Time=   6.45,  New conv eig= 18
              Basis= 52,  Time=   6.61,  New conv eig= 18
              Basis= 53,  Time=   6.64,  New conv eig= 19
              Basis= 54,  Time=   6.77,  New conv eig= 20
              Basis= 55,  Time=   6.81,  New conv eig= 21
              Basis= 56,  Time=   6.86,  New conv eig= 22
End of sweep: Basis= 56,  Time=   6.88,  New conv eig= 22
              Basis= 32,  Time=   7.83,  New conv eig=  0
              Basis= 33,  Time=   7.88,  New conv eig=  0
              Basis= 34,  Time=   7.94,  New conv eig=  0
              Basis= 35,  Time=   7.98,  New conv eig=  0
              Basis= 36,  Time=   8.02,  New conv eig=  0
              Basis= 37,  Time=   8.06,  New conv eig=  0
              Basis= 38,  Time=   8.19,  New conv eig=  0
              Basis= 39,  Time=   8.25,  New conv eig=  0
              Basis= 40,  Time=   8.28,  New conv eig=  0
              Basis= 41,  Time=   8.34,  New conv eig=  0
              Basis= 42,  Time=   8.47,  New conv eig=  0
End of sweep: Basis= 42,  Time=   8.47,  New conv eig=  0

Interpolate the eigenvector corresponding to the fifth eigenvalue to a coarse grid and plot
the result.

[xq,yq] = meshgrid(-1:0.1:1);
uintrp = interpolateSolution(results,xq,yq,5);
uintrp = reshape(uintrp,size(xq));
surf(xq,yq,uintrp)
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Interpolate Time-Dependent System

Solve a system of time-dependent PDEs and interpolate the solution.

Import slab geometry for a 3-D problem with three solution components. Plot the
geometry.

model = createpde(3);
importGeometry(model,'Plate10x10x1.stl');
pdegplot(model,'FaceLabels','on','FaceAlpha',0.5)
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Set boundary conditions such that face 2 is fixed (zero deflection in any direction) and
face 5 has a load of 1e3 in the positive z-direction. This load causes the slab to bend
upward. Set the initial condition that the solution is zero, and its derivative with respect
to time is also zero.

applyBoundaryCondition(model,'dirichlet','Face',2,'u',[0,0,0]);
applyBoundaryCondition(model,'neumann','Face',5,'g',[0,0,1e3]);
setInitialConditions(model,0,0);

Create PDE coefficients for the equations of linear elasticity. Set the material properties
to be similar to those of steel. See 3-D Linear Elasticity Equations in Toolbox Form.

E = 200e9;
nu = 0.3;
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specifyCoefficients(model,'m',1,...
                          'd',0,...
                          'c',elasticityC3D(E,nu),...
                          'a',0,...
                          'f',[0;0;0]);

Generate a mesh, setting Hmax to 1.

generateMesh(model,'Hmax',1);

Solve the problem for times 0 through 5e-3 in steps of 1e-4.

tlist = 0:1e-4:5e-3;
results = solvepde(model,tlist);

Interpolate the solution at fixed x- and z-coordinates in the centers of their ranges, 5 and
0.5 respectively. Interpolate for y from 0 through 10 in steps of 0.2. Obtain just
component 3, the z-component of the solution.

yy = 0:0.2:10;
zz = 0.5*ones(size(yy));
xx = 10*zz;
component = 3;
uintrp = interpolateSolution(results,xx,yy,zz,component,1:length(tlist));

The solution is a 51-by-1-by-51 array. Use squeeze to remove the singleton dimension.
Removing the singleton dimension transforms this array to a 51-by-51 matrix which
simplifies indexing into it.

uintrp = squeeze(uintrp);

Plot the solution as a function of y and time.

[X,Y] = ndgrid(yy,tlist);
figure
surf(X,Y,uintrp)
xlabel('Y')
ylabel('Time')
title('Deflection at x = 5, z = 0.5')
zlim([0,14e-5])
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Input Arguments
results — PDE solution
StationaryResults object (default) | TimeDependentResults object |
EigenResults object

PDE solution, specified as a StationaryResults object, a TimeDependentResults
object, or an EigenResults object. Create results using solvepde, solvepdeeig, or
createPDEResults.
Example: results = solvepde(model)
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xq — x-coordinate query points
real array

x-coordinate query points, specified as a real array. interpolateSolution evaluates
the solution at the 2-D coordinate points [xq(i),yq(i)] or at the 3-D coordinate points
[xq(i),yq(i),zq(i)]. So xq, yq, and (if present) zq must have the same number of
entries.

interpolateSolution converts query points to column vectors xq(:), yq(:), and (if
present) zq(:). The returned solution is a column vector of the same size. To ensure that
the dimensions of the returned solution is consistent with the dimensions of the original
query points, use reshape. For example, use uintrp =
reshape(gradxuintrp,size(xq)).
Data Types: double

yq — y-coordinate query points
real array

y-coordinate query points, specified as a real array. interpolateSolution evaluates
the solution at the 2-D coordinate points [xq(i),yq(i)] or at the 3-D coordinate points
[xq(i),yq(i),zq(i)]. So xq, yq, and (if present) zq must have the same number of
entries. Internally, interpolateSolution converts query points to the column vector
yq(:).
Data Types: double

zq — z-coordinate query points
real array

z-coordinate query points, specified as a real array. interpolateSolution evaluates
the solution at the 3-D coordinate points [xq(i),yq(i),zq(i)]. So xq, yq, and zq
must have the same number of entries. Internally, interpolateSolution converts
query points to the column vector zq(:).
Data Types: double

querypoints — Query points
real matrix

Query points, specified as a real matrix with either two rows for 2-D geometry, or three
rows for 3-D geometry. interpolateSolution evaluates the solution at the coordinate
points querypoints(:,i), so each column of querypoints contains exactly one 2-D or
3-D query point.
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Example: For 2-D geometry, querypoints = [0.5,0.5,0.75,0.75; 1,2,0,0.5]
Data Types: double

iU — Equation indices
vector of positive integers

Equation indices, specified as a vector of positive integers. Each entry in iU specifies an
equation index.
Example: iU = [1,5] specifies the indices for the first and fifth equations.
Data Types: double

iT — Time or mode indices
vector of positive integers

Time or mode indices, specified as a vector of positive integers. Each entry in iT specifies
a time index for time-dependent solutions, or a mode index for eigenvalue solutions.
Example: iT = 1:5:21 specifies the time or mode for every fifth solution up to 21.
Data Types: double

Output Arguments
uintrp — Solution at query points
array

Solution at query points, returned as an array. For query points that are outside the
geometry, uintrp = NaN. For details about dimensions of the solution, see “Dimensions
of Solutions, Gradients, and Fluxes” on page 3-317.

See Also
PDEModel | StationaryResults | TimeDependentResults | evaluateGradient

Topics
“Plot 2-D Solutions and Their Gradients” on page 3-284
“Plot 3-D Solutions and Their Gradients” on page 3-295
“Dimensions of Solutions, Gradients, and Fluxes” on page 3-317
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Introduced in R2015b
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interpolateStrain
Package: pde

Interpolate strain at arbitrary spatial locations

Syntax
intrpStrain = interpolateStrain(structuralresults,xq,yq)
intrpStrain = interpolateStrain(structuralresults,xq,yq,zq)
intrpStrain = interpolateStrain(structuralresults,querypoints)

Description
intrpStrain = interpolateStrain(structuralresults,xq,yq) returns the
interpolated strain values at the 2-D points specified in xq and yq. For a dynamic
structural model, interpolateStrain interpolates strain for all time-steps.

intrpStrain = interpolateStrain(structuralresults,xq,yq,zq) uses the 3-
D points specified in xq, yq, and zq.

intrpStrain = interpolateStrain(structuralresults,querypoints) uses
the points specified in querypoints.

Examples

Interpolate Strain for Plane-Strain Problem

Create a structural analysis model for a plane-strain problem.

structuralmodel = createpde('structural','static-planestrain');

Include the square geometry in the model. Plot the geometry.
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geometryFromEdges(structuralmodel,@squareg);
pdegplot(structuralmodel,'EdgeLabels','on')
axis equal

Specify the Young's modulus and Poisson's ratio.

structuralProperties(structuralmodel,'PoissonsRatio',0.3, ...
                                     'YoungsModulus',210E3);

Specify the x-component of the enforced displacement for edge 1.

structuralBC(structuralmodel,'XDisplacement',0.001,'Edge',1);

Specify that edge 3 is a fixed boundary.
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structuralBC(structuralmodel,'Constraint','fixed','Edge',3);

Generate a mesh and solve the problem.

generateMesh(structuralmodel);
structuralresults = solve(structuralmodel);

Create a grid and interpolate the x- and y-components of the normal strain to the grid.

v = linspace(-1,1,101);
[X,Y] = meshgrid(v);
intrpStrain = interpolateStrain(structuralresults,X,Y);

Reshape the x-component of the normal strain to the shape of the grid and plot it.

exx = reshape(intrpStrain.exx,size(X));
px = pcolor(X,Y,exx);
px.EdgeColor='none';
colorbar
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Reshape the y-component of the normal strain to the shape of the grid and plot it.

eyy = reshape(intrpStrain.eyy,size(Y));
figure
py = pcolor(X,Y,eyy);
py.EdgeColor='none';
colorbar
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Interpolate Strain for 3-D Static Structural Analysis Problem

Solve a static structural model representing a bimetallic cable under tension, and
interpolate strain on a cross-section of the cable.

Create a static structural model for solving a solid (3-D) problem.

structuralmodel = createpde('structural','static-solid');

Create the geometry and include it in the model. Plot the geometry.

 interpolateStrain

5-503



gm = multicylinder([0.01,0.015],0.05);
structuralmodel.Geometry = gm;
pdegplot(structuralmodel,'FaceLabels','on','CellLabels','on','FaceAlpha',0.5)

Specify the Young's modulus and Poisson's ratio for each metal.

structuralProperties(structuralmodel,'Cell',1,'YoungsModulus',110E9, ...
                                              'PoissonsRatio',0.28);
structuralProperties(structuralmodel,'Cell',2,'YoungsModulus',210E9, ...
                                              'PoissonsRatio',0.3);

Specify that faces 1 and 4 are fixed boundaries.

structuralBC(structuralmodel,'Face',[1,4],'Constraint','fixed');
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Specify the surface traction for faces 2 and 5.

structuralBoundaryLoad(structuralmodel,'Face',[2,5],'SurfaceTraction',[0;0;100]);

Generate a mesh and solve the problem.

generateMesh(structuralmodel);
structuralresults = solve(structuralmodel)

structuralresults = 
  StaticStructuralResults with properties:

      Displacement: [1x1 struct]
            Strain: [1x1 struct]
            Stress: [1x1 struct]
    VonMisesStress: [22306x1 double]
              Mesh: [1x1 FEMesh]

Define the coordinates of a midspan cross-section of the cable.

[X,Y] = meshgrid(linspace(-0.015,0.015,50));
Z = ones(size(X))*0.025;

Interpolate the strain and plot the result.

intrpStrain = interpolateStrain(structuralresults,X,Y,Z);
surf(X,Y,reshape(intrpStrain.ezz,size(X)))
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Alternatively, you can specify the grid by using a matrix of query points.

querypoints = [X(:),Y(:),Z(:)]';
intrpStrain = interpolateStrain(structuralresults,querypoints);
surf(X,Y,reshape(intrpStrain.ezz,size(X)))
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Interpolate Strain for 3-D Structural Dynamic Problem

Interpolate the strain at the geometric center of a beam under a harmonic excitation.

Create a transient dynamic model for a 3-D problem.

structuralmodel = createpde('structural','transient-solid');

Create a geometry and include it in the model. Plot the geometry.

gm = multicuboid(0.06,0.005,0.01);
structuralmodel.Geometry = gm;
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pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.5)
view(50,20)

Specify the Young's modulus, Poisson's ratio, and mass density of the material.

structuralProperties(structuralmodel,'YoungsModulus',210E9, ...
                                     'PoissonsRatio',0.3, ...
                                     'MassDensity',7800);

Fix one end of the beam.

structuralBC(structuralmodel,'Face',5,'Constraint','fixed');

Apply a sinusoidal displacement along the y-direction on the end opposite the fixed end of
the beam.
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structuralBC(structuralmodel,'Face',3,'YDisplacement',1E-4,'Frequency',50);

Generate a mesh.

generateMesh(structuralmodel,'Hmax',0.01);

Specify the zero initial displacement and velocity.

structuralIC(structuralmodel,'Displacement',[0;0;0],'Velocity',[0;0;0]);

Solve the model.

tlist = 0:0.002:0.2;
structuralresults = solve(structuralmodel,tlist);

Interpolate the strain at the geometric center of the beam.

coordsMidSpan = [0;0;0.005];
intrpStrain = interpolateStrain(structuralresults,coordsMidSpan);

Plot the normal strain at the geometric center of the beam.

figure
plot(structuralresults.SolutionTimes,intrpStrain.exx)
title('X-Direction Normal Strain at Beam Center')
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Input Arguments
structuralresults — Solution of structural analysis problem
StaticStructuralResults object | TransientStructuralResults object

Solution of the structural analysis problem, specified as a StaticStructuralResults
or TransientStructuralResults object. Create structuralresults by using the
solve function.
Example: structuralresults = solve(structuralmodel)
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xq — x-coordinate query points
real array

x-coordinate query points, specified as a real array. interpolateStrain evaluates the
strains at the 2-D coordinate points [xq(i),yq(i)] or at the 3-D coordinate points
[xq(i),yq(i),zq(i)]. Therefore, xq, yq, and (if present) zq must have the same
number of entries.

interpolateStrain converts query points to column vectors xq(:), yq(:), and (if
present) zq(:). The function returns strains as a structure array with fields of the same
size as these column vectors. To ensure that the dimensions of the returned solution are
consistent with the dimensions of the original query points, use the reshape function.
For example, use intrpStrain = reshape(intrpStrain.exx,size(xq)).
Data Types: double

yq — y-coordinate query points
real array

y-coordinate query points, specified as a real array. interpolateStrain evaluates the
strains at the 2-D coordinate points [xq(i),yq(i)] or at the 3-D coordinate points
[xq(i),yq(i),zq(i)]. Therefore, xq, yq, and (if present) zq must have the same
number of entries. Internally, interpolateStrain converts the query points to the
column vector yq(:).
Data Types: double

zq — z-coordinate query points
real array

z-coordinate query points, specified as a real array. interpolateStrain evaluates the
strains at the 3-D coordinate points [xq(i),yq(i),zq(i)]. Therefore, xq, yq, and zq
must have the same number of entries. Internally, interpolateStrain converts the
query points to the column vector zq(:).
Data Types: double

querypoints — Query points
real matrix

Query points, specified as a real matrix with either two rows for 2-D geometry or three
rows for 3-D geometry. interpolateStrain evaluates the strains at the coordinate
points querypoints(:,i), so each column of querypoints contains exactly one 2-D or
3-D query point.
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Example: For 2-D geometry, querypoints = [0.5,0.5,0.75,0.75; 1,2,0,0.5]
Data Types: double

Output Arguments
intrpStrain — Strains at query points
structure array

Strains at the query points, returned as a structure array with fields representing spatial
components of strain at the query points. For query points that are outside the geometry,
intrpStrain returns NaN.

See Also
StaticStructuralResults | StructuralModel | evaluatePrincipalStrain |
evaluatePrincipalStress | evaluateReaction | interpolateDisplacement |
interpolateStress | interpolateVonMisesStress

Introduced in R2017b
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interpolateStress
Package: pde

Interpolate stress at arbitrary spatial locations

Syntax
intrpStress = interpolateStress(structuralresults,xq,yq)
intrpStress = interpolateStress(structuralresults,xq,yq,zq)
intrpStress = interpolateStress(structuralresults,querypoints)

Description
intrpStress = interpolateStress(structuralresults,xq,yq) returns the
interpolated stress values at the 2-D points specified in xq and yq. For a dynamic
structural model, interpolateStress interpolates stress for all time-steps.

intrpStress = interpolateStress(structuralresults,xq,yq,zq) uses the 3-
D points specified in xq, yq, and zq.

intrpStress = interpolateStress(structuralresults,querypoints) uses
the points specified in querypoints.

Examples

Interpolate Stress for Plane-Strain Problem

Create a structural analysis model for a plane-strain problem.

structuralmodel = createpde('structural','static-planestrain');

Include the square geometry in the model. Plot the geometry.
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geometryFromEdges(structuralmodel,@squareg);
pdegplot(structuralmodel,'EdgeLabels','on')
axis equal

Specify the Young's modulus and Poisson's ratio.

structuralProperties(structuralmodel,'PoissonsRatio',0.3, ...
                                     'YoungsModulus',210E3);

Specify the x-component of the enforced displacement for edge 1.

structuralBC(structuralmodel,'XDisplacement',0.001,'Edge',1);

Specify that edge 3 is a fixed boundary.
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structuralBC(structuralmodel,'Constraint','fixed','Edge',3);

Generate a mesh and solve the problem.

generateMesh(structuralmodel);
structuralresults = solve(structuralmodel);

Create a grid and interpolate the x- and y-components of the normal stress to the grid.

v = linspace(-1,1,151);
[X,Y] = meshgrid(v);
intrpStress = interpolateStress(structuralresults,X,Y);

Reshape the x-component of the normal stress to the shape of the grid and plot it.

sxx = reshape(intrpStress.sxx,size(X));
px = pcolor(X,Y,sxx);
px.EdgeColor='none';
colorbar
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Reshape the y-component of the normal stress to the shape of the grid and plot it.

syy = reshape(intrpStress.syy,size(Y));
figure
py = pcolor(X,Y,syy);
py.EdgeColor='none';
colorbar
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Interpolate Stress for 3-D Static Structural Analysis Problem

Solve a static structural model representing a bimetallic cable under tension, and
interpolate stress on a cross-section of the cable.

Create a static structural model for solving a solid (3-D) problem.

structuralmodel = createpde('structural','static-solid');

Create the geometry and include it in the model. Plot the geometry.

 interpolateStress

5-517



gm = multicylinder([0.01,0.015],0.05);
structuralmodel.Geometry = gm;
pdegplot(structuralmodel,'FaceLabels','on','CellLabels','on','FaceAlpha',0.5)

Specify the Young's modulus and Poisson's ratio for each metal.

structuralProperties(structuralmodel,'Cell',1,'YoungsModulus',110E9, ...
                                              'PoissonsRatio',0.28);
structuralProperties(structuralmodel,'Cell',2,'YoungsModulus',210E9, ...
                                              'PoissonsRatio',0.3);

Specify that faces 1 and 4 are fixed boundaries.

structuralBC(structuralmodel,'Face',[1,4],'Constraint','fixed');
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Specify the surface traction for faces 2 and 5.

structuralBoundaryLoad(structuralmodel,'Face',[2,5],'SurfaceTraction',[0;0;100]);

Generate a mesh and solve the problem.

generateMesh(structuralmodel);
structuralresults = solve(structuralmodel)

structuralresults = 
  StaticStructuralResults with properties:

      Displacement: [1x1 struct]
            Strain: [1x1 struct]
            Stress: [1x1 struct]
    VonMisesStress: [22306x1 double]
              Mesh: [1x1 FEMesh]

Define coordinates of a midspan cross-section of the cable.

[X,Y] = meshgrid(linspace(-0.015,0.015,50));
Z = ones(size(X))*0.025;

Interpolate the stress and plot the result.

intrpStress = interpolateStress(structuralresults,X,Y,Z);
surf(X,Y,reshape(intrpStress.szz,size(X)))
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Alternatively, you can specify the grid by using a matrix of query points.

querypoints = [X(:),Y(:),Z(:)]';
intrpStress = interpolateStress(structuralresults,querypoints);
surf(X,Y,reshape(intrpStress.szz,size(X)))
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Interpolate Stress for 3-D Structural Dynamic Problem

Interpolate the stress at the geometric center of a beam under a harmonic excitation.

Create a transient dynamic model for a 3-D problem.

structuralmodel = createpde('structural','transient-solid');

Create a geometry and include it in the model. Plot the geometry.

gm = multicuboid(0.06,0.005,0.01);
structuralmodel.Geometry = gm;

 interpolateStress

5-521



pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.5)
view(50,20)

Specify the Young's modulus, Poisson's ratio, and mass density of the material.

structuralProperties(structuralmodel,'YoungsModulus',210E9, ...
                                     'PoissonsRatio',0.3, ...
                                     'MassDensity',7800);

Fix one end of the beam.

structuralBC(structuralmodel,'Face',5,'Constraint','fixed');

Apply a sinusoidal displacement along the y-direction on the end opposite the fixed end of
the beam.
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structuralBC(structuralmodel,'Face',3,'YDisplacement',1E-4,'Frequency',50);

Generate a mesh.

generateMesh(structuralmodel,'Hmax',0.01);

Specify the zero initial displacement and velocity.

structuralIC(structuralmodel,'Displacement',[0;0;0],'Velocity',[0;0;0]);

Solve the model.

tlist = 0:0.002:0.2;
structuralresults = solve(structuralmodel,tlist);

Interpolate the stress at the geometric center of the beam.

coordsMidSpan = [0;0;0.005];
intrpStress = interpolateStress(structuralresults,coordsMidSpan);

Plot the normal stress at the geometric center of the beam.

figure
plot(structuralresults.SolutionTimes,intrpStress.sxx)
title('X-Direction Normal Stress at Beam Center')
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Input Arguments
structuralresults — Solution of structural analysis problem
StaticStructuralResults object | TransientStructuralResults object

Solution of the structural analysis problem, specified as a StaticStructuralResults
or TransientStructuralResults object. Create structuralresults by using the
solve function.
Example: structuralresults = solve(structuralmodel)
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xq — x-coordinate query points
real array

x-coordinate query points, specified as a real array. interpolateStress evaluates the
stresses at the 2-D coordinate points [xq(i),yq(i)] or at the 3-D coordinate points
[xq(i),yq(i),zq(i)]. Therefore, xq, yq, and (if present) zq must have the same
number of entries.

interpolateStress converts the query points to column vectors xq(:), yq(:), and (if
present) zq(:). It returns stresses as a structure array with fields of the same size as
these column vectors. To ensure that the dimensions of the returned solution are
consistent with the dimensions of the original query points, use the reshape function.
For example, use intrpStress = reshape(intrpStress.sxx,size(xq)).
Data Types: double

yq — y-coordinate query points
real array

y-coordinate query points, specified as a real array. interpolateStress evaluates the
stresses at the 2-D coordinate points [xq(i),yq(i)] or at the 3-D coordinate points
[xq(i),yq(i),zq(i)]. Therefore, xq, yq, and (if present) zq must have the same
number of entries. Internally, interpolateStress converts the query points to the
column vector yq(:).
Data Types: double

zq — z-coordinate query points
real array

z-coordinate query points, specified as a real array. interpolateStress evaluates the
stresses at the 3-D coordinate points [xq(i),yq(i),zq(i)]. Therefore, xq, yq, and zq
must have the same number of entries. Internally, interpolateStress converts the
query points to the column vector zq(:).
Data Types: double

querypoints — Query points
real matrix

Query points, specified as a real matrix with either two rows for 2-D geometry or three
rows for 3-D geometry. interpolateStress evaluates stresses at the coordinate points
querypoints(:,i), so each column of querypoints contains exactly one 2-D or 3-D
query point.
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Example: For 2-D geometry, querypoints = [0.5,0.5,0.75,0.75; 1,2,0,0.5]
Data Types: double

Output Arguments
intrpStress — Stresses at query points
structure array

Stresses at the query points, returned as a structure array with fields representing spatial
components of stress at the query points. For query points that are outside the geometry,
intrpStress returns NaN.

See Also
StaticStructuralResults | StructuralModel | evaluatePrincipalStrain |
evaluatePrincipalStress | evaluateReaction | interpolateDisplacement |
interpolateStrain | interpolateVonMisesStress

Introduced in R2017b
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interpolateTemperature
Package: pde

Interpolate temperature in a thermal result at arbitrary spatial locations

Syntax
Tintrp = interpolateTemperature(thermalresults,xq,yq)
Tintrp = interpolateTemperature(thermalresults,xq,yq,zq)
Tintrp = interpolateTemperature(thermalresults,querypoints)
Tintrp = interpolateTemperature( ___ ,iT)

Description
Tintrp = interpolateTemperature(thermalresults,xq,yq) returns the
interpolated temperature values at the 2-D points specified in xq and yq. This syntax is
valid for both the steady-state and transient thermal models.

Tintrp = interpolateTemperature(thermalresults,xq,yq,zq) returns the
interpolated temperature values at the 3-D points specified in xq, yq, and zq. This syntax
is valid for both the steady-state and transient thermal models.

Tintrp = interpolateTemperature(thermalresults,querypoints) returns the
interpolated temperature values at the points in querypoints. This syntax is valid for
both the steady-state and transient thermal models.

Tintrp = interpolateTemperature( ___ ,iT) returns the interpolated temperature
values for the transient thermal model at times iT.

Examples

Interpolate Temperatures in 2-D Steady-State Thermal Model

Create a thermal model for steady-state analysis.
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thermalmodel = createpde('thermal');

Create the geometry and include it in the model.

R1 = [3,4,-1,1,1,-1,1,1,-1,-1]';
g = decsg(R1, 'R1', ('R1')');
geometryFromEdges(thermalmodel,g);
pdegplot(thermalmodel,'EdgeLabels','on')
xlim([-1.5,1.5])
axis equal

Assuming that this is an iron plate, assign a thermal conductivity of 79.5 W/(m*K).
Because this is a steady-state model, you do not need to assign mass density or specific
heat values.

5 Functions — Alphabetical List

5-528



thermalProperties(thermalmodel,'ThermalConductivity',79.5,'Face',1);

Apply a constant temperature of 300 K to the bottom of the plate (edge 3). Also, assume
that the top of the plate (edge 1) is insulated, and apply convection on the two sides of the
plate (edges 2 and 4).

thermalBC(thermalmodel,'Edge',3,'Temperature',300);
thermalBC(thermalmodel,'Edge',1,'HeatFlux',0);
thermalBC(thermalmodel,'Edge',[2,4],...
                       'ConvectionCoefficient',25,...
                       'AmbientTemperature',50);

Mesh the geometry and solve the problem.

generateMesh(thermalmodel);
results = solve(thermalmodel)

results = 
  SteadyStateThermalResults with properties:

    Temperature: [1541x1 double]
     XGradients: [1541x1 double]
     YGradients: [1541x1 double]
     ZGradients: []
           Mesh: [1x1 FEMesh]

The solver finds the values of temperatures and temperature gradients at the nodal
locations. To access these values, use results.Temperature, results.XGradients,
and so on. For example, plot the temperatures at nodal locations.

figure;
pdeplot(thermalmodel,'XYData',results.Temperature,...
                     'Contour','on','ColorMap','hot');
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Interpolate the resulting temperatures to a grid covering the central portion of the
geometry, for x and y from -0.5 to 0.5.

v = linspace(-0.5,0.5,11);
[X,Y] = meshgrid(v);

Tintrp = interpolateTemperature(results,X,Y);

Reshape the Tintrp vector and plot the resulting temperatures.

Tintrp = reshape(Tintrp,size(X));

figure
contourf(X,Y,Tintrp)
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colormap(hot)
colorbar

Alternatively, you can specify the grid by using a matrix of query points.

querypoints = [X(:),Y(:)]';
Tintrp = interpolateTemperature(results,querypoints);

Interpolate Temperature for a 3-D Steady-State Thermal Model

Create a thermal model for steady-state analysis.
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thermalmodel = createpde('thermal');

Create the following 3-D geometry and include it in the model.

importGeometry(thermalmodel,'Block.stl'); 
pdegplot(thermalmodel,'FaceLabels','on','FaceAlpha',0.5)
title('Copper block, cm')
axis equal

Assuming that this is a copper block, the thermal conductivity of the block is
approximately 4 W/(cm*K).

thermalProperties(thermalmodel,'ThermalConductivity',4);
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Apply a constant temperature of 373 K to the left side of the block (edge 1) and a constant
temperature of 573 K at the right side of the block.

thermalBC(thermalmodel,'Face',1,'Temperature',373);
thermalBC(thermalmodel,'Face',3,'Temperature',573);

Apply a heat flux boundary condition to the bottom of the block.

thermalBC(thermalmodel,'Face',4,'HeatFlux',-20);

Mesh the geometry and solve the problem.

generateMesh(thermalmodel);
thermalresults = solve(thermalmodel)

thermalresults = 
  SteadyStateThermalResults with properties:

    Temperature: [12691x1 double]
     XGradients: [12691x1 double]
     YGradients: [12691x1 double]
     ZGradients: [12691x1 double]
           Mesh: [1x1 FEMesh]

The solver finds the values of temperatures and temperature gradients at the nodal
locations. To access these values, use results.Temperature, results.XGradients,
and so on. For example, plot temperatures at nodal locations.

figure;
pdeplot3D(thermalmodel,'ColorMapData',thermalresults.Temperature)
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Create a grid specified by x, y, and z coordinates and interpolate temperatures to the
grid.

[X,Y,Z] = meshgrid(1:16:100,1:6:20,1:7:50);

Tintrp = interpolateTemperature(thermalresults,X,Y,Z);

Create a contour slice plot for fixed values of the y coordinate.

figure

Tintrp = reshape(Tintrp,size(X));

contourslice(X,Y,Z,Tintrp,[],1:6:20,[])
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xlabel('x')
ylabel('y')
zlabel('z')
xlim([1,100])
ylim([1,20])
zlim([1,50])
axis equal
view(-50,22)
colorbar

Alternatively, you can specify the grid by using a matrix of query points.

querypoints = [X(:),Y(:),Z(:)]';
Tintrp = interpolateTemperature(thermalresults,querypoints);
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Create a contour slice plot for four fixed values of the z coordinate.

figure

Tintrp = reshape(Tintrp,size(X));

contourslice(X,Y,Z,Tintrp,[],[],1:7:50)
xlabel('x')
ylabel('y')
zlabel('z')
xlim([1,100])
ylim([1,20])
zlim([1,50])
axis equal
view(-50,22)
colorbar
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Temperatures for a Transient Thermal Model on a Square

Solve a 2-D transient heat transfer problem on a square domain and compute
temperatures at the convective boundary.

Create a transient thermal model for this problem.

thermalmodel = createpde('thermal','transient');

Create the geometry and include it in the model.
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g = @squareg;
geometryFromEdges(thermalmodel,g);
pdegplot(thermalmodel,'EdgeLabels','on')
xlim([-1.2,1.2])
ylim([-1.2,1.2])
axis equal

Assign the following thermal properties:

• Thermal conductivity is 100 W/(m*C)
• Mass density is 7800 kg/m^3
• Specific heat is 500 J/(kg*C)
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thermalProperties(thermalmodel,'ThermalConductivity',100,...
                               'MassDensity',7800,...
                               'SpecificHeat',500);

Apply insulated boundary conditions on three edges and the free convection boundary
condition on the right edge.

thermalBC(thermalmodel,'Edge',[1,3,4],'HeatFlux',0);
thermalBC(thermalmodel,'Edge',2,...
                       'ConvectionCoefficient',5000,...
                       'AmbientTemperature',25);

Set the initial conditions: uniform room temperature across domain and higher
temperature on the left edge.

thermalIC(thermalmodel,25);
thermalIC(thermalmodel,100,'Edge',4);

Generate a mesh and solve the problem using 0:1000:200000 as a vector of times.

generateMesh(thermalmodel);
tlist = 0:1000:200000;
thermalresults = solve(thermalmodel,tlist)

thermalresults = 
  TransientThermalResults with properties:

      Temperature: [1541x201 double]
    SolutionTimes: [1x201 double]
       XGradients: [1541x201 double]
       YGradients: [1541x201 double]
       ZGradients: []
             Mesh: [1x1 FEMesh]

Define a line at convection boundary and compute temperature gradients across that line.

X = -1:0.1:1;
Y = ones(size(X));

Tintrp = interpolateTemperature(thermalresults,X,Y,1:length(tlist));

Plot the interpolated temperature Tintrp along the x axis for the following values from
the time interval tlist.
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figure
t = [51:50:201];
for i = t
  p(i) = plot(X,Tintrp(:,i),'DisplayName', strcat('t=', num2str(tlist(i))));
  hold on
end
legend(p(t))
xlabel('x')
ylabel('Tintrp')
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Input Arguments
thermalresults — Solution of thermal problem
SteadyStateThermalResults object | TransientThermalResults object

Solution of thermal problem, specified as a SteadyStateThermalResults object or a
TransientThermalResults object. Create thermalresults using solve.
Example: thermalresults = solve(thermalmodel)

xq — x-coordinate query points
real array

x-coordinate query points, specified as a real array. interpolateTemperature
evaluates temperatures at the 2-D coordinate points [xq(i),yq(i)] or at the 3-D
coordinate points [xq(i),yq(i),zq(i)]. So xq, yq, and (if present) zq must have the
same number of entries.

interpolateTemperature converts query points to column vectors xq(:), yq(:), and
(if present) zq(:). It returns temperatures in the form of a column vector of the same
size. To ensure that the dimensions of the returned solution is consistent with the
dimensions of the original query points, use reshape. For example, use Tintrp =
reshape(Tintrp,size(xq)).
Data Types: double

yq — y-coordinate query points
real array

y-coordinate query points, specified as a real array. interpolateTemperature
evaluates temperatures at the 2-D coordinate points [xq(i),yq(i)] or at the 3-D
coordinate points [xq(i),yq(i),zq(i)]. So xq, yq, and (if present) zq must have the
same number of entries. Internally, interpolateTemperature converts query points to
the column vector yq(:).
Data Types: double

zq — z-coordinate query points
real array

z-coordinate query points, specified as a real array. interpolateTemperature
evaluates temperatures at the 3-D coordinate points [xq(i),yq(i),zq(i)]. So xq, yq,
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and zq must have the same number of entries. Internally, interpolateTemperature
converts query points to the column vector zq(:).
Data Types: double

querypoints — Query points
real matrix

Query points, specified as a real matrix with either two rows for 2-D geometry, or three
rows for 3-D geometry. interpolateTemperature evaluates temperatures at the
coordinate points querypoints(:,i), so each column of querypoints contains exactly
one 2-D or 3-D query point.
Example: For 2-D geometry, querypoints = [0.5,0.5,0.75,0.75; 1,2,0,0.5]
Data Types: double

iT — Time indices
vector of positive integers

Time indices, specified as a vector of positive integers. Each entry in iT specifies a time
index.
Example: iT = 1:5:21 specifies every fifth time-step up to 21.
Data Types: double

Output Arguments
Tintrp — Temperatures at query points
array

Temperatures at query points, returned as an array. For query points that are outside the
geometry, Tintrp = NaN.

See Also
SteadyStateThermalResults | ThermalModel | TransientThermalResults |
evaluateHeatFlux | evaluateHeatRate | evaluateTemperatureGradient

Topics
“Dimensions of Solutions, Gradients, and Fluxes” on page 3-317
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Introduced in R2017a
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interpolateVelocity
Package: pde

Interpolate velocity at arbitrary spatial locations for all time steps for transient structural
model

Syntax
intrpVel = interpolateVelocity(structuralresults,xq,yq)
intrpVel = interpolateVelocity(structuralresults,xq,yq,zq)
intrpVel = interpolateVelocity(structuralresults,querypoints)

Description
intrpVel = interpolateVelocity(structuralresults,xq,yq) returns the
interpolated velocity values at the 2-D points specified in xq and yq for all time-steps.

intrpVel = interpolateVelocity(structuralresults,xq,yq,zq) uses the 3-D
points specified in xq, yq, and zq.

intrpVel = interpolateVelocity(structuralresults,querypoints) uses the
points specified in querypoints.

Examples

Interpolate Velocity for 3-D Structural Dynamic Problem

Interpolate velocity at the geometric center of a beam under a harmonic excitation.

Create a transient dynamic model for a 3-D problem.

structuralmodel = createpde('structural','transient-solid');

Create the geometry and include it in the model. Plot the geometry.
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gm = multicuboid(0.06,0.005,0.01);
structuralmodel.Geometry = gm;
pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.5)
view(50,20)

Specify the Young's modulus, Poisson's ratio, and mass density of the material.

structuralProperties(structuralmodel,'YoungsModulus',210E9, ...
                                     'PoissonsRatio',0.3, ...
                                     'MassDensity',7800);

Fix one end of the beam.

structuralBC(structuralmodel,'Face',5,'Constraint','fixed');
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Apply a sinusoidal displacement along the y-direction on the end opposite the fixed end of
the beam.

structuralBC(structuralmodel,'Face',3,'YDisplacement',1E-4,'Frequency',50);

Generate a mesh.

generateMesh(structuralmodel,'Hmax',0.01);

Specify the zero initial displacement and velocity.

structuralIC(structuralmodel,'Displacement',[0;0;0],'Velocity',[0;0;0]);

Solve the model.

tlist = 0:0.002:0.2;
structuralresults = solve(structuralmodel,tlist);

Interpolate velocity at the geometric center of the beam.

coordsMidSpan = [0;0;0.005];
intrpVel = interpolateVelocity(structuralresults,coordsMidSpan);

Plot the y-component of velocity of the geometric center of the beam.

figure
plot(structuralresults.SolutionTimes,intrpVel.vy)
title('Y-Velocity of the Geometric Center of the Beam')
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Input Arguments
structuralresults — Solution of dynamic structural analysis problem
TransientStructuralResults object

Solution of the dynamic structural analysis problem, specified as a
TransientStructuralResults object. Create structuralresults by using the
solve function.
Example: structuralresults = solve(structuralmodel,tlist)

 interpolateVelocity

5-547



xq — x-coordinate query points
real array

x-coordinate query points, specified as a real array. interpolateVelocity evaluates
velocities at the 2-D coordinate points [xq(i),yq(i)] or at the 3-D coordinate points
[xq(i),yq(i),zq(i)]. Therefore, xq, yq, and (if present) zq must have the same
number of entries.

interpolateVelocity converts query points to column vectors xq(:), yq(:), and (if
present) zq(:). It returns velocities as a structure array with fields of the same size as
these column vectors. To ensure that the dimensions of the returned solution are
consistent with the dimensions of the original query points, use the reshape function.
For example, use intrpVel = reshape(intrpVel.ux,size(xq)).
Data Types: double

yq — y-coordinate query points
real array

y-coordinate query points, specified as a real array. interpolateVelocity evaluates
velocities at the 2-D coordinate points [xq(i),yq(i)] or at the 3-D coordinate points
[xq(i),yq(i),zq(i)]. Therefore, xq, yq, and (if present) zq must have the same
number of entries. Internally, interpolateVelocity converts query points to the
column vector yq(:).
Data Types: double

zq — z-coordinate query points
real array

z-coordinate query points, specified as a real array. interpolateVelocity evaluates
velocities at the 3-D coordinate points [xq(i),yq(i),zq(i)]. Therefore, xq, yq, and
zq must have the same number of entries. Internally, interpolateVelocity converts
query points to the column vector zq(:).
Data Types: double

querypoints — Query points
real matrix

Query points, specified as a real matrix with either two rows for 2-D geometry or three
rows for 3-D geometry. interpolateVelocity evaluates velocities at the coordinate
points querypoints(:,i), so each column of querypoints contains exactly one 2-D or
3-D query point.
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Example: For 2-D geometry, querypoints = [0.5,0.5,0.75,0.75; 1,2,0,0.5]
Data Types: double

Output Arguments
intrpVel — Velocities at query points
structure array

Velocities at the query points, returned as a structure array with fields representing
spatial components of velocity at the query points. For query points that are outside the
geometry, intrpVel returns NaN.

See Also
StructuralModel | TransientStructuralResults | evaluatePrincipalStrain |
evaluatePrincipalStress | evaluateReaction | evaluateStrain |
evaluateStress | evaluateVonMisesStress | interpolateAcceleration |
interpolateDisplacement | interpolateStrain | interpolateStress |
interpolateVonMisesStress

Introduced in R2018a
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interpolateVonMisesStress
Package: pde

Interpolate von Mises stress at arbitrary spatial locations

Syntax
intrpVMStress = interpolateVonMisesStress(structuralresults,xq,yq)
intrpVMStress = interpolateVonMisesStress(structuralresults,xq,yq,
zq)
intrpVMStress = interpolateVonMisesStress(structuralresults,
querypoints)

Description
intrpVMStress = interpolateVonMisesStress(structuralresults,xq,yq)
returns the interpolated von Mises stress values at the 2-D points specified in xq and yq.
For a dynamic structural model, interpolateVonMisesStress interpolates von Mises
stress for all time-steps.

intrpVMStress = interpolateVonMisesStress(structuralresults,xq,yq,
zq) uses the 3-D points specified in xq, yq, and zq.

intrpVMStress = interpolateVonMisesStress(structuralresults,
querypoints) uses the points specified in querypoints.

Examples

Interpolate von Mises Stress for Plane-Strain Problem

Create a structural analysis model for a plane-strain problem.

structuralmodel = createpde('structural','static-planestrain');
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Include the square geometry in the model. Plot the geometry.

geometryFromEdges(structuralmodel,@squareg);
pdegplot(structuralmodel,'EdgeLabels','on')
axis equal

Specify the Young's modulus and Poisson's ratio.

structuralProperties(structuralmodel,'PoissonsRatio',0.3, ...
                                     'YoungsModulus',210E3);

Specify the x-component of the enforced displacement for edge 1.

structuralBC(structuralmodel,'XDisplacement',0.001,'Edge',1);
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Specify that edge 3 is a fixed boundary.

structuralBC(structuralmodel,'Constraint','fixed','Edge',3);

Generate a mesh and solve the problem.

generateMesh(structuralmodel);
structuralresults = solve(structuralmodel);

Create a grid and interpolate the von Mises stress to the grid.

v = linspace(-1,1,151);
[X,Y] = meshgrid(v);
intrpVMStress = interpolateVonMisesStress(structuralresults,X,Y);

Reshape the von Mises stress to the shape of the grid and plot it.

VMStress = reshape(intrpVMStress,size(X));
p = pcolor(X,Y,VMStress);
p.EdgeColor='none';
colorbar
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Interpolate Von Mises Stress for 3-D Static Structural Analysis Problem

Solve a static structural model representing a bimetallic cable under tension, and
interpolate the von Mises stress on a cross-section of the cable.

Create a static structural model for solving a solid (3-D) problem.

structuralmodel = createpde('structural','static-solid');

Create the geometry and include it in the model. Plot the geometry.
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gm = multicylinder([0.01,0.015],0.05);
structuralmodel.Geometry = gm;
pdegplot(structuralmodel,'FaceLabels','on','CellLabels','on','FaceAlpha',0.5)

Specify the Young's modulus and Poisson's ratio for each metal.

structuralProperties(structuralmodel,'Cell',1,'YoungsModulus',110E9, ...
                                              'PoissonsRatio',0.28);
structuralProperties(structuralmodel,'Cell',2,'YoungsModulus',210E9, ...
                                              'PoissonsRatio',0.3);

Specify that faces 1 and 4 are fixed boundaries.

structuralBC(structuralmodel,'Face',[1,4],'Constraint','fixed');
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Specify the surface traction for faces 2 and 5.

structuralBoundaryLoad(structuralmodel,'Face',[2,5],'SurfaceTraction',[0;0;100]);

Generate a mesh and solve the problem.

generateMesh(structuralmodel);
structuralresults = solve(structuralmodel)

structuralresults = 
  StaticStructuralResults with properties:

      Displacement: [1x1 struct]
            Strain: [1x1 struct]
            Stress: [1x1 struct]
    VonMisesStress: [22306x1 double]
              Mesh: [1x1 FEMesh]

Define the coordinates of a midspan cross-section of the cable.

[X,Y] = meshgrid(linspace(-0.015,0.015,50));
Z = ones(size(X))*0.025;

Interpolate the von Mises stress and plot the result.

IntrpVMStress = interpolateVonMisesStress(structuralresults,X,Y,Z);
surf(X,Y,reshape(IntrpVMStress,size(X)))
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Alternatively, you can specify the grid by using a matrix of query points.

querypoints = [X(:),Y(:),Z(:)]';
IntrpVMStress = interpolateVonMisesStress(structuralresults,querypoints);
surf(X,Y,reshape(IntrpVMStress,size(X)))
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Interpolate von Mises Stress for 3-D Structural Dynamic Problem

Interpolate the von Mises stress at the geometric center of a beam under a harmonic
excitation.

Create a transient dynamic model for a 3-D problem.

structuralmodel = createpde('structural','transient-solid');

Create the geometry and include it in the model. Plot the geometry.
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gm = multicuboid(0.06,0.005,0.01);
structuralmodel.Geometry = gm;
pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.5)
view(50,20)

Specify the Young's modulus, Poisson's ratio, and mass density of the material.

structuralProperties(structuralmodel,'YoungsModulus',210E9, ...
                                     'PoissonsRatio',0.3, ...
                                     'MassDensity',7800);

Fix one end of the beam.

structuralBC(structuralmodel,'Face',5,'Constraint','fixed');
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Apply a sinusoidal displacement along the y-direction on the end opposite the fixed end of
the beam.

structuralBC(structuralmodel,'Face',3,'YDisplacement',1E-4,'Frequency',50);

Generate a mesh.

generateMesh(structuralmodel,'Hmax',0.01);

Specify the zero initial displacement and velocity.

structuralIC(structuralmodel,'Displacement',[0;0;0],'Velocity',[0;0;0]);

Solve the model.

tlist = 0:0.002:0.2;
structuralresults = solve(structuralmodel,tlist);

Interpolate the von Mises stress at the geometric center of the beam.

coordsMidSpan = [0;0;0.005];
intrpStress = interpolateStress(structuralresults,coordsMidSpan);

Plot the von Mises stress at the geometric center of the beam.

figure
plot(structuralresults.SolutionTimes,intrpStress.sxx)
title('von Mises Stress at Beam Center')
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Input Arguments
structuralresults — Solution of structural analysis problem
StaticStructuralResults object | TransientStructuralResults object

Solution of the structural analysis problem, specified as a StaticStructuralResults
or TransientStructuralResults object. Create structuralresults by using the
solve function.
Example: structuralresults = solve(structuralmodel)
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xq — x-coordinate query points
real array

x-coordinate query points, specified as a real array. interpolateVonMisesStress
evaluates the von Mises stress at the 2-D coordinate points [xq(i),yq(i)] or at the 3-D
coordinate points [xq(i),yq(i),zq(i)]. Therefore, xq, yq, and (if present) zq must
have the same number of entries.

interpolateVonMisesStress converts query points to column vectors xq(:), yq(:),
and (if present) zq(:). The function returns von Mises stress as a column vector of the
same size as the query point column vectors. To ensure that the dimensions of the
returned solution are consistent with the dimensions of the original query points, use the
reshape function. For example, use intrpVMStress =
reshape(intrpVMStress,size(xq)).
Data Types: double

yq — y-coordinate query points
real array

y-coordinate query points, specified as a real array. interpolateVonMisesStress
evaluates the von Mises stress at the 2-D coordinate points [xq(i),yq(i)] or at the 3-D
coordinate points [xq(i),yq(i),zq(i)]. Therefore, xq, yq, and (if present) zq must
have the same number of entries. Internally, interpolateVonMisesStress converts
the query points to the column vector yq(:).
Data Types: double

zq — z-coordinate query points
real array

z-coordinate query points, specified as a real array. interpolateVonMisesStress
evaluates the von Mises stress at the 3-D coordinate points [xq(i),yq(i),zq(i)].
Therefore, xq, yq, and zq must have the same number of entries. Internally,
interpolateVonMisesStress converts the query points to the column vector zq(:).
Data Types: double

querypoints — Query points
real matrix

Query points, specified as a real matrix with either two rows for 2-D geometry or three
rows for 3-D geometry. interpolateVonMisesStress evaluates the von Mises stress at

 interpolateVonMisesStress

5-561



the coordinate points querypoints(:,i), so each column of querypoints contains
exactly one 2-D or 3-D query point.
Example: For 2-D geometry, querypoints = [0.5,0.5,0.75,0.75; 1,2,0,0.5]
Data Types: double

Output Arguments
intrpVMStress — von Mises stress at query points
column vector

von Mises stress at the query points, returned as a column vector.

For query points that are outside the geometry, intrpVMStress = NaN.

See Also
StaticStructuralResults | StructuralModel | evaluatePrincipalStrain |
evaluatePrincipalStress | evaluateReaction | interpolateDisplacement |
interpolateStrain | interpolateStress

Introduced in R2017b
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jigglemesh
(Not recommended) Jiggle internal points of triangular mesh

Note This page describes the legacy workflow. New features might not be compatible
with the legacy workflow. For the corresponding step in the recommended workflow, see
generateMesh.

Syntax
p1 = jigglemesh(p,e,t)

p1 = jigglemesh(p,e,t,'PropertyName',PropertyValue,...)

Description
p1 = jigglemesh(p,e,t) jiggles the triangular mesh by adjusting the node point
positions. The quality of the mesh normally increases.

The following property name/property value pairs are allowed.

Property Value Default Description
Opt 'off' | 'mean'

| 'minimum'
'mean' Optimization method,

described in the following
bullets

Iter numeric 1 or 20 (see the following
bullets)

Maximum iterations

Each mesh point that is not located on an edge segment is moved toward the center of
mass of the polygon formed by the adjacent triangles. This process is repeated according
to the settings of the Opt and Iter variables:

• When Opt is set to 'off' this process is repeated Iter times (default: 1).
• When Opt is set to 'mean' the process is repeated until the mean triangle quality

does not significantly increase, or until the bound Iter is reached (default: 20).
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• When Opt is set to 'minimum' the process is repeated until the minimum triangle
quality does not significantly increase, or until the bound Iter is reached (default:
20).

Examples

Mesh Jiggling

Create a triangular mesh of the L-shaped membrane, first without jiggling, and then jiggle
the mesh.

[p,e,t] = initmesh('lshapeg','jiggle','off'); 
q = pdetriq(p,t); 
pdeplot(p,e,t,'XYData',q,'ColorBar','on','XYStyle','flat')
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p1 = jigglemesh(p,e,t,'opt','mean','iter',inf); 
q = pdetriq(p1,t); 
pdeplot(p1,e,t,'XYData',q,'ColorBar','on','XYStyle','flat')
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See Also
initmesh | pdetriq

Topics
“Mesh Data” on page 2-233

Introduced before R2006a
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meshQuality
Package: pde

Evaluate shape quality of mesh elements

Syntax
Q = meshQuality(mesh)
Q = meshQuality(mesh,elemIDs)
Q = meshQuality( ___ ,'aspect-ratio')

Description
Q = meshQuality(mesh) returns a row vector of numbers from 0 through 1
representing shape quality of all elements of the mesh. Here, 1 corresponds to the
optimal shape of the element.

Q = meshQuality(mesh,elemIDs) returns the shape quality of the specified elements.

Q = meshQuality( ___ ,'aspect-ratio') determines the shape quality by using the
ratio of minimal to maximal dimensions of an element. The quality values are numbers
from 0 through 1, where 1 corresponds to the optimal shape of the element. Specify
'aspect-ratio' after any of the previous syntaxes.

Examples

Element Quality of 3-D Mesh

Evaluate the shape quality of the elements of a 3-D mesh.

Create a PDE model.

model = createpde;
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Include and plot the following geometry.

importGeometry(model,'PlateSquareHoleSolid.stl');
pdegplot(model)

Create and plot a coarse mesh.

mesh = generateMesh(model,'Hmax',35)

mesh = 
  FEMesh with properties:

             Nodes: [3x487 double]
          Elements: [10x213 double]
    MaxElementSize: 35
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    MinElementSize: 17.5000
     MeshGradation: 1.5000
    GeometricOrder: 'quadratic'

pdemesh(model)

Evaluate the shape quality of all mesh elements. Display the first five values.

Q = meshQuality(mesh);
Q(1:5)

ans = 1×5

 meshQuality

5-569



    0.3079    0.2917    0.6189    0.6688    0.5571

Find the elements with the quality values less than 0.2.

elemIDs = find(Q < 0.2);

Highlight these elements in blue on the mesh plot.

pdemesh(mesh,'FaceAlpha',0.5)
hold on
pdemesh(mesh.Nodes,mesh.Elements(:,elemIDs),'FaceColor','blue','EdgeColor','blue')

Plot the element quality in a histogram.
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figure
hist(Q)
xlabel('Element Shape Quality','fontweight','b')
ylabel('Number of Elements','fontweight','b')

Find the worst quality value.

Qworst = min(Q)

Qworst = 0.1691

Find the corresponding element IDs.

elemIDs = find(Q==Qworst)
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elemIDs = 1×2

    10   136

Element Quality of 2-D Mesh

Evaluate the shape quality of the elements of a 2-D mesh.

Create a PDE model.

model = createpde;

Include and plot the following geometry.

importGeometry(model,'PlateSquareHolePlanar.stl');
pdegplot(model)
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Create and plot a coarse mesh.

mesh = generateMesh(model,'Hmax',20)

mesh = 
  FEMesh with properties:

             Nodes: [2x286 double]
          Elements: [6x126 double]
    MaxElementSize: 20
    MinElementSize: 10
     MeshGradation: 1.5000
    GeometricOrder: 'quadratic'
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pdemesh(model)

Find the IDs of the elements within a box enclosing the center of the plate.

elemIDs = findElements(mesh,'box',[25,75],[80,120]);

Evaluate the shape quality of these elements.

Q = meshQuality(mesh,elemIDs)

Q = 1×12

    0.2980    0.8253    0.2994    0.6581    0.7838    0.6104    0.3992    0.6921    0.2948    0.5726    0.7016    0.5669
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Find the elements with the quality values less than 0.4.

elemIDs04 = elemIDs(Q < 0.4)

elemIDs04 = 1×4

     9    19    69    83

Highlight these elements in green on the mesh plot. Zoom in to see the details.

pdemesh(mesh,'ElementLabels','on')
hold on
pdemesh(mesh.Nodes,mesh.Elements(:,elemIDs04),'EdgeColor','green')
zoom(10)
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Element Quality Determined by Aspect Ratio

Determine the shape quality of mesh elements by using the ratios of minimal to maximal
dimensions.

Create a PDE model and include the L-shaped geometry.

model = createpde(1);
geometryFromEdges(model,@lshapeg);

Generate the default mesh for the geometry.

mesh = generateMesh(model);

View the mesh.

pdeplot(model)
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Evaluate the shape quality of mesh elements by using the minimal to maximal dimensions
ratio. Display the first five values.

Q = meshQuality(mesh,'aspect-ratio');
Q(1:5)

ans = 1×5

    0.8339    0.7655    0.7755    0.8301    0.8969

Evaluate the shape quality of mesh elements by using the default setting. Display the first
five values.
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Q = meshQuality(mesh);
Q(1:5)

ans = 1×5

    0.9837    0.9605    0.9654    0.9829    0.9913

Input Arguments
mesh — Mesh object
Mesh property of a PDEModel object | output of generateMesh

Mesh object, specified as the Mesh property of a PDEModel object or as the output of
generateMesh.
Example: model.Mesh

elemIDs — Element IDs
positive integer | matrix of positive integers

Element IDs, specified as a positive integer or a matrix of positive integers.
Example: [10 68 81 97 113 130 136 164]

Output Arguments
Q — Shape quality of mesh elements
row vector of numbers from 0 through 1

Shape quality of mesh elements, returned as a row vector of numbers from 0 through 1.
The value 0 corresponds to a deflated element with zero area or volume. The value 1
corresponds to an element of optimal shape.
Example: [0.9150 0.7787 0.9417 0.2744 0.9843 0.9181]
Data Types: double
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References
[1] Knupp, Patrick M. "Matrix Norms & the Condition Number: A General Framework to

Improve Mesh Quality via Node-Movement." In Proceedings, 8th International
Meshing Roundtable. Lake Tahoe, CA, October 1999: 13-22.

See Also
FEMesh Properties | area | findElements | findNodes | volume

Topics
“Finite Element Method Basics” on page 1-18

Introduced in R2018a

 meshQuality

5-579



meshToPet
Package: pde

[p,e,t] representation of FEMesh data

Note This page describes the legacy workflow. New features might not be compatible
with the [p,e,t] representation of FEMesh data.

Syntax
[p,e,t] = meshToPet(mesh)

Description
[p,e,t] = meshToPet(mesh) extracts the legacy [p,e,t] mesh representation from
a FEMesh object.

Examples

Convert 2-D Mesh to [p,e,t] Form

This example shows how to convert a mesh in object form to [p,e,t] form.

Create a 2-D PDE geometry and incorporate it into a model object. View the geometry.

model = createpde(1);

R1 = [3,4,-1,1,1,-1,-.4,-.4,.4,.4]';
C1 = [1,.5,0,.2]';
% Pad C1 with zeros to enable concatenation with R1
C1 = [C1;zeros(length(R1)-length(C1),1)];
geom = [R1,C1];
ns = (char('R1','C1'))';
sf = 'R1-C1';
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gd = decsg(geom,sf,ns);

geometryFromEdges(model,gd);
pdegplot(model,'EdgeLabels','on')
xlim([-1.1 1.1])
axis equal

Create a mesh for the geometry. View the mesh.

generateMesh(model);
pdemesh(model)
axis equal
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Convert the mesh to [p,e,t] form.

[p,e,t] = meshToPet(model.Mesh);

View the sizes of the [p,e,t] matrices.

size(p)

ans = 1×2

     2   956

size(e)
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ans = 1×2

     7   160

size(t)

ans = 1×2

     7   438

Input Arguments
mesh — Mesh object
Mesh property of a PDEModel object | output of generateMesh

Mesh object, specified as the Mesh property of a PDEModel object or as the output of
generateMesh.
Example: model.Mesh

Output Arguments
p — Mesh points
2-by-Np matrix | 3-by-Np matrix

Mesh points, returned as a 2-by-Np matrix (2-D geometry) or a 3-by-Np matrix (3-D
geometry). Np is the number of points (nodes) in the mesh. Column k of p consists of the
x-coordinate of point k in p(1,k), the y-coordinate of point k in p(2,k), and, for 3-D, the
z-coordinate of point k in p(3,k). For details, see “Mesh Data” on page 2-233.

e — Mesh edges
7-by-Ne matrix | mesh associativity object

Mesh edges, returned as a 7-by-Ne matrix (2-D), or a mesh associativity object (3-D). Ne is
the number of edges in the mesh. An edge is a pair of points in p containing a boundary
between subdomains, or containing an outer boundary. For details, see “Mesh Data” on
page 2-233.
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t — Mesh elements
4-by-Nt matrix | 7-by-Nt matrix | 5-by-Nt matrix | 11-by-Nt matrix

Mesh elements, returned as a 4-by-Nt matrix (2-D with linear elements), a 7-by-Nt matrix
(2-D with quadratic elements), a 5-by-Nt matrix (3-D with linear elements), or an 11-by-Nt
matrix (3-D with quadratic elements). Nt is the number of triangles or tetrahedra in the
mesh.

The t(i,k), with i ranging from 1 through end - 1, contain indices to the corner
points and possibly edge centers of element k. For details, see “Mesh Data” on page 2-
233. The last row, t(end,k), contains the subdomain number of the element.

Tips
• Use meshToPet to obtain the p and t data for interpolation using pdeInterpolant.

See Also
FEMesh | generateMesh

Topics
“Mesh Data” on page 2-233

Introduced in R2015a
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multicuboid
Create geometry formed by several cubic cells

Syntax
gm = multicuboid(W,D,H)
gm = multicuboid(W,D,H,Name,Value)

Description
gm = multicuboid(W,D,H) creates a geometry by combining several cubic cells.

When creating each cuboid, multicuboid uses the following coordinate system.
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gm = multicuboid(W,D,H,Name,Value) creates a multi-cuboid geometry using one
or more Name,Value pair arguments.

Examples

Nested Cuboids of Same Height

Create a geometry that consists of three nested cuboids of the same height and include
this geometry in a PDE model.

Create the geometry by using the multicuboid function. The resulting geometry
consists of three cells.

gm = multicuboid([2 3 5],[4 6 10],3)

gm = 
  DiscreteGeometry with properties:

       NumCells: 3
       NumFaces: 18
       NumEdges: 36
    NumVertices: 24

Create a PDE model.

model = createpde

model = 
  PDEModel with properties:

           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: []
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Include the geometry in the model.
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model.Geometry = gm

model = 
  PDEModel with properties:

           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: [1x1 DiscreteGeometry]
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Plot the geometry.

pdegplot(model,'CellLabels','on','FaceAlpha',0.5)
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Stacked Cuboids

Create a geometry that consists of four stacked cuboids and include this geometry in a
PDE model.

Create the geometry by using the multicuboid function with the ZOffset argument.
The resulting geometry consists of four cells stacked on top of each other.

gm = multicuboid(5,10,[1 2 3 4],'ZOffset',[0 1 3 6])

gm = 
  DiscreteGeometry with properties:
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       NumCells: 4
       NumFaces: 21
       NumEdges: 36
    NumVertices: 20

Create a PDE model.

model = createpde

model = 
  PDEModel with properties:

           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: []
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Include the geometry in the model.

model.Geometry = gm

model = 
  PDEModel with properties:

           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: [1x1 DiscreteGeometry]
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Plot the geometry.

pdegplot(model,'CellLabels','on','FaceAlpha',0.5)
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Single Cuboid

Create a geometry that consists of a single cuboid and include this geometry in a PDE
model.

Use the multicuboid function to create a single cuboid. The resulting geometry consists
of one cell.

gm = multicuboid(5,10,7)

gm = 
  DiscreteGeometry with properties:
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       NumCells: 1
       NumFaces: 6
       NumEdges: 12
    NumVertices: 8

Create a PDE model.

model = createpde

model = 
  PDEModel with properties:

           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: []
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Include the geometry in the model.

model.Geometry = gm

model = 
  PDEModel with properties:

           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: [1x1 DiscreteGeometry]
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Plot the geometry.

pdegplot(model,'CellLabels','on')
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Hollow Cube

Create a hollow cube and include it as a geometry in a PDE model.

Create a hollow cube by using the multicuboid function with the Void argument. The
resulting geometry consists of one cell.

gm = multicuboid([6 10],[6 10],10,'Void',[true,false])

gm = 
  DiscreteGeometry with properties:
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       NumCells: 1
       NumFaces: 10
       NumEdges: 24
    NumVertices: 16

Create a PDE model.

model = createpde

model = 
  PDEModel with properties:

           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: []
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Include the geometry in the model.

model.Geometry = gm

model = 
  PDEModel with properties:

           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: [1x1 DiscreteGeometry]
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Plot the geometry.

pdegplot(model,'CellLabels','on','FaceAlpha',0.5)
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Input Arguments
W — Cell width
positive real number | vector of positive real numbers

Cell width, specified as a positive real number or a vector of positive real numbers. If W is
a vector, then W(i) specifies the width of the ith cell.

Width W, depth D, and height H can be scalars or vectors of the same length. For a
combination of scalar and vector inputs, multicuboid replicates the scalar arguments
into vectors of the same length.
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Note All cells in the geometry either must have the same height, or must have both the
same width and the same depth.

Example: gm = multicuboid([1 2 3],[2.5 4 5.5],5)

D — Cell depth
positive real number | vector of positive real numbers

Cell depth, specified as a positive real number or a vector of positive real numbers. If D is
a vector, then D(i) specifies the depth of the ith cell.

Width W, depth D, and height H can be scalars or vectors of the same length. For a
combination of scalar and vector inputs, multicuboid replicates the scalar arguments
into vectors of the same length.

Note All cells in the geometry either must have the same height, or must have both the
same width and the same depth.

Example: gm = multicuboid([1 2 3],[2.5 4 5.5],5)

H — Cell height
positive real number | vector of positive real numbers

Cell height, specified as a positive real number or a vector of positive real numbers. If H is
a vector, then H(i) specifies the height of the ith cell.

Width W, depth D, and height H can be scalars or vectors of the same length. For a
combination of scalar and vector inputs, multicuboid replicates the scalar arguments
into vectors of the same length.

Note All cells in the geometry either must have the same height, or must have both the
same width and the same depth.

Example: gm = multicuboid(4,5,[1 2 3],'ZOffset',[0 1 3])
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Name-Value Pair Arguments
Specify optional comma-separated pairs of Name,Value arguments. Name is the
argument name and Value is the corresponding value. Name must appear inside quotes.
You can specify several name and value pair arguments in any order as
Name1,Value1,...,NameN,ValueN.
Example: gm = multicuboid([1 2],[1 2],[3 3],'Void',[true,false])

ZOffset — Z offset for each cell
vector of 0 values (default) | vector of real numbers

Z offset for each cell, specified as a vector of real numbers. ZOffset(i) specifies the Z
offset of the ith cell. This vector must have the same length as the width vector W, depth
vector D, or height vector H.

Note The ZOffset argument is valid only if the width and depth are constant for all cells
in the geometry.

Example: gm = multicuboid(20,30,[10 10],'ZOffset',[0 10])
Data Types: double

Void — Empty cell indicator
vector of logical false values (default) | vector of logical true or false values

Empty cell indicator, specified as a vector of logical true or false values. This vector
must have the same length as the width vector W, depth vector D, or the height vector H.

The value true corresponds to an empty cell. By default, multicuboid assumes that all
cells are not empty.
Example: gm = multicuboid([1 2],[1 2],[3 3],'Void',[true,false])
Data Types: double

Output Arguments
gm — Geometry object
DiscreteGeometry object
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Geometry object, returned as a DiscreteGeometry object.

Limitations
• multicuboid lets you create only geometries consisting of stacked or nested cuboids.

For nested cuboids, the height must be the same for all cells in the geometry. For
stacked cuboids, the width and depth must be the same for all cells in the geometry.
Use the ZOffset argument to stack the cells on top of each other without overlapping
them.

• multicuboid does not let you create nested cuboids of the same width and depth.
The call multicuboid(w,d,[h1,h2,...]) is not supported.

See Also
DiscreteGeometry | multicylinder | multisphere

Introduced in R2017a
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multicylinder
Create geometry formed by several cylindrical cells

Syntax
gm = multicylinder(R,H)
gm = multicylinder(R,H,Name,Value)

Description
gm = multicylinder(R,H) creates a geometry by combining several cylindrical cells.

When creating each cylinder, multicylinder uses the following coordinate system.

gm = multicylinder(R,H,Name,Value) creates a multi-cylinder geometry using one
or more Name,Value pair arguments.
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Examples

Nested Cylinders of Same Height

Create a geometry that consists of three nested cylinders of the same height and include
this geometry in a PDE model.

Create the geometry by using the multicylinder function. The resulting geometry
consists of three cells.

gm = multicylinder([5 10 15],2)

gm = 
  DiscreteGeometry with properties:

       NumCells: 3
       NumFaces: 9
       NumEdges: 6
    NumVertices: 6

Create a PDE model.

model = createpde

model = 
  PDEModel with properties:

           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: []
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Include the geometry in the model.

model.Geometry = gm

model = 
  PDEModel with properties:

 multicylinder

5-599



           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: [1x1 DiscreteGeometry]
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Plot the geometry.

pdegplot(model,'CellLabels','on','FaceAlpha',0.5)
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Stacked Cylinders

Create a geometry that consists of three stacked cylinders and include this geometry in a
PDE model.

Create the geometry by using the multicylinder function with the ZOffset argument.
The resulting geometry consists of four cells stacked on top of each other.

gm = multicylinder(10,[1 2 3 4],'ZOffset',[0 1 3 6])

gm = 
  DiscreteGeometry with properties:

       NumCells: 4
       NumFaces: 9
       NumEdges: 5
    NumVertices: 5

Create a PDE model.

model = createpde

model = 
  PDEModel with properties:

           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: []
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Include the geometry in the model.

model.Geometry = gm

model = 
  PDEModel with properties:
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           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: [1x1 DiscreteGeometry]
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Plot the geometry.

pdegplot(model,'CellLabels','on','FaceAlpha',0.5)
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Single Cylinder

Create a geometry that consists of a single cylinder and include this geometry in a PDE
model.

Use the multicylinder function to create a single cylinder. The resulting geometry
consists of one cell.

gm = multicylinder(5,10)

gm = 
  DiscreteGeometry with properties:

       NumCells: 1
       NumFaces: 3
       NumEdges: 2
    NumVertices: 2

Create a PDE model.

model = createpde

model = 
  PDEModel with properties:

           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: []
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Include the geometry in the model.

model.Geometry = gm

model = 
  PDEModel with properties:
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           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: [1x1 DiscreteGeometry]
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Plot the geometry.

pdegplot(model,'CellLabels','on')
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Hollow Cylinder

Create a hollow cylinder and include it as a geometry in a PDE model.

Create a hollow cylinder by using the multicylinder function with the Void argument.
The resulting geometry consists of one cell.

gm = multicylinder([9 10],10,'Void',[true,false])

gm = 
  DiscreteGeometry with properties:

       NumCells: 1
       NumFaces: 4
       NumEdges: 4
    NumVertices: 4

Create a PDE model.

model = createpde

model = 
  PDEModel with properties:

           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: []
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Include the geometry in the model.

model.Geometry = gm

model = 
  PDEModel with properties:

           PDESystemSize: 1
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         IsTimeDependent: 0
                Geometry: [1x1 DiscreteGeometry]
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Plot the geometry.

pdegplot(model,'CellLabels','on','FaceAlpha',0.5)
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Input Arguments
R — Cell radius
positive real number | vector of positive real numbers

Cell radius, specified as a positive real number or a vector of positive real numbers. If R is
a vector, then R(i) specifies the radius of the ith cell.

Radius R and height H can be scalars or vectors of the same length. For a combination of
scalar and vector inputs, multicylinder replicates the scalar arguments into vectors of
the same length.

Note Either radius or height must be the same for all cells in the geometry.

Example: gm = multicylinder([1 2 3],1,'Zoffset',[0 1 3])

H — Cell height
positive real number | vector of positive real numbers

Cell height, specified as a positive real number or a vector of positive real numbers. If H is
a vector, then H(i) specifies the height of the ith cell.

Radius R and height H can be scalars or vectors of the same length. For a combination of
scalar and vector inputs, multicylinder replicates the scalar arguments into vectors of
the same length.

Note Either radius or height must be the same for all cells in the geometry.

Example: gm = multicylinder(1,[1 2 3])

Name-Value Pair Arguments
Specify optional comma-separated pairs of Name,Value arguments. Name is the
argument name and Value is the corresponding value. Name must appear inside quotes.
You can specify several name and value pair arguments in any order as
Name1,Value1,...,NameN,ValueN.
Example: gm = multicylinder([1 2],1,'Void',[true,false])
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ZOffset — Z-offset for each cell
vector of 0 values (default) | vector of real numbers

Z-offset for each cell, specified as a vector of real numbers. ZOffset(i) specifies the Z-
offset of the ith cell. This vector must have the same length as the radius vector R or
height vector H.

Note The ZOffset argument is valid only if the radius is the same for all cells in the
geometry.

Example: gm = multicylinder(20,[10 10],'ZOffset',[0 10])
Data Types: double

Void — Empty cell indicator
vector of logical false values (default) | vector of logical true or false values

Empty cell indicator, specified as a vector of logical true or false values. This vector
must have the same length as the radius vector R or the height vector H.

The value true corresponds to an empty cell. By default, multicylinder assumes that
all cells are not empty.
Example: gm = multicylinder([1 2],1,'Void',[true,false])
Data Types: double

Output Arguments
gm — Geometry object
DiscreteGeometry object

Geometry object, returned as a DiscreteGeometry object.

Tip A cylinder has one cell, three faces, and two edges. Also, since every edge has a start
and an end vertex, a cylinder has vertices. Both edges are circles, their start and end
vertices coincide. Thus, a cylinder has two vertices - one for each edge.
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Limitations
• multicylinder lets you create only geometries consisting of stacked or nested

cylinders. For nested cylinders, the height must be the same for all cells in the
geometry. For stacked cylinders, the radius must be the same for all cells in the
geometry. Use the ZOffset argument to stack the cells on top of each over without
overlapping them.

• multicylinder does not let you create nested cylinders of the same radius. The call
multicylinder(r,[h1,h2,...]) is not supported.

See Also
DiscreteGeometry | multicuboid | multisphere

Introduced in R2017a
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multisphere
Create geometry formed by several spherical cells

Syntax
gm = multisphere(R)
gm = multisphere(R,'Void',eci)

Description
gm = multisphere(R) creates a geometry by combining several spherical cells.

When creating each sphere, multisphere uses the following coordinate system.

gm = multisphere(R,'Void',eci) creates a multi-sphere geometry with empty cells.
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Examples

Nested Spheres

Create a geometry that consists of three nested spheres and include this geometry in a
PDE model.

Create the geometry by using the multisphere function. The resulting geometry
consists of three cells.

gm = multisphere([5 10 15])

gm = 
  DiscreteGeometry with properties:

       NumCells: 3
       NumFaces: 3
       NumEdges: 0
    NumVertices: 0

Create a PDE model.

model = createpde

model = 
  PDEModel with properties:

           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: []
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Include the geometry in the model.

model.Geometry = gm

model = 
  PDEModel with properties:
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           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: [1x1 DiscreteGeometry]
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Plot the geometry.

pdegplot(model,'CellLabels','on','FaceAlpha',0.2)
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Single Sphere

Create a geometry that consists of a single sphere and include this geometry in a PDE
model.

Use the multisphere function to create a single sphere. The resulting geometry consists
of one cell.

gm = multisphere(5)

gm = 
  DiscreteGeometry with properties:

       NumCells: 1
       NumFaces: 1
       NumEdges: 0
    NumVertices: 0

Create a PDE model.

model = createpde

model = 
  PDEModel with properties:

           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: []
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Include the geometry in the model.

model.Geometry = gm

model = 
  PDEModel with properties:
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           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: [1x1 DiscreteGeometry]
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Plot the geometry.

pdegplot(model,'CellLabels','on')
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Hollow Sphere

Create a hollow sphere and include it as a geometry in a PDE model.

Create a hollow sphere by using the multisphere function with the Void argument. The
resulting geometry consists of one cell.

gm = multisphere([9 10],'Void',[true,false])

gm = 
  DiscreteGeometry with properties:

       NumCells: 1
       NumFaces: 2
       NumEdges: 0
    NumVertices: 0

Create a PDE model.

model = createpde

model = 
  PDEModel with properties:

           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: []
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Include the geometry in the model.

model.Geometry = gm

model = 
  PDEModel with properties:

           PDESystemSize: 1
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         IsTimeDependent: 0
                Geometry: [1x1 DiscreteGeometry]
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]

Input Arguments
R — Cell radius
positive real number | vector of positive real numbers

Cell radius, specified as a positive real number or a vector of positive real numbers. If R is
a vector, then R(i) specifies the radius of the ith cell.
Example: gm = multisphere([1,2,3])

eci — Empty cell indicator
vector of logical true or false values

Empty cell indicator, specified as a vector of logical true and false values. This vector
must have the same length as the radius vector R.

The value true corresponds to an empty cell. By default, multisphere assumes that all
cells are not empty.
Example: gm = multisphere([1,2,3],'Void',[false,true,false])

Output Arguments
gm — Geometry object
DiscreteGeometry object

Geometry object, returned as a DiscreteGeometry object.

See Also
DiscreteGeometry | multicuboid | multicylinder
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Topics
“Heat Conduction in Multidomain Geometry with Nonuniform Heat Flux”

Introduced in R2017a
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parabolic
(Not recommended) Solve parabolic PDE problem

Note parabolic is not recommended. Use solvepde instead.

Parabolic equation solver

Solves PDE problems of the type

d∂u∂t − ∇ ⋅ c∇u + au = f

on a 2-D or 3-D region Ω, or the system PDE problem

d∂u∂t − ∇ ⋅ c⊗ ∇u + au = f

The variables c, a, f, and d can depend on position, time, and the solution u and its
gradient.

Syntax
u = parabolic(u0,tlist,model,c,a,f,d)
u = parabolic(u0,tlist,b,p,e,t,c,a,f,d)
u = parabolic(u0,tlist,Kc,Fc,B,ud,M)
u = parabolic( ___ ,rtol)
u = parabolic( ___ ,rtol,atol)
u = parabolic( ___ ,'Stats','off')

Description
u = parabolic(u0,tlist,model,c,a,f,d) produces the solution to the FEM
formulation of the scalar PDE problem

d∂u∂t − ∇ ⋅ c∇u + au = f

5 Functions — Alphabetical List

5-618



on a 2-D or 3-D region Ω, or the system PDE problem

d∂u∂t − ∇ ⋅ c⊗ ∇u + au = f

with geometry, mesh, and boundary conditions specified in model, and with initial value
u0. The variables c, a, f, and d in the equation correspond to the function coefficients c, a,
f, and d respectively.

u = parabolic(u0,tlist,b,p,e,t,c,a,f,d) solves the problem using boundary
conditions b and finite element mesh specified in [p,e,t].

u = parabolic(u0,tlist,Kc,Fc,B,ud,M) solves the problem based on finite
element matrices that encode the equation, mesh, and boundary conditions.

u = parabolic( ___ ,rtol) and u = parabolic( ___ ,rtol,atol), for any of the
previous input arguments, modify the solution process by passing to the ODE solver a
relative tolerance rtol, and optionally an absolute tolerance atol.

u = parabolic( ___ ,'Stats','off'), for any of the previous input arguments,
turns off the display of internal ODE solver statistics during the solution process.

Examples

Parabolic Equation

Solve the parabolic equation

∂u
∂t = Δu

on the square domain specified by squareg.

Create a PDE model and import the geometry.

model = createpde;
geometryFromEdges(model,@squareg);
pdegplot(model,'EdgeLabels','on')
ylim([-1.1,1.1])
axis equal
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Set Dirichlet boundary conditions u = 0 on all edges.

applyBoundaryCondition(model,'dirichlet','Edge',1:model.Geometry.NumEdges,'u',0);

Generate a relatively fine mesh.

generateMesh(model,'Hmax',0.02,'GeometricOrder','linear');

Set the initial condition to have u(0) = 1 on the disk x2 + y2 ≤ 0 . 42 and u(0) = 0
elsewhere.

p = model.Mesh.Nodes;
u0 = zeros(size(p,2),1); 
ix = find(sqrt(p(1,:).^2 + p(2,:).^2) <= 0.4); 
u0(ix) = ones(size(ix));
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Set solution times to be from 0 to 0.1 with step size 0.005.

tlist = linspace(0,0.1,21);

Create the PDE coefficients.

c = 1;
a = 0;
f = 0;
d = 1;

Solve the PDE.

u = parabolic(u0,tlist,model,c,a,f,d);

133 successful steps
0 failed attempts
268 function evaluations
1 partial derivatives
26 LU decompositions
267 solutions of linear systems

Plot the initial condition, the solution at the final time, and two intermediate solutions.

figure
subplot(2,2,1)
pdeplot(model,'XYData',u(:,1));
axis equal
title('t = 0')
subplot(2,2,2)
pdeplot(model,'XYData',u(:,5))
axis equal
title('t = 0.02')
subplot(2,2,3)
pdeplot(model,'XYData',u(:,11))
axis equal
title('t = 0.05')
subplot(2,2,4)
pdeplot(model,'XYData',u(:,end))
axis equal
title('t = 0.1')
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Parabolic Equation Using Legacy Syntax

Solve the parabolic equation

∂u
∂t = Δu

on the square domain specified by squareg, using a geometry function to specify the
geometry, a boundary function to specify the boundary conditions, and using initmesh to
create the finite element mesh.
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Specify the geometry as @squareg and plot the geometry.

g = @squareg;
pdegplot(g,'EdgeLabels','on')
ylim([-1.1,1.1])
axis equal

Set Dirichlet boundary conditions u = 0 on all edges. The squareb1 function specifies
these boundary conditions.

b = @squareb1;

Generate a relatively fine mesh.

[p,e,t] = initmesh(g,'Hmax',0.02);

 parabolic
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Set the initial condition to have u(0) = 1 on the disk x2 + y2 ≤ 0 . 42 and u(0) = 0
elsewhere.

u0 = zeros(size(p,2),1); 
ix = find(sqrt(p(1,:).^2 + p(2,:).^2) <= 0.4); 
u0(ix) = ones(size(ix));

Set solution times to be from 0 to 0.1 with step size 0.005.

tlist = linspace(0,0.1,21);

Create the PDE coefficients.

c = 1;
a = 0;
f = 0;
d = 1;

Solve the PDE.

u = parabolic(u0,tlist,b,p,e,t,c,a,f,d);

147 successful steps
0 failed attempts
296 function evaluations
1 partial derivatives
28 LU decompositions
295 solutions of linear systems

Plot the initial condition, the solution at the final time, and two intermediate solutions.

figure
subplot(2,2,1)
pdeplot(p,e,t,'XYData',u(:,1));
axis equal
title('t = 0')
subplot(2,2,2)
pdeplot(p,e,t,'XYData',u(:,5))
axis equal
title('t = 0.02')
subplot(2,2,3)
pdeplot(p,e,t,'XYData',u(:,11))
axis equal
title('t = 0.05')
subplot(2,2,4)
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pdeplot(p,e,t,'XYData',u(:,end))
axis equal
title('t = 0.1')

Parabolic Problem Using Matrix Coefficients

Create finite element matrices that encode a parabolic problem, and solve the problem.

The problem is the evolution of temperature in a conducting block. The block is a
rectangular slab.
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model = createpde(1);
importGeometry(model,'Block.stl');
handl = pdegplot(model,'FaceLabels','on');
view(-42,24)
handl(1).FaceAlpha = 0.5;

Faces 1, 4, and 6 of the slab are kept at 0 degrees. The other faces are insulated. Include
the boundary condition on faces 1, 4, and 6. You do not need to include the boundary
condition on the other faces because the default condition is insulated.

applyBoundaryCondition(model,'dirichlet','Face',[1,4,6],'u',0);

The initial temperature distribution in the block has the form
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u0 = 10−3xyz .

generateMesh(model);
p = model.Mesh.Nodes;
x = p(1,:);
y = p(2,:);
z = p(3,:);
u0 = x.*y.*z*1e-3;

The parabolic equation in toolbox syntax is

d∂u∂t − ∇ ⋅ (c∇u) + au = f .

Suppose the thermal conductivity of the block leads to a c coefficient value of 1. The
values of the other coefficients in this problem are d = 1, a = 0, and f = 0.

d = 1;
c = 1;
a = 0;
f = 0;

Create the finite element matrices that encode the problem.

[Kc,Fc,B,ud] = assempde(model,c,a,f);
[~,M,~] = assema(model,0,d,f);

Solve the problem at time steps of 1 for times ranging from 0 to 40.

tlist = linspace(0,40,41);
u = parabolic(u0,tlist,Kc,Fc,B,ud,M);

35 successful steps
0 failed attempts
72 function evaluations
1 partial derivatives
11 LU decompositions
71 solutions of linear systems

Plot the solution on the outside of the block at times 0, 10, 25, and 40. Ensure that the
coloring is the same for all plots.

umin = min(min(u));
umax = max(max(u));
subplot(2,2,1)
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pdeplot3D(model,'ColorMapData',u(:,1))
colorbar off
view(125,22)
title 't = 0'
caxis([umin umax]);
subplot(2,2,2)
pdeplot3D(model,'ColorMapData',u(:,11))
colorbar off
view(125,22)
title 't = 10'
caxis([umin umax]);
subplot(2,2,3)
pdeplot3D(model,'ColorMapData',u(:,26))
colorbar off
view(125,22)
title 't = 25'
caxis([umin umax]);
subplot(2,2,4)
pdeplot3D(model,'ColorMapData',u(:,41))
colorbar off
view(125,22)
title 't = 40'
caxis([umin umax]);
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Input Arguments
u0 — Initial condition
vector | character vector | character array | string scalar | string vector

Initial condition, specified as a scalar, vector of nodal values, character vector, character
array, string scalar, or string vector. The initial condition is the value of the solution u at
the initial time, specified as a column vector of values at the nodes. The nodes are either
p in the [p,e,t] data structure, or are model.Mesh.Nodes. For details, see “Solve
PDEs with Initial Conditions” on page 2-161.
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• If the initial condition is a constant scalar v, specify u0 as v.
• If there are Np nodes in the mesh, and N equations in the system of PDEs, specify u0

as a column vector of Np*N elements, where the first Np elements correspond to the
first component of the solution u, the second Np elements correspond to the second
component of the solution u, etc.

• Give a text expression of a function, such as 'x.^2 + 5*cos(x.*y)'. If you have a
system of N > 1 equations, give a text array such as

char('x.^2 + 5*cos(x.*y)',...
    'tanh(x.*y)./(1+z.^2)')

Example: x.^2+5*cos(y.*x)
Data Types: double | char | string
Complex Number Support: Yes

tlist — Solution times
real vector

Solution times, specified as a real vector. The solver returns the solution to the PDE at the
solution times.
Example: 0:0.2:4
Data Types: double

model — PDE model
PDEModel object

PDE model, specified as a PDEModel object.
Example: model = createpde

c — PDE coefficient
scalar | matrix | character vector | character array | string scalar | string vector |
coefficient function

PDE coefficient, specified as a scalar, matrix, character vector, character array, string
scalar, string vector, or coefficient function. c represents the c coefficient in the scalar
PDE

d∂u∂t − ∇ ⋅ c∇u + au = f
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or in the system of PDEs

d∂u∂t − ∇ ⋅ c⊗ ∇u + au = f

You can specifyc in various ways, detailed in “c Coefficient for Systems” on page 2-122.
See also “Specify Scalar PDE Coefficients in Character Form” on page 2-74, “Specify 2-D
Scalar Coefficients in Function Form” on page 2-80, and “Specify 3-D PDE Coefficients in
Function Form” on page 2-83.
Example: 'cosh(x+y.^2)'
Data Types: double | char | string | function_handle
Complex Number Support: Yes

a — PDE coefficient
scalar | matrix | character vector | character array | string scalar | string vector |
coefficient function

PDE coefficient, specified as a scalar, matrix, character vector, character array, string
scalar, string vector, or coefficient function. a represents the a coefficient in the scalar
PDE

d∂u∂t − ∇ ⋅ c∇u + au = f

or in the system of PDEs

d∂u∂t − ∇ ⋅ c⊗ ∇u + au = f

You can specifya in various ways, detailed in “a or d Coefficient for Systems” on page 2-
147. See also “Specify Scalar PDE Coefficients in Character Form” on page 2-74, “Specify
2-D Scalar Coefficients in Function Form” on page 2-80, and “Specify 3-D PDE
Coefficients in Function Form” on page 2-83.
Example: 2*eye(3)
Data Types: double | char | string | function_handle
Complex Number Support: Yes

f — PDE coefficient
scalar | matrix | character vector | character array | string scalar | string vector |
coefficient function
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PDE coefficient, specified as a scalar, matrix, character vector, character array, string
scalar, string vector, or coefficient function. f represents the f coefficient in the scalar
PDE

d∂u∂t − ∇ ⋅ c∇u + au = f

or in the system of PDEs

d∂u∂t − ∇ ⋅ c⊗ ∇u + au = f

You can specifyf in various ways, detailed in “f Coefficient for Systems” on page 2-94. See
also “Specify Scalar PDE Coefficients in Character Form” on page 2-74, “Specify 2-D
Scalar Coefficients in Function Form” on page 2-80, and “Specify 3-D PDE Coefficients in
Function Form” on page 2-83.
Example: char('sin(x)';'cos(y)';'tan(z)')
Data Types: double | char | string | function_handle
Complex Number Support: Yes

d — PDE coefficient
scalar | matrix | character vector | character array | string scalar | string vector |
coefficient function

PDE coefficient, specified as a scalar, matrix, character vector, character array, string
scalar, string vector, or coefficient function. d represents the d coefficient in the scalar
PDE

d∂u∂t − ∇ ⋅ c∇u + au = f

or in the system of PDEs

d∂u∂t − ∇ ⋅ c⊗ ∇u + au = f

You can specifyd in various ways, detailed in “a or d Coefficient for Systems” on page 2-
147. See also “Specify Scalar PDE Coefficients in Character Form” on page 2-74, “Specify
2-D Scalar Coefficients in Function Form” on page 2-80, and “Specify 3-D PDE
Coefficients in Function Form” on page 2-83.
Example: 2*eye(3)
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Data Types: double | char | string | function_handle
Complex Number Support: Yes

b — Boundary conditions
boundary matrix | boundary file

Boundary conditions, specified as a boundary matrix or boundary file. Pass a boundary file
as a function handle or as a file name.

• A boundary matrix is generally an export from the PDE Modeler app. For details of the
structure of this matrix, see “Boundary Matrix for 2-D Geometry” on page 2-168.

• A boundary file is a file that you write in the syntax specified in “Boundary Conditions
by Writing Functions” on page 2-197.

Example: b = 'circleb1', b = "circleb1", or b = @circleb1
Data Types: double | char | string | function_handle

p — Mesh points
matrix

Mesh points, specified as a 2-by-Np matrix of points, where Np is the number of points in
the mesh. For a description of the (p,e,t) matrices, see “Mesh Data” on page 2-233.

Typically, you use the p, e, and t data exported from the PDE Modeler app, or generated
by initmesh or refinemesh.
Example: [p,e,t] = initmesh(gd)
Data Types: double

e — Mesh edges
matrix

Mesh edges, specified as a 7-by-Ne matrix of edges, where Ne is the number of edges in
the mesh. For a description of the (p,e,t) matrices, see “Mesh Data” on page 2-233.

Typically, you use the p, e, and t data exported from the PDE Modeler app, or generated
by initmesh or refinemesh.
Example: [p,e,t] = initmesh(gd)
Data Types: double
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t — Mesh triangles
matrix

Mesh triangles, specified as a 4-by-Nt matrix of triangles, where Nt is the number of
triangles in the mesh. For a description of the (p,e,t) matrices, see “Mesh Data” on page
2-233.

Typically, you use the p, e, and t data exported from the PDE Modeler app, or generated
by initmesh or refinemesh.
Example: [p,e,t] = initmesh(gd)
Data Types: double

Kc — Stiffness matrix
sparse matrix | full matrix

Stiffness matrix, specified as a sparse matrix or as a full matrix. See “Elliptic Equations”
on page 5-77. Typically, Kc is the output of assempde.

Fc — Load vector
vector

Load vector, specified as a vector. See “Elliptic Equations” on page 5-77. Typically, Fc is
the output of assempde.

B — Dirichlet nullspace
sparse matrix

Dirichlet nullspace, returned as a sparse matrix. See “Algorithms” on page 5-77. Typically,
B is the output of assempde.

ud — Dirichlet vector
vector

Dirichlet vector, returned as a vector. See “Algorithms” on page 5-77. Typically, ud is the
output of assempde.

M — Mass matrix
sparse matrix | full matrix

Mass matrix. specified as a sparse matrix or a full matrix. See “Elliptic Equations” on
page 5-77.
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To obtain the input matrices for pdeeig, hyperbolic or parabolic, run both assema
and assempde:

[Kc,Fc,B,ud] = assempde(model,c,a,f);
[~,M,~] = assema(model,0,d,f);

Note Create the M matrix using assema with d, not a, as the argument before f.

Data Types: double
Complex Number Support: Yes

rtol — Relative tolerance for ODE solver
1e-3 (default) | positive real

Relative tolerance for ODE solver, specified as a positive real.
Example: 2e-4
Data Types: double

atol — Absolute tolerance for ODE solver
1e-6 (default) | positive real

Absolute tolerance for ODE solver, specified as a positive real.
Example: 2e-7
Data Types: double

Output Arguments
u — PDE solution
matrix

PDE solution, returned as a matrix. The matrix is Np*N-by-T, where Np is the number of
nodes in the mesh, N is the number of equations in the PDE (N = 1 for a scalar PDE), and
T is the number of solution times, meaning the length of tlist. The solution matrix has
the following structure.

• The first Np elements of each column in u represent the solution of equation 1, then
next Np elements represent the solution of equation 2, etc. The solution u is the value
at the corresponding node in the mesh.
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• Column i of u represents the solution at time tlist(i).

To obtain the solution at an arbitrary point in the geometry, use pdeInterpolant.

To plot the solution, use pdeplot for 2-D geometry, or see “Plot 3-D Solutions and Their
Gradients” on page 3-295.

Algorithms

Reducing Parabolic Equations to Elliptic Equations
parabolic internally calls assema, assemb, and assempde to create finite element
matrices corresponding to the problem. It calls ode15s to solve the resulting system of
ordinary differential equations.

Partial Differential Equation Toolbox solves equations of the form

m∂
2u
∂t2 + d∂u∂t − ∇ · c∇u + au = f

When the m coefficient is 0, but d is not, the documentation refers to the equation as
parabolic, whether or not it is mathematically in parabolic form.

A parabolic problem is to solve the equation

d∂u∂t − ∇ ⋅ c∇u + au = f in Ω

with the initial condition

u(x,0) = u0(x) for x∊Ω  (5-15)

where x represents a 2-D or 3-D point and there are boundary conditions of the same kind
as for the elliptic equation on ∂Ω.

The heat equation reads

ρC∂u∂t − ∇ · k∇u + h u− u∞ = f
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in the presence of distributed heat loss to the surroundings. ρ is the density, C is the
thermal capacity, k is the thermal conductivity, h is the film coefficient, u∞ is the ambient
temperature, and f is the heat source.

For time-independent coefficients, the steady-state solution of the equation is the solution
to the standard elliptic equation

–∇ · (c∇u) + au = f.  (5-16)

Assuming a mesh on Ω and t ≥ 0, expand the solution to the PDE (as a function of x) in
the Finite Element Method basis:

u(x, t) = ∑
i

Ui(t)ϕi(x)

Plugging the expansion into the PDE, multiplying with a test function ϕj, integrating over
Ω, and applying Green's formula and the boundary conditions yield

∑
i
∫
Ω

dϕ jϕi
dUi t

dt dx + ∑
i
∫
Ω

∇ϕ j ⋅ c∇ϕi + aϕ jϕi dx + ∫
∂Ω

qϕ jϕi ds Ui(t)

= ∫
Ω

fϕ j dx + ∫
∂Ω

gϕ j ds ∀ j

In matrix notation, we have to solve the linear, large and sparse ODE system

MdU
dt + KU = F

This method is traditionally called method of lines semidiscretization.

Solving the ODE with the initial value

Ui(0) = u0(xi)  (5-17)

yields the solution to the PDE at each node xi and time t. Note that K and F are the
stiffness matrix and the right-hand side of the elliptic problem

–∇ · (c∇u) + au = f in Ω  (5-18)

with the original boundary conditions, while M is just the mass matrix of the problem

–∇ · (0∇u) + du = 0 in Ω.  (5-19)
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When the Dirichlet conditions are time dependent, F contains contributions from time
derivatives of h and r. These derivatives are evaluated by finite differences of the user-
specified data.

The ODE system is ill conditioned. Explicit time integrators are forced by stability
requirements to very short time steps while implicit solvers can be expensive since they
solve an elliptic problem at every time step. The numerical integration of the ODE system
is performed by the MATLAB ODE Suite functions, which are efficient for this class of
problems. The time step is controlled to satisfy a tolerance on the error, and factorizations
of coefficient matrices are performed only when necessary. When coefficients are time
dependent, the necessity of reevaluating and refactorizing the matrices each time step
may still make the solution time consuming, although parabolic reevaluates only that
which varies with time. In certain cases a time-dependent Dirichlet matrix h(t) may cause
the error control to fail, even if the problem is mathematically sound and the solution u(t)
is smooth. This can happen because the ODE integrator looks only at the reduced solution
v with u = Bv + ud. As h changes, the pivoting scheme employed for numerical stability
may change the elimination order from one step to the next. This means that B, v, and ud
all change discontinuously, although u itself does not.

See Also
solvepde

Topics
“PDE Problem Setup”

Introduced before R2006a
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pdeadgsc
(Not recommended) Select triangles using relative tolerance criterion

Note pdeadgsc is not recommended.

Syntax
bt = pdeadgsc(p,t,c,a,f,u,errf,tol)

Description
bt = pdeadgsc(p,t,c,a,f,u,errf,tol) returns indices of triangles to be refined in
bt. Used from adaptmesh to select the triangles to be further refined. The geometry of
the PDE problem is given by the mesh data p and t. For more details, see “Mesh Data” on
page 2-233.

c,a, and f are PDE coefficients.

u is the current solution, given as a column vector.

errf is the error indicator, as calculated by pdejmps.

tol is a tolerance parameter.

Triangles are selected using the criterion errf>tol*scale, where scale is calculated
as follows:

Let cmax, amax, fmax, and umax be the maximum of c, a, f, and u, respectively. Let l be
the side of the smallest axis-aligned square that contains the geometry.

Then scale = max(fmax*l^2,amax*umax*l^2,cmax*umax). The scaling makes the
tol parameter independent of the scaling of the equation and the geometry.
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See Also
generateMesh

Introduced before R2006a
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pdeadworst
(Not recommended) Select triangles relative to worst value

Note pdeadworst is not recommended.

Syntax
bt = pdeadworst(p,t,c,a,f,u,errf,wlevel)

Description
bt = pdeadworst(p,t,c,a,f,u,errf,wlevel) returns indices of triangles to be
refined in bt. Used from adaptmesh to select the triangles to be further refined.

The geometry of the PDE problem is given by the mesh data p and t. For details, see
“Mesh Data” on page 2-233.

c, a, and f are PDE coefficients.

u is the current solution, given as a column vector.

errf is the error indicator, as calculated by pdejmps.

wlevel is the error level relative to the worst error. wlevel must be between 0 and 1.

Triangles are selected using the criterion errf>wlevel*max(errf).

See Also
generateMesh

Introduced before R2006a
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pdearcl
Interpolation between parametric representation and arc length

Syntax
pp = pdearcl(p,xy,s,s0,s1)

Description
pp = pdearcl(p,xy,s,s0,s1) returns parameter values for a parametrized curve
corresponding to a given set of arc length values.

p is a monotone row vector of parameter values and xy is a matrix with two rows giving
the corresponding points on the curve.

The first point of the curve is given the arc length value s0 and the last point the value
s1.

On return, pp contains parameter values corresponding to the arc length values specified
in s.

The arc length values s, s0, and s1 can be an affine transformation of the arc length.

See the examples in “Geometry”.

Introduced before R2006a
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pdecgrad
(Not recommended) Flux of PDE solution

Note pdecgrad is not recommended. Use evaluateCGradient instead.

Syntax
[cgxu,cgyu] = pdecgrad(p,t,c,u)

[cgxu,cgyu] = pdecgrad(p,t,c,u,time)

[cgxu,cgyu] = pdecgrad(p,t,c,u,time,sdl)

Description
[cgxu,cgyu] = pdecgrad(p,t,c,u) returns the flux, c⊗ ∇u, evaluated at the center
of each triangle.

Row i of cgxu contains

∑
j = 1

N
ci j11

∂u j
∂x + ci j12

∂u j
∂y

Row i of cgyu contains

∑
j = 1

N
ci j21

∂u j
∂x + ci j22

∂u j
∂y

There is one column for each triangle in t in both cgxu and cgyu.

The gradient computed by pdegrad is actually the same everywhere in the triangle
interior because pdegrad uses only linear basis functions. The boundaries of triangles
are a special case: here the derivatives might be discontinuous. However, the flux c⊗ ∇u
can vary inside a triangle because the coefficient c can vary.
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The geometry of the PDE problem is given by the mesh data p and t. Details on the mesh
data representation can be found in the entry on initmesh.

The coefficient c of the PDE problem can be given in a variety of ways. See “PDE
Coefficients”.

The scalar optional argument time is used for parabolic and hyperbolic problems, if c
depends on t, the time.

The optional argument sdl restricts the computation to the subdomains in the list sdl.

See Also
evaluateCGradient | evaluateGradient

Introduced before R2006a
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pdecirc
Package: pde

Draw circle in PDE Modeler app

Syntax
pdecirc(xc,yc,R)
pdecirc(xc,yc,R,label)

Description
pdecirc(xc,yc,R) draws a circle with the center at (xc,yc) and the radius R. The
pdecirc command opens the PDE Modeler app with the specified circle already drawn in
it. If the app is already open, pdecirc adds the specified circle to the app window
without deleting any existing shapes.

pdecirc updates the state of the geometry description matrix inside the PDE Modeler
app to include the circle. You can export the geometry description matrix from the PDE
Modeler app to the MATLAB Workspace by selecting DrawExport Geometry
Description, Set Formula, Labels.... For details on the format of the geometry
description matrix, see decsg.

pdecirc(xc,yc,R,label) assigns a name to the circle. Otherwise, pdecirc uses a
default name, such as C1, C2, and so on.

Examples

Draw Circle in PDE Modeler App

Open the PDE Modeler app window containing a circle with the center at (0,0) and the
radius 1.

pdecirc(0,0,1)
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Call the pdecirc command again to draw a circle with the center at (0,0.25) and the
radius 0.5. The pdecirc command adds the second circle to the app window without
deleting the first.

pdecirc(0,0.25,0.5)
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Assign Name to Circle in PDE Modeler App

Open the PDE Modeler app window containing a circle with the center at (0,0) and the
radius 1. Assign the name circle1 to this circle.

pdecirc(0,0,1,'circle1')
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Input Arguments
xc — x-coordinate of center
real number

x-coordinate of the center of the circle, specified as a real number.
Data Types: double

yc — y-coordinate of center
real number

y-coordinate of the center of the circle, specified as a real number.
Data Types: double

R — Radius
positive number

Radius of the circle, specified as a positive number.
Data Types: double

label — Name
character vector | string scalar

Name of the circle, specified as a character vector or string scalar.
Data Types: char | string

Tips
pdecirc opens the PDE Modeler app and draws a circle. If, instead, you want to draw
circles in a MATLAB figure window, choose one of these approaches:

• Use the plot command, for example:

t = linspace(0,2*pi);
plot(cos(t),sin(t))

• Use the rectangle function with the Curvature name-value pair set to [1 1].
• Use the Image Processing Toolbox™ viscircles function.
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See Also
PDE Modeler | pdeellip | pdepoly | pderect

Introduced before R2006a
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pdecont
Shorthand command for contour plot

Note This page describes the legacy workflow. New features might not be compatible
with the legacy workflow.

Syntax
pdecont(p,t,u)

pdecont(p,t,u,n)

pdecont(p,t,u,v)

h = pdecont(p,t,u)

h = pdecont(p,t,u,n)

h = pdecont(p,t,u,v)

Description
pdecont(p,t,u) draws 10 level curves of the PDE node or triangle data u. h =
pdecont(p,t,u) additionally returns handles to the drawn axes objects.

If u is a column vector, node data is assumed. If u is a row vector, triangle data is
assumed.

The geometry of the PDE problem is given by the mesh data p and t. For details on the
mesh data representation, see “Mesh Data” on page 2-233.

pdecont(p,t,u,n) plots using n levels.

pdecont(p,t,u,v) plots using the levels specified by v.

This command is just shorthand for the call
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pdeplot(p,[],t,'XYData',u,'XYStyle','off','Contour',...
'on','Levels',n,'ColorBar','off'); 

If you want to have more control over your contour plot, use pdeplot instead of
pdecont.

Examples

Contour Plot of the Solution

Plot the contours of the solution to the equation −Δu = 1 over the geometry defined by
the L-shaped membrane. Use Dirichlet boundary conditions u = 0 on ∂Ω.

[p,e,t] = initmesh('lshapeg'); 
[p,e,t] = refinemesh('lshapeg',p,e,t); 
u = assempde('lshapeb',p,e,t,1,0,1); 
pdecont(p,t,u)

 pdecont

5-653



See Also
pdemesh | pdeplot | pdesurf

Introduced before R2006a
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pdeeig
(Not recommended) Solve eigenvalue PDE problem

Note pdeeig is not recommended. Use solvepdeeig instead.

Syntax
[v,l] = pdeeig(model,c,a,d,r)
[v,l] = pdeeig(b,p,e,t,c,a,d,r)
[v,l] = pdeeig(Kc,B,M,r)

Description
[v,l] = pdeeig(model,c,a,d,r) produces the solution to the FEM formulation of
the scalar PDE eigenvalue problem

−∇ ⋅ (c∇u) + au = λdu on Ω

or the system PDE eigenvalue problem

−∇ ⋅ (c⊗ ∇u) + au = λdu on Ω

with geometry, boundary conditions, and mesh specified in model, a PDEModel object.
See “Solve Problems Using Legacy PDEModel Objects” on page 2-3.

The eigenvalue PDE problem is a homogeneous problem, i.e., only boundary conditions
where g = 0 and r = 0 can be used. The nonhomogeneous part is removed automatically.

[v,l] = pdeeig(b,p,e,t,c,a,d,r) solves for boundary conditions described in b,
and the finite element mesh in [p,e,t].

[v,l] = pdeeig(Kc,B,M,r) produces the solution to the generalized sparse matrix
eigenvalue problem

Kc ui = λB´MBui
u = Bui
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with Real(λ) in the interval r.

Examples

Eigenvalues and Eigenvectors of L-Shaped Membrane

Compute the eigenvalues that are less than 100, and compute the corresponding
eigenmodes for −∇u = λu on the geometry of the L-shaped membrane.

model = createpde;
geometryFromEdges(model,@lshapeg);
applyBoundaryCondition(model,'edge',1:model.Geometry.NumEdges,'u',0);
generateMesh(model,'GeometricOrder','linear','Hmax',0.02);
c = 1;
a = 0;
d = 1;
r = [-Inf 100];
[v,l] = pdeeig(model,c,a,d,r);

              Basis= 10,  Time=   0.89,  New conv eig=  0
              Basis= 11,  Time=   0.89,  New conv eig=  0
              Basis= 12,  Time=   0.91,  New conv eig=  0
              Basis= 13,  Time=   0.91,  New conv eig=  0
              Basis= 14,  Time=   0.92,  New conv eig=  0
              Basis= 15,  Time=   0.92,  New conv eig=  0
              Basis= 16,  Time=   0.94,  New conv eig=  1
              Basis= 17,  Time=   0.95,  New conv eig=  4
              Basis= 18,  Time=   0.95,  New conv eig=  4
              Basis= 19,  Time=   0.97,  New conv eig=  4
              Basis= 20,  Time=   0.97,  New conv eig=  4
              Basis= 21,  Time=   1.02,  New conv eig=  4
              Basis= 22,  Time=   1.20,  New conv eig=  4
              Basis= 23,  Time=   1.20,  New conv eig=  4
              Basis= 24,  Time=   1.20,  New conv eig=  4
              Basis= 25,  Time=   1.36,  New conv eig=  5
              Basis= 26,  Time=   1.36,  New conv eig=  5
              Basis= 27,  Time=   1.38,  New conv eig=  5
              Basis= 28,  Time=   1.38,  New conv eig=  6
              Basis= 29,  Time=   1.38,  New conv eig=  7
              Basis= 30,  Time=   1.52,  New conv eig=  7
              Basis= 31,  Time=   1.67,  New conv eig=  7
              Basis= 32,  Time=   1.67,  New conv eig=  8
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              Basis= 33,  Time=   1.69,  New conv eig=  8
              Basis= 34,  Time=   1.70,  New conv eig=  8
              Basis= 35,  Time=   1.81,  New conv eig=  9
              Basis= 36,  Time=   1.81,  New conv eig=  9
              Basis= 37,  Time=   1.83,  New conv eig=  9
              Basis= 38,  Time=   1.84,  New conv eig=  9
              Basis= 39,  Time=   1.84,  New conv eig=  9
              Basis= 40,  Time=   2.09,  New conv eig=  9
              Basis= 41,  Time=   2.09,  New conv eig=  9
              Basis= 42,  Time=   2.09,  New conv eig= 11
              Basis= 43,  Time=   2.22,  New conv eig= 11
              Basis= 44,  Time=   2.23,  New conv eig=  9
              Basis= 45,  Time=   2.23,  New conv eig= 12
              Basis= 46,  Time=   2.31,  New conv eig= 14
              Basis= 47,  Time=   2.55,  New conv eig= 14
              Basis= 48,  Time=   2.55,  New conv eig= 15
              Basis= 49,  Time=   2.70,  New conv eig= 17
              Basis= 50,  Time=   2.70,  New conv eig= 17
              Basis= 51,  Time=   2.84,  New conv eig= 18
              Basis= 52,  Time=   2.95,  New conv eig= 19
              Basis= 53,  Time=   3.20,  New conv eig= 19
              Basis= 54,  Time=   3.20,  New conv eig= 20
              Basis= 55,  Time=   3.45,  New conv eig= 21
              Basis= 56,  Time=   3.61,  New conv eig= 24
              Basis= 57,  Time=   3.86,  New conv eig= 27
              Basis= 58,  Time=   3.86,  New conv eig= 28
End of sweep: Basis= 58,  Time=   3.88,  New conv eig= 28
              Basis= 38,  Time=   4.25,  New conv eig=  0
              Basis= 39,  Time=   4.25,  New conv eig=  0
              Basis= 40,  Time=   4.25,  New conv eig=  0
End of sweep: Basis= 40,  Time=   4.50,  New conv eig=  0

l(1)                    % first eigenvalue

ans = 9.6506

Display the first eigenmode, and compare it to the built-in membrane plot.

pdeplot(model,'XYData',v(:,1),'ZData',v(:,1))
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figure 
membrane(1,20,9,9)      % the MATLAB function
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Compute the sixteenth eigenvalue, and plot the sixteenth eigenmode.

l(16)                   % sixteenth eigenvalue

ans = 92.5248

figure
pdeplot(model,'XYData',v(:,16),'ZData',v(:,16))    % sixteenth eigenmode
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Eigenvalues and Eigenvectors of the L-Shaped Membrane Using Legacy Syntax

Compute the eigenvalues that are less than 100, and compute the corresponding
eigenmodes for −∇u = λu on the geometry of the L-shaped membrane, using the legacy
syntax.

Use the geometry in lshapeg. For more information about this syntax, see “Parametrized
Function for 2-D Geometry Creation” on page 2-17.

g = @lshapeg;
pdegplot(g,'EdgeLabels','on')
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axis equal
ylim([-1.1,1.1])

Set zero Dirichlet boundary conditions using the lshapeb function. For more information
about this syntax, see “Boundary Conditions by Writing Functions” on page 2-197.

b = @lshapeb;

Set coefficients c = 1, a = 0, and d = 1. Collect eigenvalues up to 100.

c = 1;
a = 0;
d = 1;
r = [-Inf 100];
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Generate a mesh and solve the eigenvalue problem.

[p,e,t] = initmesh(g,'Hmax',0.02);
[v,l] = pdeeig(b,p,e,t,c,a,d,r);

              Basis= 10,  Time=   2.53,  New conv eig=  0
              Basis= 11,  Time=   2.63,  New conv eig=  0
              Basis= 12,  Time=   2.70,  New conv eig=  0
              Basis= 13,  Time=   2.70,  New conv eig=  0
              Basis= 14,  Time=   2.81,  New conv eig=  0
              Basis= 15,  Time=   2.81,  New conv eig=  1
              Basis= 16,  Time=   2.92,  New conv eig=  1
              Basis= 17,  Time=   3.00,  New conv eig=  3
              Basis= 18,  Time=   3.00,  New conv eig=  4
              Basis= 19,  Time=   3.13,  New conv eig=  4
              Basis= 20,  Time=   3.22,  New conv eig=  4
              Basis= 21,  Time=   3.31,  New conv eig=  4
              Basis= 22,  Time=   3.33,  New conv eig=  4
              Basis= 23,  Time=   3.33,  New conv eig=  4
              Basis= 24,  Time=   3.42,  New conv eig=  5
              Basis= 25,  Time=   3.53,  New conv eig=  5
              Basis= 26,  Time=   3.55,  New conv eig=  5
              Basis= 27,  Time=   3.55,  New conv eig=  6
              Basis= 28,  Time=   3.58,  New conv eig=  7
              Basis= 29,  Time=   3.59,  New conv eig=  7
              Basis= 30,  Time=   3.69,  New conv eig=  7
              Basis= 31,  Time=   3.84,  New conv eig=  7
              Basis= 32,  Time=   3.84,  New conv eig=  8
              Basis= 33,  Time=   3.95,  New conv eig=  8
              Basis= 34,  Time=   4.08,  New conv eig=  8
              Basis= 35,  Time=   4.08,  New conv eig=  9
              Basis= 36,  Time=   4.27,  New conv eig=  9
              Basis= 37,  Time=   4.33,  New conv eig=  9
              Basis= 38,  Time=   4.34,  New conv eig=  9
              Basis= 39,  Time=   4.34,  New conv eig=  9
              Basis= 40,  Time=   4.34,  New conv eig=  9
              Basis= 41,  Time=   4.45,  New conv eig=  9
              Basis= 42,  Time=   4.58,  New conv eig= 10
              Basis= 43,  Time=   4.58,  New conv eig= 11
              Basis= 44,  Time=   4.69,  New conv eig= 12
              Basis= 45,  Time=   4.70,  New conv eig= 12
              Basis= 46,  Time=   4.72,  New conv eig= 14
              Basis= 47,  Time=   4.80,  New conv eig= 15
              Basis= 48,  Time=   4.88,  New conv eig= 16
              Basis= 49,  Time=   4.95,  New conv eig= 17
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              Basis= 50,  Time=   4.95,  New conv eig= 17
              Basis= 51,  Time=   5.17,  New conv eig= 18
              Basis= 52,  Time=   5.30,  New conv eig= 18
              Basis= 53,  Time=   5.38,  New conv eig= 19
              Basis= 54,  Time=   5.50,  New conv eig= 19
              Basis= 55,  Time=   5.63,  New conv eig= 22
              Basis= 56,  Time=   5.63,  New conv eig= 24
              Basis= 57,  Time=   5.70,  New conv eig= 28
End of sweep: Basis= 57,  Time=   5.75,  New conv eig= 28
              Basis= 38,  Time=   9.30,  New conv eig=  0
              Basis= 39,  Time=   9.80,  New conv eig=  0
              Basis= 40,  Time=  10.17,  New conv eig=  0
              Basis= 41,  Time=  10.41,  New conv eig=  0
              Basis= 42,  Time=  10.64,  New conv eig=  0
End of sweep: Basis= 42,  Time=  10.69,  New conv eig=  0

Find the first eigenvalue.

l(1)

ans = 9.6481

Eigenvalues and Eigenvectors Using Finite Element Matrices

Import a simple 3-D geometry and find eigenvalues and eigenvectors from the associated
finite element matrices.

Create a model and import the BracketWithHole.stl geometry.

model = createpde();
importGeometry(model,'BracketWithHole.stl');
figure
pdegplot(model,'FaceLabels','on')
view(30,30)
title('Bracket with Face Labels')
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figure
pdegplot(model,'FaceLabels','on')
view(-134,-32)
title('Bracket with Face Labels, Rear View')
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Set coefficients c = 1, a = 0, and d = 1. Collect eigenvalues that are less than 100.

c = 1;
a = 0;
d = 1;
r = [-Inf 100];

Generate a mesh for the model.

generateMesh(model);

Create the associated finite element matrices.

[Kc,~,B,~] = assempde(model,c,a,0);
[~,M,~] = assema(model,0,d,0);
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Solve the eigenvalue problem.

[v,l] = pdeeig(Kc,B,M,r);

              Basis= 10,  Time=   0.88,  New conv eig=  0
              Basis= 11,  Time=   0.98,  New conv eig=  0
              Basis= 12,  Time=   1.11,  New conv eig=  0
              Basis= 13,  Time=   1.11,  New conv eig=  1
              Basis= 14,  Time=   1.14,  New conv eig=  1
              Basis= 15,  Time=   1.17,  New conv eig=  1
              Basis= 16,  Time=   1.19,  New conv eig=  2
              Basis= 17,  Time=   1.19,  New conv eig=  3
End of sweep: Basis= 17,  Time=   1.20,  New conv eig=  3
              Basis= 13,  Time=   1.48,  New conv eig=  0
End of sweep: Basis= 13,  Time=   1.50,  New conv eig=  0

Look at the first two eigenvalues.

l([1,2])

ans = 2×1

    0.0000
   42.8670

Plot the solution corresponding to eigenvalue 2.

pdeplot3D(model,'ColorMapData',v(:,2))
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Input Arguments
model — PDE model
PDEModel object

PDE model, specified as a PDEModel object.
Example: model = createpde

c — PDE coefficient
scalar | matrix | character vector | character array | string scalar | string vector |
coefficient function
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PDE coefficient, specified as a scalar, matrix, character vector, character array, string
scalar, string vector, or coefficient function. c represents the c coefficient in the scalar
PDE

−∇ ⋅ (c∇u) + au = λdu on Ω

or the system PDE eigenvalue problem

−∇ ⋅ (c⊗ ∇u) + au = λdu on Ω

There are a wide variety of ways of specifying c, detailed in “c Coefficient for Systems” on
page 2-122. See also “Specify Scalar PDE Coefficients in Character Form” on page 2-74,
“Specify 2-D Scalar Coefficients in Function Form” on page 2-80, and “Specify 3-D PDE
Coefficients in Function Form” on page 2-83.
Example: 'cosh(x+y.^2)'
Data Types: double | char | string | function_handle
Complex Number Support: Yes

a — PDE coefficient
scalar | matrix | character vector | character array | string scalar | string vector |
coefficient function

PDE coefficient, specified as a scalar, matrix, character vector, character array, string
scalar, string vector, or coefficient function. a represents the a coefficient in the scalar
PDE

−∇ ⋅ (c∇u) + au = λdu on Ω

or the system PDE eigenvalue problem

−∇ ⋅ (c⊗ ∇u) + au = λdu on Ω

There are a wide variety of ways of specifying a, detailed in “a or d Coefficient for
Systems” on page 2-147. See also “Specify Scalar PDE Coefficients in Character Form” on
page 2-74, “Specify 2-D Scalar Coefficients in Function Form” on page 2-80, and “Specify
3-D PDE Coefficients in Function Form” on page 2-83.
Example: 2*eye(3)
Data Types: double | char | string | function_handle
Complex Number Support: Yes
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d — PDE coefficient
scalar | matrix | character vector | character array | string scalar | string vector |
coefficient function

PDE coefficient, specified as a scalar, matrix, character vector, character array, string
scalar, string vector, or coefficient function. d represents the d coefficient in the scalar
PDE

−∇ ⋅ (c∇u) + au = λdu on Ω

or the system PDE eigenvalue problem

−∇ ⋅ (c⊗ ∇u) + au = λdu on Ω

There are a wide variety of ways of specifying d, detailed in “a or d Coefficient for
Systems” on page 2-147. See also “Specify Scalar PDE Coefficients in Character Form” on
page 2-74, “Specify 2-D Scalar Coefficients in Function Form” on page 2-80, and “Specify
3-D PDE Coefficients in Function Form” on page 2-83.
Example: 2*eye(3)
Data Types: double | char | string | function_handle
Complex Number Support: Yes

r — Eigenvalue range
two-element real vector

Eigenvalue range, specified as a two-element real vector. Real parts of eigenvalues λ fall
in the range r(1) ≤ λ ≤ r(2). r(1) can be -Inf. The algorithm returns all eigenvalues
in this interval in the l output, up to a maximum of 99 eigenvalues.
Example: [-Inf,100]
Data Types: double

b — Boundary conditions
boundary matrix | boundary file

Boundary conditions, specified as a boundary matrix or boundary file. Pass a boundary file
as a function handle or as a file name.

• A boundary matrix is generally an export from the PDE Modeler app. For details of the
structure of this matrix, see “Boundary Matrix for 2-D Geometry” on page 2-168.
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• A boundary file is a file that you write in the syntax specified in “Boundary Conditions
by Writing Functions” on page 2-197.

Example: b = 'circleb1', b = "circleb1", or b = @circleb1
Data Types: double | char | string | function_handle

p — Mesh points
matrix

Mesh points, specified as a 2-by-Np matrix of points, where Np is the number of points in
the mesh. For a description of the (p,e,t) matrices, see “Mesh Data” on page 2-233.

Typically, you use the p, e, and t data exported from the PDE Modeler app, or generated
by initmesh or refinemesh.
Example: [p,e,t] = initmesh(gd)
Data Types: double

e — Mesh edges
matrix

Mesh edges, specified as a 7-by-Ne matrix of edges, where Ne is the number of edges in
the mesh. For a description of the (p,e,t) matrices, see “Mesh Data” on page 2-233.

Typically, you use the p, e, and t data exported from the PDE Modeler app, or generated
by initmesh or refinemesh.
Example: [p,e,t] = initmesh(gd)
Data Types: double

t — Mesh triangles
matrix

Mesh triangles, specified as a 4-by-Nt matrix of triangles, where Nt is the number of
triangles in the mesh. For a description of the (p,e,t) matrices, see “Mesh Data” on page
2-233.

Typically, you use the p, e, and t data exported from the PDE Modeler app, or generated
by initmesh or refinemesh.
Example: [p,e,t] = initmesh(gd)
Data Types: double
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Kc — Stiffness matrix
sparse matrix | full matrix

Stiffness matrix, specified as a sparse matrix or as a full matrix. See “Elliptic Equations”
on page 5-77. Typically, Kc is the output of assempde.

B — Dirichlet nullspace
sparse matrix

Dirichlet nullspace, returned as a sparse matrix. See “Algorithms” on page 5-77. Typically,
B is the output of assempde.

M — Mass matrix
sparse matrix | full matrix

Mass matrix. specified as a sparse matrix or a full matrix. See “Elliptic Equations” on
page 5-77.

To obtain the input matrices for pdeeig, hyperbolic or parabolic, run both assema
and assempde:

[Kc,Fc,B,ud] = assempde(model,c,a,f);
[~,M,~] = assema(model,0,d,f);

Note Create the M matrix using assema with d, not a, as the argument before f.

Data Types: double
Complex Number Support: Yes

Output Arguments
v — Eigenvectors
matrix

Eigenvectors, returned as a matrix. Suppose

• Np is the number of mesh nodes
• N is the number of equations
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• ev is the number of eigenvalues returned in l

Then v has size Np*N-by-ev. Each column of v corresponds to the eigenvectors of one
eigenvalue. In each column, the first Np elements correspond to the eigenvector of
equation 1 evaluated at the mesh nodes, the next Np elements correspond to equation 2,
etc.

Note Eigenvectors are determined only up to multiple by a scalar, including a negative
scalar.

l — Eigenvalues
vector

Eigenvalues, returned as a vector. The real parts of l are in the interval r. The real parts
of l are monotone increasing.

Limitations
In the standard case c and d are positive in the entire region. All eigenvalues are positive,
and 0 is a good choice for a lower bound of the interval. The cases where either c or d is
zero are discussed next.

• If d = 0 in a subregion, the mass matrix M becomes singular. This does not cause any
trouble, provided that c > 0 everywhere. The pencil (K,M) has a set of infinite
eigenvalues.

• If c = 0 in a subregion, the stiffness matrix K becomes singular, and the pencil (K,M)
has many zero eigenvalues. With an interval containing zero, pdeeig goes on for a
very long time to find all the zero eigenvalues. Choose a positive lower bound away
from zero but below the smallest nonzero eigenvalue.

• If there is a region where both c = 0 and d = 0, we get a singular pencil. The whole
eigenvalue problem is undetermined, and any value is equally plausible as an
eigenvalue.

Some of the awkward cases are detected by pdeeig. If the shifted matrix is singular,
another shift is attempted. If the matrix with the new shift is still singular a good guess is
that the entire pencil (K,M) is singular.
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If you try any problem not belonging to the standard case, you must use your knowledge
of the original physical problem to interpret the results from the computation.

Tips
• The equation coefficients cannot depend on the solution u or its gradient.

Algorithms

Eigenvalue Equations
Partial Differential Equation Toolbox software handles the following basic eigenvalue
problem:

−∇ ⋅ c∇u + au = λdu

where λ is an unknown complex number. In solid mechanics, this is a problem associated
with wave phenomena describing, e.g., the natural modes of a vibrating membrane. In
quantum mechanics λ is the energy level of a bound state in the potential well a(x), where
x represents a 2-D or 3-D point.

The numerical solution is found by discretizing the equation and solving the resulting
algebraic eigenvalue problem. Let us first consider the discretization. Expand u in the
FEM basis, multiply with a basis element, and integrate on the domain Ω. This yields the
generalized eigenvalue equation

KU = λMU  (5-20)

where the mass matrix corresponds to the right side, i.e.,

Mi, j = ∫
Ω

d(x)ϕ j(x)ϕi(x) dx

The matrices K and M are produced by calling assema for the equations

–∇ · (c∇u) + au = 0 and –∇ · (0∇u) + du = 0  (5-21)
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In the most common case, when the function d(x) is positive, the mass matrix M is
positive definite symmetric. Likewise, when c(x) is positive and we have Dirichlet
boundary conditions, the stiffness matrix K is also positive definite.

The generalized eigenvalue problem, KU = λMU, is now solved by the Arnoldi algorithm
applied to a shifted and inverted matrix with restarts until all eigenvalues in the user-
specified interval have been found.

Let us describe how this is done in more detail. You may want to look at the examples
“Eigenvalues and Eigenmodes of L-Shaped Membrane” on page 3-251 or “Eigenvalues
and Eigenmodes of Square” on page 3-263, where actual runs are reported.

First a shift µ is determined close to where we want to find the eigenvalues. When both K
and M are positive definite, it is natural to take µ = 0, and get the smallest eigenvalues; in
other cases take any point in the interval [lb,ub] where eigenvalues are sought. Subtract
µM from the eigenvalue equation and get (K - µM)U = (λ - µ)MU. Then multiply with the
inverse of this shifted matrix and get

1
λ− μU = K − μM −1MU

This is a standard eigenvalue problem AU = θU, with the matrix A = (K – µM)-1M and
eigenvalues

θi = 1
λi− μ

where i = 1, . . ., n. The largest eigenvalues θi of the transformed matrix A now
correspond to the eigenvalues λi = µ + 1/θi of the original pencil (K,M) closest to the shift
µ.

The Arnoldi algorithm computes an orthonormal basis V where the shifted and inverted
operator A is represented by a Hessenberg matrix H,

AVj = VjHj,j + Ej.  (5-22)

(The subscripts mean that Vj and Ej have j columns and Hj,j has j rows and columns. When
no subscripts are used we deal with vectors and matrices of size n.)

Some of the eigenvalues of this Hessenberg matrix Hj,j eventually give good
approximations to the eigenvalues of the original pencil (K,M) when the basis grows in
dimension j, and less and less of the eigenvector is hidden in the residual matrix Ej.
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The basis V is built one column vj at a time. The first vector v1 is chosen at random, as n
normally distributed random numbers. In step j, the first j vectors are already computed
and form the n ×j matrix Vj. The next vector vj+1 is computed by first letting A operate on
the newest vector vj, and then making the result orthogonal to all the previous vectors.

This is formulated as h j + 1v j + 1 = Av j− V jh j, where the column vector hj consists of the
Gram-Schmidt coefficients, and hj+1,j is the normalization factor that gives vj+1 unit length.
Put the corresponding relations from previous steps in front of this and get

AV j = V jH j, j + v j + 1h j + 1, je j
T

where Hj,j is a j×j Hessenberg matrix with the vectors hj as columns. The second term on
the right-hand side has nonzeros only in the last column; the earlier normalization factors
show up in the subdiagonal of Hj,j.

The eigensolution of the small Hessenberg matrix H gives approximations to some of the
eigenvalues and eigenvectors of the large matrix operator Aj,j in the following way.
Compute eigenvalues θi and eigenvectors si of Hj,j,

H j, jsi = siθi, i = 1, ..., j

Then yi = Vjsi is an approximate eigenvector of A, and its residual is

ri = Ayi− yiθi = AV jsi− V jsiθi = (AV j− V jH j, j)si = v j + 1h j + 1, jsi, j

This residual has to be small in norm for θi to be a good eigenvalue approximation. The
norm of the residual is

ri = h j + 1, js j, i

the product of the last subdiagonal element of the Hessenberg matrix and the last
element of its eigenvector. It seldom happens that hj+1,j gets particularly small, but after
sufficiently many steps j there are always some eigenvectors si with small last elements.
The long vector Vj+1 is of unit norm.

It is not necessary to actually compute the eigenvector approximation yi to get the norm
of the residual; we only need to examine the short vectors si, and flag those with tiny last
components as converged. In a typical case n may be 2000, while j seldom exceeds 50, so
all computations that involve only matrices and vectors of size j are much cheaper than
those involving vectors of length n.
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This eigenvalue computation and test for convergence is done every few steps j, until all
approximations to eigenvalues inside the interval [lb,ub] are flagged as converged. When
n is much larger than j, this is done very often, for smaller n more seldom. When all
eigenvalues inside the interval have converged, or when j has reached a prescribed
maximum, the converged eigenvectors, or more appropriately Schur vectors, are
computed and put in the front of the basis V.

After this, the Arnoldi algorithm is restarted with a random vector, if all approximations
inside the interval are flagged as converged, or else with the best unconverged
approximate eigenvector yi. In each step j of this second Arnoldi run, the vector is made
orthogonal to all vectors in V including the converged Schur vectors from the previous
runs. This way, the algorithm is applied to a projected matrix, and picks up a second copy
of any double eigenvalue there may be in the interval. If anything in the interval
converges during this second run, a third is attempted and so on, until no more
approximate eigenvalues θi show up inside. Then the algorithm signals convergence. If
there are still unconverged approximate eigenvalues after a prescribed maximum number
of steps, the algorithm signals nonconvergence and reports all solutions it has found.

This is a heuristic strategy that has worked well on both symmetric, nonsymmetric, and
even defective eigenvalue problems. There is a tiny theoretical chance of missing an
eigenvalue, if all the random starting vectors happen to be orthogonal to its eigenvector.
Normally, the algorithm restarts p times, if the maximum multiplicity of an eigenvalue is
p. At each restart a new random starting direction is introduced.

The shifted and inverted matrix A = (K – µM)–1M is needed only to operate on a vector vj
in the Arnoldi algorithm. This is done by computing an LU factorization,

P(K – µM)Q = LU  (5-23)

using the sparse MATLAB command lu (P and Q are permutations that make the
triangular factors L and U sparse and the factorization numerically stable). This
factorization needs to be done only once, in the beginning, then x = Avj is computed as,

x = QU–1L–1PMvj  (5-24)

with one sparse matrix vector multiplication, a permutation, sparse forward- and back-
substitutions, and a final renumbering.

See Also
solvepdeeig
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Introduced before R2006a
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pdeellip
Package: pde

Draw ellipse in PDE Modeler app

Syntax
pdeellip(xc,yc,a,b,phi)
pdeellip(xc,yc,a,b,phi,label)

Description
pdeellip(xc,yc,a,b,phi) draws an ellipse with the center at (xc,yc), the semiaxes a
and b, and the rotation phi (in radians). The pdeellip command opens the PDE Modeler
app with the specified ellipse drawn in it. If the app is already open, pdeellip adds the
specified ellipse to the app window without deleting any existing shapes.

pdeellip updates the state of the geometry description matrix inside the PDE Modeler
app to include the ellipse. You can export the geometry description matrix from the PDE
Modeler app to the MATLAB Workspace by selecting DrawExport Geometry
Description, Set Formula, Labels.... For details on the format of the geometry
description matrix, see decsg.

pdeellip(xc,yc,a,b,phi,label) assigns a name to the ellipse. Otherwise,
pdeellip uses a default name, such as E1, E2, and so on.

Examples

Draw Ellipse in PDE Modeler App

Open the PDE Modeler app window containing an ellipse with the center at (0,0) and the
semiaxes 1 and 0.3. Rotate the ellipse by π/4 counterclockwise.

pdeellip(0,0,1,0.3,pi/4)
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Call the pdeellip command again to draw an ellipse with the same center and semiaxes,
but rotate it by π/2 counterclockwise. The pdeellip command adds the second ellipse to
the app window without deleting the first.

pdeellip(0,0,1,0.3,pi/2)
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Assign Name to Ellipse in PDE Modeler App

Open the PDE Modeler app window containing an ellipse with the center at (0,0) and the
semiaxes 1 and 0.3. Rotate the ellipse by π/4 counterclockwise. Assign the name
ellipse1 to this ellipse.

pdeellip(0,0,1,0.3,pi/4,'ellipse1')
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Input Arguments
xc — x-coordinate of center
real number

x-coordinate of the center of the ellipse, specified as a real number.
Data Types: double

yc — y-coordinate of center
real number

y-coordinate of the center of the ellipse, specified as a real number.
Data Types: double

a — Semiaxis
positive number

Semiaxis of the ellipse, specified as a positive number.
Data Types: double

b — Semiaxis
positive number

Semiaxis of the ellipse, specified as a positive number.
Data Types: double

phi — Rotation
real number

Rotation of the ellipse, specified as a real number. The rotation value is measured in
radians.
Data Types: double

label — Name
character vector | string scalar

Name of the ellipse, specified as a character vector or string scalar.
Data Types: char | string
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See Also
PDE Modeler | pdecirc | pdepoly | pderect

Introduced before R2006a
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pdeent
Indices of triangles neighboring given set of triangles

Note This page describes the legacy workflow. New features might not be compatible
with the legacy workflow. For the corresponding step in the recommended workflow, see
generateMesh.

Syntax
ntl = pdeent(t,tl)

Description
Given triangle data t and a list of triangle indices tl, ntl contains indices of the
triangles in tl and their immediate neighbors, i.e., those whose intersection with tl is
nonempty.

See Also
generateMesh

Introduced before R2006a
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pdegplot
Plot PDE geometry

Syntax
pdegplot(g)
pdegplot(g,Name,Value)
h = pdegplot( ___ )

Description
pdegplot(g) plots the geometry of a PDE problem, as described in g.

pdegplot(g,Name,Value) plots with additional options specified by one or more
Name,Value pair arguments.

h = pdegplot( ___ ) returns handles to the graphics, using any of the previous
syntaxes.

Examples

Plot 2-D Geometry with and Without Labels

Plot the geometry of a region defined by a few simple shapes.

g = [2     1      1     1      1     1      1     1     1     4     4;
    -1    -0.6   -0.5  -0.4   -0.5   0.4      0.5    0.6   0.5  -1      0.17;
     1    -0.5   -0.4  -0.5   -0.6   0.5    0.6   0.5   0.4   0.17  1;
     0    -0.25  -0.35 -0.25  -0.15 -0.25  -0.35 -0.25 -0.15  0    -0.74;
     0    -0.35  -0.25 -0.15  -0.25 -0.35     -0.25 -0.15 -0.25 -0.74  0;
     0     0      0     0      0     0      0     0     0     1     1;
     1     1      1     1      1     1      1     1     1     0     0;
     0  -0.5   -0.5  -0.5   -0.5   0.5    0.5   0.5   0.5   0     0;
     0  -0.25  -0.25 -0.25  -0.25 -0.25  -0.25 -0.25 -0.25  0     0;
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     0     0.1    0.1   0.1    0.1   0.1    0.1   0.1   0.1   1     1;
     0     0      0     0      0     0      0     0     0     0.75  0.75;
     0     0      0     0      0     0      0     0     0     0     0];
 pdegplot(g)

View the vertex labels, edge labels, and the face label. Add space at the top of the plot to
see the top edge clearly.

pdegplot(g,'VertexLabels','on','EdgeLabels','on','FaceLabels','on')
ylim([-.8,.1])
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Plot 3-D Geometry

Import a 3-D geometry file. Plot the geometry and turn on face labels. To see the labels on
all faces of the geometry, set the transparency to 0.5.

model = createpde;
importGeometry(model,'BracketWithHole.stl');
pdegplot(model,'FaceLabels','on','FaceAlpha',0.5)
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Plot Multi-Cellular 3-D Geometry

Import a 3-D geometry file. Plot the geometry and turn on cell labels.

model = createpde;
importGeometry(model,'DampingMounts.stl');
pdegplot(model,'CellLabels','on')

 pdegplot

5-689



Input Arguments
g — Geometry description
PDEModel object | output of decsg | decomposed geometry matrix | name of geometry
file | function handle to geometry file

Geometry description, specified by one of the following:

• PDEModel object
• Output of decsg
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• Decomposed geometry matrix (see “Decomposed Geometry Data Structure” on page 2-
15)

• Name of geometry file (see “Parametrized Function for 2-D Geometry Creation” on
page 2-17)

• Function handle to geometry file (see “Parametrized Function for 2-D Geometry
Creation” on page 2-17)

Data Types: double | char | string | function_handle

Name-Value Pair Arguments
Specify optional comma-separated pairs of Name,Value arguments. Name is the
argument name and Value is the corresponding value. Name must appear inside quotes.
You can specify several name and value pair arguments in any order as
Name1,Value1,...,NameN,ValueN.

The argument SubdomainLabels is not recommended. Use FaceLabels for both 2-D
and 3-D geometries instead.
Example: pdegplot(g,'FaceLabels','on')

VertexLabels — Vertex labels for 2-D or 3-D geometry
'off' (default) | 'on'

Vertex labels for 2-D or 3-D geometry, specified as 'off' or 'on'.
Example: 'VertexLabels','on'
Data Types: char | string

EdgeLabels — Boundary edge labels for 2-D or 3-D geometry
'off' (default) | 'on'

Boundary edge labels for 2-D or 3-D geometry, specified as 'off' or 'on'.
Example: 'EdgeLabels','on'
Data Types: char | string

FaceLabels — Boundary face labels for 2-D or 3-D geometry
'off' (default) | 'on'

Boundary face labels for 2-D or 3-D geometry, specified as 'off' or 'on'.
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Example: 'FaceLabels','on'
Data Types: char | string

CellLabels — Cell labels for 3-D geometry
'off' (default) | 'on'

Cell labels for 3-D geometry, specified as 'off' or 'on'.
Example: 'CellLabels','on'
Data Types: char | string

FaceAlpha — Surface transparency for 3-D geometry
1 (default) | real number from 0 through 1

Surface transparency for 3-D geometry, specified as the comma-separated pair consisting
of 'FaceAlpha' and a real number from 0 through 1. The default value 1 indicates no
transparency. The value 0 indicates complete transparency.
Example: 'FaceAlpha',0.5
Data Types: double

Output Arguments
h — Handles to graphics objects
vector

Handles to graphics objects, returned as a vector.

Alternative Functionality

App
If you create 2-D geometry in the PDE Modeler app, you can view the geometry from
Boundary Mode. To see the edge labels, select Boundary > Show Edge Labels. To see
the face labels, select PDE > Show Subdomain Labels.
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See Also
PDE Modeler | decsg | importGeometry | wgeom

Topics
“Solve PDE with Coefficients in Functional Form” on page 2-85
“Create Geometry and Remove Face Boundaries” on page 2-13
“STL File Import” on page 2-46
“Three Ways to Create 2-D Geometry” on page 2-8
“Solve Problems Using PDEModel Objects” on page 2-6

Introduced before R2006a
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pdegrad
(Not recommended) Gradient of PDE solution

Note pdegrad is not recommended. Use evaluateGradient instead.

Syntax
[ux,uy] = pdegrad(p,t,u)

[ux,uy] = pdegrad(p,t,u,sdl)

Description
[ux,uy] = pdegrad(p,t,u) returns the gradient of u evaluated at the center of each
triangle.

Row i from 1 to N of ux contains

∂ui
∂x

Row i from 1 to N of uy contains

∂ui
∂y

There is one column for each triangle in t in both ux and uy.

Although pdegrad returns the value of the gradient at the center of a triangle, the
gradient is actually the same everywhere in the triangle interior. This is because pdegrad
uses only linear basis functions. The boundaries of triangles are a special case: here the
derivatives might be discontinuous.

The geometry of the PDE problem is given by the mesh data p and t. For details on the
mesh data representation, see initmesh.
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The optional argument sdl restricts the computation to the subdomains in the list sdl.

See Also
evaluateGradient

Introduced before R2006a
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pdeInterpolant
Interpolant for nodal data to selected locations

Note pdeInterpolant and [p,e,t] representation of FEMesh data are not
recommended. Use interpolateSolution and evaluateGradient to interpolate a
PDE solution and its gradient to arbitrary points without switching to a [p,e,t]
representation.

Description
An interpolant allows you to evaluate a PDE solution at any point within the geometry.

Partial Differential Equation Toolbox solvers return solution values at the nodes, meaning
the mesh points. To evaluate an interpolated solution at other points within the geometry,
create a pdeInterpolant object, and then call the evaluate function.

Creation

Syntax
F = pdeInterpolant(p,t,u)

Description
F = pdeInterpolant(p,t,u) returns an interpolant F based on the data points p,
elements t, and data values at the points, u.

Use meshToPet to obtain the p and t data for interpolation using pdeInterpolant.

Input Arguments
p — Data point locations
matrix with two or three rows
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Data point locations, specified as a matrix with two or three rows. Each column of p is a
2-D or 3-D point. For details, see “Mesh Data” on page 2-233.

For 2-D problems, construct p using the initmesh function, or export from the Mesh
menu of the PDE Modeler app. For 2-D or 3-D geometry using a PDEModel object, obtain
p using the meshToPet function on model.Mesh. For example, [p,e,t] =
initmesh(g) or [p,e,t] = meshToPet(model.Mesh).

t — Triangulation elements
matrix

Triangulation elements, specified as a matrix. For details, see “Mesh Data” on page 2-233.

For 2-D problems, construct t using the initmesh function, or export from the Mesh
menu of the PDE Modeler app. For 2-D or 3-D geometry using a PDEModel object, obtain
t using the meshToPet function on model.Mesh. For example, [p,e,t] =
initmesh(g) or [p,e,t] = meshToPet(model.Mesh).

u — Data values to interpolate
vector | matrix

Data values to interpolate, specified as a vector or matrix. Typically, u is the solution of a
PDE problem returned by assempde, parabolic, hyperbolic, or another solver. For
example, u = assempde(b,p,e,t,c,a,f). You can also export u from the Solve menu
of the PDE Modeler app.

The dimensions of the matrix u depend on the problem. If np is the number of columns of
p, and N is the number of equations in the PDE system, then u has N*np rows. The first np
rows correspond to equation 1, the next np rows correspond to equation 2, etc. For
parabolic or hyperbolic problems, u has one column for each solution time; otherwise, u is
a column vector.

Object Functions
evaluate Interpolate data to selected locations

Examples
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Create Interpolant

This example shows how to create a pdeInterpolant from the solution to a scalar PDE.

Solve the equation −Δu = 1 on the unit disk with zero Dirichlet conditions.

g0 = [1;0;0;1]; % circle centered at (0,0) with radius 1
sf = 'C1';
g = decsg(g0,sf,sf'); % decomposed geometry matrix
problem = allzerobc(g); % zero Dirichlet conditions
[p,e,t] = initmesh(g);
c = 1;
a = 0;
f = 1;
u = assempde(problem,p,e,t,c,a,f);

Construct an interpolant for the solution.

F = pdeInterpolant(p,t,u);

Evaluate the interpolant at the four corners of a square.

pOut = [0,1/2,1/2,0;
    0,0,1/2,1/2];
uOut = evaluate(F,pOut)

uOut = 4×1

    0.2485
    0.1854
    0.1230
    0.1852

The values uOut(2) and uOut(4) are nearly equal, as they should be for symmetric
points in this symmetric problem.

See Also
evaluate | tri2grid

Topics
“Mesh Data” on page 2-233
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Introduced in R2014b
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pdeintrp
(Not recommended) Interpolate from node data to triangle midpoint data

Note pdeintrp is not recommended. Use interpolateSolution and
evaluateGradient instead.

Syntax
ut = pdeintrp(p,t,un)

Description
ut = pdeintrp(p,t,un) gives linearly interpolated values at triangle midpoints from
the values at node points.

The geometry of the PDE problem is given by the mesh data p and t. For details on the
mesh data representation, see initmesh.

Let N be the dimension of the PDE system, np the number of node points, and nt the
number of triangles. The components of the node data are stored in un either as N
columns of length np or as an ordinary solution vector. The first np values of un describe
the first component, the following np values of un describe the second component, and so
on. The components of triangle data are stored in ut as N rows of length nt.

Caution
pdeprtni and pdeintrp are not inverse functions. The interpolation introduces some
averaging.

See Also
evaluateGradient | interpolateSolution | solvepde
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Introduced before R2006a
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pdejmps
(Not recommended) Error estimates for adaptation

Note pdejmps is not recommended.

Syntax
errf = pdejmps(p,t,c,a,f,u,alfa,beta,m)

Description
errf = pdejmps(p,t,c,a,f,u,alfa,beta,m) calculates the error indication
function used for adaptation. The columns of errf correspond to triangles, and the rows
correspond to the different equations in the PDE system.

p andt are mesh data. For details, see initmesh.

c, a, and f are PDE coefficients. c, a, and f must be expanded, so that columns
correspond to triangles.

The formula for computing the error indicator E(K) for each triangle K is

E K = α hm f − au K + β 1
2 ∑

τ ∈ ∂K
hτ

2m[nτ ⋅ (c∇uh)]2
1/2

where nτ is the unit normal of edge τ and the braced term is the jump in flux across the
element edge, where α and β are weight indices and m is an order parameter. The norm is
an L2 norm computed over the element K. The error indicator is stored in errf as column
vectors, one for each triangle in t. For more details, see the "Algorithms" section on the
adaptmesh page.

Introduced before R2006a

5 Functions — Alphabetical List

5-702



pdemesh
Plot PDE mesh

Syntax
pdemesh(model)
pdemesh(mesh)
pdemesh(nodes,elements)
pdemesh(model,u)
pdemesh( ___ ,Name,Value)

pdemesh(p,e,t)
pdemesh(p,e,t,u)

h = pdemesh( ___ )

Description
pdemesh(model) plots the mesh contained in a 2-D or 3-D model object of type
PDEModel.

pdemesh(mesh) plots the mesh defined as a Mesh property of a 2-D or 3-D model object
of type PDEModel.

pdemesh(nodes,elements) plots the mesh defined by nodes and elements.

pdemesh(model,u) plots solution data u as a 3-D plot. This syntax is valid only for 2-D
geometry.

pdemesh( ___ ,Name,Value) plots the mesh or solution data using any of the
arguments in the previous syntaxes and one or more Name,Value pair arguments.

pdemesh(p,e,t) plots the mesh specified by the mesh data p,e,t.

pdemesh(p,e,t,u) plots PDE node or triangle data u using a mesh plot. The function
plots the node data if u is a column vector , and triangle data if u is a row vector.
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If you want to have more control over your mesh plot, use pdeplot or pdeplot3D
instead of pdemesh.

h = pdemesh( ___ ) returns handles to the graphics, using any of the arguments of the
previous syntaxes.

Examples

Mesh Plot for L-Shaped Membrane

Create a mesh plot and display the node and element labels of the mesh.

Create a PDE model. Include the geometry of the built-in function lshapeg. Mesh the
geometry.

model = createpde;
geometryFromEdges(model,@lshapeg);
mesh = generateMesh(model);

Plot the mesh.

pdemesh(model)
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Alternatively, you can plot a mesh by using mesh as an input argument.

pdemesh(mesh)
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Another approach is to use the nodes and elements of the mesh as input arguments for
pdemesh.

pdemesh(mesh.Nodes,mesh.Elements)
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Display node labels.

pdemesh(model,'NodeLabels','on')
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Use xlim and ylim to zoom in on particular nodes.

xlim([-0.4,0.4])
ylim([-0.4,0.4])
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Display element labels.

pdemesh(model,'ElementLabels','on')
xlim([-0.4,0.4])
ylim([-0.4,0.4])
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Apply boundary conditions, specify coefficients, and solve the PDE.

applyBoundaryCondition(model,'dirichlet','Edge',1:model.Geometry.NumEdges,'u',0);
specifyCoefficients(model,'m',0,...
                          'd',0,...
                          'c',1,...
                          'a',0,...
                          'f',1);
generateMesh(model);
results = solvepde(model)

results = 
  StationaryResults with properties:
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    NodalSolution: [1177x1 double]
       XGradients: [1177x1 double]
       YGradients: [1177x1 double]
       ZGradients: []
             Mesh: [1x1 FEMesh]

u = results.NodalSolution;

Plot the solution at nodal locations by using pdemesh.

pdemesh(model,u)

The pdemesh function ignores NodeLabels and ElementLabels when you plot solution
data as a 3-D plot.
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Transparency for 3-D Mesh

Create a PDE model, include the geometry and mesh it.

model = createpde;
importGeometry(model,'Plate10x10x1.stl');
generateMesh(model,'Hmax',5);

Plot the mesh setting the transparency to 0.5.

pdemesh(model,'FaceAlpha',0.5)
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Elements Associated with Particular Face

Find the elements associated with a geometric region.

Create a PDE model.

model = createpde;

Include the geometry of the built-in function lshapeg. Plot the geometry.

geometryFromEdges(model,@lshapeg);
pdegplot(model,'FaceLabels','on','EdgeLabels','on')
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Generate a mesh.

mesh = generateMesh(model,'Hmax',0.5);

Find the elements associated with face 2.

Ef2 = findElements(mesh,'region','Face',2);

Highlight these elements in green on the mesh plot.

figure
pdemesh(mesh,'ElementLabels','on')
hold on
pdemesh(mesh.Nodes,mesh.Elements(:,Ef2),'EdgeColor','green')
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[p,e,t] Mesh Plot

Plot the mesh for the geometry of the L-shaped membrane.

[p,e,t] = initmesh('lshapeg');
[p,e,t] = refinemesh('lshapeg',p,e,t);
pdemesh(p,e,t)

Now solve Poisson's equation −Δu = 1 over the geometry defined by the L-shaped
membrane. Use Dirichlet boundary conditions u = 0 on δΩ, and plot the result.

u = assempde('lshapeb',p,e,t,1,0,1); 
pdemesh(p,e,t,u)
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Input Arguments
model — Model object
PDEModel object | ThermalModel object | StructuralModel object

Model object, specified as a PDEModel object, ThermalModel object, or
StructuralModel object.
Example: model = createpde(1)
Example: thermalmodel = createpde('thermal','steadystate')
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Example: structuralmodel = createpde('structural','static-solid')

u — PDE solution
vector | matrix

PDE solution, specified as a vector or matrix.
Example: results = solvepde(model); u = results.NodalSolution; or u =
assempde(model,c,a,f);

mesh — Mesh object
Mesh property of a PDEModel object | output of generateMesh

Mesh object, specified as the Mesh property of a PDEModel object or as the output of
generateMesh.
Example: model.Mesh

nodes — Nodal coordinates
2-by-NumNodes matrix | 3-by-NumNodes matrix

Nodal coordinates, specified as a 2-by-NumNodes matrix for a 2-D mesh and 3-by-
NumNodes matrix for a 3-D mesh. NumNodes is the number of nodes.

elements — Element connectivity matrix in terms of node IDs
NodesPerElem-by-NumElements matrix

Element connectivity matrix in terms of node IDs, specified as an NodesPerElem-by-
NumElements matrix. NodesPerElem is the number of nodes per element. Linear meshes
contain only corner nodes, so there are three nodes per a 2-D element and four nodes per
a 3-D element. Quadratic meshes contain corner nodes and nodes in the middle of each
edge of an element. For quadratic meshes, there are six nodes per a 2-D element and 10
nodes per a 3-D element.
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p — Mesh points
matrix
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Mesh points, specified as a 2-by-Np matrix of points, where Np is the number of points in
the mesh. For a description of the (p,e,t) matrices, see “Mesh Data” on page 2-233.

Typically, you use the p, e, and t data exported from the PDE Modeler app, or generated
by initmesh or refinemesh.
Example: [p,e,t] = initmesh(gd)
Data Types: double

e — Mesh edges
matrix

Mesh edges, specified as a 7-by-Ne matrix of edges, where Ne is the number of edges in
the mesh. For a description of the (p,e,t) matrices, see “Mesh Data” on page 2-233.

Typically, you use the p, e, and t data exported from the PDE Modeler app, or generated
by initmesh or refinemesh.
Example: [p,e,t] = initmesh(gd)
Data Types: double

t — Mesh triangles
matrix

Mesh triangles, specified as a 4-by-Nt matrix of triangles, where Nt is the number of
triangles in the mesh. For a description of the (p,e,t) matrices, see “Mesh Data” on page
2-233.

Typically, you use the p, e, and t data exported from the PDE Modeler app, or generated
by initmesh or refinemesh.
Example: [p,e,t] = initmesh(gd)
Data Types: double

Name-Value Pair Arguments
Specify optional comma-separated pairs of Name,Value arguments. Name is the
argument name and Value is the corresponding value. Name must appear inside quotes.
You can specify several name and value pair arguments in any order as
Name1,Value1,...,NameN,ValueN.
Example: pdemesh(model,'NodeLabels','on')
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NodeLabels — Node labels
'off' (default) | 'on'

Node labels, specified as the comma-separated pair consisting of 'NodeLabels' and
'off' or 'on'.

pdemesh ignores NodeLabels when you plot solution data as a 3-D plot.
Example: 'NodeLabels','on'
Data Types: char | string

ElementLabels — Element labels
'off' (default) | 'on'

Element labels, specified as the comma-separated pair consisting of 'ElementLabels'
and 'off' or 'on'.

pdemesh ignores ElementLabels when you plot solution data as a 3-D plot.
Example: 'ElementLabels','on'
Data Types: char | string

FaceAlpha — Surface transparency for 3-D geometry
1 (default) | real number from 0 through 1

Surface transparency for 3-D geometry, specified as the comma-separated pair consisting
of 'FaceAlpha' and a real number from 0 through 1. The default value 1 indicates no
transparency. The value 0 indicates complete transparency.
Example: 'FaceAlpha',0.5
Data Types: double

EdgeColor — Color of mesh edges
short color name | long color name | RGB triplet

Color of mesh edges, specified as a short or long color name or an RGB triplet. By default,
for 2-D meshes the edges within one face are blue (RGB triplet [0 0 1]) and the edges
between faces are red (RGB triplet [1 0 0]). For 3-D meshes, the default edge color is
black (RGB triplet [0 0 0]).

The short names and long names are character vectors that specify one of eight
predefined colors. The RGB triplet is a three-element row vector whose elements specify
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the intensities of the red, green, and blue components of the color; the intensities must be
in the range [0 1]. The following table lists the predefined colors and their RGB triplet
equivalents.

RGB Triplet Short Name Long Name
[1 1 0] y yellow
[1 0 1] m magenta
[0 1 1] c cyan
[1 0 0] r red
[0 1 0] g green
[0 0 1] b blue
[1 1 1] w white
[0 0 0] k black

Example: 'EdgeColor','green'
Data Types: double | char | string

FaceColor — Color of mesh faces for 3-D meshes
[0 1 1] | short color name | long color name | RGB triplet

Color of mesh faces for 3-D meshes, specified as a short or long color name or an RGB
triplet. The default face color is cyan (RGB triplet [0 1 1]). For details about available
colors, see “'EdgeColor'” on page 5-0 .
Example: 'FaceColor','green'
Data Types: double | char | string

Output Arguments
h — Handles to graphics objects
vector

Handles to graphics objects, returned as a vector.
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See Also
pdegplot | pdeplot | pdeplot3D | pdesurf

Topics
“Mesh Data” on page 2-233

Introduced before R2006a
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PDEModel
PDE model object

Description
A PDEModel object contains information about a PDE problem: the number of equations,
geometry, mesh, and boundary conditions.

Creation
Create a PDEModel object using createpde. Initially, the only nonempty property is
PDESystemSize. It is 1 for scalar problems.

Properties
PDESystemSize — Number of equations
1 (default) | positive integer

Number of equations, N, returned as a positive integer. See “Equations You Can Solve
Using PDE Toolbox” on page 1-6.
Example: 1
Data Types: double

BoundaryConditions — PDE boundary conditions
vector of BoundaryCondition objects

PDE boundary conditions, returned as a vector of BoundaryCondition objects. You create
boundary conditions using the applyBoundaryCondition function

Geometry — Geometry description
geometry object

Geometry description, returned as a geometry object.
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• AnalyticGeometry object for 2-D geometry. You create this geometry using the
geometryFromEdges function.

• DiscreteGeometry object for 3-D geometry. You create this geometry using the
importGeometry function or the geometryFromMesh function.

Mesh — Mesh for solution
FEMesh object

Mesh for solution, returned as an FEMesh object. You create the mesh using the
generateMesh function.

IsTimeDependent — Indicator if model is time-dependent
0 (false) (default) | 1 (true)

Indicator if model is time-dependent, returned as 1 (true) or 0 (false). The property is
true when the m or d coefficient is nonzero, and is false otherwise.

EquationCoefficients — PDE coefficients
vector of CoefficientAssignment objects

PDE coefficients, returned as a vector of CoefficientAssignment objects. See
specifyCoefficients.

InitialConditions — Initial conditions or initial solution
GeometricInitialConditions object | NodalInitialConditions object

Initial conditions or initial solution, returned as a GeometricInitialConditions or
NodalInitialConditions object.

In case of GeometricInitialConditions, for time-dependent problems, you must give
one or two initial conditions: one if the m coefficient is zero, and two if the m coefficient is
nonzero. For nonlinear stationary problems, you can optionally give an initial solution that
solvepde uses to start its iterations. See setInitialConditions.

In case of NodalInitialConditions, you use the results of previous analysis to set the
initial conditions or initial guess. The geometry and mesh of the previous analysis and
current model must be the same.

SolverOptions — Algorithm options for PDE solvers
PDESolverOptions object
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Algorithm options for the PDE solvers, returned as a PDESolverOptions object. The
properties of PDESolverOptions include absolute and relative tolerances for internal
ODE solvers, maximum solver iterations, and so on.

Object Functions
applyBoundaryCondition Add boundary condition to PDEModel container
generateMesh Create triangular or tetrahedral mesh
geometryFromEdges Create 2-D geometry
geometryFromMesh Create geometry from mesh
importGeometry Import geometry from STL data
setInitialConditions Give initial conditions or initial solution
specifyCoefficients Specify coefficients in a PDE model
solvepde Solve PDE specified in a PDEModel
solvepdeeig Solve PDE eigenvalue problem specified in a PDEModel

Examples

Create and Populate a PDE Model

Create and populate a PDEModel object.

Create a container for a scalar PDE (N = 1).

model = createpde()

model = 
  PDEModel with properties:

           PDESystemSize: 1
         IsTimeDependent: 0
                Geometry: []
    EquationCoefficients: []
      BoundaryConditions: []
       InitialConditions: []
                    Mesh: []
           SolverOptions: [1x1 PDESolverOptions]
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Include a torus geometry, zero Dirichlet boundary conditions, coefficients for Poisson's
equation, and the default mesh.

importGeometry(model,'Torus.stl');
applyBoundaryCondition(model,'dirichlet','face',1,'u',0);
specifyCoefficients(model,'m',0,...
                          'd',0,...
                          'c',1,...
                          'a',0,...
                          'f',1);
generateMesh(model);

Solve the PDE.

results = solvepde(model)

results = 
  StationaryResults with properties:

    NodalSolution: [12913x1 double]
       XGradients: [12913x1 double]
       YGradients: [12913x1 double]
       ZGradients: [12913x1 double]
             Mesh: [1x1 FEMesh]

See Also
applyBoundaryCondition | createpde | generateMesh | geometryFromEdges |
geometryFromMesh | importGeometry | pdegplot | pdeplot | pdeplot3D |
setInitialConditions | specifyCoefficients

Topics
“Solve Problems Using PDEModel Objects” on page 2-6

Introduced in R2015a
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pdenonlin
(Not recommended) Solve nonlinear elliptic PDE problem

Note pdenonlin is not recommended. Use solvepde instead.

Syntax
u = pdenonlin(model,c,a,f)
u = pdenonlin(b,p,e,t,c,a,f)
u = pdenonlin( ___ ,Name,Value)
[u,res] = pdenonlin( ___ )

Description
u = pdenonlin(model,c,a,f) solves the nonlinear PDE

−∇ ⋅ c∇u + au = f

with geometry, boundary conditions, and finite element mesh in model, and coefficients c,
a, and f. In this context, “nonlinear” means some coefficient in c, a, or f depends on the
solution u or its gradient. If the PDE is a system of equations
(model.PDESystemSize > 1), then pdenonlin solves the system of equations

−∇ ⋅ c⊗ ∇u + au = f

u = pdenonlin(b,p,e,t,c,a,f) solves the PDE with boundary conditions b, and
finite element mesh (p,e,t).

u = pdenonlin( ___ ,Name,Value), for any previous arguments, modifies the solution
process with Name, Value pairs.

[u,res] = pdenonlin( ___ ) also returns the norm of the Newton step residuals res.
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Examples

Minimal Surface Problem

Solve a minimal surface problem. Because this problem has a nonlinear c coefficient, use
pdenonlin to solve it.

Create a model and include circular geometry using the built-in circleg function.

model = createpde;
geometryFromEdges(model,@circleg);

Set the coefficients.

a = 0;
f = 0;
c = '1./sqrt(1+ux.^2+uy.^2)';

Set a Dirichlet boundary condition with value x2.

boundaryfun = @(region,state)region.x.^2;
applyBoundaryCondition(model,'edge',1:model.Geometry.NumEdges,...
                      'u',boundaryfun,'Vectorized','on');

Generate a mesh and solve the problem.

generateMesh(model,'GeometricOrder','linear','Hmax',0.1);
u = pdenonlin(model,c,a,f);
pdeplot(model,'XYData',u,'ZData',u)
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Minimal Surface Problem Using [p,e,t] Mesh

Solve the minimal surface problem using the legacy approach for creating boundary
conditions and geometry.

Create the geometry using the built-in circleg function. Plot the geometry to see the
edge labels.

g = @circleg;
pdegplot(g,'EdgeLabels','on')
axis equal

 pdenonlin

5-729



Create Dirichlet boundary conditions with value .Create the following file and save it on
your Matlab™ path. For details of this approach, see “Boundary Conditions by Writing
Functions” on page 2-197.

function [qmatrix,gmatrix,hmatrix,rmatrix] = pdex2bound(p,e,u,time)

ne = size(e,2); % number of edges
qmatrix = zeros(1,ne);
gmatrix = qmatrix;
hmatrix = zeros(1,2*ne);
rmatrix = hmatrix;

for k = 1:ne
    x1 = p(1,e(1,k)); % x at first point in segment
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    x2 = p(1,e(2,k)); % x at second point in segment
    xm = (x1 + x2)/2; % x at segment midpoint
    y1 = p(2,e(1,k)); % y at first point in segment
    y2 = p(2,e(2,k)); % y at second point in segment
    ym = (y1 + y2)/2; % y at segment midpoint
    switch e(5,k)
        case {1,2,3,4}
            hmatrix(k) = 1;
            hmatrix(k+ne) = 1;
            rmatrix(k) = x1^2;
            rmatrix(k+ne) = x2^2;
    end
end

Set the coefficients and boundary conditions.

a = 0;
f = 0;
c = '1./sqrt(1+ux.^2+uy.^2)';
b = @pdex2bound;

Generate a mesh and solve the problem.

[p,e,t] = initmesh(g,'Hmax',0.1);
u = pdenonlin(b,p,e,t,c,a,f);
pdeplot(p,e,t,'XYData',u,'ZData',u)
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Nonlinear Problem with 3-D Geometry

Solve a nonlinear 3-D problem with nontrivial geometry.

Import the geometry from the BracketWithHole.stl file. Plot the geometry and face
labels.

model = createpde();
importGeometry(model,'BracketWithHole.stl');
figure
pdegplot(model,'FaceLabels','on')
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view(30,30)
title('Bracket with Face Labels')

figure
pdegplot(model,'FaceLabels','on')
view(-134,-32)
title('Bracket with Face Labels, Rear View')
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Set a Dirichlet boundary condition with value 1000 on the back face, which is face 4. Set
the large faces 1 and 7, and also the circular face 11, to have Neumann boundary
conditions with value g = -10. Do not set boundary conditions on the other faces. Those
faces default to Neumann boundary conditions with value g = 0.

applyBoundaryCondition(model,'Face',4,'u',1000);
applyBoundaryCondition(model,'Face',[1,7,11],'g',-10);

Set the c coefficient to 1, f to 0.1, and a to the nonlinear value '0.1 + 0.001*u.^2'.

c = 1;
f = 0.1;
a = '0.1 + 0.001*u.^2';
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Generate the mesh and solve the PDE. Start from the initial guess u0 = 1000, which
matches the value you set on face 4. Turn on the Report option to observe the
convergence during the solution.

generateMesh(model);
u = pdenonlin(model,c,a,f,'U0',1000,'Report','on');

Iteration     Residual     Step size  Jacobian: full
   0          7.2059e-01
   1          1.3755e-01   1.0000000
   2          4.0799e-02   1.0000000
   3          1.1344e-02   1.0000000
   4          2.2737e-03   1.0000000
   5          1.7764e-04   1.0000000
   6          1.4190e-06   1.0000000

Plot the solution on the geometry boundary.

pdeplot3D(model,'ColorMapData',u)
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Input Arguments
model — PDE model
PDEModel object

PDE model, specified as a PDEModel object.
Example: model = createpde

c — PDE coefficient
scalar | matrix | character vector | character array | string scalar | string vector |
coefficient function
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PDE coefficient, specified as a scalar, matrix, character vector, character array, string
scalar, string vector, or coefficient function. c represents the c coefficient in the scalar
PDE

−∇ ⋅ c∇u + au = f

or in the system of PDEs

−∇ ⋅ c⊗ ∇u + au = f

You can specifyc in various ways, detailed in “c Coefficient for Systems” on page 2-122.
See also “Specify Scalar PDE Coefficients in Character Form” on page 2-74, “Specify 2-D
Scalar Coefficients in Function Form” on page 2-80, and “Specify 3-D PDE Coefficients in
Function Form” on page 2-83.
Example: 'cosh(x+y.^2)'
Data Types: double | char | string | function_handle
Complex Number Support: Yes

a — PDE coefficient
scalar | matrix | character vector | character array | string scalar | string vector |
coefficient function

PDE coefficient, specified as a scalar, matrix, character vector, character array, string
scalar, string vector, or coefficient function. a represents the a coefficient in the scalar
PDE

−∇ ⋅ c∇u + au = f

or in the system of PDEs

−∇ ⋅ c⊗ ∇u + au = f

You can specifya in various ways, detailed in “a or d Coefficient for Systems” on page 2-
147. See also “Specify Scalar PDE Coefficients in Character Form” on page 2-74, “Specify
2-D Scalar Coefficients in Function Form” on page 2-80, and “Specify 3-D PDE
Coefficients in Function Form” on page 2-83.
Example: 2*eye(3)
Data Types: double | char | string | function_handle
Complex Number Support: Yes
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f — PDE coefficient
scalar | matrix | character vector | character array | string scalar | string vector |
coefficient function

PDE coefficient, specified as a scalar, matrix, character vector, character array, string
scalar, string vector, or coefficient function. f represents the f coefficient in the scalar
PDE

−∇ ⋅ c∇u + au = f

or in the system of PDEs

−∇ ⋅ c⊗ ∇u + au = f

You can specifyf in various ways, detailed in “f Coefficient for Systems” on page 2-94. See
also “Specify Scalar PDE Coefficients in Character Form” on page 2-74, “Specify 2-D
Scalar Coefficients in Function Form” on page 2-80, and “Specify 3-D PDE Coefficients in
Function Form” on page 2-83.
Example: char('sin(x)';'cos(y)';'tan(z)')
Data Types: double | char | string | function_handle
Complex Number Support: Yes

b — Boundary conditions
boundary matrix | boundary file

Boundary conditions, specified as a boundary matrix or boundary file. Pass a boundary file
as a function handle or as a file name.

• A boundary matrix is generally an export from the PDE Modeler app. For details of the
structure of this matrix, see “Boundary Matrix for 2-D Geometry” on page 2-168.

• A boundary file is a file that you write in the syntax specified in “Boundary Conditions
by Writing Functions” on page 2-197.

Example: b = 'circleb1', b = "circleb1", or b = @circleb1
Data Types: double | char | string | function_handle

p — Mesh points
matrix

Mesh points, specified as a 2-by-Np matrix of points, where Np is the number of points in
the mesh. For a description of the (p,e,t) matrices, see “Mesh Data” on page 2-233.
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Typically, you use the p, e, and t data exported from the PDE Modeler app, or generated
by initmesh or refinemesh.
Example: [p,e,t] = initmesh(gd)
Data Types: double

e — Mesh edges
matrix

Mesh edges, specified as a 7-by-Ne matrix of edges, where Ne is the number of edges in
the mesh. For a description of the (p,e,t) matrices, see “Mesh Data” on page 2-233.

Typically, you use the p, e, and t data exported from the PDE Modeler app, or generated
by initmesh or refinemesh.
Example: [p,e,t] = initmesh(gd)
Data Types: double

t — Mesh triangles
matrix

Mesh triangles, specified as a 4-by-Nt matrix of triangles, where Nt is the number of
triangles in the mesh. For a description of the (p,e,t) matrices, see “Mesh Data” on page
2-233.

Typically, you use the p, e, and t data exported from the PDE Modeler app, or generated
by initmesh or refinemesh.
Example: [p,e,t] = initmesh(gd)
Data Types: double

Name-Value Pair Arguments
Specify optional comma-separated pairs of Name,Value arguments. Name is the
argument name and Value is the corresponding value. Name must appear inside quotes.
You can specify several name and value pair arguments in any order as
Name1,Value1,...,NameN,ValueN.
Example: 'Jacobian','full'

Jacobian — Approximation of Jacobian
'full' (3-D default) | 'fixed' (2-D default) | 'lumped'
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Approximation of Jacobian, specified as 'full', 'fixed', or 'lumped'.

• 'full' means numerical evaluation of the full Jacobian based on the sparse version of
the numjac function. 3-D geometry uses only 'full', any other specification yields
an error.

• 'fixed' specifies a fixed-point iteration matrix where the Jacobian is approximated
by the stiffness matrix. This is the 2-D geometry default.

• 'lumped' specifies a “lumped” approximation as described in “Nonlinear Equations”
on page 5-743. This approximation is based on the numerical differentiation of the
coefficients.

Example: u = pdenonlin(model,c,a,f,'Jacobian','full')
Data Types: char | string

U0 — Initial solution guess
0 (default) | scalar | vector of characters | vector of numbers

Initial solution guess, specified as a scalar, a vector of characters, or a vector of numbers.
For details, see “Solve PDEs with Initial Conditions” on page 2-161.

• A scalar specifies a constant initial condition for either a scalar or PDE system.
• For scalar problems, use the same syntax as “Specify Scalar PDE Coefficients in

Character Form” on page 2-74.
• For systems of N equations, write a character array with N rows, where each row has

the syntax of “Specify Scalar PDE Coefficients in Character Form” on page 2-74.
• For systems of N equations, and a mesh with Np nodes, give a column vector with

N*Np components. The nodes are either model.Mesh.Nodes, or the p data from
initmesh or meshToPet. See “Mesh Data” on page 2-233.

The first Np elements contain the values of component 1, where the value of element k
corresponds to node p(k). The next Np points contain the values of component 2, etc.
It can be convenient to first represent the initial conditions u0 as an Np-by-N matrix,
where the first column contains entries for component 1, the second column contains
entries for component 2, etc. The final representation of the initial conditions is
u0(:).

Example: u = pdenonlin(model,c,a,f,'U0','x.^2-y.^2')
Data Types: double | char | string
Complex Number Support: Yes
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Tol — Residual size at termination
1e-4 (default) | positive scalar

Residual size at termination, specified as a positive scalar. pdenonlin iterates until the
residual size is less than 'Tol'.
Example: u = pdenonlin(model,c,a,f,'Tol',1e-6)
Data Types: double

MaxIter — Maximum number of Gauss-Newton iterations
25 (default) | positive integer

Maximum number of Gauss-Newton iterations, specified as a positive integer.
Example: u = pdenonlin(model,c,a,f,'MaxIter',12)
Data Types: double

MinStep — Minimum damping of search direction
1/2^16 (default) | positive scalar

Minimum damping of search direction, specified as a positive scalar.
Example: u = pdenonlin(model,c,a,f,'MinStep',1e-3)
Data Types: double

Report — Print convergence information
'off' (default) | 'on'

Print convergence information, specified as 'off' or 'on'.
Example: u = pdenonlin(model,c,a,f,'Report','on')
Data Types: char | string

Norm — Residual norm
Inf (default) | p value for Lp norm | 'energy'

Residual norm, specified as the p value for Lp norm, or as 'energy'. p can be any
positive real value, Inf, or -Inf. The p norm of a vector v is sum(abs(v)^p)^(1/p).
See norm.
Example: u = pdenonlin(model,c,a,f,'Norm',2)
Data Types: double | char | string
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Output Arguments
u — PDE solution
vector

PDE solution, returned as a vector.

• If the PDE is scalar, meaning only one equation, then u is a column vector
representing the solution u at each node in the mesh. u(i) is the solution at the ith
column of model.Mesh.Nodes or the ith column of p.

• If the PDE is a system of N > 1 equations, then u is a column vector with N*Np
elements, where Np is the number of nodes in the mesh. The first Np elements of u
represent the solution of equation 1, then next Np elements represent the solution of
equation 2, etc.

To obtain the solution at an arbitrary point in the geometry, use pdeInterpolant.

To plot the solution, use pdeplot for 2-D geometry, or see “Plot 3-D Solutions and Their
Gradients” on page 3-295.

res — Norm of Newton step residuals
scalar

Norm of Newton step residuals, returned as a scalar. For information about the algorithm,
see “Nonlinear Equations” on page 5-743.

Tips
• If the Newton iteration does not converge, pdenonlin displays the error message Too

many iterations or Stepsize too small.
• If the initial guess produces matrices containing NaN or Inf elements, pdenonlin

displays the error message Unsuitable initial guess U0 (default: U0 =
0).

• If you have very small coefficients, or very small geometric dimensions, pdenonlin
can fail to converge, or can converge to an incorrect solution. If so, you can sometimes
obtain better results by scaling the coefficients or geometry dimensions to be of order
one.
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Algorithms

Nonlinear Equations
The basic idea is to use Gauss-Newton iterations to solve the nonlinear equations. Say you
are trying to solve the equation

r(u) = –∇ · (c(u)∇u) + a(u)u - f(u) = 0.  (5-25)

In the FEM setting you solve the weak form of r(u) = 0. Set as usual

u(x) = ∑U jϕ j

where x represents a 2-D or 3-D point. Then multiply the equation by an arbitrary test
function ϕi, integrate on the domain Ω, and use Green's formula and the boundary
conditions to obtain

0 = ρ U = ∑
j
∫
Ω

c x, U ∇ϕ j(x) ⋅ ∇ϕ j(x) + a x, U ϕ j(x)ϕi(x) dx

+ ∫
∂Ω

q x, U ϕ j(x)ϕi(x) ds U j

− ∫
Ω

f x, U ϕi(x) dx − ∫
∂Ω

g x, U ϕi(x) ds

which has to hold for all indices i.

The residual vector ρ(U) can be easily computed as

ρ(U) = (K + M + Q)U – (F + G)  (5-26)

where the matrices K, M, Q and the vectors F and G are produced by assembling the
problem

–∇ · (c(U)∇u) + a(U)u = f(U).  (5-27)

Assume that you have a guess U(n) of the solution. If U(n) is close enough to the exact
solution, an improved approximation U(n+1) is obtained by solving the linearized problem
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∂ρ U(n)

∂U U(n + 1)−U(n) = − αρ U(n)

where α is a positive number. (It is not necessary that ρ(U) = 0 have a solution even if
ρ(u) = 0 has.) In this case, the Gauss-Newton iteration tends to be the minimizer of the
residual, i.e., the solution of minU ρ(U) .

It is well known that for sufficiently small α

ρ U(n + 1) < ρ U(n)

and

pn =
∂ρ U(n)

∂U

−1

ρ U(n)

is called a descent direction for ρ(U) , where ⋅  is the L2-norm. The iteration is

U(n + 1) = U(n) + αpn,

where α ≤ 1 is chosen as large as possible such that the step has a reasonable descent.

The Gauss-Newton method is local, and convergence is assured only when U(0) is close
enough to the solution. In general, the first guess may be outside the region of
convergence. To improve convergence from bad initial guesses, a damping strategy is
implemented for choosing α, the Armijo-Goldstein line search. It chooses the largest
damping coefficient α out of the sequence 1, 1/2, 1/4, . . . such that the following
inequality holds:

ρ U(n) − ρ U(n) + αpn ≥ α
2 ρ U(n)

which guarantees a reduction of the residual norm by at least 1 – α/2. Each step of the
line-search algorithm requires an evaluation of the residual ρ U(n) + αpn .

An important point of this strategy is that when U(n) approaches the solution, then α→1
and thus the convergence rate increases. If there is a solution to ρ(U) = 0, the scheme
ultimately recovers the quadratic convergence rate of the standard Newton iteration.
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Closely related to the preceding problem is the choice of the initial guess U(0). By default,
the solver sets U(0) and then assembles the FEM matrices K and F and computes

U(1) = K–1F  (5-28)

The damped Gauss-Newton iteration is then started with U(1), which should be a better
guess than U(0). If the boundary conditions do not depend on the solution u, then U(1)

satisfies them even if U(0) does not. Furthermore, if the equation is linear, then U(1) is the
exact FEM solution and the solver does not enter the Gauss-Newton loop.

There are situations where U(0) = 0 makes no sense or convergence is impossible.

In some situations you may already have a good approximation and the nonlinear solver
can be started with it, avoiding the slow convergence regime. This idea is used in the
adaptive mesh generator. It computes a solution U on a mesh, evaluates the error, and
may refine certain triangles. The interpolant of U is a very good starting guess for the
solution on the refined mesh.

In general the exact Jacobian

Jn =
∂ρ U(n)

∂U

is not available. Approximation of Jn by finite differences in the following way is expensive
but feasible. The ith column of Jn can be approximated by

ρ U(n) + εϕi − ρ U(n)

ε

which implies the assembling of the FEM matrices for the triangles containing grid point
i. A very simple approximation to Jn, which gives a fixed point iteration, is also possible as
follows. Essentially, for a given U(n), compute the FEM matrices K and F and set

U(n+1) = K–1F .  (5-29)

This is equivalent to approximating the Jacobian with the stiffness matrix. Indeed, since
ρ(U(n)) = KU(n) – F, putting Jn = K yields

U(n + 1) = U(n)− Jn
−1ρ U(n) = U(n)− K−1 KU(n)− F = K−1F

In many cases the convergence rate is slow, but the cost of each iteration is cheap.

 pdenonlin

5-745



The Partial Differential Equation Toolbox nonlinear solver also provides for a compromise
between the two extremes. To compute the derivative of the mapping U→KU, proceed as
follows. The a term has been omitted for clarity, but appears again in the final result.

∂ KU i
∂U j

= lim
ε 0

1
ε∑l ∫Ω c U + εϕ j ∇ϕl∇ϕi dx Ul + εδl, j

− ∫
Ω

c U ∇ϕl∇ϕi dxUl

= ∫
Ω

c U ∇ϕ j∇ϕi dx + ∑
l
∫
Ω

ϕ j
∂c
∂u ∇ϕl∇ϕi dxUl

The first integral term is nothing more than Ki,j.

The second term is “lumped,” i.e., replaced by a diagonal matrix that contains the row
sums. Since Σjϕj = 1, the second term is approximated by

δi, j∑
l
∫
Ω

∂c
∂u ∇ϕl∇ϕi dxUl

which is the ith component of K(c')U, where K(c') is the stiffness matrix associated with the
coefficient ∂c/∂u rather than c. The same reasoning can be applied to the derivative of the
mapping U→MU. The derivative of the mapping U→ –F is exactly

− ∫
Ω

∂ f
∂uϕiϕ j dx

which is the mass matrix associated with the coefficient ∂f/∂u. Thus the Jacobian of the
residual ρ(U) is approximated by

J = K(c) + M(a− f ′) + diag K(c′) + M(a′) U

where the differentiation is with respect to u, K and M designate stiffness and mass
matrices, and their indices designate the coefficients with respect to which they are
assembled. At each Gauss-Newton iteration, the nonlinear solver assembles the matrices
corresponding to the equations

−∇ ⋅ (c∇u) + (a− f ′)u = 0
−∇ ⋅ (c′∇u) + a′u = 0
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and then produces the approximate Jacobian. The differentiations of the coefficients are
done numerically.

In the general setting of elliptic systems, the boundary conditions are appended to the
stiffness matrix to form the full linear system:

KU =
K H′
H 0

U
μ

=
F
R

= F

where the coefficients of K and F may depend on the solution U. The “lumped” approach
approximates the derivative mapping of the residual by

J H′
H 0

The nonlinearities of the boundary conditions and the dependencies of the coefficients on
the derivatives of U are not properly linearized by this scheme. When such nonlinearities
are strong, the scheme reduces to the fix-point iteration and may converge slowly or not
at all. When the boundary conditions are linear, they do not affect the convergence
properties of the iteration schemes. In the Neumann case they are invisible (H is an
empty matrix) and in the Dirichlet case they merely state that the residual is zero on the
corresponding boundary points.

See Also
solvepde

Introduced before R2006a
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pdeplot
Plot solution or mesh for 2-D geometry

Syntax
pdeplot(model,'XYData',results.NodalSolution)
pdeplot(model,'XYData',results.Temperature,'ColorMap','hot')
pdeplot(
model,'XYData',results.VonMisesStress,'Deformation',results.Displace
ment)
pdeplot(model,'XYData',results.ModeShapes.ux)

pdeplot(model)
pdeplot(mesh)
pdeplot(nodes,elements)

pdeplot(p,e,t)

pdeplot( ___ ,Name,Value)
h = pdeplot( ___ )

Description
pdeplot(model,'XYData',results.NodalSolution) plots the solution of a model
at nodal locations as a colored surface plot using the default 'jet' colormap.

pdeplot(model,'XYData',results.Temperature,'ColorMap','hot') plots the
temperature at nodal locations for a 2-D thermal analysis model. This syntax creates a
colored surface plot using the 'hot' colormap.

pdeplot(
model,'XYData',results.VonMisesStress,'Deformation',results.Displace
ment) plots the von Mises stress and shows the deformed shape for a 2-D structural
analysis model.
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pdeplot(model,'XYData',results.ModeShapes.ux) plots the x-component of the
modal displacement for a 2-D structural modal analysis model.

pdeplot(model) plots the mesh specified in model.

pdeplot(mesh) plots the mesh defined as a Mesh property of a 2-D model object of type
PDEModel.

pdeplot(nodes,elements) plots the mesh defined by its nodes and elements.

pdeplot(p,e,t) plots the mesh described by p,e, and t.

pdeplot( ___ ,Name,Value) plots the mesh, the data at the nodal locations, or both the
mesh and the data, depending on the Name,Value pair arguments. Use any arguments
from the previous syntaxes.

Specify at least one of the FlowData (vector field plot), XYData (colored surface plot), or
ZData (3-D height plot) name-value pairs. Otherwise, pdeplot plots the mesh with no
data. You can combine any number of plot types.

• For a thermal model, you can plot temperature or gradient of temperature.
• For a structural model, you can plot displacement, stress, strain, and von Mises stress.

In addition, you can show the deformed shape and specify the scaling factor for the
deformation plot.

h = pdeplot( ___ ) returns a handle to a plot, using any of the previous syntaxes.

Examples

2-D Mesh Plot

Create a PDE model. Include the geometry of the built-in function lshapeg. Mesh the
geometry and plot it.

model = createpde;
geometryFromEdges(model,@lshapeg);
mesh = generateMesh(model);
pdeplot(model)
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Alternatively, you can plot a mesh by using mesh as an input argument.

pdeplot(mesh)
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Another approach is to use the nodes and elements of the mesh as input arguments for
pdeplot.

pdeplot(mesh.Nodes,mesh.Elements)
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Display the node labels. Use xlim and ylim to zoom in on particular nodes.

pdeplot(model,'NodeLabels','on')
xlim([-0.2,0.2])
ylim([-0.2,0.2])
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Display the element labels.

pdeplot(model,'ElementLabels','on')
xlim([-0.2,0.2])
ylim([-0.2,0.2])

 pdeplot

5-753



Solution Plots

Create colored 2-D and 3-D plots of a solution to a PDE model.

Create a PDE model. Include the geometry of the built-in function lshapeg. Mesh the
geometry.

model = createpde;
geometryFromEdges(model,@lshapeg);
generateMesh(model);

Set the zero Dirichlet boundary conditions on all edges.
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applyBoundaryCondition(model,'dirichlet','Edge',1:model.Geometry.NumEdges,'u',0);

Specify the coefficients and solve the PDE.

specifyCoefficients(model,'m',0, ...
                          'd',0, ...
                          'c',1, ...
                          'a',0, ...
                          'f',1);
results = solvepde(model)

results = 
  StationaryResults with properties:

    NodalSolution: [1177x1 double]
       XGradients: [1177x1 double]
       YGradients: [1177x1 double]
       ZGradients: []
             Mesh: [1x1 FEMesh]

Access the solution at the nodal locations.

u = results.NodalSolution;

Plot the 2-D solution.

pdeplot(model,'XYData',u)

 pdeplot

5-755



Plot the 3-D solution.

pdeplot(model,'XYData',u,'ZData',u)
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Solution Quiver Plot

Plot the gradient of a PDE solution as a quiver plot.

Create a PDE model. Include the geometry of the built-in function lshapeg. Mesh the
geometry.

model = createpde;
geometryFromEdges(model,@lshapeg);
generateMesh(model);

Set the zero Dirichlet boundary conditions on all edges.
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applyBoundaryCondition(model,'dirichlet','Edge',1:model.Geometry.NumEdges,'u',0);

Specify coefficients and solve the PDE.

specifyCoefficients(model,'m',0, ...
                          'd',0, ...
                          'c',1, ...
                          'a',0, ...
                          'f',1);
results = solvepde(model)

results = 
  StationaryResults with properties:

    NodalSolution: [1177x1 double]
       XGradients: [1177x1 double]
       YGradients: [1177x1 double]
       ZGradients: []
             Mesh: [1x1 FEMesh]

Access the gradient of the solution at the nodal locations.

ux = results.XGradients;
uy = results.YGradients;

Plot the gradient as a quiver plot.

pdeplot(model,'FlowData',[ux,uy])
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Composite Plot

Plot the solution of a 2-D PDE in 3-D with the 'jet' coloring and a mesh, and include a
quiver plot. Get handles to the axes objects.

Create a PDE model. Include the geometry of the built-in function lshapeg. Mesh the
geometry.

model = createpde;
geometryFromEdges(model,@lshapeg);
generateMesh(model);
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Set zero Dirichlet boundary conditions on all edges.

applyBoundaryCondition(model,'dirichlet','Edge',1:model.Geometry.NumEdges,'u',0);

Specify coefficients and solve the PDE.

specifyCoefficients(model,'m',0, ...
                          'd',0, ...
                          'c',1, ...
                          'a',0, ...
                          'f',1);
results = solvepde(model)

results = 
  StationaryResults with properties:

    NodalSolution: [1177x1 double]
       XGradients: [1177x1 double]
       YGradients: [1177x1 double]
       ZGradients: []
             Mesh: [1x1 FEMesh]

Access the solution and its gradient at the nodal locations.

u = results.NodalSolution;
ux = results.XGradients;
uy = results.YGradients;

Plot the solution in 3-D with the 'jet' coloring and a mesh, and include the gradient as a
quiver plot.

h = pdeplot(model,'XYData',u,'ZData',u, ...
                  'FaceAlpha',0.5, ...
                  'FlowData',[ux,uy], ...
                  'ColorMap','jet', ...
                  'Mesh','on')
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h = 
  3x1 graphics array:

  Patch
  Quiver
  ColorBar

Solution to Transient Thermal Model

Solve a 2-D transient thermal problem.
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Create a transient thermal model for this problem.

thermalmodel = createpde('thermal','transient');

Create the geometry and include it in the model.

SQ1 = [3; 4; 0; 3; 3; 0; 0; 0; 3; 3];
D1 = [2; 4; 0.5; 1.5; 2.5; 1.5; 1.5; 0.5; 1.5; 2.5];
gd = [SQ1 D1];
sf = 'SQ1+D1';
ns = char('SQ1','D1');
ns = ns';
dl = decsg(gd,sf,ns);
geometryFromEdges(thermalmodel,dl);
pdegplot(thermalmodel,'EdgeLabels','on','FaceLabels','on')
xlim([-1.5 4.5])
ylim([-0.5 3.5])
axis equal
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For the square region, assign these thermal properties:

• Thermal conductivity is 10 W /(m∘C).
• Mass density is 2 kg/m3.
• Specific heat is 0 . 1 J /(kg∘C).

thermalProperties(thermalmodel,'ThermalConductivity',10, ...
                               'MassDensity',2, ...
                               'SpecificHeat',0.1, ...
                               'Face',1);

For the diamond region, assign these thermal properties:
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• Thermal conductivity is 2 W /(m∘C).
• Mass density is 1 kg/m3.
• Specific heat is 0 . 1 J /(kg∘C).

thermalProperties(thermalmodel,'ThermalConductivity',2, ...
                               'MassDensity',1, ...
                               'SpecificHeat',0.1, ...
                               'Face',2);

Assume that the diamond-shaped region is a heat source with a density of 4 W /m3.

internalHeatSource(thermalmodel,4,'Face',2);

Apply a constant temperature of 0 ∘C to the sides of the square plate.

thermalBC(thermalmodel,'Temperature',0,'Edge',[1 2 7 8]);

Set the initial temperature to 0 ∘C.

thermalIC(thermalmodel,0);

Mesh the geometry.

generateMesh(thermalmodel);

The dynamics for this problem are very fast. The temperature reaches a steady state in
about 0.1 second. To capture the interesting part of the dynamics, set the solution time to
logspace(-2,-1,10). This command returns 10 logarithmically spaced solution times
between 0.01 and 0.1.

tlist = logspace(-2,-1,10);

Solve the equation.

thermalresults = solve(thermalmodel,tlist)

thermalresults = 
  TransientThermalResults with properties:

      Temperature: [1481x10 double]
    SolutionTimes: [1x10 double]
       XGradients: [1481x10 double]
       YGradients: [1481x10 double]
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       ZGradients: []
             Mesh: [1x1 FEMesh]

Plot the solution with isothermal lines by using a contour plot.

T = thermalresults.Temperature;
pdeplot(thermalmodel,'XYData',T(:,10),'Contour','on','ColorMap','hot')

Plot Deformed Shape for Static Plane-Strain Problem

Create a structural analysis model for a static plane-strain problem.
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structuralmodel = createpde('structural','static-planestrain');

Create the geometry and include it in the model. Plot the geometry.

geometryFromEdges(structuralmodel,@squareg);
pdegplot(structuralmodel,'EdgeLabels','on')
axis equal

Specify the Young's modulus and Poisson's ratio.

structuralProperties(structuralmodel,'PoissonsRatio',0.3, ...
                                     'YoungsModulus',210E3);

Specify the x-component of the enforced displacement for edge 1.
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structuralBC(structuralmodel,'XDisplacement',0.001,'Edge',1);

Specify that edge 3 is a fixed boundary.

structuralBC(structuralmodel,'Constraint','fixed','Edge',3);

Generate a mesh and solve the problem.

generateMesh(structuralmodel);
structuralresults = solve(structuralmodel);

Plot the deformed shape using the default scale factor. By default, pdeplot internally
determines the scale factor based on the dimensions of the geometry and the magnitude
of deformation.

pdeplot(structuralmodel,'XYData',structuralresults.VonMisesStress, ...
                        'Deformation',structuralresults.Displacement, ...
                        'ColorMap','jet')
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Plot the deformed shape with the scale factor 500.

pdeplot(structuralmodel,'XYData',structuralresults.VonMisesStress, ...
                        'Deformation',structuralresults.Displacement, ...
                        'DeformationScaleFactor',500,...
                        'ColorMap','jet')
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Plot the deformed shape without scaling.

pdeplot(structuralmodel,'XYData',structuralresults.VonMisesStress, ...
                        'ColorMap','jet')
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Solution to Modal Analysis Structural Model

Find the fundamental (lowest) mode of a 2-D cantilevered beam, assuming a prevalence of
the plane-stress condition.

Specify the following geometric and structural properties of the beam, along with a unit
plane-stress thickness.

length = 5;
height = 0.1;
E = 3E7;
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nu = 0.3;
rho = 0.3/386;

Create a model plane-stress model, assign a geometry, and generate a mesh.

structuralmodel = createpde('structural','modal-planestress');
gdm = [3;4;0;length;length;0;0;0;height;height];
g = decsg(gdm,'S1',('S1')');
geometryFromEdges(structuralmodel,g);

Define a maximum element size (five elements through the beam thickness).

hmax = height/5;
msh=generateMesh(structuralmodel,'Hmax',hmax);

Specify the structural properties and boundary constraints.

structuralProperties(structuralmodel,'YoungsModulus',E, ...
                                     'MassDensity',rho, ... 
                                     'PoissonsRatio',nu);
structuralBC(structuralmodel,'Edge',4,'Constraint','fixed');

Compute the analytical fundamental frequency (Hz) using the beam theory.

I = height^3/12;
analyticalOmega1 = 3.516*sqrt(E*I/(length^4*(rho*height)))/(2*pi)

analyticalOmega1 = 126.9498

Specify a frequency range that includes an analytically computed frequency and solve the
model.

modalresults = solve(structuralmodel,'FrequencyRange',[0,1e6])

modalresults = 
  ModalStructuralResults with properties:

    NaturalFrequencies: [32x1 double]
            ModeShapes: [1x1 struct]
                  Mesh: [1x1 FEMesh]

The solver finds natural frequencies and modal displacement values at nodal locations. To
access these values, use modalresults.NaturalFrequencies and
modalresults.ModeShapes.
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modalresults.NaturalFrequencies/(2*pi)

ans = 32×1
105 ×

    0.0013
    0.0079
    0.0222
    0.0433
    0.0711
    0.0983
    0.1055
    0.1462
    0.1930
    0.2455
      ⋮

modalresults.ModeShapes

ans = struct with fields:
    ux: [6511x32 double]
    uy: [6511x32 double]

Plot the y-component of the solution for the fundamental frequency.

pdeplot(structuralmodel,'XYData',modalresults.ModeShapes.uy(:,1))
title(['First Mode with Frequency ', ...
        num2str(modalresults.NaturalFrequencies(1)/(2*pi)),' Hz'])
axis equal
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[p,e,t] Mesh and Solution Plots

Plot the p,e,t mesh. Display the solution using 2-D and 3-D colored plots.

Create the geometry, mesh, boundary conditions, PDE coefficients, and solution.

[p,e,t] = initmesh('lshapeg');
u = assempde('lshapeb',p,e,t,1,0,1);

Plot the mesh.

pdeplot(p,e,t)
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Plot the solution as a 2-D colored plot.

pdeplot(p,e,t,'XYData',u)
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Plot the solution as a 3-D colored plot.

pdeplot(p,e,t,'XYData',u,'ZData',u)
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Input Arguments
model — Model object
PDEModel object | ThermalModel object | StructuralModel object

Model object, specified as a PDEModel object, ThermalModel object, or
StructuralModel object.
Example: model = createpde(1)
Example: thermalmodel = createpde('thermal','steadystate')
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Example: structuralmodel = createpde('structural','static-solid')

mesh — Mesh object
Mesh property of a PDEModel object | output of generateMesh

Mesh object, specified as the Mesh property of a PDEModel object or as the output of
generateMesh.
Example: model.Mesh

nodes — Nodal coordinates
2-by-NumNodes matrix

Nodal coordinates, specified as a 2-by-NumNodes matrix. NumNodes is the number of
nodes.

elements — Element connectivity matrix in terms of node IDs
3-by-NumElements matrix | 6-by-NumElements matrix

Element connectivity matrix in terms of the node IDs, specified as a 3-by-NumElements or
6-by-NumElements matrix. Linear meshes contain only corner nodes. For linear meshes,
the connectivity matrix has three nodes per 2-D element. Quadratic meshes contain
corner nodes and nodes in the middle of each edge of an element. For quadratic meshes,
the connectivity matrix has six nodes per 2-D element.

p — Mesh points
matrix

Mesh points, specified as a 2-by-Np matrix of points, where Np is the number of points in
the mesh. For a description of the (p,e,t) matrices, see “Mesh Data” on page 2-233.
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Typically, you use the p, e, and t data exported from the PDE Modeler app, or generated
by initmesh or refinemesh.
Example: [p,e,t] = initmesh(gd)
Data Types: double

e — Mesh edges
matrix

Mesh edges, specified as a 7-by-Ne matrix of edges, where Ne is the number of edges in
the mesh. For a description of the (p,e,t) matrices, see “Mesh Data” on page 2-233.

Typically, you use the p, e, and t data exported from the PDE Modeler app, or generated
by initmesh or refinemesh.
Example: [p,e,t] = initmesh(gd)
Data Types: double

t — Mesh triangles
matrix

Mesh triangles, specified as a 4-by-Nt matrix of triangles, where Nt is the number of
triangles in the mesh. For a description of the (p,e,t) matrices, see “Mesh Data” on page
2-233.

Typically, you use the p, e, and t data exported from the PDE Modeler app, or generated
by initmesh or refinemesh.
Example: [p,e,t] = initmesh(gd)
Data Types: double

Name-Value Pair Arguments
Specify optional comma-separated pairs of Name,Value arguments. Name is the
argument name and Value is the corresponding value. Name must appear inside quotes.
You can specify several name and value pair arguments in any order as
Name1,Value1,...,NameN,ValueN.
Example: pdeplot(model,'XYData',u,'ZData',u)
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When you use a PDEModel object, pdeplot(model,'XYData',u,'ZData',u) sets
surface plot coloring to the solution u, and sets the heights for a 3-D plot to u. Here u is a
NodalSolution property of the PDE results returned by solvepde or solvepdeeig.

When you use a [p,e,t] representation, pdeplot(p,e,t,'XYData',u,'ZData',u)
sets surface plot coloring to the solution u and sets the heights for a 3-D plot to the
solution u. Here u is a solution returned by a legacy solver, such as assempde.

Tip Specify at least one of the FlowData (vector field plot), XYData (colored surface
plot), or ZData (3-D height plot) name-value pairs. Otherwise, pdeplot plots the mesh
with no data.

Data Plots

XYData — Colored surface plot data
vector

Colored surface plot data, specified as the comma-separated pair consisting of 'XYData'
and a vector. If you use a [p,e,t] representation, specify data for points in a vector of
length size(p,2), or specify data for triangles in a vector of length size(t,2).

• Typically, you set XYData to the solution u. The pdeplot function uses XYData for
coloring both 2-D and 3-D plots.

• pdeplot uses the colormap specified in the ColorMap name-value pair, using the
style specified in the XYStyle name-value pair.

• When the Contour name-value pair is 'on', pdeplot also plots level curves of
XYData.

• pdeplot plots the real part of complex data.

To plot the kth component of a solution to a PDE system, extract the relevant part of the
solution. For example, when using a PDEModel object, specify:

results = solvepde(model);
u = results.NodalSolution; % each column of u has one component of u
pdeplot(model,'XYData',u(:,k)) % data for column k

When using a [p,e,t] representation, specify:
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np = size(p,2); % number of node points
uk = reshape(u,np,[]); % each uk column has one component of u
pdeplot(p,e,t,'XYData',uk(:,k)) % data for column k

Example: 'XYData',u
Data Types: double

XYStyle — Coloring choice
'interp' (default) | 'off' | 'flat'

Coloring choice, specified as the comma-separated pair consisting of 'XYStyle' and
'interp', 'off', or 'flat'.

• 'off' — No shading, only mesh is displayed.
• 'flat' — Each triangle in the mesh has a uniform color.
• 'interp' — Plot coloring is smoothly interpolated.

The coloring choice relates to the XYData name-value pair.
Example: 'XYStyle','flat'
Data Types: char | string

ZData — Data for 3-D plot heights
matrix

Data for the 3-D plot heights, specified as the comma-separated pair consisting of
'ZData' and a matrix. If you use a [p,e,t] representation, provide data for points in a
vector of length size(p,2) or data for triangles in a vector of length size(t,2).

• Typically, you set ZData to u, the solution. The XYData name-value pair sets the
coloring of the 3-D plot.

• The ZStyle name-value pair specifies whether the plot is continuous or discontinuous.
• pdeplot plots the real part of complex data.

To plot the kth component of a solution to a PDE system, extract the relevant part of the
solution. For example, when using a PDEModel object, specify:

results = solvepde(model);
u = results.NodalSolution; % each column of u has one component of u
pdeplot(model,'XYData',u(:,k),'ZData',u(:,k)) % data for column k

When using a [p,e,t] representation, specify:
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np = size(p,2); % number of node points
uk = reshape(u,np,[]); % each uk column has one component of u
pdeplot(p,e,t,'XYData',uk(:,k),'ZData',uk(:,k)) % data for column k

Example: 'ZData',u
Data Types: double

ZStyle — 3-D plot style
'continuous' (default) | 'off' | 'discontinuous'

3-D plot style, specified as the comma-separated pair consisting of 'ZStyle' and one of
these values:

• 'off' — No 3-D plot.
• 'discontinuous' — Each triangle in the mesh has a uniform height in a 3-D plot.
• 'continuous' — 3-D surface plot is continuous.

If you use ZStyle without specifying the ZData name-value pair, then pdeplot ignores
ZStyle.
Example: 'ZStyle','discontinuous'
Data Types: char | string

FlowData — Data for quiver plot
matrix

Data for the quiver plot on page 5-786, specified as the comma-separated pair consisting
of 'FlowData' and an M-by-2 matrix, where M is the number of mesh nodes. FlowData
contains the x and y values of the field at the mesh points.

When you use a PDEModel object, set FlowData as follows:

results = solvepde(model);
gradx = results.XGradients;
grady = results.YGradients;
pdeplot(model,'FlowData',[gradx grady])

When you use a [p,e,t] representation, set FlowData as follows:

[gradx,grady] = pdegrad(p,t,u); % Calculate gradient
pdeplot(p,e,t,'FlowData',[gradx;grady])
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When you use ZData to represent a 2-D PDE solution as a 3-D plot and you also include a
quiver plot, the quiver plot appears in the z = 0 plane.

pdeplot plots the real part of complex data.
Example: 'FlowData',[ux uy]
Data Types: double

FlowStyle — Indicator to show quiver plot
'arrow' (default) | 'off'

Indicator to show the quiver plot, specified as the comma-separated pair consisting of
'FlowStyle' and 'arrow' or 'off'. Here, 'arrow' displays the quiver plot on page 5-
786 specified by the FlowData name-value pair.
Example: 'FlowStyle','off'
Data Types: char | string

XYGrid — Indicator to convert mesh data to x-y grid
'off' (default) | 'on'

Indicator to convert the mesh data to x-y grid before plotting, specified as the comma-
separated pair consisting of 'XYGrid' and 'off' or 'on'.

Note This conversion can change the geometry and lessen the quality of the plot.

By default, the grid has about sqrt(size(t,2)) elements in each direction.
Example: 'XYGrid','on'
Data Types: char | string

GridParam — Customized x-y grid
[tn;a2;a3] from an earlier call to tri2grid

Customized x-y grid, specified as the comma-separated pair consisting of 'GridParam'
and a matrix [tn;a2;a3]. For example:

[~,tn,a2,a3] = tri2grid(p,t,u,x,y);
pdeplot(p,e,t,'XYGrid','on','GridParam',[tn;a2;a3],'XYData',u)
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For details on the grid data and its x and y arguments, see tri2grid. The tri2grid
function does not work with PDEModel objects.
Example: 'GridParam',[tn;a2;a3]
Data Types: double

Mesh Plots

NodeLabels — Node labels
'off' (default) | 'on'

Node labels, specified as the comma-separated pair consisting of 'NodeLabels' and
'off' or 'on'.

pdeplot ignores NodeLabels when you use it with ZData.
Example: 'NodeLabels','on'
Data Types: char | string

ElementLabels — Element labels
'off' (default) | 'on'

Element labels, specified as the comma-separated pair consisting of 'ElementLabels'
and 'off' or 'on'.

pdeplot ignores ElementLabels when you use it with ZData.
Example: 'ElementLabels','on'
Data Types: char | string

Structural Analysis Plots

Deformation — Data for plotting deformed shape
Displacement property of StaticStructuralResults object

Data for plotting the deformed shape for a structural analysis model, specified as the
comma-separated pair consisting of 'Deformation' and the Displacement property of
the StaticStructuralResults object. This property is a structure array with the fields
containing displacement components at the nodal locations.
Example: 'Deformation',structuralresults.Displacement
Data Types: struct
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DeformationScaleFactor — Scaling factor for plotting deformed shape
real number

Scaling factor for plotting the deformed shape, specified as the comma-separated pair
consisting of 'DeformationScaleFactor' and a real number. Use this argument with
the Deformation name-value pair. The default value is defined internally, based on the
dimensions of the geometry and the magnitude of the deformation.
Example: 'DeformationScaleFactor',100
Data Types: double

Annotations and Appearance

ColorBar — Indicator to include color bar
'on' (default) | 'off'

Indicator to include a color bar, specified as the comma-separated pair consisting of
'ColorBar' and 'on' or 'off'. Specify 'on' to display a bar giving the numeric values
of colors in the plot. For details, see colorbar. The pdeplot function uses the colormap
specified in the ColorMap name-value pair.
Example: 'ColorBar','off'
Data Types: char | string

ColorMap — Colormap
'cool' (default) | ColorMap value or matrix of such values

Colormap, specified as the comma-separated pair consisting of 'ColorMap' and a value
representing a built-in colormap, or a colormap matrix. For details, see colormap.

ColorMap must be used with the XYData name-value pair.
Example: 'ColorMap','jet'
Data Types: double | char | string

Mesh — Indicator to show mesh
'off' (default) | 'on'

Indicator to show the mesh, specified as the comma-separated pair consisting of 'Mesh'
and 'on' or 'off'. Specify 'on' to show the mesh in the plot.
Example: 'Mesh','on'
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Data Types: char | string

Title — Title of plot
character vector

Title of plot, specified as the comma-separated pair consisting of 'Title' and a
character vector.
Example: 'Title','Solution Plot'
Data Types: char | string

FaceAlpha — Surface transparency for 3-D geometry
1 (default) | real number from 0 through 1

Surface transparency for 3-D geometry, specified as the comma-separated pair consisting
of 'FaceAlpha' and a real number from 0 through 1. The default value 1 indicates no
transparency. The value 0 indicates complete transparency.
Example: 'FaceAlpha',0.5
Data Types: double

Contour — Indicator to plot level curves
'off' (default) | 'on'

Indicator to plot level curves, specified as the comma-separated pair consisting of
'Contour' and 'off' or 'on'. Specify 'on' to plot level curves for the XYData data.
Specify the levels with the Levels name-value pair.
Example: 'Contour','on'
Data Types: char | string

Levels — Levels for contour plot
10 (default) | positive integer | vector of level values

Levels for contour plot, specified as the comma-separated pair consisting of 'Levels'
and a positive integer or a vector of level values.

• Positive integer — Plot Levels as equally spaced contours.
• Vector — Plot contours at the values in Levels.

To obtain a contour plot, set the Contour name-value pair to 'on'.
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Example: 'Levels',16
Data Types: double

Output Arguments
h — Handles to graphics objects
vector

Handles to graphics objects, returned as a vector.

Definitions

Quiver Plot
A quiver plot is a plot of a vector field. It is also called a flow plot.

Arrows show the direction of the field, with the lengths of the arrows showing the relative
sizes of the field strength. For details on quiver plots, see quiver.

See Also
PDEModel | pdeplot3D

Topics
“Plot 2-D Solutions and Their Gradients” on page 3-284
“Deflection of Piezoelectric Actuator” on page 3-12
“Mesh Data” on page 2-233
“Solve Problems Using PDEModel Objects” on page 2-6

Introduced before R2006a
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pdeplot3D
Plot solution or surface mesh for 3-D geometry

Syntax
pdeplot3D(model,'ColorMapData',results.NodalSolution)
pdeplot3D(model,'ColorMapData',results.Temperature)
pdeplot3D(
model,'ColorMapData',results.VonMisesStress,'Deformation',results.Di
splacement)

pdeplot3D(model)
pdeplot3D(mesh)
pdeplot3D(nodes,elements)

pdeplot3D( ___ ,Name,Value)
h = pdeplot3D( ___ )

Description
pdeplot3D(model,'ColorMapData',results.NodalSolution) plots the solution at
nodal locations as colors on the surface of the 3-D geometry specified in model.

pdeplot3D(model,'ColorMapData',results.Temperature) plots the temperature
at nodal locations for a 3-D thermal analysis model.

pdeplot3D(
model,'ColorMapData',results.VonMisesStress,'Deformation',results.Di
splacement) plots the von Mises stress and shows the deformed shape for a 3-D
structural analysis model.

pdeplot3D(model) plots the surface mesh specified in model.

pdeplot3D(mesh) plots the mesh defined as a Mesh property of a 3-D model object of
type PDEModel.

pdeplot3D(nodes,elements) plots the mesh defined by nodes and elements.

 pdeplot3D
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pdeplot3D( ___ ,Name,Value) plots the surface mesh, the data at nodal locations, or
both the mesh and data, depending on the Name,Value pair arguments. Use any
arguments from the previous syntaxes.

h = pdeplot3D( ___ ) returns a handle to a plot, using any of the previous syntaxes.

Examples

Solution Plot on Surface

Plot a PDE solution on the geometry surface. First, create a PDE model and import a 3-D
geometry file. Specify boundary conditions and coefficients. Mesh the geometry and solve
the problem.

model = createpde;
importGeometry(model,'Block.stl');
applyBoundaryCondition(model,'dirichlet','Face',[1:4],'u',0);
specifyCoefficients(model,'m',0,'d',0,'c',1,'a',0,'f',2);
generateMesh(model);
results = solvepde(model)

results = 
  StationaryResults with properties:

    NodalSolution: [12691x1 double]
       XGradients: [12691x1 double]
       YGradients: [12691x1 double]
       ZGradients: [12691x1 double]
             Mesh: [1x1 FEMesh]

Access the solution at the nodal locations.

u = results.NodalSolution;

Plot the solution u on the geometry surface.

pdeplot3D(model,'ColorMapData',u)
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Solution to Steady-State Thermal Model

Solve a 3-D steady-state thermal problem.

Create a thermal model for this problem.

thermalmodel = createpde('thermal');

Import and plot the block geometry.

 pdeplot3D
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importGeometry(thermalmodel,'Block.stl'); 
pdegplot(thermalmodel,'FaceLabel','on','FaceAlpha',0.5)
axis equal

Assign material properties.

thermalProperties(thermalmodel,'ThermalConductivity',80);

Apply a constant temperature of 100 ∘C to the left side of the block (face 1) and a constant
temperature of 300 ∘C to the right side of the block (face 3). All other faces are insulated
by default.

thermalBC(thermalmodel,'Face',1,'Temperature',100);
thermalBC(thermalmodel,'Face',3,'Temperature',300);
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Mesh the geometry and solve the problem.

generateMesh(thermalmodel);
thermalresults = solve(thermalmodel)

thermalresults = 
  SteadyStateThermalResults with properties:

    Temperature: [12691x1 double]
     XGradients: [12691x1 double]
     YGradients: [12691x1 double]
     ZGradients: [12691x1 double]
           Mesh: [1x1 FEMesh]

The solver finds the temperatures and temperature gradients at the nodal locations. To
access these values, use thermalresults.Temperature,
thermalresults.XGradients, and so on. For example, plot temperatures at nodal
locations.

pdeplot3D(thermalmodel,'ColorMapData',thermalresults.Temperature)
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Heat Flux for 3-D Steady-State Thermal Model

For a 3-D steady-state thermal model, evaluate heat flux at the nodal locations and at the
points specified by x, y, and z coordinates.

Create a thermal model for steady-state analysis.

thermalmodel = createpde('thermal');

Create the following 3-D geometry and include it in the model.
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importGeometry(thermalmodel,'Block.stl'); 
pdegplot(thermalmodel,'FaceLabels','on','FaceAlpha',0.5)
title('Copper block, cm')
axis equal

Assuming that this is a copper block, the thermal conductivity of the block is
approximately 4 W /(cmK).

thermalProperties(thermalmodel,'ThermalConductivity',4);

Apply a constant temperature of 373 K to the left side of the block (face 1) and a constant
temperature of 573 K to the right side of the block (face 3).

thermalBC(thermalmodel,'Face',1,'Temperature',373);
thermalBC(thermalmodel,'Face',3,'Temperature',573);
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Apply a heat flux boundary condition to the bottom of the block.

thermalBC(thermalmodel,'Face',4,'HeatFlux',-20);

Mesh the geometry and solve the problem.

generateMesh(thermalmodel);
thermalresults = solve(thermalmodel)

thermalresults = 
  SteadyStateThermalResults with properties:

    Temperature: [12691x1 double]
     XGradients: [12691x1 double]
     YGradients: [12691x1 double]
     ZGradients: [12691x1 double]
           Mesh: [1x1 FEMesh]

Evaluate heat flux at the nodal locations.

[qx,qy,qz] = evaluateHeatFlux(thermalresults);

figure
pdeplot3D(thermalmodel,'FlowData',[qx qy qz])
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Create a grid specified by x, y, and z coordinates, and evaluate heat flux to the grid.

[X,Y,Z] = meshgrid(1:26:100,1:6:20,1:11:50);

[qx,qy,qz] = evaluateHeatFlux(thermalresults,X,Y,Z);

Reshape the qx, qy, and qz vectors, and plot the resulting heat flux.

qx = reshape(qx,size(X));
qy = reshape(qy,size(Y));
qz = reshape(qz,size(Z));
figure
quiver3(X,Y,Z,qx,qy,qz)
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Alternatively, you can specify the grid by using a matrix of query points.

querypoints = [X(:) Y(:) Z(:)]';
[qx,qy,qz] = evaluateHeatFlux(thermalresults,querypoints);

qx = reshape(qx,size(X));
qy = reshape(qy,size(Y));
qz = reshape(qz,size(Z));
figure
quiver3(X,Y,Z,qx,qy,qz)
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Deformed Shape for Cantilever Beam Problem

Create a structural analysis model for a 3-D problem.

structuralmodel = createpde('structural','static-solid');

Import the geometry and plot it.

importGeometry(structuralmodel,'SquareBeam.STL');
pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.5)

 pdeplot3D
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Specify the Young's modulus and Poisson's ratio.

structuralProperties(structuralmodel,'PoissonsRatio',0.3, ...
                                     'YoungsModulus',210E3);

Specify that face 6 is a fixed boundary.

structuralBC(structuralmodel,'Face',6,'Constraint','fixed');

Specify the surface traction for face 5.

structuralBoundaryLoad(structuralmodel,'Face',5,'SurfaceTraction',[0;0;-2]);

Generate a mesh and solve the problem.
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generateMesh(structuralmodel);
structuralresults = solve(structuralmodel);

Plot the deformed shape with the von Mises stress using the default scale factor. By
default, pdeplot3D internally determines the scale factor based on the dimensions of the
geometry and the magnitude of deformation.

figure    
pdeplot3D(structuralmodel,'ColorMapData',structuralresults.VonMisesStress, ...
                          'Deformation',structuralresults.Displacement)

Plot the same results with the scale factor 500.

figure
pdeplot3D(structuralmodel,'ColorMapData',structuralresults.VonMisesStress, ...
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                          'Deformation',structuralresults.Displacement, ...
                          'DeformationScaleFactor',500)

Plot the same results without scaling.

figure
pdeplot3D(structuralmodel,'ColorMapData',structuralresults.VonMisesStress)
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von Mises Stress for 3-D Structural Dynamic Problem

Evaluate the von Mises stress in a beam under a harmonic excitation.

Create a transient dynamic model for a 3-D problem.

structuralmodel = createpde('structural','transient-solid');

Create the geometry and include it in the model. Plot the geometry.

gm = multicuboid(0.06,0.005,0.01);
structuralmodel.Geometry = gm;
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pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.5)
view(50,20)

Specify the Young's modulus, Poisson's ratio, and mass density of the material.

structuralProperties(structuralmodel,'YoungsModulus',210E9, ...
                                     'PoissonsRatio',0.3, ...
                                     'MassDensity',7800);

Fix one end of the beam.

structuralBC(structuralmodel,'Face',5,'Constraint','fixed');

Apply a sinusoidal displacement along the y-direction on the end opposite the fixed end of
the beam.
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structuralBC(structuralmodel,'Face',3,'YDisplacement',1E-4,'Frequency',50);

Generate a mesh.

generateMesh(structuralmodel,'Hmax',0.01);

Specify the zero initial displacement and velocity.

structuralIC(structuralmodel,'Displacement',[0;0;0],'Velocity',[0;0;0]);

Solve the model.

tlist = 0:0.002:0.2;
structuralresults = solve(structuralmodel,tlist);

Evaluate the von Mises stress in the beam.

vmStress = evaluateVonMisesStress(structuralresults);

Plot the von Mises stress for the last time-step.

figure
pdeplot3D(structuralmodel,'ColorMapData',vmStress(:,end))
title('von Mises Stress in the Beam for the Last Time-Step')
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3-D Mesh Plot

Create a PDE model, include the geometry, and generate a mesh.

model = createpde;
importGeometry(model,'Tetrahedron.stl');
mesh = generateMesh(model,'Hmax',20,'GeometricOrder','linear');

Plot the surface mesh.

pdeplot3D(model)
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Alternatively, you can plot a mesh by using mesh as an input argument.

pdeplot3D(mesh)

 pdeplot3D
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Another approach is to use the nodes and elements of the mesh as input arguments for
pdeplot3D.

pdeplot3D(mesh.Nodes,mesh.Elements)
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Display the node labels on the surface of a simple mesh.

pdeplot3D(model,'NodeLabels','on')
view(101,12)

 pdeplot3D
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Display the element labels.

pdeplot3D(model,'ElementLabels','on')
view(101,12)
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Input Arguments
model — Model object
PDEModel object | ThermalModel object | StructuralModel object

Model object, specified as a PDEModel object, ThermalModel object, or
StructuralModel object.
Example: model = createpde(1)
Example: thermalmodel = createpde('thermal','steadystate')
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Example: structuralmodel = createpde('structural','static-solid')

mesh — Mesh object
Mesh property of a PDEModel object | output of generateMesh

Mesh object, specified as the Mesh property of a PDEModel object or as the output of
generateMesh.
Example: model.Mesh

nodes — Nodal coordinates
3-by-NumNodes matrix

Nodal coordinates, specified as a 3-by-NumNodes matrix. NumNodes is the number of
nodes.

elements — Element connectivity matrix in terms of node IDs
4-by-NumElements matrix | 10-by-NumElements matrix

Element connectivity matrix in terms of the node IDs, specified as a 4-by-NumElements or
10-by-NumElements matrix. Linear meshes contain only corner nodes. For linear meshes,
the connectivity matrix has four nodes per 3-D element. Quadratic meshes contain corner
nodes and nodes in the middle of each edge of an element. For quadratic meshes, the
connectivity matrix has 10 nodes per 3-D element.
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Name-Value Pair Arguments
Specify optional comma-separated pairs of Name,Value arguments. Name is the
argument name and Value is the corresponding value. Name must appear inside quotes.
You can specify several name and value pair arguments in any order as
Name1,Value1,...,NameN,ValueN.
Example: pdeplot3D(model,'NodeLabels','on')

ColorMapData — Data to plot as colored surface
column vector

Data to plot as a colored surface, specified as the comma-separated pair consisting of
'ColorMapData' and a column vector with the number of elements that equals the
number of points in the mesh. Typically, this data is the solution returned by solvepde
for a scalar PDE problem and a component of the solution for a multicomponent PDE
system.
Example: 'ColorMapData',results.NodalSolution

 pdeplot3D
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Example: 'ColorMapData',results.NodalSolution(:,1)
Data Types: double

FlowData — Data for quiver plot
matrix

Data for the quiver plot on page 5-786, specified as the comma-separated pair consisting
of 'FlowData' and an M-by-3 matrix, where M is the number of mesh nodes. FlowData
contains the x, y, and z values of the field at the mesh points. Set FlowData as follows:

results = solvepde(model);
[cgradx,cgrady,cgradz] = evaluateCGradient(results);
pdeplot3D(model,'FlowData',[cgradx cgrady cgradz])

pdeplot3D plots the real part of complex data.
Example: 'FlowData',[cgradx cgrady cgradz]
Data Types: double

Mesh — Indicator to show mesh
'off' (default) | 'on'

Indicator to show the mesh, specified as the comma-separated pair consisting of 'Mesh'
and 'on' or 'off'. Specify 'on' to show the mesh in the plot.
Example: 'Mesh','on'
Data Types: char | string

NodeLabels — Node labels
'off' (default) | 'on'

Node labels, specified as the comma-separated pair consisting of 'NodeLabels' and
'off' or 'on'.
Example: 'NodeLabels','on'
Data Types: char | string

ElementLabels — Element labels
'off' (default) | 'on'

Element labels, specified as the comma-separated pair consisting of 'ElementLabels'
and 'off' or 'on'.
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Example: 'ElementLabels','on'
Data Types: char | string

FaceAlpha — Surface transparency for 3-D geometry
1 (default) | real number from 0 through 1

Surface transparency for 3-D geometry, specified as the comma-separated pair consisting
of 'FaceAlpha' and a real number from 0 through 1. The default value 1 indicates no
transparency. The value 0 indicates complete transparency.
Example: 'FaceAlpha',0.5
Data Types: double

Output Arguments
h — Handles to graphics objects
vector

Handles to graphics objects, returned as a vector.

See Also
PDEModel | pdeplot

Topics
“Plot 3-D Solutions and Their Gradients” on page 3-295
“Solve Problems Using PDEModel Objects” on page 2-6

Introduced in R2015a

 pdeplot3D

5-813



pdepoly
Package: pde

Draw polygon in PDE Modeler app

Syntax
pdepoly(X,Y)
pdepoly(X,Y,label)

Description
pdepoly(X,Y) draws a polygon with the corner coordinates (vertices) defined by X and
Y. The pdepoly command opens the PDE Modeler app with the specified polygon drawn
in it. If the app is already open, pdepoly adds the specified polygon to the app window
without deleting any existing shapes.

pdepoly updates the state of the geometry description matrix inside the PDE Modeler
app to include the polygon. You can export the geometry description matrix from the PDE
Modeler app to the MATLAB Workspace by selecting DrawExport Geometry
Description, Set Formula, Labels.... For details on the format of the geometry
description matrix, see decsg.

pdepoly(X,Y,label) assigns a name to the polygon. Otherwise, pdepoly uses a
default name, such as P1, P2, and so on.

Examples

Draw Polygon in PDE Modeler App

Open the PDE Modeler app window containing a polygon representing the L-shaped
membrane geometry.

pdepoly([-1 0 0 1 1 -1],[0 0 1 1 -1 -1])
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Call the pdepoly command again to draw the diamond-shaped region with corners in
(0.5,0), (1,-0.5), (0.5,-1), and (0,-0.5). The pdepoly command adds the
second polygon to the app window without deleting the first.

pdepoly([0.5 1 0.5 0],[0 -0.5 -1 -0.5])

 pdepoly
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Assign Name to Polygon in PDE Modeler App

Open the PDE Modeler app window with a polygon representing the L-shaped membrane
geometry. Assign the name L-shaped-membrane to this polygon.

pdepoly([-1 0 0 1 1 -1],[0 0 1 1 -1 -1],'L-shaped-membrane')

 pdepoly

5-817



5 Functions — Alphabetical List

5-818



Input Arguments
X — x-coordinates of vertices
vector of real numbers

x-coordinates of vertices defining the polygon, specified as a vector of real numbers.
Example: pdepoly([-1 0 0 1 1 -1],[0 0 1 1 -1 -1])
Data Types: double

Y — y-coordinates of vertices
vector of real numbers

y-coordinates of vertices defining the polygon, specified as a vector of real numbers.
Example: pdepoly([-1 0 0 1 1 -1],[0 0 1 1 -1 -1])
Data Types: double

label — Name
character vector | string scalar

Name of the polygon, specified as a character vector or string scalar.
Data Types: char | string

Tips
• pdepoly opens the PDE Modeler app and draws a polygon. If, instead, you want to

draw polygons in a MATLAB figure, use the plot function, for example:

x = [-1,-0.5,-0.5,0,1.5,-0.5,-1];
y = [-1,-1,-0.5,0,0.5,0.9,-1];
plot(x,y,'.-')

See Also
PDE Modeler | pdecirc | pdeellip | pderect

Introduced before R2006a
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pdeprtni
(Not recommended) Interpolate from triangle midpoint data to node data

Note pdeprtni is not recommended. Use interpolateSolution and
evaluateGradient instead.

Syntax
un = pdeprtni(p,t,ut)

Description
un = pdeprtni(p,t,ut) gives linearly interpolated values at node points from the
values at triangle midpoints.

The geometry of the PDE problem is given by the mesh data p and t. For details on the
mesh data representation, see initmesh.

Let N be the dimension of the PDE system, np the number of node points, and nt the
number of triangles. The components of triangle data in ut are stored as N rows of length
nt. The components of the node data are stored in un as N columns of length np.

Caution
pdeprtni and pdeintrp are not inverse functions. The interpolation introduces some
averaging.

See Also
interpolateSolution | solvepde

Introduced before R2006a
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pderect
Package: pde

Draw rectangle in PDE Modeler app

Syntax
pderect([xmin xmax ymin ymax])
pderect([xmin xmax ymin ymax], label)

Description
pderect([xmin xmax ymin ymax]) draws a rectangle with the corner coordinates
defined by [xmin xmax ymin ymax]. The pderect command opens the PDE Modeler
app with the specified rectangle drawn in it. If the app is already open, pderect adds the
specified rectangle to the app window without deleting any existing shapes.

pderect updates the state of the geometry description matrix inside the PDE Modeler
app to include the rectangle. You can export the geometry description matrix from the
PDE Modeler app to the MATLAB Workspace by selecting DrawExport Geometry
Description, Set Formula, Labels.... For details on the format of the geometry
description matrix, see decsg.

pderect([xmin xmax ymin ymax], label) assigns a name to the rectangle.
Otherwise, pderect uses a default name, such as R1, R2, and so on. For squares,
pderect uses the default names SQ1, SQ2, and so on.

Examples

Draw Rectangle in PDE Modeler App

Open the PDE Modeler app window containing a rectangle with the corners at
(-1,-0.5), (-1,0.5), (1,0.5), and (1,-0.5).
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pderect([-1 1 -0.5 0.5])

Call the pderect command again to draw a square with the corners at (-0.25,-0.25),
(-0.25,0.25), (0.25,0.25), and (0.25,-0.25). The pderect command adds the
square to the app window without deleting the rectangle.

pderect([-0.25 0.25 -0.25 0.25])
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Assign Name to Rectangle in PDE Modeler App

Open the PDE Modeler app window and draw a rectangle with the corners at (-1,-0.5),
(-1,0.5), (1,0.5), and (1,-0.5). Assign the name rectangle1 to this rectangle.

pderect([-1 1 -0.5 0.5],'rectangle1')

5 Functions — Alphabetical List

5-824



 pderect

5-825



Input Arguments
[xmin xmax ymin ymax] — Corner coordinates
vector of real numbers

Corner coordinates defining the rectangle, specified as a vector of real numbers.
Example: pderect([-1 0 -1 0])
Data Types: double

label — Name
character vector | string scalar

Name of the rectangle, specified as a character vector or string scalar.
Data Types: char | string

Tips
• pderect opens the PDE Modeler app and draws a rectangle. If, instead, you want to

draw rectangles in a MATLAB figure, use the rectangle function, for example,
rectangle('Position',[1,2,5,6]).

See Also
PDE Modeler | pdecirc | pdeellip | pdepoly

Introduced before R2006a

5 Functions — Alphabetical List

5-826



pdesdp, pdesde, pdesdt
Indices of points/edges/triangles in set of subdomains

Note pdesdp and pdesdt are not recommended. Use findNodes and findElements
instead.

Syntax
c = pdesdp(p,e,t)

[i,c] = pdesdp(p,e,t)

c = pdesdp(p,e,t,sdl)

[i,c] = pdesdp(p,e,t,sdl)

i = pdesdt(t)

i = pdesdt(t,sdl)

i = pdesde(e)

i = pdesde(e,sdl)

Description
[i,c] = pdesdp(p,e,t,sdl) given mesh data p, e, and t and a list of subdomain
numbers sdl, the function returns all points belonging to those subdomains. A point can
belong to several subdomains, and the points belonging to the domains in sdl are divided
into two disjoint sets. i contains indices of the points that wholly belong to the
subdomains listed in sdl, and c lists points that also belongs to the other subdomains.

c = pdesdp(p,e,t,sdl) returns indices of points that belong to more than one of the
subdomains in sdl.

i = pdesdt(t,sdl) given triangle data t and a list of subdomain numbers sdl, i
contains indices of the triangles inside that set of subdomains.

 pdesdp, pdesde, pdesdt
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i = pdesde(e,sdl) given edge data e, it extracts indices of outer boundary edges of
the set of subdomains.

If sdl is not given, a list of all subdomains is assumed.

Introduced before R2006a
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pdesmech
(Not recommended) Calculate structural mechanics tensor functions

Note pdesmech is not recommended. Use the PDE Modeler app instead.

Syntax
ux = pdesmech(p,t,c,u,'PropertyName',PropertyValue,...)

Description
ux = pdesmech(p,t,c,u,'PropertyName',PropertyValue,...) returns a tensor
expression evaluated at the center of each triangle. The tensor expressions are stresses
and strains for structural mechanics applications with plane stress or plane strain
conditions. pdesmech is intended to be used for postprocessing of a solution computed
using the structural mechanics application modes of the PDE Modeler app, after
exporting the solution, the mesh, and the PDE coefficients to the MATLAB workspace.
Poisson's ratio, nu, has to be supplied explicitly for calculations of shear stresses and
strains, and for the von Mises effective stress in plane strain mode.

Valid property name/property value pairs include the following.

Property Name Property Value/Default Description
tensor 'ux' | 'uy' | 'vx' | 'vy' | 'exx' |

'eyy' | 'exy' |
'sxx' | 'syy' | 'sxy' | 'e1' | 'e2' |
's1' | 's2' | {'vonmises'}

Tensor expression

application {'ps'} | 'pn' Plane stress | plane
strain

 pdesmech
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Property Name Property Value/Default Description
nu Scalar | vector | character vector | string scalar |

{0.3}
Poisson's ratio. Applies
to calculating von Mises
('vonmises') effective
stress in plane strain
mode ('pn'). Specify a
scalar if the value is
constant over the entire
geometry. Specify a
vector as a row vector
whose length is equal to
the number of elements.
Specify a character
vector or a string scalar
in coefficient form:
“Specify Scalar PDE
Coefficients in Character
Form” on page 2-74.

The available tensor expressions are

• 'ux', which is ∂u∂x
• 'uy', which is ∂u∂y
• 'vx', which is ∂v∂x
• 'vy', which is ∂v∂y
• 'exx', the x-direction strain (εx)
• 'eyy', the y-direction strain (εy)
• 'exy', the shear strain (γxy)
• 'sxx', the x-direction stress (σx)
• 'syy', the y-direction stress (σy)
• 'sxy', the shear stress (τxy)
• 'e1', the first principal strain (ε1)
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• 'e2', the second principal strain (ε2)
• 's1', the first principal stress (σ1)
• 's2', the second principal stress (σ2)
• 'vonmises', the von Mises effective stress, for plane stress conditions

σ1
2 + σ2

2− σ1σ2

or for plane strain conditions

(σ1
2 + σ2

2)(v2− v + 1) + σ1σ2 2v2− 2v− 1

where v is Poisson’s ratio nu.

Examples
Assuming that a problem has been solved using the application mode Structural
Mechanics, Plane Stress, and that the solution u, the mesh data p and t, and the PDE
coefficient c all have been exported to the MATLAB workspace, the x-direction strain is
computed as

sx = pdesmech(p,t,c,u,'tensor','sxx'); 

To compute the von Mises effective stress for a plane strain problem with Poisson's ratio
equal to 0.3, type

mises = pdesmech(p,t,c,u,'tensor','vonmises',...
  'application','pn','nu',0.3);

Introduced before R2006a
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PDESolverOptions Properties
Algorithm options for PDE solvers

Description
A PDESolverOptions object contains options used by the solvers when solving a PDE
problem specified as PDEModel. A PDEModel object contains a PDESolverOptions
object in its SolverOptions property.

Properties
Properties

AbsoluteTolerance — Absolute tolerance for internal ODE solver
1.0000e-06 (default) | positive real number

Absolute tolerance for internal ODE solver, returned as a positive real number. Absolute
tolerance is a threshold below which the value of the solution component is unimportant.
This property determines the accuracy when the solution approaches zero.
Example: model.SolverOptions.AbsoluteTolerance = 5.0000e-06
Data Types: double

RelativeTolerance — Relative tolerance for internal ODE solver
1.0000e-03 (default) | positive real number

Relative tolerance for internal ODE solver, returned as a positive real number. This
tolerance is a measure of the error relative to the size of each solution component.
Roughly, it controls the number of correct digits in all solution components, except those
smaller than thresholds imposed by AbsoluteTolerance. The default value corresponds
to 0.1% accuracy.
Example: model.SolverOptions.RelativeTolerance = 5.0000e-03
Data Types: double
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ResidualTolerance — Acceptable residual tolerance for internal nonlinear
solver
1.0000e-04 (default) | positive real number

Acceptable residual tolerance for internal nonlinear solver, returned as a positive real
number. The nonlinear solver iterates until the residual size is less than the value of
ResidualTolerance.
Example: model.SolverOptions.ResidualTolerance = 5.0000e-04
Data Types: double

MaxIterations — Maximal number of Gauss-Newton iterations allowed for the
nonlinear solver
25 (default) | positive real number

Maximal number of Gauss-Newton iterations allowed for the nonlinear solver, returned as
a positive integer.
Example: model.SolverOptions.MaxIterations = 30
Data Types: double

MinStep — Minimum damping of search direction for the nonlinear solver
1.5259e-05 (default) | positive real number

Minimum damping of search direction for the nonlinear solver, returned as a positive real
number.
Example: model.SolverOptions.MinStep = 1.5259e-7
Data Types: double

ResidualNorm — Residual norm
Inf (default) | -Inf | positive real number | 'energy'

Residual norm, returned as the p value for Lp norm, or as 'energy'. For the Lp-norm, p
can be any positive real value, Inf, or -Inf. The p norm of a vector v is
sum(abs(v)^p)^(1/p). See norm.
Example: model.SolverOptions.ResidualNorm = 'energy'
Data Types: double | char
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ReportStatistics — Flag that controls the display of internal nonlinear and
ODE solver statistics and convergence report during the solution process
'off' (default) | 'on'

Flag that controls the display of internal nonlinear and ODE solver statistics and
convergence report during the solution process, returned as 'off' or 'on'.
Example: model.SolverOptions.ReportStatistics = 'on'
Data Types: char

See Also
PDEModel | solvepde | solvepdeeig

Introduced in R2016a
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pdesurf
Shorthand command for surface plot

Note This page describes the legacy workflow. Use it when you work with legacy code
and do not plan to convert it to use the recommended approach. Otherwise, use pdeplot.

Syntax
pdesurf(p,t,u)

Description
pdesurf(p,t,u) plots a 3-D surface of PDE node or triangle data. If u is a column
vector, node data is assumed, and continuous style and interpolated shading are used. If u
is a row vector, triangle data is assumed, and discontinuous style and flat shading are
used.

h = pdesurf(p,t,u) additionally returns handles to the drawn axes objects.

For node data, this command is just shorthand for the call

pdeplot(p,[],t,'XYData',u,'XYStyle','interp',...
         'ZData',u,'ZStyle','continuous',...
         'ColorBar','off'); 

and for triangle data it is

pdeplot(p,[],t,'XYData',u,'XYStyle','flat',...
         'ZData',u,'ZStyle','discontinuous',...
         'ColorBar','off'); 

If you want to have more control over your surface plot, use pdeplot instead of
pdesurf.
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Examples

Surface Plot of The Solution

Surface plot of the solution to the equation −Δu = 1 over the geometry defined by the L-
shaped membrane. Use Dirichlet boundary conditions u = 0 on ∂Ω.

[p,e,t] = initmesh('lshapeg'); 
[p,e,t] = refinemesh('lshapeg',p,e,t); 
u = assempde('lshapeb',p,e,t,1,0,1); 
pdesurf(p,t,u)
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See Also
pdecont | pdemesh | pdeplot

Introduced before R2006a
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PDE Modeler
Solve partial differential equations in 2-D regions

Description
The PDE Modeler app provides an interactive interface for solving 2-D geometry
problems. Using the app, you can create complex geometries by drawing, overlapping,
and rotating basic shapes, such as circles, polygons and so on. The app also includes
preset modes for applications, such as electrostatics, magnetostatics, heat transfer, and
so on.

When solving a PDE problem in the app, follow these steps:

1 Create a 2-D geometry.
2 Specify boundary conditions.
3 Specify equation coefficients.
4 Generate a mesh.
5 Specify parameters for solving a PDE. The set of parameters depends on the type of

PDE. For parabolic and hyperbolic PDEs, these parameters include initial conditions.
6 Solve the problem.
7 Specify plotting parameters and plot the results.

You can choose to export data to the MATLAB workspace from any step in the app and
continue your work outside the app.

Note The app does not support 3-D geometry problems and systems of more than two
PDEs.

Open the PDE Modeler App
• MATLAB Toolstrip: On the Apps tab, under Math, Statistics and Optimization, click

the app icon.
• MATLAB command prompt: Enter pdeModeler.
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Examples
• “Current Density Between Two Metallic Conductors” on page 3-146
• “Heat Transfer in Block with Cavity: PDE Modeler App” on page 3-197
• “L-Shaped Membrane with Rounded Corner” on page 3-260

Programmatic Use
pdeModeler opens the PDE Modeler app or brings focus to the app if it is already open.

pdecirc(xc,yc,r) opens the PDE Modeler app and draws a circle with center in
(xc,yc) and radius r.

pdeellip(xc,yc,a,b,phi) opens the PDE Modeler app and draws an ellipse with
center in (xc,yc) and semiaxes a and b. The rotation of the ellipse (in radians) is phi.

pdepoly(x,y) opens the PDE Modeler app and draws a polygon with corner coordinates
defined by x and y.

pderect([xmin xmax ymin ymax]) opens the PDE Modeler app and draws a
rectangle with corner coordinates defined by [xmin xmax ymin ymax].

See Also
Functions
pdecirc | pdeellip | pdepoly | pderect

Objects
PDEModel

Topics
“Current Density Between Two Metallic Conductors” on page 3-146
“Heat Transfer in Block with Cavity: PDE Modeler App” on page 3-197
“L-Shaped Membrane with Rounded Corner” on page 3-260

Introduced before R2006a
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pdetrg
(Not recommended) Triangle geometry data

Note pdetrg is not recommended. Use area instead.

Syntax
[ar,a1,a2,a3] = pdetrg(p,t)
[ar,g1x,g1y,g2x,g2y,g3x,g3y] = pdetrg(p,t)

Description
[ar,a1,a2,a3] = pdetrg(p,t) returns the area of each triangle in ar and half of the
negative cotangent of each angle in a1, a2, and a3.

[ar,g1x,g1y,g2x,g2y,g3x,g3y] = pdetrg(p,t) returns the area and the gradient
components of the triangle base functions.

The triangular mesh of the PDE problem is given by the mesh data p and t. For details on
the mesh data representation, see initmesh.

Introduced before R2006a
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pdetriq
(Not recommended) Triangle quality measure

Note pdetriq is not recommended. Use meshQuality instead.

Syntax
q = pdetriq(p,t)

Description
q = pdetriq(p,t) returns a triangle quality measure given mesh data.

The triangular mesh is given by the mesh data p, e, and t. For details on the mesh data
representation, see initmesh.

The triangle quality is given by the formula

q = 4a 3
h1

2 + h2
2 + h3

2

where a is the area and h1, h2, and h3 the side lengths of the triangle.

If q > 0.6 the triangle is of acceptable quality. q = 1 when h1 = h2 = h3.

References
Bank, Randolph E., PLTMG: A Software Package for Solving Elliptic Partial Differential
Equations, User's Guide 6.0, Society for Industrial and Applied Mathematics,
Philadelphia, PA, 1990.
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See Also
Introduced before R2006a
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poiasma
(Not recommended) Boundary point matrix contributions for fast solvers of Poisson's
equation

Note poiasma is not recommended. To solve Poisson's equations, use solvepde. For
details, see “Solve Problems Using PDEModel Objects”.

Syntax
K = poiasma(n1,n2,h1,h2)
K = poiasma(n1,n2)
K = poiasma(n)

Description
K = poiasma(n1,n2,h1,h2) assembles the contributions to the stiffness matrix from
boundary points. n1 and n2 are the numbers of points in the first and second directions,
and h1 and h2 are the mesh spacings. K is a sparse n1*n2-by-n1*n2 matrix. The point
numbering is the canonical numbering for a rectangular mesh.

K = poiasma(n1,n2) uses h1 = h2.

K = poiasma(n) uses n1 = n2 = n.

See Also
Introduced before R2006a
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poicalc
Fast solver for Poisson's equation on rectangular grid

Note poicalc is not recommended. To solve Poisson's equations, use solvepde. For
details, see “Solve Problems Using PDEModel Objects”.

Syntax
u = poicalc(f,h1,h2,n1,n2)

u = poicalc(f,h1,h2)

u = poicalc(f)

Description
u = poicalc(f,h1,h2,n1,n2) calculates the solution of Poisson's equation for the
interior points of an evenly spaced rectangular grid. The columns of u contain the
solutions corresponding to the columns of the right-hand side f. h1 and h2 are the
spacings in the first and second direction, and n1 and n2 are the number of points.

The number of rows in f must be n1*n2. If n1 and n2 are not given, the square root of
the number of rows of f is assumed. If h1 and h2 are not given, they are assumed to be
equal.

The ordering of the rows in u and f is the canonical ordering of interior points, as
returned by poiindex.

The solution is obtained by sine transforms in the first direction and tridiagonal matrix
solution in the second direction. n1 should be 1 less than a power of 2 for best
performance.
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See Also
Introduced before R2006a
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poiindex
(Not recommended) Indices of points in canonical ordering for rectangular grid

Note poiindex is not recommended. To solve Poisson's equations, use solvepde. For
details, see “Solve Problems Using PDEModel Objects”.

Syntax
[n1,n2,h1,h2,i,c,ii,cc] = poiindex(p,e,t,sd)

Description
[n1,n2,h1,h2,i,c,ii,cc] = poiindex(p,e,t,sd) identifies a given grid p, e, t in
the subdomain sd as an evenly spaced rectangular grid. If the grid is not rectangular, n1
is 0 on return. Otherwise n1 and n2 are the number of points in the first and second
directions, h1 and h2 are the spacings. i and ii are of length (n1-2)*(n2-2) and
contain indices of interior points. i contains indices of the original mesh, whereas ii
contains indices of the canonical ordering. c and cc are of length n1*n2-
(n1-2)*(n2-2) and contain indices of border points. ii and cc are increasing.

In the canonical ordering, points are numbered from left to right and then from bottom to
top. Thus if n1 = 3 and n2 = 5, then ii = [5 8 11] and cc = [1 2 3 4 6 7 9 10
12 13 14 15].

Introduced before R2006a
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poimesh
(Not recommended) Make regular mesh on rectangular geometry

Note poimesh is not recommended. To solve Poisson's equations, use solvepde. For
details, see “Solve Problems Using PDEModel Objects”.

Syntax
[p,e,t] = poimesh(g,nx,ny)

[p,e,t] = poimesh(g,n)

[p,e,t] = poimesh(g)

Description
[p,e,t] = poimesh(g,nx,ny) constructs a regular mesh on the rectangular geometry
specified by g, by dividing the “x edge” into nx pieces and the “y edge” into ny pieces,
and placing (nx+1)*(ny+1) points at the intersections.

The “x edge” is the one that makes the smallest angle with the x-axis.

[p,e,t] = poimesh(g,n) uses nx = ny = n, and [p,e,t] = poimesh(g) uses nx
= ny = 1.

The triangular mesh is described by the mesh data p, e, and t. For details on the mesh
data representation, see initmesh.

For best performance with poisolv, the larger of nx and ny should be a power of 2.

If g does not seem to describe a rectangle, p is zero on return.

Introduced before R2006a

 poimesh

5-847



poisolv
(Not recommended) Fast solution of Poisson's equation on rectangular grid

Note poisolv is not recommended. To solve Poisson's equations, use solvepde. For
details, see “Solve Problems Using PDEModel Objects”.

Syntax
u = poisolv(b,p,e,t,f)

Description
u = poisolv(b,p,e,t,f) solves Poisson's equation with Dirichlet boundary conditions
on a regular rectangular grid. A combination of sine transforms and tridiagonal solutions
is used for increased performance.

The boundary conditions b must specify Dirichlet conditions for all boundary points.

The mesh p, e, and t must be a regular rectangular grid. For details on the mesh data
representation, see initmesh.

f gives the right-hand side of Poisson's equation.

Apart from roundoff errors, the result should be the same as u =
assempde(b,p,e,t,1,0,f).

References
Strang, Gilbert, Introduction to Applied Mathematics, Wellesley-Cambridge Press,
Cambridge, MA, 1986, pp. 453–458.

Introduced before R2006a
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refinemesh
Refine triangular mesh

Note This page describes the legacy workflow. New features might not be compatible
with the legacy workflow. For the corresponding step in the recommended workflow, see
generateMesh.

Syntax
[p1,e1,t1] = refinemesh(g,p,e,t)

[p1,e1,t1] = refinemesh(g,p,e,t,'regular')

[p1,e1,t1] = refinemesh(g,p,e,t,'longest')

[p1,e1,t1] = refinemesh(g,p,e,t,it)

[p1,e1,t1] = refinemesh(g,p,e,t,it,'regular')

[p1,e1,t1] = refinemesh(g,p,e,t,it,'longest')

[p1,e1,t1,u1] = refinemesh(g,p,e,t,u)

[p1,e1,t1,u1] = refinemesh(g,p,e,t,u,'regular')

[p1,e1,t1,u1] = refinemesh(g,p,e,t,u,'longest')

[p1,e1,t1,u1] = refinemesh(g,p,e,t,u,it)

[p1,e1,t1,u1] = refinemesh(g,p,e,t,u,it,'regular')

[p1,e1,t1,u1] = refinemesh(g,p,e,t,u,it,'longest')

Description
[p1,e1,t1] = refinemesh(g,p,e,t) returns a refined version of the triangular
mesh specified by the geometry g, Point matrix p, Edge matrix e, and Triangle matrix t.
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The triangular mesh is given by the mesh data p, e, and t. For details on the mesh data
representation, see “Mesh Data” on page 2-233.

[p1,e1,t1,u1] = refinemesh(g,p,e,t,u) refines the mesh and also extends the
function u to the new mesh by linear interpolation. The number of rows in u should
correspond to the number of columns in p, and u1 has as many rows as there are points
in p1. Each column of u is interpolated separately.

An extra input argument it is interpreted as a list of subdomains to refine, if it is a row
vector, or a list of triangles to refine, if it is a column vector.

The default refinement method is regular refinement, where all of the specified triangles
are divided into four triangles of the same shape. Longest edge refinement, where the
longest edge of each specified triangle is bisected, can be demanded by giving longest
as a final parameter. Using regular as a final parameter results in regular refinement.
Some triangles outside of the specified set may also be refined to preserve the
triangulation and its quality.

Examples

Mesh Refinement

Refine the mesh of the L-shaped membrane several times. Plot the mesh for the geometry
of the L-shaped membrane.

[p,e,t] = initmesh('lshapeg','hmax',inf); 
subplot(2,2,1), pdemesh(p,e,t) 
[p,e,t] = refinemesh('lshapeg',p,e,t); 
subplot(2,2,2), pdemesh(p,e,t) 
[p,e,t] = refinemesh('lshapeg',p,e,t); 
subplot(2,2,3), pdemesh(p,e,t) 
[p,e,t] = refinemesh('lshapeg',p,e,t); 
subplot(2,2,4), pdemesh(p,e,t) 
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subplot

Algorithms
The algorithm is described by the following steps:

1 Pick the initial set of triangles to be refined.
2 Either divide all edges of the selected triangles in half (regular refinement), or divide

the longest edge in half (longest edge refinement).
3 Divide the longest edge of any triangle that has a divided edge.
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4 Repeat step 3 until no further edges are divided.
5 Introduce new points of all divided edges, and replace all divided entries in e by two

new entries.
6 Form the new triangles. If all three sides are divided, new triangles are formed by

joining the side midpoints. If two sides are divided, the midpoint of the longest edge
is joined with the opposing corner and with the other midpoint. If only the longest
edge is divided, its midpoint is joined with the opposing corner.

See Also
initmesh | pdeent | pdesdt

Topics
“Mesh Data” on page 2-233

Introduced before R2006a
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setInitialConditions
Package: pde

Give initial conditions or initial solution

Syntax
setInitialConditions(model,u0)
setInitialConditions(model,u0,ut0)
setInitialConditions( ___ ,RegionType,RegionID)

setInitialConditions(model,results)
setInitialConditions(model,results,iT)

ic = setInitialConditions( ___ )

Description
setInitialConditions(model,u0) sets initial conditions in model. Use this syntax
for stationary nonlinear problems or time-dependent problems where the time derivative
is first order.

Note Include geometry in model before using setInitialConditions.

setInitialConditions(model,u0,ut0) use this syntax for time-dependent problems
where a time derivative is second order, such as a hyperbolic problem.

setInitialConditions( ___ ,RegionType,RegionID) sets initial conditions on a
geometry region using any of the arguments in the previous syntaxes.

setInitialConditions(model,results) sets the initial guess for stationary
nonlinear problems using the solution results from a previous analysis on the same
geometry and mesh. The initial derivative for stationary problems is 0.

setInitialConditions(model,results,iT) sets the initial conditions for time-
dependent problems using the solution results corresponding to the solution time index
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iT. If you do not specify the time index iT, setInitialConditions uses the last
solution time in results.

ic = setInitialConditions( ___ ) returns a handle to the initial conditions object.

Examples

Constant Initial Conditions

Create a PDE model, import geometry, and set the initial condition to 50 on the entire
geometry.

model = createpde();
importGeometry(model,'BracketWithHole.stl');
setInitialConditions(model,50);

Constant Initial Conditions for System

Set different initial conditions for each component of a system of PDEs.

Create a PDE model for a system with five components. Import the Block.stl geometry.

model = createpde(5);
importGeometry(model,'Block.stl');

Set the initial conditions for each component to twice the component number.

u0 = [2:2:10]';
setInitialConditions(model,u0)

ans = 
  GeometricInitialConditions with properties:

           RegionType: 'cell'
             RegionID: 1
         InitialValue: [5x1 double]
    InitialDerivative: []
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Different Initial Conditions on Subdomains

Set different initial conditions on each portion of the L-shaped membrane geometry.

Create a model, set the geometry function, and view the subdomain labels.

model = createpde();
geometryFromEdges(model,@lshapeg);
pdegplot(model,'FaceLabels','on')
axis equal
ylim([-1.1,1.1])
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Set subdomain 1 to initial value -1, subdomain 2 to initial value 1, and subdomain 3 to
initial value 5.

setInitialConditions(model,-1);
setInitialConditions(model,1,'Face',2);
setInitialConditions(model,5,'Face',3);

The initial setting applies to the entire geometry. The subsequent settings override the
initial settings for regions 2 and 3.

Nonconstant Initial Conditions That Are Functions of Position

Set initial conditions for the L-shaped membrane geometry to be x2 + y2, except in the
lower left square where it is x2− y4.

model = createpde();
geometryFromEdges(model,@lshapeg);
pdegplot(model,'FaceLabels','on')
axis equal
ylim([-1.1,1.1])
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Set the initial conditions to x2 + y2.

initfun = @(location)location.x.^2 + location.y.^2;
setInitialConditions(model,initfun);

Set the initial conditions on region 2 to x2− y4. This setting overrides the first setting
because you apply it after the first setting.

initfun2 = @(location)location.x.^2 - location.y.^4;
setInitialConditions(model,initfun2,'Face',2);
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Initial Conditions for Hyperbolic Equation

Hyperbolic equations have nonzero m coefficient, so you must set both the u0 and ut0
arguments.

Import the Block.stl to a PDE model with N = 3 components.

model = createpde(3);
importGeometry(model,'Block.stl');

Set the initial condition value to be 0 for all components. Set the initial derivative.

ut0 =

4 + x
x2 + y2 + z2

5 − tanh z

10 y
x2 + y2 + z2

To create this initial gradient, write a function file, and ensure that the function is on your
MATLAB path.

function ut0 = ut0fun(location)

M = length(location.x);

ut0 = zeros(3,M);

denom = location.x.^2+location.y.^2+location.z.^2;

ut0(1,:) = 4 + location.x./denom;

ut0(2,:) = 5 - tanh(location.z);

ut0(3,:) = 10*location.y./denom;

end

Set the initial conditions.

setInitialConditions(model,0,@ut0fun)

ans = 
  GeometricInitialConditions with properties:
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           RegionType: 'cell'
             RegionID: 1
         InitialValue: 0
    InitialDerivative: @ut0fun

Initial Condition Is Previously Obtained Solution

Set initial conditions using the solution from a previous analysis on the same geometry
and mesh.

Create and view the geometry: a square with a circular subdomain.

% Square centered at (1,1), circle centered at (1.5,0.5).
rect1 = [3;4;0;2;2;0;0;0;2;2];
circ1 = [1;1.5;.75;0.25];
% Append extra zeros to the circle;
circ1 = [circ1;zeros(length(rect1)-length(circ1),1)];
gd = [rect1,circ1];
ns = char('rect1','circ1');
ns = ns';
sf = 'rect1+circ1';
[dl,bt] = decsg(gd,sf,ns);
pdegplot(dl,'EdgeLabels','on','FaceLabels','on')
axis equal
ylim([-0.1,2.1])
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Include the geometry in a PDE model, set boundary and initial conditions, and specify
coefficients.

model = createpde();
geometryFromEdges(model,dl);

% Set boundary conditions that the upper and left edges are at temperature 10.
applyBoundaryCondition(model,'dirichlet','Edge',[2,3],'u',10);

% Set initial conditions that the square region is at temperature 0,
% and the circle is at temperature 100.
setInitialConditions(model,0);
setInitialConditions(model,100,'Face',2);
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specifyCoefficients(model,'m',0,...
                          'd',1,...
                          'c',1,...
                          'a',0,...
                          'f',0);

Solve the problem for times 0 through 1/2 in steps of 0.01.

generateMesh(model,'Hmax',0.05);
tlist = 0:0.01:0.5;
results = solvepde(model,tlist);

Plot the solution for times 0.02, 0.04, 0.1, and 0.5.

sol = results.NodalSolution;

subplot(2,2,1)
pdeplot(model,'XYData',sol(:,3))
title('Time 0.02')
subplot(2,2,2)
pdeplot(model,'XYData',sol(:,5))
title('Time 0.04')
subplot(2,2,3)
pdeplot(model,'XYData',sol(:,11))
title('Time 0.1')
subplot(2,2,4)
pdeplot(model,'XYData',sol(:,51))
title('Time 0.5')
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Now, resume the analysis and solve the problem for times from 1/2 to 1. Use the
previously obtained solution for time 1/2 as an initial condition. Since 1/2 is the last
element in tlist, you do not need to specify the solution time index. By default,
setInitialConditions uses the last solution index.

setInitialConditions(model,results)

ans = 
  NodalInitialConditions with properties:

         InitialValue: [7289x1 double]
    InitialDerivative: []
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Solve the problem for times 1/2 through 1 in steps of 0.01.

tlist1 = 0.5:0.01:1.0;
results1 = solvepde(model,tlist1);

Plot the solution for times 0.5, 0.7, 0.9, and 1.

sol1 = results1.NodalSolution;

figure

subplot(2,2,1)
pdeplot(model,'XYData',sol1(:,1))
title('Time 0.5')
subplot(2,2,2)
pdeplot(model,'XYData',sol1(:,21))
title('Time 0.7')
subplot(2,2,3)
pdeplot(model,'XYData',sol1(:,41))
title('Time 0.9')
subplot(2,2,4)
pdeplot(model,'XYData',sol1(:,51))
title('Time 1.0')
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To use the previously obtained solution for a particular solution time instead of the last
one, specify the solution time index as a third parameter of setInitialConditions.
For example, use the solution at time 0.2, which is the 21st element in tlist.

setInitialConditions(model,results,21)

ans = 
  NodalInitialConditions with properties:

         InitialValue: [7289x1 double]
    InitialDerivative: []

Solve the problem for times 0.2 through 1 in steps of 0.01.
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tlist2 = 0.2:0.01:1.0;
results2 = solvepde(model,tlist2);

Input Arguments
model — PDE model
PDEModel object

PDE model, specified as a PDEModel object.
Example: model = createpde

u0 — Initial condition
scalar | column vector of length N | function handle

Initial conditions, specified as a scalar, a column vector of length N, or a function handle.
N is the size of the system of PDEs. See “Equations You Can Solve Using PDE Toolbox” on
page 1-6.

• Scalar — Use it to represent a constant initial value for all solution components
throughout the domain.

• Column vector — Use it to represent a constant initial value for each of the N solution
components throughout the domain.

• Function handle — Use it to represent the initial conditions as a function of position.
The function must be of the form

u0 = initfun(location)

Solvers pass location as a structure with fields location.x, location.y, and, for
3-D problems, location.z. initfun must return a matrix u0 of size N-by-M, where M
= length(location.x).

Example: setInitialConditions(model,10)
Data Types: double | function_handle
Complex Number Support: Yes

ut0 — Initial condition for time derivative
scalar | column vector of length N | function handle

Initial condition for time derivative, specified as a scalar, a column vector of length N, or a
function handle. N is the size of the system of PDEs. See “Equations You Can Solve Using
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PDE Toolbox” on page 1-6. You must specify ut0 when there is a nonzero second-order
time-derivative coefficient m.

• Scalar — Use it to represent a constant initial value for all solution components
throughout the domain.

• Column vector — Use it to represent a constant initial value for each of the N solution
components throughout the domain.

• Function handle — Use it to represent the initial conditions as a function of position.
The function must be of the form

u0 = initfun(location)

Solvers pass location as a structure with fields location.x, location.y, and, for
3-D problems, location.z. initfun must return a matrix u0 of size N-by-M, where M
= length(location.x).

Example: setInitialConditions(model,10,@initfun)
Data Types: double | function_handle
Complex Number Support: Yes

RegionType — Geometric region type
'Face' | 'Edge' | 'Vertex' | 'Cell'

Geometric region type, specified as 'Face', 'Edge', 'Vertex', or 'Cell'.

When there are multiple initial condition assignments, solvers use the following
precedence rules for determining the initial condition.

• If there are multiple assignments to the same geometric region, solvers use the last
applied setting.

• If there are separate assignments to a geometric region and the boundaries of that
region, the solvers use the specified assignment on the region and choose the
assignment on the boundary as follows. The solvers give an 'Edge' assignment
precedence over a 'Face' assignment, even if you specify a 'Face' assignment after
an 'Edge' assignment. The precedence levels are 'Vertex (highest precedence),
'Edge', 'Face', 'Cell' (lowest precedence).

• If there is an assignment made with the results object, solvers use that assignment
instead of all previous assignments.

Example: setInitialConditions(model,10,'Face',1:4)
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Data Types: char | string

RegionID — Geometric region ID
vector of positive integers

Geometric region ID, specified as a vector of positive integers. Find the region IDs using
pdegplot, as shown in “Create Geometry and Remove Face Boundaries” on page 2-13 or
“STL File Import” on page 2-46.
Example: setInitialConditions(model,10,'Face',1:4)
Data Types: double

results — PDE solution
StationaryResults object | TimeDependentResults object

PDE solution, specified as a StationaryResults object or a TimeDependentResults
object. Create results using solvepde or createPDEResults.
Example: results = solvepde(model)

iT — Time index
positive integer

Time index, specified as a positive integer.
Example: setInitialConditions(model,results,21)
Data Types: double

Output Arguments
ic — Handle to initial condition
object

Handle to initial condition, returned as an object. ic associates the initial condition with
the geometric region in the case of a geometric assignment or the nodes in the case of a
results-based assignment.
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Tips
• To ensure that the model has the correct TimeDependent property setting, if possible

specify coefficients before setting initial conditions.
• To avoid assigning initial conditions to a wrong region, ensure that you are using the

correct geometric region IDs by plotting and visually inspecting the geometry.

See Also
PDEModel | findInitialConditions | pdegplot

Topics
“Set Initial Conditions” on page 2-154
“Solve Problems Using PDEModel Objects” on page 2-6
“Equations You Can Solve Using PDE Toolbox” on page 1-6

Introduced in R2016a
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solve
Package: pde

Solve heat transfer or structural analysis problem

Syntax
thermalresults = solve(thermalmodel)
thermalresults = solve(thermalmodel,tlist)

structuralresults = solve(structuralmodel,'FrequencyRange',
[omega1,omega2])

structuralresults = solve(structuralmodel)
structuralresults = solve(structuralmodel,tlist)
structuralresults = solve(structuralmodel,tlist,'ModalResults',
modalresults)

Description
thermalresults = solve(thermalmodel) returns the solution to the steady-state
thermal model represented in thermalmodel.

thermalresults = solve(thermalmodel,tlist) returns the solution to the
transient thermal model represented in thermalmodel at the times tlist.

structuralresults = solve(structuralmodel,'FrequencyRange',
[omega1,omega2]) returns the solution to the modal analysis model for all modes in the
frequency range [omega1,omega2]. Define omega1 as slightly smaller than the lowest
expected frequency and omega2 as slightly larger than the highest expected frequency.
For example, is the lowest expected frequency is zero, then use a small negative value for
omega1.

structuralresults = solve(structuralmodel) returns the solution to the static
structural analysis model represented in structuralmodel.

 solve
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structuralresults = solve(structuralmodel,tlist) returns the solution to the
transient structural dynamics model represented in .

structuralresults = solve(structuralmodel,tlist,'ModalResults',
modalresults) solves a transient structural dynamics model by using the modal
superposition method to speed up computations. First, perform modal analysis to
compute natural frequencies and mode shapes in a particular frequency range. Then, use
this syntax to invoke the modal superposition method. The accuracy of the results
depends on the number of modes in the modal analysis results.

Examples

Solution to Steady-State Thermal Model

Solve a 3-D steady-state thermal problem.

Create a thermal model for this problem.

thermalmodel = createpde('thermal');

Import and plot the block geometry.

importGeometry(thermalmodel,'Block.stl'); 
pdegplot(thermalmodel,'FaceLabel','on','FaceAlpha',0.5)
axis equal
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Assign material properties.

thermalProperties(thermalmodel,'ThermalConductivity',80);

Apply a constant temperature of 100 ∘C to the left side of the block (face 1) and a constant
temperature of 300 ∘C to the right side of the block (face 3). All other faces are insulated
by default.

thermalBC(thermalmodel,'Face',1,'Temperature',100);
thermalBC(thermalmodel,'Face',3,'Temperature',300);

Mesh the geometry and solve the problem.

generateMesh(thermalmodel);
thermalresults = solve(thermalmodel)

 solve
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thermalresults = 
  SteadyStateThermalResults with properties:

    Temperature: [12691x1 double]
     XGradients: [12691x1 double]
     YGradients: [12691x1 double]
     ZGradients: [12691x1 double]
           Mesh: [1x1 FEMesh]

The solver finds the temperatures and temperature gradients at the nodal locations. To
access these values, use thermalresults.Temperature,
thermalresults.XGradients, and so on. For example, plot temperatures at nodal
locations.

pdeplot3D(thermalmodel,'ColorMapData',thermalresults.Temperature)
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Solution to Transient Thermal Model

Solve a 2-D transient thermal problem.

Create a transient thermal model for this problem.

thermalmodel = createpde('thermal','transient');

Create the geometry and include it in the model.

SQ1 = [3; 4; 0; 3; 3; 0; 0; 0; 3; 3];
D1 = [2; 4; 0.5; 1.5; 2.5; 1.5; 1.5; 0.5; 1.5; 2.5];

 solve
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gd = [SQ1 D1];
sf = 'SQ1+D1';
ns = char('SQ1','D1');
ns = ns';
dl = decsg(gd,sf,ns);
geometryFromEdges(thermalmodel,dl);
pdegplot(thermalmodel,'EdgeLabels','on','FaceLabels','on')
xlim([-1.5 4.5])
ylim([-0.5 3.5])
axis equal

For the square region, assign these thermal properties:

• Thermal conductivity is 10 W /(m∘C).
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• Mass density is 2 kg/m3.
• Specific heat is 0 . 1 J /(kg∘C).

thermalProperties(thermalmodel,'ThermalConductivity',10, ...
                               'MassDensity',2, ...
                               'SpecificHeat',0.1, ...
                               'Face',1);

For the diamond region, assign these thermal properties:

• Thermal conductivity is 2 W /(m∘C).
• Mass density is 1 kg/m3.
• Specific heat is 0 . 1 J /(kg∘C).

thermalProperties(thermalmodel,'ThermalConductivity',2, ...
                               'MassDensity',1, ...
                               'SpecificHeat',0.1, ...
                               'Face',2);

Assume that the diamond-shaped region is a heat source with a density of 4 W /m3.

internalHeatSource(thermalmodel,4,'Face',2);

Apply a constant temperature of 0 ∘C to the sides of the square plate.

thermalBC(thermalmodel,'Temperature',0,'Edge',[1 2 7 8]);

Set the initial temperature to 0 ∘C.

thermalIC(thermalmodel,0);

Mesh the geometry.

generateMesh(thermalmodel);

The dynamics for this problem are very fast. The temperature reaches a steady state in
about 0.1 second. To capture the interesting part of the dynamics, set the solution time to
logspace(-2,-1,10). This command returns 10 logarithmically spaced solution times
between 0.01 and 0.1.

tlist = logspace(-2,-1,10);

Solve the equation.

 solve
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thermalresults = solve(thermalmodel,tlist)

thermalresults = 
  TransientThermalResults with properties:

      Temperature: [1481x10 double]
    SolutionTimes: [1x10 double]
       XGradients: [1481x10 double]
       YGradients: [1481x10 double]
       ZGradients: []
             Mesh: [1x1 FEMesh]

Plot the solution with isothermal lines by using a contour plot.

T = thermalresults.Temperature;
pdeplot(thermalmodel,'XYData',T(:,10),'Contour','on','ColorMap','hot')
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Solution to Static Structural Model

Solve a static structural model representing a bimetallic cable under tension.

Create a static structural model for solving a solid (3-D) problem.

structuralmodel = createpde('structural','static-solid');

Create the geometry and include it in the model. Plot the geometry.

 solve
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gm = multicylinder([0.01,0.015],0.05);
structuralmodel.Geometry = gm;
pdegplot(structuralmodel,'FaceLabels','on','CellLabels','on','FaceAlpha',0.5)

Specify the Young's modulus and Poisson's ratio for each metal.

structuralProperties(structuralmodel,'Cell',1,'YoungsModulus',110E9, ...
                                              'PoissonsRatio',0.28);
structuralProperties(structuralmodel,'Cell',2,'YoungsModulus',210E9, ...
                                              'PoissonsRatio',0.3);

Specify that faces 1 and 4 are fixed boundaries.

structuralBC(structuralmodel,'Face',[1,4],'Constraint','fixed');
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Specify the surface traction for faces 2 and 5.

structuralBoundaryLoad(structuralmodel,'Face',[2,5],'SurfaceTraction',[0;0;100]);

Generate a mesh and solve the problem.

generateMesh(structuralmodel);
structuralresults = solve(structuralmodel)

structuralresults = 
  StaticStructuralResults with properties:

      Displacement: [1x1 struct]
            Strain: [1x1 struct]
            Stress: [1x1 struct]
    VonMisesStress: [22306x1 double]
              Mesh: [1x1 FEMesh]

The solver finds the values of displacement, stress, strain, and von Mises stress at the
nodal locations. To access these values, use structuralresults.Displacement,
structuralresults.Stress, and so on. Displacement, stress, and strain at the nodal
locations are structure arrays with fields representing their components.

structuralresults.Displacement

ans = struct with fields:
           ux: [22306x1 double]
           uy: [22306x1 double]
           uz: [22306x1 double]
    Magnitude: [22306x1 double]

structuralresults.Stress

ans = struct with fields:
    sxx: [22306x1 double]
    syy: [22306x1 double]
    szz: [22306x1 double]
    syz: [22306x1 double]
    sxz: [22306x1 double]
    sxy: [22306x1 double]

structuralresults.Strain

 solve
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ans = struct with fields:
    exx: [22306x1 double]
    eyy: [22306x1 double]
    ezz: [22306x1 double]
    eyz: [22306x1 double]
    exz: [22306x1 double]
    exy: [22306x1 double]

Plot the deformed shape with the z-component of normal stress.

pdeplot3D(structuralmodel,'ColorMapData',structuralresults.Stress.szz, ...
                          'Deformation',structuralresults.Displacement)
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Solution to Transient Structural Model

Solve for transient response of a thin 3-D plate under a harmonic load at the center.

Create a transient dynamic model for a 3-D problem.

structuralmodel = createpde('structural','transient-solid');

Create the geometry and include it in the model. Plot the geometry.

gm = multicuboid([5,0.05],[5,0.05],0.01);
structuralmodel.Geometry=gm;
pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.5)

 solve

5-881



Zoom in to see the face labels on the small plate in the center.

figure
pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.25)
axis([-0.2 0.2 -0.2 0.2 -0.1 0.1])

Specify the Young's modulus, Poisson's ratio, and mass density of the material.

structuralProperties(structuralmodel,'YoungsModulus',210E9,...
                                     'PoissonsRatio',0.3,...
                                     'MassDensity',7800);

Specify that all faces on the periphery of the thin 3-D plate are fixed boundaries.

structuralBC(structuralmodel,'Constraint','fixed','Face',5:8);
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Apply a sinusoidal pressure load on the small face at the center of the plate.

structuralBoundaryLoad(structuralmodel,'Face',12,'Pressure',5E7,'Frequency',25);

Generate a mesh with linear elements.

generateMesh(structuralmodel,'GeometricOrder','linear','Hmax',0.2);

Specify the zero initial displacement and velocity.

structuralIC(structuralmodel,'Displacement',[0;0;0],'Velocity',[0;0;0]);

Solve the model.

tlist = linspace(0,1,300);
structuralresults = solve(structuralmodel,tlist)

structuralresults = 
  TransientStructuralResults with properties:

     Displacement: [1x1 struct]
         Velocity: [1x1 struct]
     Acceleration: [1x1 struct]
    SolutionTimes: [1x300 double]
             Mesh: [1x1 FEMesh]

The solver finds the values of displacement, velocity, and acceleration at the nodal
locations. To access these values, use structuralresults.Displacement,
structuralresults.Velocity, and so on. Displacement, velocity, and acceleration are
structure arrays with fields representing their components.

structuralresults.Displacement

ans = struct with fields:
           ux: [1873x300 double]
           uy: [1873x300 double]
           uz: [1873x300 double]
    Magnitude: [1873x300 double]

structuralresults.Velocity

ans = struct with fields:
           vx: [1873x300 double]
           vy: [1873x300 double]

 solve
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           vz: [1873x300 double]
    Magnitude: [1873x300 double]

structuralresults.Acceleration

ans = struct with fields:
           ax: [1873x300 double]
           ay: [1873x300 double]
           az: [1873x300 double]
    Magnitude: [1873x300 double]

Solution to Modal Analysis Structural Model

Find the fundamental (lowest) mode of a 2-D cantilevered beam, assuming a prevalence of
the plane-stress condition.

Specify the following geometric and structural properties of the beam, along with a unit
plane-stress thickness.

length = 5;
height = 0.1;
E = 3E7;
nu = 0.3;
rho = 0.3/386;

Create a model plane-stress model, assign a geometry, and generate a mesh.

structuralmodel = createpde('structural','modal-planestress');
gdm = [3;4;0;length;length;0;0;0;height;height];
g = decsg(gdm,'S1',('S1')');
geometryFromEdges(structuralmodel,g);

Define a maximum element size (five elements through the beam thickness).

hmax = height/5;
msh=generateMesh(structuralmodel,'Hmax',hmax);

Specify the structural properties and boundary constraints.

structuralProperties(structuralmodel,'YoungsModulus',E, ...
                                     'MassDensity',rho, ... 
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                                     'PoissonsRatio',nu);
structuralBC(structuralmodel,'Edge',4,'Constraint','fixed');

Compute the analytical fundamental frequency (Hz) using the beam theory.

I = height^3/12;
analyticalOmega1 = 3.516*sqrt(E*I/(length^4*(rho*height)))/(2*pi)

analyticalOmega1 = 126.9498

Specify a frequency range that includes an analytically computed frequency and solve the
model.

modalresults = solve(structuralmodel,'FrequencyRange',[0,1e6])

modalresults = 
  ModalStructuralResults with properties:

    NaturalFrequencies: [32x1 double]
            ModeShapes: [1x1 struct]
                  Mesh: [1x1 FEMesh]

The solver finds natural frequencies and modal displacement values at nodal locations. To
access these values, use modalresults.NaturalFrequencies and
modalresults.ModeShapes.

modalresults.NaturalFrequencies/(2*pi)

ans = 32×1
105 ×

    0.0013
    0.0079
    0.0222
    0.0433
    0.0711
    0.0983
    0.1055
    0.1462
    0.1930
    0.2455
      ⋮

modalresults.ModeShapes

 solve
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ans = struct with fields:
    ux: [6511x32 double]
    uy: [6511x32 double]

Plot the y-component of the solution for the fundamental frequency.

pdeplot(structuralmodel,'XYData',modalresults.ModeShapes.uy(:,1))
title(['First Mode with Frequency ', ...
        num2str(modalresults.NaturalFrequencies(1)/(2*pi)),' Hz'])
axis equal
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Expansion of Cantilever Beam Under Thermal Load

Find the deflection of a 3-D cantilever beam under a nonuniform thermal load. Specify the
thermal load on the structural model using the solution from a transient thermal analysis
on the same geometry and mesh.

Transient Thermal Model Analysis

Create a transient thermal model.

thermalmodel = createpde('thermal','transient');

Create and plot the geometry.

gm = multicuboid(0.5,0.1,0.05);
thermalmodel.Geometry = gm;
pdegplot(thermalmodel,'FaceLabels','on','FaceAlpha',0.5)

 solve
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Generate a mesh.

mesh = generateMesh(thermalmodel);

Specify the thermal properties of the material.

thermalProperties(thermalmodel,'ThermalConductivity',5e-3, ...
                               'MassDensity',2.7*10^(-6), ...
                               'SpecificHeat',10);

Specify the constant temperatures applied to the left and right ends on the beam.

thermalBC(thermalmodel,'Face',3,'Temperature',100);
thermalBC(thermalmodel,'Face',5,'Temperature',0);
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Specify the heat source over the entire geometry.

internalHeatSource(thermalmodel,10);

Set the initial temperature.

thermalIC(thermalmodel,0);

Solve the model.

tlist = [0:1e-4:2e-4];
thermalresults = solve(thermalmodel,tlist)

thermalresults = 
  TransientThermalResults with properties:

      Temperature: [3870x3 double]
    SolutionTimes: [0 1.0000e-04 2.0000e-04]
       XGradients: [3870x3 double]
       YGradients: [3870x3 double]
       ZGradients: [3870x3 double]
             Mesh: [1x1 FEMesh]

Plot the temperature distribution for each time step.

for n = 1:numel(thermalresults.SolutionTimes)
    figure
    pdeplot3D(thermalmodel,'ColorMapData',thermalresults.Temperature(:,n))
    title(['Temperature at Time = ' num2str(tlist(n))])
    caxis([0 100])
end

 solve
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Structural Analysis with Thermal Load

Create a static structural model.

structuralmodel = createpde('structural','static-solid');

Include the same geometry as for the thermal model.

structuralmodel.Geometry = gm;

Use the same mesh that you used to obtain the thermal solution.

structuralmodel.Mesh = mesh;

Specify the Young's modulus, Poisson's ratio, and coefficient of thermal expansion.
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structuralProperties(structuralmodel,'YoungsModulus',1e10, ...
                                     'PoissonsRatio',0.3, ...'
                                     'CTE',11.7e-6);

Apply a fixed boundary condition on face 5.

structuralBC(structuralmodel,'Face',5,'Constraint','fixed');

Apply a body load using the transient thermal model solution. By default,
structuralBodyLoad uses the solution for the last time step.

structuralBodyLoad(structuralmodel,'Temperature',thermalresults);

Specify the reference temperature.

structuralmodel.ReferenceTemperature = 10;

Solve the structural model.

thermalstressresults = solve(structuralmodel);

Plot the deformed shape of the beam corresponding to the last step of the transient
thermal model solution.

pdeplot3D(structuralmodel,'ColorMapData',thermalstressresults.Displacement.Magnitude, ...
                          'Deformation',thermalstressresults.Displacement)
title(['Thermal Expansion at Solution Time = ' num2str(tlist(end))])
caxis([0 3e-3])

 solve
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Now specify the body loads as the thermal model solutions for all time steps. For each
body load, solve the structural model and plot the corresponding deformed shape of the
beam.

for n = 1:numel(thermalresults.SolutionTimes)
    structuralBodyLoad(structuralmodel,'Temperature',thermalresults,'TimeStep',n);
    thermalstressresults = solve(structuralmodel);
    figure
    pdeplot3D(structuralmodel,'ColorMapData',thermalstressresults.Displacement.Magnitude, ...
                              'Deformation',thermalstressresults.Displacement)
    title(['Thermal Results at Solution Time = ' num2str(tlist(n))])
    caxis([0 3e-3])
end
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Solution to Transient Structural Model by Using Modal Superposition Method

Solve the for transient response at the center of a 3-D beam under a harmonic load on
one of its corners.

Modal Analysis

Create a modal analysis model for a 3-D problem.

modelM = createpde('structural','modal-solid');

Create the geometry and include it in the model. Plot the geometry and display the edge
and vertex labels.

 solve
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gm = multicuboid(0.05,0.003,0.003);
modelM.Geometry=gm;
pdegplot(modelM,'EdgeLabels','on','VertexLabels','on');
view([95 5])

Generate a mesh.

msh = generateMesh(modelM);

Specify the Young's modulus, Poisson's ratio, and mass density of the material.

structuralProperties(modelM,'YoungsModulus',210E9, ...
                            'PoissonsRatio',0.3, ...
                            'MassDensity',7800);
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Specify minimal constraints on one end of the beam to prevent rigid body modes. For
example, specify that edge 4 and vertex 7 are fixed boundaries.

structuralBC(modelM,'Edge',4,'Constraint','fixed');
structuralBC(modelM,'Vertex',7,'Constraint','fixed');

Solve the problem for the frequency range from 0 to 500000. The recommended approach
is to use a value that is slightly smaller than the expected lowest frequency. Thus, use -0.1
instead of 0.

Rm = solve(modelM,'FrequencyRange',[-0.1,500000]);

Transient Analysis

Create a transient analysis model for a 3-D problem.

modelD = createpde('structural','transient-solid');

Use the same geometry and mesh as for the modal analysis.

modelD.Geometry = gm;
modelD.Mesh = msh;

Specify the same values for the Young's modulus, Poisson's ratio, and mass density of the
material.

structuralProperties(modelD,'YoungsModulus',210E9, ...
                            'PoissonsRatio',0.3, ...
                            'MassDensity',7800);

Specify the same minimal constraints on one end of the beam to prevent rigid body
modes.

structuralBC(modelD,'Edge',4,'Constraint','fixed');
structuralBC(modelD,'Vertex',7,'Constraint','fixed');

Apply a sinusoidal force on the corner opposite to the constrained edge and vertex.

structuralBoundaryLoad(modelD,'Vertex',5,'Force',[0,0,10],'Frequency',7600);

Specify the zero initial displacement and velocity.

structuralIC(modelD,'Velocity',[0;0;0],'Displacement',[0;0;0]);

Specify the relative and absolute tolerances for the solver.

 solve
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modelD.SolverOptions.RelativeTolerance = 1E-5;
modelD.SolverOptions.AbsoluteTolerance = 1E-9;

Solve the model using the modal results.

tlist = linspace(0,0.004,120);
Rdm = solve(modelD,tlist,'ModalResults',Rm)

Rdm = 
  TransientStructuralResults with properties:

     Displacement: [1x1 struct]
         Velocity: [1x1 struct]
     Acceleration: [1x1 struct]
    SolutionTimes: [1x120 double]
             Mesh: [1x1 FEMesh]

Interpolate and plot the displacement at the center of the beam.

intrpUdm = interpolateDisplacement(Rdm,0,0,0.0015);

plot(Rdm.SolutionTimes,intrpUdm.uz)
grid on
xlabel('Time');
ylabel('Center of beam displacement')
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Input Arguments
thermalmodel — Thermal model
ThermalModel object

Thermal model, specified as a ThermalModel object. The model contains the geometry,
mesh, thermal properties of the material, internal heat source, boundary conditions, and
initial conditions.
Example: thermalmodel = createpde('thermal','steadystate')

 solve
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structuralmodel — Structural model
StructuralModel object

Structural model, specified as a StructuralModel object. The model contains the
geometry, mesh, structural properties of the material, body loads, boundary loads, and
boundary conditions.
Example: structuralmodel = createpde('structural','transient-solid')

tlist — Solution times
real vector

Solution times, specified as a real vector of monotonically increasing or decreasing
values.
Example: 0:20
Data Types: double

[omega1,omega2] — Frequency range
vector of two elements

Frequency range, specified as a vector of two elements. Define omega1 as slightly smaller
than the lowest expected frequency and omega2 as slightly larger than the highest
expected frequency. For example, is the lowest expected frequency is zero, then use a
small negative value for omega1.
Example: [-0.1,1000]
Data Types: double

modalresults — Modal analysis results
ModalStructuralResults object.

Modal analysis results, specified as a ModalStructuralResults object.
Example: modalresults = solve(structuralmodel,'FrequencyRange',
[0,1e6])

Output Arguments
thermalresults — Thermal results
SteadyStateThermalResults object | TransientThermalResults object
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Thermal results, returned as a SteadyStateThermalResults object or
TransientThermalResults object. The type of thermalresults depends on whether
thermalmodel represents a steady-state problem (thermalmodel.AnalysisType =
'steadystate') or a transient problem (thermalmodel.AnalysisType =
'transient').

structuralresults — Structural results
StaticStructuralResults object | TransientStructuralResults object |
ModalStructuralResults object

Structural results, returned as a StaticStructuralResults,
TransientStructuralResults, or ModalStructuralResults object. The type of
structuralresults depends on whether structuralmodel represents a static
problem, a transient problem, or a modal analysis problem. To check the type of a
structural analysis problem, type structuralmodel.AnalysisType.

Tips
• When you use modal analysis results to solve a transient structural dynamics model,

the modalresults argument must be created in Partial Differential Equation Toolbox
version R2019a or newer.

See Also
geometryFromEdges | PDEModel | StructuralModel | ThermalModel |
geometryFromMesh | importGeometry

Introduced in R2017a

 solve
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solvepde
Package: pde

Solve PDE specified in a PDEModel

Syntax
result = solvepde(model)
result = solvepde(model,tlist)

Description
result = solvepde(model) returns the solution to the stationary PDE represented in
model. A stationary PDE has the property model.IsTimeDependent = false. That is,
the time-derivative coefficients m and d in model.EquationCoefficients must be 0.

result = solvepde(model,tlist) returns the solution to the time-dependent PDE
represented in model at the times tlist. At least one time-derivative coefficient m or d
in model.EquationCoefficients must be nonzero.

Examples

Solve a Stationary Problem: Poisson's Equation for the L-shaped Membrane

Create a PDE model, and include the geometry of the L-shaped membrane.

model = createpde();
geometryFromEdges(model,@lshapeg);

View the geometry with edge labels.

pdegplot(model,'EdgeLabels','on')
ylim([-1.1,1.1])
axis equal
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Set zero Dirichlet conditions on all edges.

applyBoundaryCondition(model,'dirichlet','Edge',1:model.Geometry.NumEdges,'u',0);

Poisson's equation is

−∇ ⋅ ∇u = 1 .

Toolbox solvers address equations of the form

m∂
2u
∂t2 + d∂u∂t − ∇ c∇u + au = f .

Include the coefficients for Poisson's equation in the model.

 solvepde
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specifyCoefficients(model,'m',0,...
                          'd',0,...
                          'c',1,...
                          'a',0,...
                          'f',1);

Mesh the model and solve the PDE.

generateMesh(model,'Hmax',0.25);
results = solvepde(model);

View the solution.

pdeplot(model,'XYData',results.NodalSolution)
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Solve a Time-Dependent Parabolic Equation with Nonconstant Coefficients

Create a model with 3-D rectangular block geometry.

model = createpde();
importGeometry(model,'Block.stl');

Suppose that radiative cooling causes the solution to decrease as the cube of temperature
on the surface of the block.

gfun = @(region,state)-state.u.^3*1e-6;
applyBoundaryCondition(model,'neumann','Face',1:model.Geometry.NumFaces,'g',gfun);

The model coefficients have no source term.

specifyCoefficients(model,'m',0,...
                          'd',1,...
                          'c',1,...
                          'a',0,...
                          'f',0);

The block starts at a constant temperature of 350.

setInitialConditions(model,350);

Mesh the geometry and solve the model for times 0 through 20.

generateMesh(model);
tlist = 0:20;
results = solvepde(model,tlist);

Plot the solution on the surface of the block at times 1 and 20.

pdeplot3D(model,'ColorMapData',results.NodalSolution(:,2))
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figure
pdeplot3D(model,'ColorMapData',results.NodalSolution(:,21))
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Input Arguments
model — PDE model
PDEModel object

PDE model, specified as a PDEModel object. The model contains the geometry, mesh, and
problem coefficients.
Example: model = createpde(1)

tlist — Solution times
real vector
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Solution times, specified as a real vector. tlist must be a monotone vector (increasing
or decreasing).
Example: 0:20
Data Types: double

Output Arguments
result — PDE results
StationaryResults object | TimeDependentResults object

PDE results, returned as a StationaryResults object or as a TimeDependentResults
object. The type of result depends on whether model represents a stationary problem
(model.IsTimeDependent = false) or a time-dependent problem
(model.IsTimeDependent = true).

Tips
• If the Newton iteration does not converge, solvepde displays the error message Too

many iterations or Stepsize too small.
• If the initial guess produces matrices containing NaN or Inf elements, solvepde

displays the error message Unsuitable initial guess U0 (default: U0 =
0).

• If you have very small coefficients, or very small geometric dimensions, solvepde can
fail to converge, or can converge to an incorrect solution. In this case, you might
obtain better results by scaling the coefficients or geometry dimensions to be of order
one.

See Also
PDEModel | applyBoundaryCondition | setInitialConditions | solvepdeeig |
specifyCoefficients

Topics
“Solve Problems Using PDEModel Objects” on page 2-6
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Introduced in R2016a
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solvepdeeig
Package: pde

Solve PDE eigenvalue problem specified in a PDEModel

Syntax
result = solvepdeeig(model,evr)

Description
result = solvepdeeig(model,evr) solves the PDE eigenvalue problem in model for
eigenvalues in the range evr.

Examples

Solve an Eigenvalue Problem With 3-D Geometry

Solve for several vibrational modes of the BracketTwoHoles geometry.

The equations of elasticity have three components. Therefore, create a PDE model that
has three components. Import and view the BracketTwoHoles geometry.

model = createpde(3);
importGeometry(model,'BracketTwoHoles.stl');
pdegplot(model,'FaceLabels','on','FaceAlpha',0.5)
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Set F1, the rear face, to have zero deflection.

applyBoundaryCondition(model,'dirichlet','Face',1,'u',[0;0;0]);

Set the model coefficients to represent a steel bracket. For details, see 3-D Linear
Elasticity Equations in Toolbox Form.

E = 200e9; % elastic modulus of steel in Pascals
nu = 0.3; % Poisson's ratio
specifyCoefficients(model,'m',0,...
                          'd',1,...
                          'c',elasticityC3D(E,nu),...
                          'a',0,...
                          'f',[0;0;0]); % Assume all body forces are zero
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Find the eigenvalues up to 1e7.

evr = [-Inf,1e7];

Mesh the model and solve the eigenvalue problem.

generateMesh(model);
results = solvepdeeig(model,evr);

              Basis= 10,  Time=  31.14,  New conv eig=  0
              Basis= 11,  Time=  31.23,  New conv eig=  0
              Basis= 12,  Time=  31.38,  New conv eig=  0
              Basis= 13,  Time=  31.45,  New conv eig=  0
              Basis= 14,  Time=  31.59,  New conv eig=  1
              Basis= 15,  Time=  31.81,  New conv eig=  2
              Basis= 16,  Time=  32.05,  New conv eig=  2
              Basis= 17,  Time=  32.22,  New conv eig=  3
              Basis= 18,  Time=  32.44,  New conv eig=  4
End of sweep: Basis= 18,  Time=  32.44,  New conv eig=  4
              Basis= 14,  Time=  33.88,  New conv eig=  0
End of sweep: Basis= 14,  Time=  33.88,  New conv eig=  0

How many results did solvepdeeig return?

length(results.Eigenvalues)

ans = 3

Plot the solution on the geometry boundary for the lowest eigenvalue.

V = results.Eigenvectors;
subplot(2,2,1)
pdeplot3D(model,'ColorMapData',V(:,1,1))
title('x Deflection, Mode 1')
subplot(2,2,2)
pdeplot3D(model,'ColorMapData',V(:,2,1))
title('y Deflection, Mode 1')
subplot(2,2,3)
pdeplot3D(model,'ColorMapData',V(:,3,1))
title('z Deflection, Mode 1')
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Plot the solution for the highest eigenvalue.

figure
subplot(2,2,1)
pdeplot3D(model,'ColorMapData',V(:,1,3))
title('x Deflection, Mode 3')
subplot(2,2,2)
pdeplot3D(model,'ColorMapData',V(:,2,3))
title('y Deflection, Mode 3')
subplot(2,2,3)
pdeplot3D(model,'ColorMapData',V(:,3,3))
title('z Deflection, Mode 3')
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Input Arguments
model — PDE model
PDEModel object

PDE model, specified as a PDEModel object. The model contains the geometry, mesh, and
problem coefficients.
Example: model = createpde(1)

evr — Eigenvalue range
two-element real vector
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Eigenvalue range, specified as a two-element real vector. evr(1) specifies the lower limit
of the range of the real part of the eigenvalues, and may be -Inf. evr(2) specifies the
upper limit of the range, and must be finite.
Example: [-Inf;100]
Data Types: double

Output Arguments
result — Eigenvalue results
EigenResults object

Eigenvalue results, returned as an EigenResults object.

Tips
• The equation coefficients cannot depend on the solution u or its gradient.

See Also
PDEModel | applyBoundaryCondition | solvepde | specifyCoefficients

Topics
“Eigenvalues and Eigenmodes of L-Shaped Membrane” on page 3-251
“Eigenvalues and Eigenmodes of Square” on page 3-263
“Solve Problems Using PDEModel Objects” on page 2-6

Introduced in R2016a
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specifyCoefficients
Package: pde

Specify coefficients in a PDE model

Coefficients of a PDE

solvepde solves PDEs of the form

m∂
2u
∂t2 + d∂u∂t − ∇ · c∇u + au = f

solvepdeeig solves PDE eigenvalue problems of the form

−∇ · c∇u + au = λdu
or

−∇ · c∇u + au = λ2mu

specifyCoefficients defines the coefficients m, d, c, a, and f in the PDE model.

Syntax
specifyCoefficients(model,Name,Value)
specifyCoefficients(model,Name,Value,RegionType,RegionID)
CA = specifyCoefficients( ___ )

Description
specifyCoefficients(model,Name,Value) defines the specified coefficients in each
Name to each associated Value, and includes them in model. You must specify all of these
names: m, d, c, a, and f. This syntax applies coefficients to the entire geometry.

Note Include geometry in model before using specifyCoefficients.
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specifyCoefficients(model,Name,Value,RegionType,RegionID) assigns
coefficients for a specified geometry region.

CA = specifyCoefficients( ___ ) returns a handle to the coefficient assignment
object in model.

Examples

Specify Poisson's Equation

Specify the coefficients for Poisson's equation −∇ ⋅ ∇u = 1.

solvepde addresses equations of the form

m∂
2u
∂t2 + d∂u∂t − ∇ ⋅ c∇u + au = f .

Therefore, the coefficients for Poisson's equation are m = 0, d = 0, c = 1, a = 0, f = 1.
Include these coefficients in a PDE model of the L-shaped membrane.

model = createpde();
geometryFromEdges(model,@lshapeg);
specifyCoefficients(model,'m',0,...
                          'd',0,...
                          'c',1,...
                          'a',0,...
                          'f',1);

Specify zero Dirichlet boundary conditions, mesh the model, and solve the PDE.

applyBoundaryCondition(model,'dirichlet','Edge',1:model.Geometry.NumEdges,'u',0);
generateMesh(model,'Hmax',0.25);
results = solvepde(model);

View the solution.

pdeplot(model,'XYData',results.NodalSolution)
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Coefficient Handle for Nonconstant Coefficients

Specify coefficients for Poisson's equation in 3-D with a nonconstant source term, and
obtain the coefficient object.

The equation coefficients are m = 0, d = 0, c = 1, a = 0. For the nonconstant source term,
take f = y2tanh z /1000.

f = @(location,state)location.y.^2.*tanh(location.z)/1000;

Set the coefficients in a 3-D rectangular block geometry.
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model = createpde();
importGeometry(model,'Block.stl');
CA = specifyCoefficients(model,'m',0,...
                               'd',0,...
                               'c',1,...
                               'a',0,...
                               'f',f)

CA = 
  CoefficientAssignment with properties:

    RegionType: 'cell'
      RegionID: 1
             m: 0
             d: 0
             c: 1
             a: 0
             f: @(location,state)location.y.^2.*tanh(location.z)/1000

Set zero Dirichlet conditions on face 1, mesh the geometry, and solve the PDE.

applyBoundaryCondition(model,'dirichlet','Face',1,'u',0);
generateMesh(model);
results = solvepde(model);

View the solution on the surface.

pdeplot3D(model,'ColorMapData',results.NodalSolution)
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Specify Coefficients Depending On Subdomain

Create a scalar PDE model with the L-shaped membrane as the geometry. Plot the
geometry and subdomain labels.

model = createpde();
geometryFromEdges(model,@lshapeg);
pdegplot(model,'FaceLabels','on')
axis equal
ylim([-1.1,1.1])
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Set the c coefficient to 1 in all domains, but the f coefficient to 1 in subdomain 1, 5 in
subdomain 2, and -8 in subdomain 3. Set all other coefficients to 0.

specifyCoefficients(model,'m',0,'d',0,'c',1,'a',0,'f',1,'Face',1);
specifyCoefficients(model,'m',0,'d',0,'c',1,'a',0,'f',5,'Face',2);
specifyCoefficients(model,'m',0,'d',0,'c',1,'a',0,'f',-8,'Face',3);

Set zero Dirichlet boundary conditions to all edges. Create a mesh, solve the PDE, and
plot the result.

applyBoundaryCondition(model,'dirichlet','Edge',1:model.Geometry.NumEdges,'u',0);
generateMesh(model,'Hmax',0.25);
results = solvepde(model);
pdeplot(model,'XYData',results.NodalSolution)
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Input Arguments
model — PDE model
PDEModel object

PDE model, specified as a PDEModel object.
Example: model = createpde
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Name-Value Pair Arguments

Note You must specify all of these names: m, d, c, a, and f.

Example:
specifyCoefficients(model,'m',0,'d',0,'c',1,'a',0,'f',@fcoeff)

m — Second-order time derivative coefficient
scalar | column vector | function handle

Second-order time derivative coefficient, specified as a scalar, column vector, or function
handle. For details on the sizes, and for details of the function handle form of the
coefficient, see “m, d, or a Coefficient for specifyCoefficients” on page 2-142.

Specify 0 if the term is not part of your problem.
Example:
specifyCoefficients('m',@mcoef,'d',0,'c',1,'a',0,'f',1,'Face',1:4)

Data Types: double | function_handle
Complex Number Support: Yes

d — First-order time derivative coefficient
scalar | column vector | function handle

First-order time derivative coefficient, specified as a scalar, column vector, or function
handle. For details on the sizes, and for details of the function handle form of the
coefficient, see “m, d, or a Coefficient for specifyCoefficients” on page 2-142.

Note If the m coefficient is nonzero, d must be 0 or a matrix, and not a function handle.
See “d Coefficient When m is Nonzero” on page 5-927.

Specify 0 if the term is not part of your problem.
Example:
specifyCoefficients('m',0,'d',@dcoef,'c',1,'a',0,'f',1,'Face',1:4)

Data Types: double | function_handle
Complex Number Support: Yes
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c — Second-order space derivative coefficient
scalar | column vector | function handle

Second-order space derivative coefficient, specified as a scalar, column vector, or function
handle. For details on the sizes, and for details of the function handle form of the
coefficient, see “c Coefficient for specifyCoefficients” on page 2-100.
Example:
specifyCoefficients('m',0,'d',0,'c',@ccoef,'a',0,'f',1,'Face',1:4)

Data Types: double | function_handle
Complex Number Support: Yes

a — Solution multiplier coefficient
scalar | column vector | function handle

Solution multiplier coefficient, specified as a scalar, column vector, or function handle. For
details on the sizes, and for details of the function handle form of the coefficient, see “m,
d, or a Coefficient for specifyCoefficients” on page 2-142.

Specify 0 if the term is not part of your problem.
Example:
specifyCoefficients('m',0,'d',0,'c',1,'a',@acoef,'f',1,'Face',1:4)

Data Types: double | function_handle
Complex Number Support: Yes

f — Source coefficient
scalar | column vector | function handle

Source coefficient, specified as a scalar, column vector, or function handle. For details on
the sizes, and for details of the function handle form of the coefficient, see “f Coefficient
for specifyCoefficients” on page 2-97.

Specify 0 if the term is not part of your problem.
Example:
specifyCoefficients('m',0,'d',0,'c',1,'a',0,'f',@fcoeff,'Face',1:4)

Data Types: double | function_handle
Complex Number Support: Yes

RegionType — Geometric region type
'Face' for a 2-D model | 'Cell' for a 3-D model
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Geometric region type, specified as 'Face' or 'Cell'.
Example: specifyCoefficients('m',0,'d',0,'c',1,'a',0,'f',10,'Cell',2)
Data Types: char | string

RegionID — Geometric region ID
vector of positive integers

Geometric region ID, specified as a vector of positive integers. Find the region IDs using
pdegplot, as shown in “Create Geometry and Remove Face Boundaries” on page 2-13 or
“STL File Import” on page 2-46.
Example:
specifyCoefficients('m',0,'d',0,'c',1,'a',0,'f',10,'Cell',1:3)

Data Types: double

Output Arguments
CA — Coefficient assignment
CoefficientAssignment object

Coefficient assignment, returned as a CoefficientAssignment object.

Definitions

d Coefficient When m is Nonzero
The d coefficient takes a special matrix form when m is nonzero. You must specify d as a
matrix of a particular size, and not as a function handle.

d represents a damping coefficient in the case of nonzero m. To specify d, perform these
two steps:

1 Call results = assembleFEMatrices(...) for the problem with your original
coefficients and using d = 0. Use the default 'none' method for
assembleFEMatrices.
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2 Take the d coefficient as a matrix of size results.M. Generally, d is either
proportional to results.M, or is a linear combination of results.M and
results.K.

See “Dynamics of Damped Cantilever Beam”.

Tips
• For eigenvalue equations, the coefficients cannot depend on the solution u or its

gradient.

See Also
PDEModel | findCoefficients

Topics
“PDE Coefficients”
“Solve Problems Using PDEModel Objects” on page 2-6

Introduced in R2016a
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sptarn
(Not recommended) Solve generalized sparse eigenvalue problem

Note sptarn is not recommended. Use solvepdeeig instead.

Syntax
[xv,lmb,iresult] = sptarn(A,B,lb,ub)

[xv,lmb,iresult] = sptarn(A,B,lb,ub,spd)

[xv,lmb,iresult] = sptarn(A,B,lb,ub,spd,tolconv)

[xv,lmb,iresult] = sptarn(A,B,lb,ub,spd,tolconv,jmax)

[xv,lmb,iresult] = sptarn(A,B,lb,ub,spd,tolconv,jmax,maxmul)

Description
[xv,lmb,iresult] = sptarn(A,B,lb,ub,spd,tolconv,jmax,maxmul) finds
eigenvalues of the pencil (A – λB)x = 0 in interval [lb,ub]. (A matrix of linear polynomials
Aij – λBij, A – λB, is called a pencil.)

A and B are sparse matrices. lb and ub are lower and upper bounds for eigenvalues to be
sought. We may have lb = -inf if all eigenvalues to the left of ub are sought, and rb =
inf if all eigenvalues to the right of lb are sought. One of lb and ub must be finite. A
narrower interval makes the algorithm faster. In the complex case, the real parts of lmb
are compared to lb and ub.

xv are eigenvectors, ordered so that norm(a*xv-b*xv*diag(lmb)) is small. lmb is the
sorted eigenvalues. If iresult >= 0 the algorithm succeeded, and all eigenvalues in the
intervals have been found. If iresult<0 the algorithm has not yet been successful, there
may be more eigenvalues—try with a smaller interval.

spd is 1 if the pencil is known to be symmetric positive definite (default 0).
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tolconv is the expected relative accuracy. Default is 100*eps, where eps is the machine
precision.

jmax is the maximum number of basis vectors. The algorithm needs jmax*n working
space so a small value may be justified on a small computer, otherwise let it be the default
value jmax = 100. Normally the algorithm stops earlier when enough eigenvalues have
converged.

maxmul is the number of Arnoldi runs tried. Must at least be as large as maximum
multiplicity of any eigenvalue. If a small value of jmax is given, many Arnoldi runs are
necessary. The default value is maxmul = n, which is needed when all the eigenvalues of
the unit matrix are sought.

Algorithms
The Arnoldi algorithm with spectral transformation is used. The shift is chosen at ub, lb,
or at a random point in interval (lb,ub) when both bounds are finite. The number of steps
j in the Arnoldi run depends on how many eigenvalues there are in the interval, but it
stops at j = min(jmax,n). After a stop, the algorithm restarts to find more Schur
vectors in orthogonal complement to all those already found. When no more eigenvalues
are found in lb < lmb <= ub, the algorithm stops. For small values of jmax, several
restarts may be needed before a certain eigenvalue has converged. The algorithm works
when jmax is at least one larger than the number of eigenvalues in the interval, but then
many restarts are needed. For large values of jmax, which is the preferred choice, mul+1
runs are needed. mul is the maximum multiplicity of an eigenvalue in the interval.

Note The algorithm works on nonsymmetric as well as symmetric pencils, but then
accuracy is approximately tol times the Henrici departure from normality. The
parameter spd is used only to choose between symamd and colamd when factorizing, the
former being marginally better for symmetric matrices close to the lower end of the
spectrum.

In case of trouble,

If convergence is too slow, try (in this order of priority):

• a smaller interval lb, ub
• a larger jmax
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• a larger maxmul

If factorization fails, try again with lb or ub finite. Then shift is chosen at random and
hopefully not at an eigenvalue. If it fails again, check whether pencil may be singular.

If it goes on forever, there may be too many eigenvalues in the strip. Try with a small
value maxmul = 2 and see which eigenvalues you get. Those you get are some of the
eigenvalues, but a negative iresult tells you that you have not gotten them all.

If memory overflow, try smaller jmax.

The algorithm is designed for eigenvalues close to the real axis. If you want those close to
the imaginary axis, try A = i*A.

When spd = 1, the shift is at lb so that advantage is taken of the faster factorization for
symmetric positive definite matrices. No harm is done, but the execution is slower if lb is
above the lowest eigenvalue.

References
[1] Golub, Gene H., and Charles F. Van Loan, Matrix Computations, 2nd edition, Johns

Hopkins University Press, Baltimore, MD, 1989.

[2] Saad, Yousef, “Variations on Arnoldi's Method for Computing Eigenelements of Large
Unsymmetric Matrices,” Linear Algebra and its Applications, Vol. 34, 1980, pp.
269–295.

See Also
solvepdeeig

Introduced before R2006a
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StaticStructuralResults
Static structural solution and its derived quantities

Description
A StaticStructuralResults object contains the displacement, stress, strain, and von
Mises stress in a form convenient for plotting and postprocessing.

Displacements, stresses, and strains are reported for the nodes of the triangular or
tetrahedral mesh generated by generateMesh. Displacement values at the nodes appear
as a structure array in the Displacement property. The fields of the structure array
contain components of displacement at nodal locations.

Stress and strain values at the nodes appear as structure arrays in the Stress and
Strain properties, respectively.

von Mises stress at the nodes appears as a vector in the VonMisesStress property.

To interpolate the displacement, stress, strain, and von Mises stress to a custom grid,
such as the one specified by meshgrid, use interpolateDisplacement,
interpolateStress, interpolateStrain, and interpolateVonMisesStress,
respectively.

To evaluate reaction forces on a specified boundary, use evaluateReaction. To evaluate
principal stress and principal strain at nodal locations, use evaluatePrincipalStress
and evaluatePrincipalStrain, respectively.

Creation
Solve a static linear elasticity problem by using the solve function. This function returns
a static structural solution as a StaticStructuralResults object.
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Properties
Displacement — Displacement values at nodes
structure array

Displacement values at the nodes, returned as a structure array. The fields of the
structure array contain components of displacement at nodal locations.
Data Types: struct

Stress — Stress values at nodes
structure array

Stress values at the nodes, returned as a structure array. The fields of the structure array
contain components of stress at nodal locations.
Data Types: struct

Strain — Strain values at nodes
structure array

Strain values at the nodes, returned as a structure array. The fields of the structure array
contain components of strain at nodal locations.
Data Types: struct

VonMisesStress — Von Mises stress values at nodes
vector

Von Mises stress values at the nodes, returned as a vector.
Data Types: struct

Mesh — Finite element mesh
FEMesh object

Finite element mesh, returned as a FEMesh object. For details, see FEMesh.

Object Functions
interpolateDisplacement Interpolate displacement at arbitrary spatial locations
interpolateStress Interpolate stress at arbitrary spatial locations
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interpolateStrain Interpolate strain at arbitrary spatial locations
interpolateVonMisesStress Interpolate von Mises stress at arbitrary spatial locations
evaluateReaction Evaluate reaction forces on boundary
evaluatePrincipalStress Evaluate principal stress at nodal locations
evaluatePrincipalStrain Evaluate principal strain at nodal locations

Examples

Solution to Static Structural Model

Solve a static structural model representing a bimetallic cable under tension.

Create a static structural model for solving a solid (3-D) problem.

structuralmodel = createpde('structural','static-solid');

Create the geometry and include it in the model. Plot the geometry.

gm = multicylinder([0.01,0.015],0.05);
structuralmodel.Geometry = gm;
pdegplot(structuralmodel,'FaceLabels','on','CellLabels','on','FaceAlpha',0.5)
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Specify the Young's modulus and Poisson's ratio for each metal.

structuralProperties(structuralmodel,'Cell',1,'YoungsModulus',110E9, ...
                                              'PoissonsRatio',0.28);
structuralProperties(structuralmodel,'Cell',2,'YoungsModulus',210E9, ...
                                              'PoissonsRatio',0.3);

Specify that faces 1 and 4 are fixed boundaries.

structuralBC(structuralmodel,'Face',[1,4],'Constraint','fixed');

Specify the surface traction for faces 2 and 5.

structuralBoundaryLoad(structuralmodel,'Face',[2,5],'SurfaceTraction',[0;0;100]);
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Generate a mesh and solve the problem.

generateMesh(structuralmodel);
structuralresults = solve(structuralmodel)

structuralresults = 
  StaticStructuralResults with properties:

      Displacement: [1x1 struct]
            Strain: [1x1 struct]
            Stress: [1x1 struct]
    VonMisesStress: [22306x1 double]
              Mesh: [1x1 FEMesh]

The solver finds the values of displacement, stress, strain, and von Mises stress at the
nodal locations. To access these values, use structuralresults.Displacement,
structuralresults.Stress, and so on. Displacement, stress, and strain at the nodal
locations are structure arrays with fields representing their components.

structuralresults.Displacement

ans = struct with fields:
           ux: [22306x1 double]
           uy: [22306x1 double]
           uz: [22306x1 double]
    Magnitude: [22306x1 double]

structuralresults.Stress

ans = struct with fields:
    sxx: [22306x1 double]
    syy: [22306x1 double]
    szz: [22306x1 double]
    syz: [22306x1 double]
    sxz: [22306x1 double]
    sxy: [22306x1 double]

structuralresults.Strain

ans = struct with fields:
    exx: [22306x1 double]
    eyy: [22306x1 double]
    ezz: [22306x1 double]
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    eyz: [22306x1 double]
    exz: [22306x1 double]
    exy: [22306x1 double]

Plot the deformed shape with the z-component of normal stress.

pdeplot3D(structuralmodel,'ColorMapData',structuralresults.Stress.szz, ...
                          'Deformation',structuralresults.Displacement)
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See Also
ModalStructuralResults | StructuralModel | TransientStructuralResults |
solve

Introduced in R2017b
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ModalStructuralResults
Structural modal analysis solution

Description
A ModalStructuralResults object contains the natural frequencies and modal
displacement in a form convenient for plotting and postprocessing.

Modal displacement is reported for the nodes of the triangular or tetrahedral mesh
generated by generateMesh. The modal displacement values at the nodes appear as a
structure array in the ModeShapes property. The fields of the structure array contain the
components of the displacement at the nodal locations.

You can use a ModalStructuralResults object to approximate solutions for transient
dynamics problems. For details, see solve.

Creation
Solve a modal analysis problem by using the solve function. This function returns a
modal structural solution as a ModalStructuralResults object.

Properties
NaturalFrequencies — Natural frequencies
column vector

Natural frequencies of the structure, returned as a column vector.
Data Types: double

ModeShapes — Modal displacement values at nodes
structure array

Modal displacement values at the nodes, returned as a structure array. The fields of the
structure array contain components of modal displacement at nodal locations.
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Data Types: struct

Mesh — Finite element mesh
FEMesh object

Finite element mesh, returned as a FEMesh object. For details, see FEMesh.

Examples
Solution to Modal Analysis Structural Model

Find the fundamental (lowest) mode of a 2-D cantilevered beam, assuming a prevalence of
the plane-stress condition.

Specify the following geometric and structural properties of the beam, along with a unit
plane-stress thickness.

length = 5;
height = 0.1;
E = 3E7;
nu = 0.3;
rho = 0.3/386;

Create a model plane-stress model, assign a geometry, and generate a mesh.

structuralmodel = createpde('structural','modal-planestress');
gdm = [3;4;0;length;length;0;0;0;height;height];
g = decsg(gdm,'S1',('S1')');
geometryFromEdges(structuralmodel,g);

Define a maximum element size (five elements through the beam thickness).

hmax = height/5;
msh=generateMesh(structuralmodel,'Hmax',hmax);

Specify the structural properties and boundary constraints.

structuralProperties(structuralmodel,'YoungsModulus',E, ...
                                     'MassDensity',rho, ... 
                                     'PoissonsRatio',nu);
structuralBC(structuralmodel,'Edge',4,'Constraint','fixed');

Compute the analytical fundamental frequency (Hz) using the beam theory.
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I = height^3/12;
analyticalOmega1 = 3.516*sqrt(E*I/(length^4*(rho*height)))/(2*pi)

analyticalOmega1 = 126.9498

Specify a frequency range that includes an analytically computed frequency and solve the
model.

modalresults = solve(structuralmodel,'FrequencyRange',[0,1e6])

modalresults = 
  ModalStructuralResults with properties:

    NaturalFrequencies: [32x1 double]
            ModeShapes: [1x1 struct]
                  Mesh: [1x1 FEMesh]

The solver finds natural frequencies and modal displacement values at nodal locations. To
access these values, use modalresults.NaturalFrequencies and
modalresults.ModeShapes.

modalresults.NaturalFrequencies/(2*pi)

ans = 32×1
105 ×

    0.0013
    0.0079
    0.0222
    0.0433
    0.0711
    0.0983
    0.1055
    0.1462
    0.1930
    0.2455
      ⋮

modalresults.ModeShapes

ans = struct with fields:
    ux: [6511x32 double]
    uy: [6511x32 double]
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Plot the y-component of the solution for the fundamental frequency.

pdeplot(structuralmodel,'XYData',modalresults.ModeShapes.uy(:,1))
title(['First Mode with Frequency ', ...
        num2str(modalresults.NaturalFrequencies(1)/(2*pi)),' Hz'])
axis equal

See Also
StaticStructuralResults | StructuralModel | TransientStructuralResults |
solve
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Introduced in R2018a
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TransientStructuralResults
Transient structural solution and its derived quantities

Description
A TransientStructuralResults object contains the displacement, velocity, and
acceleration in a form convenient for plotting and postprocessing.

Displacement, velocity, and acceleration are reported for the nodes of the triangular or
tetrahedral mesh generated by generateMesh. The displacement, velocity, and
acceleration values at the nodes appear as structure arrays in the Displacement,
Velocity, and Acceleration properties. The fields of the structure arrays contain the
components of the displacement, velocity, and acceleration at the nodal locations.

To evaluate the stress, strain, von Mises stress, principal stress, and principal strain at
the nodal locations, use evaluateStress, evaluateStrain,
evaluateVonMisesStress, evaluatePrincipalStress, and
evaluatePrincipalStrain, respectively.

To evaluate the reaction forces on a specified boundary, use evaluateReaction.

To interpolate the displacement, velocity, acceleration, stress, strain, and von Mises stress
to a custom grid, such as the one specified by meshgrid, use
interpolateDisplacement, interpolateVelocity, interpolateAcceleration,
interpolateStress, interpolateStrain, and interpolateVonMisesStress,
respectively.

Creation
Solve a dynamic linear elasticity problem by using the solve function. This function
returns a transient structural solution as a TransientStructuralResults object.
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Properties
Displacement — Displacement values at nodes
structure array

Displacement values at the nodes, returned as a structure array. The fields of the
structure array contain components of displacement at nodal locations.
Data Types: struct

Velocity — Velocity values at nodes
structure array

Velocity values at the nodes, returned as a structure array. The fields of the structure
array contain components of velocity at nodal locations.
Data Types: struct

Acceleration — Acceleration values at nodes
structure array

Acceleration values at the nodes, returned as a structure array. The fields of the structure
array contain components of acceleration at nodal locations.
Data Types: struct

SolutionTimes — Solution times
real vector

Solution times, returned as a real vector. SolutionTimes is the same as the tlist input
to solve.
Data Types: double

Mesh — Finite element mesh
FEMesh object

Finite element mesh, returned as a FEMesh object. For details, see FEMesh.

Object Functions
evaluateStress Evaluate stress for dynamic structural analysis problem
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evaluateStrain Evaluate strain for dynamic structural analysis problem
evaluateVonMisesStress Evaluate von Mises stress for dynamic structural analysis

problem
evaluateReaction Evaluate reaction forces on boundary
evaluatePrincipalStress Evaluate principal stress at nodal locations
evaluatePrincipalStrain Evaluate principal strain at nodal locations
interpolateDisplacement Interpolate displacement at arbitrary spatial locations
interpolateVelocity Interpolate velocity at arbitrary spatial locations for all time

steps for transient structural model
interpolateAcceleration Interpolate acceleration at arbitrary spatial locations for all

time steps for transient structural model
interpolateStress Interpolate stress at arbitrary spatial locations
interpolateStrain Interpolate strain at arbitrary spatial locations
interpolateVonMisesStress Interpolate von Mises stress at arbitrary spatial locations

Examples
Solution to Transient Structural Model

Solve for transient response of a thin 3-D plate under a harmonic load at the center.

Create a transient dynamic model for a 3-D problem.

structuralmodel = createpde('structural','transient-solid');

Create the geometry and include it in the model. Plot the geometry.

gm = multicuboid([5,0.05],[5,0.05],0.01);
structuralmodel.Geometry=gm;
pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.5)
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Zoom in to see the face labels on the small plate in the center.

figure
pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.25)
axis([-0.2 0.2 -0.2 0.2 -0.1 0.1])
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Specify the Young's modulus, Poisson's ratio, and mass density of the material.

structuralProperties(structuralmodel,'YoungsModulus',210E9,...
                                     'PoissonsRatio',0.3,...
                                     'MassDensity',7800);

Specify that all faces on the periphery of the thin 3-D plate are fixed boundaries.

structuralBC(structuralmodel,'Constraint','fixed','Face',5:8);

Apply a sinusoidal pressure load on the small face at the center of the plate.

structuralBoundaryLoad(structuralmodel,'Face',12,'Pressure',5E7,'Frequency',25);

Generate a mesh with linear elements.

5 Functions — Alphabetical List

5-948



generateMesh(structuralmodel,'GeometricOrder','linear','Hmax',0.2);

Specify the zero initial displacement and velocity.

structuralIC(structuralmodel,'Displacement',[0;0;0],'Velocity',[0;0;0]);

Solve the model.

tlist = linspace(0,1,300);
structuralresults = solve(structuralmodel,tlist)

structuralresults = 
  TransientStructuralResults with properties:

     Displacement: [1x1 struct]
         Velocity: [1x1 struct]
     Acceleration: [1x1 struct]
    SolutionTimes: [1x300 double]
             Mesh: [1x1 FEMesh]

The solver finds the values of displacement, velocity, and acceleration at the nodal
locations. To access these values, use structuralresults.Displacement,
structuralresults.Velocity, and so on. Displacement, velocity, and acceleration are
structure arrays with fields representing their components.

structuralresults.Displacement

ans = struct with fields:
           ux: [1873x300 double]
           uy: [1873x300 double]
           uz: [1873x300 double]
    Magnitude: [1873x300 double]

structuralresults.Velocity

ans = struct with fields:
           vx: [1873x300 double]
           vy: [1873x300 double]
           vz: [1873x300 double]
    Magnitude: [1873x300 double]

structuralresults.Acceleration

 TransientStructuralResults

5-949



ans = struct with fields:
           ax: [1873x300 double]
           ay: [1873x300 double]
           az: [1873x300 double]
    Magnitude: [1873x300 double]

See Also
ModalStructuralResults | StaticStructuralResults | StructuralModel |
solve

Introduced in R2018a
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structuralBC
Package: pde

Specify boundary conditions for structural model

Syntax
structuralBC(structuralmodel,RegionType,RegionID,'Constraint',Cval)
structuralBC(structuralmodel,RegionType,RegionID,'Displacement',
Dval)
structuralBC(structuralmodel,RegionType,RegionID,'XDisplacement',
XDval,'YDisplacement',YDval,'ZDisplacement',ZDval)

structuralBC(structuralmodel,RegionType,RegionID,'XDisplacement',
XDval,Name,Value)
structuralBC(structuralmodel,RegionType,RegionID,'YDisplacement',
YDval,Name,Value)
structuralBC(structuralmodel,RegionType,RegionID,'ZDisplacement',
ZDval,Name,Value)

structuralBC( ___ ,'Vectorized','on')
bc = structuralBC( ___ )

Description
structuralBC(structuralmodel,RegionType,RegionID,'Constraint',Cval)
specifies one of the standard structural boundary constraints. Here, Cval can be
'fixed', 'free', 'roller', or 'symmetric'. The default value is 'free'.

Avoid using 'symmetric' for transient and modal analysis, since symmetric constraint
can prevent participation of some structural modes.

structuralBC(structuralmodel,RegionType,RegionID,'Displacement',
Dval) enforces displacement on the boundary of type RegionType with RegionID ID
numbers.
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structuralBC(structuralmodel,RegionType,RegionID,'XDisplacement',
XDval,'YDisplacement',YDval,'ZDisplacement',ZDval) specifies the x-, y-, and
z-components of the enforced displacement.

structuralBC does not require you to specify all three components. Depending on your
structural analysis problem, you can specify one or more components by picking the
corresponding arguments and omitting others.

structuralBC(structuralmodel,RegionType,RegionID,'XDisplacement',
XDval,Name,Value)specifies the form and duration of the time-varying value of the x-
component of the enforced displacement.

structuralBC(structuralmodel,RegionType,RegionID,'YDisplacement',
YDval,Name,Value) specifies the form and duration of the time-varying value of the y-
component of the enforced displacement.

structuralBC(structuralmodel,RegionType,RegionID,'ZDisplacement',
ZDval,Name,Value) specifies the form and duration of the time-varying value of the z-
component of the enforced displacement.

structuralBC( ___ ,'Vectorized','on') uses vectorized function evaluation when
you pass a function handle as an argument. If your function handle computes in a
vectorized fashion, then using this argument saves time. See “Vectorization” (MATLAB).
For details of this evaluation, see “Nonconstant Boundary Conditions” on page 2-179.

Use this syntax with any of the input arguments from previous syntaxes.

bc = structuralBC( ___ ) returns the structural boundary condition object using any
of the input arguments from previous syntaxes.

Examples

Apply Fixed Boundaries and Specify Surface Traction

Apply fixed boundaries and traction on two ends of a bimetallic cable.

Create a structural model.

structuralModel = createpde('structural','static-solid');
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Create nested cylinders to model a bimetallic cable.

gm = multicylinder([0.01,0.015],0.05);

Assign the geometry to the structural model and plot the geometry.

structuralModel.Geometry = gm;
pdegplot(structuralModel,'CellLabels','on','FaceLabels','on','FaceAlpha',0.4)

For each metal, specify the Young's modulus and Poisson's ratio.

structuralProperties(structuralModel,'Cell',1,'YoungsModulus',110E9, ...
                                              'PoissonsRatio',0.28);
structuralProperties(structuralModel,'Cell',2,'YoungsModulus',210E9, ...
                                              'PoissonsRatio',0.3);
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Specify that faces 1 and 4 are fixed boundaries.

structuralBC(structuralModel,'Face',[1,4],'Constraint','fixed')

ans = 
  StructuralBC with properties:

                RegionType: 'Face'
                  RegionID: [1 4]
                Vectorized: 'off'

   Boundary Constraints and Enforced Displacements
              Displacement: []
             XDisplacement: []
             YDisplacement: []
             ZDisplacement: []
                Constraint: "fixed"

   Boundary Loads
                     Force: []
           SurfaceTraction: []
                  Pressure: []
    TranslationalStiffness: []

Specify the surface traction for faces 2 and 5.

structuralBoundaryLoad(structuralModel,'Face',[2,5],'SurfaceTraction',[0;0;100])

ans = 
  StructuralBC with properties:

                RegionType: 'Face'
                  RegionID: [2 5]
                Vectorized: 'off'

   Boundary Constraints and Enforced Displacements
              Displacement: []
             XDisplacement: []
             YDisplacement: []
             ZDisplacement: []
                Constraint: []

   Boundary Loads
                     Force: []
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           SurfaceTraction: [3x1 double]
                  Pressure: []
    TranslationalStiffness: []

Specify Displacements

Create a structural model.

structuralModel = createpde('structural','static-solid');

Create a block geometry.

gm = multicuboid(0.2,0.1,0.05);

Assign the geometry to the structural model and plot the geometry.

structuralModel.Geometry = gm;
pdegplot(structuralModel,'FaceLabels','on','FaceAlpha',0.5)
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Specify the Young's modulus, Poisson's ratio, and mass density.

structuralProperties(structuralModel,'YoungsModulus',74e9,...
                                     'PoissonsRatio',0.42,...
                                     'MassDensity',19.29e3);

Specify the gravity load on the beam.

structuralBodyLoad(structuralModel,'GravitationalAcceleration',[0;0;-9.8]);

Specify that face 5 is a fixed boundary.

structuralBC(structuralModel,'Face',5,'Constraint','fixed');
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Specify z-displacement on face 3 of the model. By leaving the x- and y-displacements
unspecified, you enable face 3 to move in x- and y-direction.

structuralBC(structuralModel,'Face',3,'ZDisplacement',0.0001);

Generate a mesh and solve the model.

generateMesh(structuralModel);
R = solve(structuralModel); 

Plot the deformed shape with the x-component of normal stress.

pdeplot3D(structuralModel,'ColorMapData',R.Stress.sxx,'Deformation',R.Displacement)
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Now specify all three displacements on the same face. Here, z-displacement is the same,
but x- and y-displacements are both zero. Face 3 cannot move in the x- and y-directions.

structuralBC(structuralModel,'Face',3,'Displacement',[0;0;0.0001]); 
R = solve(structuralModel);
pdeplot3D(structuralModel,'ColorMapData',R.Stress.sxx,'Deformation',R.Displacement)

Thus, specifying 'Displacement',[0;0;0.0001] is equivalent to specifying
'XDisplacement',0,'YDisplacement',0,'ZDisplacement',0.0001.

structuralBC(structuralModel,'Face',3,'XDisplacement',0, ...
                                      'YDisplacement',0, ...
                                      'ZDisplacement',0.0001); 
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R = solve(structuralModel);
pdeplot3D(structuralModel,'ColorMapData',R.Stress.sxx,'Deformation',R.Displacement)

Specify Nonconstant Displacement by Using Function Handle

Use a function handle to specify a harmonically varying excitation in a beam.

Create a transient dynamic model for a 3-D problem.

structuralmodel = createpde('structural','transient-solid');

Create a geometry and include it in the model. Plot the geometry.
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gm = multicuboid(0.06,0.005,0.01);
structuralmodel.Geometry = gm;
pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.5)
view(50,20)

Specify Young's modulus, Poisson's ratio, and mass density of the material.

structuralProperties(structuralmodel,'YoungsModulus',210E9, ...
                                     'PoissonsRatio',0.3, ...
                                     'MassDensity',7800);

Fix one end of the beam.

structuralBC(structuralmodel,'Face',5,'Constraint','fixed');
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Apply a sinusoidal displacement along y-direction on the end opposite to the fixed end of
the beam.

yDisplacementFunc = @(location,state) ones(size(location.y))*1E-4*sin(50*state.time);
structuralBC(structuralmodel,'Face',3,'YDisplacement',yDisplacementFunc)

ans = 
  StructuralBC with properties:

                RegionType: 'Face'
                  RegionID: 3
                Vectorized: 'off'

   Boundary Constraints and Enforced Displacements
              Displacement: []
             XDisplacement: []
             YDisplacement: [function_handle]
             ZDisplacement: []
                Constraint: []

   Boundary Loads
                     Force: []
           SurfaceTraction: []
                  Pressure: []
    TranslationalStiffness: []

   Time Variation of Force, Pressure, or Enforced Displacement
                 StartTime: []
                   EndTime: []
                  RiseTime: []
                  FallTime: []

   Sinusoidal Variation of Force, Pressure, or Enforced Displacement
                 Frequency: []
                     Phase: []

Apply Sinusoidal Displacement by Specifying Frequency

Specify a harmonically varying excitation by specifying its frequency.

Create a transient dynamic model for a 3-D problem.
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structuralmodel = createpde('structural','transient-solid');

Create a geometry and include it in the model. Plot the geometry.

gm = multicuboid(0.06,0.005,0.01);
structuralmodel.Geometry = gm;
pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.5)
view(50,20)

Specify the Young's modulus, Poisson's ratio, and mass density of the material.

structuralProperties(structuralmodel,'YoungsModulus',210E9, ...
                                     'PoissonsRatio',0.3, ...
                                     'MassDensity',7800);
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Fix one end of the beam.

structuralBC(structuralmodel,'Face',5,'Constraint','fixed');

Apply a sinusoidal displacement along y-direction on the end opposite to the fixed end of
the beam.

structuralBC(structuralmodel,'Face',3,'YDisplacement',1E-4,'Frequency',50);

Specify Displacement at Corner of Rectangle

Fix one corner of a rectangular plate to restrain all rigid body motions of the model.

Create a structural model for static plane-stress analysis.

model = createpde('structural','static-planestress'); 

Create the geometry and include it into the structural model.

length = 1;
width = 0.5;
radius = 0.1;
R1 = [3 4 -length length length -length ...
          -width -width  width   width]';
C1 = [1 0 0 radius 0 0 0 0 0 0]';
gdm = [R1 C1];
ns = char('R1','C1');
g = decsg(gdm,'R1- C1',ns');
geometryFromEdges(model,g);

Plot the geometry displaying edge labels.

figure
pdegplot(model,'EdgeLabels','on');
axis([-1.2*length 1.2*length ...
      -1.2*width  1.2*width])
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Plot the geometry displaying vertex labels.

figure
pdegplot(model,'VertexLabels','on');
axis([-1.2*length 1.2*length ...
      -1.2*width  1.2*width])
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Specify the Young's modulus and Poisson's ratio of the material.

structuralProperties(model,'YoungsModulus',210E9,'PoissonsRatio',0.3);

Set the x-component of displacement on the left edge of the plate to zero to resist the
applied load..

structuralBC(model,'Edge',3,'XDisplacement',0);

Apply the surface traction with a non-zero x-component on the right edge of the plate.

structuralBoundaryLoad(model,'Edge',1,'SurfaceTraction',[100000 0]);

Set the y-component of displacement at the bottom left corner (vertex 3) to zero to
restraint the rigid body motion.
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structuralBC(model,'Vertex',3,'YDisplacement',0);

Generate the mesh, using Hmax to control the mesh size. A fine mesh lets you capture the
gradation in solution accurately.

generateMesh(model,'Hmax',radius/6);

Solve the problem.

R = solve(model); 

Plot the x-component of the normal stress distribution.

pdeplot(model,'XYData',R.Stress.sxx);
axis equal
colormap jet
title 'Normal Stress Along x-Direction';
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Input Arguments
structuralmodel — Structural model
StructuralModel object

Structural model, specified as a StructuralModel object. The model contains the
geometry, mesh, structural properties of the material, body loads, boundary loads, and
boundary conditions.
Example: structuralmodel = createpde('structural','transient-solid')
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RegionType — Geometric region type
'Vertex' | 'Edge' | 'Face' (for a 3-D model only)

Geometric region type, specified as 'Vertex', 'Edge', or, for a 3-D model, 'Face'.

You cannot use the following geometric region types if you specify the 'roller' or
'symmetric' value for the boundary constraint Cval:

• 'Edge' for a 3-D model
• 'Vertex' for a 2-D or 3-D model

Example: structuralBC(structuralmodel,'Face',
[2,5],'XDisplacement',0.1)

Data Types: char | string

RegionID — Geometric region ID
vector of positive integers

Geometric region ID, specified as a vector of positive integers. Find the region IDs using
pdegplot, as shown in “Create Geometry and Remove Face Boundaries” on page 2-13 or
“STL File Import” on page 2-46.
Example: structuralBC(structuralmodel,'Face',
[2,5],'XDisplacement',0.01)

Data Types: double

Dval — Enforced displacement
numeric vector | function handle

Enforced displacement, specified as a numeric vector or function handle. A numeric
vector must contain two elements for a 2-D model and three elements for a 3-D model.
The function must return a two-row matrix for a 2-D model and a three-row matrix for a 3-
D model. Each column of the matrix must correspond to an enforced displacement vector
at the boundary coordinates provided by the solver. In case of a transient structural
model, Dval also can be a function of time.
Example: structuralBC(structuralmodel,'Face',[2,5],'Displacement',
[0;0;0.01])

Data Types: double | function_handle

XDval — x-component of enforced displacement
number | function handle
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x-component of enforced displacement, specified as a number or function handle. The
function must return a row vector. Each element of this vector corresponds to the x-
component value of the enforced displacement at the boundary coordinates provided by
the solver. In case of a transient structural model, XDval also can be a function of time.
Example: structuralBC(structuralmodel,'Face',
[2,5],'XDisplacement',0.01)

Data Types: double | function_handle

YDval — y-component of enforced displacement
number | function handle

y-component of enforced displacement, specified as a number or function handle. The
function must return a row vector. Each element of this vector corresponds to the y-
component value of the enforced displacement at the boundary coordinates provided by
the solver. In case of a transient structural model, YDval also can be a function of time.
Example: structuralBC(structuralmodel,'Face',
[2,5],'YDisplacement',0.01)

Data Types: double | function_handle

ZDval — z-component of enforced displacement
number | function handle

z-component of enforced displacement, specified as a number or function handle. The
function must return a row vector. Each element of this vector corresponds to the z-
component value of the enforced displacement at the boundary coordinates provided by
the solver. In case of a transient structural model, ZDval also can be a function of time.
Example: structuralBC(structuralmodel,'Face',
[2,5],'ZDisplacement',0.01)

Data Types: double | function_handle

Cval — Standard structural boundary constraints
'free' (default) | 'fixed' | 'roller' | 'symmetric'

Standard structural boundary constraints, specified as 'free','fixed','roller', or
'symmetric'.

You cannot use the 'roller' and 'symmetric' values with the following geometric
region types:
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• 'Edge' for a 3-D model
• 'Vertex' for a 2-D or 3-D model

Example: structuralBC(structuralmodel,'Face',
[2,5],'Constraint','fixed')

Data Types: char | string

Name-Value Pair Arguments
Use one or more of the name-value pair arguments to specify the form and duration of the
time-varying value of a component of displacement. Specify the displacement value using
one of the following arguments: XDval, YDval, or ZDval. You cannot specify more than
one time-varying component or specify the Dval value with these name-value pair
arguments.

You can model a rectangular, triangular, and trapezoidal displacement pulses. If the start
time is 0, you can omit specifying it.

• For a rectangular pulse, specify the start and end times.
• For a triangular pulse, specify the start time and any two of the following times: rise

time, fall time, and end time. You also can specify all three times, ensuring that they
are consistent.

• For a trapezoid pulse, specify all four times.

5 Functions — Alphabetical List

5-970



You can model a harmonic displacement by specifying its frequency and initial phase. If
the initial phase is 0, you can omit specifying it.
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Example: structuralBC(structuralmodel,'Face',
[2,5],'XDisplacement',0.01,'RiseTime',0.5,'FallTime',0.5,'EndTime',3
)

Rectangular, Triangular, or Trapezoidal Pulse

StartTime — Start time for displacement component
0 (default) | positive number

Start time for the displacement component, specified as a positive number. Specify this
argument only for transient structural models.
Example: structuralBC(structuralmodel,'Face',
[2,5],'XDisplacement',0.01,'StartTime',1,'EndTime',3)

Data Types: double

EndTime — End time for displacement component
0 (default) | positive number
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End time for the displacement component, specified as a positive number equal or greater
than the start time value. Specify this argument only for transient structural models.
Example: structuralBC(structuralmodel,'Face',
[2,5],'XDisplacement',0.01,'StartTime',1,'EndTime',3)

Data Types: double

RiseTime — Rise time for displacement component
0 (default) | positive number

Rise time for the displacement component, specified as a positive number. Specify this
argument only for transient structural models.
Example: structuralBC(structuralmodel,'Face',
[2,5],'XDisplacement',0.01,'RiseTime',0.5,'FallTime',0.5,'EndTime',3
)

Data Types: double

FallTime — Fall time for displacement component
0 (default) | positive number

Fall time for the displacement component, specified as a positive number. Specify this
argument only for transient structural models.
Example: structuralBC(structuralmodel,'Face',
[2,5],'XDisplacement',0.01,'RiseTime',0.5,'FallTime',0.5,'EndTime',3
)

Data Types: double

Harmonic Displacement

Frequency — Frequency of sinusoidal displacement component
positive number

Frequency of a sinusoidal displacement component value, specified as a positive number
in radians per unit of time. Specify this argument only for transient structural models.
Example:
structuralBC(structuralmodel,'Face','XDisplacement',0.01,'Frequency'
,25)

Data Types: double
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Phase — Frequency of sinusoidal displacement component
0 (default) | positive number

Phase of a sinusoidal displacement component value, specified as a positive number in
radians. Specify this argument only for transient structural models.
Example: structuralBC(structuralmodel,'Face',
[2,5],'XDisplacement',0.01,'Frequency',25,'Phase',pi/6)

Data Types: double

Output Arguments
bc — Handle to boundary condition
StructuralBC object

Handle to boundary condition, returned as a StructuralBC object.

Tips
• Specify as many boundary conditions as needed to restrain all rigid body motions. Not

restraining all rigid body motions means that the entire geometry can freely rotate or
move. The resulting linear system of equations is singular. The system can take a long
time to converge, or it might not converge at all. If the system converges, the solution
includes a large rigid body motion in addition to deformation.

See Also
StructuralModel | structuralBodyLoad | structuralBoundaryLoad |
structuralDamping | structuralProperties

Introduced in R2017b
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StructuralBC Properties
Boundary condition or boundary load for structural analysis model

Description
A StructuralBC object specifies the type of PDE boundary condition or boundary load
on a set of geometry boundaries. A StructuralModel object contains a vector of
StructuralBC objects in its BoundaryConditions.StructuralBCAssignments
property.

To specify boundary conditions for your model, use the structuralBC function. To
specify boundary loads, use structuralBoundaryLoad.

Properties
Properties of StructuralBC

RegionType — Geometric region type
'Face' for 3-D geometry | 'Edge' for 2-D geometry

Geometric region type, returned as 'Face' for 3-D geometry or 'Edge' for 2-D
geometry.
Data Types: char

RegionID — Geometric region ID
vector of positive integers

Geometric region ID, returned as a vector of positive integers. Find the region IDs using
pdegplot with 'FaceLabels' (3-D) or 'EdgeLabels' (2-D) set to 'on'.
Data Types: double

Vectorized — Vectorized function evaluation
'off' (default) | 'on'

Vectorized function evaluation, returned as 'off' or 'on'. This evaluation applies when
you pass a function handle as an argument. To save time in the function handle
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evaluation, specify 'on', assuming that your function handle computes in a vectorized
fashion. See “Vectorization” (MATLAB). For details of this evaluation, see “Nonconstant
Boundary Conditions” on page 2-179.
Data Types: char

Boundary Constraints and Enforced Displacements

Displacement — Enforced displacement
numeric vector | function handle

Enforced displacement, returned as a numeric vector or function handle. The numeric
vector must contain two elements for a 2-D model and three elements for a 3-D model.
The function must return a two-row matrix for a 2-D model and a three-row matrix for a 3-
D model. Each column of the matrix must correspond to enforced displacement vector at
the boundary coordinates provided by the solver.
Data Types: double | function_handle

XDisplacement — x-component of enforced displacement
number | function handle

x-component of the enforced displacement, returned as a number or function handle. The
function must return a row vector. Each column of the vector must correspond to the
value of the x-component of the enforced displacement at the boundary coordinates
provided by the solver.
Data Types: double | function_handle

YDisplacement — y-component of enforced displacement
number | function handle

y-component of the enforced displacement, returned as a number or function handle. The
function must return a row vector. Each column of the vector must correspond to the
value of the y-component of the enforced displacement at the boundary coordinates
provided by the solver.
Data Types: double | function_handle

ZDisplacement — z-component of enforced displacement
number | function handle

z-component of the enforced displacement, returned as a number or function handle. The
function must return a row vector. Each column of the vector must correspond to the
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value of the z-component of the enforced displacement at the boundary coordinates
provided by the solver.
Data Types: double | function_handle

Constraint — Standard structural boundary constraints
'free' | 'fixed' | 'roller' | 'symmetric'

Standard structural boundary constraints, returned as 'free','fixed','roller', or
'symmetric'.
Data Types: char

Boundary Loads

SurfaceTraction — Normal and tangential distributed forces on boundary
numeric vector | function handle

Normal and tangential distributed forces on the boundary (in global Cartesian
coordinates system), returned as a numeric vector or function handle. The numeric vector
must contain two elements for a 2-D model and three elements for a 3-D model. The
function must return a two-row matrix for a 2-D model and a three-row matrix for a 3-D
model. Each column of the matrix must correspond to the surface traction vector at the
boundary coordinates provided by the solver.
Data Types: double | function_handle

Pressure — Pressure normal to boundary
number | function handle

Pressure normal to the boundary, returned as a number or function handle. The function
must return a row vector with each column corresponding to value of pressure at the
boundary coordinates provided by the solver. A positive value of pressure acts in the
direction of the outward normal to the boundary.
Data Types: double | function_handle

TranslationalStiffness — Distributed spring stiffness
numeric vector | function handle

Distributed spring stiffness for each translational direction used to model an elastic
foundation, returned as a numeric vector or function handle. The numeric vector must
contain two elements for a 2-D model and three elements for a 3-D model. The custom
function must return a two-row matrix for a 2-D model and a three-row matrix for a 3-D
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model. Each column of this matrix corresponds to the stiffness vector at the boundary
coordinates provided by the solver.
Data Types: double | function_handle

See Also
findStructuralBC | structuralBC | structuralBoundaryLoad

Introduced in R2017b
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structuralIC
Package: pde

Set initial conditions for a transient structural model

Syntax
structuralIC(structuralmodel,'Displacement',u0,'Velocity',v0)
structuralIC( ___ RegionType,RegionID)
structuralIC(structuralmodel,Sresults)
structuralIC(structuralmodel,Sresults,iT)
struct_ic = structuralIC( ___ )

Description
structuralIC(structuralmodel,'Displacement',u0,'Velocity',v0) sets
initial displacement and velocity for the entire geometry.

structuralIC( ___ RegionType,RegionID) sets initial displacement and velocity for
a particular geometry region using the arguments from the previous syntax.

structuralIC(structuralmodel,Sresults) sets initial displacement and velocity
using the solution Sresults from a previous structural analysis on the same geometry. If
Sresults is obtained by solving a transient structural problem, then structuralIC
uses the solution Sresults for the last time-step.

structuralIC(structuralmodel,Sresults,iT) uses the solution Sresults for the
time-step iT from a previous structural analysis on the same geometry.

struct_ic = structuralIC( ___ ) returns a handle to the structural initial
conditions object.

Examples
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Specify Initial Velocity

Specify initial velocity values for the entire geometry and for a particular face.

Create a transient dynamic model for a 3-D problem.

structuralmodel = createpde('structural','transient-solid');

Create a geometry and include it into the model. Plot the geometry.

gm = multicuboid(0.06,0.005,0.01);
structuralmodel.Geometry = gm;
pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.5)
view(50,20)
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Specify the zero initial velocity on the entire geometry. When you specify only the initial
velocity or initial displacement, structuralIC assumes that the omitted parameter is
zero. For example, here the initial displacement is also zero.

structuralIC(structuralmodel,'Velocity',[0;0;0])

ans = 
  GeometricStructuralICs with properties:

             RegionType: 'Cell'
               RegionID: 1
    InitialDisplacement: []
        InitialVelocity: [3x1 double]

Update the initial velocity on face 2 to model impulsive excitation.

structuralIC(structuralmodel,'Face',2,'Velocity',[0;60;0])

ans = 
  GeometricStructuralICs with properties:

             RegionType: 'Face'
               RegionID: 2
    InitialDisplacement: []
        InitialVelocity: [3x1 double]

Specify Nonconstant Initial Displacement by Using Function Handle

Specify initial z-displacement to be dependent on the coordinates x and y.

Create a transient dynamic model for a 3-D problem.

structuralmodel = createpde('structural','transient-solid');

Create the geometry and include it into the model. Plot the geometry.

gm = multicuboid(0.06,0.005,0.01);
structuralmodel.Geometry = gm;
pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.5)
view(50,20)
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Specify the zero initial displacement on the entire geometry.

structuralIC(structuralmodel,'Displacement',[0;0;0])

ans = 
  GeometricStructuralICs with properties:

             RegionType: 'Cell'
               RegionID: 1
    InitialDisplacement: [3x1 double]
        InitialVelocity: []
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Now change the initial displacement in the z-direction on face 2 to a function of the
coordinates x and y:

u 0 =
0
0

x2 + y2

Write the following function file. Save it to a location on your MATLAB® path.

function uinit = initdisp(location)

M = length(location.x);

uinit = zeros(3,M);

uinit(3,:) = location.x.^2 + location.y.^2;

Pass the initial displacement to your structural model.

structuralIC(structuralmodel,'Face',2,'Displacement',@initdisp)

ans = 
  GeometricStructuralICs with properties:

             RegionType: 'Face'
               RegionID: 2
    InitialDisplacement: @initdisp
        InitialVelocity: []

Use Static Solution as Initial Condition

Use a static solution as an initial condition for a dynamic structural model.

Create a static model.

staticmodel = createpde('structural','static-solid');

Create the geometry and include it in the model. Plot the geometry.

gm = multicuboid(0.06,0.005,0.01);
staticmodel.Geometry = gm;
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pdegplot(staticmodel,'FaceLabels','on','FaceAlpha',0.5)
view(50,20)

Specify the Young's modulus, Poisson's ratio, and mass density.

structuralProperties(staticmodel,'YoungsModulus',210E9, ...
                                 'PoissonsRatio',0.3,...
                                 'MassDensity',7800);

Apply the boundary condition and static load.

structuralBC(staticmodel,'Face',5,'Constraint','fixed');
structuralBoundaryLoad(staticmodel,'Face',3,'SurfaceTraction',[0;1E6;0]);

Generate a mesh and solve the model.
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generateMesh(staticmodel,'Hmax',0.02);
Rstatic = solve(staticmodel);

Create a dynamic model and assign geometry.

dynamicmodel = createpde('structural','transient-solid');
gm = multicuboid(0.06,0.005,0.01);
dynamicmodel.Geometry = gm;

Apply the boundary condition.

structuralBC(dynamicmodel,'Face',5,'Constraint','fixed');

Generate a mesh.

generateMesh(dynamicmodel,'Hmax',0.02);

Specify the initial condition using the static solution.

structuralIC(dynamicmodel,Rstatic)

ans = 
  NodalStructuralICs with properties:

    InitialDisplacement: [113x3 double]
        InitialVelocity: [113x3 double]

Input Arguments
structuralmodel — Transient structural model
StructuralModel object

Transient structural model, specified as a StructuralModel object. The model contains
the geometry, mesh, structural properties of the material, body loads, boundary loads,
boundary conditions, and initial conditions.
Example: structuralmodel = createpde('structural','transient-solid')

u0 — Initial displacement
numeric vector | function handle
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Initial displacement, specified as a numeric vector or function handle. A numeric vector
must contain two elements for a 2-D model and three elements for a 3-D model. The
elements represent the components of initial displacement.

The function must return a two-row matrix for a 2-D model and a three-row matrix for a 3-
D model. Each column of the matrix corresponds to the initial displacement at the
coordinates provided by the solver. The approaches for using function handles to specify
initial conditions for StructuralModel and PDEModel are the same. For details about
nonconstant initial conditions for a PDEModel object, see “Nonconstant Initial
Conditions” on page 2-154.
Example: structuralIC(structuralmodel,'Face',[2,5],'Displacement',
[0;0;0.01])

Data Types: double | function_handle

v0 — Initial velocity
numeric vector | function handle

Initial velocity, specified as a numeric vector or function handle. A numeric vector must
contain two elements for a 2-D model and three elements for a 3-D model. The elements
represent the components of initial velocity.

The function must return a two-row matrix for a 2-D model and a three-row matrix for a 3-
D model. Each column of the matrix corresponds to the initial velocity at the coordinates
provided by the solver. The approaches for using function handles to specify initial
conditions for StructuralModel and PDEModel are the same. For details about
nonconstant initial conditions for a PDEModel object, see “Nonconstant Initial
Conditions” on page 2-154.
Example: structuralIC(structuralmodel,'Face',[2,5],'Displacement',
[0;0;0.01],'Velocity',[0;60;0])

Data Types: double | function_handle

RegionType — Geometric region type
'Face' | 'Edge' | 'Vertex' | 'Cell'

Geometric region type, specified as 'Face', 'Edge', 'Vertex', or 'Cell'.

When you apply multiple initial condition assignments, the solver uses these precedence
rules for determining the initial condition.
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• For multiple assignments to the same geometric region, the solver uses the last
applied setting.

• For separate assignments to a geometric region and the boundaries of that region, the
solver uses the specified assignment on the region and chooses the assignment on the
boundary as follows. The solver gives an 'Edge' assignment precedence over a
'Face' assignment, even if you specify a 'Face' assignment after an 'Edge'
assignment. The precedence levels are 'Vertex (highest precedence), 'Edge',
'Face', 'Cell' (lowest precedence).

• For an assignment made with the results object, the solver uses that assignment
instead of all previous assignments.

Example: structuralIC(structuralmodel,'Face',[2,5],'Displacement',
[0;0;0.01],'Velocity',[0;60;0])

Data Types: char

RegionID — Geometric region ID
vector of positive integers

Geometric region ID, specified as a vector of positive integers. Find the region IDs using
pdegplot, as shown in “Create Geometry and Remove Face Boundaries” on page 2-13 or
“STL File Import” on page 2-46.
Example: structuralIC(structuralmodel,'Face',[2,5],'Displacement',
[0;0;0.01],'Velocity',[0;60;0])

Data Types: double

Sresults — Structural model solution
StaticStructuralResults object | TransientStructuralResults object

Structural model solution, specified as a StaticStructuralResults or
TransientStructuralResults object. Create Sresults by using solve.

iT — Time index
positive integer

Time index, specified as a positive integer.
Example: structuralIC(structuralmodel,Sresults,21)
Data Types: double
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Output Arguments
struct_ic — Handle to initial conditions
object

Handle to initial conditions, returned as an object. structuralIC associates the
structural initial condition with the geometric region in the case of a geometric
assignment, or the nodes in the case of a results-based assignment.

See Also
GeometricStructuralICs Properties | NodalStructuralICs Properties | StructuralModel |
findStructuralIC | structuralBC | structuralBodyLoad |
structuralBoundaryLoad | structuralDamping | structuralProperties

Introduced in R2018a
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structuralDamping
Specify damping parameters for transient structural model

Syntax
structuralDamping(structuralmodel,'proportional','Alpha',a,'Beta',b)
ab = structuralDamping( ___ )

Description
structuralDamping(structuralmodel,'proportional','Alpha',a,'Beta',b)
specifies proportional (Rayleigh) damping parameters a and b for structuralmodel.
The second argument must be 'proportional'.

ab = structuralDamping( ___ ) returns the damping parameters object, using the
previous syntax.

Examples

Rayleigh Damping Parameters

Specify proportional (Rayleigh) damping parameters for a beam.

Create a transient structural model.

 structuralModel = createpde('structural','transient-solid');

Import and plot the geometry.

 gm = importGeometry(structuralModel,'SquareBeam.STL');
 pdegplot(structuralModel,'FaceAlpha',0.5)
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Specify the Young's modulus, Poisson's ratio, and mass density.

structuralProperties(structuralModel,'YoungsModulus',210E9,...
                                     'PoissonsRatio',0.3,...
                                     'MassDensity',7800);

Specify the Rayleigh damping parameters.

structuralDamping(structuralModel,'proportional','Alpha',10,'Beta',2)

ans = 
  StructuralDampingAssignment with properties:

      RegionType: 'Cell'
        RegionID: 1
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    DampingModel: 'proportional'
           Alpha: 10
            Beta: 2

Input Arguments
structuralmodel — Transient structural model
StructuralModel object

Transient structural model, specified as a StructuralModel object. The model contains
the geometry, mesh, structural properties of the material, body loads, boundary loads,
boundary conditions, and initial conditions.
Example: structuralmodel = createpde('structural','transient-solid')

a — Mass proportional damping
real number

Mass proportional damping, specified as a real number.
Data Types: double

b — Stiffness proportional damping
real number

Stiffness proportional damping, specified as a real number.
Data Types: double

Output Arguments
ab — Handle to damping parameters
StructuralDampingAssignment object

Handle to damping parameters, returned as a StructuralDampingAssignment object.
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See Also
StructuralModel | solve | structuralBC | structuralBodyLoad |
structuralBoundaryLoad | structuralProperties

Introduced in R2018a
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findStructuralDamping
Package: pde

Find damping model assigned to structural dynamics model

Syntax
dma = findStructuralDamping(structuralmodel.DampingModels)

Description
dma = findStructuralDamping(structuralmodel.DampingModels) returns the
damping model and its parameters assigned to the structural dynamics model. The
toolbox supports the proportional (Rayleigh) damping model. The parameters of this
damping model are the mass and stiffness proportional damping parameters.

Examples

Find Damping Model Assignment

Find the damping model assignment for a 3-D model.

Create a transient structural model.

structuralModel = createpde('structural','transient-solid');

Import and plot the geometry.

importGeometry(structuralModel,'Block.stl');
pdegplot(structuralModel,'CellLabels','on')

 findStructuralDamping

5-993



Specify the stiffness proportional damping parameter.

structuralDamping(structuralModel,'proportional','Beta',40);

Now specify the mass proportional damping parameter.

structuralDamping(structuralModel,'proportional','Alpha',10);

Check the damping parameter assignment for structuralModel. Notice that the Beta
parameter is empty.

findStructuralDamping(structuralModel.DampingModels)

ans = 
  StructuralDampingAssignment with properties:
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      RegionType: 'Cell'
        RegionID: 1
    DampingModel: 'proportional'
           Alpha: 10
            Beta: []

When you specify damping parameters by calling the structuralDamping function
several times, the toolbox uses the last assignment. Specify both the mass and stiffness
parameters.

structuralDamping(structuralModel,'proportional','Alpha',10,'Beta',40);

Check the damping parameter assignment for structuralModel.

findStructuralDamping(structuralModel.DampingModels)

ans = 
  StructuralDampingAssignment with properties:

      RegionType: 'Cell'
        RegionID: 1
    DampingModel: 'proportional'
           Alpha: 10
            Beta: 40

Input Arguments
structuralmodel.DampingModels — Damping model
DampingModels property of StructuralModel object

Damping model of the structural model, specified as a DampingModels property of a
StructuralModel object.
Example: structuralmodel.DampingModels
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Output Arguments
dma — Damping model assignment
StructuralDampingAssignment object

Damping model assignment, returned as a StructuralDampingAssignment object. For
details, see StructuralDampingAssignment Properties.

See Also
StructuralDampingAssignment Properties | structuralDamping

Introduced in R2018a
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StructuralDampingAssignment Properties
Damping assignment for a structural analysis model

Description
A StructuralDampingAssignment object contains the damping model and its
parameters for a structural analysis model. A StructuralModel container has a vector
of StructuralDampingAssignment objects in its
DampingModels.StructuralDampingAssignments property.

To set damping parameters for your structural model, use the structuralDamping
function.

Properties
Properties of StructuralDampingAssignment

RegionType — Region type
'Face' | 'Cell'

Region type, returned as 'Face' for a 2-D region, or 'Cell' for a 3-D region.
Data Types: char

RegionID — Region ID
positive integer

Region ID, returned as a positive integer. The toolbox defines damping parameters for the
entire geometry.
Data Types: double

DampingModel — Damping model type
'proportional'

Damping model type, returned as 'proportional'. The toolbox supports the
proportional (Rayleigh) damping model.
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Data Types: double

Alpha — Mass proportional damping parameter
number

Mass proportional damping parameter, returned as a number.
Data Types: double

Beta — Stiffness proportional damping parameter
number

Stiffness proportional damping parameter, returned as a number.
Data Types: double

See Also
findStructuralDamping | structuralDamping

Introduced in R2018a
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StructuralMaterialAssignment Properties
Structural material property assignments

Description
A StructuralMaterialAssignment object contains the description of material
properties of a structural analysis model. A StructuralModel container has a vector of
StructuralMaterialAssignment objects in its
MaterialProperties.MaterialAssignments property.

To create the material properties assignments for your structural analysis model, use the
structuralProperties function.

Properties
Properties of StructuralMaterialAssignment

RegionType — Region type
'Face' | 'Cell'

Region type, returned as 'Face' for a 2-D region, or 'Cell' for a 3-D region.
Data Types: char

RegionID — Region ID
vector of positive integers

Region ID, returned as a vector of positive integers. To determine which ID corresponds
to which portion of the geometry, use the pdegplot function, setting the 'FaceLabels'
name-value pair to 'on'.
Data Types: double

YoungsModulus — Young's modulus
positive number

Young's modulus of the material, returned as a positive number.

 StructuralMaterialAssignment Properties

5-999



Data Types: double

PoissonsRatio — Poisson's ratio
positive number

Poisson's ratio of the material, returned as a positive number.
Data Types: double

MassDensity — Mass density
positive number

Mass density of the material, returned as a positive number. This property is required
when modeling gravitational effects.
Data Types: double

See Also
findStructuralProperties | structuralProperties

Introduced in R2017b
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structuralBodyLoad
Package: pde

Specify body load for structural model

Syntax
structuralBodyLoad(structuralmodel,'GravitationalAcceleration',
GAval)

structuralBodyLoad(structuralmodel,'Temperature',Tval)
structuralBodyLoad(structuralmodel,'Temperature',Tresults)
structuralBodyLoad(structuralmodel,'Temperature',
Tresults,'TimeStep',iT)

bodyLoad = structuralBodyLoad( ___ )

Description
structuralBodyLoad(structuralmodel,'GravitationalAcceleration',
GAval) specifies acceleration due to gravity as a body load for a static or transient
structural model. Structural models for modal analysis cannot have body loads.

structuralBodyLoad(structuralmodel,'Temperature',Tval) specifies a
thermal load on a static structural analysis model.

Tip If Tval is the temperature itself, and not a change in temperature, you also must
specify a reference temperature. To specify it, assign the reference temperature value to
structuralmodel.ReferenceTemperature. For details, see StructuralModel.

structuralBodyLoad(structuralmodel,'Temperature',Tresults) uses the
steady-state or transient thermal analysis results Tresults to specify a thermal load on a
static structural analysis model. If Tresults is the solution of a transient thermal
problem, then this syntax uses the temperature and its gradients from the last time step.
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structuralBodyLoad(structuralmodel,'Temperature',
Tresults,'TimeStep',iT) uses the transient thermal analysis results Tresults and
the time step index iT to specify a thermal load on a static structural analysis model.

bodyLoad = structuralBodyLoad( ___ ) returns the body load object, using the
input arguments from any of the previous syntaxes.

Examples

Gravity Load on Beam

Create a structural model.

structuralModel = createpde('structural','static-solid');

Create and plot the geometry.

gm = multicuboid(0.5,0.1,0.1);
structuralModel.Geometry = gm;
pdegplot(structuralModel,'FaceAlpha',0.5)
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Specify the Young's modulus, Poisson's ratio, and mass density. The mass density value is
required for modeling gravitational effects.

structuralProperties(structuralModel,'YoungsModulus',210E3, ...
                                     'PoissonsRatio',0.3, ...
                                     'MassDensity',2.7E-6);

Specify the gravity load on the beam.

structuralBodyLoad(structuralModel,'GravitationalAcceleration',[0;0;-9.8])

ans = 
  BodyLoadAssignment with properties:

 structuralBodyLoad
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                   RegionType: 'Cell'
                     RegionID: 1
    GravitationalAcceleration: [3x1 double]
                  Temperature: []
                     TimeStep: []

Constant Thermal Load

Specify a constant temperature rise for a thermal stress analysis of a bimetallic cantilever
beam.

Create a static structural model.

structuralmodel = createpde('structural','static-solid');

Create and plot the geometry.

gm = multicuboid(0.5,0.04,[0.03,0.03],'Zoffset',[0,0.03]);
structuralmodel.Geometry = gm;
pdegplot(structuralmodel,'CellLabels','on')
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Set the reference temperature. This temperature corresponds to the state of zero thermal
stress of the model.

structuralmodel.ReferenceTemperature = 20

structuralmodel = 
  StructuralModel with properties:

            AnalysisType: 'static-solid'
                Geometry: [1x1 DiscreteGeometry]
      MaterialProperties: []
               BodyLoads: []
      BoundaryConditions: []
    ReferenceTemperature: 20
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                    Mesh: []

Apply the constant temperature as a structural body load.

structuralBodyLoad(structuralmodel,'Temperature',300)

ans = 
  BodyLoadAssignment with properties:

                   RegionType: 'Cell'
                     RegionID: [1 2]
    GravitationalAcceleration: []
                  Temperature: 300
                     TimeStep: []

Thermal Load as Steady-State Thermal Model Solution

Specify a thermal load using the solution from a steady-state thermal analysis on the
same geometry and mesh.

Steady-State Thermal Model Analysis

Create a steady-state thermal model.

thermalmodel = createpde('thermal','steadystate');

Create and plot the geometry.

gm = multicuboid(0.5,0.1,0.05);
thermalmodel.Geometry = gm;
pdegplot(thermalmodel,'FaceLabels','on','FaceAlpha',0.5)

5 Functions — Alphabetical List

5-1006



Generate a mesh.

generateMesh(thermalmodel);

Specify the thermal conductivity of the material.

thermalProperties(thermalmodel,'ThermalConductivity',5e-3);

Specify constant temperatures on the left and right ends on the beam.

thermalBC(thermalmodel,'Face',3,'Temperature',100);
thermalBC(thermalmodel,'Face',5,'Temperature',0);

Specify the heat source over the entire geometry.
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internalHeatSource(thermalmodel,10);

Solve the model.

thermalresults = solve(thermalmodel)

thermalresults = 
  SteadyStateThermalResults with properties:

    Temperature: [3870x1 double]
     XGradients: [3870x1 double]
     YGradients: [3870x1 double]
     ZGradients: [3870x1 double]
           Mesh: [1x1 FEMesh]

Plot the temperature distribution.

pdeplot3D(thermalmodel,'ColorMapData',thermalresults.Temperature)
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Static Structural Analysis with Thermal Load

Create a static structural model.

structuralmodel = createpde('structural','static-solid');

Include the same geometry as for the thermal model.

structuralmodel.Geometry = gm;

Apply the solution of the thermal model analysis as a body load for the structural model.

structuralBodyLoad(structuralmodel,'Temperature',thermalresults)

ans = 
  BodyLoadAssignment with properties:
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                   RegionType: 'Cell'
                     RegionID: 1
    GravitationalAcceleration: []
                  Temperature: [1x1 pde.SteadyStateThermalResults]
                     TimeStep: []

Thermal Load as Transient Thermal Model Solution

Specify a thermal load using the solution from a transient thermal analysis on the same
geometry and mesh.

Transient Thermal Model Analysis

Create a transient thermal model.

thermalmodel = createpde('thermal','transient');

Create and plot the geometry.

gm = multicuboid(0.5,0.1,0.05);
thermalmodel.Geometry = gm;
pdegplot(thermalmodel,'FaceLabels','on','FaceAlpha',0.5)
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Generate a mesh.

generateMesh(thermalmodel);

Specify the thermal properties of the material.

thermalProperties(thermalmodel,'ThermalConductivity',5e-3, ...
                               'MassDensity',2.7*10^(-6), ...
                               'SpecificHeat',10);

Specify the constant temperatures on the left and right ends on the beam.

thermalBC(thermalmodel,'Face',3,'Temperature',100);
thermalBC(thermalmodel,'Face',5,'Temperature',0);
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Specify the heat source over the entire geometry.

internalHeatSource(thermalmodel,10);

Set the initial temperature.

thermalIC(thermalmodel,0);

Solve the model.

tlist = [0:1e-4:2e-4];
thermalresults = solve(thermalmodel,tlist)

thermalresults = 
  TransientThermalResults with properties:

      Temperature: [3870x3 double]
    SolutionTimes: [0 1.0000e-04 2.0000e-04]
       XGradients: [3870x3 double]
       YGradients: [3870x3 double]
       ZGradients: [3870x3 double]
             Mesh: [1x1 FEMesh]

Plot the temperature distribution for each time step.

for n = 1:numel(thermalresults.SolutionTimes)
    figure
    pdeplot3D(thermalmodel,'ColorMapData',thermalresults.Temperature(:,n))
    title(['Time = ' num2str(tlist(n))])
    caxis([0 100])
end
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Static Structural Analysis with Thermal Load

Create a static structural model.

structuralmodel = createpde('structural','static-solid');

Include the same geometry as for the thermal model.

structuralmodel.Geometry = gm;

Apply the solution of the thermal model analysis as a body load for the structural model.
By default, structuralBodyLoad uses the thermal model solution for the last time step.

structuralBodyLoad(structuralmodel,'Temperature',thermalresults);
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You also can specify the time step you want to use. For example, apply the thermal model
solution for the second time step as a body load for the structural model.

structuralBodyLoad(structuralmodel,'Temperature',thermalresults, ...
                                   'TimeStep',2);

Input Arguments
structuralmodel — Static or transient structural model
StructuralModel object

Static or transient structural model, specified as a StructuralModel object. The model
contains the geometry, mesh, structural properties of the material, body loads, boundary
loads, and boundary conditions.
Example: structuralmodel = createpde('structural','transient-solid')

GAval — Acceleration due to gravity
numeric vector

Acceleration due to gravity, specified as a numeric vector. GAval must be specified in
units consistent with the geometry and material properties units.
Example:
structuralBodyLoad(structuralmodel,'GravitationalAcceleration',
[0;0;-9.8])

Data Types: double

Tval — Constant thermal load
real number

Constant thermal load on a static structural model, specified as a real number. Tval must
be specified in units consistent with the geometry and material properties units.
Example: structuralBodyLoad(structuralmodel,'Temperature',300)
Data Types: double

Tresults — Thermal model solution
StaticThermalResults object | TransientThermalResults object
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Thermal model solution applied as a body load on a static structural model, specified as a
StaticThermalResults or TransientThermalResults object. Create Tresults by
using solve.
Example: Tresults = solve(thermalmodel);
structuralBodyLoad(structuralmodel,'Temperature',Tresults)

iT — Time index
positive integer

Time index, specified as a positive integer.
Example:
structuralBodyLoad(structuralmodel,'Temperature',Tresults,'TimeStep'
,21)

Data Types: double

Output Arguments
bodyLoad — Handle to body load
BodyLoadAssignment object

Handle to body load, returned as a BodyLoadAssignment object.

See Also
StructuralModel | structuralBC | structuralBoundaryLoad |
structuralDamping | structuralProperties

Introduced in R2017b
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structuralBoundaryLoad
Package: pde

Specify boundary loads for structural model

Syntax
structuralBoundaryLoad(structuralmodel,RegionType,
RegionID,'SurfaceTraction',STval,'Pressure',
Pval,'TranslationalStiffness',TSval)
structuralBoundaryLoad(structuralmodel,'Vertex',VertexID,'Force',
Fval)

structuralBoundaryLoad( ___ ,'Vectorized','on')

structuralBoundaryLoad( ___ ,'Pressure',Pval,Name,Value)
structuralBoundaryLoad(structuralmodel,'Vertex',VertexID,'Force',
Fval,Name,Value)

boundaryLoad = structuralBoundaryLoad( ___ )

Description
structuralBoundaryLoad(structuralmodel,RegionType,
RegionID,'SurfaceTraction',STval,'Pressure',
Pval,'TranslationalStiffness',TSval) specifies surface traction, pressure, and
translational stiffness on the boundary of type RegionType with RegionID ID numbers.
You can specify translational stiffness for a static, transient, or modal analysis. To specify
pressure or surface traction, structuralmodel must be static or transient. Structural
models for modal analysis cannot have pressure or surface traction.

• Surface traction is determined as distributed normal and tangential forces acting on a
boundary, resolved along the global Cartesian coordinate system.

• Pressure must be specified in the direction that is normal to the boundary. A positive
pressure value acts into the boundary (for example, compression). A negative pressure
value acts away from the boundary (for example, suction).
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• Translational stiffness is a distributed spring stiffness for each translational direction.
Translational stiffness is used to model an elastic foundation.

structuralBoundaryLoad does not require you to specify all three body loads.
Depending on your structural analysis problem, you can specify one or more boundary
loads by picking the corresponding arguments and omitting others.

The default boundary load is a stress-free boundary condition.

structuralBoundaryLoad(structuralmodel,'Vertex',VertexID,'Force',
Fval) specifies concentrated force at a vertex with the VertexID number.

structuralBoundaryLoad( ___ ,'Vectorized','on') uses vectorized function
evaluation when you pass a function handle as an argument. If your function handle
computes in a vectorized fashion, then using this argument saves time. See
“Vectorization” (MATLAB). For details of this evaluation, see “Nonconstant Boundary
Conditions” on page 2-179.

Use this syntax with any of the input arguments from previous syntaxes.

structuralBoundaryLoad( ___ ,'Pressure',Pval,Name,Value) lets you specify
the form and duration of a nonconstant pressure pulse for a transient structural model
without creating a function handle. When using this syntax, you must specify the model,
region type and region ID, and pressure. Surface traction and translational stiffness are
optional arguments.

structuralBoundaryLoad(structuralmodel,'Vertex',VertexID,'Force',
Fval,Name,Value) lets you specify the form and duration of a nonconstant
concentrated force for a transient structural model without creating a function handle.

boundaryLoad = structuralBoundaryLoad( ___ ) returns the boundary load object.

Examples

Apply Fixed Boundaries and Specify Surface Traction

Apply fixed boundaries and traction on two ends of a bimetallic cable.

Create a structural model.
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structuralModel = createpde('structural','static-solid');

Create nested cylinders to model a bimetallic cable.

gm = multicylinder([0.01,0.015],0.05);

Assign the geometry to the structural model and plot the geometry.

structuralModel.Geometry = gm;
pdegplot(structuralModel,'CellLabels','on','FaceLabels','on','FaceAlpha',0.4)

For each metal, specify the Young's modulus and Poisson's ratio.

structuralProperties(structuralModel,'Cell',1,'YoungsModulus',110E9, ...
                                              'PoissonsRatio',0.28);
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structuralProperties(structuralModel,'Cell',2,'YoungsModulus',210E9, ...
                                              'PoissonsRatio',0.3);

Specify that faces 1 and 4 are fixed boundaries.

structuralBC(structuralModel,'Face',[1,4],'Constraint','fixed')

ans = 
  StructuralBC with properties:

                RegionType: 'Face'
                  RegionID: [1 4]
                Vectorized: 'off'

   Boundary Constraints and Enforced Displacements
              Displacement: []
             XDisplacement: []
             YDisplacement: []
             ZDisplacement: []
                Constraint: "fixed"

   Boundary Loads
                     Force: []
           SurfaceTraction: []
                  Pressure: []
    TranslationalStiffness: []

Specify the surface traction for faces 2 and 5.

structuralBoundaryLoad(structuralModel,'Face',[2,5],'SurfaceTraction',[0;0;100])

ans = 
  StructuralBC with properties:

                RegionType: 'Face'
                  RegionID: [2 5]
                Vectorized: 'off'

   Boundary Constraints and Enforced Displacements
              Displacement: []
             XDisplacement: []
             YDisplacement: []
             ZDisplacement: []
                Constraint: []

 structuralBoundaryLoad

5-1021



   Boundary Loads
                     Force: []
           SurfaceTraction: [3x1 double]
                  Pressure: []
    TranslationalStiffness: []

Specify Translational Stiffness

Create a structural model.

structuralModel = createpde('structural','static-solid');

Create a block geometry.

gm = multicuboid(20,10,5);

Assign the geometry to the structural model and plot the geometry.

structuralModel.Geometry = gm;
pdegplot(structuralModel,'FaceLabels','on','FaceAlpha',0.5)
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Specify the Young's modulus and Poisson's ratio.

structuralProperties(structuralModel,'YoungsModulus',30, ...
                                     'PoissonsRatio',0.3);

The bottom face of the block is resting on an elastic foundation (a spring). To model this
foundation, specify the translational stiffness.

structuralBoundaryLoad(structuralModel,'Face',1,'TranslationalStiffness',[0;0;30])

ans = 
  StructuralBC with properties:

                RegionType: 'Face'
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                  RegionID: 1
                Vectorized: 'off'

   Boundary Constraints and Enforced Displacements
              Displacement: []
             XDisplacement: []
             YDisplacement: []
             ZDisplacement: []
                Constraint: []

   Boundary Loads
                     Force: []
           SurfaceTraction: []
                  Pressure: []
    TranslationalStiffness: [3x1 double]

Apply Concentrated Force at Point

Specify a force value at a vertex of a geometry.

Create a structural model for static analysis of a solid (3-D) problem.

model = createpde('structural','static-solid');

Create the geometry, which consists of two cuboids stacked on top of each other.

gm = multicuboid(0.2,0.01,[0.01 0.01],'Zoffset',[0 0.01]);

Include the geometry in the structural model.

model.Geometry = gm;

Plot the geometry and display the face labels. Rotate the geometry so that you can see the
face labels on the left side.

figure 
pdegplot(model,'FaceLabels','on');
view([-67 5])
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Plot the geometry and display the vertex labels. Rotate the geometry so that you can see
the vertex labels on the right side.

figure 
pdegplot(model,'VertexLabels','on','FaceAlpha',0.5)
xlim([-0.01 0.1])
zlim([-0.01 0.02])
view([60 5])
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Specify the Young's modulus, Poisson's ratio, and mass density of the material.

structuralProperties(model,'YoungsModulus',201E9,'PoissonsRatio',0.3);

Specify that faces 5 and 10 are fixed boundaries.

structuralBC(model,'Face',[5 10],'Constraint','fixed');

Specify the concentrated force at vertex 6.

structuralBoundaryLoad(model,'Vertex',6,'Force',[0;10^4;0])

ans = 
  StructuralBC with properties:
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                RegionType: 'Vertex'
                  RegionID: 6
                Vectorized: 'off'

   Boundary Constraints and Enforced Displacements
              Displacement: []
             XDisplacement: []
             YDisplacement: []
             ZDisplacement: []
                Constraint: []

   Boundary Loads
                     Force: [3x1 double]
           SurfaceTraction: []
                  Pressure: []
    TranslationalStiffness: []

Specify Nonconstant Pressure by Using Function Handle

Use a function handle to specify a harmonically varying pressure at the center of a thin 3-
D plate.

Create a transient dynamic model for a 3-D problem.

structuralmodel = createpde('structural','transient-solid');

Create a geometry consisting of a thin 3-D plate and a small plate in the center. Include
the geometry in the model and plot it.

gm = multicuboid([5,0.05],[5,0.05],0.01);
structuralmodel.Geometry=gm;
pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.5)
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Zoom in to see the face labels on the small plate in the center.

figure
pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.25)
axis([-0.2 0.2 -0.2 0.2 -0.1 0.1])
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Specify the Young's modulus, Poisson's ratio, and mass density of the material.

structuralProperties(structuralmodel,'YoungsModulus',210E9,...
                                     'PoissonsRatio',0.3,...
                                     'MassDensity',7800);

Specify that all faces on the periphery of the thin 3-D plate are fixed boundaries.

structuralBC(structuralmodel,'Constraint','fixed','Face',5:8);

Apply a harmonically varying pressure load on the small face at the center of the plate.

plungerLoad = @(location,state)5E7.*sin(25.*state.time);
structuralBoundaryLoad(structuralmodel,'Face',12,'Pressure',plungerLoad)
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ans = 
  StructuralBC with properties:

                RegionType: 'Face'
                  RegionID: 12
                Vectorized: 'off'

   Boundary Constraints and Enforced Displacements
              Displacement: []
             XDisplacement: []
             YDisplacement: []
             ZDisplacement: []
                Constraint: []

   Boundary Loads
                     Force: []
           SurfaceTraction: []
                  Pressure: @(location,state)5E7.*sin(25.*state.time)
    TranslationalStiffness: []

   Time Variation of Force, Pressure, or Enforced Displacement
                 StartTime: []
                   EndTime: []
                  RiseTime: []
                  FallTime: []

   Sinusoidal Variation of Force, Pressure, or Enforced Displacement
                 Frequency: []
                     Phase: []

Apply Sinusoidal Pressure by Specifying Frequency

Specify a harmonically varying pressure at the center of a thin 3-D plate by specifying its
frequency.

Create a transient dynamic model for a 3-D problem.

structuralmodel = createpde('structural','transient-solid');

Create a geometry consisting of a thin 3-D plate and a small plate in the center. Include
the geometry in the model and plot it.
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gm = multicuboid([5,0.05],[5,0.05],0.01);
structuralmodel.Geometry=gm;
pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.5)

Zoom in to see the face labels on the small plate in the center.

figure
pdegplot(structuralmodel,'FaceLabels','on','FaceAlpha',0.25)
axis([-0.2 0.2 -0.2 0.2 -0.1 0.1])
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Specify the Young's modulus, Poisson's ratio, and mass density of the material.

structuralProperties(structuralmodel,'YoungsModulus',210E9,...
                                     'PoissonsRatio',0.3,...
                                     'MassDensity',7800);

Specify that all faces on the periphery of the thin 3-D plate are fixed boundaries.

structuralBC(structuralmodel,'Constraint','fixed','Face',5:8);

Apply a harmonically varying pressure load on the small face at the center of the plate.

structuralBoundaryLoad(structuralmodel,'Face',12,'Pressure',5E7,'Frequency',25)
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ans = 
  StructuralBC with properties:

                RegionType: 'Face'
                  RegionID: 12
                Vectorized: 'off'

   Boundary Constraints and Enforced Displacements
              Displacement: []
             XDisplacement: []
             YDisplacement: []
             ZDisplacement: []
                Constraint: []

   Boundary Loads
                     Force: []
           SurfaceTraction: []
                  Pressure: 50000000
    TranslationalStiffness: []

   Time Variation of Force, Pressure, or Enforced Displacement
                 StartTime: []
                   EndTime: []
                  RiseTime: []
                  FallTime: []

   Sinusoidal Variation of Force, Pressure, or Enforced Displacement
                 Frequency: 25
                     Phase: []

Apply Rectangular Pressure Pulse on Boundary

Create a transient structural model.

structuralModel = createpde('structural','transient-solid');

Import and plot the geometry.

importGeometry(structuralModel,'BracketWithHole.stl');
pdegplot(structuralModel,'FaceLabels','on')
view(-20,10)
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Specify the Young's modulus and Poisson's ratio.

structuralProperties(structuralModel,'YoungsModulus',200e9, ...
                                     'PoissonsRatio',0.3,...
                                     'MassDensity',7800);

Specify that face 4 is a fixed boundary.

structuralBC(structuralModel,'Face',4,'Constraint','fixed');

Apply a rectangular pressure pulse on face 7 in the direction normal to the face.

structuralBoundaryLoad(structuralModel,'Face',7,'Pressure',10^5,...
                                       'StartTime',0.1,'EndTime',0.5)
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ans = 
  StructuralBC with properties:

                RegionType: 'Face'
                  RegionID: 7
                Vectorized: 'off'

   Boundary Constraints and Enforced Displacements
              Displacement: []
             XDisplacement: []
             YDisplacement: []
             ZDisplacement: []
                Constraint: []

   Boundary Loads
                     Force: []
           SurfaceTraction: []
                  Pressure: 100000
    TranslationalStiffness: []

   Time Variation of Force, Pressure, or Enforced Displacement
                 StartTime: 0.1000
                   EndTime: 0.5000
                  RiseTime: []
                  FallTime: []

   Sinusoidal Variation of Force, Pressure, or Enforced Displacement
                 Frequency: []
                     Phase: []

Apply Rectangular Force Pulse at Point

Specify a short concentrated force pulse at a vertex of a geometry.

Create a structural model for static analysis of a solid (3-D) problem.

structuralmodel = createpde('structural','transient-solid');

Create the geometry, which consists of two cuboids stacked on top of each other.

gm = multicuboid(0.2,0.01,[0.01 0.01],'Zoffset',[0 0.01]);
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Include the geometry in the structural model.

structuralmodel.Geometry = gm;

Plot the geometry and display the face labels. Rotate the geometry so that you can see the
face labels on the left side.

figure 
pdegplot(structuralmodel,'FaceLabels','on');
view([-67 5])

Plot the geometry and display the vertex labels. Rotate the geometry so that you can see
the vertex labels on the right side.
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figure 
pdegplot(structuralmodel,'VertexLabels','on','FaceAlpha',0.5)
xlim([-0.01 0.1])
zlim([-0.01 0.02])
view([60 5])

Specify the Young's modulus, Poisson's ratio, and mass density of the material.

structuralProperties(structuralmodel,'YoungsModulus',201E9, ...
                           'PoissonsRatio',0.3, ...
                           'MassDensity',7800);

Specify that faces 5 and 10 are fixed boundaries.

structuralBC(structuralmodel,'Face',[5 10],'Constraint','fixed');
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Specify a short concentrated force pulse at vertex 6.

structuralBoundaryLoad(structuralmodel,'Vertex',6,'Force',[0;1000;0], ...
                             'StartTime',1,'EndTime',1.05)

ans = 
  StructuralBC with properties:

                RegionType: 'Vertex'
                  RegionID: 6
                Vectorized: 'off'

   Boundary Constraints and Enforced Displacements
              Displacement: []
             XDisplacement: []
             YDisplacement: []
             ZDisplacement: []
                Constraint: []

   Boundary Loads
                     Force: [3×1 double]
           SurfaceTraction: []
                  Pressure: []
    TranslationalStiffness: []

   Time Variation of Force, Pressure, or Enforced Displacement
                 StartTime: 1
                   EndTime: 1.0500
                  RiseTime: []
                  FallTime: []

   Sinusoidal Variation of Force, Pressure, or Enforced Displacement
                 Frequency: []
                     Phase: []

Specify zero initial displacement and velocity.

structuralIC(structuralmodel,'Displacement',[0;0;0],'Velocity',[0;0;0]) 

ans = 
  GeometricStructuralICs with properties:

             RegionType: 'Cell'
               RegionID: [1 2]
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    InitialDisplacement: [3×1 double]
        InitialVelocity: [3×1 double]

Generate a fine mesh.

generateMesh(structuralmodel,'Hmax',0.02);

Because the load is zero for the initial time span and is applied for only a short time, solve
the model for two time spans. Use the first time span to find the solution before the force
pulse.

structuralresults1 = solve(structuralmodel,0:1E-2:1); 

Use the second time span to find the solution during and after the force pulse.

structuralIC(structuralmodel,structuralresults1)

ans = 
  NodalStructuralICs with properties:

    InitialDisplacement: [511×3 double]
        InitialVelocity: [511×3 double]

structuralresults2 = solve(structuralmodel,[1.001:0.001:1.01 1.02:1E-2:2]);

Plot the displacement value at the node corresponding to vertex 6, where you applied the
concentrated force pulse.

loadedNd = findNodes(structuralmodel.Mesh,'region','Vertex',6); 
plot(structuralresults2.SolutionTimes,structuralresults2.Displacement.uy(loadedNd,:))
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Input Arguments
structuralmodel — Static or transient structural model
StructuralModel object

Static or transient structural model, specified as a StructuralModel object. The model
contains the geometry, mesh, structural properties of the material, body loads, boundary
loads, and boundary conditions.
Example: structuralmodel = createpde('structural','transient-solid')
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RegionType — Geometric region type
'Edge' for a 2-D model | 'Face' for a 3-D model

Geometric region type, specified as 'Edge' for a 2-D model or 'Face' for a 3-D model.
Example: structuralBoundaryLoad(structuralmodel,'Face',
[2,5],'SurfaceTraction',[0,0,100])

Data Types: char | string

RegionID — Geometric region ID
positive integer | vector of positive integers

Geometric region ID, specified as a positive integer or vector of positive integers. Find the
region IDs using pdegplot, as shown in “Create Geometry and Remove Face
Boundaries” on page 2-13 or “STL File Import” on page 2-46.
Example: structuralBoundaryLoad(structuralmodel,'Face',
[2,5],'SurfaceTraction',[0,0,100])

Data Types: double

VertexID — Vertex ID
positive integer | vector of positive integers

Vertex ID, specified as a positive integer or vector of positive integers. Find the vertex IDs
using pdegplot.
Example: structuralBoundaryLoad(structuralmodel,'Vertex',6,'Force',
[0;10^4;0])

Data Types: double

STval — Distributed normal and tangential forces on boundary
numeric vector | function handle

Distributed normal and tangential forces on the boundary, resolved along the global
Cartesian coordinate system, specified as a numeric vector or function handle. A numeric
vector must contain two elements for a 2-D model and three elements for a 3-D model.
The function must return a two-row matrix for a 2-D model and a three-row matrix for a 3-
D model. Each column of the matrix must correspond to the surface traction vector at the
boundary coordinates provided by the solver. In case of a transient structural model,
STval also can be a function of time.
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Example: structuralBoundaryLoad(structuralmodel,'Face',
[2,5],'SurfaceTraction',[0;0;100])

Data Types: double | function_handle

Pval — Pressure normal to boundary
number | function handle

Pressure normal to the boundary, specified as a number or function handle. The function
must return a row vector with each column corresponding to the value of pressure at the
boundary coordinates provided by the solver. In case of a transient structural model,
Pval also can be a function of time. A positive value of pressure acts into the boundary
(for example, compression), while a negative value pressure acts away from the boundary
(for example, suction).
Example: structuralBoundaryLoad(structuralmodel,'Face',
[2,5],'Pressure',10^5)

Data Types: double | function_handle

TSval — Distributed spring stiffness
numeric vector | function handle

Distributed spring stiffness for each translational direction used to model elastic
foundation, specified as a numeric vector or function handle. A numeric vector must
contain two elements for a 2-D model and three elements for a 3-D model. The custom
function must return a two-row matrix for a 2-D model and a three-row matrix for a 3-D
model. Each column of this matrix corresponds to the stiffness vector at the boundary
coordinates provided by the solver. In case of a transient structural model, TSval also
can be a function of time.
Example: structuralBoundaryLoad(structuralmodel,'Edge',
[2,5],'TranslationalStiffness',[0;5500])

Data Types: double | function_handle

Fval — Concentrated force
numeric vector | function handle

Concentrated force at a vertex, specified as a numeric vector or function handle.
Example: structuralBoundaryLoad(structuralmodel,'Vertex',5,'Force',
[0;0;10])

Data Types: double | function_handle
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Name-Value Pair Arguments
Use one or more of the name-value pair arguments to specify the form and duration of the
pressure or concentrated force pulse. Specify the pressure or force value using the Pval
or Fval argument, respectively.

You can model a rectangular, triangular, and trapezoidal pressure or concentrated force
pulses. If the start time is 0, you can omit specifying it.

• For a rectangular pulse, specify the start and end times.
• For a triangular pulse, specify the start time and any two of the following times: rise

time, fall time, and end time. You also can specify all three times, ensuring that they
are consistent.

• For a trapezoid pulse, specify all four times.
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You can model a harmonic pressure or concentrated force load by specifying its frequency
and initial phase. If the initial phase is 0, you can omit specifying it.

Example: structuralBoundaryLoad(structuralmodel,'Face',
[2,5],'Pressure',10^5,'RiseTime',0.5,'FallTime',0.5,'EndTime',3)

Rectangular, Triangular, or Trapezoidal Pulse

StartTime — Start time for pressure or concentrated force load
0 (default) | positive number

Start time for pressure or concentrated force load, specified as a positive number. Specify
this argument only for transient structural models.
Example: structuralBoundaryLoad(structuralmodel,'Face',
[2,5],'Pressure',10^5,'StartTime',1,'EndTime',3)

Data Types: double

EndTime — End time for pressure or concentrated force load
0 (default) | positive number
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End time for pressure or concentrated force load, specified as a positive number equal or
greater than the start time value. Specify this argument only for transient structural
models.
Example: structuralBoundaryLoad(structuralmodel,'Face',
[2,5],'Pressure',10^5,'StartTime',1,'EndTime',3)

Data Types: double

RiseTime — Rise time for pressure or concentrated force load
0 (default) | positive number

Rise time for pressure or concentrated force load, specified as a positive number. Specify
this argument only for transient structural models.
Example: structuralBoundaryLoad(structuralmodel,'Face',
[2,5],'Pressure',10^5,'RiseTime',0.5,'FallTime',0.5,'EndTime',3)

Data Types: double

FallTime — Fall time for pressure or concentrated force load
0 (default) | positive number

Fall time for pressure or concentrated force load, specified as a positive number. Specify
this argument only for transient structural models.
Example: structuralBoundaryLoad(structuralmodel,'Face',
[2,5],'Pressure',10^5,'RiseTime',0.5,'FallTime',0.5,'EndTime',3)

Data Types: double

Harmonic Pressure or Force Load

Frequency — Frequency of sinusoidal pressure or concentrated force
positive number

Frequency of a sinusoidal pressure or concentrated force, specified as a positive number,
in radians per unit of time. Specify this argument only for transient structural models.
Example: structuralBoundaryLoad(structuralmodel,'Face',
[2,5],'Pressure',10^5,'Frequency',25)

Data Types: double

Phase — Phase of sinusoidal pressure or concentrated force
0 (default) | positive number
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Phase of a sinusoidal pressure or concentrated force, specified as a positive number, in
radians. Specify this argument only for transient structural models.
Example: structuralBoundaryLoad(structuralmodel,'Face',
[2,5],'Pressure',10^5,'Frequency',25,'Phase',pi/6)

Data Types: double

Output Arguments
boundaryLoad — Handle to boundary load
StructuralBC object

Handle to boundary load, returned as a StructuralBC object.

See Also
StructuralModel | structuralBC | structuralBodyLoad | structuralDamping |
structuralProperties

Introduced in R2017b
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StructuralModel
Structural model object

Description
A StructuralModel object contains information about a structural analysis problem:
the geometry, material properties, damping parameters, body loads, boundary loads,
boundary constraints, initial displacement and velocity, and mesh.

Creation
To create a StructuralModel object, use createpde, specifying the first argument
'structural'.

Properties
AnalysisType — Type of structural analysis
'static-solid' | 'static-planestress' | 'static-planestrain' |
'transient-solid' | 'transient-planestress' | 'transient-planestrain' |
'modal-solid' | 'modal-planestress' | 'modal-planestrain'

Type of structural analysis, returned as one of these values.

Static analysis:

• 'static-solid' for static structural analysis of a solid (3-D) problem
• 'static-planestress' for static structural analysis of a plane-stress problem
• 'static-planestrain' for static structural analysis of a plane-strain problem

Transient analysis:

• 'transient-solid' for transient structural analysis of a solid (3-D) problem
• 'transient-planestress' for transient structural analysis of a plane-stress

problem
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• 'transient-planestrain' for transient structural analysis of a plane-strain
problem

Modal analysis:

• 'modal-solid' for modal analysis of a solid (3-D) problem
• 'modal-planestress' for modal analysis of a plane-stress problem
• 'modal-planestrain' for modal analysis of a plane-strain problem

Example: model = createpde('structural','static-solid')
Data Types: char

Geometry — Geometry description
AnalyticGeometry | DiscreteGeometry

Geometry description, returned as AnalyticGeometry for a 2-D geometry or
DiscreteGeometry for a 2-D and 3-D geometry.

• Create AnalyticGeometry using the geometryFromEdges function. For details, see
AnalyticGeometry.

• Create DiscreteGeometry using the importGeometry function or the
geometryFromMesh function. For details, see DiscreteGeometry.

MaterialProperties — Material properties
StructuralMaterialAssignment object containing material property assignments

Material properties within the domain, returned as a StructuralMaterialAssignment
object containing the material property assignments. For details, see
StructuralMaterialAssignment Properties.

To create the material properties assignments for your structural analysis model, use the
structuralProperties function.

BodyLoads — Loads acting on domain or subdomain
BodyLoadAssignment object containing body load assignments

Loads acting on the domain or subdomain, returned as a BodyLoadAssignment object
containing body load assignments. For details, see BodyLoadAssignment Properties.

To create body load assignments for your structural analysis model, use the
structuralBodyLoad function.
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BoundaryConditions — Structural loads and boundary conditions
StructuralBC object containing boundary condition assignments

Structural loads and boundary conditions applied to the geometry, returned as a
StructuralBC object containing the boundary condition assignments. For details, see
StructuralBC Properties.

To specify boundary conditions for your model, use the structuralBC function. To
specify boundary loads, use structuralBoundaryLoad.

DampingModels — Damping model for transient dynamic analysis
StructuralDampingAssignment object containing damping assignments

Damping model for transient dynamic analysis, returned as a
StructuralDampingAssignment object containing damping assignments. For details,
see StructuralDampingAssignment Properties.

To set damping parameters for your structural model, use the structuralDamping
function.

ReferenceTemperature — Reference temperature for thermal load
0 (default) | number

Reference temperature for a thermal load, specified as a number. The reference
temperature corresponds to state of zero thermal stress of the model. The default value 0
implies that the thermal load is specified in terms of the temperature change and its
derivatives.

To specify the reference temperature for a thermal load in your static structural model,
assign the property value directly, for example,
structuralmodel.ReferenceTemperature = 10. To specify the thermal load itself,
use the structuralBodyLoad function.
Data Types: double

InitialConditions — Initial displacement and velocity
GeometricStructuralICs object | NodalStructuralICs object

Initial displacement and velocity, returned as a GeometricStructuralICs or
NodalStructuralICs object. For details, see GeometricStructuralICs Properties and
NodalStructuralICs Properties.
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To set initial conditions for your transient structural model, use the structuralIC
function.

Mesh — Mesh for solution
FEMesh object

Mesh for solution, returned as a FEMesh object. For property details, see FEMesh.

To create the mesh, use the generateMesh function.

Object Functions
geometryFromEdges Create 2-D geometry
geometryFromMesh Create geometry from mesh
importGeometry Import geometry from STL data
structuralBC Specify boundary conditions for structural model
structuralBodyLoad Specify body load for structural model
structuralBoundaryLoad Specify boundary loads for structural model
structuralIC Set initial conditions for a transient structural model
structuralProperties Assign structural properties of material for structural model
solve Solve heat transfer or structural analysis problem

Examples

Create and Populate Structural Analysis Model

Create a static structural model for solving a solid (3-D) problem.

structuralModel = createpde('structural','static-solid')

structuralModel = 
  StructuralModel with properties:

            AnalysisType: 'static-solid'
                Geometry: []
      MaterialProperties: []
               BodyLoads: []
      BoundaryConditions: []
    ReferenceTemperature: []
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                    Mesh: []

Create and plot the geometry.

gm = multicuboid(0.5,0.1,0.1);
structuralModel.Geometry = gm;
pdegplot(structuralModel,'FaceAlpha',0.5)

Specify the Young's modulus, Poisson's ratio, and mass density.

structuralProperties(structuralModel,'Cell',1,'YoungsModulus',210E3, ...
                                              'PoissonsRatio',0.3, ...
                                              'MassDensity',2.7E-6)
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ans = 
  StructuralMaterialAssignment with properties:

       RegionType: 'Cell'
         RegionID: 1
    YoungsModulus: 210000
    PoissonsRatio: 0.3000
      MassDensity: 2.7000e-06
              CTE: []

Specify the gravity load on the rod.

structuralBodyLoad(structuralModel,'GravitationalAcceleration',[0;0;-9.8])

ans = 
  BodyLoadAssignment with properties:

                   RegionType: 'Cell'
                     RegionID: 1
    GravitationalAcceleration: [3x1 double]
                  Temperature: []
                     TimeStep: []

Specify that face 6 is a fixed boundary.

structuralBC(structuralModel,'Face',6,'Constraint','fixed')

ans = 
  StructuralBC with properties:

                RegionType: 'Face'
                  RegionID: 6
                Vectorized: 'off'

   Boundary Constraints and Enforced Displacements
              Displacement: []
             XDisplacement: []
             YDisplacement: []
             ZDisplacement: []
                Constraint: "fixed"

   Boundary Loads
                     Force: []
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           SurfaceTraction: []
                  Pressure: []
    TranslationalStiffness: []

Specify the surface traction for face 5.

structuralBoundaryLoad(structuralModel,'Face',5,'SurfaceTraction',[0;0;100])

ans = 
  StructuralBC with properties:

                RegionType: 'Face'
                  RegionID: 5
                Vectorized: 'off'

   Boundary Constraints and Enforced Displacements
              Displacement: []
             XDisplacement: []
             YDisplacement: []
             ZDisplacement: []
                Constraint: []

   Boundary Loads
                     Force: []
           SurfaceTraction: [3x1 double]
                  Pressure: []
    TranslationalStiffness: []

Generate a mesh.

generateMesh(structuralModel)

ans = 
  FEMesh with properties:

             Nodes: [3x7800 double]
          Elements: [10x4857 double]
    MaxElementSize: 0.0208
    MinElementSize: 0.0104
     MeshGradation: 1.5000
    GeometricOrder: 'quadratic'

View the properties of structuralModel.
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structuralModel

structuralModel = 
  StructuralModel with properties:

            AnalysisType: 'static-solid'
                Geometry: [1x1 DiscreteGeometry]
      MaterialProperties: [1x1 StructuralMaterialAssignmentRecords]
               BodyLoads: [1x1 BodyLoadAssignmentRecords]
      BoundaryConditions: [1x1 StructuralBCRecords]
    ReferenceTemperature: []
                    Mesh: [1x1 FEMesh]

See Also
createpde | generateMesh | geometryFromEdges | geometryFromMesh |
importGeometry | pdegplot | pdeplot | pdeplot3D | solve | structuralBC |
structuralBodyLoad | structuralBoundaryLoad | structuralProperties

Introduced in R2017b
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structuralProperties
Package: pde

Assign structural properties of material for structural model

Syntax
structuralProperties(structuralmodel,'YoungsModulus',
YMval,'PoissonsRatio',PRval)
structuralProperties( ___ ,'MassDensity',MDval)
structuralProperties( ___ ,'CTE',CTEval)
structuralProperties( ___ ,RegionType,RegionID)
mtl = structuralProperties( ___ )

Description
structuralProperties(structuralmodel,'YoungsModulus',
YMval,'PoissonsRatio',PRval) assigns the Young's modulus and Poisson's ratio for
the entire geometry. Use this syntax if your model is static and does not account for
gravitational and thermal effects.

Tip A structural model supports only homogeneous isotropic materials. Therefore, all
material properties must be numeric scalars.

structuralProperties( ___ ,'MassDensity',MDval) assigns the mass density of
the material for the entire geometry, and can include any of the arguments used in the
previous syntax. Specify the mass density of the material if your model is transient or
modal, or if it accounts for gravitational effects.

structuralProperties( ___ ,'CTE',CTEval) assigns the coefficient of thermal
expansion for a thermal stress analysis. Use this syntax if your model is static and
accounts for thermal effects.

structuralProperties( ___ ,RegionType,RegionID) assigns material properties
for the specified geometry region.
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mtl = structuralProperties( ___ ) returns the material properties object.

Examples

Structural Material Properties for Static Model Accounting for Gravity

Create a structural model.

structuralModel = createpde('structural','static-solid');

Import and plot the geometry.

importGeometry(structuralModel,'BracketWithHole.stl');
pdegplot(structuralModel,'FaceAlpha',0.5)
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Specify the Young's modulus, Poisson's ratio, and mass density.

structuralProperties(structuralModel,'YoungsModulus',200e9, ...
                                     'PoissonsRatio',0.3, ...
                                     'MassDensity',7800)

ans = 
  StructuralMaterialAssignment with properties:

       RegionType: 'Cell'
         RegionID: 1
    YoungsModulus: 2.0000e+11
    PoissonsRatio: 0.3000
      MassDensity: 7800
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              CTE: []

Structural Material Properties for Modal Analysis

Create a structural model for modal analysis.

structuralModel = createpde('structural','modal-solid');

Create and plot the geometry.

gm = multicuboid(0.5,0.1,0.1);
structuralModel.Geometry = gm;
pdegplot(structuralModel,'FaceAlpha',0.5)
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Specify the Young's modulus, Poisson's ratio, and mass density.

structuralProperties(structuralModel,'YoungsModulus',210E3, ...
                                     'PoissonsRatio',0.3, ...
                                     'MassDensity',2.7E-6)

ans = 
  StructuralMaterialAssignment with properties:

       RegionType: 'Cell'
         RegionID: 1
    YoungsModulus: 210000
    PoissonsRatio: 0.3000
      MassDensity: 2.7000e-06
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              CTE: []

Structural Material Properties for Thermal Stress Analysis

Specify the coefficients of thermal expansion for a bimetallic cantilever beam. The bottom
layer is steel. The top layer is copper.

Create a static structural model.

structuralmodel = createpde('structural','static-solid');

Create and plot the geometry.

gm = multicuboid(0.5,0.04,[0.03,0.03],'Zoffset',[0,0.03]);
structuralmodel.Geometry = gm;
pdegplot(structuralmodel,'CellLabels','on')
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Specify the Young's modulus, Poisson's ratio, and coefficient of thermal expansion for the
bottom cell C1.

structuralProperties(structuralmodel,'Cell',1','YoungsModulus',210e9, ...
                                               'PoissonsRatio',0.28, ...
                                               'CTE',1.3e-5)

ans = 
  StructuralMaterialAssignment with properties:

       RegionType: 'Cell'
         RegionID: 1
    YoungsModulus: 2.1000e+11
    PoissonsRatio: 0.2800
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      MassDensity: []
              CTE: 1.3000e-05

Specify the Young's modulus, Poisson's ratio, and coefficient of thermal expansion for the
top cell C2.

structuralProperties(structuralmodel,'Cell',2','YoungsModulus',110e9, ...
                                               'PoissonsRatio',0.37, ...
                                               'CTE',2.4e-5)

ans = 
  StructuralMaterialAssignment with properties:

       RegionType: 'Cell'
         RegionID: 2
    YoungsModulus: 1.1000e+11
    PoissonsRatio: 0.3700
      MassDensity: []
              CTE: 2.4000e-05

Structural Material Properties for Each Geometric Region

Create a structural model.

structuralModel = createpde('structural','static-solid');

Create nested cylinders to model a bimetallic cable.

gm = multicylinder([0.01,0.015],0.05);

Assign the geometry to the structural model and plot the geometry.

structuralModel.Geometry = gm;
pdegplot(structuralModel,'CellLabels','on','FaceAlpha',0.4)
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Specify the Young's modulus and Poisson's ratio for each metal.

structuralProperties(structuralModel,'Cell',1,'YoungsModulus',110E9, ...
                                              'PoissonsRatio',0.28)

ans = 
  StructuralMaterialAssignment with properties:

       RegionType: 'Cell'
         RegionID: 1
    YoungsModulus: 1.1000e+11
    PoissonsRatio: 0.2800
      MassDensity: []
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              CTE: []

structuralProperties(structuralModel,'Cell',2,'YoungsModulus',210E9, ...
                                              'PoissonsRatio',0.3)

ans = 
  StructuralMaterialAssignment with properties:

       RegionType: 'Cell'
         RegionID: 2
    YoungsModulus: 2.1000e+11
    PoissonsRatio: 0.3000
      MassDensity: []
              CTE: []

Input Arguments
structuralmodel — Structural model
StructuralModel object

Structural model, specified as a StructuralModel object. The model contains the
geometry, mesh, structural properties of the material, body loads, boundary loads, and
boundary conditions.
Example: structuralmodel = createpde('structural','transient-solid')

YMval — Young's modulus
positive number

Young's modulus of the material, specified as a positive number.
Example:
structuralProperties(structuralmodel,'YoungsModulus',210e3,'Poissons
Ratio',0.3)

Data Types: double

PRval — Poisson's ratio
number greater than 0 and less than 0.5

Poisson's ratio of the material, specified as a number greater than 0 and less than 0.5.
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Example:
structuralProperties(structuralmodel,'YoungsModulus',210e3,'Poissons
Ratio',0.3)

Data Types: double

MDval — Mass density
positive number

Mass density of the material, specified as a positive number. This argument is required
for transient and modal models. MDval is also required when modeling gravitational
effects.
Example:
structuralProperties(structuralmodel,'YoungsModulus',210e3,'Poissons
Ratio',0.3,'MassDensity',11.7e-6)

Data Types: double

CTEval — Coefficient of thermal expansion
real number

Coefficient of thermal expansion, specified as a real number. This argument is required
for thermal stress analysis. Thermal stress analysis requires the structural model to be
static.
Example:
structuralProperties(structuralmodel,'YoungsModulus',210e3,'Poissons
Ratio',0.3,'MassDensity',2.7e-6,'CTE',11.7e-6)

Data Types: double

RegionType — Geometric region type
'Face' for a 2-D model | 'Cell' for a 3-D model

Geometric region type, specified as 'Face' for a 2-D model or 'Cell' for a 3-D model.
Example:
structuralProperties(structuralmodel,'Cell',1,'YoungsModulus',110E9,
'PoissonsRatio',0.3)

Data Types: char | string

RegionID — Geometric region ID
vector of positive integers
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Geometric region ID, specified as a vector of positive integers. Find the region IDs using
pdegplot with the 'FaceLabels' (3-D) or 'EdgeLabels' (2-D) value set to 'on'.
Example:
structuralProperties(structuralmodel,'Cell',1:3,'YoungsModulus',110E
9,'PoissonsRatio',0.3)

Data Types: double

Output Arguments
mtl — Handle to material properties
StructuralMaterialAssignment object

Handle to material properties, returned as a StructuralMaterialAssignment object.
mtl associates the material properties with the geometric region.

See Also
StructuralModel | createpde | structuralBC | structuralBodyLoad |
structuralBoundaryLoad | structuralDamping

Introduced in R2017b
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StationaryResults
Time-independent PDE solution and derived quantities

Description
A StationaryResults object contains the solution of a PDE and its gradients in a form
convenient for plotting and postprocessing.

• A StationaryResults object contains the solution and its gradient calculated at the
nodes of the triangular or tetrahedral mesh, generated by generateMesh.

• Solution values at the nodes appear in the NodalSolution property.
• The three components of the gradient of the solution values at the nodes appear in the

XGradients, YGradients, and ZGradients properties.
• The array dimensions of NodalSolution, XGradients, YGradients, and

ZGradients enable you to extract solution and gradient values for specified equation
indices in a PDE system.

To interpolate the solution or its gradient to a custom grid (for example, specified by
meshgrid), use interpolateSolution or evaluateGradient.

Creation
There are several ways to create a StationaryResults object:

• Solve a time-independent problem using the solvepde function. This function returns
a PDE solution as a StationaryResults object. This is the recommended approach.

• Solve a time-independent problem using the assempde or pdenonlin function. Then
use the createPDEResults function to obtain a StationaryResults object from a
PDE solution returned by assempde or pdenonlin. Note that assempde and
pdenonlin are legacy functions. They are not recommended for solving PDE
problems.
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Properties
Mesh — Finite element mesh
FEMesh object

Finite element mesh, returned as a FEMesh object.

NodalSolution — Solution values at the nodes
vector | array

Solution values at the nodes, returned as a vector or array. For details about the
dimensions of NodalSolution, see “Dimensions of Solutions, Gradients, and Fluxes” on
page 3-317.
Data Types: double

XGradients — x-component of gradient at the nodes
vector | array

x-component of the gradient at the nodes, returned as a vector or array. For details about
the dimensions of XGradients, see “Dimensions of Solutions, Gradients, and Fluxes” on
page 3-317.
Data Types: double

YGradients — y-component of gradient at the nodes
vector | array

y-component of the gradient at the nodes, returned as a vector or array. For details about
the dimensions of YGradients, see “Dimensions of Solutions, Gradients, and Fluxes” on
page 3-317.
Data Types: double

ZGradients — z-component of gradient at the nodes
vector | array

z-component of the gradient at the nodes, returned as a vector or array. For details about
the dimensions of ZGradients, see “Dimensions of Solutions, Gradients, and Fluxes” on
page 3-317.
Data Types: double
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Object Functions
evaluateCGradient Evaluate flux of PDE solution
evaluateGradient Evaluate gradients of PDE solutions at arbitrary points
interpolateSolution Interpolate PDE solution to arbitrary points

Examples

Obtain a StationaryResults Object from solvepde

Create a PDE model for a system of three equations. Import the geometry of a bracket
and plot the face labels.

model = createpde(3);
importGeometry(model,'BracketWithHole.stl');

figure
pdegplot(model,'FaceLabels','on')
view(30,30)
title('Bracket with Face Labels')
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figure
pdegplot(model,'FaceLabels','on')
view(-134,-32)
title('Bracket with Face Labels, Rear View')
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Set boundary conditions such that face 4 is immobile, and face 8 has a force in the
negative z direction.

applyBoundaryCondition(model,'dirichlet','Face',4,'u',[0,0,0]);
applyBoundaryCondition(model,'neumann','Face',8,'g',[0,0,-1e4]);

Set coefficients that represent the equations of linear elasticity. See 3-D Linear Elasticity
Equations in Toolbox Form.

E = 200e9;
nu = 0.3;
specifyCoefficients(model,'m',0,...
                          'd',0,...
                          'c',elasticityC3D(E,nu),...
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                          'a',0,...
                          'f',[0;0;0]);

Create a mesh.

generateMesh(model,'Hmax',1e-2);

Solve the PDE.

results = solvepde(model)

results = 
  StationaryResults with properties:

    NodalSolution: [14002x3 double]
       XGradients: [14002x3 double]
       YGradients: [14002x3 double]
       ZGradients: [14002x3 double]
             Mesh: [1x1 FEMesh]

Access the solution at the nodal locations.

u = results.NodalSolution;

Plot the solution for the z-component, which is component 3.

pdeplot3D(model,'ColorMapData',u(:,3))
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Results from createPDEResults

Obtain a StationaryResults object from a legacy solver together with
createPDEResults.

Create a PDE model for a system of three equations. Import the geometry of a bracket
and plot the face labels.

model = createpde(3);
importGeometry(model,'BracketWithHole.stl');
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figure
pdegplot(model,'FaceLabels','on')
view(30,30)
title('Bracket with Face Labels')

figure
pdegplot(model,'FaceLabels','on')
view(-134,-32)
title('Bracket with Face Labels, Rear View')
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Set boundary conditions such that F4 is immobile, and F8 has a force in the negative z
direction.

applyBoundaryCondition(model,'dirichlet','Face',4,'u',[0,0,0]);
applyBoundaryCondition(model,'neumann','Face',8,'g',[0,0,-1e4]);

Set coefficients for a legacy solver that represent the equations of linear elasticity. See 3-
D Linear Elasticity Equations in Toolbox Form.

E = 200e9;
nu = 0.3;
c = elasticityC3D(E,nu);
a = 0;
f = [0;0;0];
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Create a mesh.

generateMesh(model,'Hmax',1e-2);

Solve the problem using a legacy solver.

u = assempde(model,c,a,f);

Create a StationaryResults object from the solution.

results = createPDEResults(model,u)

results = 
  StationaryResults with properties:

    NodalSolution: [14002x3 double]
       XGradients: [14002x3 double]
       YGradients: [14002x3 double]
       ZGradients: [14002x3 double]
             Mesh: [1x1 FEMesh]

Access the solution at the nodal locations.

u = results.NodalSolution;

Plot the solution for the z-component, which is component 3.

pdeplot3D(model,'ColorMapData',u(:,3))
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See Also
EigenResults | TimeDependentResults | evaluateCGradient |
evaluateGradient | interpolateSolution | solvepde

Topics
“Poisson's Equation on Unit Disk” on page 3-169
“Minimal Surface Problem”
“Solve Problems Using PDEModel Objects” on page 2-6
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Introduced in R2016a
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SteadyStateThermalResults
Steady-state thermal solution and derived quantities

Description
A SteadyStateThermalResults object contains the temperature and temperature
gradient values in a form convenient for plotting and postprocessing.

The temperature and its gradients are calculated at the nodes of the triangular or
tetrahedral mesh generated by generateMesh. Temperature values at the nodes appear
in the Temperature property. The three components of the temperature gradient at the
nodes appear in the XGradients, YGradients, and ZGradients properties.

To interpolate the temperature or its gradients to a custom grid (for example, specified by
meshgrid), use interpolateTemperature or evaluateTemperatureGradient.

To evaluate heat flux of a thermal solution at nodal or arbitrary spatial locations, use
evaluateHeatFlux. To evaluate integrated heat flow rate normal to specified boundary,
use evaluateHeatRate.

Creation
Solve a steady-state thermal problem using the solve function. This function returns a
steady-state thermal solution as a SteadyStateThermalResults object.

Properties
Mesh — Finite element mesh
FEMesh object

Finite element mesh, returned as a FEMesh object.

Temperature — Temperature values at nodes
vector
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Temperature values at nodes, returned as a vector.
Data Types: double

XGradients — x-component of temperature gradient at nodes
vector

x-component of the temperature gradient at nodes, returned as a vector.
Data Types: double

YGradients — y-component of temperature gradient at nodes
vector

y-component of the temperature gradient at nodes, returned as a vector.
Data Types: double

ZGradients — z-component of temperature gradient at nodes
vector

z-component of the temperature gradient at nodes, returned as a vector.
Data Types: double

Object Functions
evaluateHeatFlux Evaluate heat flux of a thermal solution at nodal or

arbitrary spatial locations
evaluateHeatRate Evaluate integrated heat flow rate normal to specified

boundary
evaluateTemperatureGradient Evaluate temperature gradient of a thermal solution at

arbitrary spatial locations
interpolateTemperature Interpolate temperature in a thermal result at arbitrary

spatial locations

Examples

Solution to Steady-State Thermal Model

Solve a 3-D steady-state thermal problem.
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Create a thermal model for this problem.

thermalmodel = createpde('thermal');

Import and plot the block geometry.

importGeometry(thermalmodel,'Block.stl'); 
pdegplot(thermalmodel,'FaceLabel','on','FaceAlpha',0.5)
axis equal

Assign material properties.

thermalProperties(thermalmodel,'ThermalConductivity',80);
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Apply a constant temperature of 100 ∘C to the left side of the block (face 1) and a constant
temperature of 300 ∘C to the right side of the block (face 3). All other faces are insulated
by default.

thermalBC(thermalmodel,'Face',1,'Temperature',100);
thermalBC(thermalmodel,'Face',3,'Temperature',300);

Mesh the geometry and solve the problem.

generateMesh(thermalmodel);
thermalresults = solve(thermalmodel)

thermalresults = 
  SteadyStateThermalResults with properties:

    Temperature: [12691x1 double]
     XGradients: [12691x1 double]
     YGradients: [12691x1 double]
     ZGradients: [12691x1 double]
           Mesh: [1x1 FEMesh]

The solver finds the temperatures and temperature gradients at the nodal locations. To
access these values, use thermalresults.Temperature,
thermalresults.XGradients, and so on. For example, plot temperatures at nodal
locations.

pdeplot3D(thermalmodel,'ColorMapData',thermalresults.Temperature)
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See Also
TransientThermalResults | evaluateHeatFlux | evaluateHeatRate |
evaluateTemperatureGradient | interpolateTemperature

Introduced in R2017a
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ThermalBC Properties
Boundary condition for thermal model

Description
A ThermalBC object specifies the type of PDE boundary condition on a set of geometry
boundaries. A ThermalModel object contains a vector of ThermalBC objects in its
BoundaryConditions.ThermalBCAssignments property.

Specify boundary conditions for your model using the thermalBC function.

Properties
Properties

RegionType — Geometric region type
'Face' for 3-D geometry | 'Edge' for 2-D geometry

Geometric region type, returned as 'Face' for 3-D geometry or 'Edge' for 2-D
geometry.
Data Types: char

RegionID — Geometric region ID
vector of positive integers

Geometric region ID, returned as a vector of positive integers. Find the region IDs using
pdegplot with the 'FaceLabels' (3-D) or 'EdgeLabels' (2-D) value set to 'on'.
Data Types: double

Temperature — Temperature boundary condition
number | function handle

Temperature boundary condition, returned as a number or a function handle. Use a
function handle to specify spatially or temporally varying temperature.
Data Types: double | function_handle
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HeatFlux — Heat flux boundary condition
number | function handle

Heat flux boundary condition, returned as a number or a function handle. Use a function
handle to specify a spatially or temporally varying heat flux or a nonlinear heat flux.
Data Types: double | function_handle

ConvectionCoefficient — Coefficient for convection to ambient heat transfer
condition
number | function handle

Convection to ambient boundary condition, returned as a number or a function handle.
Use a function handle to specify a spatially or temporally varying convection coefficient or
a nonlinear convection coefficient. Specify ambient temperature using the
AmbientTemperature argument.
Data Types: double | function_handle

Emissivity — Radiation emissivity coefficient
number in the range (0,1)

Radiation emissivity coefficient, returned as a number in the range (0,1). Use a function
handle to specify spatially or temporally varying emissivity or nonlinear emissivity.
Specify ambient temperature using the AmbientTemperature argument and the Stefan-
Boltzmann constant using the thermal model properties.
Data Types: double | function_handle

AmbientTemperature — Ambient temperature
number

Ambient temperature, returned as a number. The ambient temperature value is required
for specifying convection and radiation boundary conditions.
Data Types: double

Vectorized — Vectorized function evaluation
'off' (default) | 'on'

Vectorized function evaluation, returned as 'on' or 'off'. This evaluation applies when
you pass a function handle as an argument. To save time in function handle evaluation,
specify 'on', assuming that your function handle computes in a vectorized fashion. See
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“Vectorization” (MATLAB). For details of this evaluation, see “Nonconstant Boundary
Conditions” on page 2-179.
Data Types: char

See Also
ThermalModel | findThermalBC | thermalBC

Introduced in R2017a
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ThermalMaterialAssignment Properties
Thermal material properties assignments

Description
A ThermalMaterialAssignment object contains the description of a thermal model’s
material properties. A ThermalModel container has a vector of
ThermalMaterialAssignment objects in its
MaterialProperties.MaterialAssignments property.

Create material properties assignments for your thermal model using the
thermalProperties function.

Properties
Properties

RegionType — Region type
'Face' | 'Cell'

Region type, returned as 'Face' for a 2-D region, or 'Cell' for a 3-D region.
Data Types: char

RegionID — Region ID
vector of positive integers

Region ID, returned as a vector of positive integers. To determine which ID corresponds
to which portion of the geometry, use the pdegplot function. Set the 'FaceLabels'
name-value pair to 'on'.
Data Types: double

ThermalConductivity — Thermal conductivity of the material
nonnegative number | function handle

Thermal conductivity of the material, returned as a nonnegative number or a function
handle.
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Data Types: double | function_handle

MassDensity — Mass density of the material
nonnegative number | function handle

Mass density of the material, returned as a nonnegative number or a function handle.
Data Types: double | function_handle

SpecificHeat — Specific heat of the material
nonnegative number | function handle

Specific heat of the material, returned as a nonnegative number or a function handle.
Data Types: double | function_handle

See Also
findThermalProperties | thermalProperties

Introduced in R2017a
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ThermalModel
Thermal model object

Description
A ThermalModel object contains information about a heat transfer problem: the
geometry, material properties, internal heat sources, temperature on the boundaries, heat
fluxes through the boundaries, mesh, and initial conditions.

Creation
Create a ThermalModel object using createpde with the first argument 'thermal'.

Properties
AnalysisType — Type of thermal analysis
'steadystate' | 'transient'

Type of thermal analysis, returned as 'steadystate' or 'transient'.

Geometry — Geometry description
geometry object

Geometry description, returned as a geometry object.

• AnalyticGeometry object for 2-D geometry. Create this geometry using the
geometryFromEdges function.

• DiscreteGeometry object for 3-D geometry. Create this geometry using the
importGeometry function or the geometryFromMesh function.

MaterialProperties — Material properties within the domain
object containing material property assignments

Material properties within the domain, returned as an object containing the material
property assignments.
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HeatSources — Heat source within the domain or subdomain
object containing heat source assignments

Heat source within the domain or subdomain, returned as an object containing heat
source assignments.

BoundaryConditions — Boundary conditions applied to the geometry
object containing boundary condition assignments

Boundary conditions applied to the geometry, returned as an object containing the
boundary condition assignments.

InitialConditions — Initial temperature or initial guess
object containing the initial temperature assignments within the geometric domain

Initial temperature or initial guess, returned as an object containing the initial
temperature assignments within the geometric domain.

Mesh — Mesh for solution
FEMesh object

Mesh for solution, returned as a FEMesh object. You create the mesh using the
generateMesh function.

StefanBoltzmannConstant — Constant of proportionality in Stefan-Boltzmann
law governing radiation heat transfer
number

Constant of proportionality in Stefan-Boltzmann law governing radiation heat transfer,
returned as a number. This value must be consistent with the units of the model. Values of
the Stefan-Boltzmann constant in commonly used system of units are:

• SI – 5.670367e-8 W/(m2·K4)
• CGS – 5.6704e-5 erg/(cm2·s·K4)
• US customary – 1.714e-9 BTU/(hr·ft2·R4)

SolverOptions — Algorithm options for PDE solvers
PDESolverOptions object

Algorithm options for the PDE solvers, returned as a PDESolverOptions object. The
properties of PDESolverOptions include absolute and relative tolerances for internal
ODE solvers, maximum solver iterations, and so on.
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Object Functions
geometryFromEdges Create 2-D geometry
geometryFromMesh Create geometry from mesh
importGeometry Import geometry from STL data
thermalProperties Assign thermal properties of a material for a thermal model
internalHeatSource Specify internal heat source for a thermal model
thermalBC Specify boundary conditions for a thermal model
thermalIC Set initial conditions or initial guess for a thermal model
generateMesh Create triangular or tetrahedral mesh
solve Solve heat transfer or structural analysis problem

Examples

Create and Populate a Thermal Model

Create a transient thermal model container.

thermalmodel = createpde('thermal','transient')

thermalmodel = 
  ThermalModel with properties:

               AnalysisType: 'transient'
                   Geometry: []
         MaterialProperties: []
                HeatSources: []
    StefanBoltzmannConstant: []
         BoundaryConditions: []
          InitialConditions: []
                       Mesh: []
              SolverOptions: [1x1 PDESolverOptions]

Create the geometry and include it in the model.

g = @squareg;
geometryFromEdges(thermalmodel,g)

ans = 
  AnalyticGeometry with properties:
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       NumCells: 0
       NumFaces: 1
       NumEdges: 4
    NumVertices: 4

Assign material properties.

thermalProperties(thermalmodel,'ThermalConductivity',79.5,...
                               'MassDensity',7850,...
                               'SpecificHeat',450,...
                               'Face',1)

ans = 
  ThermalMaterialAssignment with properties:

             RegionType: 'face'
               RegionID: 1
    ThermalConductivity: 79.5000
            MassDensity: 7850
           SpecificHeat: 450

Specify that the entire geometry generates heat at the rate 25 W/m^3.

internalHeatSource(thermalmodel,25)

ans = 
  HeatSourceAssignment with properties:

    RegionType: 'face'
      RegionID: 1
    HeatSource: 25

Apply insulated boundary conditions on three edges and the free convection boundary
condition on the right edge.

thermalBC(thermalmodel,'Edge',[1,3,4],'HeatFlux',0);
thermalBC(thermalmodel,'Edge',2,...
                       'ConvectionCoefficient',5000,...
                       'AmbientTemperature',25)

ans = 
  ThermalBC with properties:
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               RegionType: 'Edge'
                 RegionID: 2
              Temperature: []
                 HeatFlux: []
    ConvectionCoefficient: 5000
               Emissivity: []
       AmbientTemperature: 25
               Vectorized: 'off'

Set the initial conditions: uniform room temperature across domain and higher
temperature on the left edge.

thermalIC(thermalmodel,25);
thermalIC(thermalmodel,100,'Edge',4)

ans = 
  GeometricThermalICs with properties:

            RegionType: 'edge'
              RegionID: 4
    InitialTemperature: 100

Specify the Stefan-Boltzmann constant.

thermalmodel.StefanBoltzmannConstant = 5.670367e-8;

Generate mesh.

generateMesh(thermalmodel)

ans = 
  FEMesh with properties:

             Nodes: [2x1541 double]
          Elements: [6x734 double]
    MaxElementSize: 0.1131
    MinElementSize: 0.0566
     MeshGradation: 1.5000
    GeometricOrder: 'quadratic'

thermalmodel now contains the following properties.
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thermalmodel

thermalmodel = 
  ThermalModel with properties:

               AnalysisType: 'transient'
                   Geometry: [1x1 AnalyticGeometry]
         MaterialProperties: [1x1 MaterialAssignmentRecords]
                HeatSources: [1x1 HeatSourceAssignmentRecords]
    StefanBoltzmannConstant: 5.6704e-08
         BoundaryConditions: [1x1 ThermalBCRecords]
          InitialConditions: [1x1 ThermalICRecords]
                       Mesh: [1x1 FEMesh]
              SolverOptions: [1x1 PDESolverOptions]

See Also
createpde | generateMesh | geometryFromEdges | geometryFromMesh |
importGeometry | internalHeatSource | pdegplot | pdeplot | pdeplot3D |
thermalBC | thermalIC | thermalProperties

Introduced in R2017a
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thermalProperties
Package: pde

Assign thermal properties of a material for a thermal model

Syntax
thermalProperties(thermalmodel,'ThermalConductivity',
TCval,'MassDensity',MDval,'SpecificHeat',SHval)
thermalProperties( ___ ,RegionType,RegionID)
mtl = thermalProperties( ___ )

Description
thermalProperties(thermalmodel,'ThermalConductivity',
TCval,'MassDensity',MDval,'SpecificHeat',SHval) assigns material properties,
such as thermal conductivity, mass density, and specific heat. For transient analysis,
specify all three properties. For steady-state analysis, specifying thermal conductivity is
enough. This syntax sets material properties for the entire geometry.

For a nonconstant or nonlinear material, specify TCval, MDval, and SHval as function
handles.

thermalProperties( ___ ,RegionType,RegionID) assigns material properties for a
specified geometry region.

mtl = thermalProperties( ___ ) returns the material properties object.

Examples

Assign Thermal Conductivity

Assign material properties for a steady-state thermal model.
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model = createpde('thermal','steadystate');
gm = importGeometry(model,'SquareBeam.STL');
thermalProperties(model,'ThermalConductivity',0.08)

ans = 
  ThermalMaterialAssignment with properties:

             RegionType: 'cell'
               RegionID: 1
    ThermalConductivity: 0.0800
            MassDensity: []
           SpecificHeat: []

Assign Thermal Conductivity, Mass Density, and Specific Heat

Assign material properties for transient analysis.

thermalmodel = createpde('thermal','transient');
gm = importGeometry(thermalmodel,'SquareBeam.STL');
thermalProperties(thermalmodel,'ThermalConductivity',0.2,...
                               'MassDensity',2.7*10^(-6),...
                               'SpecificHeat',920)

ans = 
  ThermalMaterialAssignment with properties:

             RegionType: 'cell'
               RegionID: 1
    ThermalConductivity: 0.2000
            MassDensity: 2.7000e-06
           SpecificHeat: 920

Assign Thermal Conductivities for Each Geometric Region

Create a steady-state thermal model.

thermalModel = createpde('thermal');
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Create nested cylinders to model a two-layered insulated pipe section, consisting of inner
metal pipe surrounded by insulated material.

gm = multicylinder([20,25,35],20,'Void',[1,0,0]);

Assign geometry to the thermal model and plot the geometry.

thermalModel.Geometry = gm;
pdegplot(thermalModel,'CellLabels','on','FaceAlpha',0.5)

Specify thermal conductivities for metal and insulation.

thermalProperties(thermalModel,'Cell',1,'ThermalConductivity',0.4)
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ans = 
  ThermalMaterialAssignment with properties:

             RegionType: 'cell'
               RegionID: 1
    ThermalConductivity: 0.4000
            MassDensity: []
           SpecificHeat: []

thermalProperties(thermalModel,'Cell',2,'ThermalConductivity',0.0015)

ans = 
  ThermalMaterialAssignment with properties:

             RegionType: 'cell'
               RegionID: 2
    ThermalConductivity: 0.0015
            MassDensity: []
           SpecificHeat: []

Specify Nonconstant Thermal Properties

Use function handles to specify a thermal conductivity that depends on temperature and
specific heat that depends on coordinates.

Create a thermal model for transient analysis and include the geometry. The geometry is
a rod with a circular cross section. The 2-D model is a rectangular strip whose y-
dimension extends from the axis of symmetry to the outer surface, and whose x-dimension
extends over the actual length of the rod.

thermalmodel = createpde('thermal','transient');

g = decsg([3 4 -1.5 1.5 1.5 -1.5 0 0 .2 .2]');
geometryFromEdges(thermalmodel,g);

Specify the thermal conductivity as a linear function of temperature, k = 40 + 0 . 003T.

k = @(location,state)40 + 0.003*state.u;

Specify the specific heat as a linear function of the y-coordinate, cp = 500y.
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cp = @(location,state)500*location.y;

Specify the thermal conductivity, mass density, and specific heat of the material.

thermalProperties(thermalmodel,'ThermalConductivity',k,...
                               'MassDensity',2.7*10^(-6),...
                               'SpecificHeat',cp)

ans = 
  ThermalMaterialAssignment with properties:

             RegionType: 'face'
               RegionID: 1
    ThermalConductivity: @(location,state)40+0.003*state.u
            MassDensity: 2.7000e-06
           SpecificHeat: @(location,state)500*location.y

Input Arguments
thermalmodel — Thermal model
ThermalModel object

Thermal model, specified as a ThermalModel object. The model contains the geometry,
mesh, thermal properties of the material, internal heat source, boundary conditions, and
initial conditions.
Example: thermalmodel = createpde('thermal','steadystate')

RegionType — Geometric region type
'Face' for a 2-D model | 'Cell' for a 3-D model

Geometric region type, specified as 'Face' or 'Cell'.
Example:
thermalProperties(thermalmodel,'Cell',1,'ThermalConductivity',100)

Data Types: char | string

RegionID — Geometric region ID
vector of positive integers
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Geometric region ID, specified as a vector of positive integers. Find the region IDs using
pdegplot, as shown in “Create Geometry and Remove Face Boundaries” on page 2-13 or
“STL File Import” on page 2-46.
Example:
thermalProperties(thermalmodel,'Cell',1:3,'ThermalConductivity',100)

Data Types: double

TCval — Thermal conductivity of the material
positive number | matrix | function handle

Thermal conductivity of the material, specified as a positive number, a matrix, or a
function handle. You can specify thermal conductivity for a steady-state or transient
model. In case of orthotropic thermal conductivity, use a thermal conductivity matrix.

Use a function handle to specify the thermal conductivity that depends on space, time, or
temperature. The function must be of the form

TCval = TCfun(location,state)

The solver passes location data as a structure array with the fields location.x,
location.y, and, for 3-D problems, location.z. The state data is a structure array
with the fields state.u, state.ux, state.uy, state.uz (for 3-D problems), and
state.time (for transient problems). The state.u field contains the solution vector.
The state.ux, state.uy, state.uz fields are estimates of the solution’s partial
derivatives at the corresponding points of the location structure. The state.time field
contains time at evaluation points.

TCfun must return a matrix TCval with number of rows equal to 1, Ndim, Ndim*(Ndim
+1)/2, or Ndim*Ndim, where Ndim is 2 for 2-D problems and 3 for 3-D problems. The
number of columns must equal the number of evaluation points, M =
length(location.x). For details about dimensions of the matrix, see “c Coefficient for
specifyCoefficients” on page 2-100.
Example:
thermalProperties(thermalmodel,'Cell',1,'ThermalConductivity',100) or
thermalProperties(thermalmodel,'ThermalConductivity',[80;10;80]) for
orthotropic thermal conductivity
Data Types: double | function_handle

MDval — Mass density of the material
positive number | function handle
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Mass density of the material, specified as a positive number or a function handle. Specify
this property for a transient thermal conduction analysis model.

Use a function handle to specify the mass density that depends on space, time, or
temperature. The function must be of the form

MDval = MDfun(location,state)

The solver passes location data as a structure array with the fields location.x,
location.y, and, for 3-D problems, location.z. The state data is a structure array
with the fields state.u, state.ux, state.uy, state.uz (for 3-D problems), and
state.time (for transient problems). The state.u field contains the solution vector.
The state.ux, state.uy, state.uz fields are estimates of the solution’s partial
derivatives at the corresponding points of the location structure. The state.time field
contains time at evaluation points.

MDfun must return a row vector MDval with the number of columns equal to the number
of evaluation points, M = length(location.x).
Example:
thermalProperties(thermalmodel,'Cell',1,'ThermalConductivity',100,'M
assDensity',2730e-9,'SpecificHeat',910)

Data Types: double | function_handle

SHval — Specific heat of the material
positive number | function handle

Specific heat of the material, specified as a positive number or a function handle. Specify
this property for a transient thermal conduction analysis model.

Use a function handle to specify the specific heat that depends on space, time, or
temperature. The function must be of the form

SHval = SHfun(location,state)

The solver passes location data as a structure array with the fields location.x,
location.y, and, for 3-D problems, location.z. The state data is a structure array
with the fields state.u, state.ux, state.uy, state.uz (for 3-D problems), and
state.time (for transient problems). The state.u field contains the solution vector.
The state.ux, state.uy, state.uz fields are estimates of the solution’s partial
derivatives at the corresponding points of the location structure. The state.time field
contains time at evaluation points.
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SHfun must return a row vector SHval with the number of columns equal to the number
of evaluation points, M = length(location.x).
Example:
thermalProperties(thermalmodel,'Cell',1,'ThermalConductivity',100,'M
assDensity',2730e-9,'SpecificHeat',910)

Data Types: double | function_handle

Output Arguments
mtl — Handle to material properties
object

Handle to material properties, returned as an object. mtl associates material properties
with the geometric region.

See Also
internalHeatSource | specifyCoefficients

Topics
“Heat Conduction in Multidomain Geometry with Nonuniform Heat Flux”

Introduced in R2017a
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TimeDependentResults
Time-dependent PDE solution and derived quantities

Description
A TimeDependentResults object contains the solution of a PDE and its gradients in a
form convenient for plotting and postprocessing.

• A TimeDependentResults object contains the solution and its gradient calculated at
the nodes of the triangular or tetrahedral mesh, generated by generateMesh.

• Solution values at the nodes appear in the NodalSolution property.
• The solution times appear in the SolutionTimes property.
• The three components of the gradient of the solution values at the nodes appear in the

XGradients, YGradients, and ZGradients properties.
• The array dimensions of NodalSolution, XGradients, YGradients, and

ZGradients enable you to extract solution and gradient values for specified time
indices, and for the equation indices in a PDE system.

To interpolate the solution or its gradient to a custom grid (for example, specified by
meshgrid), use interpolateSolution or evaluateGradient.

Creation
There are several ways to create a TimeDependentResults object:

• Solve a time-dependent problem using the solvepde function. This function returns a
PDE solution as a TimeDependentResults object. This is the recommended
approach.

• Solve a time-dependent problem using the parabolic or hyperbolic function. Then
use the createPDEResults function to obtain a TimeDependentResults object
from a PDE solution returned by parabolic or hyperbolic. Note that parabolic
and hyperbolic are legacy functions. They are not recommended for solving PDE
problems.
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Properties
Mesh — Finite element mesh
FEMesh object

Finite element mesh, returned as a FEMesh object.

NodalSolution — Solution values at the nodes
vector | array

Solution values at the nodes, returned as a vector or array. For details about the
dimensions of NodalSolution, see “Dimensions of Solutions, Gradients, and Fluxes” on
page 3-317.
Data Types: double
Complex Number Support: Yes

SolutionTimes — Solution times
real vector

Solution times, returned as a real vector. SolutionTimes is the same as the tlist input
to solvepde, or the tlist input to the legacy parabolic or hyperbolic solvers.
Data Types: double

XGradients — x-component of gradient at the nodes
vector | array

x-component of the gradient at the nodes, returned as a vector or array. For details about
the dimensions of XGradients, see “Dimensions of Solutions, Gradients, and Fluxes” on
page 3-317.
Data Types: double
Complex Number Support: Yes

YGradients — y-component of gradient at the nodes
vector | array

y-component of the gradient at the nodes, returned as a vector or array. For details about
the dimensions of YGradients, see “Dimensions of Solutions, Gradients, and Fluxes” on
page 3-317.
Data Types: double
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Complex Number Support: Yes

ZGradients — z-component of gradient at the nodes
vector | array

z-component of the gradient at the nodes, returned as a vector or array. For details about
the dimensions of ZGradients, see “Dimensions of Solutions, Gradients, and Fluxes” on
page 3-317.
Data Types: double

Object Functions
evaluateCGradient Evaluate flux of PDE solution
evaluateGradient Evaluate gradients of PDE solutions at arbitrary points
interpolateSolution Interpolate PDE solution to arbitrary points

Examples

Solution of a Parabolic Problem

Solve a parabolic problem with 2-D geometry.

Create and view the geometry: a square with a circular subdomain.

% Square centered at (1,1)
rect1 = [3;4;0;2;2;0;0;0;2;2];
% Circle centered at (1.5,0.5)
circ1 = [1;1.5;.75;0.25];
% Append extra zeros to the circle
circ1 = [circ1;zeros(length(rect1)-length(circ1),1)];
gd = [rect1,circ1];
ns = char('rect1','circ1');
ns = ns';
sf = 'rect1+circ1';
[dl,bt] = decsg(gd,sf,ns);
pdegplot(dl,'EdgeLabels','on','FaceLabels','on')
axis equal
ylim([-0.1,2.1])
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Include the geometry in a PDE model.

model = createpde();
geometryFromEdges(model,dl);

Set boundary conditions that the upper and left edges are at temperature 10.

applyBoundaryCondition(model,'dirichlet','Edge',[2,3],'u',10);

Set initial conditions that the square region is at temperature 0, and the circle is at
temperature 100.

setInitialConditions(model,0);
setInitialConditions(model,100,'Face',2);
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Define the model coefficients.

specifyCoefficients(model,'m',0,'d',1,'c',1,'a',0,'f',0);

Solve the problem for times 0 through 1/2 in steps of 0.01.

generateMesh(model,'Hmax',0.05);
tlist = 0:0.01:0.5;
results = solvepde(model,tlist);

Plot the solution for times 0.02, 0.04, 0.1, and 0.5.

sol = results.NodalSolution;
subplot(2,2,1)
pdeplot(model,'XYData',sol(:,3))
title('Time 0.02')
subplot(2,2,2)
pdeplot(model,'XYData',sol(:,5))
title('Time 0.04')
subplot(2,2,3)
pdeplot(model,'XYData',sol(:,11))
title('Time 0.1')
subplot(2,2,4)
pdeplot(model,'XYData',sol(:,51))
title('Time 0.5')
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See Also
EigenResults | StationaryResults | evaluateCGradient | evaluateGradient |
interpolateSolution

Topics
“Heat Transfer in Block with Cavity” on page 3-202
“Wave Equation on Square Domain”
“Solve Problems Using PDEModel Objects” on page 2-6
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TransientThermalResults
Transient thermal solution and derived quantities

Description
A TransientThermalResults object contains the temperature and gradients values in
a form convenient for plotting and postprocessing.

The temperature and its gradient are calculated at the nodes of the triangular or
tetrahedral mesh generated by generateMesh. Temperature values at the nodes appear
in the Temperature property. The solution times appear in the SolutionTimes
property. The three components of the temperature gradient at the nodes appear in the
XGradients, YGradients, and ZGradients properties. The array dimensions of
Temperature, XGradients, YGradients, and ZGradients let you extract solution and
gradient values for specified time indices.

To interpolate the temperature or its gradient to a custom grid (for example, specified by
meshgrid), use interpolateTemperature or evaluateTemperatureGradient.

To evaluate heat flux of a thermal solution at nodal or arbitrary spatial locations, use
evaluateHeatFlux. To evaluate integrated heat flow rate normal to specified boundary,
use evaluateHeatRate.

Creation
Solve a transient thermal problem using the solve function. This function returns a
transient thermal solution as a TransientThermalResults object.

Properties
Mesh — Finite element mesh
FEMesh object

Finite element mesh, returned as a FEMesh object.
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Temperature — Temperature values at nodes
vector | matrix

Temperature values at nodes, returned as a vector or matrix.

SolutionTimes — Solution times
real vector

Solution times, returned as a real vector. SolutionTimes is the same as the tlist input
to solve.
Data Types: double

XGradients — x-component of temperature gradient at nodes
vector | matrix

x-component of the temperature gradient at nodes, returned as a vector or matrix.
Data Types: double

YGradients — y-component of temperature gradient at nodes
vector | matrix

y-component of the temperature gradient at nodes, returned as a vector or matrix.
Data Types: double

ZGradients — z-component of temperature gradient at nodes
vector | matrix

z-component of the temperature gradient at nodes, returned as a vector or matrix.
Data Types: double

Object Functions
evaluateHeatFlux Evaluate heat flux of a thermal solution at nodal or

arbitrary spatial locations
evaluateHeatRate Evaluate integrated heat flow rate normal to specified

boundary
evaluateTemperatureGradient Evaluate temperature gradient of a thermal solution at

arbitrary spatial locations
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interpolateTemperature Interpolate temperature in a thermal result at arbitrary
spatial locations

Examples

Solution to Transient Thermal Model

Solve a 2-D transient thermal problem.

Create a transient thermal model for this problem.

thermalmodel = createpde('thermal','transient');

Create the geometry and include it in the model.

SQ1 = [3; 4; 0; 3; 3; 0; 0; 0; 3; 3];
D1 = [2; 4; 0.5; 1.5; 2.5; 1.5; 1.5; 0.5; 1.5; 2.5];
gd = [SQ1 D1];
sf = 'SQ1+D1';
ns = char('SQ1','D1');
ns = ns';
dl = decsg(gd,sf,ns);
geometryFromEdges(thermalmodel,dl);
pdegplot(thermalmodel,'EdgeLabels','on','FaceLabels','on')
xlim([-1.5 4.5])
ylim([-0.5 3.5])
axis equal
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For the square region, assign these thermal properties:

• Thermal conductivity is 10 W /(m∘C).
• Mass density is 2 kg/m3.
• Specific heat is 0 . 1 J /(kg∘C).

thermalProperties(thermalmodel,'ThermalConductivity',10, ...
                               'MassDensity',2, ...
                               'SpecificHeat',0.1, ...
                               'Face',1);

For the diamond region, assign these thermal properties:
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• Thermal conductivity is 2 W /(m∘C).
• Mass density is 1 kg/m3.
• Specific heat is 0 . 1 J /(kg∘C).

thermalProperties(thermalmodel,'ThermalConductivity',2, ...
                               'MassDensity',1, ...
                               'SpecificHeat',0.1, ...
                               'Face',2);

Assume that the diamond-shaped region is a heat source with a density of 4 W /m3.

internalHeatSource(thermalmodel,4,'Face',2);

Apply a constant temperature of 0 ∘C to the sides of the square plate.

thermalBC(thermalmodel,'Temperature',0,'Edge',[1 2 7 8]);

Set the initial temperature to 0 ∘C.

thermalIC(thermalmodel,0);

Mesh the geometry.

generateMesh(thermalmodel);

The dynamics for this problem are very fast. The temperature reaches a steady state in
about 0.1 second. To capture the interesting part of the dynamics, set the solution time to
logspace(-2,-1,10). This command returns 10 logarithmically spaced solution times
between 0.01 and 0.1.

tlist = logspace(-2,-1,10);

Solve the equation.

thermalresults = solve(thermalmodel,tlist)

thermalresults = 
  TransientThermalResults with properties:

      Temperature: [1481x10 double]
    SolutionTimes: [1x10 double]
       XGradients: [1481x10 double]
       YGradients: [1481x10 double]
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       ZGradients: []
             Mesh: [1x1 FEMesh]

Plot the solution with isothermal lines by using a contour plot.

T = thermalresults.Temperature;
pdeplot(thermalmodel,'XYData',T(:,10),'Contour','on','ColorMap','hot')

See Also
SteadyStateThermalResults | evaluateHeatFlux | evaluateHeatRate |
evaluateTemperatureGradient | interpolateTemperature
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thermalBC
Package: pde

Specify boundary conditions for a thermal model

Syntax
thermalBC(thermalmodel,RegionType,RegionID,'Temperature',Tval)
thermalBC(thermalmodel,RegionType,RegionID,'HeatFlux,HFval)
thermalBC(thermalmodel,RegionType,RegionID,'ConvectionCoefficient',
CCval,'AmbientTemperature',ATval)
thermalBC(thermalmodel,RegionType,RegionID,'Emissivity',
REval,'AmbientTemperature',ATval)
thermalBC = thermalBC( ___ )

Description
thermalBC(thermalmodel,RegionType,RegionID,'Temperature',Tval) adds a
temperature boundary condition to thermalmodel. The boundary condition applies to
regions of type RegionType with ID numbers in RegionID.

thermalBC(thermalmodel,RegionType,RegionID,'HeatFlux,HFval) adds a heat
flux boundary condition to thermalmodel. The boundary condition applies to regions of
type RegionType with ID numbers in RegionID.

Note Use thermalBC with the HeatFlux parameter to specify a heat flux to or from an
external source. To specify internal heat generation, that is, heat sources that belong to
the geometry of the model, use internalHeatSource.

thermalBC(thermalmodel,RegionType,RegionID,'ConvectionCoefficient',
CCval,'AmbientTemperature',ATval) adds a convection boundary condition to
thermalmodel. The boundary condition applies to regions of type RegionType with ID
numbers in RegionID.
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thermalBC(thermalmodel,RegionType,RegionID,'Emissivity',
REval,'AmbientTemperature',ATval) adds a radiation boundary condition to
thermalmodel. The boundary condition applies to regions of type RegionType with ID
numbers in RegionID.

thermalBC = thermalBC( ___ ) returns the thermal boundary condition object.

Examples

Specify Temperature on the Boundary

Apply temperature boundary condition on two edges of a square.

thermalmodel = createpde('thermal');
geometryFromEdges(thermalmodel,@squareg);
thermalBC(thermalmodel,'Edge',[1,3],'Temperature',100)

ans = 
  ThermalBC with properties:

               RegionType: 'Edge'
                 RegionID: [1 3]
              Temperature: 100
                 HeatFlux: []
    ConvectionCoefficient: []
               Emissivity: []
       AmbientTemperature: []
               Vectorized: 'off'

Specify Heat Coming Through the Boundary

Apply heat flux boundary condition on two faces of a block.

thermalmodel = createpde('thermal','transient');
gm = importGeometry(thermalmodel,'Block.stl');
thermalBC(thermalmodel,'Face',[1,3],'HeatFlux',20)

ans = 
  ThermalBC with properties:
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               RegionType: 'Face'
                 RegionID: [1 3]
              Temperature: []
                 HeatFlux: 20
    ConvectionCoefficient: []
               Emissivity: []
       AmbientTemperature: []
               Vectorized: 'off'

Specify Convection on the Boundary

Apply convection boundary condition on four faces of a block.

thermalModel = createpde('thermal','transient');
gm = importGeometry(thermalModel,'Block.stl');
thermalBC(thermalModel,'Face',[2 4 5 6], ...
                       'ConvectionCoefficient',5, ...
                       'AmbientTemperature',27)

ans = 
  ThermalBC with properties:

               RegionType: 'Face'
                 RegionID: [2 4 5 6]
              Temperature: []
                 HeatFlux: []
    ConvectionCoefficient: 5
               Emissivity: []
       AmbientTemperature: 27
               Vectorized: 'off'

Specify Radiation Through the Boundary

Apply radiation boundary condition on four faces of a block.

thermalmodel = createpde('thermal','transient');
gm = importGeometry(thermalmodel,'Block.stl');
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thermalmodel.StefanBoltzmannConstant = 5.670373E-8;
thermalBC(thermalmodel,'Face',[2,4,5,6],...
                       'Emissivity',0.1,...
                       'AmbientTemperature',300)

ans = 
  ThermalBC with properties:

               RegionType: 'Face'
                 RegionID: [2 4 5 6]
              Temperature: []
                 HeatFlux: []
    ConvectionCoefficient: []
               Emissivity: 0.1000
       AmbientTemperature: 300
               Vectorized: 'off'

Specify Nonconstant Thermal Boundary Conditions

Use function handles to specify thermal boundary conditions that depend on coordinates.

Create a thermal model for transient analysis and include the geometry. The geometry is
a rod with a circular cross section. The 2-D model is a rectangular strip whose y-
dimension extends from the axis of symmetry to the outer surface, and whose x-dimension
extends over the actual length of the rod.

thermalmodel = createpde('thermal','transient');
g = decsg([3 4 -1.5 1.5 1.5 -1.5 0 0 .2 .2]');
geometryFromEdges(thermalmodel,g);

Plot the geometry.

figure
pdegplot(thermalmodel,'EdgeLabels','on');
xlim([-2 2]);
ylim([-2 2]);
title 'Rod Section Geometry with Edge Labels';
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Assume that there is a heat source at the left end of the rod and a fixed temperature at
the right end. The outer surface of the rod exchanges heat with the environment due to
convection.

Define the boundary conditions for the model. The edge at y = 0 (edge 1) is along the axis
of symmetry. No heat is transferred in the direction normal to this edge. This boundary is
modeled as an insulated boundary, by default.

The temperature at the right end of the rod (edge 2) is a fixed temperature, T = 100 C.
Specify the boundary condition for edge 2 as follows.

thermalBC(thermalmodel,'Edge',2,'Temperature',100)
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ans = 
  ThermalBC with properties:

               RegionType: 'Edge'
                 RegionID: 2
              Temperature: 100
                 HeatFlux: []
    ConvectionCoefficient: []
               Emissivity: []
       AmbientTemperature: []
               Vectorized: 'off'

The convection coefficient for the outer surface of the rod (edge 3) depends on the y-
coordinate, 50y. Specify the boundary condition for this edge as follows.

outerCC = @(location,~) 50*location.y;
thermalBC(thermalmodel,'Edge',3,...
                       'ConvectionCoefficient',outerCC,...
                       'AmbientTemperature',100)

ans = 
  ThermalBC with properties:

               RegionType: 'Edge'
                 RegionID: 3
              Temperature: []
                 HeatFlux: []
    ConvectionCoefficient: @(location,~)50*location.y
               Emissivity: []
       AmbientTemperature: 100
               Vectorized: 'off'

The heat flux at the left end of the rod (edge 4) is also a function of the y-coordinate,
5000y. Specify the boundary condition for this edge as follows.

leftHF = @(location,~) 5000*location.y;
thermalBC(thermalmodel,'Edge',4,'HeatFlux',leftHF)

ans = 
  ThermalBC with properties:

               RegionType: 'Edge'
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                 RegionID: 4
              Temperature: []
                 HeatFlux: @(location,~)5000*location.y
    ConvectionCoefficient: []
               Emissivity: []
       AmbientTemperature: []
               Vectorized: 'off'

Input Arguments
thermalmodel — Thermal model
ThermalModel object

Thermal model, specified as a ThermalModel object. The model contains the geometry,
mesh, thermal properties of the material, internal heat source, boundary conditions, and
initial conditions.
Example: thermalmodel = createpde('thermal','steadystate')

RegionType — Geometric region type
'Edge' for a 2-D model | 'Face' for a 3-D model

Geometric region type, specified as 'Edge' or 'Face'.
Example: thermalBC(thermalmodel,'Face',1,'Temperature',72)
Data Types: char

RegionID — Geometric region ID
vector of positive integers

Geometric region ID, specified as a vector of positive integers. Find the region IDs using
pdegplot with the 'FaceLabels' (3-D) or 'EdgeLabels' (2-D) value set to 'on'.
Example: thermalBC(thermalmodel,'Edge',2:5,'Temperature',72)
Data Types: double

Tval — Temperature boundary condition
number | function handle
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Temperature boundary condition, specified as a number or a function handle. Use a
function handle to specify the temperature that depends on space, time, or temperature.
The function must be of the form

Tval = Tfun(location,state)

The solver passes location data as a structure array with the fields location.x,
location.y, and, for 3-D problems, location.z. The state data is a structure array
with the fields state.u, state.ux, state.uy, state.uz (for 3-D problems), and
state.time (for transient problems). The state.u field contains the solution vector.
The state.ux, state.uy, state.uz fields are estimates of the solution’s partial
derivatives at the corresponding points of the location structure. The state.time field
contains time at evaluation points.

Tfun must return a row vector Tval with the number of columns equal to the number of
evaluation points, M = length(location.x).
Example: thermalBC(thermalmodel,'Face',1,'Temperature',72)
Data Types: double | function_handle

HFval — Heat flux boundary condition
number | function handle

Heat flux boundary condition, specified as a number or a function handle. Use a function
handle to specify the heat flux that depends on space, time, or temperature. The function
must be of the form

HFval = HFfun(location,state)

The solver passes location data as a structure array with the fields location.x,
location.y, and, for 3-D problems, location.z. The state data is a structure array
with the fields state.u, state.ux, state.uy, state.uz (for 3-D problems), and
state.time (for transient problems). The state.u field contains the solution vector.
The state.ux, state.uy, state.uz fields are estimates of the solution’s partial
derivatives at the corresponding points of the location structure. The state.time field
contains time at evaluation points.

HFfun must return a row vector HFval with the number of columns equal to the number
of evaluation points, M = length(location.x).
Example: thermalBC(thermalmodel,'Face',[1,3],'HeatFlux',20)
Data Types: double | function_handle
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CCval — Coefficient for convection to ambient heat transfer condition
number | function handle

Convection to ambient boundary condition, specified as a number or a function handle.
Use a function handle to specify the convection coefficient that depends on space, time,
or temperature. The function must be of the form

CCval = CCfun(location,state)

The solver passes location data as a structure array with the fields location.x,
location.y, and, for 3-D problems, location.z. The state data is a structure array
with the fields state.u, state.ux, state.uy, state.uz (for 3-D problems), and
state.time (for transient problems). The state.u field contains the solution vector.
The state.ux, state.uy, state.uz fields are estimates of the solution’s partial
derivatives at the corresponding points of the location structure. The state.time field
contains time at evaluation points.

CCfun must return a row vector CCval with the number of columns equal to the number
of evaluation points, M = length(location.x).

Specify ambient temperature using the AmbientTemperature argument. The value of
ConvectionCoefficient is positive for heat convection into the ambient environment.
Example: thermalBC(thermalmodel,'Edge',
[2,4],'ConvectionCoefficient',5,'AmbientTemperature',60)

Data Types: double | function_handle

REval — Radiation emissivity coefficient
number in the range (0,1)

Radiation emissivity coefficient, specified as a number in the range (0,1). Use a function
handle to specify the radiation emissivity that depends on space, time, or temperature.
The function must be of the form

REval = REfun(location,state)

The solver passes location data as a structure array with the fields location.x,
location.y, and, for 3-D problems, location.z. The state data is a structure array
with the fields state.u, state.ux, state.uy, state.uz (for 3-D problems), and
state.time (for transient problems). The state.u field contains the solution vector.
The state.ux, state.uy, state.uz fields are estimates of the solution’s partial
derivatives at the corresponding points of the location structure. The state.time field
contains time at evaluation points.
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REfun must return a row vector REval with the number of columns equal to the number
of evaluation points, M = length(location.x).

Specify ambient temperature using the AmbientTemperature argument and the Stefan-
Boltzmann constant using the thermal model properties. The value of Emissivity is
positive for heat radiation into the ambient environment.
Example: thermalmodel.StefanBoltzmannConstant = 5.670373E-8;
thermalBC(thermalmodel,'Edge',
[2,4,5,6],'Emissivity',0.1,'AmbientTemperature',300)

Data Types: double | function_handle

ATval — Ambient temperature
number

Ambient temperature, specified as a number. The ambient temperature value is required
for specifying convection and radiation boundary conditions.
Example: thermalBC(thermalmodel,'Edge',
[2,4],'ConvectionCoefficient',5,'AmbientTemperature',60)

Data Types: double

Output Arguments
thermalBC — Handle to thermal boundary condition
object

Handle to thermal boundary condition, returned as an object. thermalBC associates the
thermal boundary condition with the geometric region.

See Also
applyBoundaryCondition | internalHeatSource | thermalIC |
thermalProperties

Topics
“Heat Conduction in Multidomain Geometry with Nonuniform Heat Flux”

Introduced in R2017a
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thermalIC
Package: pde

Set initial conditions or initial guess for a thermal model

Syntax
thermalIC(thermalmodel,T0)
thermalIC(thermalmodel,T0,RegionType,RegionID)
thermalIC(thermalmodel,Tresults)
thermalIC(thermalmodel,Tresults,iT)
thermalIC = thermalIC( ___ )

Description
thermalIC(thermalmodel,T0) sets initial temperature or initial guess for temperature
to the entire geometry.

thermalIC(thermalmodel,T0,RegionType,RegionID) sets initial temperature or
initial guess for temperature to a particular geometry region.

thermalIC(thermalmodel,Tresults) sets initial temperature or initial guess for
temperature using the solution Tresults from a previous thermal analysis on the same
geometry and mesh. If Tresults is obtained by solving a transient thermal problem,
thermalIC uses the solution Tresults for the last time-step.

thermalIC(thermalmodel,Tresults,iT) sets initial temperature or initial guess for
temperature using the solution Tresults for the time-step iT from a previous thermal
analysis on the same geometry and mesh.

thermalIC = thermalIC( ___ ), for any previous syntax, returns a handle to the
thermal initial conditions object.

Examples
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Constant Initial Temperature

Create a thermal model, import geometry, and set the initial temperature to 0 on the
entire geometry.

thermalModel = createpde('thermal','transient');
geometryFromEdges(thermalModel,@lshapeg);
thermalIC(thermalModel,0)

ans = 
  GeometricThermalICs with properties:

            RegionType: 'face'
              RegionID: [1 2 3]
    InitialTemperature: 0

Different Initial Temperatures on Subdomains

Set different initial conditions on each portion of the L-shaped membrane geometry.

Create a model and include a 2-D geometry.

thermalModel = createpde('thermal','transient');
geometryFromEdges(thermalModel,@lshapeg);
pdegplot(thermalModel,'FaceLabels','on')
axis equal
ylim([-1.1 1.1])
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Set initial conditions.

thermalIC(thermalModel,0,'Face',1)

ans = 
  GeometricThermalICs with properties:

            RegionType: 'face'
              RegionID: 1
    InitialTemperature: 0

thermalIC(thermalModel,10,'Face',2)
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ans = 
  GeometricThermalICs with properties:

            RegionType: 'face'
              RegionID: 2
    InitialTemperature: 10

thermalIC(thermalModel,75,'Face',3)

ans = 
  GeometricThermalICs with properties:

            RegionType: 'face'
              RegionID: 3
    InitialTemperature: 75

Nonconstant Initial Temperature

Use a function handle to specify an initial temperature that depends on coordinates.

Create a thermal model for transient analysis and include the geometry. The geometry is
a rod with a circular cross section. The 2-D model is a rectangular strip whose y-
dimension extends from the axis of symmetry to the outer surface, and whose x-dimension
extends over the actual length of the rod.

thermalmodel = createpde('thermal','transient');
g = decsg([3 4 -1.5 1.5 1.5 -1.5 0 0 .2 .2]');
geometryFromEdges(thermalmodel,g);

Set the initial temperature in the rod to be dependent on the y-coordinate, for example,
103 0 . 2 − y2 .

T0 = @(location)10^3*(0.2 - location.y.^2);
thermalIC(thermalmodel,T0)

ans = 
  GeometricThermalICs with properties:

            RegionType: 'face'
              RegionID: 1
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    InitialTemperature: @(location)10^3*(0.2-location.y.^2)

Initial Condition as Previously Obtained Solution

Create a thermal model and include a square geometry.

thermalmodel = createpde('thermal','transient');
geometryFromEdges(thermalmodel,@squareg);
pdegplot(thermalmodel,'FaceLabels','on')
ylim([-1.1,1.1])
axis equal
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Specify material properties and internal heat source, and set boundary conditions and
initial conditions.

thermalProperties(thermalmodel,'ThermalConductivity',500,...
                               'MassDensity',200,...
                               'SpecificHeat',100);

internalHeatSource(thermalmodel,2);
thermalBC(thermalmodel,'Edge',[1,3],'Temperature',100);
thermalIC(thermalmodel,0);

Generate mesh, solve the problem, and plot the solution.

generateMesh(thermalmodel);
tlist = 0:0.5:10;
result1 = solve(thermalmodel,tlist)

result1 = 
  TransientThermalResults with properties:

      Temperature: [1541x21 double]
    SolutionTimes: [1x21 double]
       XGradients: [1541x21 double]
       YGradients: [1541x21 double]
       ZGradients: []
             Mesh: [1x1 FEMesh]

pdeplot(thermalmodel,'XYData',result1.Temperature(:,end))
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Now, resume the analysis and solve the problem for times from 10 to 15 seconds. Use the
previously obtained solution for 10 seconds as an initial condition. Since 10 seconds is the
last element in tlist, you do not need to specify the solution time index. By default,
thermalIC uses the last solution index.

thermalIC(thermalmodel,result1)

ans = 
  NodalThermalICs with properties:

    InitialTemperature: [1541x1 double]

Solve the problem and plot the solution.
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result2 = solve(thermalmodel,10:0.5:15)

result2 = 
  TransientThermalResults with properties:

      Temperature: [1541x11 double]
    SolutionTimes: [10 10.5000 11 11.5000 12 12.5000 13 13.5000 14 14.5000 15]
       XGradients: [1541x11 double]
       YGradients: [1541x11 double]
       ZGradients: []
             Mesh: [1x1 FEMesh]

pdeplot(thermalmodel,'XYData',result2.Temperature(:,end))
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To use the previously obtained solution for a particular solution time instead of the last
one, specify the solution time index as a third parameter of thermalIC. For example, use
the solution at time 5 seconds, which is the 11th element in tlist.

tlist(11)

ans = 5

thermalIC(thermalmodel,result1,11);

result2 = solve(thermalmodel,5:0.5:15)

result2 = 
  TransientThermalResults with properties:

      Temperature: [1541x21 double]
    SolutionTimes: [1x21 double]
       XGradients: [1541x21 double]
       YGradients: [1541x21 double]
       ZGradients: []
             Mesh: [1x1 FEMesh]

pdeplot(thermalmodel,'XYData',result2.Temperature(:,end))
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Input Arguments
thermalmodel — Thermal model
ThermalModel object

Thermal model, specified as a ThermalModel object. The model contains the geometry,
mesh, thermal properties of the material, internal heat source, boundary conditions, and
initial conditions.
Example: thermalmodel = createpde('thermal','steadystate')
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T0 — Initial temperature or initial guess for temperature
number | function handle

Initial temperature or initial guess for temperature, specified as a number or a function
handle. Use a function handle to specify spatially varying temperature. The function must
be of the form

T0 = T0fun(location)

The solver passes location as a structure with fields location.x, location.y, and,
for 3-D problems, location.z. T0fun must return a row vector T0 with the number of
columns equal to M = length(location.x).
Data Types: double | function_handle

RegionType — Geometric region type
'Vertex' | 'Edge' | 'Face' | 'Cell' for a 3-D model only

Geometric region type, specified as 'Vertex', 'Edge', 'Face', or 'Cell' for a 3-D
model. For a 2-D model, use 'Vertex', 'Edge', or 'Face'.
Example: thermalIC(thermalmodel,10,'Face',1)
Data Types: char | string

RegionID — Geometric region ID
vector of positive integers

Geometric region ID, specified as a vector of positive integers. Find the region IDs using
pdegplot, as shown in “Create Geometry and Remove Face Boundaries” on page 2-13 or
“STL File Import” on page 2-46.
Example: thermalIC(thermalmodel,10,'Edge',2:5)
Data Types: double

Tresults — Thermal model solution
ThermalResults object

Thermal model solution, specified as a ThermalResults object. Create Tresults by
using solve.

iT — Time index
positive integer
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Time index, specified as a positive integer.
Example: thermalIC(thermalmodel,Tresults,21)
Data Types: double

Output Arguments
thermalIC — Handle to initial condition
object

Handle to initial condition, returned as an object. thermalIC associates the thermal
initial condition with the geometric region in the case of a geometric assignment, or the
nodes in the case of a results-based assignment.

See Also
internalHeatSource | setInitialConditions | thermalBC | thermalProperties

Introduced in R2017a
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tri2grid
(Not recommended) Interpolate from PDE triangular mesh to rectangular grid

Note tri2grid is not recommended. Use interpolateSolution instead.

Syntax
uxy = tri2grid(p,t,u,x,y)
[uxy,tn,a2,a3] = tri2grid(p,t,u,x,y)
uxy = tri2grid(p,t,u,tn,a2,a3)

Description
uxy = tri2grid(p,t,u,x,y) computes the function values uxy over the grid defined
by the vectors x and y, from the function u with values on the triangular mesh defined by
p and t. Values are computed using linear interpolation in the triangle containing the grid
point. The vectors x and y must be increasing. u must be a vector. For systems of
equations, uxy interpolates only the first component. For solutions returned by
hyperbolic or parabolic, pass u as the vector of values at one time, u(:,k).

[uxy,tn,a2,a3] = tri2grid(p,t,u,x,y) additionally lists the index tn of the
triangle containing each grid point, and interpolation coefficients a2 and a3.

uxy = tri2grid(p,t,u,tn,a2,a3) with tn, a2, and a3 computed in an earlier call to
tri2grid, interpolates using the same grid as in the earlier call. This variant is, however,
much faster if several functions have to be interpolated using the same grid, such as
interpolating hyperbolic or parabolic solutions at multiple times.

All tri2grid output arguments are ny-by-nx matrices, where nx and ny are the lengths
of the vectors x and y respectively. At grid points outside of the triangular mesh, all
tri2grid output arguments are NaN.

See Also
interpolateSolution | solvepde
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volume
Package: pde

Volume of 3-D mesh elements

Syntax
V = volume(mesh)
[V,VE] = volume(mesh)
V = volume(mesh,elements)

Description
V = volume(mesh) returns the volume V of the entire mesh.

[V,VE] = volume(mesh) also returns a row vector VE containing volumes of each
individual element of the mesh.

V = volume(mesh,elements) returns the combined volume of the specified elements
of the mesh.

Examples

Volume of 3-D Mesh

Generate a 3-D mesh and find its volume.

Create a PDE model.

model = createpde;

Import and plot the geometry.

importGeometry(model,'BracketWithHole.stl');
pdegplot(model)
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Generate a mesh and plot it.

mesh = generateMesh(model);
figure
pdemesh(model)
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Compute the volume of the entire mesh.

mv = volume(mesh)

mv = 8.0295e-04

Volume of Individual Elements of 3-D Mesh

Generate a 3-D mesh and find the volume of each element.

Create a PDE model.

 volume
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model = createpde;

Import and plot the geometry.

importGeometry(model,'BracketWithHole.stl');
pdegplot(model)

Generate a mesh and plot it.

mesh = generateMesh(model);
figure
pdemesh(model)
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Compute the volume of the entire mesh and the volume of each individual element of the
mesh. Display the volumes of the first 5 elements.

[va,vi] = volume(mesh);
vi(1:5)

ans = 1×5
10-6 ×

    0.5427    0.2243    0.4379    0.2740    0.4541
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Total Volume of Group of Elements

Find the combined volume of a group of elements of a 3-D mesh.

Create a PDE model.

model = createpde;

Import and plot the geometry.

importGeometry(model,'BracketWithHole.stl');
pdegplot(model)

Generate a mesh and plot it.
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mesh = generateMesh(model);
figure
pdemesh(model)

Evaluate the shape quality of the mesh elements and find the elements with the quality
values less than 0.5.

Q = meshQuality(mesh);
elemIDs = find(Q < 0.5);

Compute the total volume of these elements.

mv05 = volume(mesh,elemIDs)

mv05 = 4.2568e-06
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Find how much of the total mesh volume belongs to these elements. Return the result as a
percentage.

mv05_percent = mv05/volume(mesh)*100

mv05_percent = 0.5301

Input Arguments
mesh — Mesh object
Mesh property of a PDEModel object | output of generateMesh

Mesh object, specified as the Mesh property of a PDEModel object or as the output of
generateMesh.
Example: model.Mesh

elements — Element IDs
positive integer | matrix of positive integers

Element IDs, specified as a positive integer or a matrix of positive integers.
Example: [10 68 81 97 113 130 136 164]

Output Arguments
V — Volume
positive number

Volume of the entire mesh or the combined volume of the specified elements of the mesh,
returned as a positive number.

VE — Volume of individual elements
row vector of positive numbers

Volume of individual elements, returned as a row vector of positive numbers.

See Also
FEMesh Properties | area | findElements | findNodes | meshQuality
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Topics
“Finite Element Method Basics” on page 1-18

Introduced in R2018a
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wbound
(Not recommended) Write boundary condition specification file

Note wbound is not recommended. Use applyBoundaryCondition instead.

Syntax
fid = wbound(bl,mn)

Description
fid = wbound(bl,mn) writes a Boundary file with the name [mn,'.m']. The Boundary
file is equivalent to the Boundary Condition matrix bl. The output fid is -1 if the file
could not be written.

bl describes the boundary conditions of the PDE problem. bl is a Boundary Condition
matrix.

The output file [mn,'.m'] is the name of a Boundary file. (See “Boundary Conditions by
Writing Functions” on page 2-197.)

See Also
decsg | wgeom

Introduced before R2006a

5 Functions — Alphabetical List

5-1150



wgeom
Write geometry specification function

Note This page describes the legacy workflow. New features might not be compatible
with the legacy workflow.

Syntax
fid = wgeom(dl,mn)

Description
fid = wgeom(dl,mn) writes a Geometry file with the name [mn,'.m']. The Geometry
file is equivalent to the Decomposed Geometry matrix dl. fid returns -1 if the file could
not be written.

dl is a Decomposed Geometry matrix. For a description of the format of the Decomposed
Geometry matrix, see “Decomposed Geometry Data Structure” on page 2-15.

The output file [mn,'.m'] is the name of a Geometry file. For a description of the
Geometry file format, see “Parametrized Function for 2-D Geometry Creation” on page 2-
17.

See Also
decsg

Introduced before R2006a
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